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Dear Reader,

Thank you for choosing Mastering Revit Architecture 2010. This book is part of a family of premium-
quality Sybex books, all of which are written by outstanding authors who combine practical 
experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to producing consis-
tently exceptional books. With each of our titles, we’re working hard to set a new standard for 
the industry. From the paper we print on, to the authors we work with, our goal is to bring you the 
best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments and 
get your feedback on how we’re doing. Feel free to let me know what you think about this or any 
other Sybex book by sending me an email at nedde@wiley.com. If you think you’ve found a tech-
nical error in this book, please visit http://sybex.custhelp.com. Customer feedback is critical to 
our efforts at Sybex. 

 Best regards,
 

 
 

 
 
 
 Neil Edde

 Vice President and Publisher
 Sybex, an Imprint of Wiley
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For Serene 
—Greg

For all the fantastic friends that Revit brought to me, 
from Norway to South Africa, I love and miss you all  
— Tanja

For my family who puts up with me writing these 
books evenings and weekends. 
—Eddy
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Foreword
Revit Architecture will turn 10 years old in the coming year, possibly while you are reading 
this book. As such, it seems appropriate to reflect on the origins of this tool and describe a small 
portion of the history of Revit from my personal perspective, as well as some of the factors that 
influenced where we are now.

Change Was Coming
The basic tenets of building information modeling (BIM) and parametric building modeling 
have been discussed for 30 years. So why did it take so long for the architecture, engineering, 
and construction (AEC) industry to get there? I believe the software and AEC industries were 
uniquely aligned over the past 10 years and, in the context of macroeconomic conditions like 
booms and recessions, helped catalyze the changes we see today. Over that time, conditions 
were right for the inception, formation, and strengthening of the ideas and technologies inside 
Revit and for the development of the larger concept of BIM. 

There were significant reasons why the AEC industry should have been primed for change 
in the late 1990s. The United States had come out of the recession that plagued it earlier in 
the decade. The construction industry was thriving, as were information technology and the 
Internet. There had been dramatic increases in computational power and networking. Adoption 
of CAD was increasing dramatically in architectural firms, and other solutions on the market 
also offered 3D modeling and building-specific modeling capabilities. Despite these innova-
tions, the typical construction documentation process was tedious and error-prone. The typical 
design-bid-build construction process was inefficient and costly. Was that enough to cause the 
architectural design industry to change? No. The industry was simply not ready for dramatic 
process and technical change from a business, design process, or technology adoption standpoint. 
(The AEC industry is not known for moving quickly.)

The factors I’ve listed did not change the AEC industry overnight, but they did start to sow 
the seeds. A contributing factor in the evolution toward what we now understand as BIM can be 
found in the early history of Revit, which tells a story of how small teams, a clear vision, a little 
bit of venture capital money and a large amount of luck can contribute toward building an inno-
vative software product. 

There Are People Who Do 
In 1999 I was happily working as a design architect who also happened to be interested in tech-
nology. Over time, I started reading WIRED and FastCompany more than Architectural Record. 
In Silicon Valley and the San Francisco Bay Area, venture capital money was flowing. A change 
was also happening on the East Coast: friends of mine had started to take jobs at software start-
ups. I noticed they seemed to spend a good deal of time playing foosball.

I joined a small startup software company called Charles River Software in October of 1999 
and was one of the first architects hired to work on a new parametric building modeler, code-
named Perspective. At that point the software could do little more than draw walls and place 
windows. The roof tool was still a rough sketch on a whiteboard and the column tool had just 
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come online. It crashed when you clicked the button. There were a lot of crashes in those days. 
We had no shipping product, no customers, and did not even have a name for the company or 
the product. (The name Revit came later.) My expectations of playing foosball in a fun startup 
environment had vanished. There was a lot of work to do.

In retrospect, the most important things we had were a product vision and a small group of 
people who knew how to get things done. The software development team was literally a group 
of physicists and rocket scientists. They had experience building parametric modeling applica-
tions and maintaining a high level of bidirectional associativity, and they were comfortable 
solving hard math and logic problems. The marketing team proved to be quite adept as well. 
The quality assurance, product design, and technical support teams were from the AEC indus-
try. The management team believed in the power of small teams and in accountability. They also 
knew how to ruthlessly prioritize and force a level of critical thinking. The team learned how to 
get things done and deliver results because it had to. Our survival depended on it.

As an impressionable novice in the realm of software development, I learned a great deal 
from the early Revit management team. Two books that informed their thinking were Crossing 
the Chasm by Geoffrey Moore (HarperBusiness, 1999) and Rules for Revolutionaries by Guy 
Kawasaki (Collins, 1999). They were popular in the late 1990s and are still good entry points 
into the field today. I dug them out of my basement to help write this foreword.

Great teams are usually small—under fifty in total head count… 
Guy Kawasaki, Rules for Revolutionaries

In April 2000, I helped ship a crappy product (to paraphrase Guy Kawasaki). Revit 1.0 was 
launched at the AIA Convention in Philadelphia. It could only draw walls, roofs, floors and ceil-
ings. There were only 14 creation commands and they all fit on the screen at one time. It was 
insanely hard to build your own windows and doors. Performance was horrible. Our baby was 
not perfect, far from it, but the fundamental concepts of the parametric building model were all 
there. The hardest part was convincing ourselves we were ready to ship. We had to learn it was 
okay not to be perfect.

Revolutionary products don’t fail because they are shipped too early; they fail because they are not 
revised fast enough.
Guy Kawasaki, Rules for Revolutionaries

iterating and innovating in a Recession

It turns out our attitude toward technology adoption becomes significant any time we are introduc-
ing products that require us to change our current mode of behavior or to modify other products 
and services we rely on. In academic terms, such products are called discontinuous innovations. 
The contrasting term, continuous innovations, refers to the normal upgrading of products that 
does not require us to change behavior.
Geoffrey Moore, Crossing the Chasm

Geoffrey Moore’s book Crossing the Chasm is one of the must-reads for anyone attempting to 
deliver innovative products and services to a market. He introduces the Technology Adoption 
Life Cycle, which divides customers into segments like Innovators, Early Adopters, Early 
Majority, and Late Majority, following a traditional bell curve. 
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The first thing any new product needs to do is identify and work with the Innovators and 
Early Adopters in the industry. Accordingly, we spent the next 2 years (2000–2002) iterating and 
revising, designing, and developing the first few versions of Revit. The things we had during 
that time were a vision, and, most important, a small set of customers who definitely fit the mold 
of Innovators and Early Adopters. These customers believed in the vision and were not afraid 
to stick their necks out and try our software, and they were vocal in telling us what did and did 
not work. Ideas were tried and rapidly improved or discarded.

Listen to what your early adopters say about your product and improve it accordingly because 
while better is the enemy of good enough, better… better be coming.
Guy Kawasaki, Rules for Revolutionaries

By fall 2001, we still did not have very many customers and the economy was not doing well. 
The Internet boom was over and the United States was in another recession. Companies that 
sold pet food online had started to fail. Quite frankly, times were tough. Money was tight and it 
was not clear what the future would bring. We dug in and continued to listen and work with our 
customers and produce more versions. There was a remarkable sense of creativity and camara-
derie in our second-rate office building in Boston as we designed, built, tested and supported a 
young product. 

A lousy building and lousy furniture are necessary because suffering is good for revolutionaries. 
It builds cohesiveness; it creates a sense of urgency; and it focuses the team on what’s important: 
shipping! If you are ever recruited by a team that claims to be revolutionary and see beautiful, 
matched Herman Miller furniture, run do not walk, from the interview. On the other hand, if you 
see a lousy building, lousy furniture, but fantastically creative workspaces, then sign up immediately.
Guy Kawasaki, Rules for Revolutionaries

Between 2000 and 2002, the team built the main features of Revit as a parametric building 
modeler and created the seeds of a discontinuous innovation and a disruptive technology, as 
defined by Clay Christensen in his book The Innovator’s Dilemma: When New Technologies Cause 
Great Firms to Fail (Harvard Business School Press, 1997):

Disruptive technologies bring to a market a very different value proposition than had been 
available previously. Generally, disruptive technologies underperform established products in 
mainstream markets. But they have other features that a few fringe (and generally new) custom-
ers value. Products based on disruptive technologies are typically cheaper, simpler, smaller, and 
frequently more convenient to use.
Clay Christensen, The Innovator’s Dilemma

It was not apparent to us at that time, but the core features of Revit that are the most disrup-
tive and technologically innovative were developed during this time frame. Perhaps there is 
some correlation between the squeeze of the tech bust in the early 2000s and the activities of 
a small team of software engineers and architects hunkered down in an ugly office building 
outside of Boston. Interestingly, there are now publications that discuss how major innovations 
are more likely to happen in recessions. It’s probably a good thing we did not spend those years 
playing foosball.

Consider the year 2001, by all accounts a rough year. It was clear that the Internet bubble had burst. 
The Nasdaq index was down close to 30%—and that was before the Sept. 11 terrorist attacks. But 
was it a bad year for disruption? Quite the contrary. In 2001, [there were] at least a dozen specific 
disruptive developments in the U.S. alone.
Scott D. Anthony and Leslie Feinzaig, “Innovating During a Recession,” http://www.forbes 
.com/2008/07/08/recession-innovation-retailing_leadership_clayton_in_sa_ 
0708claytonchristensen_inl.html
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Nurturing a Young Technology
The business environment continued to prove challenging in the early 2000s. Revit needed a 
sales channel and customers. The saving grace came on April 1, 2002, when Revit Technology 
Corporation was acquired by Autodesk, Inc. There were now opportunities to continue nurtur-
ing a young technology and start utilizing the global reach of the Autodesk organization. 

The seven years after the acquisition were spent nurturing and developing the product and 
the underlying platform. An investment was made by forward-looking industry executives 
inside Autodesk, not just in the acquisition of a small startup, but in the development of a new 
platform for the AEC industry. During that time, the expanded Revit product development 
team, also known as the “The Factory,” continued to develop software. Customers were listened 
to; features were added and refined; support, sales, and marketing organizations were exposed 
to the newly acquired product. 

It is difficult to prove exactly when, but at some point along the way Revit Architecture 
“crossed the chasm” and started to be deployed in the larger market of Early Majority custom-
ers. Many products and services fail to make the treacherous crossing. 

There were still large challenges to overcome. The product needed to be turned into a plat-
form. Teams started to work on what are now Revit Structure and Revit MEP. Large customers 
needed to be supported. A large number of creative and passionate people started working 
on Revit. Forward-looking executives started to articulate the ideas we now know as building 
information modeling.

I feel extremely fortunate and honored to work with many creative, passionate people in the 
Autodesk organization, as well as many leading architectural and engineering firms. 

Where Are We Now?
So what does the world look like in April 2009? BIM is decidedly the present. We are now living 
in a BIM-enabled world, where technologies like Revit have helped enable larger process and 
business-related changes. The small experimental software project from 10 years ago has been 
nurtured and supported. It has matured over time into the current Revit Architecture 2010. The 
number of new firms and individuals starting to use Revit is increasing rapidly. 

Concepts like BIM are larger than any technology and, when combined with other trends 
like integrated project delivery (IPD), are helping the AEC industry to change very quickly, 
more quickly than any time in the last 10–15 years. It is important to understand that BIM is 
larger than just Revit. An old friend and colleague of mine sums this up:

The reason Mastering Revit Architecture is such a great book is because of its holistic approach to 
BIM. Eddy, Greg, and Tatjana have taken great care to help you understand the context of what 
you’re trying to accomplish within the application of important design principles. Many books 
mistakenly view BIM as mere “technology”—or even one particular technology. It’s not. BIM is a 
philosophical approach to architecture that emphasizes the integration of the design, development, 
and delivery process. It’s about understanding the implications, complications, and context of 
design decisions as early as possible.

It’s about being accountable for your own design decisions.
Phil Read, foreword to Mastering Revit Architecture 2009 (Sybex, 2008)

So how can we help more professionals in the industry understand the implications, compli-
cations, and context of their design decisions as early as possible? Revit Architecture 2010 can 
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help. In this new release, the talented team of product managers, interaction designers, and soft-
ware developers in the Factory have built a new user interface, added new conceptual modeling 
tools, and extended the underlying platform. 

The process used to design, develop, and test this release has been thoughtful and rigorous. 
The teams working on these problems are professional and have worked closely with users. If 
you are interested in learning more about this process, I recommend you visit the “Inside the 
Factory” blog (http://insidethefactory.typepad.com). I am confident that our talented team 
of software designers and developers will continue to work with users in the field and, collec-
tively, we can create better tools for the industry.

In this new release, we have added new conceptual modeling features to the Revit platform. 
We have built a set of tools in Revit that make it easier to create and manipulate geometric form, 
and then turn it into a building in Revit, something that historically has been quite difficult to 
do and often required additional software tools. We have worked with an exceptionally talented 
group of customers, product designers, software developers, quality assurance architects, user 
assistance professionals, marketing managers, and product managers. I feel extremely fortunate 
and honored to have been able to lead this effort and work closely with my colleagues (Lira 
Nikolovska, Greg Demchak, Nathan Lockwood, Laura Gutwillig, Heather Lech, Zach Kron, 
Scott Latch, and Jason Winstanley).

Revit is being implemented in mainstream architecture and engineering firms worldwide, 
and books like Mastering Revit Architecture 2010 are instrumental in helping people make the 
transition from CAD to BIM. I applaud Greg, Tatjana, and Eddy for the dedication, time, and 
effort they have contributed to every edition of this book. 

What’s Next? 
Ten years ago, the environment was right for a few software visionaries to see the market 
opportunity in the AEC industry. Eight years ago, the challenging times of the last recession 
influenced the critical formation of a new technology. Five years ago, the environment was right 
for a strengthened technology to be piloted by more firms and used on significant projects like 
Skidmore Owens and Merrill’s Freedom Tower. During these years, the larger concept of BIM 
was formed and is now generally recognized as where the industry is headed. 

So what’s next? What pressures, market conditions, and opportunities do we see in the cur-
rent day? Here are two pressures affecting both the AEC and high-tech industry.

Economic Pressures
We are in the midst of a massive global economic downturn, perhaps the worst recession in our 
lifetime. What does this mean for the AEC industry and for how we think about technology? 
How can design teams work more effectively together and provide more value to their clients 
and owners? How can design teams produce a better built environment in these times? How 
can they use the tools we have more effectively, foster deeper insight into our designs, and ulti-
mately make better design decisions?

Revit was conceived of as a platform for managing change and coordinating documents, 
but as people get past the building modeling part of BIM, they realize the middle letter of BIM 
stands for information. The data in the Revit model can help design teams make better deci-
sions earlier in the process. We see firms using the building information model not just for 
coordinated documentation, but to perform efficiency calculations and what-if scenarios for 
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their clients. As design teams become more conversant with their tools and more design data 
is added to the model, the relative value of the model increases. This can help not only the core 
design team, but also the larger team, including the owner and contractor, especially when used 
in conjunction with integrated project delivery (IPD). When you combine the benefits of coordi-
nated documentation, improved building insight, and sharing of valuable information with the 
extended design team, investing in BIM seems to make sense, even in the current downturn.

Environmental Pressures
We are also in the midst of severe environmental changes and have come to a collective real-
ization that the way we use energy and our natural resources is not sustainable. We know our 
buildings have an enormous impact in terms of energy usage during construction and operation 
of a given building. Can we better understand how our current building stock is performing 
and where energy is being used today? Can we propose thoughtful and strategic modifications 
to existing buildings? Can we work to make our new designs more sustainable and energy-
conscious?

Once again, the middle letter of BIM stands for information. As government officials and the 
general population become more aware of the impact buildings have on the environment, one 
might expect a renewed interest in energy-efficient design. The same information latent in the 
building model can be used to better understand and predict how a building will perform, 
through both whole building energy analysis and more detailed, specific analysis. If you are 
interested in finding out how, please visit http://www.autodesk.com/green.

What does the future look like? From a technology and software design standpoint, I can’t 
help but wonder what the world will look like in another 5–10 years. Given the current economic 
and political climate, perhaps there is another round of increased innovation on the horizon. 
Only time will tell. Revit has certainly been a core part of advances in the industry over the past 
10 years, and we look forward to working with you and other architects and engineers to design 
better tools for the AEC industry in the future.

All the best,
Matt Jezyk
April 2009

Matt Jezyk is an architect and product designer. He was one of the first product designers working on what 
is now called Revit Architecture. Since joining Autodesk with the Revit acquisition, he was a product 
designer for Revit Architecture, lead the design team working on Revit Structure, and most recently 
lead the team working on the new conceptual modeling tools in the 2010 release. Matt is now leading the 
user experience team working on analysis and simulation tools for the building industry.
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Welcome to the second edition of Mastering Revit Architecture, based on the Revit Architecture 2010 
release.

This book follows on the heels of our updated Introducing Revit Architecture 2010 (Wiley, 2009). 
In preparing the 2010 edition of the Mastering book, we took the opportunity to introduce some 
of the features new to the 2010 release of the software, to rewrite large portions of the text, and 
to polish up the rest, taking into consideration comments and suggestions from many readers 
and friends. Working as a team of three authors, we kept one another in constant check, each 
of us writing, reviewing, editing, and updating as chapters rolled out. One additional change 
we made to the previous edition of the book was to break some of the longer chapters into more 
bite-sized morsels, which we hope resulted in chapters that flow better and give you some 
breathing room as you move through the book.

Writing books looks easier than it truly is. What drives and inspires us is the feeling that 
we’re doing something important: sharing our best knowledge and practices about Revit and 
building information modeling (BIM) with those who are already acquainted with its incredible 
power and feel the need to go deeper and further to fully leverage its abilities and values. We 
want to help you make better designs, be more efficient in creating correct documentation, learn 
some new techniques, and put some fun back into using software.

We also wanted to write a book that is as much about architectural design and practice as it 
is about software. We think we’ve succeeded, because the book follows real-life workflows and 
scenarios and is full of practical examples that show how to use Revit practically and creatively.

Who Should Read This Book
This book is written for architects who have already gotten their feet wet with Revit and are 
eager to learn more so they can optimize workflow and leverage the full power of this tool. It’s 
for architects of any generation—you don’t need to be a high-tech wizard to dive into this book. 
However, a basic understanding of Revit will make it easier to work through the book. Revit is 
very rich, and the topics we’ve selected include some of the most widely used ones, as well as 
some of the least understood. Many more books need to be written to cover the entire world  
of Revit.

This book is also for the seasoned user who has already received training or has started 
working on projects with Revit and is looking to discover useful best practices and tips that will 
make the work on a project smoother and the implementation easier. We’ve added many time-
saving and inspiring concepts to the book, supported by examples from architect friends and 
colleagues from all around the world, to motivate you and help you on your journey into the 
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new era of building information modeling. For BIM managers, the book offers insights into the 
best practices for creating good project or office templates; these managers should also take a 
sneak peek into the powerful world of building content and Revit families.

What You Will Learn
This book will help you take the basics of Revit and BIM that you already know and expand on 
them using real-world examples. We will show you how to take a preliminary model and add 
layers of intelligence to help analyze and augment your designs.

In this particular volume, we go beyond introductory topics. Thus, we won’t be starting a 
project from scratch or teaching you how to build a simplified BIM model from the ground 
up. (If you are interested in that approach, please see Introducing Revit Architecture 2010 [Wiley, 
2009], which is meant to be complementary to this book). Instead, our book begins with a brief 
overview of the BIM approach. As you are already aware, BIM is more than just a change in soft-
ware; it’s a change in architectural workflow and culture. To leverage the full advantages of both 
BIM and Revit in your office structure, you will need to make some changes to your practice. 
We’ve designed the book around an ideal, integrated workflow to help you make this transition.

Starting with the workflows for conceptual design and feasibility studies, it continues 
through best practices for design iteration and refinement. You’ll learn about powerful model-
ing techniques, design documentation best practices, how to make compelling presentation 
graphics, parametric design with the family editor, workflow topics like tracking changes and 
worksharing, and some strategies for sustainable design. The book concludes with an appendix 
on troubleshooting and best practices so you can avoid common pitfalls. Throughout the book 
we’ve tried to share our practical experience with you, particularly in the form of Real-World 
Scenario sidebars.

Whether you’re studying Revit on your own or in a class or training program, you can use 
the Master It questions in the Bottom Line section at the end of each chapter to test your mastery 
of the skills you’ve learned.

Also featured is a color project gallery containing inspirational Revit projects from friends 
and colleagues who were generous enough to share their good work with the rest of the world.

All the tutorial files necessary to complete the book’s exercises plus sample families are 
hosted online at www.sybex.com/go/masteringrevit2010. To download the trial version of Revit 
Architecture, go to www.autodesk.com/revitarchitecture, where you’ll also find complete sys-
tem requirements for running Revit.

Enjoy! Revit has changed our lives. Maybe it will change yours as well.
We welcome your feedback! Please feel free to email us at GoRevit@gmail.com.
Go Revit!

Greg, Tanja, and Eddy
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The Mastering Series
The Mastering series from Sybex provides outstanding instruction for readers with intermediate 
and advanced skills, in the form of top-notch training and development for those already work-
ing in their field and clear, serious education for those aspiring to become pros. Every Mastering 
book includes:

Real-World Scenarios, ranging from case studies to interviews, that show how the tool, •u	

technique, or knowledge presented is applied in actual practice

Skill-based instruction, with chapters organized around real tasks rather than abstract •u	

concepts or subjects

Self-review test questions, so you can be certain you’re equipped to do the job right•u	
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Chapter 1

Understanding BIM: From the Basics 
to Advanced Realities

In this chapter we’ll cover the principles of a building information modeling (BIM) approach and 
summarize how BIM differs from a traditional 2D computer-aided design (CAD) process. We’ll 
explain fundamental characteristics of Revit, how Revit delivers the benefits of a true BIM tool, and 
why Revit is the tool best suited for a process motivated by an integrated and collaborative practice.

In this chapter, you’ll learn to:

Identify the advantages of building information modeling•u	

Know what to expect from BIM•u	

Identifying the Advantages of BIM
The production of design documents has traditionally been an exercise in drawing lines to 
represent a building. These documents become instruction sets: an annotated booklet that 
describes what the building should look like when complete. The plan, section, elevation, and 
detail are all skillfully drafted—line by line, drawing by drawing, sheet by sheet. Whether 
physical or digital, these traditional drawing sets are composed of annotated graphics where 
each line and text is part of a larger abstraction meant to convey design intent so that a building 
can eventually be constructed. By and large, this is still the reality we face today, but the process 
of creating these drawings is being fundamentally changed as a result of BIM. 

Let’s put this into an historical context for a moment and briefly walk through the evolution 
of architectural design and documentation.

A Brief History of Design and Documentation
Andrea Palladio’s Four Books on Architecture (trans. Robert Tavernor and Richard Schofield, 
MIT Press, 1997) presents an amazing array of drawing techniques that show buildings cut in 
plan and section and even hybrid drawings that show elevations and sections in one drawing. 
You can see hints about construction techniques and structural gestures in the form of trusses, 
arches, and columns.

These representations were meant as simplified expressions of a project, and often they were 
idealized versions of the building—not necessarily how the building was built. The drawings 
were communication and documentation tools, themselves works of detailed craftsmanship. In 
those days (14th–17th centuries), the architect was brought up in the tradition of building and 
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had integral knowledge of how buildings were constructed. Palladio, like many other architects 
of his day, grew up as a stonemason. Building techniques were deeply embedded in the construc-
tion trades, which in turn spawned the great architects of the time. Other master masons and 
sculptors who were also architects include the likes of Filippo Brunelleschi, Giovanni Bernini, 
and Francesco Borromini. These architects are often referred to as the master builders, because 
they were involved in all facets of the design and construction of buildings.

Over time, however, architecture became more and more academic as building typologies 
solidified, and under the influence of Beaux Arts tradition, classical reconstructions on paper 
and in model form became part of the formative education of the architect. The design profes-
sion began its gradual separation from the building trades. The notion of design process and 
iterative problem solving became critical attributes of a design professional—in many cases 
superseding knowledge of construction means and methods.

With modern architecture, solving abstract spatial problems, accommodating program-
matic elements, and experimenting with new materials became driving forces. The machine 
age and the promise of mass production were idealized and fully embraced. Le Corbusier’s 
(1887–1965) romantic vision of steamships and automobiles inspired a new generation of archi-
tecture, and buildings became increasingly machine-like. Consider all the office towers and 
commercial office parks that have emerged, each with internal mechanical systems to keep them 
operational.

As buildings continued to grow in complexity, both technically and programmatically, the 
architect grew more removed from the act of physical construction. Modern materials such as 
steel and reinforced concrete became prevalent, and complex building systems were introduced. 
In turn, the production of more detailed drawings became a legal and practical requirement. 
Structural engineers and mechanical engineers were added to the process, as need for special-
ized knowledge of building systems grew. No longer could the architect expect to produce a 
few simple drawings and have a building erected. Complexity in building systems demanded 
greater amounts of information, and this information was delivered in the form of larger and 
more complex construction document sets. Architects today find themselves drafting, producing 
details, working with a wide range of consultants, and still having to create sketches for contrac-
tors in the field in order to resolve the complexity of construction assemblies.

The traditional production of plans, sections, and elevations continues to this day, but with 
far more drawings than in the days of Palladio. At the same time, we ask these questions: Will 
all these drawings be necessary in the near future? Will the adoption of BIM lead to new ways of 
communicating the design, new delivery methods, new forms of construction, and new roles for 
the architect? Can a shift in technology lead to a shift in thinking about the building process? 

Building Information Modeling
Fast-forward to the present context and the advent of building information modeling. The pro-
duction of drawings is now streamlined by creating a digital 3D model composed of virtual 
building elements. These elements are loaded with data that describe not only geometry, but 
also material, fire rating, cost, manufacturer, count, and just about any other metadata you 
can imagine. The focus moves from 2D abstractions to integrated model delivery. It’s now possible 
to detect spatial clashes between the multitudes of complex systems in the building. You can 
know with confidence whether ductwork will interfere with the structural steel long before 
construction starts.

56491c01.indd   2 6/2/09   2:41:42 PM



identiFying the advantages oF BiM | 3

The goal of reducing errors and smoothing out the construction process is driving firms to 
be more efficient, effective, and productive. With BIM, all the plans, sections, and elevations are 
derivative representations of the model: producing these drawings is no longer a set of isolated, 
repetitive, and discontinuous tasks. A data-rich model also means that more analysis and itera-
tive searching for optimal solutions can occur early in the design process. As detail is added, 
the model becomes an increasingly accurate representation of what will actually be built. The 
model itself can be used to generate parts lists, shop drawings, and instructions for industrially 
produced elements for the fabrication process. If you can send a digital file that can instruct 
machines to produce components, the need for traditional annotated drawings might disappear 
entirely. The ultimate benefits of BIM are still emerging in a market primed to change radically 
the way buildings are designed and built. A shift in process and expectation is happening in the 
architecture, engineering, and construction (AEC) world, with private and public sector owners 
beginning to demand BIM models as part of the delivery package.

The shift from traditional 2D abstractions to on-demand simulations of building performance, 
usage, and cost is no longer a futuristic fantasy but a reality. In the age of information-rich 
digital models, all disciplines involved with a project can share a single database. Architecture, 
structure, mechanical, infrastructure, and construction can be coordinated in ways never 
before possible.

Models can now be sent directly to fabrication numerically controlled machines (CNC), 
bypassing the need for traditional shop drawings. Energy analysis can be done at the outset of 
design, and construction costs are becoming increasingly predictable. These are just a few of the 
exciting opportunities that a BIM approach offers. Designers and contractors can begin to look 
at the entire building process—from preliminary design through construction documentation 
into construction—and rethink how buildings come together. The whole notion of paper-based 
delivery may become obsolete as more players adopt up-to-date, accurate, digital models.

With the Revit building information model, a parametric 3D model is created that produces 
traditional building abstractions such as plans, sections, elevations, details, and schedules. 
The drawings produced aren’t discrete collections of manually coordinated lines, but interac-
tive  representations or, more accurately, different views of a model. Working in a model-based 
framework such as Revit guarantees that a change in one view will propagate to all other views 
of the model. As you shift elements in plan, they simultaneously change in elevation and sec-
tion. If you change a level height, all the walls and floors associated with that level update 
automatically and adjust their base/height/length to the new condition. If you remove a door 
from your model, it’s simultaneously removed from all other views, and your door schedule is 
updated automatically. This unprecedented level of coordination allows designers and builders 
to better control and display information, ensuring higher quality and a leaner process.

The immediate access to 3D visualization of the building and its spaces makes it much 
easier to understand and communicate the building design. One model can also contain many 
variations (Design Options), any of which can be explored at any stage in the design process. 
Integrated design and documentation keeps the data centralized and coordinated. This in turn 
leads to live and up-to-date schedules and quantity take-offs. That information can then be 
used to make decisions early in the design process, reducing risk and cost overruns. Not only 
that, but with the coordinated BIM model, you can start running energy analysis, solar studies, 
daylight simulations, and egress analysis much earlier in the process, allowing you to iterate 
through design decisions earlier, not later.
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Coordination with BIM is now required for many buildings to come into existence. BIM is 
extremely useful for complex projects such as Daniel Libeskind’s Denver Art Museum, with its 
extreme geometric configuration (Figure 1.1). Integrating the mechanical and structural systems 
into a 3D model is essential to completing a building of this complexity. Exact spatial organiza-
tion of structural members could be modeled, which in turn led to fewer field errors and fewer 
requests for information. In addition, parts could be sent directly to fabrication from the model, 
eliminating the need for 2D drawings entirely.

Let’s not leave out some of the more pleasurable aspects of BIM that go beyond all the tech-
nical, economic, and ecological benefits. With a 3D model, you can expect to see changes in 
how you interact with your team and your clients and in the way you produce presentations. 
No longer are you stuck with using 2D drawings or outsourcing to create perspective images. 
You’ll find yourself working with your team in close quarters, sharing a model, and exploring 
it together. With your clients, you can now take them through the building, in full 3D, from the 
beginning. The experience of working with and visualizing 3D space can’t be overemphasized, 
and people enjoy it immensely. In the BIM era, 3D experience is the norm, not the exception.

BIM and Process Change
When moving to a BIM work environment, you’ll experience a change in process and workflow. 
Perhaps the most immediate and obvious difference is that a traditional CAD system uses many 
separate files to document a building, whereas a BIM project typically has only one file. With 
CAD, all the separate files are created individually and have no intelligent connection between 
them. Each drawing represents a separate piece of work to be managed and updated through-
out the design process. With such an unwieldy process, the possibility of uncoordinated data, 
and thus errors, is very high. The manual change management enforced by CAD is a tedious 
and error-prone process that requires diligent project management and lots of red lines. BIM 
provides a different approach to the problem: rather than many files, you work with one logical 
file. With BIM, all information is consolidated and networked together for you, and the resulting 
drawings all relate back to a single underlying database, guaranteeing an internally consistent 
model. 

Figure 1.1 
BIM makes it pos-
sible to build more 
complex buildings 
with fewer errors.
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If you understand the basic premise of an integrated building model, then you’ll by now have 
realized that BIM removes the concept of drawing lines to represent objects. Instead, you build 
walls, roofs, stairs, and furniture. You model the building and its systems. Figure 1.2 shows a 
3D sectional view of a Revit model. You can see that the model incorporates façade elements, 
floors, roofs, parapets, curtain walls, and materials. All this information is modeled and must be 
designed as it is to be built. You then add information to the drawings to explain the model in 
the form of parametric tags and keynotes. Although the end result is still a set of printed lines, 
you rarely draw these lines. This concept of modeling is so simple, and matches more closely the 
process of building design that you as an architect are familiar with, that you’ll get used to the 
idea in no time.

Revit is excellent at managing changes and keeping your model interconnected. Unlike CAD, 
the intent of BIM is to let the computer take responsibility for redundant interactions and calcu-
lations, leaving you, the designer, with more time to design and evaluate your decisions. With a 
BIM tool such as Revit, be prepared to change your expectations of how to use design software. 
Remember: you are modeling a building now—not drafting lines. You’re doing what you do 
best: solving complex spatial problems.

Figure 1.2 
The BIM model 
keeps you honest 
and focused on 
solving the design 
problems of a 
model, rather than 
managing lines.

56491c01.indd   5 6/2/09   2:41:43 PM



6 | Chapter 1 Understanding BiM: FroM the Basics to advanced realities

Revit Encourages Creativity
Revit’s tools are clustered in easy-to-access ribbon tabs that have collections of logically grouped 
tools. Most of these tools will get you where you need to go with minimal effort. For more 
complicated conditions, be prepared to put your creativity to use. Remember, Revit is a 3D 
modeling application that will let you build almost anything you want. For example, if you can’t 
create the wall or roof you want with the explicit Wall or Roof tool, you can create your own 
custom-shaped walls or roofs using the Model in Place tool. This tool lets you make a 3D solid 
geometry of the wall that you can then assign to the Wall category and that will behave and 
schedule as a regular wall. Figure 1.3 shows an example of custom-designed railings, curtain 
walls, and structural elements—all possible for a creative and engaged designer. These custom 
elements participate in the underlying data structure of Revit, making them schedulable and 
quantifiable.

Every Element in Revit Has Properties
Throughout the design process of a project, you’ll often need to adjust elements and change 
the model. Get used to the idea of clicking the Element Properties button to make interactive 
changes to the model. Better yet, map Element Properties to a keyboard shortcut. A member 
of the Basic Wall family, for example, has properties like width, height, bearing or nonbearing, 
demolished or new, interior or exterior, fire rating, and material. You can even define how layers 
wrap when inserts are placed in the wall, add integrated wall sweeps, and build stacked walls. 
Figure 1.4 shows the assembly options embedded in the type properties of a Revit wall.

Figure 1.3 
Be creative, and 
work out your 
design solutions 
in 3D.
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Elements Interact with Other Elements—All the Time
Remember: there is one model and many ways to look at it, called views; no matter in which 
view you change the model, the change will immediately be updated in all views. And in 
each view, you have total control over what information you want to display. Think of a view 
as a pair of glasses that can filter what you see—but the underlying model is still there, all 
the time. 

A wall in Revit interacts with other walls to produce clean connections and appropriate 
levels of material abstraction. It connects to floors, levels, and roofs; forms rooms; and defines 
areas. Windows and doors placed in a wall move with the wall that hosts them when that wall 
is repositioned. Deleting a wall will delete all windows and doors in that wall and all dimen-
sions associated with the wall. If you move a level, expect floors, roofs, walls, plumbing, and 
electrical features to also move as their parameters change. Keep the interaction of elements in 
mind, especially in multiuser scenarios where your changes to the model will affect many views 
at once.

Duplicating Views Takes Two Clicks
With Revit, you can duplicate floor plan views quickly, allowing you to generate plans as in-
progress working drawings, others for presentation purposes, and still others for final construc-
tion documents (CDs). Note that this is very different from making a copy of a drawing of a 
floor plan: duplicating does not create any copy of elements in a model—what happens is that 
you are simply duplicating a view of the model and you can have as many different views of the 
same model as you wish.

Figure 1.4 
The Element Prop-
erties dialog box 
of a wall contains 
many powerful 
features allowing 
detailed editing of 
the wall assembly.
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Revit Fosters Problem Solving
An advantage of a BIM methodology is that you can’t cheat the documentation of your design. 
Because the elements have properties based on real-life constraints, you’ll find it difficult to fake 
elements within the design. When you get stuck trying to resolve a roof condition, it’s most likely 
that you have a complex roof to solve. You can’t just fake the elevations and call it a day. Of course, 
in CAD-based systems, faking annotations has always been possible and has no doubt led to some 
messy construction administration work. As you move into the BIM world, be prepared to take on 
some early design challenges. 

Figure 1.5 shows what appears to be a simple house model, but it’s more complex than it looks. 
With Revit, you model the dormers, the trusses, and the fascia and soffits. You need to determine 
how the walls and roofs connect to one another—and Revit is well suited to figuring these 
things out.

Revit Lets You Leverage Other Tools to Support Your Workflow
Other software packages, such as SketchUp, Rhinoceros, Autodesk Alias Design Studio, Autodesk 
Maya, and Autodesk 3ds Max, are all excellent 3D modeling applications. While they can produce 
either quick 3D concepts or conceptually complex geometrical shapes, these modeling applications 
don’t have the ability to document fully your design for construction, nor can they be leveraged 
downstream. Note, though, that even if these tools are not BIM, they can still play a role in a 
BIM workflow; many architects use them to generate concept models that can then be brought 
into a BIM application and progress through design, analysis, and documentation. If you prefer 
to work with other tools for concept modeling, doing so isn’t a problem. When the design starts to 
gel, import the geometry into Revit, convert the imported conceptual models into real building 
elements, and start taking advantage of BIM.

Figure 1.5 
To build a BIM 
model, you need 
to solve problems 
in 3D space, from 
dormers to trusses.
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Finally, not everything in a Revit model is modeled in 3D. You can create pure 2D drawings, 
drafting views, and details in Revit; import existing CAD details; and reuse details from other 
Revit projects.

Revit Allows You to Draft
The tools may be a bit different than those in AutoCAD or any other drafting application, but 
there is nothing you can draw in CAD that can’t be drawn in Revit. By using the intelligence of 
Revit families, you can build your details into individual components, thereby embedding draft-
ing elements into the 3D object. Figure 1.6 shows an example of a detail drawn entirely in Revit.

The Family Editor Is a Powerful Tool
Most elements (families) in Revit are made with the Family Editor and can be built with incred-
ibly powerful behaviors. Don’t be afraid to dig in to the Family Editor and explore your creative 
side. We’ve seen many beautiful families and clever tricks put to use that make Revit fun to use. 
Figure 1.7 shows a curtain wall system with nested panels and attachment clamps. As we’ll 
discuss in Chapter 5 and reinforce in Chapter 10, creating such families isn’t too difficult, and 
requires no programming or scripting knowledge. Using 3D modeling tools and parametric 
dimensions, you can create reusable and dimensionally flexible components for any architec-
tural element. By taking your time, being patient, and tackling problem solving, you’ll be pro-
ducing custom content in no time.

Figure 1.6 
2D details can be 
drawn directly 
over the 3D model, 
allowing you to 
add much more 
information to the 
model.
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Revit Does Away with Layers and X-References
If you’ve already made the jump into Revit, then this will already be obvious: rather than user-
defined layers, you use an intelligent architectural classification system to manage visibility, 
graphics, and selection. This may seem stringent at first, but once you get the hang of it, you’ll 
see the benefits. Because a building model is an assembly of meaningful, to-be-built objects, 
you control the visibility and graphics of those objects using a rational list of well-understood 
categories. This also makes it easy to select similar elements and edit them. Figure 1.8 shows the 
list of classifications that manage visibility. You can’t add to or alter this list, which means every 
project enjoys the same level of visual predictability. And of course, with an integrated model, 
you don’t need to worry about referencing other drawings to keep the drawings up to date and 
in sync.

BIM Is More than a Technology Approach: It’s a Change in Process 
One of the powers of Revit is the ability to work in a single-file environment where the design 
and documentation of the building happens on a holistic model. This can be a disadvantage if 
it isn’t taken seriously. Users who are quick to make changes without thinking about how such 
changes will ripple through the model can cause unintended problems. Revit is a parametric 
modeler that maintains relationships between building elements to streamline the design pro-
cess. For example, deleting a roof underlay in a view doesn’t just delete the roof in that view—it 
deletes it everywhere in the model. You need to think before you delete that wall or ignore that 
warning message!

Figure 1.7 
Using the Family 
Editor, you can 
model intelligent 
part assemblies.
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Be prepared to work in much tighter, more collaborative teams. As soon as you enter the BIM 
multiuser world, you absolutely need to be communicating with your team all the time. The 
changes that you make in the model will affect the whole model and other people’s work. We 
think this is a great—perhaps unintended—consequence of moving into a model-based design 
paradigm.

Anticipate that tasks will take different amounts of time when compared to a CAD produc-
tion environment. You’ll perform tasks in Revit that you never had in CAD; and conversely, 
some CAD tasks that took weeks (such as chamfering and trimming thousands of lines to draw 
walls properly or making a door schedule) take almost no time using Revit. On the other hand, 
some tasks may seem to take longer in Revit. This may initially seem true, but remember that as 
you’re modifying or adding something in plan, you’re also adding it in section, elevation, and 
detail. Be prepared to discover and embrace new tasks with BIM that were never part of a 2D 
workflow.

In Revit you’ll often feel as if you are working in traditional types of 2D views—just keep 
in mind that it’s still a 3D model. Moving walls, windows, and doors in plan feels like a 2D 
operation, but of course it’s not. If you’ve never worked in a model-based environment, it can 
be jarring at first to see the drawing you’ve been working on change as a result of an edit in a 
different view. As we mentioned, this becomes even more dramatic when you start working in 
a team and sharing a model. You’ll learn that preventing movement of elements becomes just 
as critical as being able to edit elements in the model. Pinning down grids, levels, and exterior 
walls will become part of your workflow, especially in larger projects with many users working 
in a single file.

Figure 1.8 
The Visibility/
Graphic Overrides 
dialog box contains 
the entire range of 
elements used in 
Revit.
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Revit Is the Most Advanced BIM Application
Revit is the most technologically advanced BIM application, and it’s under highly dynamic 
development. What began as a single tool for architects has expanded into a platform that is the 
base for the structural and mechanical disciplines as well. The evolution of the Revit software 
platform will continue. As with any new technology, you’ll run into problems, get flustered, 
and no doubt pull out some hair. That said, no other application on the market delivers the 
advantages of BIM as well as Revit does. Consider this for a moment: most other architectural 
products in today’s market are based on technology that is 20-plus years old, whereas Revit is 
a new technology that was designed from the ground up as a BIM tool to specifically address 
the AEC industry. From its inception, Revit has had the goal of improving design communica-
tion, coordination, and change management. It has a patented parametric change engine that is 
unmatched in sophistication. It’s also the leading software package in the international market. 
Revit is not the only BIM package out there, but we feel it offers the most holistic approach. 

As you complete more projects with Revit, you’ll begin to understand some of its advanced 
functionality. In this book, we’ll delve into advanced concepts and guide you through some 
really cool features. We’ll touch on the fact that Revit is now a technological platform that sup-
ports architectural, structural, and mechanical disciplines. The fact that you can share a model 
with your structural and mechanical, electrical, plumbing engineers (MEP) without any inter-
mediate translation methods or change to the base environment is an exciting prospect, and one 
that will continue to drive changes in process.

Where Can You Go from Here?
Building information modeling is a revolutionary approach to the design, analysis, and docu-
mentation of buildings that takes full advantage of modern-day computational technology. At its 
core, BIM manages the flow of information throughout the lifecycle of a building-design process, 
allowing you to experience the building before it is built. Using BIM from early conceptual 
design through construction documentation and into construction administration and beyond, 
it’s possible to better predict, plan, and execute the complex task of creating architecture to meet 
today’s demanding requirements.

The flow of information in this new world consists of virtually all imagined inputs that go 
into a building design: the gross area of the building; its impact on the environment; the number 
of windows, doors, and plumbing fixtures; the cost of materials; the size of heating and cooling 
equipment—you name it. All this information is stored in a digital model—a virtual 3D database 
chock-full of information primed for extraction, analysis, and representation. The input turns 
into output in the form of coordinated document sets that can be shared across multiple disci-
plines and that serve as a centralized design-management tool for an entire project.

The AEC industry is at the cusp of a major shift in technology, and the resulting impact on 
building—and by extension the greater environment—will be revolutionary. We can no longer 
build without considering the impact of the building, without considering the building as part 
of a larger network of interconnected flows. The promise of BIM lies in the ability to visualize 
and understand how a building participates in these complex networks: how it performs, how it 
will age, and how it will accommodate and adapt to dynamic economic and spatial requirements. 
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Revit, along with a change in process, can change the way you do business, structure your 
office, present ideas to clients, win new jobs, and ultimately build a new architecture.

Armed with the skills you’ll develop in this book, you’ll be able to take Revit to the edges of 
creative expression and maybe create something as ambitious as the skyscraper in Figure 1.9.

Figure 1.9 
Taking Revit to the 
edges of creative 
expression.
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The Bottom Line

Identify the advantages of building information modeling.    The traditional architectural 
design tools you’ve mastered are probably serving you well. New software and a new con-
ceptual model of the building process will inevitably involve some adjustments, so they need 
to provide significant benefits.

Master It    What are some of the advantages of using BIM over traditional CAD tools?

Know what to expect from BIM.    A BIM project is based on a single, centralized database 
of information. You need to anticipate how that change can affect workflows based on more 
independent functions.

Master It    How can your work process be affected by the adoption of BIM?

56491c01.indd   14 6/2/09   2:41:44 PM



Chapter 2

Revit Fundamentals

The power of a database is that information can be easily accessed, managed, queried, and 
updated. A Revit project is essentially a database that makes it easy to quickly identify elements, 
control their visibility and graphics, and generate reports based on this information. The data is 
highly structured, but you have tremendous liberty when it comes to the representation of that 
data. This flexibility lets you have as many views as you want or need to convey your design 
intent. Every view is a filtered, graphical representation of an underlying database, and you’re 
free to make as many views of this data as you deem necessary.

The sooner you embrace this concept and start exploring the opportunities it presents, the 
better. If you can’t get your drawings to look just right, chances are you just haven’t dug deep 
enough. Throughout this book we’ll give you suggestions and techniques that we hope will 
inspire you to think creatively about how to exploit the data to get the output you want.

In this chapter, you’ll learn to:

Understand Revit parametric elements•u	

Work with the Revit user interface•u	

Modify the Revit user interface•u	

Use the Project Browser•u	

Navigate views and view properties•u	

Understanding Revit Parametric Elements
Every element in Revit is considered a family, and each family belongs to a category. Figure 2.1 
shows the basic Revit object model. In this section, we’ll discuss how Revit organizes all these 
families into categories and why this makes sense from a workflow and consistency point of 
view. We’ll next look at the different types of families, the principles of their behavior, and how 
to create them.
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Revit uses a classification system to organize all the families in the model. This system of 
organization is based specifically on the AEC industry and is set up to help manage relation-
ships between classes of elements as well as the graphical representation for each class. To see 
all the categories available in a Revit project, go to the Manage tab, and from the Project Settings 
panel, choose Settings  Object Styles to open the dialog box shown in Figure 2.2.

At the core of this organization is a fixed list of categories to which all elements ultimately 
belong. Although this may seem stringent, it works well and will help you maintain a consis-
tent graphical representation across your projects. As you can see, every element belongs to a 
category, and that category is either a model or an annotation object. In addition, each element 

Figure 2.1 
The essential  
categorization of 
Revit elements.

2D 3D 2D 3D

Revit Element
(Family)

Category

ModelView Annotation

Figure 2.2 
The Object Styles 
dialog box.
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is either 2D or 3D in nature. Whenever the mouse hovers over an element, a tooltip appears and 
tells you what kind of element it is and what category it belongs to. In Figure 2.3, for example, 
the element on the left is part of an unshared project and omits the workset name. The element 
on the right is part of a workset named Shell and Core.

tooltips Information

If you aren’t working in a worksharing (multiuser) project, then the first bit of text in the tooltip 
tells you what category the element belongs to. If you’re in a worksharing project, the category is 
preceded by the name of the workset containing the element. (See Chapter 24 for more detail on 
worksharing.) The next part of a tooltip tells you the family name, and then comes the family type. 
So, the tooltip follows this logic.

Model Categories
Let’s look quickly at some of the main types of model categories. 

Model Object categories—the first tab in the Object Styles dialog box—include all the real-
world types of objects typically found in buildings. These object categories include elements 
such as walls, floors, roofs, and furniture, along with other categories that make sense in an 
architectural project. 

The model categories Detail Items and Lines are used for elements that represent real-world 
objects used for 2D detailing such as detail components. In Revit, these objects are not modeled 
as 3D elements but added as 2D representations, as shown in Figure 2.4.

For elements that don’t fit into any obvious category, there is the Generic Models category. This 
can be used for objects or parts of an overall assemblage that do not need to be scheduled. An 
example might be a canopy or reception desk. 

Model elements appear by default in all views. In other words, if you draw a wall in plan, 
it will show up in any other applicable plans, elevations, sections, and 3D views. Remember, 
you’re working on a single building model: all views in Revit are just different ways to look at 
the same model. Detail components, on the other hand, appear only in the view in which they 
were placed. If you want them to appear in other views as well, you will need to manually copy 
them to those other views.

Figure 2.3 
Using tooltips to 
define elements. 
The element on 
the left is part 
of an unshared 
project and omits 
the workset name; 
the element on 
the right is part of 
a workset named 
Shell and Core.
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As we’ll discuss in more detail shortly, you can turn the visibility on and off for any category 
or element in any view. For example, imagine you’ve placed furniture in your model. The fur-
niture is 3D geometry that will be visible by default in many views. Revit lets you turn off the 
visibility of the furniture in one floor plan while leaving it visible in another floor plan, or turn it 
off in plan view while having it visible in section view. The furniture isn’t deleted; it’s made vis-
ible or not depending on the information you need to convey in particular drawings.

Because model elements appear in all other views, two types of graphic representation 
are defined for each category: projection and cut, as shown in the Object Styles dialog box in 
Figure 2.2. The projection graphics define the graphics for the element in elevation, 3D views, 
or any other view where the element isn’t being cut by the view. The cut graphics define how 
the element will look when cut by sections and plan views. Typically, the section cut graphic is 
bolder than the projection lines, to emphasize that the element is being cut by the view plane.

Surface and cut patterns are always drawn with line weight 1 and can’t be made thicker.
Figure 2.5 shows how the wall line weight differs between cut and projection. Also notice 

that patterns are applied to the walls and floors. Patterns can be added to give additional 
graphic representation to a material and are always drawn with a thin line weight. 

Categories also make it easy to interchange elements. You can swap out elements of the same 
category with another type of element with only few clicks of the mouse. This deliberate limit-
ing of choices to only those that make sense is what streamlines the process of swapping out 
types of elements. For example, you can swap a lighting fixture with another lighting fixture 
by selecting the element and then seeing what other lighting fixtures are available in the Type 
Selector. Choosing another type swaps out the type instantly.

Revit is smart about this interchange—it offers only different types of the same category of 
elements. For example, when you select a door, you don’t get a list of plumbing fixtures or win-
dows to swap it with; you get a list of other door families.

Figure 2.4 
Details such as 
this steel connec-
tion at the roof are 
composed of 2D 
elements.
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Annotation Categories
Annotation Object categories include all the annotations, symbols, and descriptive data added 
to a view to describe the building. These are listed in the second tab of the Object Styles dialog 
box. Most annotations are view-specific 2D elements and appear only in the view in which they 
were created. Examples include dimensions, tags, callouts, and text notes. Annotations such as 
sections, levels, and grids are 2D graphics, but they have 3D characteristics and appear in other 
views. These elements (levels, grids, sections) appear in many views thanks to BIM application 
functionality. Levels, grids, and section marks extend throughout the model and can be edited 
from multiple views. You don’t need to draw these elements in each view as separate, discon-
nected graphics. With Revit, they’re truly 3D annotations. (Levels, grids, and section marks never 
appear in 3D views.)

Dependent Views

There is an exception to the rule that annotations appear only in the view in which they were placed. 
With dependent views, annotations are shared between views, so that if you change the annotation 
in one view, it affects other views as well.

Figure 2.5 
Cut and projec-
tion graphics are 
defined for each 
element.

Cut lines

Projection lines
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Subcategories
Within each category are many subcategories that let you control the graphics of an element 
with finer precision. This is what makes the concept of categories so much more powerful and 
natural to work with than layers. Go to the Manage tab, and in the Project Settings panel, choose 
Settings  Object Styles, and look in the Modeling tab at the Door category: you can see that 
the category Doors (Figure 2.6) has a set of subcategories that relate to subelements in the door 
assembly, such as Elevation Swing, Frame/Mullion, Glass, Opening, Panel, Plan Swing, and 
any other user-defined elements that can be made when creating a door family. For each subcat-
egory, independent line weight, color, and pattern can be assigned.

Imported Categories/Subcategories
When a CAD file is imported into Revit, all of its layers are represented as subcategories in the 
Imported Objects tab of the Object Styles dialog box. Layers have a projection line weight, a 
color, and a pattern.

Imported File Limitations

There is no Cut line style for DWG, DXF, and DGN files. These files are just sets of lines, and lines 
can have only one line weight.

These can be overridden at any time to suit your requirements. Each import appears as a cat-
egory in this dialog box, as shown in Figure 2.7. There is no need to remap CAD layers into Revit 
taxonomy. If you’re used to the layer conventions set up in CAD, these will be mapped directly 
into the Object Styles dialog box with the same names, line weights, and colors. This is true unless 
you have consciously chosen Invert Colors during the CAD import.

Views
Views are also considered parametric elements in Revit, and they have many properties to help 
you define how they should display information. A view doesn’t change the model in any way—
it only acts as a filter through which you view the model. This also applies to schedules and 
material take-offs. Although schedules are more abstract ways to think of a view, they’re still 
parametric views into the model. Throughout the book, you’ll be asked to make views, and we’ll 
guide you through various methods for making views convey specific information about your 
design.

Figure 2.6 
Subcategories 
allow finer  
graphic control 
over categories.
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Type and Instance Parameters
A parametric element is something that can change size, material, and graphic look but is still the 
same fundamental element. Most elements in Revit are designed with parameters that allow for 
the creation of variations of a base type. Take a typical Revit door family as an example. Each 
family can have many types built into it, where each type typically represents a variation in 
size, material, color, or other defining characteristic. Although each type can vary in shape and 
size, the base geometry for each type is derived from the same family.

the Difference between CaD Blocks and Families

In a typical CAD environment, for each size of the same door you might create a separate block; 
each of those blocks would be a separate element unrelated to any of the others. So, 20 door sizes 
would mean 20 floor-plan blocks, 20 (or 40) section blocks, 20 elevation blocks, and 20 3D blocks if 
you were going to use them as liberally as we use them in Revit. All of those in Revit are represented 
with one family that can display itself in 2D and 3D and whose size, material, and visibility can be 
changed at any time.

Depending on how the family is built, parameters can affect either the type or the instance. A 
change of type parameters affects all instances of this type in the same family used in the model, 
whereas instance parameters affect only the selected instance. This is an important distinction: you 
can change instance properties only when you have an element selected, but you can change type 
properties without selecting anything.

Figure 2.7 
Imported CAD lay-
ers represented as 
subcategories.
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Consider a round table. You might define its shape using a type parameter for the radius. If 
you placed 20 types of tables with a 2’ (60cm) radius and then changed that radius to 3’ (90cm), 
all 20 tables would update automatically. Now, if the radius parameter were an instance param-
eter, changing the radius would affect only the table you currently had selected. The same logic 
can be applied to other dimensional constraints and materiality. Revit forces you to consider 
what an element is and what it means to change the element’s defining characteristics. For 
example, most content in Revit doesn’t let you arbitrarily change dimensions of every instance, 
on the fly, whenever you want—this would make tracking the notion of object type difficult and 
would make mass-updating more tedious. Think of a type as something you’ll eventually have 
to schedule, spec, and install as a real-world commodity.

Bidirectional Relationships
Objects with parameters that can be edited are nothing new in the world of software. But what 
makes Revit unique is its ability to go beyond 3D objects with parameters and create relation-
ships between objects. This ability, which includes the parametric relationships and the under-
lying change engine, is a core technological advantage built into Revit.

For example, walls can be attached to a roof, and if the roof changes to a new shape or size, 
all walls attached to the roof automatically adapt to the roof shape. Figure 2.8 shows that chang-
ing a roof pitch automatically adjusts other roofs and walls to keep them joined.

Another powerful manifestation of interrelationships occurs among walls, floors, roofs, com-
ponents, and levels. They all have explicit relationships to levels, so that if a level changes eleva-
tion, all elements associated with that level update automatically. Not only do the bases of the 
walls attached to a level change, but the tops of the walls attached to this level also change. This 
is fundamentally different from other BIM software applications, where elements understand 
the relationship with the level on which they are placed but not the level to which they extend. 
Thus, if you change the height of a story (level), there will be a gap in the walls, columns, and 
other elements, and, due to the lack of relationship to the level above, they will not understand 
that they need to become taller. Similarly, when you change the size of a room by moving walls 
to new positions, you’re changing not only the wall positions but also everything those walls 
affect in the model: the size of the room (area and volume), color-fill schemes applied to the 

Figure 2.8 
Changing the roof 
pitch updates walls 
automatically.
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rooms, and the shape and size of ceilings and floors. Doors, windows, and any other wall-hosted 
elements, such as light fixtures or sockets, will move with the wall when the wall changes posi-
tion, and any dimensions to that wall will automatically update.

Revit tries to keep things joined and connected in order to eliminate huge amounts of tedious 
editing. You’ll begin to take it for granted after a few days with Revit, but remember: when 
you drag a wall that has other walls attached to it, those other walls will automatically stretch 
with your move. Not only that, but rooms, dimensions, floors, components, and tags will also 
move. Of course, if you don’t want all this intelligent behavior, Revit provides other options. For 
example, if you right-click a wall’s end control, you can disallow it from joining other walls (see 
Figure 2.9). Or you can select Disjoin available in the Options bar once you’ve selected a wall, 
and then selected the Move command—doing so will detach the smart relationships between 
the wall and the rest of the model and treat the wall as an independent entity.

This parametric behavior extends to annotations and sheet management as well. Tags aren’t 
simple graphics and text; they’re interactive graphical parameters of the element being tagged. 
To edit a tag is to edit the element or tag family, and vice versa. This is also known as a bidirec-
tional associactivity. You can edit the elements and the tag and maintain consistent data. A great 
example is easily demonstrated with a view and a sheet. When you place a section view onto a 
sheet, the section key automatically references the sheet number and detail number on the sheet. 
Change the sheet number, and the section tag updates instantly. This is what a real parametric 
engine is and what ensures total coordination of documentation. You’ve probably heard this 
phrase before, but it’s worth repeating: the parametric engine guarantees that a “change any-
where is a change everywhere.”

adjusting a Level and roof Slope to Meet Design requirements

In a real-world project, the height of a level is bound to change in the design process, which in 
turn will change floor-to-ceiling heights and roof locations and will influence the building’s overall 
height. Consider a scenario in which keeping the top of the roof below a maximum height was a 
design requirement. Not to worry—with Revit, changing the height of levels (floor-to-floor heights) 
at any point in the process updates all dimensions and elements associated with that level.

Figure 2.9 
By right-clicking  
the end of a wall join, 
you can stop the wall 
from autojoining to 
other walls.

56491c02.indd   23 6/3/09   10:27:11 AM



24 | Chapter 2 Revit Fundamentals

If changing the Roof level pushes the roof peak too high, this is easy to fix. By editing the roof and 
changing its slope parameter, you can lower the roof height, and all the walls attached to the roof 
update to reflect the change. There is no need to edit the walls independently in order to get the 
correct results.

With one edit, you change the roof height. The walls and roof update immediately. 

With an edit to the roof property for slope, the roof updates, as do the walls attached to it.
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Constraints
During the design phase, you may want to apply some dimensional rules to the design and 
make sure they aren’t altered. These rules might be a minimum hallway width for code compli-
ance or a maximum office square footage for a particular user. Whatever the restriction, Revit 
dimensions make it possible to lock it down and create a constraint. This constraint is indepen-
dent, but it’s related to the dimension. If you delete the dimension, you can keep the constrained 
condition and know that the model will maintain those relationships. The point is that a dimen-
sion can be much more than a 2D annotation.

These design rules are used all the time, but not many software applications let you capture 
this design intent in the model. If you run a dimension string from level to level and lock the 
dimensions (as in Figure 2.10), you’re locking the relationship between these elements in the 
whole model. By locking down elements, you make it harder for other elements in the model to 
break this important design intent and thus keep the model more intact and predictable.

Some practical examples of situations in which this is particularly useful are when you want 
your door jamb always positioned 4” (10cm) from the wall corner; or you want three windows in 
a room to be always positioned at equal distances throughout the length of the exterior wall in a 
room. By defining and locking these relationships, you embed design intent into the model. And 
these relationships will react to any later change of the model; if the side wall moves, the door 
will move as well, to keep the locked 4” rule; or the windows will reposition to maintain the rule 
of being equally spaced.

Other, Less explicit Ways to associate elements to One another

Revit also provides a less explicit, automatic way to associate elements to other elements. When 
an element is selected, there is an option to make the element move with nearby elements in the 
Options bar; Revit will make its best guess as to which elements drive other elements to move. Good 
example of this is to have a bed move with the nearby wall.

Figure 2.10 
Design intent  
can be locked 
down by adding 
constraints.
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Revit Families
Revit families are used to create your model. There are three overarching methods for creating 
families in Revit:

System families•u	

Component (Standard) families•u	

In-place families•u	

The difference between them lies in their creation method, in what context they’re created, 
and the types of parameters available. Let’s review each of these types of families.

SyStem FamilieS

Model system families are made up of a limited set of categories: walls, roofs, floors, ceilings, 
stairs, railings, ramps, mullions, curtain panels, mechanical equipment, and toposurfaces 
(topography). See Figure 2.11 for examples of system families. These families are created in the 
context of each project, using some predefined types. These families also have various creation 
methods that are specific to the type of the family. For example, to make walls you can just start 
drawing (placing a wall), whereas to make a floor or roof, you enter a Sketch mode in which you 
define the outer shape with lines that then generate a 3D model of the floor. For stairs and rail-
ings, you enter a more detailed Sketch mode that has additional features not available for floors 
or roofs. When making toposurfaces, you use a Sketch mode that lets you edit 3D points specific 
to toposurfaces. As you can see, system families all have slightly different creation methods.

You can create new types of system families by duplicating existing types and editing their 
parameters. If you’ve been using Revit for any length of time, then this method of duplicating a 
type to create new types should be familiar territory for you.

You can’t create new categories in Revit. These categories are predefined within Revit and 
limited to the list available. This is primarily to maintain control over the graphics from project 
to project.

Figure 2.11 
System families.

System Families

Walls

Toposurface

Roofs
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If you aren’t sure whether an element is a system family, open the Element Properties and in 
the Instance Properties dialog box, check the family name. If the element is a system family, it 
is embedded in the family name. Figure 2.12 shows that Basic Wall and Section are both system 
families.

System families are also used for many annotation categories, such as sections, elevations, 
levels, grids, text, and dimensions—they aren’t limited to model elements.

Another characteristic of system families is that you can’t save them outside of your project to 
a shared library as a standalone component. Even so, it’s still possible to reuse system families in 
other projects. To transfer system families between projects, go to the Manage tab, and from the 
Project Settings tab, choose Transfer Project Standards to display the Select Items to Copy dialog 
box (Figure 2.13). This dialog box gives you a feel for the number of different types of system 
families used in a Revit project.

Component FamilieS

Component or “standard” families (see Figure 2.14) are created outside of the project environ-
ment using the Family Editor. They’re stored in an external library (folders on your hard drive) 
and can be loaded into a project for use at any point. Every component family belongs to a spe-
cific Revit category so that when it’s loaded into a project, it adopts the graphic rules defined 
for its category in the Object Styles dialog box. This guarantees graphic consistency throughout 
your project without your having to manage changes to new families constantly. This also guar-
antees that when you schedule a category, you get all elements that belong to that category.

For example, if you find a lighting fixture family on the Web and load it into your project, 
it will use the Lighting Fixtures object style in your project to represent the family. It will be 
scheduled with other lighting fixtures. You aren’t forced to open the family and adjust line 
weights or colors or add metadata to the element, because this is all controlled at the project 
level. This illustrates the value of having a fixed number of categories to manage—you can rest 

Figure 2.12 
System families 
include model  
and annotation 
elements.

Figure 2.13 
The Select Items to 
Copy dialog box.
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assured that the project won’t inflate with endless, oddly named layers that are difficult, if not 
impossible, to decode.

Component families have their own file format extension (.rfa) and can be stored outside 
the project environment for later use in other projects. Revit ships with a predefined folder 
structure to help manage the vast numbers of families available. Go to the Insert tab and from 
the Load from Library panel, choose Load Family to see how Revit organizes information (see 
Figure 2.15).

Figure 2.14 
Component (stan-
dard) families.

Windows

Entourage

Door

Figure 2.15 
The Load Family 
dialog box.
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Organizing Your Office Library

In your office you’re free to organize your families in whatever way makes the most sense. You can 
use a read-only, shared office library or per-project mini-libraries. Whatever route you go, be sure 
to add your library locations to your Revit file load dialog box.

To do this from the Load Family dialog box, browse to your office library and choose Tools  Add 
Current Folder to Places, located at bottom of the dialog box. The folder will appear in the list of 
default folder locations.

 

Another option is to use the Options dialog box located in the Applications menu. To open it, go to 
the Applications menu and click the Settings button located at the bottom right and then click the 
File Locations tab. Add a new path to the Libraries table.
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Once you do this, a new link appears in the Open dialog box with the name of your library. Clicking 
the icon takes you directly to your office library.

To create variations of a component family, duplicate an existing one in the project and mod-
ify its properties. To make more radical geometrical changes to the family, you need to open it in 
the Family Editor and change the form there. The process of editing a family supports an itera-
tive design workflow: by selecting any family, you have the option either to edit its properties 
or to open it in the Family Editor and make changes to it and then load it right back into your 
project. Families can be complex, but at least you won’t need to learn any specialized scripting 
languages to create smart, parametric content. This goes for all forms of component families, 
from totally parametric windows and doors to one-off pieces of furniture or lighting fixtures.

Revit provides a set of starting family templates you can use to make content from scratch. 
When you want to start creating a new library element (family), you first need to select the cor-
rect template. To open a template, go to the Application Menu and choose New  Family. Choose 
the type of element you want to make, and the template will open. Embedded in each template 
are smart behavior characteristics of the family you’re creating. Figure 2.16 illustrates a door 
family template, where geometry, parameters, and dimensions are already in place to help you 
get started.

Doors, windows, balusters, casework, columns, curtain wall panels, entourage, furniture, 
massing elements, generic objects, and plantings are all examples of standard Revit family 
categories.

To move families between projects, you can copy and paste them or save your families to disk 
and then load them into another project.
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in-plaCe FamilieS

In-place families are custom elements that are specific to a project and the conditions of the 
project. An in-place family accesses functionality available in the Family Editor in the context 
of a project environment. The model grays out and becomes unselectable when you make such 
families. A nonvertical, sweeping wall shape is a good example for when you would use an in-
place family.

You can copy and paste in-place families from project to project, but you can’t save them as 
RFA (Revit projects have the extension .rvt, Revit families .rfa) as you can with standard fami-
lies. Figure 2.17 shows an in-place family added to a façade in order to create some nonorthogo-
nal mullions.

Using In-place Families

There are some more advanced features of building information modeling that you will inevitably 
want to pursue, such as energy modeling or daylighting or direct-to-fabrication. Some of these 
features do not interface well with in-place families. Try to limit your use of in-place families if 
possible.

Figure 2.16 
The template for 
this door family 
includes geometry, 
parameters, and 
dimensions to help 
get you started.
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Overriding the Representation of Elements
There are no layers in Revit. Revit uses object categories and subcategories (not layers) to define 
the graphics for each element class as well as to control visibility (which is the purpose of layers 
in other software). The Object Styles dialog box (accessed from the Manage tab, in the Project 
Settings panel, under Settings) establishes the default graphics for every category; however, in 
any view, you can override these graphics using the Visibility/Graphics Overrides dialog box 
(on the View tab, in the Graphics panel click Visibility/Graphics) shown in Figure 2.18. The two 
dialog boxes look very similar—the difference is that Object Styles shows the defaults preset 
for a project, whereas Visibility/Graphic Overrides is the place to review and make changes to 
those default settings on a per-view basis. The same familiar categories and subcategories dis-
played in the Object Styles dialog box are displayed in this dialog box as well.

The same level of visual control for line weight, color, and pattern is provided here but in a 
slightly different interface. In addition to line overrides, you can override cut and surface pat-
terns and choose to show a category as halftone, transparent, or at a different level of detail. 
Figure 2.19 shows the Roof category overridden to be transparent in the 3D view, allowing you 
to see through the roof and look into the rooms beneath while keeping the shape of the roof vis-
ible. Changes made using this dialog box are applied only to your current view.

Figure 2.17 
Example of an in-
place family used 
to add skewed mul-
lions to the façade.
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Figure 2.18 
The Visibility/
Graphic Overrides 
dialog box.

Figure 2.19 
The Roof category 
has been over-
ridden to be  
transparent in  
the 3D view.
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The same categories are used to control the visibility of elements in a view. You can turn off 
entire categories, subcategories, or individual elements in any view.

Working with the Revit User Interface
In this section we look at how Revit appears out of the box when you first open it and familiar-
ize you with how the interface is organized. One of the things you’ll notice from the beginning 
is that Revit is tailored for the architectural design community. The tools, commands, and 
objects that you use in Revit are based on tasks and requirements taken directly from the prac-
tice of architecture.

If you have used earlier versions of Revit, you will notice that the user interface (UI) of Revit 
2010 is dramatically different from its previous version. Revit, along with an entire family of 
Autodesk products, has moved to the “ribbon” paradigm, allowing both easier use of Revit itself 
and easier adoption of multiple Autodesk products that have a similar user interface. To help 
current users, we will be calling out the location of certain commands that we believe are not 
obvious in their placement in the new ribbonized UI.

Starting Revit
There are several ways to start Revit: by double-clicking the Revit icon that was automati-
cally created on your desktop during installation, by going to C:\Program Files\Revit 
Architecture 2010\Program and double-clicking Revit.exe, or by double-clicking on any file 
with the .rvt extension.

The Start Screen
When you start Revit, you should see the screen shown in Figure 2.20. (However, when you first 
start the new product, you might not see any project thumbnails, as they only show once you 
have worked on projects.)

Figure 2.20 
The Revit 2010 
startup screen.
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The startup screen is also redesigned to this release of Revit 2010, offering the following 
possibilities:

Projects:

Open a recent project (select one of the preview thumbnails)•u	

Open any existing project (click the Open button)•u	

Create a new project (click the New button)•u	

Families:

Open a recently created or modified family (select Open under Families)•u	

Create a new family (click the New button)•u	

Create a new Conceptual Mass (click New Conceptual Mass )—this option is new to  •u	

Revit 2010

Link to the Revit library on the Web (click the Web Library button)•u	

The User Interface
The Revit interface (Figure 2.21), new to Revit 2010, is conceptualized around the ribbon para-
digm: a simple idea of grouping workflow-based functions and tools in separate ribbons and 
exposing only task-relevant options to the user, saving workspace and making the UI less 
overwhelming. 

Figure 2.21 
The Revit  
interface.
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appliCation Frame overview

The application frame has nine main parts, which we’ll now discuss in the following sections.

Application button•u	

Quick Access toolbar•u	

Info Center toolbar•u	

Status bar•u	

The Ribbon itself•u	

Options bar •u	

Drawing Area•u	

View Controls •u	

Project Browser•u	

Let’s take a look at each of these components.

The Application Menu    The big purple R letter on top left of your screen (Figure 2.22) is what 
we will be referring to as the application button. Pressing this button opens the Application 
Menu, which offers options for creating new projects or families; opening existing projects or 
families; saving projects or families; exporting the project in various CAD, schedule, and 
other formats; and publishing and printing. The Application Menu also displays the licens-
ing information. All of this will be more or less extensively covered in the remainder of this 
book. In this chapter we will discuss in detail only those features that will not be covered 
later in the book.

Figure 2.22 
The  
Application Menu.
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At the bottom right of the Application Menu, you will also find the Options button, which 
hosts options for various project settings. (Figure 2.23). Located in various tabs are different 
settings that you can change to accommodate your decisions about file location selection, 
rendering path, settings relevant to the SteeringWheels, the view cube, spelling, and macros, 
as well as some general settings such as setting the username, saving reminder intervals, and 
setting the application frame display theme.

The Quick Access toolbar    The quick access toolbar (Figure 2.24) is located at the top left of 
the application frame and is new in Revit 2010. It enables quick access to the most-used com-
mands such as Open, Save, Undo-Redo, and Switch to 3D View, as well as options for forcing 
synchronization of local files to the central file when in a worksharing environment.

InfoCenter    The InfoCenter is also new in the Revit 2010 interface. The Info Center toolbar is 
located in the same zone as the Quick Access toolbar and the title bar, on the far top right of 
the applications frame (Figure 2.25).

Figure 2.23 
The Options  
dialog box.

Figure 2.24 
The Quick Access 
toolbar.

Figure 2.25 
The InfoCenter 
toolbar.
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Links to a variety of information sources are located in the Info Center toolbar. From left to 
right, the first feature is a search field where you can type a term (function, feature) that you 
are searching for. The search function (binoculars icon) looks into the Revit help file as well 
as various resources on the Web, thanks to the Autodesk Online services. The Subscription 
Center (key icon) links to various benefits and services available only to subscription users 
are accessible. The Communication Center (satellite dish icon) links to product updates and 
various product announcements. The favorites button (star icon) links to topics you identify 
as your favorites throughout your work with Revit. To add topics to your favorites, click the 
icon that appears next to the link on the Info Center Search results panel, Subscription Center 
panel or Communication Center panel. The last button is the help button, which links to the 
Revit Architecture help directory.

The status bar    The status bar is located at the very bottom of the application window, on 
the far left. Here you will see helpful text that describes what you have selected and what you 
should do when in a command. Whenever you aren’t sure what the next step should be, look 
at the status bar. See Figure 2.26 for three examples of the status bar in action.

To the right of the status bar, in the same zone, you will find two more useful tools: the Count 
Selection tool and the Press & Drag option.

Count Selection tool    The Count Selection tool is located on the far right in the same 
zone as the status bar. The Count Selection tool gives information about the number of 
Revit elements currently selected.

Clicking anywhere over the Count Selection tool invokes the Selection Filter dialog box, 
where you can narrow a selection if needed. You can also access the Count Selection tool 
by clicking the Filter button located in the Ribbon under the Multi-Select tab (a tab that 
is activated automatically upon multiple selections of elements of different categories) 
(Figure 2.27).

Figure 2.26 
The status bar 
when (top) select-
ing or hovering 
over a wall,  
(center) drawing a 
wall, and (bottom) 
using the Rotate 
command.

Figure 2.27 
The Filter com-
mand appears in 
the Ribbon upon 
selection of  
multiple elements 
of different  
categories.

56491c02.indd   38 6/3/09   10:27:16 AM



WoRking With the Revit useR inteRFace | 39

Next to the Count Selection tool, you will find a check box for Press & Drag. What that 
means is that when this option is checked, you can drag an element without having to 
select it.

The Ribbon    The newly introduced Ribbon stores all Revit commands and tools necessary 
to create and edit your project information. The Ribbon displays automatically by opening a 
file or creating a new project in Revit. 

The Ribbon can be minimized for maximum use of the drawing area and has three different 
display settings (Figure 2.28) accessible by selecting the drop-down arrow located to the far 
right of the tabs part of the Ribbon:

Full Ribbon (displays the Ribbon in all its glory)•u	

Panel tiles (semi-minimized state of the Ribbon that shows only the Panel and •u	

Label tabs)

Tabs•u	

The Ribbon is organized in tabs that are themselves organized in panels. Each panel holds 
logically connected tools for executing a certain type of activity.

Figure 2.29 shows the Home tab. It has seven panels containing the creation tools for almost 
all modeling elements in Revit.

Let us just spend few minutes explaining the logic of the ribbon. 

There are eight tabs in Revit: Home, Insert, Annotate, Modify, Massing & Site, Collaborate, 
View, and Manage. The Family Editor has one additional tab called the Create tab. 

Figure 2.28 
Different display 
settings of the 
Ribbon—from top 
down: Full Ribbon; 
Panel tiles, Tabs.

Figure 2.29 
Organization of  
the Ribbon.

Panel

Tab
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Home    The Home tab contains all tools necessary to build 3D elements in Revit or to cre-
ate the building model. 

Create    Available only in the Family Editor, the Create tab gives you a set of tools neces-
sary to create a family. 

Insert    Raster images and CAD files are often inserted in a Revit file as a help/support 
or as additional information for your project. This tab contains tools for importing and 
managing these files. 

Annotate    To describe or enhance the display of the building model, we often use 2D 
elements. This tab contains all the tools for adding 2D elements in the project. 

Modify    Once they are created, all elements need to be changed or edited. This tab con-
tains all editing tools. You first need to select the element to be edited and then the tool to 
edit it. 
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Massing & Site    Creating and modifying conceptual mass studies is a way to start a 
project in Revit. You will find all conceptual massing tools under this tab. 

Collaborate    It is rare that only one person works on a project. Tools that aid in collabo-
rating on the same project and managing that collaboration are located under this tab. 

View    The Revit project is described through many views that are different queries of the 
Revit database. Tools for creating and managing those views are located under this tab. 

Manage    Design options as well as many project-related settings and options are all  
located here.

If you notice additional tabs on your Revit ribbon, you (or someone you work with) probably 
have installed some separately purchased add-ins. 

We have now covered almost all you need to know about the ribbon interface of Revit. To fin-
ish up, we just want to turn your attention to a few tools that are somewhat invisible or are hid-
den in the expanded panels and dialog launchers. 

Expanded panels    These are accessible upon selection of the drop-down arrow at the bottom 
of a panel. When you expand the panel, additional tools and controls will be displayed. To keep 
a panel expanded, click the push-pin icon in the bottom-left corner of the expanded panel.
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Dialog launchers    These are types of panels that when expanded, allow you to access addi-
tional settings or complete a task. A dialog-launcher arrow on the bottom of a panel opens a 
dialog. For example, the Structure panel has a dialog launcher. Clicking the arrow opens the 
Structural Settings dialog box. 

Dialog Launcher

As you work on a project, the contextual tabs automatically change to reflect what tool 
has been selected. If, for example, you select the Wall tool from the Home tab, the Place Wall 
contextual tab (Figure 2.30) will automatically appear, offering options for placement of new 
walls of that type, different shapes of the wall segment (straight, curved), as well as access to 
the Element properties of the Wall tool. This contextual menu will be automatically closed the 
moment you quit (escape) the Wall command. That is basically the principle that is applied to all 
Revit tools.

The principle of contextual tabs is also applied when modifying elements. If, for example, 
you select one or multiple walls, a new contextual tab called Modify Walls (Figure 2.31) will be 
displayed on the Ribbon, offering tools that are logically dependent on your selection. The con-
tent of these contextual menus thus depends on what has been selected. As in the previous case, 
the moment the selection is undone, the contextual tab closes.

Note that in both of the mentioned cases, the Element panel is present. This panel is very 
important as it contains the Type Selector available under the Change Element Type button) and 
the Element Properties button. 

The type selector allows selection of a family type. For example, for the Wall object (Wall 
family) you will find in the Type Selector a list of all available wall types in the project. For the 
Door tool, all door types available in the project will be listed under the type selector. 

Figure 2.30 
The contextual 
tab Place Wall is 
displayed while 
adding a wall.

Figure 2.31 
The contextual tab 
Modify Walls is 
displayed when a 
wall is selected.
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A notable improvement of the type selector in this release of Revit is that it gives you a little 
visual preview of the types in the list and then lists all sizes of the type (Figure 2.32).

Also new and improved in this release is access to Type properties. You can directly access 
the Type properties of an element without having to go through the Instance Properties dialog 
box. To do that, just expand the Element Properties button and pick Type Properties (Figure 2.33). 
Click the small arrow on the right-hand side of the Element Properties button to display a menu 
where you can choose to open Instance or Type properties.

Some elements in Revit are created starting from a sketch. Examples include floors, ceil-
ings, roofs, and stairs. A sketch is a collection of 2D lines that will define the base shape for a 3D 
object. The sketch tools vary depending on the object you will be creating or modifying (see 
Figure 2.34). A roof sketch becomes a roof by definition of the sketch shape as well as slopes of 
the roof; the stair sketch on the other side consists of the lines that defined the run, the landing, 
and so on. As a visual aid, the color of the background of the buttons in Sketch mode is change-
able: It turns green and the button is automatically closed the moment you accept or cancel the 
line work. 

One very useful addition to this new edition of Revit is the tooltip that appear when you 
hover over any of the tools in the panels. The tooltips appear in two levels: the first is just a tex-
tual description and the second textual description supported by visual graphical image as help 
for the description. To display just the first tooltip leave the mouse over any of the tools for one 

Figure 2.32 
The Type Selector 
displays only the 
type of element 
that is selected or 
being created.

Figure 2.33 
Click the small 
arrow on the right-
hand side of the 
Element Properties 
button to expand 
the menu where 
you can choose to 
open Instance or 
Type properties.

Figure 2.34 
The tools to cre-
ate a stair are 
displayed auto-
matically in a con-
textual tab.
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second. If you want to see the visual tooltip, leave it a bit longer, approximately two seconds, 
over the tool in question.

If you have already used previous versions of Revit and cannot find some of the commands 
displayed in the old UI, go to the Where Is My Command? tool located in the list that appears 
when you click the Help button in the Info Center.

The Options bar    The Options bar is located right below the Ribbon. Its content varies 
depending on the selected element that needs to be created or edited. Its purpose is to offer 
options relevant to that tool. In Figure 2.35, you can see four examples of how the Options bar 
looks when different elements or tools are selected.

Figure 2.35 
The Options bar 
changes for differ-
ent tools. From  
top down: Options 
bar for dimensions, 
walls, windows, 
and model  
in-place mass.
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The View Window
The View window is where all the action takes place. Here you add elements, modify them, 
and construct and document your model. The view area can tile multiple views, allowing you 
to visualize the model from multiple vantage points concurrently. We don’t recommend tiling 
the views if you have more than six or so open views because the views get too small and it 
becomes difficult to work effectively.

To arrange views, go to the View tab and in the Windows panel try the Cascade or Tile 
option. You’ll also see the option Close Hidden Windows.

The Close Hidden Windows feature is a great way to clear your workspace when you have an 
unmanageable number of views open. Selecting Close Hidden Windows closes all but one view 
for each project or family you have open. This is advisable to improve performance when you’re 
working on a complex project.

Views in Revit show the same model from different vantage points. Thus, when selecting an 
element in one view, you’ll see that the element becomes selected in all views. You can try this 
by opening two views (click on the view names in the Project Browser) and tile the views (View 
tab, Windows panel, Tile). This simple interaction shows that when you make a change to an ele-
ment in one view the change is instantly reflected in other views. This is a great way to concep-
tually understand the reality of a true BIM modeler.

view ControlS

Each view has properties, and some of these properties are exposed at the bottom of the View 
window in what is called the View Control bar (Figure 2.36).

These controls allow you to change the display of the view quickly without having to dig into 
a Properties dialog box. The available controls include View Scale, Detail Level, Model Graphic 
Style, Graphics Display Options, Rendering, Crop View, Show Crop Region, Temporary Hide/
Isolate, and Reveal Hidden Elements.

SteeringWheel and View Cube
Whenever you open a 2D view in a project, you will see a floating palette located on the far right 
of the View window. (Figure 2.37). That palette is called Navigation bar.

Figure 2.36 
The View  
Control bar.

View 
Scale

Detail
Level

Model
Graphic
Style

Graphics
Display Options

Crop
View

Show
Crop
Region

Reveal 
Hidden
Elements

Temporary
Hide/Isolate

Render
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In a 2D view, in the Navigation bar you will see two tools: the Full Navigation Wheel and 
the Zoom tool. Upon selection of the Full Navigation Wheel, the SteeringWheel appears on the 
screen; it follows (travels with) the mouse to provide quick access to the navigation tools in the 
context of the work you do. When placed in 2D view, the wheel looks like Figure 2.38 and offers 
three functionalities: zoom, pan, and rewind.

The SteeringWheel in 3D view looks slightly different, as shown in Figure 2.39, which dis-
plays the Full Navigation Wheel. You can choose different versions of the Navigation Wheel by 
expanding the list that appears when you select the arrow below the wheel icon on the floating 
palette. You can set the default appearance of the SteeringWheels from the Applications menu at 
the same time as you select the Options button and the SteeringWheels tab.

The Project Browser
The Project Browser allows you to navigate to all your views, create new views, access element 
properties, and place elements. All the views (including schedules and sheets), families, and 
linked files of your project are stored here, making it possible to organize and navigate through 
a project from one location. 

Figure 2.40 shows a collapsed view of a typical Project Browser. 
The Project Browser is the backbone of your project. We’ll devote much of the rest of this 

chapter to exploring its use.

Figure 2.37 
The Navigation bar.

Figure 2.38 
SteeringWheel tool 
in 2D view allows 
for zoom, pan,  
and rewind.

Figure 2.39 
The full Navigation 
Wheel in 3D view.

Figure 2.40 
The Project 
Browser shows the 
range of elements.
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Modifying and Personalizing the Interface
Revit 2010’s new ribbonized UI in can be changed and customized, although not to the extent 
permitted by other software applications. This feature is new in this release of Revit. A full cus-
tomization and change of the UI are still not possible, but you can make certain changes to it, 
such as changing the panel order or moving a panel off the Ribbon to your desktop.

This version of Revit also supports double screens, a response to a longstanding wish of the 
current users. 

You can make the following changes to the UI: 

Change order of panels    You can change the order of the panels within the contextual tabs 
and also undock a panel from the Ribbon so to have it floating in the workspace and visible at 
all times. Figure 2.41 shows the Build panel undocked from the Home tab. With the double-
screen monitor support you can position the floating menu on the second screen. To modify 
the order of the panels in the contextual tabs, click the title of the panel, hold the click, and 
move to another location. 

Return panels to the Ribbon    Once you’ve undocked it, you can place a floating toolbar 
back on the Ribbon by hovering the mouse over the undocked, floating bar and clicking the 
arrow that will appear on the top right of the dialog box that opens that activates the com-
mand Return Panels to Ribbon (Figure 2.42).

All changes that you are making to the UI are memorized and stored so that they are there 
each time you open Revit from zero.

Restore original settings    If, however, you played around with customization of the UI a 
bit too much and wish to revert to the original state of the Ribbon at installation, you can do 
that by deleting the file in which these changes have been recorded. The name of that file is 
UIState.dat. It is usually located as follows:

Windows XP    C:\Documents and Settings\ UserName \Local Settings\Application 
Data\Autodesk\Revit\Autodesk Revit Architecture 2010 

Windows Vista    C:\Users\UserName\AppData\Local\Autodesk\Revit\Autodesk Revit 
Architecture 2010

Figure 2.41 
The Build panel 
undocked from the 
Home tab.

Figure 2.42 
Returning an 
undocked panel 
to the Ribbon by 
selecting Return 
Panels to Ribbon.
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Once you have deleted this file, restart Revit, and you will see the standard UI setup.

Undock the Project Browser     As did previous releases of Revit, Revit 2010 lets you undock 
the Project Browser and make it float over the drawing area, as shown in the two images below.

  

Users with double screens can now place the Project Browser in the second screen. Revit2010 
will remember all changes to the interface and will display them in the next launch of the 
application.

Use keyboard shortcuts    Keyboard shortcuts are surely the fastest way to work with Revit. 
The shortcuts assigned to the existing Revit commands are unfortunately not as obvious 
in the new UI as they were previously. To visualize the assigned keyboard shortcuts, you 
have to hover over a tool, wait for the tooltip to appear, and then look for the assigned short-
cut, which is described with two capital letters (Figure 2.43). To change the automatically 
assigned shortcuts, you should, as in previous releases of Revit, edit the KeyboardShortcuts 
.txt file located in \Program Files\Autodesk Revit Architecture 2010\.

You will have to restart Revit after changing the keyboard shortcuts in the .txt file. 

Display keytips    Revit 2010 introduced a new concept called keytips. To display the keytips 
of the Quick Access toolbar or the main toolbars, press the Alt key (Figure 2.44).

If you want to display the keytips for all the tools within a contextual tab, press the Alt key 
followed by the letter that describes that tab (H for Home; N for Manage, and so on).

Figure 2.43 
Keyboard short-
cuts are visible in 
the tooltip.

Figure 2.44 
Keytips display 
when you press  
the Alt key.
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Using the Project Browser
You can navigate through a Revit project in a number of ways. As you start working in real 
projects, the number of views and drawings that accumulate will become quite large. Being able 
to find your views and move between them is critical to an effective workflow. We’ll look at the 
various methods of moving between views, explore best practices, and show you how to cus-
tomize the display of these views using the Project Browser.

Views
A view is a graphical way to look at the database of information you’re creating. Plan, section, 
schedule table, 3D view—all of these are just different ways to look at and query the same 
underlying database that describes your building. Revit organizes all the views of your project 
in the Project Browser. Your plans, sections, elevations, 3D views, and schedules are all stored 
there. Double-clicking a view name from the Project Browser opens the view in the View win-
dow. When you close a window using the controls at the top right on each window, you don’t 
need to save the view first—it’s always accessible from the Project Browser.

The default organization of the Project Browser is based on the view type and presented as 
nodes in a tree structure. The default organization when all the nodes are collapsed looks like this:

The Project Browser allows you to define an organization of views per your needs. We will go 
into how to do this in more detail later in this chapter.

With a node expanded, right-click a view name to access additional options for any view (see 
Figure 2.45). From the context menu, you can open views, rename them, duplicate them, and 
apply view templates.

Figure 2.45 
Context menu  
for a view.
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Note that you can multiselect views in the Project Browser. When more than one view is 
selected, you can right-click to bring up the context menu (Figure 2.46).

For example, from the context menu you can create and apply view templates. This is a way 
to give views a consistent scale and graphical appearance, among other things. Let’s look at how 
to use the Project Browser to drive properties from one view to another:

 1. Open Foundation_ch02.rvt from the Chapter 2 folder on this book’s companion website 
(www.sybex.com/go/masteringrevit2010).

 2. Open Plan: Level 1.

 3. Right-click the view and duplicate it.

 4. Rename the view Level 1 - Presentation.

 5. Type VG to open the Visibility/Graphic Overrides dialog box.

 6. Select the Annotations tab, and turn off visibility of all annotations by clearing the Show 
Annotation Categories in This View check box at the top of the table.

 7. Go back to the view in the Project Browser, and right-click the view. Select Create View 
Template from View (Figure 2.47).

 8. Name the template Presentation Graphics.

Figure 2.46 
Context menu for 
a view.

Figure 2.47 
Creating a new 
view template.
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 9. Duplicate Level 2, and rename it Level 2 - Presentation.

 10. Right-click the view name, and choose Apply View Template.

 11. Choose Presentation Graphics from the list in the dialog box shown in Figure 2.48.

 12. The plan now has the same properties as the Level 1 - Presentation view.

Working in a data-driven model, you can use View properties to customize how the browser 
sorts and organizes all your views. This is a great way to manage the large number of views that 
will fill your project. Clicking the top of the Project Browser window (not a view) makes it the 
active selection. 

Customizing the Project Browser’s Organization
Use these steps to customize the Project Browser’s organization:

 1. With the Foundation_ch02.rvt file still open, select the Views icon in the Project 
Browser.

 2. The Type Selector lists Browser - Views (all). 

 3. Right-click and open the Properties dialog box.

 4. Change the Type to Not on Sheets. You’ll see the browser reorganize the list and remove 
views that are on sheets.

Now let’s make a custom sort based on your name (or initials) by applying a new Drawn By 
parameter to all views and then using that parameter to sort the views in the browser:

 1. From the Manage tab, under the Project Settings panel, select Project Parameters.

 2. In the resulting dialog box, click the Add button to add a new parameter.

Figure 2.48 
Choosing the Pre-
sentation Graphics 
template.
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 3. Choose the Views category on the right side of the Parameter Properties dialog box (see 
Figure 2.49) under Categories, and under the Parameter Data give the parameter the 
name Drawn by. In the Group Parameter under drop-down list, select Identity Data. 
Click OK. Validate your choice in the Parameter Value dialog box that opens next.

 4. Go back to the Project Browser.

 5. Right-click View All and select Properties. Under Type make sure Not on Sheets is 
selected, and choose Duplicate. Name the duplicate My Drawings.

 6. Click the Folders button.

 7. Change the Group by setting to Drawn by (Figure 2.50), and click OK.

 8. Go to any view, and open its View properties.

 9. The project parameter you added appears in the Identity Data group as Drawn by. Type 
your initials or name in the Value field, and click OK (Figure 2.51).

Sheets
Sheets are special views that are your final documents—the actual sheets you’ll be sharing with 
your contractor, client, or team members. This is where the collections of drawings that eventually 
get printed are stored. Under each sheet node you see all the views placed on that sheet. As with 
any other view in Revit, if you double-click the node, the sheet view opens in the View window.

Figure 2.49 
Create a new proj-
ect parameter for 
views.

Figure 2.50 
Group views by 
the new parameter 
(Drawn by).
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To make a new sheet, go to the View tab, and from the Sheet Composition panel, select New 
Sheet. This lets you select a title block family to use.

activating a View on a Sheet

Double-clicking a view on a sheet is the same as opening the view from the view’s node. Double-
clicking the sheet name opens the sheet. From the sheet, you can directly edit views on the sheet 
by right-clicking a view and choosing the Activate View option. This opens the view and grays out 
the sheet context, allowing you to edit elements in the view from the context of your sheet. To get 
back to the sheet, use the context menu again, and choose Deactivate View.

Figure 2.51 
Change the Drawn 
by parameter for 
any view.
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Families
In the Project Browser you can see all the loaded families in your project. Loaded means available 
from within the project and usually also indicates something loaded along with the template. 
You can load additional families while working on the project, and each one you load will be 
available in this location in the Project Browser. From here, you can drag and drop families 
into the drawing area, query their properties, create new types of elements, and even select all 
instances of a given element in the model in order to locate them or perform wholesale changes. 

The context menu for families (Figure 2.52) is different from that for views. Note that if you 
choose the option to edit a family, you’ll open the family in the Family Editor, where you can 
make changes to the component and then reload it. If you expand the family node to expose 
all the family types, you can right-click a type and choose Select All Instances from the context 
menu. All instances in the model become selected, even if you can’t see them in your current 
view. This lets you make edits to the family type in one interaction. For example, you can select 
all instances of a door family and swap it with a different door type.

Links 
Revit links (other Revit files that are linked into your project) are also listed in the Project 
Browser. Using the context menu, you can reload, unload, open, copy, and visually identify the 
links in your project.

Figure 2.52 
Options for fami-
lies in the Project 
Browser.
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Groups
Groups are associated collections of elements that can be repeatedly placed throughout the 
model. Groups are used for repeating entities (furniture composed of a table and six chairs, 
a typical bathroom layout with fixtures and partitions, or a typical hotel room, for example). 
When one group changes, all other instances of that group also change. Whenever a group is 
created, it appears in the Project Browser. You can place a group from the Project Browser by 
dragging it into the View window.

Navigating Views and View Properties
As we’ve mentioned, all views have properties that determine characteristics such as scale, 
graphics display, and view depth. Each view type has special characteristics and options, and it 
is important to understand them when you’re using Revit. We’ll look at the different view types 
and explain their defining features and how to use them. To access View properties, use any of 
these access methods:

Right-click anywhere in the View window, and select View Properties from the  •u	

context menu

Right-click a view in the Project Browser, and select Properties from the context menu•u	

From the Ribbon, select the View tab, and on the Graphics panel, click View Properties•u	

Use the keyboard shortcut •u	 VP to access the View Properties dialog box directly

Floor Plans
Plan views are used to show horizontal slices through your building. Each plan view in Revit is 
associated with a level. A level is a horizontal datum that establishes major floor-to-floor heights 
and other critical horizontal working planes. Figure 2.53 shows that each level generates a plan 
view. By default, the plan is cut 4” (1–1.2 m) above the actual level height, but this value can be 
customized to suit your requirements.

Figure 2.53 
Levels generate 
plan views.
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Use Caution When Deleting Levels!

If you delete a level in your project, you will delete all views and elements associated with that level, 
including any walls, roofs, and furniture—so be careful when deleting levels!

Each plan view can show a range of the model based on levels. This aspect of Revit is often 
misunderstood, so let’s take a moment to demystify it.

view range

When creating your documents, you want them to represent your elements correctly. Using the 
Object Styles dialog box and graphic overrides, you can get your drawings to look exactly the 
way you want them to look. However, you also may often wish to add a level of abstraction to 
the drawing that involves elements that aren’t typically visible in the view. For example, you 
may want to see rooflines overhead or see down into an atrium a few levels below. This is where 
the View Range options come in handy.

The options available in the View Range dialog box allow you to define how elements in a 
view are represented based on their location in space. View Range values are stored as a prop-
erty of the view and are included when you save a view as a view template.

Figure 2.54 shows three ways to represent the same space and elements by using different 
View Range settings. Think of the mess you might end up with if you had to do this using a lay-
ering system!

To access the View Range dialog box, go to the View properties of a plan or ceiling plan 
view, and choose to edit the View Range parameter. Doing so opens the dialog box shown in 
Figure 2.55.

Figure 2.54 
Three different 
representations of 
the same model in 
plan view.
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The View Range dialog box is divided into two parameter groups: Primary Range and View 
Depth. Let’s start by looking at the primary range. It is defined by horizontal planes. Three of 
them (Top, Cut Plane, and Bottom) define the primary range, and a fourth plane defines the 
view depth.

Top    Defines the top limit of the view range.

Cut Plane    Defines the height of the Cut plane.

Bottom    Defines the bottom limit of the view range.

Note that the positioning of these is always relative to a level. The Cut plane always references 
the level of the view in which you’re working, and the other two can reference any level of the 
project.

Revit doesn’t offer a graphical representation of the View Range settings that we are describ-
ing here, but it shouldn’t be difficult to imagine their position in space. Look at Figure 2.56, a 
representation of different positions of the horizontal planes of a view range. In a floor plan 
view, the direction of the view is from top to bottom—so you’re looking from above.

Figure 2.55 
The View Range 
dialog box.

Figure 2.56 
Various positions 
of the view range 
(top) and the asso-
ciated plan view 
(bottom).
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In a ceiling plan, the view direction is exactly the opposite—you’re looking from below, 
upward (see Figure 2.57).

Depending on the positioning of the elements with respect to the view range and its param-
eters, the graphical display of those elements can vary. The Cut Plane parameter can radically 
change the appearance of your view, because every element in Revit has a physical location in 
space. Elements look different depending on whether they’re cut by the Cut plane, above the Cut 
plane, or below the Cut plane.

Does a Category allow Cutting?

How do you determine whether a category allows its elements to be cut? A fast way is to look it up 
in the Revit Help file under Revit Architecture 2010 User’s Guide  Customizing Project Settings  
Detail Level  Managing Family Visibility and Detail Level. 

There is another method as well, which may be more practical. In the Visibility Graphic Overrides 
dialog box or the Object Styles dialog box is a Cut column. For certain categories, this column is 
grayed out; this is the indicator that the category doesn’t allow cutting. 

Figure 2.57 
Position of the 
view range for ceil-
ing plans (top) and 
the associated plan 
view (bottom)
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Cut plane

Not all Revit elements behave the same with respect to the Cut plane. Some Revit categories 
don’t support the notion of being cut (furniture families, for example); even if a Cut plane inter-
sects them, they’re always represented as if viewed from above (not cut). Figure 2.58 shows that 
a stool looks the same, no matter where the Cut plane happens to intersect it.

the primary range

Now that you have a general understanding of how the Cut plane affects elements in a view, 
let’s dig deeper into the primary range concept. As we mentioned, this range consists of two 
other planes, Top and Bottom, which are placed respectively above and below the Cut plane. The 
exact positioning of these two planes is defined by an offset value relative to a level:

The Top plane can reference any level above the current one. The Bottom plane can reference 
any level below the current one. Let’s look at some examples:

If an element is cut by a Cut plane, it’s visible in the view, as shown in Figure 2.59.•u	

If an element is•u	  below the Cut plane but within the primary range (partially or completely), 
it’s visible in the plan view as if it were looked at from above, as shown in Figure 2.60.

Figure 2.58 
Some categories, 
such as furniture, 
are not affected by 
the Cut plane.

Figure 2.59 
The cabinet is cut 
by the Cut plane 
and is visible.

Figure 2.60 
The lower book-
case isn’t cut but is 
visible.
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If an element is •u	 above the Cut plane and completely within the view range, it doesn’t appear 
unless it’s the category Windows, Casework, or Generic Model. It appears as if seen from 
above, as shown in Figure 2.61. Because the wall shelf is the category Casework, and it’s 
within the primary range, it appears in plan view.

view Depth

The View Depth is defined by a horizontal plane that is below the view range. The positioning 
of this plane uses the same principle as the planes in the view range—it’s defined by an offset 
referencing a level:

This plane is often confused with the Bottom plane of the view range. Remember this: the 
View Depth cannot be above the Bottom plane. View Depth allows you to see elements below. 
The default is set to show nothing, because it’s associated with the active level and has no offset.

The View Depth is easy to misunderstand: it sounds confusing to have a Bottom plane in 
the view range and also have this additional View Depth parameter. The idea here is that you 
need the ability to control the display of elements that are below the primary range but within 
the View Depth. Consider a wall with a footing. The wall is placed on Level 0 and goes up to 
Level 1. In the plan view of Level 0, using the default settings, you don’t see the footing (see 
Figure 2.62).

Figure 2.63 shows the effect of the default view range when it’s set to be coincident with the 
view’s associated level, in this case Level 0. Lowering the depth of the view makes the footings 

Figure 2.61 
The wall shelf 
appears.

Figure 2.62 
With the default 
View Depth, the 
footings aren’t vis-
ible in plan view.
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visible in plan view. They’re represented with the Beyond line style, which in this example uses 
a dashed line. To make the footing visible in the Level 0 plan view, you need to do one of the 
following:

Lower the height of the Bottom plane in the primary range, and define the View Depth to •u	

be coincident with it

Define the View Depth so that it’s below the base of the footing•u	

In the second case, you don’t need to change anything about the Bottom plane. In addi-
tion, you can obtain a different graphic presentation for the footings (without modifying the 
Visibility/Graphic Overrides settings). The View Depth allows elements that are below the 
current level to appear in a unique line style named Beyond. To control that line style, go to the 
Manage tab, and in the Project Settings panel and from the Settings choose Line Styles.

To display the elements in view in a specific way, you’ll need to play with various parameter 
settings in the View Range dialog box. See Figure 2.64, in which the View Range settings work 
in the vertical dimension (view shown in elevation) and affect plan views (corresponding plan 
view shown below). 

Figure 2.63 
Modifying the 
view range for the 
footing of a wall 
makes the footing 
visible in  
plan view.

Figure 2.64 
The View Range 
settings work in 
the vertical dimen-
sion (view shown 
in elevation) and 
affect plan views 
(corresponding 
plan view shown 
below).
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To fully understand this example, it’s essential to understand the categories of the elements 
participating in this view (from left to right in Figure 2.65):

The door    The door belongs to the Door category. It’s cut by the Cut plane. Its graphic pre-
sentation is controlled by the Cut style in the Object Styles or Visibility/Graphic Overrides 
dialog box. The arc representing the door swing is a 2D symbolic element and thus can’t be 
cut by the Cut plane.

The low cabinet    The low cabinet belongs to the Furniture category. Because it’s placed 
below the Cut plane but still within the View Depth, it’s visible in plan view. It uses the 
Beyond line style.

The wall-mounted shelf    The wall shelf belongs to the Furniture System category. The shelf 
is above the Cut plane but within the view range. Its category allows it to be represented 
in plan view. Its graphics are controlled by the Projection column in the Visibility/Graphic 
Overrides or Object Styles dialog box.

The desk–chair–drawer family    The desk with a chair and a drawer (all one family) 
belongs to the Furniture category. This family is cut by the Cut plane. Its category doesn’t 
allow for it to be cut, and its graphics are thus controlled by the Projection style in the 
Visibility/Graphic Overrides or Object Styles dialog box.

The window    The window belongs to the Window category. It’s cut by the Cut plane. Its 
graphics are controlled by the Cut style in the Visibility/Graphic Overrides or Object Styles 
dialog box.

Creating a Plan View Using View Range and a Plan Region
Figure 2.65 is a model of a simple space that we’ll use to understand view range. We have cho-
sen a split-level example to show you the power of various settings and resulting displays of the 
View Range parameters. The goal is to create a plan view of Level 0 that displays information 
from a lower level. We want to display elements placed on Level 00B with a dashed line style. 

Follow these steps:

 1. Open the file ViewRange.rvt from the Chapter 2 folder on the book’s companion web page.

In the elevation view (South Elevation) you can see the various planes shown in Figure 2.65. 
The View Depth is defined to be the same as the Bottom plane.

 2. From the Level 00 plan view, go to View Properties, and open the View Range dialog box 
(Figure 2.66).

The default Revit settings are currently being used. Notice in Figure 2.67 that Level 00B and 
all elements placed on it are not visible in this view. The low cabinet is visible in the view, 
because it’s placed on Level 00 and is within the primary range. The wall shelf above the low 
cabinet belongs to the category Furniture Systems and is also visible, even though it’s above 
the Cut plane.
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Figure 2.65 
Working with the 
view range

Figure 2.66 
View Range  
settings.
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 3. Change the Bottom and View Depth settings to Level Below (Level 00B), and click Apply. 

Having defined the Bottom plane as well as the View Depth to be coincident to Level 00B, 
you’ve managed to show the elements of Level 00B in the Level 00 plan view. The problem 
is that it will be difficult to assign a dashed-line style to the elements placed on Level 00B, as 
you initially desired. You could manually override all the elements, but you’d have to do so in 
each view manually—let’s look at a smarter way to do this.

 4. The furniture in this level is below the Cut plane. To change the graphic display of it, you 
could use the Projection column in the Visibility/Graphic Overrides or Object Styles dia-
log box, but in that case, the presentation of the furniture on Level 00 would be affected—
and that isn’t what you want to happen.

 5. Set the Bottom plane to Level 00, and give the View Depth a –4’ (–1.2m) offset below Level 
00. Click Apply. In the elevation in Figure 2.68, you can see the various planes in dashed-
line style. As you’ll notice, the chairs are now visible but not the table—this is because the 
chairs are partially within the view but the tables aren’t (they’re below the View Depth). 
The chairs belong to the Furniture category, which doesn’t support a cut representation; 
they’re shown as if they were seen from above, even though they’re intersected by the 
View Depth.

 6. Set View Depth to Level Below (Level 00B) and give it a –4’ (–1m) offset. In the elevation 
in Figure 2.69, you can see the various planes in dashed-line style.

Figure 2.67 
You can see the 
effect of moving 
the Bottom plane 
and View Depth to 
Level 00B.
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Figure 2.68 
Modifying the 
View Range  
settings.

Figure 2.69 
Lowering the  
View Depth.
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By changing the View Depth, you have achieved your goal of seeing the furniture from 
below in a dashed-line style; however, the windows don’t look quite right. To fix that, Revit 
provides a tool that allows you to selectively alter the view range for certain parts of the view 
using a plan region. This tool lets you draw a rectangle and then define the view range for that 
rectangle as a way to override the View Range settings of the view.

 7. In the View tab, under the Create panel, click Plan Views, select the Plan Region tool, and 
sketch a rectangle around the windows, as shown in Figure 2.70. This region will make it 
possible to show the windows as if they were cut.

 8. From the Element panel, click Plan Region Properties, and change the view range of the 
plan region. In this example, to show the window, set the level the Cut plane is referenc-
ing to Level 00B (see Figure 2.71).

If you need to adjust the properties of the plan region later, select it, go to its Element 
Properties, select View Range, and go back to the settings.

Sections
Section views are traditionally live cuts through the building model. They can be generated 
using the Section View tool from the View or Basics Design bar. You can place section lines in 
plans, elevations, and other section views, and they will appear in other views that cross the sec-
tion perpendicular to the Cut plane. A section has two graphic symbols associated with it that 
appear at either end of the section line. Check the Ribbon when placing a new section—you’ll 
notice that you can choose a section type (Building, Wall, Detail) and in the Options bar you can 
preset the scale. These are the options available when placing a section:

You define the section line by making two clicks in the view. Once a section has been created, 
you can move it by dragging it. The amazing thing is that when you move the section line, the 
view it references is automatically regenerated. A section line always shows what it’s cutting 
when the view is displayed. It’s impossible to have a section that is out of sync with the model.

Figure 2.70 
Making a plan 
region, annotated 
here by the rect-
angle in the  
upper right.

Figure 2.71 
View Range  
properties of the 
plan region.

56491c02.indd   66 6/3/09   10:27:21 AM



navigating vieWs and vieW PRoPeRties | 67

Some special properties are available for sections that help you create the drawings you 
want. We’ll focus on those next.

Broken SeCtion lineS

The default section graphic is shown as a solid line with a section head and section tail at the 
ends. You can break a section cut line by clicking the little squiggle icon in the center of the line. 
Doing this lets you create a graphic, as shown in Figure 2.72.

JoggeD SeCtionS

As you draw a section line, you’ll notice that you can only draw a straight segment. Often, how-
ever, you’ll want the section line to pass through important parts of the building that don’t lie on 
the same line—you’ll need to break the section line and make it jog. You can jog the section line 
around elements in plan to change what is shown in the view. To do this, click the Split Segment 
button available in the Section panel when a section is selected. The cursor changes to a knife. 
Click to split the section, and begin dragging the segment. Figure 2.73 shows an example of a 
section split that jogs around an elevator core but cuts through classrooms.

Figure 2.72 
Clicking the  
squiggle icon 
breaks the  
section line.

Figure 2.73 
Jogging a  
section line.
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Depth oF a SeCtion

When a section is selected, you can control the extents of the view interactively using the crop 
boundaries. The right and left sides directly affect the section view size on a sheet. The far clip 
limits how much geometry is visible in depth. To improve performance and get the right repre-
sentation, be aware of how deep your sections are. Show only what is needed. By default, a new 
section extends the entire depth of the model. To change that, pull the far clip closer to the Cut 
plane (see Figure 2.74). The same logic applies to elevation depth.

autohiDing SeCtionS anD elevationS

It’s possible for sections to disappear from time to time as you change the scale of a view. If you 
check the visibility settings or try Reveal Hidden Elements mode, it won’t be clear why the sec-
tions aren’t visible. This behavior is a result of a little-known feature: Hide at Scales Coarser 
Than. This parameter lets you set a scale beyond which the section will no longer be visible. In 
most circumstances, the benefit of this feature will be nearly invisible—Revit will do the right 
thing, and you’ll go about your business as usual.

Elevations
Elevations are made by placing elevation tags in floor plan views. Depending on where you 
place the elevation in the model, you’ll get different resulting views. Revit assumes that if you 
place an elevation in the model (in a room, for example), you’re creating interior elevations. The 
view shows only the walls visible in that room. If you place an elevation outside your model, a 
building elevation is created that shows the entire façade.

Elevations are a lot like sections in terms of how they behave in Revit: they have a clip plane, 
a crop boundary, and a symbol; and they can be opened directly by double-clicking the symbol. 
Elevation tags can have as many as four views related to one tag for the purpose of creating inte-
rior elevations of rooms. This is great for interior elevations but limits your ability to customize 
the graphics of these tags. 

Figure 2.74 
Controlling the 
section depth.
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hiding Sections at Coarser View Scales

In a 1⁄4˝ (1:50) floor plan view, you may have many wall sections, building sections, and interior eleva-
tion tags visible. However, with a 1⁄8˝ plan (1:100), you want to see only the building sections and 
exterior elevation tags. Using the Hide at Scales Coarser Than option, you can do this. Select your 
interior elevation tags, and set their Type property to hide at scales coarser than 1⁄4˝ (1:50). (Make 
sure you select the view direction arrow, not the view reference part.) Next time you open the 1⁄8˝ 
(1:100) plan, they won’t be visible. Do the same for your wall sections. Because this is an instance 
property, you must first select the elements to which you want to apply this rule.

In many scenarios, the symbol used for an exterior building elevation is identical to the sym-
bol used for section heads. Currently in Revit, this can’t be done with a standard elevation symbol. 
For this use case, we suggest a common workaround:

 1. Create a building section, and open its properties. Click the Edit/New button, and then 
duplicate the section. Name the new type Exterior Elevation, as shown in Figure 2.75.

 2. When you go to place an exterior elevation, choose the Section tool instead. Draw the sec-
tion so that it creates an exterior view of the model.

 3. Drag the section head to the middle of the model. Notice that the section extents stay 
where they are, so the view isn’t affected by this graphical change.
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 4. Turn off the visibility of the section tail by clicking the cycle icon.

 5. Drag the section line so it disappears into the section head.

 6. Check your Project Browser. A new node appears for your exterior elevations.

 7. In Figure 2.76, the elevation still appears in the sections node, but it’s appended with the 
Exterior Elevation type. You can rename the section if needed. (Note that the elevation tag 
looks like the section tag.)

Figure 2.75 
Making a new 
section type for a 
building section.

Figure 2.76 
The elevation tag 
looks like the  
section tag.
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If you go this route, be aware that to adjust the cropping, you must select the section line you 
just worked so hard to hide. You’ll need to zoom in close and use the Tab key to select that line 
again. Once it’s selected, you’ll have full access to the other controls associated with the section.

3D Views
One of the most obvious benefits of working with BIM is the 3D nature of the model. When 
using Revit, you’ll find yourself constantly generating different 3D views, examining the space 
from various vantage points, and making presentations you would not be able to do using a 2D 
application. You can create two types of 3D views in Revit: axonometric and perspective. Each 
has special characteristics that you need to be aware of.

axonometriC 3D viewS

An axon view is a scaled drawing showing the model in three dimensions. These views allow 
you to dimension lengths in all three dimensions with no perspective distortion. The easiest 
way to make an axon view is to duplicate the default {3D} view using the Project Browser. Right-
click the {3D} view name, and duplicate it. Once you do this, the next time you click the 3D icon, 
a new default {3D} view will be created automatically. Once you have a 3D view, use the mouse 
to spin it around. Hold down Shift and the middle mouse button to orbit around the model. If 
you first select something and then orbit, you’ll orbit around your selection. To pan the view, 
hold down the middle mouse button and pan. To zoom, scroll the mouse wheel back and forth.

Orienting to Other Views

Perhaps the most compelling feature of the axon view is its ability to orient to other views. 
To do this, right-click on view cube to access the context menu, and then choose to Orient to 
View. When you do this, a 3D section box is enabled in the view that cuts the model with all six 
faces of the box. You can go from a very dense, hard-to-read model to a focused representation. 
Figure 2.77 shows a 3D view that was oriented to a section view. You’re free to create new ele-
ments and edit the model from these types of views.

Figure 2.77 
3D view oriented 
to a section view 
and then orbited
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You can then spin the model to get a 3D representation. With Revit, these types of views are 
easily generated; they suggest a new type of drawing to be included in standard construction 
and presentation document sets.

perSpeCtive viewS (CameraS)

Perspectives in Revit (bird’s-eye and worm’s-eye views) follow the metaphor of placing a cam-
era in space. To make a new camera, start from a floor plan, and use the Camera tool from the 
View Design tab. The first click establishes where the camera is placed in the model. Look at the 
Options bar: you can set the camera height prior to placement if you want. The default puts the 
camera 5’-6” (1.8m) above the active level you’re on. You then give the camera a direction and set 
the center of rotation by clicking a second time. The view automatically opens for you to reveal 
what your camera sees. The camera placement is shown in Figure 2.78.

Once in the camera view, you can navigate by using the mouse buttons to orbit and pan. For 
even more options, enable the SteeringWheels from the Navigation panel in the main view win-
dow, shown in Figure 2.79.

Figure 2.78 
Camera  
placement.

Figure 2.79 
The Navigation 
panel contains the 
SteeringWheels 
and Zoom tool.

A B C
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Use the small arrow icon in the lower-right corner of the SteeringWheel to access additional 
options and change which wheel is active.

Once a camera has been placed, you won’t see it in other views. Its default state is to be invis-
ible. To make a camera visible, select the view in the Project Browser, and choose Show Camera 
from the context menu. You’ll see a graphic of the camera and its available controls, such as the 
camera, target, and far clip plane (if it’s enabled). Select any controls, and drag them around to 
alter the location of the camera. Clicking empty space or another element deselects the camera; it 
will disappear.

Unlike axon views, perspective cameras don’t have a view scale that determines how big the 
view is. A perspective has no scale, so you use the crop region to define the size of the image. 
Click on one of the lines of the crop region, and from the Crop panel select Size Crop. This 
opens the Crop Region Size dialog box.

The width and height are controlled here—this is the size of the image if it was printed out 
on paper. If you start editing the values, you’ll see the crop boundary resize. The default option 
(Field of View) adjusts the width and height independently, and the model becomes more or less 
cropped. Figure 2.80 shows the effect of changing Width from 16” to 12”.

If you choose the Scale (Locked Proportions) option and change either Width or Height, the 
image looks exactly the same but is scaled up or down. If you like the proportions of your shot 
but you want a bigger version of it, choose this option.

Figure 2.80 
Changing the crop 
boundary.

56491c02.indd   73 6/3/09   10:27:23 AM



74 | Chapter 2 Revit Fundamentals

The Bottom Line

Understand Revit parametric elements.    Although you can find references to objects, fami-
lies, instances, and components, in the end everything is an element.

Master It    What are Revit elements, and how are they managed graphically?

Work with the Revit user interface.    As in any software application, you need to know 
where all the major components are and what tasks they support.

Master It    How do you change the graphics of a category for all views? What if you need 
to change the graphics for only one view?

Use the Project Browser.    This UI component provides access to all elements in your model. 
Become accustomed to using it to locate views, families, groups, and links.

Master It    Knowing how to navigate views in Revit is essential to completing work. 
What are some of the ways to open views in Revit?

Navigate views and view properties.    Views are also elements. Just like the walls, floors, 
and roofs you add to the model, you’ll also add views. They have properties you should 
become familiar with.

Master It    You need to change the scale of a plan view from 1⁄8” to 1⁄4”. How do you do 
this with Revit?
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Chapter 3

Know Your Editing Tools

Get to know Revit’s basic commands, tools, and techniques. The faster you learn to work with the 
interface, the more productive you’ll become. With the new interface, most tools appear when an 
object is selected; however, some tools are located on the Modify tab. As you progress using Revit, 
you’ll find that certain commands are better suited for certain tasks. For example, you’ll develop a 
sense of when to copy and paste an element versus when to move and copy it; and when to use the 
spacebar instead of the Rotate tool. You will also get acquainted with the Join Geometry tools, the 
Split Face and Paint tools, and Revit’s keyboard shortcuts.

In this chapter, you’ll learn to:

Select, change, and replace elements•u	

Edit elements interactively•u	

Use other handy editing tools•u	

Selecting, Modifying, and Replacing Elements
Knowing how to select, modify, and replace elements of a Revit building model is fundamental 
to working with the software. These basic interface operations are the building blocks that you’ll 
use throughout the process of making edits to your model.

Selection
Selection is straightforward in Revit: hover your cursor over an element and it highlights (turns 
purple); click the highlighted element, and it turns blue, meaning you have it selected. Once the 
item is selected, a special contextual ribbon tab appears that contains the tools relevant to the 
selected command or context (Figure 3.1).

Figure 3.1 
The tool set  
offered in the  
ribbon depends on 
the type of element 
you’ve selected.
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You can select multiple elements in several ways:

Additive selection    Hold down the Ctrl key while clicking new elements to add them to 
your selection. To remove elements from the selection, hold down the Shift key and click the 
selected elements.

Window selection    You can select many elements by dragging a selection window across the 
view. Do this by holding down the left mouse button and dragging. A left-to-right drag selects 
only elements completely within the selection window; a right-to-left drag selects anything 
within or intersecting the selection window.

Chain selection    You can select connected lines and walls by placing your cursor over a line 
or wall (don’t pick, just let it highlight) and then holding down the Tab key and selecting a 
wall or line. All walls/lines that are end-joined to that wall become selected.

Selection Count tool    The selection count tool is displayed on the far right in the same zone 
as the status bar; its icon is a filter because it actually is an addition to the selection filter func-
tionality and gives information about the number of Revit elements currently selected.

After making a selection of elements, you can see the number of elements you selected by 
double-clicking the count icon. This invokes the Filter dialog box, where you can narrow down 
your selection if needed. If you have nothing selected in the model, double-clicking on the 
count icon will not invoke the Filter dialog box.

You can also access the selection count tool by directly invoking the Filter dialog box from 
the Multiselect tab. This box is only active after you have made a selection of multiple differ-
ent categories of elements in the model. Note that if you select elements of one category, the 
filter option does not exist

Filtering Your Selection

You can filter what you’ve selected based on categories by using the Filter button (located in the 
Multiselect tab), which appears upon selection of multiple elements. This allows you to make large, 
nonspecific box selections and then focus your selection by removing categories from it. For 
example, if you box-select an entire floor plan, you’ll end up selecting many categories of elements. 
Using the Filter dialog box, you can limit the selection to just the Windows category (or Doors, or 
whatever element you need). Note that you can open and access the Filter dialog box by double 
clicking on the previously mentioned count tool.

Try this out on any model you have open. Using a box selection, draw a big box around a por-
tion of your model, and then click the Filter button from the Multiselect tab. You’ll get a dialog 
box like the one shown in Figure 3.2. Here, you can deselect categories to limit what you’ve 
selected. Think of this as a shortcut. Let’s say you need to change the properties of 20 doors in a 
plan view. It’s much faster to box-select an area of your model and then filter out all the elements 
except the doors than it is to Ctrl-select all 20 doors one at a time.

Selecting All inStAnceS

This option is available in the context (right-click) menu of an element and allows you to select 
all instances of a particular family in the entire model. This is great when you need to perform 
a wholesale swap of a certain family throughout the entire model. For example, if you placed 
some generic wood doors in your project and you now want to swap all those with metal doors, 
this command is perfect. To use it, select one door in the model, right-click, and choose Select 
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All Instances from the context menu to select all the wood doors. Then, select Change Element 
Type, which invokes the Type Selector in the Modify tab, to change the door type. With this 
command, elements become selected that may not be visible in your view (the elements might 
be hidden), because this type of selection isn’t limited to what you see or have manually clicked. 
Remember that you’re selecting all instances of that family type used in the entire model.

Whenever you make a selection of elements, you can look at the count tool on the bottom 
right of your screen. Figure 3.3 shows that four elements were selected.

uSing the tYpe Selector

The best practices to model a building in BIM are to start to model using generic walls, floors, 
doors, and windows, and then over time, as you make more specific decisions and refine the 
details of the design intent, swap those for specific types of elements. Using Revit, you don’t 
have to redraw elements when you decide to get more specific with your design. You make new 
types or load new content, and then swap out the elements using the Change Element Type (that 
invokes the Type Selector) in the Modify tab. The elements listed are all of the same category, 
making it easy to locate relevant content.

You can take advantage of this feature the moment you start placing any Revit families. 
During creation, you can use the Change Element Type tool to choose the type of element being 
placed. Once you select an element, the same list becomes available, making it simple to change 
the types.

MAtching propertieS

The Match Type button is located on the Modify tab under the Clipboard panel and allows you, 
upon selection of an element, to apply its properties (type and instance) to another element 

Figure 3.2 
Use the Filter 
dialog box to 
limit what you’ve 
selected.

Figure 3.3 
Count showing the 
number of items 
selected.
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of the same category. Once you select an element, the little brush icon attached to the cursor 
appears filled. Each subsequent click on elements of the same category will replace the selected 
element with the type currently active in the Match Type tool. Note that the Match Properties 
tool will only appear in the Modify tab when nothing is selected.

Be careful when you use this tool with walls, because not only does it change the wall 
type, but it also changes the top and bottom constraints of the walls being matched. Thus, 
the best practice for walls, if you need to change the type but don’t want any of the level con-
straints to change, is not to use the Match Type tool but instead to use the Change Element 
Type button (Type Selector) from the Modify Walls tab that becomes available upon selection 
of a wall.

Copying and Pasting
Copying and pasting is a familiar technique used in almost all software applications, and Revit 
provides the basic features you’d expect with a copy and paste interaction (Ctrl+C and Ctrl+V). 
It also has some additional time-saving options that are specific to working on a 3D building 
model.

To copy any element to the clipboard, select it and press Ctrl+C. Elements are copied and 
now ready to be pasted. To paste, press Ctrl+V. In the majority of cases, Revit pastes the elements 
with a dashed bounding box around them. You then determine where to place the elements by 
clicking a point to define its position of placement. In the Options bar you will find an option 
called Constrain that when checked will only let you define the location of the copied element 
relative to the main constrain directions of the original element. 

pASte Aligned

Once you’ve copied elements to the clipboard, you can paste them into other views with a variety 
of options. This allows you to quickly duplicate elements from one view to another (an entire 
furniture set from one floor to another floor, for example) while maintaining a consistent location 
in the X–Y coordinate plane. After selecting elements and copying them to the clipboard using 
either Ctrl+C or the Copy button in the Clipboard Panel of the Modify tab, choose Edit  Paste 
Aligned from the main menu, as shown in Figure 3.4.

Five options are available. Depending on the view from which you copy and what elements 
you copy, the availability of these options will change. For example, if you select a model element 
in a plan view, you’ll have all the options shown in the figure. The options are as follows:

Select Levels     This is a mode you can use to copy and paste elements between different 
levels. Once you select the elements and choose this option, you choose levels from a list in 
a dialog box, and you can paste to multiple levels at once. This is useful when you have a 

Figure 3.4 
Paste Aligned 
options.
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multistory tower design and you wish to copy and paste a furniture layout that repeats on 
20+ floors; in such a case, selecting levels graphically in a view can be tedious. The X–Y posi-
tion of the selected elements is maintained, and the pasted elements are translated in the 
vertical dimension.

Select Views    This option allows you to copy elements to other views by selecting views 
from a list of views in a dialog box. In the list available for selection, you don’t see levels 
listed but rather a list of parallel views. For example, if elements are copied from a plan view, 
all other plan views are listed. Likewise, if you copy from an elevation view, only elevation 
views appear as possible views to paste into.

Current View    This pastes the elements from the clipboard into the currently active view, in 
the same relative spatial location. For example, if you copy a series of walls in one view, switch 
to another view in the Project Browser, and choose Current View, Revit pastes the walls into 
exactly the same X–Y locations in the new view you switched to.

Same Place    This option places an element from the clipboard in the exact same place from 
which it was copied or cut. One use for this tool is copying elements into a design option; see 
Chapter 10, “Working with Design Options,” for an explanation of design options.

Pick Levels Graphics    This is a mode you can use to copy and paste elements between dif-
ferent floors. Once you select the elements and choose this option, you’re placed into a pick 
mode where you can select a level in section or elevation. You must be in an elevation or sec-
tion view to have this option available. The level you select determines the Z location of the 
paste and preserves the X–Y location. You might use this type of paste to copy balconies on a 
façade from one floor to another.

Create Similar
Rather than hunting through a list of families or making copies using copy and paste, try using 
the Create Similar tool to add new instances of an element to your model.

The Create Similar tool is available in the Create panel of the Modify tab when an element 
is selected. You can also access the tool from the right-click menu. To use this tool, think about 
the type of element you need to make, and select an instance of it. Then, click the Create Similar 
tool, and you’ll immediately be put into placement–creation mode. If you use this tool later 
to create a similar floor or roof (or any other sketch-based element), you’re taken directly into 
sketch mode, where you can start sketching your new element.

Editing Elements Interactively
Revit provides a range of options to interactively edit elements in the model. The most obvious 
is to select elements to drag around the screen or use the blue control grips to extend walls and 
lines. However, you often need more precise ways of moving and positioning things. Let’s look 
at some ways to do this.

Moving Elements
Revit provides several ways to move elements, ranging from traditional tools to intelligent 
dimensions that appear on the fly when you select elements. Become familiar with each method, 
and find what is best for your workflow.
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uSing teMporArY diMenSionS

You should have noticed by now that when elements are selected, dimensions appear. These 
dimensions are called temporary dimensions and are there to both inform you of the location of the 
elements relative to other elements in the model and help you reposition the elements. Clicking 
the blue dimension value makes it an active, editable value. Type in a new value and the element 
that was selected will move to that point. Keep this in mind: when editing a position of an element 
via the dimensions, it will always be the selected element that moves. By the same token, you can’t 
edit a dimension if nothing is selected.

If a temporary dimension isn’t referencing a meaningful element, you can choose a different 
reference by dragging the small blue square attached to the dimension witness line to a new 
parallel reference (Figure 3.5). Parallel references highlight when you mouse over them. For 
example, if you want to position a door opening at a specific dimension from the wall, you will 
need to drag the blue dot reference that currently references the door middle axis to the door 
opening so that the temporary dimension can read that distance and you can further edit to the 
value you wish. Parallel references highlight when the cursor moves over them.

If you click a blue grip, it cycles to the next possible reference in the element. For example, 
clicking the blue grip of a dimension to a door or window cycles between the left and right 
openings and the center of the element. The same is true for walls: try clicking the blue grip 
control of a temporary dimension that appears when you select the door, and see how the tem-
porary dimension cycles through the various references in the wall (interior face, centerline, 
exterior face).

Figure 3.5 
Drag or click the 
small blue grip to 
change the refer-
ence of the tempo-
rary dimension.

Drag square control to new reference
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To change which references temporary dimensions go to first, use the Temporary Dimension 
Properties dialog box shown in Figure 3.6 (Manage tab  Settings  Temporary Dimensions). 
Here, you can specify how dimensions default to walls, doors, and windows independently.

If you have many elements selected at the same time, temporary dimensions sometimes don’t 
appear. Check the Options bar for the Activate Dimensions button; clicking it will make the 
temporary dimensions appear in the view.

uSing the Move tool

Use the Move tool to move elements precise distances by typing in values or using the tempo-
rary dimensions as helpers. Once you have selected an element, the Move tool will be enabled.

Moving elements is a two-click process: first you define a start point, and then you click to 
define an endpoint. If you know you need to move something to the left 10´-6 ,̋ it doesn’t matter 
where your two picks take place; all that matters is that the distance between the two clicks is 
10´-6 .̋ (Figure 3.7 shows the graphics provided during a move operation.) 

There are a few options on the Options bar to be aware of when the Move command is active.

Figure 3.6 
The Temporary 
Dimension Proper-
ties dialog box lets 
you define default 
behaviors.

Figure 3.7 
Use the Move tool 
to move elements 
precisely.
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Constrain    When this option is selected, it constrains movements to horizontal and vertical 
directions. Deselecting it gives you free movement if the element is freestanding. Hosted elements 
such as windows and doors always move in a constrained manner parallel to their host axis.

Disjoin    Hosted elements such as windows and doors can’t change host and move to another 
host without explicitly being disjoined from their host. This option lets you disconnect inserts 
from their host and move them to new hosts. For example, if you need to move a door from 
one wall to another, you select the door, select the Move tool, select Disjoin on the Options 
bar, and move the door to another host.

Copy    This option lets you make a copy of the element without moving the original element. 
In the strictest sense, this isn’t really a move operation but a shortcut to making a copy.

Multiple    This option, which is selectable only after you pick the Copy option, lets you make 
multiple copies of the selected element. 

nudging eleMentS

Nudging is a great way to push things around quickly. When an element is selected, you can use 
the arrow keys on the keyboard to move the element horizontally and vertically, repositioning 
it in small increments. Each press of an arrow key nudges the element a specific distance based 
on your current zoom factor. The closer you zoom, the finer the nudge is. Likewise, as you zoom 
out, the nudge moves elements by larger increments. This is a good tool when you’re working 
with views placed on sheets.

Moving with neArbY eleMentS

Another way to move freestanding elements, but in a more automatic way, is to use the Moves 
with Nearby Elements feature. This tool is designed to capture logical relationships between 
elements. When furnishing a space for example, you probably want to align the bed or dresser 
with a wall. If you change your design, you want the furniture to follow the wall to the new 
location. For this purpose, select the furniture and then select Moves with Nearby Elements on 
the Options bar. By doing so, you create an invisible relationship between the bed and the wall 
so that each time you move the wall, the bed moves with it (Figure 3.8).

Figure 3.8 
Once the bed is 
selected, it can be 
set to move with 
nearby elements.
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Copy
This is an interactive tool that is nearly identical to the Move tool but makes a copy of the selected 
element at the location of the second pick. This tool doesn’t copy anything to the clipboard; it cop-
ies an instance of an element or selection of elements in the same view. If you change views while 
using this tool, your selection is dropped.

To activate this tool, first choose the element or elements you want to copy, and then select the 
Copy tool from the Modify tab. Using the Options bar, you can choose to make multiple copies in 
one interaction by selecting the Multiple option.

Rotating and Mirroring Elements
It’s common to need to rotate an element. Just as with Move, Revit provides a few methods for 
rotating elements. The time-saving spacebar is a quick way to rotate elements in 90-degree 
increments. Just press the spacebar when an element is selected; each press of the spacebar will 
rotate the element another 90 degrees. If a diagonal reference (wall, grid, or reference plane) is 
nearby, then the spacebar will locate this as a rotation candidate. For more precision, the Rotate 
tool is provided, which you can use to rotate elements to any specific angle you require.

uSing the SpAcebAr

Revit uses the spacebar to rotate elements both at the time of placement and after an element 
has been placed. This is a great timesaving command to become familiar with, because you can 
forgo using more traditional tools such as Rotate and Mirror by taking advantage of the space-
bar. Here are a few examples:

Doors and windows    If you have a door with its swing in the wrong direction, select it and 
press the spacebar. You can cycle through all four possible orientations of the door with a few 
clicks. The same holds true for windows; however, many window families are built to only 
let you flip the window from inside to outside, because many windows are symmetrical in 
elevation. If you are creating an asymmetrical window on your own, be sure to add flip con-
trols to the window family during its creation. These allow the spacebar to work on hosted 
elements. Figure 3.9 shows the window opened in the Family Editor and where to access the 
flip controls for placement from the Create tab.

Figure 3.9 
Flip arrows, used 
to flip elements, 
can be added to 
families from the 
Family Editor.
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Walls    If you select a wall, pressing the spacebar flips the element as if it were being mirrored 
about its length. Walls flip based on the Wall Location Line, which often isn’t the wall center-
line. If you aren’t sure which direction your wall is facing, select it and look for the flip-control 
arrows. These are always drawn on the exterior side of walls (Figure 3.10).

Freestanding elements    If you select a freestanding element like the loveseat shown in 
Figure 3.11, the spacebar rotates the element about the center reference planes defined in the 
family. Depending on how the family was built, the rotation origin may not make the most 
sense, but you can quickly orient your furniture and casework. If you decide to edit a family to 
change the location of the geometry relative to the center reference planes, be careful: when 
loaded back into a project, all your elements will jump to a new X–Y location based on the 
changes you made!

Figure 3.10 
The flip arrow is 
another way to 
reorient an ele-
ment. For walls, 
the flip arrow is 
always on the  
exterior side.

Figure 3.11 
Center reference 
planes defined in 
the family deter-
mine the rotation 
origin.
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uSing the rotAte tool

To rotate an element, select it and click the Rotate tool. This is a two-click operation similar to 
the Move and Copy tools. Alternatively, you can enter numeric values. Revit locates the geo-
metric center of the selected element or elements and uses that as the default center of rotation. 
This is fine if you don’t need to be precise and just want to rotate something by a known angle. 
However, in most cases you first must designate a meaningful center of rotation.

To do so, select and drag the center of the rotation—the rotation cursor—to a new location 
before clicking to set start and end picks. Once the origin is established, begin rotating the 
element using the temporary dimensions as a reference or by typing in the angle of rotation 
explicitly.

You’ll notice that while moving the origin, you lose the ability to pan and zoom the view. 
To overcome this, drag the origin into the Project Browser and release the mouse button; then, 
move the cursor back into the view. The cursor changes to a rotation icon, and you can freely 
pan and zoom all you want. The next click you make places the origin, and you can then desig-
nate the rotation.

uSing the Mirror tool

The Mirror tool allows you to mirror elements across an axis in order to create a mirror image of 
an element, like the sinks in Figure 3.12. You can either pick an existing reference in the model 
(the arrow icon) or draw the axis interactively (the pencil icon). In Figure 3.12, a mirror axis was 
drawn through the center of the top exterior wall.

Use the pick method when you have an existing element with a meaningful center axis. If 
nothing in the model exists as a mirror axis, use the Draw mode and draw your own axis.

Arraying Elements
An array allows you to copy instances of an element with equal spacing between instances. Revit 
provides intelligent arrays that can be parametrically grouped and associated, as well as one-off, 
unassociated arrays. Like all the other tools we’ve reviewed, the creation options are presented 
on the Options bar.

Figure 3.12 
The sinks, toilet 
fixtures, and door 
are mirrored about 
the middle of the 
wall at the top of 
the view.
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You can create two types of array: linear and radial. 
Linear arrays are set as the default because they’re the most common. As you would expect, 

a linear array creates a series of elements in a line. Each element in the line can be given a set 
distance from the previous element or be spaced equally based on a maximum line length. 
Figure 3.13 shows a linear array where the Move to 2nd option was selected in order to set the 
initial spacing correctly. Think of this type of array as additive and subtractive: if you change 
the number, the length expands or contracts.

If you want to arrange elements in a fixed space, and the exact spacing between elements is 
a less important factor, use the Last option. Figure 3.14 shows an array where the location of the 
last element in the array was picked, and the elements (in this example, windows) were placed 
equally between the first and last elements in the array. With this option, the length is fixed, 
and the array squeezes elements within that constraint as the number changes. The examples in 
Figures 3.14 and 3.15 show that depending on your design criteria, you can use different arrays.

A radial array works in a similar fashion, but it revolves around a center point. With a 
radial array, elements auto-rotate so that each element faces the center of the array, as shown in 
Figure 3.15.

Figure 3.13 
Move to 2nd option 
used in the array 
tool to set a fixed 
distance between 
groups.

Figure 3.14 
This array uses the 
Last option and 
backfills instances 
between the first 
and last group.

Figure 3.15 
When you’re  
making a radial 
array, you can 
specify the number 
of instances  
interactively.
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Enabling the Group and Associate option allows you to treat an array as a group that can be 
modified later to adjust the number and spacing of the array. If this option is unchecked, then 
the array is a one-off operation, and you have no means of adjusting the array after you create it.

When an element in a grouped array is selected, a control appears, indicating the number of 
elements in the array. Editing that number changes the number of elements in the array. This tool 
comes in handy when you’re creating certain families, because the array number can be param-
eterized. See the section “Parametric Arrays in the Family Editor” in Chapter 11, “Moving from 
Design to Documentation,” for a detailed exercise.

Scaling Elements
The Scale tool lets you scale certain lines and graphic elements in 2D that make sense to scale, 
such as imported raster images and 2D line shapes. In Figure 3.16, the Scale tool was used to 
make the lines surrounding a door tag a bit larger. The first pick was the center of the family, the 
second pick was the center of one of the lines, and the final pick finished the resize.

This tool is also well suited for working with imported images that need to be scaled to 
match real-world dimensions. For example, it’s common to import an aerial photograph of a site 
to use as a contextual underlay. The Scale tool works great to get the image to the right scale. 
You also can create a formula in the element properties of an image to rescale it very specific 
requirements. 

This tool is active once you select an image. After you select the Scale tool, click a point to enter 
an origin (say, the lower-left corner of the image); click a second point to determine the width of 
the image that you want to fit within a certain size; finally, click a third time to get the new length 
you want.

Important note: Keep in mind that you’re working with a building information model (BIM) 
made out of real-world objects, not abstract primitive forms. Don’t expect to be able to scale most 
elements in Revit—it’s not practical or meaningful. For example, you can’t scale the size of a 
door, wall, or sink because they represent real-life types and scaling them would mean scaling 
all their components. This would probably lead to impractical or even meaningless results—for 
example, the door frame will scale in unreal proportions while the size of the panel might be 
still right.

Aligning Elements
If you’ve been using Revit for any amount of time, you should have discovered the incredible 
power of the Align tool. If not, take time to get acquainted with this tool, because it’s a real time-
saver and supplants the need to use many of the tools we’ve already discussed. The Align tool 
lets you line things up in an easy, quick, and intuitive manner.

Figure 3.16 
The Scale com-
mand sequence is a 
three-click process.
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With this tool, you explicitly align references from one element to another. For example, you 
can align windows in a façade so their centers are all in alignment. You will find the Align tool 
in the Modify tab, under the Edit panel. To use the Align tool, you will first select the target 
reference (a part or side of the element to which you want to align another element) and then 
select what you want to align to that reference (the part or side of the element whose position 
needs to be modified). The second element picked always moves into alignment. This selection 
sequence is the opposite of the other editing tools we’ve looked at so far, so remember: first you 
select the aligning reference, and then you select the element to move into alignment with the 
reference.

As soon as you make your second pick, a lock icon appears so you can constrain the alignment. 
Once you click the lock icon, if either element moves, it brings the constrained element along 
with it.

Figure 3.17 shows the use of the Align tool to align windows on a façade. The left opening of 
the topmost window was used to align multiple windows using the Multiple Alignment option 
on the Options bar.

The Align tool also works for aligning geometry with surface patterns like brick or stone. 
Select a line in the surface pattern, and then select the geometry you want aligned. Figure 3.18 
shows how you can align the edge of a window to a brick pattern. Use the Tab key if you cannot 
get surface patterns selected with the first mouse click. The align tool will also rotate elements 
in the process of aligning them to objects which are not parallel. This is a real time saver com-
pared to rotating and moving.

Figure 3.17 
The Align tool is 
great for lining up 
edges of windows 
in a façade.
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Trimming Lines and Walls 
You can trim and extend lines and walls to one another using the Trim tool on the Modify tab. 
With the Trim tool, you first select the tool and then operate on elements in the model, selecting 
two lines or walls that need to meet in a corner. 

The Trim tool, which is called Trim / Extend to Corner, trims elements to one another, creat-
ing a cleaned-up end join between walls and lines. For example, Figure 3.19 shows two walls 
before and after using the Trim/Extend to Corner tool.

The Trim tool is used a lot for editing sketches of floors and roofs, because it’s easy to end 
up with overlapping lines that need to be neatly trimmed. Keep in mind that with the Trim 
tool, you’re selecting pairs of elements to remain, not be removed. Use the temporary preview 
graphics to help you. If you do trim the wrong thing, you’ll see it immediately—just undo, 
and pick again.

Figure 3.18 
You can also align 
model elements to 
surface patterns.

Figure 3.19 
The result of trim-
ming two walls to 
one another is a 
clean corner join.
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Extending Lines and Walls
Next to the Trim tool, you will find the Extend tool. There you will see two options: Trim/
Extend Single Element and Trim/Extend Multiple Elements.

 

This tool lets you extend single or multiple instances of lines and walls. The first option, 
Trim/Extend Single Element, is for extending a single wall. To extend a wall, first select a target 
wall; then select the wall you want to extend to that target (Figure 3.20). The second option, 
Trim/Extend Multiple Elements, lets you extend many walls in one interaction.

Splitting Lines and Walls
The Split tool operates on walls and lines. This tool lets you slice a line or wall into few pieces. 
To cut a wall, place the cursor over the edge of the wall. Before you click, you’ll see a preview of 
the split line before clicking.

The Options bar offers a nice feature called Delete Inner Segment that removes the need to 
use the Trim tool. In Figure 3.21, you need to remove the middle section of the wall and end up 
with a clean set of wall joins. Using the Split tool with the Delete Inner Segment option checked, 
you can accomplish this with two clicks and get a clean condition without having to come back 
and use the Trim command

Figure 3.20 
Trim can be used 
 to extend walls  
as well.

Figure 3.21 
Using the Split tool 
with the Delete 
Inner Segment 
option checked.
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Offsetting Lines and Walls
Offset is similar to the Move and Copy tools in that it moves or moves and makes a copy of an 
element by offsetting it parallel to an edge you select. You can find the Offset tool either in the 
Edit panel of the Modify tab or on the Options bar when you’re sketching lines or walls.

This tool is especially useful in the Family Editor when you’re making shapes that have a 
consistent thickness in profile, such as extruded steel shapes. Offset is also handy when you’re 
making roof forms or soffits with known offsets from a wall. You can either offset a line and 
maintain the original (for that, make sure that the Copy option in the Options bar is checked) 
or offset the line, removing the original. Figure 3.22 shows roof creation done by offsetting the 
sketch lines in the Roof Editor where the offset has been defined as 1́ -0 .̋ Each pick of the wall 
offsets the line by 1́ -0 .̋

Keeping Elements from Moving
In many cases, you’ll want to make sure some elements in the model never move. A good exam-
ple of this is when you work on a renovation of an existing building. You surely would not like 
to move walls that already are built somewhere else in the model. Other examples are imported 
drawings, grids, levels, and exterior walls (once their position is set). Revit provides two ways to 
deal with this and lock certain elements preventing them from moving.

pinning eleMentS

You can restrict an element’s ability to move by pinning it down with the Pin tool. Use this tool 
to lock down critical elements that need to remain fixed for long periods of time. This is a great 
feature for imported CAD files, because it’s very easy to accidentally select an import and drag 
it or move it. This kind of accident can lead to coordination problems, even in a BIM environ-
ment. Use pins to lock down gridlines as well, because you certainly don’t want those to move 
accidentally. 

This tool is located in the Modify panel of the Modify tab. Select the element you want to pin 
down and click the Pin tool. If you try to move the element, nothing will happen—you won’t 
even get a ghost preview of a potential move. To unpin an element, select it and look for the 
pin icon. Clicking the pin removes it and frees the element. The Unpin All tool is essential for 
unpinning multiple elements rather than selecting and unpinning one at a time. 

Figure 3.22 
Offset lets you pick 
existing elements 
and create new 
elements with a 
specific offset  
distance.
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Warning

Pinned elements can be deleted. This unfortunately is misunderstood by users who believe that 
a pinned element is safe from deletion. Revit will however give you a warning before it deletes and 
element.

conStrAintS

Constraints aren’t as rigid as the Pin tool, but they do allow you to create dimensional rules 
in the model so that elements remain fixed relative to one another. You can create a constraint 
using dimensions and alignments and then click the lock icon that appears upon creation or 
selection of elements.

A simple example of using constraints is keeping a door a fixed distance from a side wall, 
so that if the wall moves, the door also moves. If you do try to move the door, Revit will not let 
you do it. Look at Figure 3.23: the door has been locked to remain 53⁄8˝ from the wall face. This 
is done by selecting the door and locking the padlock that appears next to the temporary dimen-
sion defining the position of the door to the wall. After locking the padlock and thus creating 
a constraint, if the wall moves, the door moves as well; but if you try to drag the door to a new 
location, you can’t.

Another example is locking the head height of a series of windows relative to a level. This 
prevents users from accidentally dragging windows into undesired locations while guarantee-
ing that if the level moves, the windows also move.

Exploring Other Editing Tools
A range of other editing tools are available in Revit, and these will be covered in subsequent 
chapters when they’re used in specific operations. There are a few tools you should know about 
now, however, because they’re generic tools that you can put to use on any project immediately. 

Figure 3.23 
A door constrained 
to a wall can’t be 
moved indepen-
dently of the wall.
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These tools, which will help you produce the drawings you need, have the added benefit of 
being intelligent and parametric.

Join Geometry
Joining floors to walls and walls to floors creates cleaner-looking drawings Revit does a good job 
of cleaning up joins between elements such as walls, floors, and roofs automatically. However, 
in many cases elements don’t look right unless they’re explicitly joined. This is where the Join 
Geometry tool, accessed by the Join button, is useful. This tool creates joins between floor, walls, 
ceilings, roofs, and slabs. A common use for this tool is in building sections, where floors and 
walls appear overlapped and not joined. Figure 3.24 shows a floor intersecting some walls that 
aren’t joined. Using the Join Geometry tool, these conditions can be cleaned up nicely. 

Figure 3.24 
Intersections at 
Level 2 have been 
joined.
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To fix this condition, select the Join Geometry tool, and then select the floor and wall in 
sequence.

You should be aware that joining host elements across a large model created significant 
regeneration issues. One way to avoid this is to apply the following workaround: Give a black 
solid fill to elements in the cut plane of your sections – and then selectively join for medium and 
fine views. Solid host elements also read better in section at smaller scales (like half-size sets).

Split Face and Paint
To support painting of surfaces without having to make new types of elements, Revit provides 
the Split Face and Paint tools located in the Edit Face panel of the Modify tab. You can paint the 
exterior faces of walls, floors, roofs, and ceilings with a material. This material has no thickness, 
but you can schedule it (with a materials take-off schedule) and tag it. A typical use case for this 
feature is the application of a carpet material or tile to a floor.

Figure 3.25 shows the floor that initially covered both of the restroom spaces being split 
with the Split Face tool. Once the face has been split, you can activate the Paint tool to apply 
material to it. 

The Type Selector lists all the materials in your project (Figure 3.26). 

Figure 3.25 
Use Split Face to 
sketch an area 
of the floor to be 
painted with a new 
material.
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Choosing a tile material and then clicking the split face applies the material. The result is that 
the floor is unchanged structurally, and the bathroom appears with a tile finish (Figure 3.27).

Keyboard Shortcuts (Accelerators)
Many users like using keyboard shortcuts to speed up common commands and minimize the 
need to interrupt workflow. When you hover your cursor over any tool in the ribbon, the key-
board shortcut is indicated to the right of the tool name, as shown here.

Figure 3.26 
The Paint tool lists 
all materials in 
your project in the 
Type Selector.

Figure 3.27 
You can apply a 
Tile material to the 
split face to get the 
desired effect.
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Revit contains preset keyboard shortcuts when installed, but you can modify the default short-
cuts by editing the Keyboard.txt file located in the C:\Program Files\Revit Architecture 2010\
Program folder. Revit’s shortcuts are two-key shortcuts and are available only for commands 
that already exist. When you change the shortcuts in the Keyboard.txt file, Revit shows these 
abbreviations in the menu.

The Bottom Line

Select, change, and replace elements    Learning the basic mechanics of the interface is  
crucial to just about everything you’ll do in Revit.

Master It    Selecting elements in the model happens all the time. What are some of the 
capabilities that the Revit user interface provides when you select elements?

Edit elements interactively    The architectural process inevitably involves revision, so be 
sure you know how to make changes on the fly.

Master It    You need to make some major changes to a floor plan, moving the bathroom 
20´ down a corridor. How might you do this with Revit?

Use other handy editing tools    Revit provides a wide range of tools for making changes in 
a project.

Master It    In a section view, you notice that the walls and floors aren’t cleaning up 
neatly—you’re seeing lines overlap. What tool could you use to try to clean that up?
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Chapter 4

Setting Up Your Templates and 
Office Standards

In this chapter we discuss how to set up your office standards and how to prepare a project tem-
plate that is rich with information that goes beyond the out-of-the-box content. We show how 
templates are used to assure graphic consistency in your projects and how the reuse of work will 
increase productivity in the future, making the process of creating documents more seamless. We 
tackle the Family Editor and the creation of custom annotation symbols, title blocks, object styles, 
and view templates. 

In this chapter, you’ll learn to:

Start a project with a custom template•u	

Create custom annotation tags•u	

Create custom title blocks•u	

Starting a Project with a Custom Template
The type of building you’re planning, the geographical area in which your building will be 
built, and even the style of the building you’re designing will require settings and content that 
differ from the out-of-the-box Revit template. Software vendors make a great effort to provide 
locale-specific content libraries that respect local traditions as well as incorporate local regula-
tions in their documentation, but as we all know, that is only a good starting point and can’t 
cover all the types of elements you’ll need in the course of a project. Like many other software 
packages, Revit allows you to start with a basic template and then spawn your own custom tem-
plates to suit your specific requirements.

As your knowledge of the software progresses, you’ll begin to create new wall types, roof 
types, ceilings, stairs, and other families in order to meet your design and documentation needs. 
This is also the case with regard to the graphical language that you or your firm has established 
over the years and probably wants to continue using in Revit. How you graphically present ele-
ments like text, dimensions, annotations, keynotes, and hatch patterns defines your style of 
design documentation. The reality of the architectural profession is that we tend to develop 
stylized graphics, and Revit respects this need by letting you customize your starting templates. 
One possible example of graphic style in a CD phase of a project is shown in Figure 4.1.
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With Revit, you can expect to set up your templates by doing one or more of the following:

Defining all the project settings to meet your graphic requirements•u	

Preloading model and annotation families •u	

Defining system families before you start a project•u	

Once everything is in place, you can then save the file as a new template (.rte) and use that 
template whenever you start a new project. Once you’ve saved a new template, you can have 
Revit open that template when you’re starting new projects. To do so, follow these steps:

 1. Go to the Applications Menu, and at the bottom of the menu that opens, click Options.

 2. In the Options dialog box, select the File Locations tab. The first option in the dialog box 
shows the default template location.

 3. Click the Browse button to choose a new path to your default template (Figure 4.2).

Creating and reusing templates can increase your productivity and keep your documentation 
looking consistent. Specifically, using templates allows you to do the following:

Easily reuse work that you’ve already created•u	

Maintain consistency in a project (very important when many team members work on one •u	

centralized file)

Assure a graphic consistency across all your projects•u	

Figure 4.1 
Example of styl
ized annotations 
used in a custom 
template.
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In this chapter we focus on personalizing (customizing) the Revit template file (.rte). The 
following list lays out items we suggest you go through one by one when setting up templates. 
This doesn’t represent all possible settings you can predefine in a template, but it includes those 
that we think are most pertinent.

Settings for graphics•u	

Object styles•u	

Materials•u	

Line styles•u	

Line patterns•u	

Fill patterns (hatches)•u	

View templates•u	

Setting up annotations•u	

Dimension styles•u	

Text styles•u	

View tags•u	

Annotation tags•u	

Figure 4.2 
Change the path  
to your default 
template.
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Setting up title blocks•u	

Global project settings•u	

Keynoting external file locations•u	

Project units•u	

Strategies for Making Templates
Architectural firms tend to address template files in one of two ways: a generic, one-size-fits-all 
office template or a project type–specific template. Some firms focus on one type of building 
(healthcare, office, retail, and so on) where a single template is sufficient, and others do a wide 
range of projects and may even work across cultures with very different requirements between 
project types. If you work all over the globe or have many types of projects, then a generic office 
template probably isn’t the best strategy. Instead, create new templates for each type of project. 
On the other hand, if you’re focused on predictable, similar projects, you can start all projects 
from the same template. 

Templates not only contain all graphic and visibility settings but also contain loaded families 
that you are likely to use in each project. Don’t overburden your template with too many fami-
lies—especially if you don’t intend to use them all. To systematically remove families from your 
template, use the Purge Unused option in the File menu and select what you want to remove. 
You’ll experience better performance when launching Revit and reduce the file size footprint of 
your model by starting out with a lean template.

When creating your own personalized template, be sure to avoid starting from an empty file 
(do not select the No Template option); rather always use an existing RTE file. You’ll save your-
self a lot of time by doing this.

Settings for Graphic Consistency
One of the goals of using a template is to assure graphic consistency across a project or even 
across an office. To achieve that, you need to set up the object styles that control the graphic 
appearance of everything in your Revit project, from 3D elements to 2D lines and hatch patterns.

Object Styles
As we mentioned in Chapter 2, object styles control the graphics for all the categories in your 
project. To access these settings, switch to the Manage tab, choose Settings  Object Styles. This 
dialog box has three tabs: Model Objects, Annotation Objects, and Imported Objects. In this sec-
tion we’ll discuss the first two types of objects. The third tab, for imported objects, is where all 
DWG, DXF, or DGN files that you import in your Revit file appear. Even though these file types 
are based on a layering system, Revit still gives you full control over the graphics of each indi-
vidual layer by translating each layer into a subcategory. When you define your template, focus 
on the first two tabs: Model Objects and Annotation Objects. They both organize categories and 
subcategories into a collapsible tree structure. From here, you can define graphics for the main 
category as well as any subcategories. If we take a door family as an example, you can define 
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different graphic settings (line weight, color, and pattern) for the panel, the frame, and the door 
swing. The settings on these tabs are as follows:

Model Objects    As shown in Figure 4.3, six columns are used to control graphic properties 
of model elements. The first holds the list of all available categories and their subcategories of 
model elements in Revit.

The next two columns define the line weight that will be used when these elements are 
drawn in projection (elevation and 3D) or section (plan or section) view. In some of the cat-
egories, you’ll notice that the Cut column is grayed out; this indicates that the category of ele-
ment will never be cut by Revit. The furniture category, for example, will not be represented 
as cut in plan or section views. The next two columns define the color and pattern of the lines 
used to draw the geometry of these elements. The last column on the right lets you define a 
default material that will be associated with the category or subcategory in the event that ele-
ments in that category don’t have materials explicitly defined. If a family has materials set to 
By Category, it looks to the material set in the Object Styles dialog box. 

Annotation Objects    This tab is similar to the Model Objects tab. The difference lies in the 
material definition (lines don’t have materials!) and the line weight (there is no distinguish-
ing between projection and cut line weight), because annotation objects are 2D only.

All these settings may look like overkill at first, but you usually need to customize these 
values only at the beginning of a process when building your office templates. Once you’ve 
assigned all the desired line weights, colors, and materials, you shouldn’t mess around with 
them as these settings will affect the appearance of the entire project. While object styles are 
global, you do have the ability to change the graphic style of any element for a specific view 
using overrides (right-click in any view to open the context menu of the View Properties  
Visibility/Graphic Overrides, or you can use the keyboard shortcut, VG).

Figure 4.3 
The Object Styles 
dialog box gives 
you independent 
graphic control  
of all Revit cate
gories and their  
subcategories.
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Object styles allow you to establish the graphical standard for the drawings that leave your 
office, contributing to an appearance of professionalism, so be sure to take your time and invest 
in getting them right. These powerful settings shouldn’t scare you—they will ensure that your 
drawings have a consistent look and feel.

Line Styles
Much like object styles, a line style is composed of a line weight, line color, and line pattern and 
controls how all 2D and 3D lines will appear. Keep in mind that these settings are for the more 
traditional use of nonintelligent lines. To put this in context, when you draw lines or detail lines, 
they use a line style. To access the line styles, switch to the Manage tab, and choose Settings  
Line Styles. The dialog box that opens (Figure 4.4) has three columns to control the appearance 
of each line type. 

The Category column is organized in a tree structure, with all line styles listed as subcatego-
ries of lines. As you can see, each style is defined by Line Weight, Line Color, and Line Pattern. 
Line Weight can have a value between 1 and 16, corresponding to a physical pen thickness that 
varies slightly based on view scale. This is the actual thickness of the line when printed on 
paper at 100 percent. You’ll notice that lines have different thickness as you zoom in and out of a 
view; this is because the lines have a real thickness.

Line weights are managed from the dialog box shown in Figure 4.5, which you access by 
switching to the Manage tab and choosing Settings  Line Weights. As the scale gets coarser, 
line weights adjust so the drawing is still readable. Examining the Line Weights dialog box, 
you’ll notice that line thickness for heavy pens varies between scales.

Back in the Line Styles dialog box, notice that some of the line style names are bracketed 
but others aren’t. The bracketed line styles are internal, “system” types of lines, which can’t be 
renamed or deleted. Any unbracketed line style can be renamed or deleted at any time.

Figure 4.4 
Line styles define 
weight, color, and 
pattern for all lines 
used in a project.
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Caution When Deleting Line Styles

If you delete a line style that is used by elements in a project, those elements cannot reference that 
line style anymore. What happens is that the line style will appear retained but will actually be 
modified—its pattern will switch to Solid but the line weight will be the same.  This could create 
undesirable results, so use caution when deleting line styles from your projects or templates.

To create a new line style, click the New button in the Modify Subcategories button group. 
Enter a new name in the dialog box that opens, and confirm it by clicking OK. The new style 
appears in the tree structure on the left, and you can now set the rest of the parameters (Line 
Weight, Line Color, and Line Pattern) to suit your needs. 

Take particular care when modifying the line weights. There can be some confusion when 
the intended result is changing the weight of an element in a project. This should not be done by 
changing in the Line Weights dialog box, but rather through the Object Styles dialog box. For 
example, if you wanted the Cut value of a wall to increase from 5 to 7, don’t increase the value of 
5 in the Line Weights dialog box. You would change this value by selecting 7 as the Cut weight 
of a wall in the Object Styles dialog box.

Finally, don’t delete the range of model line weights based on the various scales. This is really 
an important feature in Revit. Certain line weights are modified slightly based on the scale of 
a drawing. For example, a line weight of 1 is very thin and doesn’t get any thinner as the scale 
decreases. But a line weight of 16, which is 1/2‘ wide at a scale of 1”=1’-0” rightfully decreases as 
the scale increases (to 0.20). Persistent line weights across all scales will produce illegible drawings! 

Line Patterns
A line pattern is a repetitive series of line segments, spaces, and points. To create a new line pat-
tern, switch to the Manage tab and choose Settings  Line Patterns. The resulting dialog box 

Figure 4.5 
Model line weights 
vary depending on 
the view scale.
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displays a list of existing line patterns in the project. On the right side are four buttons: New, 
Edit, Delete, and Rename (see Figure 4.6).

To edit an existing line, click the Edit button. To create a new line pattern, click New. You can 
then create a line pattern by specifying line and space lengths that form a repeating sequence. 
To rename a pattern, click Rename. Be careful when naming line patterns: if you give a line pat-
tern a name that already exists in the list, Revit overrides the existing pattern with the new one 
and overrides all elements that use that line pattern.

A pattern sequence can contain dashes, dots, and spaces. For dashes and spaces, you need to 
define their length; for points, a value isn’t necessary. The construction of a sequence is simple: 
in the Type column, you select Dash or Dot from the drop-down list, and in the Value column, 
you provide a length (if it’s a dash or space). For each row you add, only the available choices are 
shown in the drop-down list. Notice that in the first row, the drop-down offers only Dash and 
Dot as options—this is because Revit does not allow a sequence to begin with a space. Following 
the same logic, you can’t have a dot after a dash or the opposite, because they will merge and the 
result will look like a longer dash.

Before deleting any line pattern, you must verify that it hasn’t been used anywhere in your 
project. If you fail to do so, you’ll lose information, as the lines using the deleted style will be 
assigned to the Line category. This can only be done manually by checking line patterns used in 
the Object Styles, Line Styles, and Visibility/Graphic Overrides dialog boxes.

Creating a New Line Pattern
Follow these steps to create a new line pattern:

 1. Switch to the Manage tab and choose Settings  Line Patterns.

 2. In the Line Pattern dialog box, click New. 

 3. Give the new line pattern a name.

 4. Define the sequence, as shown in Figure 4.7.

Figure 4.6 
Line patterns are 
made of dashes, 
spaces, and dots.
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 5. Confirm by clicking OK.

 6. The resulting line pattern looks like this:

Materials
Defining materials in your project template is something you should not neglect. Materials fun-
damentally drive the graphic representation of elements. They don’t just affect the display of 
an element in rendered views—a big misconception—they are responsible for representing the 
chosen material in symbolic patterns for documentation purposes. Materials are also respon-
sible for cleanups, and they merge with one another when elements of the same materials are 
joined. For example, concrete walls join and appear contiguous with concrete floors when the 
elements’ geometry is joined together. A material also defines how an element’s surface looks 
in shaded views, when cut in plan or section, and when seen in 3D and elevation views. In 
Figure 4.8, the surface patterns are all derived from the material used in the element.

Figure 4.7 
Make a new pat
tern using this 
sample as a guide.

Figure 4.8 
Materials define 
the surface and  
cut patterns,  
color, and render 
material of the  
elements.

Surface Patterns

Surface Color
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To access the Materials Editor, switch to the Manage tab and choose Materials from the 
Project Settings panel. You’ll see the dialog box shown in Figure 4.9.

The Materials Editor has two components: a list and a tabbed properties interface. On the 
left is a list of all available Revit materials in the project. Below the list are options to duplicate, 
rename, and delete materials:

Duplicate    Use this button each time you need to create a new material. As with most ele-
ments you want to customize in Revit, always duplicate a material before you change any of 
its properties—if you fail to do so, you may change a material definition already used in the 
project and risk inadvertently changing and thus losing a lot of work. To create a new mate-
rial, find an existing material that closely matches what you want to make. Once you click the 
Duplicate button, you’ll be prompted to provide a name for the newly created material.

Rename    This works like all other Rename buttons in Revit. Clicking the button lets you 
rename the material. If you use a name that’s not unique, Revit will warn you and prompt for 
a unique name.

Delete   If for some reason you decide to do so, select the material that you wish to delete, 
and click the Delete button. You’ll need to click OK to finalize the deletion. Be sure you don’t 
delete a material that is already being used by elements.

On the right side of the editor are four tabs that contain material properties:

Graphics    Defines shading color, surface patterns, and cut patterns.

Render Appearance    Defines rendering attributes.

Figure 4.9 
Use the Materials 
Editor to define the 
hatch patterns on 
elements.
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Physical    Defines structural properties of a material (used for structural analysis).

Identity    Defines schedule values and keynotes.

We’ll concentrate on the Graphics and Render Appearance tabs, because those include the 
graphical properties of materials. The other tabs are used for scheduling and structural analysis 
and aren’t critical to this chapter.

Graphics

Here are the Graphics tab’s options:

Shading    This allows you to define the color and transparency used for the selected mate-
rial when a view is set to Shaded or Shaded with Edges display mode (Figure 4.10). Note 
that the color can be dependent on the associated render appearance. In that case, when the 
option Use Render Appearance for Shading is checked, the color and transparency are taken 
from the render appearance, and the color and transparency controls will be disabled.

Surface Pattern    This allows you select a model pattern that will be displayed on the faces 
of the elements in elevation, plan, and 3D views. Click the button next to the preview to see a 
graphical list of available patterns (Figure 4.11). You can control the color of patterns here as well.

Cut Pattern    The fill pattern that you select here is a drafting pattern, and it will be the 
pattern displayed when an element is cut through. Some Revit elements can’t be cut, as we 
discussed in Chapter 2, “Revit Fundamentals”; in these cases, this parameter has no effect on 
the graphic display and the pattern will not show.

Figure 4.10 
Shading properties.

Figure 4.11 
Use the visual pre
view to help choose 
the appropriate 
surface pattern.
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render appearance

Click the Render Appearance tab to view render properties. These properties will become vis-
ible only when you render a view and will not affect construction documentation graphics. 

It may seem impossible to imagine all the materials you’ll need in a project, making build-
ing a template seem daunting. Think of the basic materials you’re likely to use—woods, brick, 
concrete, glass, and so on—and build from those. Remember, a template is just a starting point, 
and you can always expand it. If you end up making a lot of nice materials over the course of a 
project, use the Transfer Project Standards function to move materials back into your templates.

Fill Patterns (Hatches) 
Materials are often represented with simple hatch patterns. For any material used in Revit, you 
can define a surface pattern and a cut pattern. For simple parallel hatches and crosshatches, you 
can use the patterns already supplied in Revit or you can make your own custom hatches.

For more complex patterns, you need to import an external pattern file (.pat). To create, 
modify, or view an available fill pattern, switch to the Manage tab and choose Settings  Fill 
Patterns (see Figure 4.12). On the left side of the Fill Patterns dialog box, you can view the names 
and small graphic previews of the patterns to help you visualize as you select and edit the pat-
terns. Below those are the Pattern Type options, where you choose what type of patterns to 
create and specify what type of pattern you wish to edit (drafting or model). As with the Line 
Styles dialog box, the New, Edit, and Delete buttons appear on the right.

There are two types of fill patterns: model patterns and drafting patterns. Use the model pat-
terns when you want to convey real-world dimensional patterns to represent a material. Use 
drafting patterns for symbolic representations. For example, a model pattern is used to show a 
brick pattern in 3D and elevation views, whereas a drafting brick pattern is used to represent 
the cut pattern in plan and section. Figure 4.13 shows how concrete masonry units (CMUs) are 
represented with a running bond pattern (model) as well as a crosshatch (drafting).

Another way of thinking about this is that model patterns are “glued” to a surface, while draft-
ing patterns are not. Try this: rotate a wall with a model pattern and you’ll notice that the pattern 
rotates with respect to the wall. Now rotate a wall with a drafting pattern (like Concrete or Diagonal 
Crosshatch). The drafting pattern is not “fixed” to the wall and rotates with respect to the screen. 

Figure 4.12 
Fill patterns are 
defined separately 
for drafting  
and model  
representations.
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Model and drafting patterns have specific behaviors. In our example, we have a CMU wall 
with blocks that measure 16˝ × 8˝ (40mm × 20mm), regardless of the view scale. With a drafting 
pattern, the opposite is true: the pattern adjusts with the view scale so the pattern looks identi-
cal in all scales.

To create a new pattern, first choose either Model or Drafting, and then click the New button. 
A generic pattern appears in the New Pattern dialog box. You can then design your pattern and 
assign some behaviors.

The option Orientation in Host Layers is particularly useful when you’re making drafting 
patterns. This allows you to specify how a pattern orients itself relative to host elements such 
as walls, floors, roofs, and ceilings when they’re represented as cut. (Note that the option isn’t 
available for model pattern types.)

The three options shown in Figure 4.14 are described here:

Orient to View    When this orientation is applied, the patterns used in the project all have 
the same orientation and the same origin. They’re always perfectly aligned with the origin of 
the view.

Figure 4.13 
The CMU wall type 
has both a drafting 
pattern (cut) and 
a model pattern 
(surface) defined.

Cut Pattern

Surface Pattern

Figure 4.14 
From left to right: 
pattern orientation 
Orient to View, 
Keep Readable, 
and Align with 
Element.
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Keep Readable    This orientation is best understood when compared with the Keep 
Readable attribute of text—it stays readable (will not appear upside down) regardless of its 
orientation. 

Align with Element    This orientation ensures that the pattern orientation depends on the 
orientation of the host element. Patterns essentially run parallel with the element.

You can choose to make either simple or custom patterns with this dialog box, using the 
radio button options. Figure 4.15 shows the result of each option.

Simple    These patterns are generated with parallel or crosshatch lines that can have differ-
ent angles and spacing. With both the crosshatch and parallel options, you can specify only 
one angle for the entire pattern. Using crosshatch, you can set two spacing values. The exer-
cise in the sidebar “Creating a Simple Fill Pattern” demonstrates creating a fill pattern.

Custom    To create a more complex custom pattern, you have to import a pattern (.pat) file 
from an external source. This is often necessary due to Revit’s current limitation in creating 
natively complex patterns. Your office may have a set of established patterns they’ve been 
using for years, and the Custom option allows you to import and reuse them without having 
to make them again from scratch. Custom patterns let you import a PAT file from anywhere 
on your hard drive or on a network and use it as a base pattern for a new fill pattern in Revit. 
The next section shows some best practices for importing a PAT file.

creatinG a custom pattern usinG a pattern File 

Custom patterns require an external file that contains the definition of the pattern. The file 
extension of that pattern should be .pat, which is what you’ll make in this section by editing an 
existing AutoCAD PAT file. An advantage of specifying patterns in the template file is that the 
PAT file won’t need to be installed on each computer where Revit is installed; Revit stores each 
pattern internally in each template or project.

Before modifying PAT files, always make a copy of the original PAT file you intend to use as a 
base; you don’t want to risk messing up other files that might already be using that original PAT 
file. PAT files can be edited with Notepad, but any text-editing application will also do. For this 
exercise, you’ll choose the AutoCAD pattern called Grass, which you can find in acadiso.pat in 
metric units) or acad.pat (Imperial units) located in the Chapter 4 folder on the book’s compan-
ion web page (www.sybex.com/go/masteringrevit2010).

Figure 4.15 
From left to right: 
simple fill pat
tern, simple fill 
pattern with the 
crosshatch option 
selected, and a cus
tom fill pattern.
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importinG a custom pattern

Follow these steps to make a custom fill pattern by importing an existing pattern definition:

 1. Using Notepad, open the file acadiso.pat or acad.pat.

 2. Highlight the lines that define the pattern, and select them:

45, 6.35, 0, 4.49013, 4.49013, 1.5875, -5.80526, 1.5875, -8.98026
*GRASS, turfed surface
90, 0, 0, 17.9605, 17.9605, 4.7625, -31.1585
45, 0, 0, 0, 25.4, 4.7625, -20.6375
135, 0, 0, 0, 25.4, 4.7625, -20.6375
*GRATE, grid
0, 0, 0, 0, 0.79375

 3. Choose Edit  Copy.

 4. Open a new text file, and paste the selection. (Note that you can also open the PAT file 
located in C:\Program Files\Revit Architecture 2010\Data, in which all Revit pat-
terns are already saved. In that case, you can paste the selected text in that file.)

 5. This is the important part: in the new text file where you pasted the selected text, add the 
two lines shown highlighted here:

;%UNITS=MM
*GRASS, turfed surface
;%TYPE=DRAFTING
90, 0, 0, 17.9605, 17.9605, 4.7625, -31.1585
45, 0, 0, 0, 25.4, 4.7625, -20.6375
135, 0, 0, 0, 25.4, 4.7625, -20.6375

The first line that you write before the pattern text, ;%UNITS=MM, can appear only once in the 
text file. It defines the value for the units used in the pattern. In the example, the units are 
millimeters (MM); if you wanted to work in imperial units, it would be ;%UNITS=INCH. (If you 
followed our second option to not create a new note for each file but collect them in one file, 
then this line already exists and you don’t need to add it.)

The second statement, ;%TYPE=DRAFTING, helps define whether you’re creating a drafting or 
model pattern. In this example, the pattern is the drafting type. 

 6. Save your text file with a .pat file extension.

 7. From the Manage tab, choose Settings  Fill Patterns.

 8. In the Fill Patterns dialog box, verify that the Drafting option is selected, and click New.

 9. In the New Pattern dialog box, select the Custom option. The lower part of the dialog box 
offers new options.

 10. Click Import.

56491c04.indd   111 6/2/09   4:47:25 PM



112 | Chapter 4 Setting Up YoUr templateS and office StandardS

 11. Navigate to the place on your hard drive or network where you saved the PAT file, and 
click Open.

 12. In the list that appears to the right of this button, you can see the name of the pattern you 
created: Grass. (If you have a PAT file with many patterns defined, you see all the other 
drafting patterns available in that list.) The name of the pattern automatically becomes 
the name of your fill pattern, but you can change that if you like. See Figure 4.16.

 13. If necessary, you can adjust the scales of the imported pattern. The Preview window dis-
plays the graphic of the pattern, always in 1:1 scale. This informs you if you need to scale 
the pattern up or down. You’ll know that you need to scale the pattern if the preview 
appears as a solid black box—that means the pattern is too dense.

 14. If you’re happy with the result, confirm by clicking OK.

Creating a Simple Fill pattern

Often, the default templates don’t have all the patterns you need. Following these steps, you can 
make a new simple fill pattern:

 1. From the Manage tab choose Settings  Fill Patterns.

 2. In the Fill Patterns dialog box, choose to make either a model or a drafting pattern, and 
click New. 

Figure 4.16 
The New Pattern 
dialog box displays 
the imported PAT 
file in the Custom 
group.
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 3. In the New Pattern dialog box, enter a new name for the fill pattern.

 4. If Drafting is selected, also choose an option from the Orientation in Host Layers dropdown.

 5. In the Simple group, enter a line angle. Choosing to create a crosshatched pattern lets you define 
the line spacing in both directions of the crosshatch. Note that a crosshatch always makes the 
second set of parallel lines perpendicular to the first. 

 6. The Preview window shows the pattern. Click OK to commit the pattern to the model. 

 importinG pat Files

When you import a new pattern, the type of pattern needs to be the same as the new type of pat-
tern you’re making. In other words, if you’re making a new model pattern, you can’t import a draft-
ing pattern. If you try to do so, you’ll see a warning message like the one shown in Figure 4.17.

Dimension Styles
Dimensions are system families used to dimension the model. Dimensions can be linear, angular, or 
radial; each of these has a set of type parameters that control their graphic characteristics. In Revit 
you have dimension styles in which predefined type parameters are set. When placing dimensions 
in the project, you can choose between aligned, linear, angular, radial, and arc length dimensions. 
Depending on the choice you make, a corresponding dimension style will be chosen for you:

Aligned, linear, and arc length dimensions are associated with the system family Linear •u	

Dimension Style.

The angular dimensions are associated with the system family Angular Dimension Style.•u	

The radial dimensions are associated with the system family Radial Dimension Style.•u	

Figure 4.17 
If you try to assign a 
drafting .pat pattern to 
a Revit model pattern, 
you’ll see a warning.
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properties oF dimension styles

Dimension styles can vary from a rigid technical appearance to more creative and sketchy types. 
Figure 4.18 shows three variations of a liner dimension style, each using a different type of tick 
mark. A wide range of graphic controls is at your disposal. Most conventions can be achieved 
using the options located in the type properties of your dimension types. Options include tick 
marks, length of dimension lines, extension, text type, spacing of text, spacing between the text 
and the dim line, and so on. Figure 4.19 shows the type properties of a linear dimension. 

Let’s look at the various ways you can customize the appearance of dimensions:

Dimension String Type    This parameter allows for control of how a string of multiple 
dimensions will appear. It has three options: Continuous, Baseline, and Ordinate. The con-
tinuous type is typical of architectural drawings; the others are seen in structural drawings. 
Figure 4.18 shows the difference between the appearances of the three string types.

Tick Mark    This option allows you to select the type of graphic called a tick mark that marks 
the crossing between the dimension line and the extension lines. You can select the type of 
the tick mark but not its size. Adjusting the size isn’t possible directly from the Dimension 

Figure 4.18 
Dimension string 
types can have 
various tick marks 
assigned.

Figure 4.19 
Type properties  
are used to  
define different 
graphic styles for 
dimensions.
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Type dialog box. To edit a tick mark or make a new one, from the Manage tab choose 
Settings  Arrow Heads. You’ll see the Type Properties dialog box shown in Figure 4.20.

Line Weight    This sets the thickness of the line that represents the dimension line and can 
be any value from 1 to 16. These numbers correspond to the weights defined in the Line 
Weights dialog box (Manage tab  Settings  Line Weights  Annotation Line Weights).

Tick Mark Line Weight    You can set the thickness of the tick mark to any value from 1 to 16.

Dimension Line Extension    This setting allows you to define the length of the extension of 
the dimension line beyond the tick mark. In this example, the line extension has been high-
lighted in bold:

Flipped Dimension Line Extension    This setting is grayed out unless Tick Mark is set to 
Arrow Head. It inverts the direction of the arrows when the space between them is too small 
to accommodate both arrows in the dimension space. This parameter controls the length of 
the extension of the dimension line after the arrow symbol. 

Witness Line Control    This setting controls the position of the witness lines with respect 
to the element that is dimensioned. You can choose one of the following options: Gap to 
Element or Fixed to Dimension Line.

Figure 4.20 
Type properties of 
a tick mark.
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Witness Line Length    This parameter defines the length of the witness line. It’s active only 
when Witness Line Control is set to Fixed to Dimension Line.

Witness Line Gap to Element    This parameter sets the distance between the element that is 
dimensioned and the witness line. It’s active only when Witness Line Control is set to Gap to 
Element.

Witness Line Extension    This parameter controls the length of the witness line above the 
dimension line. 

Centerline Symbol    Some local standards require a specific graphic representation of the 
dimensions that reference to the center axis of an element. By loading custom annotation 
symbol families into your project, you’ll be able to choose which one is best suited to your 
needs. 

Centerline Pattern    Using this parameter, you can define a line style when you’re dimen-
sioning to the center axis of an element. Again, this is to accommodate various local stan-
dards that require the center of elements to be graphically different from other dimensions. 

Centerline Tick Mark    This is the third graphical way to make the axes or centers of ele-
ments easily recognizable. This parameter allows for a different graphic to be used as a tick 
mark when dimensioning centerlines of elements. 

Interior Tick Mark    If more than one set of arrows don’t fit in the space in a dimension chain, 
you can define smaller or simpler tick marks for the interior portions of the dimension segment. 

Color    This parameter allows you to define any color for a dimension style (text and lines 
are both affected). 
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Dimension Line Snap Distance    Before you click the second line in a dimension chain, a 
dimension help line in a dashed green style appears, to help with positioning. The snap dis-
tance defines the automatic offset between two dimension lines. When you place a second 
dimension chain, the second one snaps to this designated offset.

Text    Text height, offset from the dimension line, reading convention, text font, background 
(opaque or transparent), and unit format can all be set, allowing for a high level of customi-
zation when you create your own style.

Show Opening Height    When selected, this parameter displays the opening height of the 
element that is dimensioned, as shown here:

You can customize and rename the existing types and also create your own. To create your 
own type, you need to select an existing type, duplicate it, give it a name, and then edit the 
parameters:

Create a new type    In the Type Properties dialog box, click Duplicate, give the new type a 
name, and click OK. 

Rename a type    In the Type Properties dialog box, select a type from the Type list, click 
Rename, give the type a new name, and click OK. 

Delete a type    To delete a type, switch to the Manage tab, and from the Project Settings 
panel, choose Purge Unused. In the Purge Unused Elements dialog box, select the dimension 
types you wish to delete, and click OK.

Text
Text is used to add notes to your drawings and can be customized to suit your needs. By default, 
Revit provides a couple of styles for you—feel free to edit these and add more as you see fit. 
Standard graphical control over size, font, color, and style are provided as well as the ability to 
add leaders to text.

Text is another form of system family and offers a range of graphic options for customization. 
Realistically, Revit isn’t a full-blown text-editing application and it would benefit from many 
improvements when it comes to text editing; so you won’t see the same level of font and para-
graph style control that you might find in regular text editors. However, a number of common 
parameters let you change the appearance of text.
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properties oF text

Some text parameters are exposed directly in the Place Text tab appearing after selection of the 
Text tool in the Annotate tab or when text is selected for editing. 

However, most properties are managed through the Type Properties dialog box accessible 
by clicking the Element Properties button in the same tab. The following text properties can be 
accessed by selecting text and going to the Type Properties dialog box:

Color    Text can be assigned any color using a standard color picker.

Line Weight    Any text note can be accompanied by leader lines—this parameter controls 
the weight of the leader lines. 

Background    The background on which text is written can be opaque or transparent. An 
opaque background is solid white and obscures other elements beneath it; a transparent 
background lets elements show through the text area. The usage of this parameter depends 
on the style of graphics you want to show. In busy drawings, setting the background opaque 
can help keep text readable. Figure 4.21 shows the effects of this parameter.

Leader Arrowhead    This parameter defines the leader arrowhead used in the leader line. 
You can’t define the size of the leader arrowhead here. If you wish to create another size of 
leader arrowhead, go to the Manage tab, and from the Project Settings panel choose Settings 
 Arrowheads.

Keep Readable    This parameter accommodates different reading conventions for the text 
with respect to the screen and sheet. The Keep Readable parameter is an Instance parameter.

Text Font    This parameter controls the font that will be used for the text.

Text Size    This parameter controls the height of the text in dimensional values. Revit doesn’t 
support the use of standard point sizes; you type in values in inches (mm).

Tab Size    This parameter controls the length of text when a tabulator is included in the text 
string. 

Bold    This parameter makes the text bold.

Italic    This parameter makes the text italic.

Figure 4.21 
Text with (left) 
opaque and (right) 
transparent  
backgrounds
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Underline    This parameter underlines the text.

Width Factor    This parameter lets you control the length of text without affecting its height. 
The default value is 1. If you want the text to be narrower, change this value to less than 1. If 
you need the text to be wider, the value must be greater than 1. In the example shown here, 
on the left the width factor is 0.5, in the center it’s 1.0, and on the right it’s 2.0.

You can customize and rename the existing types and also create your own. To create your 
own type, you need to select an existing type, duplicate it, give it a name, and then edit the 
parameters to suit your requirements:

Create a new type    In the Type Properties dialog box, click Duplicate, give the new type a 
name, and click OK.

Rename a type    In the Type Properties dialog box, select a type from the Type list, click 
Rename, give the type a new name, and click OK.

Delete a type    To delete a type, switch to the Manage tab and choose Purge Unused. In the 
Purge Unused Elements dialog box, select the dimension types that you wish to delete, and 
click OK.

Creating Custom Annotation Tags
Many kinds of annotations are used in design and construction documents. These range from 
door and window tags, to wall and room tags, to view tags for sections and elevations. You can 
see the full list of annotation categories in the Object Styles dialog box, under the Annotations 
Objects tab (Figure 4.22). Using the Family Editor, you can customize all of these tags (with 
the exception of elevation tags) to meet your graphic conventions. In this section, we’ll walk 
through the creation of some common tags and show you how to make your own.

Figure 4.22 
The Annotation 
Objects tab of  
the Object Styles 
dialog box.
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archiving and Managing Your Custom Families

Many new users of Revit are unsure where to store customcreated families. It isn’t advisable to save 
them in the system folders created during the installation of Revit, because you may lose track of 
them or inadvertently delete them when you reinstall the software. Reinstalling Revit erases just 
about any folder and its entire contents. It is thus advisable to keep your personally created content 
somewhere else, under a separate independent folder; if you are not a single user, store that folder 
on a shared network drive.

You should also keep your templates up to date as you add more content; that way, you need only 
maintain a few template files rather than dozens of separate family files. It’s even better if you can 
establish this as a role within the office so no one is making graphical changes to your templates.

View Tags
Section, callout, and elevation tags are graphic indicators that reference (link to) other views 
in your project. The graphics for these elements can be customized to meet most scenarios. To 
create a custom section tag, for example, you have to first create a custom section tag family. To 
access the view tags, switch to the Manage tab and choose Settings. From here, you can custom-
ize the Callout, Elevation, and Section tag view tags through their Type Properties dialog boxes. 
By default, there is a predefined view tag for each view type. The graphics can vary depending 
on the language version of Revit you have installed on your machine. The tags shown here are 
displayed and available by default in the USA English version:

You can use the existing tag, rename it or duplicate it, and amend its properties to create your 
own custom tag.

The creation of custom view tags slightly differs depending on which view tag you’re work-
ing with. Some require you to load a family file (.rfa) that can be fully customized with the 
Family Editor; others don’t have corresponding family files and allow only limited customiza-
tion directly within the project.
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section View taGs

Before selecting a section tag, make sure you load multiple section tags from the family library 
so you’ll have some options to choose from. This can be useful when you decide to use different 
section tags for building sections and wall sections as one example and maybe even different 
tags for presentation plans than for construction documents. To implement these options in 
your project, you need to create each set of tags and load them into the project environment so 
they’re available to select from the tag’s Type Properties. All the section tags are defined in the 
Manage tab, Project Settings panel, under Settings  Section Tags. In the Type Properties dialog 
box, you will find the following parameters:

Section Head    With this parameter, you can select different symbols for the section head. 
The drop-down list contains all loaded section view tag families (RFA files). Note that you 
can create your own fully customized section head using the Family Editor. Once selected 
from the list, the section head family appears at the beginning of the section line.

Section Tail    In some countries, a section line is described with the same symbol at the 
beginning and the end; in others, a section head appears on only one end of a section line, 
and at the other end is a section tail (a simplified graphic). This parameter lets you select the 
tail graphic. Like the section head, this symbol can be fully customized in the Family Editor 
and loaded as a family (RFA file). Once selected from the list, the section head family appears 
at the beginning of the section line.

Broken Section Display Style    It’s usual practice when documenting a building to make 
nonlinear sections—sections that change direction and cut through the more important 
aspects of the design. With the section line selected, use the Split Segment tool from the 
Section panel of the Modify Views tab to split a section in many segments. To split a section 
line with gaps, click on the break icon located on the section line (see Figure 4.23).

Creating a Custom Section Tag

To create your own section tag, you first need to select the tag family to which your new tag will 
belong. You have two options:

The family already exists in your library, in which case all you need to do is load it into the •u	

template.

The RFAs from the library don’t correspond to your needs, and you wish to create a custom •u	

section tag. In this case, you first have to create a section tag in the Family Editor and then 
load it in the template.

Figure 4.23 
Click the “gaps in 
segments” icon in 
the middle of the 
section line to split 
the line.
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This section’s examples show how to create a custom tag family that you’ll then use for your 
custom section tag.

Static Text and Parametric Labels    Creating annotation families in the Family Editor is by 
no means difficult, but you must understand the principle of using parametric labels and text:

Text    In the Family Editor, placing text in an annotation or title block means you’re 
defining text that will always be the same and is unchangeable when that annotation is 
placed in the project environment. Figure 4.24 shows the words AREA and VOLUME 
as text. Regardless of where this room tag is placed, the text will always say AREA and 
VOLUME. Section tags work the same way: if you add static text, that text appears exactly 
the same for all section marks. This isn’t typically used for sections, because each section 
is a reference to a unique view, and you want that information to be dynamic and para-
metric. That’s where label functionality comes into play.

Labels    A label offers textual information, but unlike static text, it’s a live reference to 
a parameter value of an element in the project. It pulls information about a parameter 
directly from the BIM model. So, if you add an Area label, it will pull the value of the 
area of the room; if you add a Sheet Number label in a Section Head family in the Family 
Editor environment and then use that section head in a project, the label will automati-
cally display the actual sheet number on which this section is placed in the project. If you 
move the section from one sheet to another, the label will automatically report the new 
sheet number. In Figure 4.24, Unit 4 is a label of the room name; the number 201 is a label 
of the room number. The label behaves as dynamic text and is always fully coordinated 
with the value of the parameter it represents. Like text, labels have graphical properties 
such as height, color, and font.

Creating a Custom Section Tag Family

An exercise will clarify what we just discussed. Imagine you would like to create a section tag 
that looks like the one shown in Figure 4.25. You need to first create a section tag family using 

Figure 4.24 
A custom room 
tag showing room 
name, number, 
area, and volume.
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the Family Editor and then load it into your template before you can create the tag in the project. 
Follow these steps:

 1. From the Application Menu choose New  Family  Annotations.

 2. In the Open dialog box, select the family called Section Head.rft or M_Section Head.rft, 
and click Open.

 3. The Family Editor environment automatically opens, and the drawing area shows a view 
in which three green reference planes (two vertical and one horizontal) have already been 
drawn. Do not change the position of either the horizontal reference plane or the vertical 
reference on the right. In some templates, this is indicated with help text in red (which 
you should later remove).

The intersection of horizontal and right reference planes defines the connection location with 
the section line. This means your annotation will be located in between the two intersection 
points.

A proposed geometric shape is drawn for the annotation: a circle (two arcs) and a hori-
zontal line. You’re free to delete this default geometry and create your own tag shape. The 
default shape is there to help you visually understand where to begin drawing your new tag 
geometry.

 4. Select the arcs that create the circle (use the Ctrl key for faster selection), and delete them. 

 5. From the Annotate panel on the Create Tab, click the Label button. Position your cursor 
between the two vertical reference planes and below the horizontal plane, and click to 
position the start of the label. The cursor changes as shown here:

Figure 4.25 
Custom section tag.
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 6. In the Edit Label dialog box, select Sheet Number. Click the Add Parameter(s) to Label 
button. In the Sample Value column, you can enter a value; the default is A101. 

This isn’t an actual value that will be displayed—it’s a sample value that is visible only in 
the Family Editor. The text is a placeholder for an eventual real parameter value and is only 
here to help as a reference with layout. Once you load the family into a project template or 
project, this value will be replaced with the actual parameter value pulled from the database 
of your model. The default value is logical, so confirm by clicking OK. The label is placed 
and displays blue grips when selected. These let you change the length of the label text field. 
The length is important, because any value that is added (in a project) that is longer than the 
length of this box will begin to wrap and could mess up your graphics.

 7. Following the same principle, place the label Detail Number above the horizontal refer-
ence but still between the vertical references.

 8. You can reposition a label by selecting it and using the Move button to move it around. 
For more precise positioning, use the arrow keys on your keyboard to nudge elements in 
small increments. You can also help yourself by zooming in for a better view. (Note that 
zooming in makes the increment for the nudge tools finer.) 

 9. From the Detail panel of the Create tab, click the Filled Region button. You’ll be put into 
Sketch mode. Using the Line tool, draw the shape shown here. In the Region properties, 
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check that Color is set to Black and Cut Fill Pattern to Solid Fill. Make sure the lines form 
a closed loop (no gaps or overlapping lines).

 10. Click Finish Region from the Create Filled Region Boundary tab. If you did everything 
correctly, you should have a custom-designed family, as shown here:

Save the tag you just created somewhere on your hard drive or network, and you’re ready to 
use it in the template or a project. To load it into your project, click the Load into Project but-
ton located in the Family Editor panel of the Modify Filled Region tab. Choose the project 
you want to use the symbol in, and click OK.

In the next exercise, you’ll assign this tag to a section mark in the context of a project.

Creating a Section Tag with a Custom Head/Tail Graphic

To create a section type that utilizes the section head family you created previously, you need to 
load the created section head in the template file:

 1. Switch to the Insert tab and from the Load from Library panel, choose Load Family.

 2. In the Load Family dialog box, find the section head you created previously, select it, and 
click Open.

 3. Switch to the Manage tab and select Settings. From the Settings menu, click Section Tags.

 4. In the Type Properties dialog box, click Duplicate.

 5. In the Name dialog box (Figure 4.26), name the new tag Filled Arrow and click OK.

Figure 4.26 
Naming the new 
section view tag.
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 6. In the section head’s Type Properties dialog box, click the drop-down menu and select 
your custom head family. For Section Tail, click <none>. This means the other end of the 
section line will not use a symbol (Figure 4.27). Click OK. 

 7. Switch to the View tab and from the Create panel, select Section.

 8. From the Section tab, select Element Properties.

 9. In the Instance Properties dialog box, click Edit, and from the Type Properties dialog box, 
select Duplicate.

 10. Name the new type Filled Arrow - No Section Tail, and click OK (Figure 4.28).

 11. Under Section Tag, click the drop-down menu, select the tag you created, and click OK.

You can now place a section in your drawing area and see the results shown in Figure 4.29. 

Note that each time you create a new section type, Revit creates a new folder for it in the 
Project Browser. Our example uses two types of sections: building sections and detail sections. 
When you place one of each in a project environment, they’re each placed in a new folder named 
by section type.

As you’ll see next, the same principles apply when you make callout views.

Figure 4.27 
You just created 
a new section tag 
that you now wish 
to associate with a 
section type.

Figure 4.28 
Create a new sec
tion type with a 
unique name.

Figure 4.29 
Draw one of your 
new sections— 
it should look  
like this.
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callouts

In order to have a variety of different callout tags in the project environment, you must load 
some customized callout tags into the project. To do that, switch to the Insert tab, and from the 
Load from Library panel, select Load Family. Under Annotations, find the available callout tags. 
The properties of callout tags offer a few options:

Callout Heads    This parameter defines the family and the callout type that will be used. 
The drop-down list contains all loaded callout head families (RFA files); you can also use no 
family (None). Using the Family Editor, you can create callout head families just as you can 
for section heads and tails.

Corner Radius    A callout in Revit usually has a rectangular shape with filetted edges. This 
parameter lets you define the radius of those arcs on the corners of the callout tag.

Creating a Custom Callout Head

Figure 4.30 shows on the left the callout tag family you’ll create in this exercise. Follow these 
steps:

 1. From the Application Menu choose New  Family Annotations.

 2. In the Select Template dialog box, select the family template called Callout head.rft or 
M_Callout Head.rft, and click Open.

 3. The Family Editor opens, and a view with two crossing reference planes appears. Again, 
if you want to avoid problems later, don’t move either of these two planes. In red, you’ll 
see important guideline text: always read it before deleting it. This text informs you that 
the tag will be positioned in the center of the crossing of the two reference planes and 
that the callout leader will be trimmed (adjusted) to match the width of the drawn ele-
ments. Select the help text and delete it. 

 4. From the Annotate panel of the Create tab, click the Label button. Click the vertical refer-
ence plane and above the horizontal one to position the label.

Figure 4.30 
(left) Custom call
out annotation; 
(right) custom 
callout annotation 
associated with 
callout boundary.
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 5. In the Edit Label dialog box that opens, select Detail Number; in the Value zone, you 
can place a value as explained in step 6 of the exercise in the section “Creating a Custom 
Section Tag Family.”

 6. Following the same principle, add another label—this time using Sheet Number—and 
position it below the horizontal reference plane.

 7. Switch to the Create tab, and from the Detail panel, select Filled Region. Revit goes into 
Sketch mode. Using the Line tool, draw the shape that represents the graphic of the call-
out tag you wish to create. Make sure the filled region uses a solid fill black pattern by 
editing its type properties.

 8. Click Finish Region.

 9. You can also adjust the text to be a different font or font size if desired. The annotation in 
the Family Editor should look like this:
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 10. Save your callout tag, and load it into your project.

 11. In the project, switch to the Manage tab, and choose Settings  Callouts. Make a new 
type, or edit an existing type by choosing the family you just loaded in. You should do 
this in order to take advantage of your custom tag. Simply loading it into your project 
won’t automatically assign it to a callout.

Changing the Graphic appearance of the Filled region in a Callout tag

You may want to use colors other than black for the filled region, and you may want to make it 
transparent or opaque. This will result in a different graphic presentation when you place the tag 
in the project and a different graphical presentation when it’s printed, because most reprographics 
companies don’t print fullsized sheets in color.

Callout Views—Type Properties

The following are the type properties of a callout view:

Callout Tag    Lists all available callout tags.

Reference Label    The default label for referenced callouts.

Creating Callout Tags

You’ve already created your Callout Head family. Now you’ll load it in the template file and 
associate it with a callout tag:

 1. Switch to the Insert tab, and from the Load from Library panel, select Load Family. 

 2. In the Load Family dialog box, find the callout head you created previously, select it, and 
click Open.

 3. Switch to the Manage tab, select Settings, and from Settings menu, choose Callout Tags.

 4. In the Type Properties dialog box, click Duplicate.

 5. In the Name dialog box, name the new tag Filled Rectangle, and click OK (Figure 4.31).

 6. Next to Callout Head, click the drop-down list and select your callout family. Next to 
Corner Radius, set the angle that will be applied to the corners of the callout boundary 
line (Figure 4.32).

Figure 4.31 
Give the callout 
tag type a unique 
name.
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 7. Click OK. You just created a new callout tag that you can now associate with a callout type. 

 8. Switch to the View tab and from the Create panel, select Callout.

 9. From the Callout tab, click the Element Properties button. 

 10. In the Instance Properties dialog box, click Edit and then from the Type Properties dialog 
box select Duplicate.

 11. Give the new type a name (Filled Rectangle - Corner Radius 3.5mm), and click OK 
(Figure 4.33).

 12. Under the Section Tag parameter, click the drop-down list and select the callout tag you 
created. 

 13. Click OK.

You can now place a callout in your drawing area and see the results shown in Figure 4.34.

eleVation taGs

Unlike all other tags in Revit, elevation tags don’t reference a family file and are customizable 
only to a limited extent. You can’t create custom elevation tags—the only thing Revit lets you do 

Figure 4.32 
Choose the callout 
head, and set the 
radius for the call
out corners.

Figure 4.33 
Create a new call
out view type.

Figure 4.34 
The final appear
ance of the new 
callout type.
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is choose between a round or square-shaped elevation tag and make a few small modifications 
to those shapes. However, you can create different elevation tags for exterior and interior eleva-
tions. Figure 4.35 shows the properties for elevation tags.

Elevation Tag Properties

The following parameters are available in the Type Properties dialog box for elevation tags:

Shape    This provides the two possible shapes for elevation tags: Circle and Square.

Text Position    Each elevation tag allows text to show the number of the view when placed 
on a sheet. This value is empty until that elevation view is placed on a sheet. You can also 
decide to add the name of the view to the elevation tag. This can make the tag busy and 
illegible, so consider your options carefully. Figure 4.36 shows the options from left to right: 
Outside Left, Outside Center, Outside Right, and at the end, Inside. In the last case, it’s prefer-
able for better legibility to select an empty arrowhead. 

Figure 4.35 
Type Properties 
dialog box of an 
elevation tag.

Figure 4.36 
Elevation varia
tions, left to right: 
Outside Left, Out
side Center, Out
side Right, Inside.
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Arrow Angle    The arrow indicates the direction of the view, and this parameter controls the 
angle of the arrow. 

Filled    This option controls whether or not the arrow associated with the tag is filled. Set 
this option depending on your graphical requirements.

Show View Name    This parameter allows you to add the information about the name of the 
view in the elevation tag.

View Name Position    If you’ve decided to add the view name in the elevation tag, this 
parameter allows you to control the position of the name.

Reference Label Position    This parameter controls the position of the reference label with 
respect to the tag. Figure 4.37 shows the different positions, from left to right: Outside Left, 
Outside Center, Outside Right.

Line Weight    This parameter defines the weight of the lines used for the entire tag. The Line 
Weight value can be any number from 1 to 16. 

Color    This parameter defines the color of the lines.

Line Pattern    This parameter defines the line pattern for lines used in the tag.

Text Font    This parameter defines the font used in the tag. 

Text Size    This parameter defines the height of the text used in the tag. 

Width    This parameter defines the size of the shape. If you choose Circle, this value is the 
diameter; if the tag is square, this is the size of the square.

Elevation View Type Properties

The following parameters are available as elevation type properties:

Elevation Tag    This parameter lists all available elevation tags in the project. You create 
elevation tags in the Settings  View Tags  Elevation Tags dialog box.

Figure 4.37 
The name of the 
elevation can 
appear on each 
arrow.
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Callout Tag    This parameter lists all available callout tags in the project. You create callout 
tags in the Settings  View Tags  Callout Tags dialog box. 

Reference Label    This parameter defines the default label for referenced elevations.

Custom elevation tags Workaround

As we mentioned previously, elevation tags are the only tags in Revit for which you can’t create your 
own graphics using the Family Editor. For example, many firms use the same symbol for sections as 
they do for exterior building elevations. A common workaround to this problem is to use sections 
in lieu of elevations to get the right graphic appearance.

This workaround works well and is simple. The only downside is that your building elevations will 
appear under the Section tree in the Project Browser.

Creating an Elevation Tag

Unlike section and callout tags, to create a new elevation tag you can’t load an elevation family, 
because there are none. You can create your custom elevation tag only by duplicating an existing 
one and changing its properties. You will be able to change the appearance of the elevation tag 
to a degree and then associate it with a new elevation view type. Follow these steps:

 1. Switch to the View tab, and from the Create panel, select Elevation.

 2. Click the Element Properties button.

 3. In the Instance Properties dialog box click Edit, and then from the Type Properties dialog 
box click Duplicate. 

 4. Give the new type a name (Elevation Tag Presentation), and click OK.

 5. Under the Elevation Tag parameter, click the drop-down list and select the elevation tag 
you created.

 6. Click OK.

You can now place an elevation in your drawing area and see the results, as shown here:
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Assigning a Family to a View Tag

We discussed how to create custom annotation families that are used to create custom tags. To 
put these annotations to use, you need to assign them to a view tag type. For sections and call-
outs, you use a section head family and a callout family. To assign an annotation to a section or 
callout view tag, switch to the Manage tab, and choose Settings  Section Tags. In the resulting 
dialog box, you can choose what symbols to use for the section head and tail. The same proce-
dure is used for callouts.

leVels

Levels in Revit usually indicate stories or represent levels used for referencing heights of certain 
elements. Graphically they are represented with a line and a level symbol that can be placed at 
one or both ends of the level line. Creating level types allows you to define the graphical charac-
teristics of the level line, the level family symbol, and Z-coordinate system used by the level tags. 
All these parameters are stored in the level type properties; you can create as many as you please.

Level Properties

The following properties are available for levels:

Elevation Base    You’ll find two options for Elevation Base: Project and Shared. When you 
select Project, the project’s coordinate system is used. When you select Shared, the coordi-
nates correspond to the shared coordinates. 

Line Weight    This parameter allows you to set the line weight of the level line. Line Weight 
can be any number from 1 to 16. These numbers correspond to virtual pens with various 
thicknesses, which can depend on different scales applied to a view. To review the current 
settings, from the Manage tab, choose Settings  Line Weights  Annotation Line Weights.

Color    This parameter defines the color of the level line.

Line Pattern    This parameter defines the pattern of the line used for the level line.

Symbol    This parameter provides a list of all available level symbols that can be placed at 
the ends of the level lines. This list shows all level head family files currently loaded into 
your project. Just as with other tag families, you can create custom level tags and load them 
in your template. To create a custom level tag family, you need to use the correct family tem-
plate: Level Head.rft or M_Level Head.rft.

For the level tags shown in Figure 4.38, we created a custom level tag family and selected it in 
the custom level tag.

Symbol at End 1 Default and Symbol at End 2 Default    These options allow you to define 
whether to place the level head symbol at both sides of the level line (in which case this and 

Figure 4.38 
Level tags can be 
fully customized.
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the next option should be selected) or just one of them. End 1 is the start point when you 
draw the level line; End 2 is the end point.

Grids

The principle of customizing and creating grid types is similar to that of levels. The one parameter 
that grids don’t have is Elevation Base. You can fully customize the appearance of a grid line, design 
your own symbol family, and define these in the Type properties of grids. For custom symbols, there 
is a Grid Head.rft or M_Grid head.rft family template to use when you need to create your own.

Customizing Element Tags
During the construction documentation phase of a project, architects need to annotate various 
building components with symbolized descriptions (tags) in order to give additional informa-
tion about the elements to be built. In the majority of cases, Revit allows automatic placement of 
the tags during the placement of components. If you don’t want to fill your drawings with anno-
tations early in the process (and to be honest, that might not even be possible, as in early design 
stages you might not be sure exactly which types you will be using), you can choose to not tag 
elements during placement. You can add the tags later, in a manual or automated way (see “Tag 
All Not Tagged” in Chapter 19, “Annotations”). The tags are annotation families, meaning that 
they are created in the Family Editor, loaded into a project, and then used wherever you need 
them. You can customize the graphics for all tags to meet your specific requirements.

It’s advisable to load all tag families that you intend to use in your project or office template. 
That way, you can guarantee coherence and consistency in the way you document your project 
across the project team or office.

You can load the various tags in the template using several tactics:

Switch to the Insert tab, and from the Load Library panel, select Load Family.•u	

Using Windows Explorer, select •u	 .rfa tag families and drag and drop them to place them in 
the Revit project environment. (You’ll need to have the template file open.) When you try to 
load more than one family at the same time, Revit prompts you either to open each of those 
files in an independent window (so you can modify them) or to load them all in the current 
project. Choose the second option.

Use the Loaded Tags tool available in the Annotate tab, when you expand the Tag panel •u	

(Figure 4.39). The advantage of this method is that you have a preview of all loaded and 
preset tags that will be used throughout the project.

Figure 4.39 
Tags dialog box.
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Certain tags are indispensable in a project template. These include door tags, window tags, 
room tags, revision tags, material tags, keynotes, and area tags. Out of the box, Revit offers at 
least one of each of these tags, but you’ll probably want to create your own in the Family Editor 
and load them into your template.

creatinG a custom door taG

As an example of creating custom tags for a basic element, the following steps show you how to 
create the custom door tag shown in Figure 4.40:

 1. From the Application Menu choose New  Family  Annotations.

 2. In the Select Template File dialog box, select the family template called Door Tag.rft or 
M_Door Tag.rft, and click Open.

The Family Editor opens in a view with two crossing reference planes. To avoid problems 
later, don’t move the two reference planes. The intersection point is the center point of the tag. 

 3. From the Annotate panel of the Create tab, select Label. Click the intersection of the two 
planes to position the label. 

 4. In the Edit Label dialog box that opens, select Mark and click the Add Parameter(s) to 
Label button. In the Sample Value column, you can enter a value that will be a symbolic 
value visible only in the Family Editor and that will be replaced by the number of the 
door to which this tag is associated. In this case, accept the proposed value and click OK.

Figure 4.40 
The custom door 
tag you’ll create in 
this exercise.
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Everything you learned about repositioning and changing the length of the section tag label 
in the exercise in the section “Creating a Custom Section Tag Family” applies here as well.

 5. Click to select the label you just placed. From the Modify Label tab, click the Element 
Properties button.

 6. In the Instance Properties dialog box, click Edit.

 7. In the Type Properties dialog box, select the text color, set the background to Transparent, 
and select a font style and size consistent with your office standards.

 8. Click OK. Your graphic should look like this if you’ve followed the steps so far:

 9. From the Create tab, in the Detail panel, click the Filled Region button, and sketch the 
shape of the tag.

 10. Click the Element Properties button, and in the Instance Properties dialog box, click Edit 
Type. In the Type Properties dialog box, change the color of the fill pattern (select a color 
that allows you to see the color of the text—gray or yellow). Set Cut Fill Pattern to Solid Fill.

 11. Click OK in all open dialog boxes. 

 12. Select the Filled Region you just created, and from the Edit panel of the Modify Filled 
Region tab, select Edit Sketch.

 13. Holding down the Tab key, click one of the lines in the sketch (and thus select all con-
nected lines); from the Element panel select Line Styles and choose <Invisible Lines> 
from the list. When you do this, the defined shape of the tag, which has a colored fill, will 
have no drawn boundary around it, as shown previously in Figure 4.40.
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Invisible lines are for reference only in the Family Editor and in Sketch mode. They’re select-
able but not visible in the project environment, and they never appear on printed documents.

 14. Click Finish Region. The result should look like this:

 15. Save your tag. It’s ready to be reused in a project or a template.

creatinG taGs For other cateGories that don’t haVe Family templates

While creating custom tags, you’ll notice that family templates aren’t available for all Revit cate-
gories that exist. For example, if you need to create a furniture tag, you won’t find a correspond-
ing template for the furniture tag. What do you do? For such tags, you use the template called 
Generic Tag.rft or M_Generic Tag.rft. As a first step when starting the template, you assign it 
to the category you wish it to be associated with. Here are the steps to do that:

 1. In the Family Editor, switch to the Manage tab and choose Category and Parameters from 
the Family Properties tab. (This exists only in the Family Editor.)

 2. In the resulting dialog box, select the desired category (Furniture, in this case), and 
click OK.

 3. Select the red information text, and delete it.

You can now proceed, using the techniques shown in our previous examples.

Keynotes and Textnotes
Notes are a critical part of communicating design and construction intent to contractors, sub-
contractors, and owners. No drawing set would be complete without textual definitions and 
instructions on how to assemble the building. Keynotes are element specific and can be sched-
uled and standardized in the Revit database.

Keynotes are textual annotations that relate text strings to specific elements in the model, 
which are in turn linked to an external text file. You can format font style, size, and justification 
in the same manner as for standard text, but keynotes behave like a Revit family. This means 
you can insert different text family types in Revit, just as you would door or window families.
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Keynote types

The Keynote command is located on the Annotate tab under the Tag panel. Adding keynotes in 
Revit gives you three options similar to those mentioned in our discussion of adding tags:

Element    This option allows you to note an element in the model, such as a wall or a floor. 
This type of note is typically used if you want to note an entire assembly, such as a wall 
assembly. You can find this value in the Family properties of that element.

Material    This option lets you note a specific material in Revit. You can add a note to con-
crete, gypsum board, or acoustical tile, for example. This value can also be found in the Manage 
tab under Materials. The Identity tab lets you add keynote values directly to each material. 

User    This option allows you to select any model-based component in Revit and define a 
custom keynote for it. Notes defined this way differ from those defined under Element or 
Material because they’re unique to the particular object selected. They can be used in con-
junction with element and material notes.

creatinG a custom Keynote

To create a custom keynote, follow these steps:

 1. From the Application Menu, choose Open  Family, select the Imperial library (or Metric, 
depending on your installation), and then choose Annotations  Keynote Tag.rfa. You’ll 
use an existing note block to edit in lieu of making one from scratch; this note is great to 
use as a template because it has each type of note already created.

From the Family Properties panel, select Type. The Family Types dialog box includes Keynote 
Number, Keynote Number Boxed, and Keynote Text note types; checkboxes under each allow 
you to customize the notes further. As an example, here is Keynote Number Boxed:

 2. For your keynote, select the Keynote Text option from the drop-down list, and click OK. 
As we discussed with the other tag families, you can add labels, text, lines, filled regions, 
and other graphic tools to customize your keynote.

 3. Because you’re using the text and not the numbers for this note, delete the box surround-
ing the note.

 4. Select the label for the note (the 1), and go to the Label properties. Here, you can adjust 
the font size and style. Also change the justification from Center to Left. Click OK to exit 
the dialog boxes when you’ve finished editing.

 5. A critical part of a keynote is the note length. The overall length of the note before the 
texts begins to wrap to a new line is controlled by the size of the box for the note label. 
In this case, you want your notes to be 25 characters long (roughly 21⁄4˝ at 3⁄32˝ scale). The 
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best way to do this is to number the characters. Remember, the value you enter in this box 
now is only an aid to create the family.

When you insert notes into the model and annotate a wall, you can see how the text 
responds, on one line or on two (Figure 4.41).

Creating Custom Title Blocks
While you’re building a rich BIM model and adding more detail and intelligence in each phase 
of the project, you also have to document each phase and share it—deliver drawings (sheets) for 
others. No matter whether you share this information digitally (DWF, PDF) or via printed docu-
ments, you need to place information that is company specific (logo and contact information), 
project specific, and sheet specific on those sheets. Consistency among sheets is essential.

Sheets in Revit can be created in the project environment. Their creation starts with the 
selection of a title block that can have any shape, graphic layout, and size. Figure 4.42 shows a 
couple of examples; you’ll create the second in this section’s exercise. Title blocks are external 
families—you can create any kind of a title block in the Family Editor and add project number, 
sheet number, or company-specific information on it, both textual and images. (You can include 
your logo, an image of your project, and any other graphic.) Companies have different title block 
styles for document sharing with different parties.

Figure 4.41 
Examples of mate
rial keynotes.

Figure 4.42 
Different title 
blocks: left for pre
sentations, right 
for construction 
documents.

56491c04.indd   140 6/2/09   4:47:29 PM



creating cUStom title BlockS | 141

To use the title block families you’ve created in the Family Editor on a sheet, you must load 
them in the project. If you’ve created office standards, the project templates are the best place to 
store title block families you created on your own. There is no need to create final sheets in the 
template file—loading the title block families is sufficient. However, different offices have differ-
ent strategies.

Creating a Custom Title Block with the Family Editor
Revit lets you easily create sheets to any standard you require. Sheets usually have standard 
dimensions based on standard paper sizes. These vary from country to country but are more or 
less standardized within each country.

The first thing to think about when creating a title block is the paper size on which it will be 
printed. You then think about the layout graphics as well as the information you want included 
on the sheet. Various world standards (ARCH, DIN 680, BS 4264, SFS 2488, ISO 11180, ANSI/
ASME Y14. 1, and U.S. National CAD Standards) define precise layout requirements for sheets 
and the content displayed in them. 

Keep in mind that the default title blocks in Revit use the lower-left corner of the sheet as the 
origin. This is important if you start with a default title block or if you exchange one sheet size 
for another, since they’ll be swapped out at the point of origin. 

Revit accommodates all these requirements—many of them in an automated manner. You 
can add any shapes, graphics, and textual information as well as use parametric labels capable 
of extracting information from the project. As you’ll see, labels are part of the coordinated BIM 
concept and will help streamline your process.

The following steps demonstrate how to create the custom title block illustrated in Figure 4.43.

 1. From the Application Menu, choose New  Title Block.

 2. From the list, either select one of the prepared sheet sizes or select New Size. This opens a 
title block template, where you can start laying out your title block. Let’s assume that the 
size you need to duplicate doesn’t exist in the list; select New Size.

 3. A blank template file opens with nothing but a rectangle. Click the lines of the rectangle 
to activate temporary dimensions. You can then edit the dimension text value to drive the 
size of the rectangle. Make the sheet 42˝×32 .̋

 4. Draw lines with the Line tool, creating a layout, as shown in Figure 4.43. For each varia-
tion in line thickness or color, you’ll need to make a new line style using the Line Styles 
dialog box. Add new subcategories to the Title Blocks category.

 

Figure 4.43 
The vertical title 
block you’ll make.
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Once you’ve finished with the lines, you’ll continue by adding images, fill patterns, text, 
labels, and symbols.

 1. Add an image by switching to the Insert tab, and from the Import panel select Image. 
Select the example on the book’s companion web page or any image on your computer. 
Place it anywhere, resize it using its grips when selected, and position it on the title block. 
This is how you can place your company logo into your title blocks.

 2. Add fill patterns with the Filled Region tool to add a color banner or hatched area to your 
sheets. You can’t add a fill pattern on a sheet in the project environment, so you need to 
add them in the Family Editor.

Fill patterns added in the title block are always displayed in front of any views placed on the 
sheet. In other words, you can’t use a filled region to create a colored backdrop view. There 
are other ways to achieve that.

 3. Add text with the Text tool. Text is always the same and is unchangeable from the project 
environment. Drawn by, Scale, and Date are all examples of text. For each variation in font 
or size, you need to create a new type of text.

 4. Add labels with the Label tool. These are textual fields that report information stored in 
individual projects. As with text notes, you need to create new types for every variation 
in font or size. By adding the label Project Name to the title block, you can reuse the title 
block in many projects; the label will update in each project with the appropriate name. 
The same principle works for the other labels, shown in the Edit Label dialog box in 
Figure 4.44. In this example, Project No. is prefix text and remains unchanged in the proj-
ect environment. The number 00.0000 is a label and will reflect the number of the project 
set in the project information. Using this dialog box, you can add prefixes to the label. Be 
sure to add some blank spaces after the prefix if you go this route.

Figure 4.45 illustrates the difference between text and label elements, which behave as 
described in “Static Text and Parametric Labels” earlier in the chapter.

 5. Continue to build the title block by placing text and labels on the sheet in the manner of 
Figure 4.46.

Figure 4.44 
Edit Label  
dialog box.
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 6. Add a revision schedule to the title block so you can track changes in your document set. 
Changes are stored as revisions and can be displayed parametrically in your title blocks. 
We’ll review the revisions in more detail in Chapter 23, but you’ll add the revision 
schedule now.

Revisions

You can control the appearance of your revision schedule in the Appearance tab of the 
Revision properties. From the View tab, under the Create panel, select Revision Schedule 
(Figure 4.47). The Revision Schedule dialog box opens, and you can choose which parameters 
to schedule. Choose Revision Number, Description, and Date. To adjust the font and size, use 
the Appearance tab. You can specify if the schedule adds new revision rows from bottom 
up or from top down. In addition, you can set the height to User Defined, which allows you 
to dynamically set the height in the title block family to a fixed number of rows. Choosing 
Variable for the height will allow the revision table to get taller as new revisions are added. 
See Figure 4.48. When you’ve finished, click OK. An empty schedule appears; close  
that view.

Figure 4.45 
Place labels  
with standard 
parameters.

Figure 4.46 
Continue to build 
the title block.

Figure 4.47 
Place a revision 
schedule.
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 7. In the Project Browser, click the Sheets node and open the title block sheet.

 8. Still in the Project Browser, expand the Views node, and then open the Schedules node. 
Drag and drop the revision schedule into the title block to place it. The revision schedule 
appears empty, but don’t worry—it will be filled automatically when used in a project. If 
you have set the height to be user defined, go ahead and adjust the height using the blue 
grip control (Figure 4.49).

Figure 4.48 
You can control  
the appearance 
of your revision 
schedule in the 
Appearance tab  
of the Revision 
Properties  
dialog box.
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Once you’ve placed all these elements, the title block is good to go. Save it to your hard drive 
with a unique name, and click the Load Into Project button. Choose a project file, and the title 
block will be loaded.

Best Practices and Workarounds: Positioning Views on a Sheet
Revit has no automated way to place similarly scaled floor plans in the exact same location 
across many sheets; you’ll have to eyeball the placement. However, a useful aid is available to 
help, which takes advantage of the invisible line type. Choose an origin in your title block by 
drawing two intersecting invisible lines. These lines aren’t visible in the project but provide a 
snappable intersection you can move views relative to. Another aid is to add tick marks to the 
title block to create a basic cell division. Another option would be to create a light graphic grid 
on your title block. The visibility of the grid can be controlled with a type parameter. This will 
allow you to turn off the grid on all sheets at once. Or if the grid is very light (light blue, for 
example) it will print but hardly be legible. 

The Bottom Line

Start a project with a custom template.    Creating a template that incorporates your firm’s 
styles and preferences is an essential first step in putting Revit to work.

Master It    Your firm has some deeply established graphic conventions that were defined 
in AutoCAD. How would you go about matching these graphics and setting up a Revit 
template?

Create custom annotation tags.    Styles for annotations, dimensions, and text are all governed 
by office standards, and the Family Editor is your tool for setting up those standards in Revit.

Master It    You need to create dimensions, text, and annotations that match your office 
standards. How do you do this with Revit? 

Create custom title blocks.    Title blocks are another important element of office standards 
that you can configure in the Family Editor.

Master It    Most offices have several title blocks with lots of information embedded in 
them. How would you add multiple title blocks to your project template file?

Figure 4.49 
Userdefined 
height control for 
revision schedule.
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Chapter 5

Customizing System Families and 
Project Settings in Your Template

In this chapter, we’ll dig into customizing the Revit system families (see Chapter 2, “Revit 
Fundamentals,” for a definition of system families) so that you can make your office templates 
exactly as you need them. Knowing how to adapt the system families—by using view templates, 
type catalogs, and other global project settings—and include them in templates can save you 
headaches early in the design process. In addition, the documentation process will be a lot easier 
because the assemblies are created correctly from their inception. 

In this chapter, you’ll learn to:

Create new types of system families•u	

Use type catalogs•u	

Customize project settings in your template•u	

Creating New Types of System Families
System families in Revit are a bit different from the other family types. They represent a limited 
list of building elements (walls, curtain walls, floors, ceilings, roofs, stairs, mullions) that cannot 
be saved as files external to your project the way you can do with the component, standard fam-
ilies (RFA files). There are only three ways to create or add new system families to your model:

Create them in your project by duplicating one that already exists and modifying its •u	

properties

Copy and paste them in as objects from one project to another•u	

Use the Transfer Project Standards tool available from the Manage tab in the Project •u	

Settings panel (this technique again allows copying from one project to another)

The first way is the most commonly used one in Revit. In the following sections, we will review 
how to modify the system families in Revit, allowing you to create your own, unique types. 

Wall Types
Walls are made from layers that represent the construction materials used to build real walls. 
In Revit, these layers can be assigned functional values, allowing them to join and react to other 

56491c05.indd   147 6/2/09   2:40:51 PM



148 | Chapter 5 Customizing system Families and ProjeCt settings in your temPlate

layers in the model when walls, floors, and roofs meet. Each wall has at minimum a core, with 
the option to add layers of material to the core in order to create multilayered assembly wall 
types. These layers can be added inside the core or placed outside the core. As you’ll see, this 
special wall core layer is a powerful element; understanding it is essential to mastering Revit.

A wall core is much more than a layer of material. The core identifies the structural part of 
the wall; it influences the behavior of the wall and how the wall interacts with other elements in 
the model such as floors and roofs. Every wall type in Revit has a core material with a boundary 
on either side of it. These core boundaries can be snapped and dimensioned to when you are 
laying out your model.

For example, when you draw a floor above your exterior walls and use the “pick walls” 
method, the option to extend to the core of the wall is available on the Options bar. You can choose 
to offset your floor from the core layer as well. This floor creation method results in an explicit 
relationship between the floor and the underlying wall core layer. If any wall changes position, the 
floor follows and stays related to the wall core layer—even if the wall type is changed. Figure 5.1, 
which shows a section through a wall and floor, demonstrates that the sketch of a floor represent-
ing its boundary can be constrained to a certain layer or offset from the core boundary of the wall. 
If you created your floor using the pick walls method, the relationship between the floor and the 
wall will happen automatically.

Figure 5.1 
Section through 
wall and floor: the 
sketch of a floor 
representing its 
boundary can be 
constrained to a 
certain layer or 
offset from the 
core boundary  
of the wall.
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If you decided to use the draw method instead of the pick walls method and you still want 
your floors to be dependent on the position of the walls and have a relationship with them, you 
need to manually lock the relationship so that the dependency is established. To get the locks 
that create constraints between aligned elements to appear, select and drag the sketch lines of 
the floor over the walls (or use the align tool) so that they are coincident with the boundary or 
core lines of the walls, and then click the blue lock icon to establish the relationship. If your floor 
sketch lines were already coincident with the wall lines, just select one, drag it away from the 
coincident wall line, and drag it back Another way to do this is to use the align tool. The lock 
icon will appear and you will be able to lock it.

To access and edit wall-core boundaries and material layers, first select a wall and click the 
Element Properties button. In the Instance Properties dialog box, click the Edit Type button to 
open the Type Properties dialog box. Select the Structure parameter to open the Edit Assembly 
dialog box. Here you can define materials, move layers in and out of the core boundary, and 
assign functions to each layer (see Figure 5.2).

Creating Your own wall tYpes

If you have a series of wall types that are standard in your office, you’ll want to create them and 
add them to your project template right from the beginning so that they are available to all team 
members at all times. Creating new wall types involves duplicating an existing type, and then 
modifying wall structure and type properties. A wall can be a simple structure (a single-layered 
wall, which is typically used for resolving early design decisions) or a complex structure (a mul-
tilayered wall, which is used when the design becomes more resolved in terms of level of detail). 
If you need to make new types that are not part of your template, you can create new wall types 
on the fly at any stage in a project by duplicating existing types, adding or removing wall layers, 
and adjusting parameters to meet your requirements. The Edit Assembly dialog box, shown in 
Figure 5.3, is where you define the layers of the wall type. This dialog box is divided into four 
zones: the Preview window, the Layers table, the Default Wrapping option, and the Modify 
Vertical Structure option (which is available only when the section preview is active). 

Figure 5.2 
Each wall type is 
composed of lay-
ers of material, 
defined in the 
Layers portion of 
the Edit Assembly 
dialog box.
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The Preview Window

On the left side of the dialog box, you will see a graphical preview of the wall structure in plan 
view (the default one) or section view. (If you don’t see the preview, click the Preview button at 
the bottom of the dialog box.) To switch from the default plan view preview to the section view 
preview, or vice versa, click the drop-down list under View to choose another viewing option. In 
the preview, the core boundaries of the wall are drawn with green lines. Note that in the section 
preview, when you select a row in the Layers table, the layer is highlighted in red.

The Layers Table

The Layers table is where you add, delete, move, and define layers of the wall structure. Each 
wall layer is represented as a separate row of information. Note that two of the rows are gray: 
they represent the boundaries of the core of the wall, which usually define each face of the struc-
tural part of the wall. They don’t represent any physical component but are just a visual repre-
sentation of the separation between the structural and nonstructural components of the wall. In 
between those two gray zones is the wall’s structural core layer.

The table is divided into four columns:

Function    This column provides six choices for wall functions that relate to the purpose of 
the material in the wall assembly. Each of those functions defines a priority that determines 
how it joins with other walls, floors, and roofs:

Structure [1]     Defines the structural components of the wall that should support the rest 
of the wall layers. This function gives the highest priority to a wall layer and allows it to 
join with other structural layers by cutting through lower-priority layers.

Figure 5.3 
The Edit Assembly 
dialog box for  
a wall.
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Substrate [2]    Forms a foundation for other layers (materials such as plywood or gypsum 
board).

Thermal/Air [3]    Defines the wall’s thermal insulation layer.

Membrane Layer    A zero-thickness material that usually represents vapor prevention.

Finish 1 [4]    A finish layer to use if you have only one layer of finish (gypsum wall 
board).

Finish 2 [5]    A secondary, weaker finish layer (plaster, tiles, or brick).

With the exception of the membrane layer, which has no priority assigned, all the other layers 
have a priority value from 1 to 5, with 1 the highest priority. Revit uses the priorities of the 
layers in a wall to determine how to clean up the intersections between various layers when 
two or more walls meet at an intersection. The principle is simple: priority 1 is the highest in 
order; a layer that has a value of 1 will cut through any other layer with a lower priority value 
(2, 3, 4, 5). A layer with priority 2 will cut layers with priority 3, 4, or 5, and so on. Logically, 
the layer with priority 1 should be placed between the core limits and represents the core of 
the wall (the structural component); the other layers should be outside the core. Revit starts 
sorting out wall joins by beginning with the highest-priority components and then working 
down the priorities. Look at Figure 5.4, in which layers with the same priority clean up when 
joined. Layers with priority 1 join and clean up first, and then the layers with priority 4 clean up.

Material    Associating a material to a wall layer provides graphical as well as physical char-
acteristics for the wall. With a material, you can calculate the quantity of that material used 
in your project and schedule this information. The material also knows how to graphically 
clean up when it joins with other walls, floors, and roofs that are made of the same material. 
Finally, a material will define the color and graphical pattern of a layer.

How does a material definition affect the cleanup? The material usage informs Revit how to 
treat wall layers at intersections. If the priority of the layers is the same and the material is 
the same, Revit cleans up the join between these two layers, creating a graphically consistent 
material representation. If the materials are different, even though their priority is the same, 
Revit separates the two layers graphically with a thin line. Figure 5.5 shows two layers with 

Figure 5.4 
Layers with the 
same priority clean 
up when joined.

4
1
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the same priority (1) but different materials: the cleanup between the layers isn’t taking place 
because of the different materials used. 

Thickness    This value represents the actual thickness of the material. Note that the membrane 
layer is the only layer that can have a zero-thickness value.

Wraps    Wall layers rarely end with a straight-cut finish at wall ends or wall penetrations 
(windows and doors). This option allows a layer to wrap around other layers. Figure 5.6 
shows layer wrapping defined within a window family in the Family Editor. You can define 
different settings for wrapping the end of walls or openings. Looking again at Figure 5.6, the 
image on the left shows wrapping applied only to the first exterior component of the wall; 
only that layer wraps around the window opening. On the right, the first and second exterior 
components have wrapping active, so they both wrap around the opening of the window.

To create a wrapping solution for openings that reflect a real-life condition, this setting prob-
ably won’t be sufficient. All you can define in the Wall Editor is if a material layer will wrap 
and whether it’s an exterior or interior wrap. The Wall Editor alone can only solve wrapping 
conditions in a generic way. To achieve more complex wraps like the one shown in Figure 5.6, 
you must define another set of rules in the Family Editor while creating the window or door 
family itself. These additional settings, combined with the wrap function of the wall layer, 
will produce more complex wraps at opening conditions.

To summarize, editing the wall structure means adding or deleting wall layers. Each of those 
layers needs to be associated with a priority, material, thickness, and wrap information. To move 
layers up and down in the table, or to add and remove layers, use the buttons at the bottom of 
the dialog box.

Once layers have been defined and positioned, you need to consider a few more properties.

Figure 5.5 
Two layers with 
the same priority 
(1) but different 
materials. The 
separation between 
the two layers is 
indicated with a 
thin line.

1

Figure 5.6 
Layer wrapping 
defined within a 
window family in 
the Family Editor.
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Default Wrapping

Each wall layer can either wrap or not wrap at the ends of the wall or at inserts (windows, doors, 
openings). To make this happen in the project, you must decide whether the wrapping should 
occur at openings or wall ends or at both. For inserts, you can choose Do Not Wrap, Exterior, 
Interior, or Both. Similarly, for wall ends, the options are None, Exterior, and Interior. The default 
wrapping parameters appear in both the Edit Assembly dialog box (Figure 5.3) and the wall’s 
Type Properties dialog box, as shown here:

Modify Vertical Structure (Section Preview only)

Walls are often complex and articulated in their composition. Cornices, reveals, corrugated 
metal finish, and other elements are used all the time. Revit can accommodate any of these 
types of design articulation, and this is the place where all that is handled. See Chapter 12, 
“Extended Modeling Techniques—Walls,” for a detailed explanation of these functions.

Level of Detail

Walls have only two different styles of graphic display for the three levels of detail: one for 
Coarse views and another for Medium and Fine views. You will notice that changing from 
Medium to Fine view, and vice versa, has no effect on the graphic display of the wall, because 
they use the same representation.

Coarse Display    This is defined as a type property for each wall family, and is typically 
used for 1:200 scaled drawings. You can set both Coarse Scale Fill Pattern as well as Coarse 
Scale Fill Color. If no Coarse Scale fill is set, then the wall category material (set in Object 
Styles) will be used. 

Medium/Fine Display    This is defined in the Type Properties dialog box in the wall assem-
bly. The materials used for each layer establish the cut and surface patterns of the wall. These 
types of display will be rich in detail and show each layer of the wall.

In Figure 5.7, Coarse Scale Fill Pattern is set to a solid fill and Color to black. On the left is the 
Coarse view: Individual layers are not displayed; a black Coarse Fill pattern is assigned. On the 
right, Medium/Fine view displays all wall layers. You can see the difference in how these walls 
present in the same plan at different scales, and thus different levels of detail. 

Rather than setting the wall fill to solid black as a coarse display option, you can also use the 
visibility settings of a view to override the cut value of many objects (walls, floors, roofs, ceil-
ings, and so forth) to a solid black fill at one time. This technique will save you significant time 
compared to manually joining geometry between host elements during design.
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Managing Layer position

When you insert new wall layers, you will notice in the Layers table that the newly created wall 
layer is always positioned below the active wall layer (the selected layer). To position your new wall 
layer where you want it, either you can click the Insert button and use the Up and Down buttons 
to position the new wall layer, or you can select the layer you want to reposition with the mouse 
(place the mouse at the beginning of the line and select the entire line, as shown in Figure 5.3, and 
again, use the Up and Down buttons to reposition it where you need it). By default, each time you 
insert a new wall layer, it has a Priority value of Structure [1], a Material setting of By Category, and 
a Thickness value of 0. Also, Wrap is selected. 

Note that you cannot delete the wall layer between the two gray lines (the core that represents the 
structural portion of the wall) if it is the only layer or the last one. A structural layer must exist 
and have at least one layer that has a value greater than zero. If you create a wall that has only one 
material (like a concrete foundation wall), you must place that one concrete layer between the gray 
core-boundary lines.

Wall Function

Each wall assembly has a function whose value is Interior, Exterior, Foundation, Retaining, 
Soffit, or Core-Shaft, as specified in the Wall Type properties. Changing this parameter doesn’t 

Figure 5.7 
On the left is the 
Coarse view: 
individual layers 
are not displayed; 
a black Coarse 
Fill pattern is 
assigned. On the 
right: Medium/
Fine view displays 
all wall layers.

Coarse Medium/Fine
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affect the geometry of the wall, but setting it correctly allows you to control the visibility of 
walls and is useful for scheduling purposes. Another important use of this categorization is 
during export to DWG: you will be able to assign each functional wall type to a different CAD 
layer for export.

Floor and Roof Types
The process of creating floor and roof types is similar to that for walls. Editing the floor struc-
ture follows the same principles as editing the wall structure. One notable difference is that 
floors and roofs do not involve Wraps—in the Floor Editor, this parameter is always grayed 
out. On the other hand, multilayered floors have an additional parameter (that wall layers don’t 
have) that allows the layer to vary in thickness if the floor is sloped. This appears in the Layers 
table as a new column named Variable (Figure 5.8). The Variable parameter is available only for 
Floor and Roof structures.

Revit allows you to slope floors and roofs by adding points and ridges that can then be 
manipulated to create creases and sloping forms. You do so using Shape Editing tools, which 
are available in the Shape Editing panel of the Modify Floors tab when a floor or roof is selected. 
The Shape Editing tools are explained in more detail in Chapter 13, “Extended Modeling 
Techniques—Roofs and Floors.”

Figure 5.8 
The Variable 
parameter is  
available only for 
Floor and Roof 
structures.
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Floors or roofs that have been dynamically edited with these tools will have the Variable 
parameter enabled. If you select the Variable property, that layer can have a nonuniform thick-
ness, as shown in Figure 5.9.

If the Variable property isn’t selected, as in Figure 5.10, the layer in question has a uniform 
thickness, and the entire floor structure is going to be sloped.

Ceiling Types
Ceilings are also system families. Revit includes two different ceilings families: a generic ceil-
ing that has no thickness or internal layers, and a multilayered ceiling that is identical to floors 
and roof in terms of functionality (Figure 5.11). Ceilings don’t support the variable-layer thick-
ness functionality we just mentioned, and they don’t have a wrap function. What they can do 
(that floors and roofs cannot) is host ceiling-mounted lighting fixtures. This is very important to 
know: if you need to place light fixtures, you’re going to have to add a ceiling.

Use the simple ceiling to model drop ceilings that are hung from the structure. These are 
typically only as thick as the acoustical tiles and don’t need to be modeled as fully 3D forms. 
The multilayered ceiling is good for gypsum ceilings placed on joists. 

Figure 5.9 
The Variable property is 
selected, so the floor layer has 
a nonuniform thickness.

Figure 5.10 
The Variable property isn’t 
selected, so the floor layer has 
uniform thickness and the 
entire structure slopes.

Figure 5.11 
Ceilings can be 
generic (repre-
sented as one 
simple line) or 
compound (rep-
resented with 
layers).
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Stair Types
Stairs are complex building elements and require a deep understanding of local standards, rules, 
and requirements. Check the local building code requirements (minimum width, maximum 
height) to confirm that you’re using the correct stairwell dimensions and proper headroom. 
Formulas for calculating stairs are based on common codes and ergonomics. These may have 
slight variations in different regions, based on local conditions.

A number of parameters define the representation of stairs, including rules for risers, treads, 
and stringers; selection of construction techniques; and material used. All of these can be adjusted 
and made into types for use in your templates so that you always have the types of stairs that con-
form to the local building rules where you operate. Figure 5.12 illustrates different types of stairs 
that can be created in Revit.

Figure 5.12 
Stair types rep-
resenting differ-
ent construction 
approaches and 
material selections.
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properties of stairs

In the Type Properties dialog box for stairs, you can control the following properties:

Calculation rules    In the stair’s Type Properties dialog box, in the Construction/Calculation 
rules, click the Edit button to open the calculation rules. To use the calculation functionality, 
select the option at the top of the Stair Calculator dialog box (see Figure 5.13). The calcula-
tion rule is based on the universal calculation formula that sets the value that should result 
depending on the size of the runs and risers. If this value can’t be achieved, it should at least 
be within the minimum and maximum range you’ve defined.

Extend Below Base    This field defines an offset between the base of the stair and the level 
where it starts. A positive value means the stair starts higher than its base level, and a nega-
tive value starts the stair below the base level. The top of the stair isn’t affected by this 
parameter. This option is needed for conditions where the floor material demands that the 
stair start a bit higher or lower than the level.

Monolithic Stair    When this option is checked, it changes the stair into a monolithic form 
where the stringers, risers, and treads are treated as the same material. This is great for mak-
ing concrete stairs.

Landing Overlap    This option is active only when the Underside of Winder option is 
selected (see the following explanation).

Underside of Winder    This option is available only with monolithic stairs and has two 
values: Smooth and Stepped. They represent the treatment of the underside of the stairs, as 
shown in Figure 5.14.

Break Symbol in Plan    This parameter shows a break line in plan. If it’s selected, the break 
symbol appears at the cut height of the stair. The part of the stair that is beyond the break 
symbol (above the cut plane of the view) is shown with special subcategories of stairs: Stairs 
Beyond Cut Line and Stringers Beyond Cut Line. Each can be assigned a different color and 
line type. This setting is unique to the rest of the graphics used for the stair.

Figure 5.15 shows a stair with a visible break symbol (on the left), and the same stair with no 
break symbol (on the right). 

Figure 5.13 
Stair calculation 
options.
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Text Size and Font    When creating stairs, you can set automatic appearance of Up and 
Down text that indicates the direction of the stairs. The text size and font define the proper-
ties of that text.

Material    You can set different materials for various components of the stairs. When the 
Monolithic Stair option is selected, some of the options under Material will become grayed 
out as only one material will be considered for the entire stair.

Minimum Tread Depth    This parameter controls the depth of a tread. Once you place a 
stair in a project, you can set the Actual Tread Depth in the stair’s instance parameters. If this 
value is less than the type property Minimum Tread Depth, Revit gives you an error message 
alerting you to the problem.

Tread Thickness    This parameter controls the thickness of each tread.

Nosing Length    As the name suggests, this parameter controls the length of a nosing in a 
stair. When this parameter has a value of 0, no nosing is applied to the stair. A positive value 
for this parameter results in a nosing being exposed on all treads.

Nosing Profile    This is where you can set the nosing profile that is used when Nosing 
Length has a positive value. You can create any custom Profile family for the nosing—the 
Family Editor includes a Profile-Stair Nosing family template you need to use. Once you have 
the custom nosing family, you load it in the template (project) and associate it with a certain 
stair type.

Apply Nosing Profile    This determines where the nosing profile is placed relative to the 
tread. The available values are Front Only; Front and Left; Front and Right; and Front, Left, 
and Right. No Back option is available.

Maximum Riser Height    This field defines the maximum allowed value for a riser. Usually, 
this setting depends on regulations set in the local building code as well as the type of 
building.

Begin with a Riser, End with a Riser    These settings control the start and end of the stair 
and the connection with the landing.

Figure 5.14 
Monolithic stairs 
with Underside  
of Winder set to  
(A) Stepped and  
(B) Smooth.

A B

Figure 5.15 
The same stair 
with and without 
the break-line 
graphic enabled.
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Riser Type    There are three possible types: None, Straight, and Slanted. As shown in 
Figure 5.16, this is fairly self-explanatory for the riser. For the slanted type, you can’t define 
the angle of the slope; that value is a result of the length of the tread and the profile of the 
nosing.

Riser Thickness    This value defines the thickness of the riser material.

Riser to Tread Connection    There are two options: Extend Riser behind Tread, as shown on 
the left, and Extend Tread under Riser, as shown on the right:

Trim Stringers at Top    This option controls how the stringer finishes its geometry at the top 
of the flight (see Figure 5.17).

Figure 5.16 
Riser types: left to 
right, (A) no riser, 
(B) straight riser, 
(C) slanted rise 
with the value 1˝ 
(2cm) for nosing, 
(D) slanted riser 
with the value 1.5˝ 
(3cm) for nosing.

A B C D

Figure 5.17 
Trim stringer 
options.

•  Do Not Trim: The stringer continues above the level.

•  Match Level: The height of the stringer is coincident with the level.

•  Match Landing Stringer: The top of the stringer is cut at a height that matches 
    the landing stringer.
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Stringer Left/Right    This setting provides three options for stringer geometry:

None: No stringers applied to the stair.

Closed: The stringers are placed on the sides of the stair.

Open: The stringers are placed below the stair and are cut away by risers and treads.

Note that if you have a stair with stringers and decide to change the type to Monolithic Stair, 
the stringer will disappear.

Middle Stringers    This option allows you to add one or more stringers below the stair. 
When more than one is added, they’re evenly spaced.

Thickness/Height of Stringers    This option gives you dimensional control over the 
stringers.

Open Stringer Offset    This option is active only if the stringers are defined as open. This 
parameter controls the position of the stringer relative to the stair.

Stringer Carriage Height    This is the value between the stringer height and the treads. The 
larger the value, the deeper the stringer goes below the treads (the tread position stays the 
same).

Landing Carriage Height    This value controls the distance between the bottom of the land-
ing and the bottom edge of the stringer.

Door and Window Types
Doors and windows are external families (RFA files) and are loaded into a project as needed. 
You should include door and window families that you use most frequently in your templates, 
and should remove content that you do not use.
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You can create initial types using the Family Editor or loading from the existing library, and 
there is no limit to the number of additional types you can create in the context of a project. The 
same principle applies to other standard families such as furniture, plumbing fixtures, light-
ing fixtures, and so on. As you develop doors and window families that you think will be used 
downstream in many projects, be sure to load them into your default templates.

Using Types and Type Catalogs
To see why type catalogs are useful, you need to understand the various ways types of families 
can be created.

Library elements (referred to as component or standard families) often come in different 
sizes and colors while maintaining the essential shape. Revit allows you to embed many varia-
tions of an element in terms of size and material in a single family by creating different types 
of that family. Each type corresponds to a combination of user-defined values that control the 
size and material. In Figure 5.18, you can see three types of the same table that come in three 
different sizes and three different chair configurations. They’re all the same family, but each 
variation in table size is captured as a separate type. The geometry and number of chairs are all 
controlled parametrically, allowing for many types to be generated.

You can create types of Revit elements in different ways and places, depending on the ele-
ments as well as the intended purpose of the types or their number:

You can create types of families in the project environment using the duplication method•u	

You can set them in the family environment•u	

You can also use a type-catalog approach. This is used in cases where you need more than •u	

five or six types, such as 50-plus different sizes of manufactured steel columns

Keep in mind that all the family types defined in the Family Editor are loaded when the 
family is placed in a project, even if you only use one of the defined types. By using a type cata-
log, only the types that you select are loaded into the project (and you may load other types as 
needed as the project progresses).

Creating Family Types in the Project Environment
When you create new types in a project environment, they exist only in that project. The process 
for creating a new type of element involves duplicating an existing type and giving it a new 
name and new parameter values. For example, select a wall and open its Instance Properties 

Figure 5.18 
One family with 
three types: 
4-chairs type, 
6-chairs type, and 
8-chairs type.
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dialog box using right-click menu to access element properties. In the Instance Properties dialog 
box, click Edit Type and then click Duplicate. Give the wall a new name, and change its proper-
ties to reflect the new type you need. If you want to reuse that new type in another project, you 
can use the Transfer Project Standards tool located on the Manage tab in the Project Settings 
panel. This tool copies those types in another project, and they will be available for use from 
then on. You can create types of both standard and system families using this method.

Creating Family Types in the Family Editor
Creating family types in the Family Editor applies only to component (standard) families. You 
create new types using the Types tool in the Family Properties panel of the Create tab in the 
Family Editor. (To open the Family Editor, you’ll need to open any existing RFA family, or select 
the Application Menu  New  Family to make a new family.) By creating the types in the 
Family Editor, you save time downstream by providing a collection of common sizes that will 
be available when loaded into any project. Creating types in the Family Editor also ensures con-
sistent library components across projects, as they are likely shared by the whole office. If you 
make unintended changes in a project, you can always reload the original family file from the 
library and override the values you changed. 

The strategy of defining types in the Family Editor isn’t always applicable depending on the 
number of types you need per element. If you think you’ll have more than five or six different 
types, consider using the type-catalog strategy instead of making the types in the family. Type 
catalogs are the best way to define many types by entering textual information that a family 
then uses to construct a list of possible types.

Creating Family Types with Type Catalogs
Each family type uses a certain amount of memory for its definition. When you load a family 
into a project, every type in that family is automatically loaded. There is no way to selectively 
load types of a given family created in the Family Editor. If you have lots of families with lots of 
types, this can consume unnecessary memory and bloat your file size, especially if you need just 
one type of each and many remain unused. Additionally, when you have several types defined 
in a family and you load them in a project, the list of available types can become long and the 
Type Selector becomes difficult to search through. 

Think about it this way: each potential option creates a new permutation, so introducing 
another option causes the permutations to expand exponentially. A simple desk with three 
options each for length, width, and height? 3 × 3 × 3 = 27 permutations. What happens if you 
add two hardware options? 54 permutations. Three finish options? 162 possible permutations! 
Things can get busy fast, making your project “heavier” than necessary.

 This is where type catalogs can help. They allow you to define many different types (size 
combinations) of an element, which can then be selectively loaded into your project. A type cata-
log is a text-formatted list that contains all the dimensions of the family for each type variation 
and can include an infinite number of types. The catalog is a separate .txt file related to the 
family. To create a type catalog file, all you need is a simple text editor (Notepad, for example). 
When you load a family associated with a type catalog, you get the option to choose which 
types to load in.

When you’re creating a type catalog, the .txt file has to have the same name as the RFA fam-
ily and be located in the same folder as the family. Figure 5.19 shows a steel column that comes 
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in many different sizes (for example, in cases when you need more than 20 types) and what the 
corresponding type catalog looks like.

Let’s take a look at how to create a type catalog.

tYpe Catalog sYntax

To create and edit a type catalog, keep in mind these syntax rules:

The type catalog must have the exact same name as the family it’s associated with. The •u	

only difference should be the file extension (.txt). In the example in Figure 5.19, the family 
is called MMiscellaneous Wide Flange-Column.rfa and the matching type catalog is 
MMiscellaneous Wide Flange-Column.txt

The type catalog has to be stored in the same directory as the family. The example men-•u	

tioned can be found in the following standard installation locations:

Imperial sizes: C:\Documents and Settings\All Users\Application Data\Autodesk\
RAC 2010\Imperial Library\Structural\Columns\Steel

Metric sizes: C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 
2010\Metric Library\Structural\Columns\Steel

Each value must be delimited with a comma or semicolon, depending on the regional set-•u	

tings of your PC. Note that the first line must also begin with a delimiter

The first line in the type-catalog file declares the parameters that will be taken into account 
in the type catalog:

,W##other##,A##area##inches,d##length##inches,tw##length##inches,bf##
length##inches,tf##length##inches,k##length##inches

or

;Width##Length##millimeters ;Height##Length##millimeters;Frame##other##

Let’s look at the second example in more detail. The syntax is as follows:

Name of Parameter##Type of Parameter##Units

Figure 5.19 
The type catalog 
lets you create 
many types using a 
text editor.
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Name of Parameter corresponds to the name of a parameter in the family. You have to be 
careful when typing, because this value is case-sensitive. For example, if you have a Width 
parameter in the family, it should be shown as Width in the catalog as well. This parameter must 
be followed by two # symbols. Type of Parameter also must correspond to a type parameter in 
the family. The supported types are Length, Area, Volume, Angle, Force, and Linear Force. If the 
parameter in the family doesn’t correspond to any of these, type Other. It may not seem obvi-
ous at first, but instance parameters may not be defined in type catalogs. You’ll have to define 
instance parameters once the family is placed in the project. 

Next, enter the units. These are the valid units that will work in a type catalog: 

Length    Inches, feet, meters, centimeters, and millimeters

Area    Square feet, square inches, square meters, square centimeters, square millimeters, 
acres, and hectares

Angle    Decimal degrees, minutes, and seconds

Force    Newtons, decanewtons, kilonewtons, meganewtons, kips, kilograms-force, tonnes-
force, and pounds

Linear force    Newtons per meter, decanewtons per meter, kilonewtons per meter, mega-
newtons per meter, kips per foot, kilograms force per meter, tonnes force per meter, and 
pounds per foot

Other    For Other, you don’t specify a value; it can be anything. This is where you might 
define a material option or anything that is not defined as a length, area, or angle. In our case, 
it’s Yes/No.

In the example, Width is a length parameter defined in millimeters, Height is also a length 
parameter defined in millimeters, and Frame is a parameter that has Other as its value and no 
defined units.

After editing the first line in the catalog, key in values to define types. Here is an example 
showing four types. Notice that each definition consists of name, length, height, and frame:

900mm x 400mm - D;900 ;400 ;1
900mm x 400mm;900 ;400 ;0
1200mm x 600mm – D;1200 ;600 ;1
1200mm x 600mm;1200 ;600 ;0

By having set this in the type catalog, you’ve created four types for one family. The first type 
is named 900mm × 400mm – D. The width of the element is 900mm, the height is 400mm, and 
there is a frame (Frame is defined in a family as a Yes/No parameter; in the type catalog, this 
value uses 1 for Yes and 0 for No). To better understand the principle of the type catalog, it’s best 
to see it in table form:

type Name Width height Frame

900mm × 400mm – D  900 400 1

900mm × 400mm  900 400 0

1200mm × 600mm – D 1200 600 1

1200mm × 600mm 1200 600 0
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Loading from a Type Catalog
When you have a type catalog associated with a family and you load the family into a project, 
the Specify Types dialog box gives you the option to selectively load types from a table. This 
table lists type properties to help you sort and choose which types you want. Select one or many 
of these types (use Shift or Ctrl for multiple selections), and then click OK to load the family and 
selected types. Using the Ctrl key, you can select several types that aren’t sequential. Figure 5.20 
shows a Shift-selection, and Figure 5.21 shows a selection using the Ctrl key.

Customizing Project Settings in Your Template
Having a well-thought-out project template can not only save you time but can also guarantee 
a higher level of graphical consistency between projects. This way, you don’t have to become 
familiar with the settings in Revit and modify them each time you start a new project; you sim-
ply have to do it once and save it to a location that is accessible by everyone.

Graphic Overrides of Host Objects 
When dealing with multilayered walls, Revit uses object styles and represents the wall layers 
with a single cut-line style for all walls. As shown on the left in Figure 5.22, this cut line applies 
to the wall’s outermost layer. This isn’t flexible enough for some representations, where you may 
want to show only the core as a thick line and reduce the line weight of finish layers, as shown 
on the right in Figure 5.22. To add richer and more descriptive graphics to complex host struc-
tures, you need the ability to assign line thickness, type, and color to individual layers in a host 
structure (walls, floors, and roofs). You can do so on a per-view basis using graphical overrides; 
however, the settings can be stored in a view template and applied to other views.

You can change the line weight, color, and pattern of host layers. To do this, from the context 
menu select View Properties and open the Visibility/Graphic Overrides dialog box from a plan 
view. Then, choose the Overrides Host Layers option for Cut Line Styles (Figure 5.23). You need 
to check the Cut Line Style option to make the Edit button active.

Figure 5.20 
When you load a 
family with a type 
catalog, the Specify 
Types dialog box 
allows you to choose 
which types to load.

Figure 5.21 
Using the Ctrl key, 
you can select 
several types that 
aren’t sequential.
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When the Host Layer Line Styles dialog box opens, you see that the wall functions are listed 
with options to adjust the line weight, color, and pattern. Changing these values lets you gener-
ate wall graphics. Figure 5.24 shows the effect of changing line weight, color, and pattern for 
walls.

Figure 5.22 
(Left) The default 
representation of 
a cut line. (Right) 
The core layer can 
be made bolder 
and the finish  
layers thinner.

Figure 5.23 
You can change the 
line weight, color, 
and pattern of host 
layers.

Figure 5.24 
The effect of 
changing line 
weight, color, and 
pattern for walls.
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You can also control the line styles for common edges. As shown in Figure 5.25, you can over-
ride host layers in the Host Layer Line Styles dialog box. 

The Host Layer Line Styles dialog box also lets you define how the core layers should clean up:

Default    All line weights, colors, and patterns use standard behavior.

Use Function    This setting ignores the material settings (the line is never invisible) and sets 
the style of the separating line based on the layers’ functional priorities. The style of a sepa-
rating line is determined by the layer with the higher functional priority.

Use Common Edge Style    This setting ignores the functional priorities and material set-
tings and always uses the common edge style.

No Edge    This option sets the separating line to invisible whenever the layers have the same 
fill pattern.

Additional Global Project Settings to Consider When Making Your 
Templates
In addition to setting up the object styles for your templates, you should set up some other 
global settings in advance. In the Manage tab’s Project Settings panel (Figure 5.26), you’ll find 
global project settings that can be stored on a per-template basis.

area and Volume Computations settings

Area and volume calculations are based on the height of the cut plane and the layer in a wall to 
which the calculation is measured. The Area and Volume Computations settings are located on 
the Home tab, after you expand the Room and Area panel. The Area and Volume Computations 

Figure 5.25 
Overriding host 
layers in the Host 
Layer Line Styles 
Dialog box.

Figure 5.26 
The Project  
Settings menu.
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dialog box includes several predefinitions for you to consider (Figure 5.27). Here you can enable 
automatic calculation of Area only or Area and Volumes. We don’t suggest enabling the volume 
calculation option at all times because it can slow down overall performance when you’re work-
ing on your model. Do it only when you need the information or have to print out the docu-
ments that contain that information.

You can also apply different rules for room calculations that relate to boundary options in 
walls. These include wall finish, center, core layer, and core center.

Finally, a very important factor for computation of rooms and areas is the cut height. The 
computation height is a property of a Level family. By default, it is set to Automatic, which is 4´ 
(1200mm) above the base level. You can change it to any other value. Changing the computa-
tional cut height in nonvertical rooms affects the perimeter used for computation. Some users 
apply the strategy of creating multiple-level families that use different computation heights. 

These settings affect area plans that are used to convey building usage that extends beyond 
the shape and size of individual rooms, such as rentable area or office space. You access area 
plans from the View list of the Project Browser.

units

Depending on where the project is located or what country you work in, you’ll use either met-
ric or imperial units. In the Project Units dialog box (Figure 5.28), which is available from the 
Project Settings panel of the Manage tab, you can set the units for length, area, volume, angles, 
slope, and currency. Under each of these options, you can define a rounding value, rounding 
increment, and units suffix and decide whether you wish to show the plus symbol (+) for posi-
tive values.

Note that Revit allows for a combination of imperial and metric units within the context of 
the same project. For each unit type in the Project Units dialog box, you can specify the format-
ting that is most suitable. Also note that while the project settings establish a consistent baseline, 
you can override project unit settings for elements such as dimensions and schedules.

Figure 5.27 
Area and Volume 
calculations are 
based on the height 
of the cut plane 
and the layer in a 
wall to which the 
calculation is  
measured.
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Imperial Feet or Inches?

When you’re using Revit for the first time and working in imperial units, you’ll notice that numeric 
values resolve in feet instead of inches, which is different from the way AutoCAD works. A majority 
of Revit users have extensive experience (and thus established habits) with AutoCAD, so this can 
be frustrating at first. If you want to make sure your workflow isn’t inhibited by this issue, you can 
modify the setting here to work in inches instead of feet.

KeYnoting settings

Keynotes are a great way to standardize on a numeric system for calling out materials and 
assemblies. Keynoting settings are available in the Annotate tab when you expand the Tags 
panel (click the little arrow in the panel). When setting up keynotes, define the following key-
noting settings at the outset. First, set the keynote table path, as shown in Figure 5.29. The path 
defaults to the Revit library locations, but you may want to change this if you’re using custom-
ized keynote files located on the office network. In this dialog box, you establish whether the 
numbering method for keynotes is By Keynote or By Sheet. We’ll go into more detail about how 
to use keynoting in Revit in Chapter 19, “Annotating Your Model.”

Figure 5.28 
Set up your units 
and rounding in 
your templates.
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materials

The Materials dialog can be accessed from the Manage tab (Figure 5.30). A full render appear-
ance library ships with Revit, and you can use it to map rendering appearances to your existing 
Revit materials. To do so, select materials from the list on the left, and then click the Replace but-
ton to go to the Render Appearance Library (Figure 5.31).

Figure 5.29 
The Keynoting Set-
tings dialog box.

Figure 5.30 
Remapping con-
crete using the 
Materials toolset 
located in the Man-
age tab’s Project 
Settings panel.
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If you were using custom texture maps previously, then use the Generic Render appearance 
and remap the image files. Be sure to set appropriate scale using the Sample Size control. Keep 
in mind that for this to work in your templates, the images need to be accessible over the net-
work by anyone who uses the template.

setting up good projeCt defaults

Whatever type of element you selected last with the Type Selector will be set in the project 
template as the default type during creation. Revit remembers the most recently used settings 
across sessions. It’s therefore important that you set the types of your selected Revit elements as 
desirable defaults.

Default Wall

To set a default wall type, activate the Wall tool. Click the Change Element Type button to open 
the Type Selector. From the list, select the wall type that you wish to be the default choice. In the 
Element Properties dialog box or from the Options bar, select the wall height or set a top level, 
and select the wall location line. You never know which wall type you’ll need in the next project, 
so we suggest setting this to a generic type. The selection of exact wall types can come later.

Default Doors and Windows

Your project template is loaded with windows and doors that are typically used in projects. 
Activate the window or door tools, then using the Change Element Type button to open the 
Type Selector, choose a default door and window family, and save your template. The last 
selected door and window will be default elements in the Type Selector when you place new  
elements. This applies to all other family elements in your template.

Figure 5.31 
Use the render 
appearance library 
to select a render 
material.
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Default Dimension Types

To streamline your workflow, set the dimension style used most commonly in your template. 
You can consider presetting:

The type of dimension (we suggest selecting Linear)•u	

The reference selection that will be used when dimensioning a wall (to or from). Here the •u	

choices are the usual wall references: wall center, face, core face, and core center

The selection method, or what we call•u	  manual versus automated dimensioning. In Revit, the 
Pick method can be Individual, where you’re asked to click each instance you wish to 
dimension, or Entire Walls, where you click an element and it’s dimensioned automatically. 
With the Entire Walls option, another dialog box prompts you to further define what ele-
ments are used as auto-dimension references when you click walls (Figure 5.32)

Align Tool

Many users find this to be one of the most helpful tools in Revit, as it aligns elements to any 
reference target in the model. Setting its options correctly will aid in smoothing your workflow. 
Preset which wall layer to which you want the Align tool to default. The options available for a 
wall are shown in Figure 5.33.

Levels and Plan Views

Set up levels and corresponding plan views in advance in your template to save time down-
stream. You can predefine the number of levels, their typical height, and naming convention 
(Figure 5.34).

Figure 5.32 
Dimensions can 
be preset in your 
template to be 
automatic if  
need be.

Figure 5.33 
Setting a default 
alignment prefer-
ence with respect 
to wall references.

56491c05.indd   173 6/2/09   2:40:57 PM



174 | Chapter 5 Customizing system Families and ProjeCt settings in your temPlate

Elevations

If you’ve started building your template from an existing Revit template, you’ll already have 
four default exterior elevations defined. If you started from scratch with no template (which we 
strongly recommend against), you’ll need to create all four base elevations (south, east, north, 
and west) by placing elevation markers. (Note that we don’t recommend that you ever start Revit 
using the None option when making a new file, as you’ll have to define a great many things to 
make Revit work that are already defined in the default template.) It’s very important that you 
also set the width and depth of the elevations. To do so, select the arrow of the elevation mark 
that activates the current width and depth; then you can adjust them accordingly (Figure 5.35).

Figure 5.34 
Levels in the Proj-
ect Browser and in 
section view.

Figure 5.35 
Two different set-
tings for elevation 
tag depth and 
width.
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Views

For each view that you preset in the Revit template, you can define a scale, a level of detail, the 
state of the crop region (visible or not), and display settings (hidden lines, shaded view, and so 
on). But mostly, think of view templates when you preset your views, because they’re the biggest 
time-savers—setting them in the templates will increase productivity significantly and help you 
maintain graphical consistency.

View Templates

View templates let you define a desired set of view properties for any of your view typical types 
(plans, section, elevations, schedules, etc.). This is a great way to enforce graphic consistency 
across views. For example, if you want your architectural plan views to always show furniture 
as half-toned, you can define this in your plan view template. If someone changes the appearance 
of furniture to no longer be half-toned, you can reapply the view template to get the drawing 
back to its original configuration. To do this, right-click the view name in the Project Browser, 
and choose the Apply View Template option. Choose the desired template, and click OK. 

Every view can have a default view template assigned to help streamline updating the view 
later in the process (Figure 5.36). 

This doesn’t automatically keep the view in sync with the view template, but it lets you select 
many views in the Project Browser and push their default view template back into the view. 
To do this, select multiple views in the Project Browser, and choose to apply the view template. 
Choose the option Default View Template.

Figure 5.36 
Views can have 
a default view 
template assigned 
to them to help 
streamline updat-
ing the view later 
in the process.
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Use View templates

As your use of Revit on projects progresses, you’ll find that you will have view settings you will 
use over and over again that will help quickly define many of the parameters in a new view. These 
can easily be for plans, details, sections, or any other view within the project. Once you’ve defined 
these view templates, add them to your project template so that you can quickly access them when 
you begin new projects.

All view template-related tools are available from the View tab’s Graphics panel when you 
click the View Templates button. The last option, View Template Settings, is the place for cre-
ating, editing, and managing view templates. Look at the view templates that ship with the 
default template, and adjust these to suit your requirements. For example, the architectural plan 
scale (1:100) is set to 1⁄8˝=1́ -0 ,̋ as you can see in Figure 5.37. If this is too coarse for your needs, 
change the value to 1⁄4˝=1́ -0˝ (1:50).

Color Fill Schemes

Color fill schemes let you apply color to room and area parameter values to help graphically 
illustrate spatial organization. Applying a color fill scheme to a plan or section view color-codes 
room properties such as department, name, and usage. It’s good practice to predefine different 
color schemes that you’re likely to use. Once a color scheme is defined, it can be applied to any 
number of plan views. Keep in mind that color is applied only to spaces that have been popu-
lated with room or area elements. If you want to make department-usage plans, think about 
prepopulating your color schemes with commonly used department and usage names. This will 
make the value available for rooms later so you don’t have to manually type them in each time. 
For example, if you add “Accounting” as a value to a color scheme in your template that colors 
by department, then when you later go to a room’s element properties to assign it a department, 
you’ll see “Accounting” as a predefined choice in the drop-down list.

The Color Scheme settings are available from the Home tab when you expand the Room and 
Area panel. 

Figure 5.37 
The View Template 
Settings dialog box 
lets you create, 
edit, and manage 
view templates.
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The Bottom Line

Create new types of system families.    Incorporating common building components in your 
project template is fundamental to using Revit effectively.

Master It    How do you add/remove wall, floor, and roof types to your template?

Use type catalogs.    Revit’s type catalogs are an important tool for keeping the types you 
create accessible in a project.

Master It    What are type catalogs used for?

Customize project settings in your template.    View templates allow you to tailor views 
according to the requirements of a project.

Master It    How would you set up a new view template for plan views where the surface 
pattern of floors is turned off?
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Chapter 6

Modeling Principles in Revit I 

Creating a BIM model requires modeling in 3D. This is very different from using abstract 2D 
lines, arcs, and text to represent your design. To work with Revit and be able to build a BIM model, 
you need to understand how a building is built and how various building parts, ranging from the 
building mass down to furniture assemblies, are constructed at various scales. You need to know 
how various building elements interact with and depend on each other, what materials they are 
made of, and how they are constructed and assembled. To this end, Revit provides a set of tools 
that enable you to build your model and all the elements that go into the model. Understanding 
the principles of modeling in the context of Revit will be essential to your success as you move 
deeper into building information modeling.

This chapter is the first half of a description of the basic modeling principles that support the 
design process in Revit. In this chapter, you’ll learn to:

Understand the basics of modeling with Revit•u	

Understand sketch-based design•u	

Understand work planes, levels, grids, reference planes, and reference lines•u	

Grasping the Basics of Modeling with Revit
Designers have a long tradition of modeling before building. This activity involves the use of 
pliable and tactile materials such as clay and wood to model designs smoothly. With these mate-
rials, form can be explored with ease, as designs iterate directly in our own hands. The use of 
software to model form has become a popular extension of this activity, and you only need to 
look so far as the latest animated film to see how far the technology has come.

Many software modeling tools are available that allow direct editing and intuitive shaping 
of form. Tools such as Autodesk Alias Design Studio, Autodesk Maya, Rhinoceros, Autodesk 
3ds Max, Google SketchUp, and the latest release of AutoCAD allow you to create free-form 
conceptual shapes with relative ease. These tools are great for concept modeling, but they are 
not geared for a BIM approach to design and documentation. The elements created with these 
modelers are meshes, Non-Uniform Rational B-Spline (NURBS), ACIS solids, and other generic 
geometrical shapes that are used to represent walls, slabs, roofs, and windows. However, they 
do not have embedded intelligence or relationships among themselves or with other elements in 
the model. Further, they barely contain any metadata that can be quantified and analyzed. So, 
as it stands today, you will find great modelers that are not BIM and BIM applications that are 
not powerful modelers. One way that Revit approaches this problem is to allow importing of 
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free-form geometry into the project and family environment, where it can then be used to derive 
walls, floors, and roofs. And while it is not as free-form as some other applications, Revit natively 
supports the creation of parametric 3D forms.

The entire modeling concept in Revit is founded on some basic class modeling forms—
extrusions, revolves, sweeps, blends, and swept blends—and the combinations these can 
produce. The only place where this is not the case is the new set of Conceptual Design tools, 
introduced in this 2010 release of Revit. We will discuss these in greater detail later in the book 
in chapters 8 and 9. 

Each of the five basic modeling techniques can produce either a positive or negative shape 
(solid or void). These shapes can be combined to create more complex forms. Each form is derived 
from 2D sketches that are drawn on work planes and then given a third dimension. We’ll explore 
sketch-based forms in more detail in the next section.

Figure 6.1 shows an example of what’s possible using the modeling tools.

Understanding Sketch-Based Design
The majority of internal modeling techniques in Revit rely on an approach called sketch-based 
design, where you draw a shape in a special Sketch mode by creating 2D lines that then generate 
3D forms. When you model most Revit elements, you enter a mode in which the entire model is 
grayed out and not selectable, so focus is placed on the sketch, which is represented in strong 
magenta lines. Once you’ve defined your shapes by creating closed loops of lines, you click 
Finish Sketch, and the geometry is generated. This Sketch mode is used throughout Revit, so 
you should get acquainted with its behavior early on. 

For example, the Floor, Roof, Ceiling, Stair, and Railing tools require you to first sketch 2D 
shapes and then generate the form by “finishing the sketch.” Revit then applies a thickness or 
other element-specific property to the sketch, based on the element type. Even walls have an 
underlying sketch, but in the case of walls, this is a sketch that can be edited in elevation, not 
plan view, as is the case with the rest of the elements (Figure 6.2). To edit the elevation of a wall, 
select the wall in an elevation or 3D view and click the Edit Profile button in the Modify Wall 
panel of the Modify tab. Note that this tool only applies to linear walls.

Figure 6.1 
Example of expres-
sive architecture 
using Revit.
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Floors and Roofs
One of the first places you’ll encounter sketch-based modeling is with the Floor and Roof tools. 
When you initiate either of these tools, you are instantly placed in Sketch mode. The Ribbon 
changes, indicating the new mode (Figure 6.3), and you see a set of tools specific to the task of 
creating 2D sketch lines and creating lines with relationships to other model elements.

For example, you can either draw lines freely using the Line tool in Draw panel, or use the 
Pick Walls tool from the same panel, which generates the floor or roof sketch lines when you 
pick on walls. When using the pick walls method, you create an explicit relationship between 

Figure 6.2 
Moorish architec-
tural example: (A) 
Standard straight 
rectangle shaped 
wall; (B) eleva-
tion sketch of that 
wall changed to 
the desired shape 
using simple lines; 
(C) wall shape 
result achieved by 
simple editing of 
the sketch in eleva-
tion; (D) the wall 
used in a building.
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Figure 6.3 
The Create Floor 
Boundary tab 
offers tools for 
sketching the  
floor shape.
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the floor or roof sketch and the walls. As a result, when walls move, the sketch (and thus the 
floor or the roof made of it) adapts and updates with the walls.

There are a few important rules you must apply when creating a sketch so that it is valid:

The sketch has to form a closed loop of lines, and the lines have to be perfectly trimmed at •u	

the ends. You cannot have gaps or overlapping lines in the sketch. Whenever a sketch is not 
complete or has overlaps, Revit will indicate that something is wrong with an error mes-
sage and you will not be able to finish the sketch until you fix and clean it up.

When creating certain types of elements, you are allowed to sketch more than one closed •u	

loop within or outside of the same sketch—this is fine as long as the two loops do not inter-
sect. If one loop of lines is within the boundaries of the other, it creates an opening in the 
outer shape (Figure 6.4).

Figure 6.4 
Creating a closed 
loop within 
another closed loop 
of lines results in 
an opening.
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If you were to draw another loop within those openings, it would be positive and create 
another solid piece of floor of the same type. Here’s the logic behind loops: one is positive, the 
next one within it is negative, and the next one within it is positive (Figure 6.5).

Sketching Rules of Thumb
Here are some rules of thumb you will need to follow when sketching:

To edit a sketch, you must be in a view that is parallel to the sketch or a 3D view. For example, •u	

it is not logical to edit the sketch of a wall profile in a plan view as you would not be able to 
see the sketch in a way that is relevant. If you attempt to do this in plan view, Revit alerts you 
and proposes other views in which you can execute the task. The same goes for a floor—only 
in plan or 3D will you be able to edit the sketch.

Sketch mode cannot be activated in perspective (camera) views. If you select a wall or any •u	

other element and want to edit its shape but cannot find the Edit button on the Options bar, 
you are in camera view. Switch to an axonometric, 3D, or any other view in which the 
sketch makes sense to edit.

Understanding Work Planes, Levels, Grids, Reference 
Planes, and Reference Lines
Reference planes, reference lines, levels, work planes… what are they? This section delves into 
each of these topics. First, to master modeling techniques in Revit, you need to understand the 
concept of a work plane.

Work Planes
The work plane is a 3D plane that you sketch on. For example, when you are in a plan view and 
start sketching a floor, the work plane is set to the level associated with the plan view you are 
working in. The majority of views in Revit (plans, 3D views, or views set in the family templates) 
have predefined work planes set automatically when they are created. Views such as sections and 
elevations require you to manually pick a work plane in order to add 3D elements to those views. 
In some cases, as with placing windows or doors in an elevation view, this is done implicitly—the 
cursor locates planes (walls) automatically.

Figure 6.5 
An additional loop 
of lines results in a 
positive shape.
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A work plane can be understood as a surface on which you draw or place something. Imagine 
you are holding a marker in your hand and have a space in front of you. Can you draw with the 
marker in the space? No. You need a piece of paper, glass, wall—some kind of a surface to draw 
on. So, a work plane defines a surface on which you can build geometry. You can define a work 
plane by drawing a reference plane, picking a face from an existing element, or using an existing 
level (datum) as a reference.

Figure 6.6 illustrates the work plane. There are a few simple rules you must follow when 
using a work plane:

The work plane is set by selecting a reference plane/reference line; a datum plane (like a •u	

level or grid); or a planar face of a model element. Often it is preset and you do not need to 
explicitly set it.

Many elements in Revit use the active work plane to know where to sketch or place objects. •u	

(Some objects are limited to only horizontal or vertical work planes.)

The work plane is also used when you are modifying objects. When you drag or move an •u	

object, it is typically constrained to that plane.

When you set the work plane to be based on other selectable elements, it creates a •u	 dependency, 
or relationship, to the underlying reference you selected. If the underlying object is moved, 
the work plane is moved to stay aligned to it. Any objects created on the work plane will 
also update.

Let’s take a closer look at the types of work planes available in Revit.

Figure 6.6 
Concept of work 
planes.

Lines Sketched on
Active Work Plane

Model Face
Reference Plane
(or other Datum Plane)

Active Work Plane
(based on Model Face 
or Datum Plane)
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Levels
Levels are horizontal work planes that define the levels in a building and can also be used to 
denote important horizontal references in a building (such as attic height). Levels are only cre-
ated and visible in section or elevation views. The only exception to this is when creating a new 
Conceptual Mass in the Family Editor—there levels are represented in a 3D view. Each level 
typically has a corresponding floor plan view associated with it, although it is possible to make 
levels with no associated floor plan. For example, a level may define the Top of Steel in a build-
ing section, but there is no need to have a floor plan view of that level. For that case, you can 
create levels without plans by clearing the option Make Plan View on the Options bar when the 
Level tool is activated. This creates a level that appears black and white rather than blue, indicat-
ing that there is no hyperlinked view.

Note that when you create new levels using the Copy tool from the Modify panel, the newly 
created levels are black and white (unlike the levels that are drawn using the Level tool and that 
are represented with a blue symbol). This change in color indicates that this level has not gener-
ated a new floor plan that is associated with that level as the Level tool does usually. If you do 
need a corresponding floor plan associated with that level, you can use the Plan Views tool in 
the Create panel of the View tab. You will then be able to add a plan view associated with any 
existing level in the project.

When you place families, they automatically become associated with the level they are placed 
on. Walls, roofs, and stairs all have top and bottom constraints to levels. This guarantees that 
when the level changes height, so too will all the elements on that level. All sketch-based families 
such as floors, roofs, ceilings, and stairs are also associated with at least one level. This, however, 
means as well that if you delete a level, all the elements associated with that level will also be 
deleted! So use caution when deleting levels; it’s not just a drawing that you are deleting!

Grids
Grids are vertical planes used as standard references in the construction industry for creating 
location grids on the site as well as a communication reference between the building participants. 
These construction datums are used to accurately define locations for elements such as columns 
and beams or positions of main structural walls or the exterior shell. You can associate elements 
with the grids so that when the grid system changes, it controls the position of the associated ele-
ments. A good example for that would be columns associated with grid intersections. As with a 
level, when a grid is moved, associated elements move with the grid (Figure 6.7). Grids and levels 
(datum) only show up in views that intersect the datum. 

Figure 6.7 
Grids are reference 
planes that can 
be used to control 
other elements 
such as beams and 
columns.
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extending Levels and Grids

If you wish to expand grids or levels to encompass a larger portion of your model, you can use the 
context menu of the grids and select Propagate Extents. This command is also available in the 
Datums panel of the Modify tab when you select a grid line. This extends the datum planes you 
have selected to the maximum extents of the model geometry.

Reference Planes
Reference planes are used to drive other geometry. They are planes that exist in 3D space that 
other elements can be attached to. While not visible in 3D views, they can be seen when per-
pendicular to plan, section, and elevations and are represented as green dashed lines. Similar 
to levels and grids, these lines are not view specific and will appear in all perpendicular plans, 
sections, and elevations. Even though reference planes look and feel like ordinary lines, they are 
very different. Think of them as symbolic representations of infinite planes. The ends of refer-
ence planes are selectable and you can drag them to make them longer, but you will not be able 
to rotate the end of a reference plane freely as you can with lines.

Using RefeRence Planes in the family editoR

Reference planes are the essence of parametric content creation in the Family Editor, as they are 
used to create the parametric skeleton to which geometry is then attached and allowed to vary. 
The reference planes in a family are what you dimension to when they are loaded into a project—
not the geometry.

Giving the reference planes various states also affects how other elements relate to the family. 
A reference plane can be set as not a reference, weak, or strong, and it can be defined as a reference 
for the left, right, front, bottom, back, or center position. The selection of these options is impor-
tant in the Family Editor environment, as they define references for snapping. When you have 
two crossing references set as Strong, they define the insertion point of an element when you 
place it in the project environment. The origin must be further defined in the instance properties 
of the crossing reference planes by selecting “Defines Origin.”

In Figure 6.8, the two centrally positioned strong references define the insertion point of the 
element. The weak references serve only as secondary snaps.

Figure 6.8 
The insertion point 
of the desk is the 
point of the two 
crossing references 
that has been iden-
tified as “Defines 
Origin.”
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In a project, reference planes can be used to drive geometry (see Figure 6.9).

Reference Lines
Reference lines were designed mostly for use in the Family Editor to overcome the limitation 
of the reference planes and their inability to define constraints that reference a point, direction, 
and angle. Unlike with reference planes, the start and end points of a reference line can be ref-
erenced and used for dimensioning. A popular use of a reference line is to define door swing 
opening angles by creating an angular relationship between the door leaf position and the 
closed state of the door leaf. This will let the user set any angle of door opening later in the proj-
ect. Other differences between reference lines and reference planes are that you cannot name 
the reference lines and you can only select them graphically.

Reference lines define four work planes—the two along the axis of the reference line and the 
third and fourth planes that are perpendicular to each of the line segments (see Figure 6.10). 

Figure 6.9 
Reference planes 
are used exten-
sively in the Family 
Editor to create 
parametric con-
straints that can 
drive forms and 
define snapping 
references. In this 
example, two of 
the vertical refer-
ence planes define 
the width of the 
chair while the two 
horizontal define 
its height.

Figure 6.10 
Reference lines 
are used to control 
door swings and 
opening angle in 
families.
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scoPe Boxes

As previously mentioned, reference planes extend in all views. Once drawn in one view, they 
will appear in every view that shows the area where they are created. But that is not necessarily 
what you always need. Let’s say your project has a base of five floors of conference area with a 
30-story hotel above (like the model shown in Figure 6.11). It’s likely you’ll have separate struc-
tural bays for each part of the building. You don’t need to see all grid lines of the conferencing 
base in the hotel tower, and vice versa. 

The Scope Box tool will help you deal with this issue and allow you to limit the range in 
which reference planes (grid lines, levels, and reference lines) extend and appear. In our exam-
ple shown in Figure 6.11, the building has a base shape that accommodates a conference center 
and a tower in which a hotel is situated. They have very different configurations and need 
different grid systems. The thing to do is to draw two separate scope boxes around those two 
entities, using the Scope Box tool allocated in the Create panel of the View menu. Then the grids 
of each of those two parts of the building need to be assigned to the appropriate scope box (the 
grid of the base to the Conference scope box and the grid of the tower to the Hotel scope box).

Scope boxes are visible in 3D views—although not in camera (perspective) views—and 
you can easily manipulate their extents at any time directly using the grip controls. Assigning 

Figure 6.11 
(A) This building 
consists of two 
main volumes, a 
low volume with 
conference usage 
and a tower with 
hotel use. These 
two volumes use 
separate grid sys-
tems, and thus two 
different scope 
boxes are created 
to control the vis-
ibility of the sepa-
rate grids. (B) Grid 
element properties 
indicate the scope 
box to which the 
grid belongs.

A

B
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gridlines or other datums to a scope box is easy: select the gridlines, and in the Instance 
Properties dialog box, choose the Scope Box parameter and select the scope box where the 
datums should belong. Figure 6.11 shows the Instance Properties dialog box for the gridlines 
and the associated scope box.

Visibility of Grid Lines in Sections and elevations

Grid lines will show in section or elevation view and only if the view is cut perpendicular to the grid 
line. In no other case will the grid line appear. This is done to avoid confusion on the construction 
site due to misleading graphic description.

Work Planes in a Nutshell
Before moving on to look at using work planes in practice, let’s take a moment to summarize the 
basic theory.

WoRking With WoRk Planes

When creating elements that do not necessarily fall on a standard reference plane (such as a level), 
you will need to select the Set button on the Work Plane panel of the Home tab to establish your 
work plane. This brings up the Work Plane dialog box shown in Figure 6.12. Let’s review the 
options in the dialog box.

Name    This option displays available levels, grids, and named reference planes. Note that 
only reference planes to which you have explicitly assigned names appear in this list. To 
name a reference plane, use the element properties of the reference plane.

Pick a Plane    This option allows you to select a plane interactively in the model. The selec-
tion is visual and you need to click on a reference plane, wall face, or faces of an element. 
Figure 6.13 shows how different an extruded shape will be when selecting different planes 
on which to sketch and create a void extrusion. The face of the element that’s marked darker 
represents which side of the element was set as a work plane.

Figure 6.12 
The Work Plane 
dialog box lets you 
specify the active 
work plane for  
a view.

56491c06.indd   189 6/2/09   2:40:44 PM



190 | Chapter 6 Modeling PrinciPles in revit i 

Pick a Line and Use the Work Plane It Was Sketched In    With this option, Revit converts 
the work plane on which the line was created into the active work plane. When you select a 
work plane that is perpendicular to your current view, Revit opens a new Go to View dialog 
box that gives you options to select a view in which the chosen work plane can be worked on 
(Figure 6.14).

WoRk Plane VisiBility

You can visually show the active work plane in your view using the Show button in the Work 
Plane panel of the Create tab. When visible in 3D, the work plane is shown as a semitransparent 
grid face (Figure 6.15). By activating work plane visibility, you’ll see where you will be adding 
new elements. You can see the work plane change location by using the Pick Plane option in the 
Work Plane dialog box. Select model faces and you’ll see the active work plane change.

If you are not sure where your active work plane is, click the Show button in the Work Plane 
panel.

otheR WoRk Plane oPeRations

Revit will let you rotate a work plane grid by clicking on it and selecting Rotate from the Modify 
panel. This in turn affects how new elements will be placed on that work plane. You can also 
align elements to the work plane grid, and lines will snap to the grid (Figure 6.16).

Figure 6.13 
The same mass and 
the same 2D shape 
extruded as a hole. 
In (A) the extrusion 
shape is drawn on 
the front face of 
the mass; in (B) the 
extrusion is drawn 
on the back face of 
the mass.

A B

Figure 6.14 
The Go to View dia-
log box lists views 
where you can 
work on the active 
work plane.
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Figure 6.15 
Making the work 
plane visible helps 
you understand 
the active work 
plane in a 3D view.

Figure 6.16 
When the work 
plane grid is 
rotated, new  
elements placed on 
the work plane will 
also be rotated.
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To change the work plane an element is already associated with, select the element, and then 
click the Edit Work Plane button in the Work Plane panel of the Modify tab and select another 
work plane using one of the methods in the dialog box.

To dissociate an element from a work plane, first select the element. Next, click the Edit Work 
Plane button in the Work Plane panel to display the dialog box shown in Figure 6.17, and click 
the Dissociate button. The element will then be free to move anywhere in the model. Note that 
this option is only available for work plane–based families.

Once you have dissociated an element from its work plane, you will notice that the value for the 
work plane instance parameter (located in Element Properties) will be set to <not associated>. 

Most importantly, you will notice that the element is free from constraints and is free to be 
moved in any 3D direction.

To rehost elements from one host (wall, floor, or roof, for example) to another, you can use the 
Pick New Host button from the same Work Plane panel when an element is selected. This allows 
you to select a new host to place the element. With this tool, you can choose any new host—it 
does not have to be in the same plane as the original. For example, you can select a window in 
one wall, click the Pick New Host button, and then choose a new wall for the window.

Figure 6.18 shows an extruded shape originally created on a horizontal work plane. Using the 
Pick New Host tool, you can place the form on any surface in the model. 

Figure 6.17 
The Work Plane 
dialog box allows 
you to set the work 
plane of an ele-
ment or dissociate 
it from its work 
plane.

Figure 6.18 
(A) Original  
condition;  
(B) desired repo-
sitioning of the 
curved element; 
(C) the element 
is rehosted and 
a relationship 
between the two 
elements has been 
created; (D) the 
host changed its 
geometry and the 
hosted elements 
follow the change.

A B

C D
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Using Work planes with revit roofs

Here are two versions of the same building, with roofs that use the same sketch profile but are 
drawn on two different work planes. Image A shows a roof by extrusion sketched on a work plane 
parallel to the exterior wall; B shows the same roof sketched on a work plane rotated 45 degrees 
with respect to the exterior wall. Notice the difference!

A B

Creating a roof by extrusion (Default Work plane)

Take the following steps to see for yourself how version A was created:

 1. Draw four walls in plan view in the shape of a square.

 2. On the Work Plane panel of the Home tab, select the Reference Plane tool and draw a reference 
plane parallel to the south wall:

 3. Pick the reference plane and open its instance properties. Give it the name Front Roof Plane.
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 4. On the Create panel of the Home tab, select the Roof tool and select Roof by Extrusion. You will 
be prompted to select a work plane.

 5. From the Name list, select the named reference plane you just drew and named. You’ll be asked 
to open a view to begin sketching. Choose the south elevation.

 6. Sketch a roof in arc shape, as shown here, and finish the sketch:

 7. Go to the default 3D view and, using the blue arrows, adjust the length of the roof to make sure 
it extends beyond the exterior walls, as shown here:
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 8. While still in the 3D view, select all the walls. Click the Top/Base: Attach button in the Modify 
Walls panel of the Modify tab and then select the roof to attach the walls to the roof. The result-
ing building should look something like this:

 9. To cut the roof so that it ends at the edge of the exterior walls, switch to plan view (Level 2 or Site 
plan), select the roof, and select the option Vertical Opening in the Modify Roof panel. This allows 
you to cut off the extruded roof exactly at the edge of the building, regardless of its shape. In this 
example, draw two rectangles (the location is indicated in the following figure with Vertical open-
ing) that cut the roof up to the face of the walls.
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After applying the two sketches using the Vertical Opening tool, the final result for the first 
roof should look like this:

Creating Version B: a roof Using a 45-Degree Work plane as a reference

To obtain the second roof (B) shown at the beginning of this section, repeat all the previous steps, 
but draw the reference plane at a 45-degree angle to the building, as shown here. Remember to give 
the reference plane a different name in its Instance Properties dialog box. 
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The finished roof looks like this:

 

The Bottom Line

Understand the basics of modeling with Revit.    Modeling with software is an extension of 
the traditional art of modeling with the hands. Free-form 3D modeling tools are not designed 
with BIM workflows in mind, but it is still possible to import shapes into Revit for down-
stream use. At the same time, Revit provides some basic tools for 3D design, and you should 
familiarize yourself with these.

Master It    Tools such as Autodesk Alias Design Studio, Rhinoceros, Autodesk 3ds Max, 
Autodesk Maya, SketchUp, and AutoCAD 2010 allow you to create free-form shapes with 
relative ease. How does Revit let you take advantage of such shapes?

Understand sketch-based design.    Sketch-based design allows you to define some basic 
parameters and shapes in Sketch mode within Revit.

Master it    Revit uses a 2D sketch-based approach to modeling. What modeling elements 
in Revit use this 2D sketch principle to generate their form?

Understand work planes, levels, grids, reference planes, and reference lines.    Using these 
tools gives you the ability to better control your model and your design by applying and con-
trolling parameters.

Master It    In order to sketch a form, the form must reside on a work plane. How do you 
define and visualize the work plane in Revit?
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Chapter 7

Modeling Principles in Revit II

Creating a BIM model requires modeling in 3D. This is very different from working with abstract 
2D lines in order to represent your design. To work with Revit and be able to build a BIM model, 
you must understand how objects are constructed at various scales ranging from the building mass 
down to furniture assemblies. You need to know how various building elements interact and depend 
on each other, what materials they are made of, and how they are constructed and assembled. To 
this end, Revit provides a set of tools that enable you to model all the elements that go into the model. 
Understanding the principles of modeling in the context of Revit is essential to your success as 
you move deeper into building information modeling.

This chapter is the second part of a description of the basic modeling principles that support 
the design process in Revit. In this chapter, you’ll learn to:

Understand the principles of modeling in Revit•u	

Model with five basic forms•u	

Combine solids and voids to create complex and intriguing forms•u	

Understanding the Principles of Modeling in Revit
Revit is much more than a 3D modeler. It was designed specifically for architects and has behav-
ioral rules built into many of the architectural elements that make up the model. For example, 
walls are usually vertically oriented rectangular shapes; floors and ceilings are horizontal 
shapes with constant thickness. These major building elements use 2D boundary lines to gener-
ate 3D geometry, as these types of elements tend to have a consistent thickness. This is one of 
Revit’s major differences when compared to a generic modeler that lets you model anything, any 
way you like. In essence, with Revit the type of element you are modeling will present a tailored 
set of creation tools. This approach to software tools becomes more apparent in Revit 2010, with 
the introduction of a new set of conceptual modeling tools designed to support free-form mod-
eling in the early phases of design development. We’ll delve into more specific methods of mod-
eling throughout this chapter. 

Revit provides specialized tools depending on the element you are creating. For example, you 
draw a wall by defining its start and end points, which will determine its position and length, 
while the width and height are determined by the instance and type properties of the wall. The 
wall becomes a 3D element immediately with each click of the mouse. Roofs, floors, and ceilings, 
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on the other hand, require you to enter a 2D drawing mode to define the boundary shape. Their 
thickness is defined in the type properties. To create conceptual models, you start by drawing 
lines, and then select them to make 3D forms. Once you’ve made a form, you can then modify it 
directly using interactive controls on edges, faces, and vertices. We’ll dig into the specifics of this 
toolset in the next chapter.

Once the envelope of the building has been established (walls, floors, and roofs), you pro-
gressively add more elements—windows, doors, furniture, plumbing fixtures, and so on—to the 
model. These building components rarely depend on the context of the building and are usually 
manufactured offsite at a factory in real life. Somewhat similarly, in Revit many components are 
predefined and saved in a library for use across multiple projects. These loadable components 
are all created in the Family Editor using a combination of simple geometric forms that can be 
associated with parametrically driven dimensions and materiality. For example, a chair can 
be created with a combination of sweeps, blends, extrusions, and revolves. The same applies to 
a light fixture, a bench, a plumbing fixture—you name it. Figure 7.1 shows samples of standard 
“loadable” family types.

The Family Editor allows you to create components of any flavor. In some cases, the flexibility 
of the Family Editor modeling tools can be useful in the context of your project. When you want 
to create a custom design feature that is tightly related to the context of the building or the land-
scape around it (such as an entrance canopy or a reception desk in a welcome area), you’ll need 
a robust set of tools that are not part of the basic wall, floor, and roof tools. To access the full 
range of Family Editor modeling tools in a project file, use the Model In-Place tool located in 
the Component drop-down on the Home tab (see Figure 7.2). 

You can use the same features of the Family Editor to create your geometry. Figure 7.3 shows 
a fireplace built as an in-place model.

Figure 7.1 
These windows 
and doors are 
standard loadable 
components.

Figure 7.2 
The Model In-Place 
tool located under 
the Component 
tool of the  
Home tab.
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Another workflow where free-form modeling comes into play is at the early stages of concep-
tual design, where massing studies are explored. With massing, the tools need to be flexible and 
not constrained to a specific use case. In Revit, these mass forms are created with the Massing tools 
as combinations of various geometric shapes. In Revit 2010, when making massing forms using 
the conceptual design tools, the interaction with form is intended to support free-form creation 
and direct manipulation of forms. You do not enter a “sketch mode,” but rather edit forms 
directly. Figure 7.4 shows a massing study using Revit’s form-making tools.

Figure 7.3 
Example of an  
in-place model.

Figure 7.4 
Example of  
massing concept 
studies.
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Modeling with the Five Basic Sketch-Based Techniques
When creating standard components, there are five basic form-making options in Revit. With 
these techniques you can create a variety of shapes for various scales of design. By combining 
forms and using forms as subtractive elements, you can model nearly anything in Revit. The five 
primary modeling techniques used for making components in Revit are:

Extrusions•u	

Revolves•u	

Sweeps•u	

Blends•u	

Swept Blends•u	

These are accessible from the Family Editor when you’re creating Solid or Void forms,  
and are also available when you’re making in-place family components within the Project envi-
ronment (Figure 7.5).

You can choose to create either solids or voids when making 3D forms. Selecting Solid Form 
or Void Form from any of these toolbars displays the options shown in Figure 7.6.

Extrusions
An extrusion, the simplest of all modeling transformations, is derived from a 2D loop (a closed 
chain or chains of line segments) drawn in a plane that has a thickness value. The thickness is 
always perpendicular to the work plane of the 2D lines (see Figure 7.7).

Figure 7.5 
The standard form-
making types.

Figure 7.6 
Solid and Void 
Extrusion, Blend, 
Revolve, Sweep, 
and Swept Blend 
options.
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The element properties of an extrusion allow you to set the thickness of the extrusion as well 
as an offset from the work plane it was drawn on.

Extrusion Start    This defines where the extrusion starts and has a default of 0, but it can 
have any positive or negative value. The effects of this parameter are shown in Figure 7.8.

Extrusion End    This parameter defines the end of the extrusion relative to the work plane. 
This value can be positive or negative. The default is set to 1˝-0² (250mm). The total thickness 
of an extrusion is the difference between the extrusion end and extrusion start.

When an extruded element is selected, check the contextual tab and the Options bar for rel-
evant options.

Edit Extrusion    This button takes you back to the 2D editing mode so that you can make 
changes to the underlying shape. Once you have changed the shape, don’t forget to click 
Finish Extrusion on the Ribbon.

Figure 7.7 
An extrusion is 
a 2D shape with 
thickness.

Figure 7.8 
(A) Extrusion start 
is set to 0; (B) has a 
positive value and 
starts above the 
work plane; (C) has 
a negative value 
and starts below 
the work plane.

A B

C

56491c07.indd   203 6/2/09   2:40:30 PM



204 | Chapter 7 Modeling PrinciPles in revit ii

Depth    Depth defines the value of the extrusion thickness. This value can be positive or 
negative. With vertical extrusions, the depth actually is the height of the extrusion.

Visibility Settings    Visibility Settings define in which view types or levels of detail the 
extrusion will be visible. Figure 7.9 shows that the selected extrusion will be visible only 
in plan and reflected ceiling plan views, and only in medium and fine levels of detail. 
Setting the appropriate Display and Detail Level will improve printing, exporting, and 
overall graphic performance.

Edit Work Plane    This button allows you to change the work plane of the extrusion. You can 
only set a new work plane if it is parallel to the existing work plane of the extrusion.

Figure 7.10 demonstrates how a furniture element can be constructed from two extrusions 
that create the entire shape.

Figure 7.9 
Forms can be made 
visible or invisible 
in different views 
and at different 
levels of detail.

Figure 7.10 
A cozy lounge chair 
made of two simple 
extrusions.
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Directions in a reference plane

The direction in which you draw a reference plane determines which way is positive and which 
way is negative.

These images demonstrate in plan view how the direction in which the reference plane was drawn 
affects the direction of the extrusion.

Because it is difficult to remember which way you drew each reference plane, we suggest that you 
name each reference plane you create. If you do that, you will see the name of the reference plane when 
it is selected, and the name is always placed at the end of the direction in which it was drawn.

When you use the face of an element as a work plane (rather than a reference plane), as shown 
in Figure 7.11, the direction of the extrusion will depend on whether you are making it a solid or 
a void shape.

When you sketch a shape that is going to be a void, the void extrudes positively toward the 
interior of the object that you used to define the work plane.

When you add a solid shape, the shape extrudes positively away from the exterior of the 
object face, as shown in Figure 7.12.

Figure 7.11 
A void extrudes 
into the solid face.

Figure 7.12 
A solid extrudes 
away from the 
solid face.
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Revolve
A revolve takes a 2D profile and rotates it around an axis. A revolve is composed of two elements: 
a 2D profile (think of this as a cross section) that will define the surface once it is revolved, and an 
axis that the profile revolves around. As with extrusions, the profile must be a closed loop of lines 
for the revolve to be valid. The bollard shown in Figure 7.13 is an example of a revolve form.

By default, a revolve follows a full 360-degree path. In the element properties of a revolve, 
you can adjust this angle so that the profile will appear open, as shown in Figure 7.14. The 
parameters for the revolve will let you determine the start and end angles:

Figure 7.13 
A revolve consists 
of a closed loop of 
lines and an axis of 
rotation.

Figure 7.14 
The end angle is set 
to 270 degrees.
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End Angle    The end angle positions the profile relative to the work plane of the end of the 
revolution. Figure 7.14 shows a revolve with an end angle set to 270 degrees.

Start Angle    The start angle positions the profile relative to the work plane at the beginning 
of the revolution. By setting the start angle to a value other than 0, you can get shapes like that 
shown in Figure 7.15.

When you select a revolve form, you’ll see options similar to those available for an extrusion. 

These are similar to the options available when selecting other modeling forms. You can change 
the 2D boundary that you used to execute the revolution with, set the visibility, edit the work 
plane, or re-host the form to another plane.

To understand how sketches create revolve shapes, we will look at three different results 
based on three different types of sketches. Figure 7.16 shows a standard revolve made out of one 
closed loop of lines; Figure 7.17 shows a revolve made out of two closed loops, where one loop is 
a subtractive element; and Figure 7.18 shows another revolve with two closed loops, where each 
loop is an additive element.

Figure 7.15 
The start angle is 
set to 90 degrees 
and the end angle is 
set to 270 degrees.

Figure 7.16 
One closed loop 
of lines revolved 
around an axis.
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A revolve can be composed of multiple closed loops to define the profile lines. Keep in mind 
that a profile must not intersect another profile; if it does, it will fail, and Revit will warn you 
when you try to finish the revolve. Depending on the positioning of the different profile loops, 
you can achieve different results, as shown in Figures 7.17 and 7.18.

A common example of a revolve form appears in Figure 7.19. The profile defines the cross sec-
tion of a dome (cupola) roof. By rotating this profile around the center axis, we can generate a 
dome form.

Figure 7.17 
In this example, the two 
closed loops of lines are placed 
one inside the other. Follow-
ing the principle of sketch-
based design, the inner loop 
creates a hole in the first loop.

Figure 7.18 
The two loops are indepen-
dent of one another and thus 
the resulting revolution cre-
ates two solid shapes.

Figure 7.19 
The profile is 
revolved around 
the center axis, 
resulting in a  
dome form.
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the rule of the axis

None of the shapes that are to be revolved can cross the axis of the revolution. They can, however, 
have an angle other than 90 degrees relative to the axis and can be offset from it.

Another example of a revolve is this doorknob (Figure 7.20), where the cross section is drawn 
and then revolved around an axis.

Sweeps
A sweep is conceptually similar to an extrusion, but you must define a path for the extrusion 
profile to follow. The resulting form is generated by sweeping the profile along path segments. 
The profile is always swept perpendicular to the path segment it follows.

A sweep is defined by two sets of lines: the path, and the profile that you sweep along the 
path. The path can be drawn on any work plane, and the profile will always be drawn perpen-
dicular to the path. The first segment of the path you draw determines the default work plane for 
the profile lines. To change the default location of the profile sketch plane, delete the line segment 
of the path that hosts it; the profile plane will jump to the next available line segment in the path. 
Figure 7.21 shows a swept form, along with the path and profile used to create it.

Figure 7.20 
A revolve can be 
used to create 
elements such as 
doorknobs as well.

Figure 7.21 
Example of a 
sweep. The dashed 
rectangle is the 
profile plane, 
which is always 
perpendicular to 
the path.
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Defining the Sweep path

You can make a path by either selecting existing geometric edges (imported lines, edges of other 
forms) to create new lines or drawing lines directly. The options shown here are available on the 
Mode panel when making a sweep.

When using the draw method, you’ll be able to pick and draw lines. However, the path must 
be in the same plane. The Pick Path method allows you to create a 3D path. When you enter the 
Pick Path mode, click the Pick 3D Edges button, and then pick edges in the model. Note that 
with this method of defining the path, you will not be able to draw lines—you must pick off of 
existing geometry.

With this method, you create a dependency between the swept element and the object that 
you selected for edges to define the path. Thus, when the geometry of the referenced object 
changes, so too will the swept element. We strongly recommend working in a 3D view when 
using this method, as it will make it easier to understand the relationships and effects of chang-
ing geometry (Figure 7.22).

Defining the profile

A profile can be created using one of two methods: by drawing the profile directly or by using 
a loaded, predefined profile. These options are shown in the Ribbon when defining the profile 
for the sweep. The default, By Sketch, lets you draw the profile using standard draw tools. Click 
the Edit Profile button to bring up the Draw/Pick Gallery and start drawing lines. Once a profile 
has been loaded, it will show up in the Profile drop-down list. 

This method is applicable in cases where you need to sweep the same profile on many paths. 
For example, you would first create a 2D profile family using the Profile (imperial) or M_Profile 
(metric) template. The profile has to be a closed loop of lines. Save the profile on your hard drive 
and then load it in your project or family.

Figure 7.23 shows the drop-down list and the Edit Profile and Load Profile buttons.

Figure 7.22 
Example of a sweeping path 
that is created by selecting 
existing edges of a solid geom-
etry (in this case a wall open-
ing). If the opening changes 
its size, the sweep will also 
change because of the depen-
dency established with the 
Pick method.

Figure 7.23 
The default method for creat-
ing profiles is by sketching. 
You can also load premade 
profiles and use those.
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If you use a loaded profile, you are given controls to position the profile relative to the X and 
Y axes (see Figure 7.24). These values are distances from the point of insertion of the profile (the 
intersection of the two reference planes in the Family Editor) and the point of reference of the 
profile and the path (the green cross). The values are editable in the Options bar, and will update 
if you move the profile interactively as well.

You can rotate the loaded profile by adding a value under the Angle option (see Figure 7.25). 
The Flip button mirrors the profile, if you need it. Click the Apply button on the Options bar to 
finish placing the profile.

Once a sweep is created, you can always change the values that are available in the Element 
Properties dialog box of the sweep, shown here:

The advantage to using premade profiles is enormous. Figure 7.26 illustrates a concrete 
example of a sunshading family that needs to be edited. 

Figure 7.24 
Offsetting the profile from the 
point of reference of the path. 
In this profile, the crossing of 
the references in the Family 
Editor was set to the lower-
left corner of the profile. Thus, 
the offset values start from 
that point.

Figure 7.25 
The angle of rotation is 
applied to the profile that  
is to be swept.

Figure 7.26 
Sweeps can be 
used to create a 
sunshade.
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If you had drawn your profile manually and then used the Copy Multiple command to repeat 
the shade, you would need to change each shade separately to apply a new profile. However, if 
you had drawn the shape as a loadable profile family and loaded it into the family, you would 
only need to change the profile family once and reload it. All instances of the profile will update 
automatically when reloaded. 

putting the Sweep tool to Work

Here are some real-life scenarios in which the Sweep tool is very handy. We’ll let the pictures do 
most of the talking.

First consider the modern shower fixture in the bathroom shown here: 

This design was created as a simple sweep on a circular path:
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The architectural example shown next demonstrates another use of sweeps: to create a highly 
specific wall shape. The retaining wall was created as an in-place wall using the Create function 
and the Sweep method.
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trajectory Segmentation

The Trajectory Segmentation parameter (see Figure 7.27) provides a way to segment smooth arcs 
into linear segments. This can be useful when you’re rationalizing a form into planar, construct-
ible elements. 

Figure 7.27 
Sweeps can be 
segmented using 
the Trajectory  
Segmentation 
parameter.
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When the option is checked, it makes the parameter Maximum Segment Angle active. The 
value you set defines the maximum value of the angle between two segments of the arc. The 
smaller that value, the higher the number of linear segments that will replace the arc. Figure 7.28 
shows the effects of this parameter.

Figure 7.28 
An arc path can be 
segmented using 
the Maximum 
Segment Angle 
parameter.

Trajectory before segmentation

Maximum Segment Angle = 30°

Maximum Segment Angle = 60°

Maximum Segment Angle = 90°
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Blends
A blend creates a form by connecting two different 2D shapes on two different planes along a 
linear path (see Figure 7.29). The distance between the two shapes—the base and top—is what 
defines the depth of the blend. The two shapes for the top and base of the blend do not need to 
be the same shape or have the same number of segments. Revit can even blend arcs into linear 
segments.

When the top and base shapes are the same, the resulting form will look exactly like an 
extrusion or sweep along a single, linear segment. You can think of a blend as an extrusion with 
two sketches—one for the base, and one for the top.

The instance properties of a blend resemble those of an extrusion. You can set the blend 
depth as well as the offset from the work planes on which the shapes are drawn:

First End    This defines the offset of the base shape relative to its work plane. This value can 
be negative or positive. The default value is set to 0.

Second End    This defines the offset of the top shape relative to the work plane on which the 
blend is drawn. This value can be positive or negative. The default is set to 1́ -0˝ (250mm).

The total depth of the blend is the resulting value between the first end and the second end.
When a blended element is selected, look to the Modify Blend tab, where you’ll be able to 

reedit the base and top, change the work plane, and re-host the blend:

Figure 7.29 
A blend is created 
from two sketches 
that blend together 
along a linear path.
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As you can see, these are the same as the options you had for extrusions, with the addition of 
two other features that take you to the sketch of the base or top of the blend: 

Edit Blend Base    This allows you to enter boundary edit mode, where you can modify the 
top boundary.

Edit Blend Top    This allows you to enter boundary edit mode, where you can modify the 
base boundary. 

Whenever you select one of those two options, the Ribbon will update as shown in 
Figure 7.30. Click Finish Blend to complete the blend.

When creating blends, the boundaries are drawn on a single work plane; this means that the 
two shapes will always be parallel to one another. 

The Vertex Connect tool is specific to blends, and it shows up in the Ribbon when you’re edit-
ing the blend boundary lines. This tool allows you to set the connection between the vertices 
that the two shapes have. Manipulating the vertices alters results in the final blend.

When you click the Edit Vertices tool, you see graphic controls indicating existing connec-
tions between the vertices of the blend shapes.

There are two different things you can do here:

Twisting    After selecting the Edit Vertices tool, a new contextual tab will appear with the 
options Twist Right, Twist Left, and Reset, and the ability to edit the controls at either the 
base or top.

These options control the number of twists between the two shapes. In Figure 7.31, image A 
shows a basic blend between two 45°-oriented square shapes. Image B shows one additional 
twist, and image C shows yet another twist.

Editing Vertices    This is another way to affect the blend in order to arrive at alternative 
shapes. By clicking one of the open blue circle controls that appear when you first select the 
Edit Vertices tool, you can change the direction of the vertices by clicking on the control. 
Once you change the connection point, the circle will be filled in solid blue, and a line will be 
drawn showing a preview of the connection from one vertex to another. Revit connects the 
vertices from the base shape to the top shape in an automated way with each click. But each 
of the vertices has an option to be connected to the top vertex that lies to the right of it, or to 
the left, or both. The example shown in Figure 7.32 demonstrates how the same blend with 
the same base, top, and depth all look different depending on the vertex connections.

Figure 7.30 
The contextual  
ribbon for  
editing a 
blend form (left 
and right sides 
shown).
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troubleShooting blenDS

When the base shape of a blend has the same number of vertices as the top shape, the results are 
pretty much predictable. But often the number is not the same and you may not get the results 
you expect or desire. Here’s a tip to consider when working with more complex blends: if one of 
the shapes is a circle, you might want to break it up into segments to get additional vertex points 
so that you arrive at a shape you need, as shown in Figures 7.33 and 7.34.

 Figure 7.31 
Various looks for 
the same element 
depending on the 
number of vertex 
connections or 
twists: the form 
shown can be 
either a tower 
shape or a  
table leg.

A B C

Figure 7.32 
Changing ver-
tex connections 
results in different 
blend forms. A B
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Figure 7.33 
A standard blend 
you will often 
see, with the base 
shape a square and 
the top shape a 
circle.

Figure 7.34 
The same shapes 
with the circle split 
into four segments 
to add three more 
vertices. In exam-
ple A, the vertex 
points are orthogo-
nal; in B, they are 
rotated 45 degrees. 
Note the difference 
in the results.

A B
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Creating a Lamp with Blends and Sweeps

A real-world application of blends and sweeps can be seen in the Revit lamp family illustrated here:

The shade is constructed using a blend between a segmented circle for the top (A) and a more com-
plex series of arcs for the base (B). 

A B
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The top boundary has been divided into many segments to match the number of vertices of the 
base. This file can be found in the Chapter 7 folder on the book’s companion web page if you want 
to explore it some more on your own (PS Lamp.rfa). 

The legs of this lamp were made using sweeps. A void extrusion was used to cut the bottom of the 
legs horizontally so that the lamp sits flat on the floor.
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exampleS of blenDS in practice

The shapes in Figure 7.35 are inspired by the lamps of sculptor and designer Isamu Noguchi, 
but as you can imagine, they could just as easily represent a lamp, a column, or the shape of an 
entire building. They are constructed as simple combinations of connected blends.

The blend boundaries cannot contain more than one loop of closed lines. If your intention 
is to create something like the lampshade shown in Figure 7.36, you need to add a void, or use 
a revolve. If you try to make such a shape using multiple loops, Revit will give you a warning 
message telling you that “more than one loop is not allowed.”

To obtain the result needed, you need to first create a solid blend and then a second one, done 
with a void that has a smaller radius, as shown in Figure 7.37.

Swept Blends
The swept blend is a combination of a single-segment sweep with a blend. The principles for 
creating a swept blend follow from the sweep and blend workflow. With a blend, you have no 
control over the path: it is always perpendicular to the sketch plane. With the swept blend, you 
can create arc paths for the profiles to blend along. Examples of this include a roof or roof seg-
ment with a shape that changes over a nonstraight path, an elbow pipe that changes diameter 
between the two ends, funky furniture shapes or parts, and walls beneath curved stairs. Note 

Figure 7.35 
A series of  
blends used to  
create a more  
complex form.

Figure 7.36 
This blend sketch with mul-
tiple loops is not allowed and 
would generate a warning 
message.

Figure 7.37 
A lampshade can 
be made by creat-
ing a void blend 
that is smaller than 
the solid blend.
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that a swept blend can only contain a single line segment for the path. If you draw more than a 
single segment, Revit will issue this warning: “More than one curve not allowed.”

Consider Your Options

Before making a digital model of your components, you need to analyze the basic geometric shapes 
that are used to create such a form. Is your object best modeled as an extrusion? A blend? A sweep? 
A blend with a void cut in it? Think carefully how the object is made, how it is assembled, and the 
tools that Revit provides to plan your modeling strategy.

Combining Solids and Voids
Many complex shapes go beyond the basic form-making techniques we just explored. Designs 
often require a combination of forms that are both additive and subtractive. To accommodate 
richer modeling, Revit approaches this problem by allowing any form to be solid or void. Solids 
are positive, physical elements, and voids are invisible, cutting elements that remove form from 
solids.

All the forms we covered (extrusion, revolve, sweep, blend, swept blend) can be made as 
either a solid or a void, as seen in the Create tab of the Family Editor.

Notes on Solids and Voids

Keep the following in mind:

Voids that don’t cut a solid and solids that are not joined may be switched from one to the other •u	

(from solid to void and vice versa) from the properties dialog box. Once they are joined or cut, 
they cannot be toggled in this way.

Once a void is cut, it is no longer visible unless selected. However, because the void is no longer •u	

visible once it’s cut, it may be helpful to model voids and solids as solids. Then switch solids to 
voids and use the cut geometry command as appropriate.

All solids can be cut by the same void, but they do not have to be if you prefer not to. •u	
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Examples Showing Use of Voids
Voids can be used in many ways to arrive at some surprising geometric forms. Think of a void 
as a way to carve away from a solid chunk of clay. You can truly sculpt with this tool!

VaultS

In Figure 7.38, complex vaults have been created out of a solid pentagonal extrusion and half-
circle void extrusions are cutting through it.

Join Geometry tool Solves Geometry Connections

You will need to use the Join Geometry tool to have the void cut the solid.

Vertical ShapeS

The basic shape of the table legs shown in Figure 7.39 is a simple blend. A plow shape is used 
at the base, and a triangular shape is defined for the top (A). Then a simple curved shaped void 
extrusion is used to carve out the blend (B). The result is an interesting shape that is far more 
complex than what you’d expect to be able to do with the four basic modeling forms (C-D).

Figure 7.38 
Vaulted space created out 
of a combination of solid 
and void extrusions.
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Figure 7.39 
A blend with a void 
extrusion results 
in some very inter-
esting forms!

A CB D
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complex roofS

A shape like the one shown in Figure 7.40 could be created using two revolved shapes and then 
cut off using a void square around the edges.

Where Can You Go from here?

Mastering the modeling techniques in Revit and understanding the power of parametric relation-
ships will open doors to some powerful modeling skills. In order to construct custom components, 
you’ll need to become familiar with the toolset, and once you do, you’ll be able to model nearly 
anything you can imagine. We’ve walked through the basic form-making tools for generating com-
ponents. In the next chapter, “Concept Massing Study,” we’ll get into the new form-making tools 
that were added to Revit 2010 for making building mass forms. You’ll see that making complex 
building forms in Revit is no longer science fiction, but right at your fingertips!
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Figure 7.40 
Use of a simple 
void to cut out 
geometry from a 
revolved shape.
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The Bottom Line

Understand the principles of modeling in Revit.    Understanding how to use Revit’s mod-
eling tools is an important part of project documentation. Knowing which modeling tools to 
use when will aid not only in project visualization but also in documentation, scheduling, 
and rendering.

Master It    There are many unique design elements in any project. Know when to use the 
appropriate modeling tools at the right times. What tool in Revit might you use to model 
the following elements?

Reception counter•u	

Entry canopy•u	

A lampshade•u	

Custom furnishings•u	

Model with five basic forms.    These tools are at the root of practically all form modeling.

Master It    Having learned the basics of Revit’s form-making tools, how would you build 
this faucet designed by Philippe Starck?

Master It    In some cases, a form uses multiple sketch lines to generate its form. What 
form-making tools in Revit use more than one set of 2D sketches to generate the form?

Combine solids and voids to create complex and intriguing forms.    Revit’s five basic forms 
can be expressed as either positive space (solids) or negative space (voids).

Master It    To make more complex forms, both solids and voids can be used. Think of a 
case where the using voids as a subtractive element makes sense.
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Chapter 8

Concept Massing Studies

In this chapter you’ll explore the early stages of design and how to generate initial massing studies 
used to iterate on design concepts. We introduce you to the tools in Revit that support early concep-
tual design workflows where the form is not only explored but also rationalized. Revit allows you 
to maintain continuity in design data as you move from the massing study into real building elements, 
making it possible to easily transform massing studies into buildings that can be documented and 
eventually built. We discuss various approaches for creating massing studies and the underlying 
principles of creating parametric mass elements using the new conceptual design environment. 
We will also introduce you to a method for rationalizing massing surfaces.

In this chapter, you’ll learn to: 

Understand massing workflows •u	

Start a conceptual massing study•u	

Understand form making and rationalization•u	

Understanding Massing Workflows
There are many ways to start a new design. It often starts as a series of early sketches that con-
vey form and function related to the project brief. These first ideas often encapsulate the essence 
of the design and, unless some unforeseen changes are demanded in the design, are usually eas-
ily recognizable in the final building. Many architects are known for the remarkable similarity 
between the first sketches of their ideas and the final outcome of the built buildings, as can be 
seen in drawings by architects such as Frank Gehry, Jorn Utzon, Daniel Libeskind, Frank Lloyd 
Wright, and countless others. Figure 8.1 shows a hand sketch using very gestural lines, tones, 
and hatches. The ability to sketch freely and with gestural expression is a fundamental aspect of 
design iteration and has been part of the architectural profession for centuries.

Figure 8.1 
An inspiring early 
sketch.
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Architects have long realized that the only way to make investors buy into their early ideas and 
designs is to make those early designs understandable to them. Many investors have difficulty 
reading technical drawings, so architects use creative methods to communicate the design, 
the space, and the experience of that space from the early stages of the design on. Perspective 
drawings, photo collages, and 3D physical models made of wood, Styrofoam, cardboard, balsa, 
Plexiglas, and metals are all used to help the client, and sometimes the public, understand the 
implications of a given design. Increasingly, with the pervasive use of digital tools, 3D printed 
models and laser cut models are being used.

In more sophisticated design studios, physical models are constructed so that the design can be 
evaluated by deconstructing the model into parts representing different levels or functional parts 
of the building. This allows people to examine individual stages of construction and integrated 
systems. Models can range in fidelity from very rough massing studies to highly photorealistic 
models, as Figure 8.2 demonstrates.

Three-dimensional physical models offer some obvious advantages for conveying design 
intent:

You get an immediate feel for proportion, scale, and composition•u	

You get a sense of spatial volume•u	

Light and shadow can be easily simulated by holding a real lamp near the model and •u	

observing the shadows

If you model the surrounding site, you can easily understand how your design relates to its •u	

context

Three-dimensional physical models also have some potential disadvantages:

They take a lot of time and patience to create•u	

They require space for creation as well as storage•u	

Figure 8.2 
Models can range 
from very rough 
(A and B) to highly 
refined representa-
tions (C and D).

A B

C D
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They are created in one scale only•u	

They can’t handle design options easily and thereby require building multiple models to •u	

convey each design option

They require manual work—both in the physical modeling and in performing calculations •u	

of area and space

They can be costly in terms of skilled personnel, materials, and equipment•u	

As clients become more demanding, they aren’t satisfied with just understanding how the 
future building will look but also want to know how the building will perform in terms of 
lifecycle costs. With sustainability now an integral part of the design process, they also need to 
understand how the building will function over time from an energy point of view. BIM makes 
this process much more viable, as you are building much more than a mere physical model. The 
forms you make in Revit can be used to do early sun studies, area analysis, and energy analysis. 
Multiple iterations can be generated for comparison. Making a final decision is not always easy, 
but the ability to compare and contrast multiple proposed solutions in order to arrive at an opti-
mized design solution makes it easier for you and your clients.

To accommodate all these requirements, architects and owners need to analyze the building 
and experience it in the early stages of design before it’s ever built. Traditional hand-built mod-
els don’t provide this kind of analytical flexibility. This is where using digital models backed up 
by real data come into play. See Figure 8.3.

Massing Study Workflows
Regardless of how a massing study is done (digitally or in a physical medium), there has always 
been a break in the workflow between the conceptual design phase and the next phase of more 
detailed analysis of how the building will behave and be constructed. In the case of a built 

Figure 8.3 
Early massing 
studies.
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physical massing model, once you’ve built one, moving that model forward into more detailed 
design requires that you create a digital project from scratch, usually in a tool such as AutoCAD. 
The 3D model is not inherently reusable downstream. 

Even when you make a study using digital tools such as Rhinoceros, SketchUp, Form-Z, 
Maya, or 3ds Max, in order to document those studies you still need to start from scratch 
because these tools are mainly modelers—not architectural documentation tools—and the 
data created with these tools is not reusable in any intelligent manner. In these cases, the docu-
mentation phase traditionally occurs in the form of 2D drawings produced with tools such as 
AutoCAD. 

With the advent of building information modeling, this is all changing, as you can now carry 
a conceptual model through to construction documentation in one environment. Indeed, an 
important aspect of using BIM is the ability to move and reuse previously created data through-
out the design process, from start to finish—without having to start over. Revit provides a set 
of tools for converting an abstract mass form into a full-fledged building information model. In 
Revit, a specific set of tools keeps the design process integrated. For early conceptual studies, 
you can create models natively within Revit using the conceptual design tools, or by importing 
geometric massing studies created in other applications. Regardless of how you create the con-
cept massing studies (either within or outside of Revit), they can later be used to generate build-
ing elements such as walls, floors, and roofs. 

Common Uses for the Massing tools

Here are some common scenarios where using Revit massing tools makes sense.

Site Studies: Using Massing to Quickly Build the Context environment around 
the Building

You can use Revit’s massing tools to quickly model the surrounding context of your building to get a 
feel for how it fits the site. This is a standard practice used to demonstrate how your design relates 
to its environment. Once you have modeled the environment around your building, you can gener-
ate walkthrough cameras that move around your building so you can experience it from different 
points of view. You can also make solar studies to better understand how your building affects the 
environment and how the environment affects your design.
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Massing Studies for testing Different Design Options

You can do a quick conceptual massing study to work out a functional design arrangement, make 
more options, and look for an optimal solution. For each design, separate masses can be made and 
given color to indicate their function. This allows you to see spatial relationships in simplified geo-
metric forms but also get precise area and volume values for each mass option you explore.
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Feasibility Studies and program Verification

You can take the massing study a step further and make feasibility studies to explore how to fit the 
client’s program on the site and calculate the floor area ratio (FAR), mass floor area, and volume. 
With mode information added to the model, you can get better estimates about building cost, 
energy analysis, and aesthetics.
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Three-dimensional digital massing studies allow architects to use advanced technologies and make 
physical prototypes for demonstration or testing purposes using the 3D printing services that are 
becoming more affordable. For many architects as well as owners, a physical model is still something 
they like to have in order to study the design.

Rapid prototyping is the automatic construction of physical objects using solid freeform fabrication. 
The first techniques for rapid prototyping became available in the 1980s and were used to produce 
models and prototype parts. Thanks to advances in technology and the increasing affordability of 3D 
printing, professionals in many fields now rely on rapid prototyping—architects to create models, 
industrial designers to make first-draft prototypes, and even artists to sculpt complex shapes for 
fine arts. The process of rapid prototyping takes virtual designs from a digital model, transforms 
them into virtual cross sections, and creates each cross section in physical space one after the next 
until the model is finished. This is often done by layering liquid and powdered material for each 
section and using glue or a laser; the material is fused together as shown here. 
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The most common file format for sending this data is .stl. The .stl export is not natively built in 
Revit—you can find a prototype for an .stl exporter for Revit on the Autodesk Labs site, http://
labs.autodesk.com/utilities/revit_stl/.

Figure 8.4 shows a rapid prototype model of an unbuilt Louis Kahn building.

Figure 8.4 
Early massing 
studies.
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Revit’s Massing Tools
There are two ways to work with conceptual modeling tools in Revit—as in-place masses built 
directly in the project or as loadable families built using the conceptual mass family template. 
Each method offers slightly different behaviors, which can impact workflow. For example, build-
ing out a site context model, which is generally static, might make most sense to do in the proj-
ect environment, whereas building multiple massing studies that can be swapped in and out of 
the site model is better handled with family instances. Anytime you have a massing shape that 
repeats and has some parametric variations in size, think of using a family.

In order to create, study, analyze, and later convert a massing form into a building, you need 
to understand the available tools first; then we’ll walk through a real exercise in which you can 
experience the entire workflow. If you’re in a project already, the massing features can be found 
on the Massing & Site tab (Figure 8.5). You’ll use this tab to create in-place masses, place masses, 
and model by face (apply Revit building objects to massing surfaces). To start a new conceptual 
mass family, use the Application Menu  New  Conceptual Mass (Figure 8.6). 

The tools for creating masses in Revit are a bit different than those we discussed in Chapters 
6 and 7, “Modeling Principles in Revit I and II.” Rather than using explicit sketch-based tools 
(Solid Extrusion, Solid Blend, Solid Revolve, Solid Sweep, and Solid Swept Blend), you start with 
lines and then “create form” by selecting those lines. You can still make extrusions, sweeps, 
revolves, and blends, and you can also create lofts and surfaces now—but the creation method 
is a bit different in 2010 for making all of these forms. Once you have made a form, you can then 
freely manipulate it using interactive controls, temporary dimensions, and parametric dimen-
sions. Click on any surface, edge, or vertex of a form, and a control will appear. Use this control 
to adjust the form. Figure 8.7 shows an edge being dragged with the control. 

Once you’ve made a form, you can rationalize it by either dividing the surface and applying 
panels to the surface or applying walls, floors, and roofs to surfaces using the Model by Face 
tools and Mass Floors (Figure 8.8). Dividing a surface always takes place while editing the fam-
ily, and modeling by face takes place when in the project environment. 

Figure 8.5 
The Massing & Site 
tab provides tools 
needed to create a 
massing study in a 
project.

Figure 8.6 
You can start a new 
conceptual mass 
family from the 
Application Menu.
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Figure 8.7 
Use form control 
arrows to freely 
manipulate  
massing.

Figure 8.8 
Using the Model 
by Face tools and 
Mass Floors, you 
can move from 
concept mass to 
building elements 
quickly.
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Mass Creation and Visibility Tools
There are two ways to create a mass element in the project environment—by making it directly 
in the project or by loading it into your project. Let’s look at the tools that will help you do this.

In-Place Mass tool  This method allows you to create a new mass element in the project. 
When you start this tool, a new tab, In-Place Mass, appears on the Ribbon. (We’ll discuss this 
later in this chapter.)

Place Mass tool  This method allows you to place a mass family or load a mass family from your 
library. To make a mass family, use the method explained earlier, by going to the Application 
Menu  New  Conceptual Mass.

Show Mass tool  In order to support more fluid workflows, the Massing category has a 
special visibility feature built in that allows all massing to be either visible or not, throughout 
the entire project. This is a global toggle (similar to how Thin Lines mode works) that will keep 
you from having to manage mass visibility independently in every view. The toggle is located 
on the Massing & Site tab. We’ll explain this now, as you’ll get a warning message as soon as 
you start a new massing.

Visibility of Mass Elements
When you try to place or create a mass for the first time, you’ll most likely get the following 
message, which conveys information about the visibility of mass elements:

This message can be disconcerting at first unless you understand what is going on. Visibility 
of mass elements can be controlled either via the Show Mass tool or through the Visibility/
Graphic Overrides dialog box. The Show Mass control is a global on/off switch for massing that 
affects all views temporarily. 

When you click the toggle button, all masses, in all views, will become visible. This is great 
for early massing studies, allowing you to move from view to view and see your mass without 
having to turn the category on or off in each view separately. When this mode is enabled, it does 
not affect the Visibility/Graphic Overrides state of your views. This massing toggle is a tempo-
rary view control and doesn’t affect printed output.

To see the mass elements in specific views only, you should use the Visibility/Graphic Overrides 
settings for view control. Even when the Show Mass button is turned off, if you activate the Mass 
setting in the Visibility/Graphic Overrides dialog box, it will be visible in that view.

Keep in mind that to print and/or export massing, you need to turn on the Massing category 
using the Visibility/Graphic Overrides dialog box.

As you develop your design further by moving from the conceptual phase into the early 
design development phase, you will start creating the real building components (walls, floors, 
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and roofs) by adding elements to the mass model. This will slowly but surely obscure the vis-
ibility of the massing form. A great way to maintain a view where only massing is visible is to 
create a 3D view where all categories are turned off except the Massing category. To do this, use the 
Visibility/Graphic Overrides dialog box. Be sure to duplicate a view when doing this, and name 
the view Massing or something appropriate. Figure 8.9 shows two views: one with only the 
Massing category visible and the other with all categories visible. This is handy when you want 
to make adjustments to the basic shapes that define the geometry (masses) without being dis-
tracted by the presence of the building elements. 

Starting a Conceptual Massing Study
You create massing forms using tools in the conceptual modeling environment. With these 
tools, you can quickly generate site plans and initial building shapes for early, formal design 
iterations. You can also divide surfaces and apply repeating components on the divided surface 
to explore more articulated designs.

Creating a Mass—Basics
When you select the Model In-Place Mass tool from the Massing & Site tab, you’re first prompted 
to name the mass you’re about to create. Once you provide a name, the interface transforms and 
you will find yourself in a mass-creation mode, with a new set of tools (Figure 8.10). Using these 
tools, you proceed to create the massing form using combinations of solid and void forms. 

The tools on this tab are specific to form making and surface rationalization and will be 
available until you click the Finish Mass button. You’ll also notice that the other tabs are still 
available while modeling an in-place mass—click the tabs in the Ribbon to see what tools 
are enabled. Various other tools will be enabled or disabled depending on their relevance to 
massing tasks. For example, the Edit tools will still be accessible under the Modify tab, and 
Dimension will be available in the Annotate tab. Other tools, such as walls, floors, and roofs, 
will not be enabled. If you have modeled other building elements, these will not be editable 
while using in-place massing mode.

Figure 8.9 
The same model 
with two visibility 
states (views) show-
ing only mass, and 
the full model.

View with only the massing category visible View with all categories visible

Figure 8.10 
The Model In-Place 
Mass tab.
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Creating Form

The tool for creating a massing form is the Create Form command. This tool requires that you 
first select lines, or edges of existing geometry, to generate a form. If you click the Create Form 
command, you’ll get a warning telling you that you need to select model lines or references 
(Figure 8.11) in order to generate a form. This warning can seen a bit heavy-handed, but it is 
basically giving you a hint about how to use the tool. This means you first need to draw lines, 
and then create form from those lines.

Use the tools in the Draw panel to create your initial lines (Figure 8.12). These should all 
be familiar tools—they allow you to draw lines, rectangles, polygons, circles, arc, splines, and 
ellipses. Note that there are two types of lines you can make: lines and references. Two differ-
ences between the two should be noted: first, lines will be “consumed” into a form when used 
to make a form, while reference lines will not. Second, reference lines can be used to host other 
elements, whereas lines cannot. For example, a family can be loaded into a conceptual mass and 
placed on a reference line, and if that reference line rotates or moves, the family will go along for 
the ride. 

To get acquainted with this environment, start by drawing a simple rectangle, and click on 
the Create Form button in the ribbon to make a box. Note that if you de-select the lines before 
making the box, you simply re-select the lines and then click the Create Form button. You’ll 
notice that selection in this environment will prefer chains of lines over individual lines when 
lines are connected. In other words, you will not need to press Tab to select a chain. When lines 
are selected, the contextual tab changes to Modify Lines. Clicking the Create Form button will 
then create a solid box, as shown in Figure 8.13. 

Figure 8.11 
This warning  
message appears 
if you click Create 
Form without first 
selecting an input.

Figure 8.12 
The Draw panel 
of line-creation 
methods.

Figure 8.13 
Lines are used to 
create a form using 
the Create Form 
command.
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You can make as many forms as you see fit for any given mass element. Everything you add 
in the mass editing session will create a single mass instance when you finish. Your decision 
to make each shape as a separate mass element will depend on what you need it to represent 
and how you intend to interact with it. For example, one mass element could have five boxes 
representing five buildings. Or, you could make five separate mass elements for each building. 
Do you want to move each building independently? Or, will you likely want to move all the 
buildings together as a single element? Let these kinds of questions guide your decision-making 
process.

When you’ve finished modeling, click the Finish Mass button in the Ribbon. After clicking 
Finish Mass, everything you modeled becomes one mass element. To re-edit the mass, select it 
and click the Edit In-Place button on the contextual tab. 

Direct Manipulation of Mass
Once you’ve made a form some controls will show up when a mass is selected. These controls 
will allow for some direct editing by dragging the triangular control grips on the form. You will 
get different controls depending on whether you are editing the form from the project context 
or the conceptual design mode. When you’re in the project, you’ll see blue triangles appear on 
masses when selected. These controls do not provide temporary dimensions, and the dragging 
will result in hard-to-predict numeric values (Figure 8.14). Rather than deal with these grips, it is 
easier to simply select the form and edit it in place. You’ll get better interaction and more precise 
control with the arrow controls (Figure 8.15).

Figure 8.14 
When a mass is 
selected, grips 
appear on the 
form. You can drag 
these and change 
the form.

Figure 8.15 
For more precise 
editing and less 
visual noise, edit 
the form in place 
by selecting the 
surface, edge, or 
vertex you want  
to edit.
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When you have a surface, edge, or vertex selected, you’ll be able to use this control. Press the 
spacebar to change the orientation of the control to align with local geometry. This is useful if 
the geometry you are working on is not aligned to the global XYZ coordinates. Note that if the 
local geometry is aligned with the global XYZ axis, the control will not change appearance with 
the spacebar.

Boolean Operations
The conceptual tools support essential Boolean operations—such as cutting and joining of inter-
secting forms. It is important to note that massing forms can be solids or surfaces—something 
new to the 2010 release (Figure 8.16); however, surfaces cannot be used to cut into solids. We’ll 
explore the range for form topologies later in the chapter. 

Any form can be either solid or void and can be changed from one state into another state 
at any time with the Create Form tool (Figure 8.17). Try making two boxes—one void and one 
solid—using the options in the Create Form pull-down. If the two forms intersect, the void will 
cut away geometry from the solid.

Figure 8.16 
Surfaces, such as 
this loft, can be 
created in the con-
ceptual massing 
environment; how-
ever, they cannot 
be joined to solids.

Figure 8.17 
You can make a 
solid or void form 
with the Create 
Form tool.

56491c08.indd   240 6/2/09   9:58:20 PM



starting a ConCeptual Massing study | 241

Voids, as the name suggests, create negative volumes that carve away from solid forms, as 
shown in Figure 8.18. A void will autocut a solid when they intersect, and it can be made to not 
cut using the Don’t Cut tool in the Modify tab.

Multiple forms can be joined to one another to create connected forms. The Join and Unjoin 
Geometry tools are available on the Modify tab.

Join Geometry
This tool joins solids to form one connected element. (Note that voids can’t be joined together.) It 
merges the shapes (masses) into one, both graphically and as data (Figure 8.19). To use this tool, 
select the tool, and then select solids you want to join. Multiple solids can be joined together.

Figure 8.18 
A void form inter-
secting a solid 
form creates a dif-
ferent form.

Figure 8.19 
Joining two masses 
together creates a 
single, seamless 
element.
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If you edit the position of one of the joined forms (by pressing the Tab key twice when over a 
joined geometry), the intersection (called the Boolean) instantly updates. If you move one of the 
joined forms outside the boundary of the other joined form so they no longer intersect, they will 
still maintain their Boolean relationship. You can see this by pressing the Tab key when your 
hover over an apparently disconnected form. Both forms will become selected (Figure 8.20). To 
remove the Boolean, use the Unjoin Geometry command in the Modify tab. 

Creating a New Mass Family
You can create your own mass families using the new Conceptual Massing Family Editor and 
load them later in any project. To create a mass family, you use a special family template called 
Mass.rft. Later in this chapter, we’ll guide you through the creation of various mass forms.

Creating parametric Forms

At any point when making a massing form, you can add dimensions and make them parametric 
variables. This allows you to control the form precisely via the Element Properties dialog box for 
obvious values such as height, length, width, and radius.

In the next section, “Understanding Form Making and Rationalization,” we’ll add param-
eters as we build forms. A feature unique to the new conceptual design environments is called 

Figure 8.20 
Joined masses—
the first selection 
in tab order—show 
that apparently 
disconnected  
elements are still 
one connected 
form element.
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“loose labeled dimensions.” This sounds complicated, but it just means that the interaction with 
parametric dimensions has been loosened to allow more bidirectional behavior. Unlike in the 
standard Family Editor where a labeled dimension will prevent you from directly manipulating 
a form, in this environment, you are free to drag a form, and the labeled dimensions update on 
the fly. You will not be confronted with “Constraints Are Not Satisfied” warnings by dragging 
something with a labeled dimension, as you might see in the standard Family Editor.

Understanding Form Making and Rationalization
We’ve talked about how to get started on a massing form and some likely workflows you’ll 
encounter. Now we’ll dig into how to actually create forms, and then we’ll rationalize form 
using a surface division tool. In the following exercise we’ll guide you through the creation of 
several types of forms that you can make in the conceptual modeling environment, including 
extrusions, lofts, sweeps, and revolves. (In the next chapter, “From Conceptual Mass to a Real 
Building,” we’ll explore creation of special panel components that can be hosted on a surface.) 
The result will be the mass shapes similar to those shown in Figure 8.21.

Figure 8.21 
Basic forms that 
can be generated 
include lofted 
surfaces, sweeps, 
revolves, and 
extrusions.
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Making a Parametric Extrusion
First, when you’re creating a new mass, it’s essential to select the correct family template. In this 
case, you want to be sure to select Mass.rft or Metric Mass.rft—the default template if you 
use New  Conceptual Mass. Follow these steps:

 1. Choose Application Menu  New  Conceptual Mass. In the New dialog box, select the 
template Mass.rft or Metric Mass.rft and click the Open button.

The Family Editor opens with a 3D view. You’ll see a base level and two reference planes in 
the view. The level sets a starting elevation plane, and the intersection of the reference planes 
define the origin of the family. 

 2. Using the Rectangle tool from the Draw panel, draw a rectangle on Level 1. This will be 
the default work plane, and it will highlight as you draw the rectangle.

 3. Click the Create Form tool. A box will appear, with a temporary dimension to the top of 
the box. Type in 100’ to set the height.
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 4. To make the height parametric, click the Make this Temporary Dimension Permanent 
icon next to the vertical temporary dimension. This will create a dimension.

 5. Using the Label dropdown list in the Options bar, add a parameter to the dimension—
making it parametric.

 6. In the Parameter Properties dialog box that opens, name the parameter Height, group it 
under Dimensions, make it an Instance parameter, and click OK.

 7. Now, reselect the top face of the box and drag it up and down. Note how the parameter 
updates with the direct edit. You’ll notice that dragging a face results in overly sensitive 
precise dimension values—numbers that round to nearest 256th of an inch, for example. 
To overcome this, click on the Types button in the Family Properties panel to open the 
Family Types dialog box, and set the value there.

 

56491c08.indd   245 6/2/09   9:58:21 PM



246 | Chapter 8 ConCept Massing studies

 8. Set Height to 120’ and click OK. As you can see, the height can be whatever you want in 
the family environment, but without the parametric dimension, you’ll have no way to 
change the height parametrically once the box is loaded into a project.

 9. Open a new project using the Application Menu  New  Project. This will open a blank 
project. Press Ctrl+Tab to go back to the box you were making.

 10. Click the Load into Project button in the Ribbon to load the box into the project. You will 
be put into component placement mode, in the default plan view. Note that your cursor 
will show as a banned symbol, indicating that you cannot place the component. This is 
because the Placement Editor is looking for a face to place your massing box onto. Not a 
problem—change the placement method to Place on Work Plane in the Placement panel 
on the Place Mass tab—this will allow you to place the mass family on Level 1 (or any 
level in your project using the Placement Plane drop-down list in the Options bar).

 11. Click to place the mass family, and then hit the Esc key twice to cancel the placement mode.

 12. Using the 3D View tool in the Quick Access toolbar, open the default 3D view to see the 
placed mass. Change the view display to Shaded with Edges, and you’ll see a semitrans-
parent box.
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 13. Select the mass and open the Instance Properties dialog box. Change the Height value to 
200’ and click OK—you’ll see the form update to the new height. Your mass box is now 
working parametrically.

making a ParametriC material

You’ll notice the material appears slightly transparent. This is because the material in the project 
has the same name as in the Conceptual Mass template, and materials in the project always trump 
those created in the Family Editor that have the same name. The reason for the semitransparent 
material is so you can visualize mass floors when they are added to a massing form, as shown in 
Figure 8.22.

To make the material parametric, follow these steps:

 1. Go back to the box massing family. 

 2. Select any part of the form and open the Instance Properties dialog box. Next to the 
Material parameter, click the small button at the far right. In the Associate Family 
Parameter dialog box that opens, click the button at the bottom, Add Parameter.
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 3. Create a new parameter named Box Material, group it under Materials and Finishes, and 
make it an Instance parameter.

 

Figure 8.22 
The transparent 
material allows 
you to visualize 
mass floors.
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 4. Load the family back into your project. You’ll get a warning that the family already 
exists. Choose Overwrite the Existing Version.

 

 5. Select the massing element, and open its Instance properties—you should see the new 
material parameter, Box Material. With this parameter you can now assign any material 
you want to the mass instance. In this example, we gave the mass a Chipboard material.

 

Now that you have made a parametric box with height and material parameters, let’s see 
what other forms you can quickly generate with Revit’s conceptual modeling tools.

Making a Revolve
A revolve form (Figure 8.23) takes curves and revolves them around an axis. To make a revolve, 
you simply draw a line for your axis, draw lines to revolve around that axis, select the lines, and 
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use the Create Form command. Revolves can be made from open or closed profiles. Let’s try 
making one now.

 1. Create a new conceptual mass family.

 2. In the view draw a single straight-line segment—this will become the axis of rotation.

 3. Draw an arc offset from the line segment—this is what will revolve around the axis.

 4. Select the arc, and then make the radius dimension permanent using the Make 
Dimension Permanent toggle on the temporary dimension.

 5. Add a parameter to the dimension named Radius. 

 6. From the Create tab, choose Aligned Dimension and dimension to the ends of the arc. 
Make this dimension parametric by adding a parameter to it named Length. 

Figure 8.23 
A revolve form.
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 7. Select the arc and line, and then click the Create Form button. You will see a preview to 
two possible forms appear below the form: a revolve and a surface. Hover the cursor over 
the revolve preview and click on it—this will create a revolved form.

 8. Select the top face of the form, and go to the Instance Parameters dialog box. Change End 
Angle to 180, and click OK. This will give you a half-revolve form.
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 9. Select any edge of the form and experiment with dragging the control arrows. You’ll 
notice that the parameters update as you manipulate the form. At any point, you can 
open the Types dialog box on the Ribbon and enter exact numbers.

Making a Loft
A lofted form (Figure 8.24) is a surface or solid that blends between two or more open or closed 
curves. For example, if you draw a series of splines on different levels, you can loft between 
the lines and create a surface. Likewise, you can loft between closed loops and even loft from a 
closed loop to a single line segment.

Figure 8.24 
A lofted  
surface form.
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Let’s make a lofted form now:

 1. Open a new conceptual mass template.

 2. Draw an ellipse on Level 1.

 3. Select Level 1 and drag it up with the Ctrl key pressed—this will create a Level-2 copy. 
Set the height of the level to be 80’ using the temporary dimensions.
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 4. Select Level 2 and Ctrl+drag it to make a third level—set the height to be 80’ above Level 2.

 5. Select the ellipse on Level 1 and press Ctrl+C to copy it to the clipboard.

 6. Using the Paste Aligned option from the Clipboard panel, choose Select Levels, and 
choose Level 2 and Level 3 by holding down the Ctrl key when selecting the levels.
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 7. Select the top ellipse and rotate it 90 degrees.

 8. Select the middle ellipse and rotate it 45 degrees. Use the Options bar for quick numeric 
entry.

 9. Select the three ellipses and then click Create Form. A lofted form will be generated.

 10. Use the View Cube to see the form from the top.
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 11. Select the form and click the X-Ray command on the Modify Form panel. This will allow 
you to see the skeleton geometry of the form.

X-ray mode

In X-Ray mode, it is easier to select the individual ellipses and make further modifications, such 
as move, rotate, and scale. X-Ray is a temporary, per element override, and only one element can 
be shown in X-Ray at a time.

Making a Sweep
Sweeps are composed of a path and a profile that follows that path (Figure 8.25). A path can 
have multiple segments, so long as they are connected end to end. Profiles can be open or closed; 
however, if the path contains multiple segments, the profile must be closed.

Figure 8.25 
A swept form.
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Here’s how to make a sweep.

 1. Open a new conceptual mass family.

 2. Start by drawing a spline through points from the Draw panel, on Level 1, that creates a 
swooping path. 

 3. Place a reference point on the spline—this will serve as the plane on which we will draw 
a shape to be swept along the spline.

 4. Select the reference point—this will set the active work plane to that of the point, which is 
perpendicular to the spline.
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 5. Draw another spline through points on the point you placed on the spline.

 6. You can drag the reference point and see that it follows the spine it is hosted on, and by 
extension the spline you sketched on the point also follows. Select both splines and then 
click the Create Form button; a swept surface will be created.
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 7. Select the form and click the X-Ray tool to reveal the path and profile that are being 
swept:

Rationalization of Surfaces
Once a form has been generated, it is often necessary to divide the form into regular intervals 
to better understand how a complex surface can actually be rationalized into buildable form 
(Figure 8.26). Once a surface has been divided, you can then begin to place real building compo-
nents on that surface. These components begin to suggest an architectural articulation that goes 
beyond mere massing studies and also begin to suggest fenestration patterns, surface modulation, 
and surface variations.

Figure 8.26 
A divided surface 
with a component 
family applied.
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divide SurFaCe tool

To divide a surface, select any surface and then click the Divide Surface tool in the contextual tab. 
The default division is a two-dimensional pattern that divides the surface evenly into 12 divi-

sions in both U and V directions. U and V represent a way to show a surface as a mesh that follows 
the natural contours of a surface. You are probably familiar with XYZ coordinates; well, U and V 
are simply the letters in the alphabet directly before that. Start with a simple box, and select a sur-
face to divide—click the Divide Surface button, and you will see the surface disappear and a UV 
grid appear. You can see a UV division on nonplanar surfaces, as shown in Figure 8.27.

Changing the UV division of the surface can be done a number of ways: using the Options 
bar, using the Instance Properties dialog box, or using the Configure UV Layout mode—
accessible by clicking the icon that appears on the center of a divided surface when selected 
(Figure 8.28). 

Figure 8.27 
UV surface  
divisions.

Figure 8.28 
Click the UV  
Layout icon to  
get access to  
in-context  
controls.

56491c08.indd   260 6/2/09   9:58:25 PM



understanding forM Making and rationalization | 261

Divisions can be established using a fixed number or a fixed distance. If you want to start 
dividing a surface using more concrete sizes, change your division to fixed values. The fixed 
number will result in nonstandard numbers that change based on the surface. To change the 
division to use fixed distances, use the Options bar, as shown in Figure 8.29. 

aPPlying a Pattern to the SurFaCe

Once a surface has been divided, you can apply patterns to the surface. Revit ships with a fixed 
set of predefined patterns (Figure 8.30) that range from simple rectangles and triangles to more 
complex hex patterns and brick layouts. To apply a pattern, select the divided surface and use 
the type selector.

Patterns are two dimensional by default but can be swapped with 3D components on the fly. 
We will look at how to make a custom component family and get it onto a surface in the next 
chapter. Note that you cannot make custom patterns—you must choose a pattern from the pre-
set list.

Figure 8.29 
Use the Options 
bar to change how 
the U and V divi-
sion is computed.

Figure 8.30 
Use the predefined 
patterns to  
create some inter-
esting surface 
rationalizations.
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Importing 3D Conceptual Models Created in Other Applications
We walked through some examples of conceptual forms that can be created directly in Revit. Of 
course, Revit is not the only 3D modeler out there, and many people have become experts with 
tools such as AutoCAD, SketchUp, Rhinoceros, Maya, and 3ds Max, among others. All of these 
tools can still be used, and the geometry you create can be leveraged inside a mass instance or 
mass family. Importing CAD formats is supported in the conceptual design environment, and 
you can even divide surfaces from these files. You may want to use imported geometry in sev-
eral scenarios:

You have users who are comfortable with 3D modeling tools such as those listed. They pre-•u	

fer to do the massing there and then use Revit’s conceptual analysis capabilities as well as 
the Model by Face tools to turn the mass into a building

There are shapes and NURBS forms that Revit doesn’t do easily (or at all), so you need to •u	

create the shape in another application. You need not import a whole building shape, as 
shown in Figure 8.31—it may be just a face of a shape that you’ll need later to design a spe-
cific portion of a complex-shaped building, such as its roof

You can import individual masses (a complex shape, for example) or a fully developed mass-
ing study model. Regardless of what the import represents, the strategy is to never import it 
directly into the project file but to go through a family import:

If the geometry is an individual element that you’re likely to reuse, open the Family Editor •u	

by opening a mass template, and create a new mass by importing the geometry

If you have a full study model, it’s advisable to import it as an in-place mass family in the •u	

project (use the Create Mass tool and then choose Insert  CAD Formats to import the 3D 
geometry created elsewhere)

We’ll talk more in Chapter 9, “From Conceptual Mass to a Real Building,” about how the 
behavior of the imported items depends on how they’re imported, whether directly into the 
project, in a mass family, or in an in-place mass.

Figure 8.31 
A NURBS shape can 
be imported into 
Revit and used as 
a basis for making 
building elements.
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The Bottom Line

Understand massing workflows.    Using generic forms, you can create early conceptual 
models and then use the mass to create the walls, floors, and roofs.

Master It    You need to explore a design idea early on, in 3D, using abstract forms. How 
would you do this with Revit?

Start a conceptual massing study.    In the project environment, you can make massing 
forms at any time. For generic forms that might appear in multiple projects, consider using 
the conceptual mass template and creating mass families.

Master It    You’ve imported a 2D site plan, and now you need to start building a massing 
study model in the project. How would you approach this with Revit?

Understand form making and rationalization.    You can make many types of form using 
Revit’s form-making tools. You can then rationalize your form using the Divide Surface 
tool. Get familiar with how to go about creating forms, as it’s different from in the standard 
Family Editor.

Master It    You have made a form and want to edit it further. What tools can you use to 
make changes to the form?
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Chapter 9

From Conceptual Mass 
to a Real Building

In this chapter, we describe the use of an early conceptual mass model to help you understand pro-
gram fit and the creation of early feasibility studies. You’ll see how easy it is to convert a massing 
study—whether done within Revit or imported from another application—into building elements 
such as walls, floors, and roofs. The premise of a BIM approach to design is that a fluid workflow 
can be maintained as you move from early concept models into design development and eventual 
construction documentation, all the while maintaining the same underlying geometry and 
design intent. Revit provides specific tools that accommodate early massing model studies for 
program validation and feasibility studies, which can then be quickly converted to real building 
elements.

In this chapter, you’ll learn to: 

Make conceptual designs and early studies in Revit•u	

Build a real building out of a 3D concept mass•u	

Use imported geometry from other applications for massing•u	

Use smart relationships between the building mass and the underlying mass•u	

Understanding Conceptual Design and Early Studies
A project usually starts with a rough conceptualization of first ideas in which the architect’s 
mind wanders between the creativity of fantasy and the reality of customer needs, merged with 
the influence of the context, the genius loci.

Conceptual designs are the first graphical words an architect exchanges with a client to 
get approval for the architect’s first thoughts and sense the client’s taste. When the initial idea is 
approved, the architect continues in the next stage of development and makes more detailed stud-
ies supported by concrete measurements and numbers that prove the applicability and feasibility 
of the design.

We’ll review how this process of initial conceptualization and form finding can be done 
using Revit. Figure 9.1 shows an example of an early massing study made in Revit. Let’s walk 
through how this workflow is supported.
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Getting Site Data and Building the Context
A project usually starts with a client’s wishes, vision, and expectations that are described in 
initial conversations with the architect. A list of program requirements is compiled, listing the 
types of spaces the building will have and its rough area. The architect then starts gathering 
information and data about the site—aerial photos, photos of the site and context, site-survey 
files with land information, and building footprints and blocks. Using site analysis, program 
requirements, and creativity, the architect proceeds to study what shape and size building fits 
best. Variations of the design are studied, analyzed, critiqued, and presented to the client.

Getting site data into the digital model is the first step in moving from loose napkin sketches 
to a real project. By importing DWG or DGN site information into Revit or using a CSV points 
files, you’ll have a real-world underlay from which to work. (For small projects, this can also be a 
scanned image of a hand-drawn site situation.)

CAD drawings with site information usually come with a rich amount of information that 
needs to be culled. Using the Visibility/Graphic Overrides dialog box, after having imported the 
DWG or DGN file, you can hide unnecessary layers to make the drawings more legible. Setting 
the correct scale and orientation of the site relative to the building will be the most critical initial 
steps, and they should be carefully considered during the import.

Scale

In the Import CAD Formats dialog box, setting the Import units to Auto-Detect usually works 
well if the CAD file was drawn correctly, that is, at 1:1 scale. If the drawing was scaled, you may 
find that the scale of the imported file is incorrect. If this is the case, you can rescale the image 
using Element Properties, in the Instance Properties dialog box.

OrientatiOn

The next step is to deal with the orientation of the imported site plan. Maps are usually created 
so that north is always at the top, and that is how site information should be displayed in final 
documents. However, when you’re working on developing a site plan, you’ll probably prefer to 

Figure 9.1 
Massing study 
model.
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work in a way that is most comfortable for you, in a way that the site is oriented parallel to your 
computer screen (meaning you don’t have work under some strange angles)—not to true north.

Orienting a Site plan to Fit Your Screen

Suppose you’re starting your design study and you open a site plan view to import the CAD file 
with the site. An imported CAD drawing usually comes in its original coordinates’ orientation, 
with north and south in the vertical axis.
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If you open the view’s properties, you’ll notice that the Orientation parameter indicates Project 
North.

By default, the orientation of a view is set to Project North. By changing the Orientation parameter 
to True North and rotating the True North setting, you can work in a comfortably oriented plan 
relative to your screen.

In the View Properties dialog box of a plan view, change the Orientation parameter to True North, 
and rotate true north using Manage  Project Settings  Position  Rotate True North. A rotation 
control appears in the view. Rotate to an angle best suited to work on. Note that this does not mean 
you’ve rotated the project, but rather you’ve rotated the world.

This procedure is more than enough if you don’t intend to send information back to the person you 
received the file from. However, if you’re collaborating with a civil engineer and need to send back 
the building footprint or an early mass study, you need to establish a connection between the two 
files so they have the same coordinates. This can be achieved using Linking (an option during the 
import) as well as the Acquire Coordinates functionality. 

Positioning Imported Files Relative to the Revit Project
You can choose an automated or manual placement of the imported file in your Revit project. 
With Automatically Place (under the Positioning drop-down in the Import dialog box) you have 
the following options:

Auto - Center to Center    Aligns the 3D center points of both models.

Auto - Origin to Origin    Places the world origin of the linked file at the Revit model’s origin 
point. If the linked model was created far from the origin point, linking with this option may 
put the linked file far away from the main model.

Auto - By Shared Coordinates    Places a linked Revit file according to the shared coordi-
nate system created between the two files (this is available only if you’re linking files). If no 
shared coordinate exist between the two files, Revit alerts you and uses the Auto - Center to 
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Center positioning. The Shared Coordinates settings can be found in the Tools drop-down 
menu; you have the following options:

Acquire Coordinates    Allows you to take the coordinates of the linked file into the host 
model. There is no change to the host model’s internal coordinates; however, the host 
model acquires the true north of the linked model and its Origin setting.

Publish Coordinates    Allows you to publish the Origin and True North settings to your 
linked model. Revit understands that there may be other things in your linked file, and 
you may not want this to be a global change to the linked file. An additional dialog box 
appears that gives you the option to name separate locations for each set of coordinates.

Specify Coordinates at a Point    Allows you to manually key in X, Y, and Z coordinates 
relative to the origin or define where you want your (0,0,0) point to be.

Report Shared Coordinates    Shows the E/W (east–west) (X), N/S (north–south) (Y), and 
elevation (Z) coordinates of any point in the model.

Manual - Origin    The imported document’s origin is centered on the cursor.

Manual - Base Point    The imported document’s base point is centered on the cursor. Use 
this option only for AutoCAD 2009 or later files that have a defined base point.

Manual - Center    Sets the cursor at the center of the imported geometry. You can drag the 
imported geometry to its location.

You can import a CAD file so that it appears in all views of your project, or you can import 
it so that it is visible only in the current view in which you are importing it. You will find these 
options at the left side of the dialog box. 

Remember that for topography files, as an exception to the rule, you should not select the 
Current View Only option because you will not be able to convert the imported file into topog-
raphy. This might be slightly counterintuitive because this is exactly a case where you would 
logically import it only in site view because you don’t need the topography in any other view 
(and thus the Current View Only option would have rather been the logical way to proceed). 
However, because of some settings concerning the site in Revit, you will need to remember 
this exception. In any other case, if you need to see an imported file just in one view, select the 
Current View Only option.

If you forget this rule during the import and import the site plan using the Current View 
Only option, we advise that you delete the import and re-import the file, making sure that the 
Current View Only option is not checked. As you will probably not want the site file to be visible 
in all other views, you can turn its visibility off in the other views later.

Building the 3D Context
After positioning an imported CAD file in your site plan and reorienting it to true north, you 
can start building a 3D environment using the massing tools. The base shapes of buildings in 
the CAD file can be used to generate a massing model of the surrounding site quickly. Figures 
9.2 through 9.5 show examples of generic massing of context buildings. Use photos or actual 
data to establish building heights.
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To make a 3D study of the surrounding site, use the In-Place Massing features and begin 
developing solids out of the existing geometry:

 1. From the Massing & Site tab, select Create In-Place Mass. Give the mass a name, such as 
context buildings. 

 2. Select the Pick Lines tool in the Draw panel (the last icon in the gallery) and the pick lines 
from the imported file to use as a base for generating 3D masses using the Create Form tool. 

 3. Select chains of lines individually, and then click the Create Form tool. Use the temporary 
dimensions and the form control arrow to set exact heights.

Figure 9.2 
Massing used to 
add surrounding 
context buildings.
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Figure 9.3 
Massing used for 
abstract contextual 
representation.
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Program Check and Feasibility
Many of the activities in early design revolve around exploring the commercial viability of the 
site and figuring out the right mix of uses (for example, residential versus office versus retail). 
All these uses have different economic returns. Zoning regulations can be complicated in how 
they allow different amounts of total development based on the mix ratio. In essence, two num-
bers govern almost all urban properties: floor area ratio (FAR) and lot coverage ratio (LCR). FAR 
is a number that says how many multiples of the site area the building area can be. LCR specifies 
the percentage area of the site that can be covered by the building footprint. Usually the archi-
tect is required to maximize the FAR by determining the right mix of uses placed at the right 
location on the site.

At this stage, the problem is not only about forms or shapes but also about the program, 
construction costs, rents, and the functional distribution on the site horizontally and vertically. 
The architect usually attempts to determine what physical forms, in what location, and with 
what use will provide the best economic return to the owner. This study then needs to be con-
solidated and documented. While studying this problem, the architect may generate tens if not 
hundreds of slightly different alternatives for numerical comparative purposes. A few of the 
most promising are then developed further for client and authority presentation purposes.

At early stages in design, you need to check the program and how well your proposed design 
fits into it. A program can be less or more precise, depending on the client and the task in ques-
tion. It can be as bold as 15,000 sq. ft. (4,570 sq. meters) offices, 40,000 sq. ft. (12,200 sq. meters) 

Figure 9.4 
Massing used to 
model existing 
buildings on site.
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hotel space, and 20,000 sq. ft. (6,100 sq. meters) retail space for a bigger complex, or it can be an 
exact number of rooms and spaces when working on one building. Figure 9.5 shows an early 
massing study annotated to show usage and areas.

The next step is to propose multiple solutions to the client, so proposals with different mixes 
of functions and spatial solutions can be reviewed and analyzed. This is where the Design 
Options tools you’ll learn about in Chapter 10, “Working with Design Options,” come in handy.

Architects are constantly thinking about architectural expression, fitting in the site, and 
accommodating the program. They’re also evaluating whether the client’s requirements can fit 
the allowed buildable area and height of the site, zoning regulations, land uses, traffic require-
ments (they usually always want more), and information about the number of parking spaces 
and other support functionalities. This phase of the project can also involve shadow stud-
ies and energy modeling, as discussed in Chapter 18, “Evaluating Your Preliminary Design: 
Sustainability.”

Figure 9.5 
Early study 
documenting 
maximum allowed 
heights and total 
square footage of a 
proposed solution.
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Creating Multiple Massing Study Design Options

Here is a suggested workflow based on a real-world use case.

The architectural firm Gensler created an option set with three options, each with a distinct name. 
They duplicated the 3D views, made three different variations of the design and schedules to docu-
ment project information of the three design options early on. In each view, the Visibility/Graphic 
Overrides were set to display only one option at the time (one set to Option 1, another to Option 2, 
and the third to Option 3). Doing so not only visually described the new option but also presented 
the data behind each design.
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Modeling by Face to Make a Building
After a series of iterations and tweaking, the client makes up their mind. One of the solutions 
is selected, and you’re ready to move early massing studies into a real building project. Here is 
where the Model by Face tools comes into play. With these tools, you can use the mass as a basis 
for actual building elements and move to the next stage of design, attaching walls, floors, and 
roofs to the massing surfaces.

This approach has two major advantages over traditional 3D systems:

The need to re-create the digital data from scratch is eliminated. Instead of building a new •u	

project with walls, floors, and the like, you simply use the created mass as a reference

A connection between the building elements made by referencing the mass and the mass •u	

itself is established, so that the massing design can change later, and this will automatically 
update the building elements made out of its faces or floor slices

The nice thing about this workflow is that it also supports the import of massing elements or 
studies from other tools, such as AutoCAD 2010, Maya, Rhino, 3ds Max, Inventor, or SketchUp, 
and converts them into Revit mass elements, to which you can then attach walls, floors, and 
roofs and thus convert the mass into a real building.

Chapter 8, “Concept Massing Studies,” discussed the principles of conceptual form making 
and rationalization, so by now you should have a good understanding of how to create a mass 
element or an entire massing study using in-place massing or loaded mass families.

In this chapter we’ll focus on how to apply building components to your massing—in the 
conceptual design environment and in the project. The tools for placing mass floors, roofs, 
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curtain systems, walls, and floors are under the Model by Face drop-down in the Conceptual 
Mass tab on the Massing & Site tab.

Let’s get an overview of the available tools and then examine their real-life application.

MaSS FlOOrS

The first tool you should know about isn’t visible in the Massing & Site tab, but it will show up 
when a massing instance is selected in the Modify Mass contextual tab. The tool is the Mass 
Floors tool, which is designed to get early square footage take-offs from your massing model. 

Assuming you’ve created a mass study in which you defined the basic volumes and shapes 
that will form your building or complex of buildings, you’re ready to start setting up levels. 
Depending on the type of building you’re making, code regulations, and functional usage, you 
can begin to lay out levels for the building. Let’s say the maximum allowed regulated height for 
your building is 70’ (22m), and your building is a hotel, which will usually have a 10’ (3m) floor-
to-floor height. In that case, you can get approximately seven levels.

Switch to any elevation view, and using the Level tool, start adding as many levels as your 
building needs to have. It’s obviously much easier to copy a level graphically using the Multiple 
Copy or Array command than to manually draw a level seven, eight, or as many times as you 
need it. However, if you use the Copy or Array method for level creation, you won’t create actual 
floor plan views associated with each of the levels, something that would automatically be done 
when you manually draw levels. (The difference between drawing and copying a level was cov-
ered in Chapter 3.) If that’s okay with you, and you don’t need floor plan views for each of the 
levels, then all is well and you can go ahead. If not, and you do wish to have a relevant floor plan 
generated for each level you are creating, you can either use the Level tool and draw each level 
or use the Copy method to create levels but then additionally create floor plans from those lev-
els by using the View/Floor Plan tool and selecting which levels should have a floor plan view 
associated with them.

Once you have established the number of levels your building will have, select the mass and 
click the Mass Floor button from the Modify Mass tab. (It is good to do this in a 3D view, as you 
will instantly understand what that tool does.) Upon clicking the Mass Floor button, a dialog 
box will appear with a list of all available levels in the project. Click the checkbox next to each of 
the  levels you want to generate floor areas for. If you check all levels, a mass floor will be created 
for each level that can be calculated for area. If you want to skip a level because of double room 
height, for example, don’t check that level. You can do this for all masses at the same time or sep-
arately for each one. You can also add or remove levels later: anything in Revit can be changed 
at any time.
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Select the levels that intersect your mass and that you want to get area information from, and 
click OK. You will see the mass sliced by all the levels you selected, and mass floors are indi-
cated on the mass.

Figure 9.6 shows Mass Floors being applied to the main building only. In Figure 9.7, all other 
masses representing other buildings have also been sliced by the Mass Floors tool.

Figure 9.6 
Mass Floors tool 
applied to one of 
the masses.
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Figure 9.7 
The different 
masses can be 
sliced using a  
different level 
selection.
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assigning Levels for Mass Floors

In cases where you have multiple individual mass bodies representing different buildings, you can 
have them all use the same levels for the floor slicing, or you can select them individually and have 
each one use different levels. Imagine you have set up levels at a distance of 3m and have seven levels. 
You have a hotel building and a conference center building. The conference building might have a 
floor-to-floor height of 6m, and thus you’d select only Level 1 and Level 3 as floor area slicers—as 
opposed to the hotel rooms that will need a floor sliced each 3m.

Revit is fantastic because you can add, delete, and reshuffle levels at any moment in your 
project development without needing to redo work or losing any invested work.

The slicing of masses done by the Mass Floors tool doesn’t just visually help you understand 
the number of floors and divisions—it also provides numerical information essential for early 
conceptual analysis. With the help of this tool, you can find out the following:

Floor area•u	

Exterior surface area•u	

Floor perimeter•u	

Floor volume •u	

Usage•u	

The Mass Floor Area parameter can be added to schedules, so that you can call out and 
schedule all parameters associated with mass floors (Figure 9.8).

An additional improvement allows you to get information about the floor perimeter and the 
exterior surface area (Figure 9.9).

Figure 9.8 
Mass floor can 
report areas in 
schedules.
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You can calculate gross floor area, surface area, and volume, and for that you make a sched-•u	

ule of the Mass category

You can also calculate and schedule floor area, exterior surface area, floor perimeter, floor •u	

volume, usage, and some additional parameters inherited from the mass, all per individual 
level—and to do that you schedule the Mass Floor category

This provides data that can help you easily create a conceptual analysis and validate the 
program fit. By scheduling, sorting, and filtering the data of mass floors, you can find out the 
exterior skin material for each usage on each floor and calculate its percentage against the entire 
exterior surface of the building. You can do similar calculations for the floor area to determine 
the total usage of various functions and their percentage relative to the total usable area of the 
building.

Even though the floor area faces calculate volumetric slices of the mass, they will not show 
up as 3D volumes. Only the floor area surface geometry becomes a new element in the model.

VeriFying yOur DeSign anD itS Fit within the DeFineD PrOgraM

You can schedule the parameters and values of the masses like you can for any other Revit ele-
ment. In the earliest phase of the project, you’ll probably want to schedule the functional zones. 
To create an understandable schedule, it’s a good idea to give the mass elements you created names 
according to their function—Hotel, Conference Hall, Parking, Restaurants, and so on—and assign 
them different colors (materials) so it’s easy to visually represent the data. If you need to rename 
the mass element once it is created, you can do that from the Project Browser—find the mass 
element in question and rename it using the context menu. You can also add project parameters 
to the mass elements, such as Public or Private Space, Department, and so on. If you wish to tag 
those new parameters so that they are shown in a mass tag, you must make them shared param-
eters and add them in the Massing Tag family. See Chapter 19 to learn about shared parameters 
and their applicability.

Out of the box, the Mass category in Revit can report the following numeric properties:

Gross floor area•u	

Gross surface•u	

Gross volume•u	

Figure 9.9 
Floor perimeter 
and exterior  
surface in Revit 
schedules.

56491c09.indd   278 6/2/09   2:39:59 PM



Building the 3d Context | 279

If you create an initial mass study and schedule the mass elements, the schedule reports the 
gross surface area and gross volume of the entire shape, as shown in Figure 9.10. Note that the Gross 
Floor Area field is blank: the reason for that is that you can’t schedule the gross floor area without 
first adding levels and creating mass floors, as explained at the beginning of the chapter.

By defining levels and creating floor area faces using the Mass Floor tool, the floor area slices 
will show in the mass, and the missing information about the gross floor area will be automati-
cally filled in the schedule (Figure 9.11). 

Figure 9.10 
Example of a mass 
element without 
mass floors applied 
(no floor area faces 
generated as of yet).

Figure 9.11 
The mass is  
sliced into floor 
area faces.
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The gross floor area of the mass is the sum of all the mass floor slices related to  any given  
mass element. Periodically, you need to get separate data about the floor area per floor, sorted 
and grouped by use or function. This is possible by creating a schedule for the Mass Floor cat-
egory (Figure 9.12).

The reported values are useful for further conceptual analysis, as you can apply different cost 
factors for different exterior skins. For example, you can get a good idea about the cost of  mak-
ing the last five floors of your building using glass skin versus having them all be solid walls.

The massing tools in Revit have been extensively used by many architects. Figure 9.13 shows 
a project of the firm HOK in which they used the massing tools to produce colored diagrams 
that are great for explaining to the client the spatial organization of the project. This book is 
black and white, so you will need to apply your imagination as to how such a color diagram 
looks. Know that investors love this simple but informative way of understanding functional 
distribution.

Figure 9.12 
Scheduling new 
parameters can 
help you make a 
more accurate con-
ceptual analysis 
about the usage  
of space and  
materials.

Figure 9.13 
Transparency  
and color in  
massing studies 
used as a language 
to explain  
programming.
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Because you can quickly generate metrics and graphics showing the functional distribution 
of program elements, you should be able to get feedback on the fitness of the design early on. 
This will in turn allow you to fine-tune the design and make sure you’re keeping pace with the 
client’s requirements. Once you’ve built a parametric massing model, the elements are all adjust-
able in size and shape, and any change you make will instantly be reflected in the visual and 
schedule data (Figure 9.14).

After you’ve reviewed a couple of design options with the client, a decision is made and you 
need to move forward into the real project. Moving to the next stage is simple: you can use the mass 
to generate building components using specially designed tools. Let’s look at these tools now.

MODel by Face: wallS

You can start using the mass to generate real building elements such as walls. For that you will 
use the Model by Face  Wall tool on the Massing & Site tab. Note that you can create walls by 
face only on vertical and inclined faces or arc faces of a mass. Walls cannot be applied to horizon-
tal faces. You can begin applying generic walls that you will later swap out with the exact wall 
types you’ll be using; or, if you want to make early renderings that convey color and texture, you 
can apply the types of walls that you believe best represent your concept about and texture, 
material, and color. 

Many of the rules and principles behind standard wall creation should be followed here as 
well. It’s important to correctly set your wall location prior to applying it in order to minimize 

Figure 9.14 
Conceptual mass 
analysis.
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rework later. Of course, if you make a mistake, you can always fix that later. How you build the 
mass—to represent the outermost envelope or to represent the interior envelope—will deter-
mine how you want to set the location line for your walls. Use the exterior face if you modeled 
the massing to the exterior envelope of construction. Keep these limitations in mind:

Any wall in Revit can be converted into a curtain wall. Unfortunately, this isn’t the case •u	

with walls created with the Wall by Face option. To make curtain walls, you need to use the 
Curtain System tool in the Model by Face drop-down list

You can’t edit the profile of a wall by face (using the Edit Profile tool available to standard •u	

walls)—meaning you will not be able to freely carve out shapes from a wall. To do that, you 
must change the shape of the underlying mass first

MODel by Face: FlOOrS

Only after you’ve used the Mass Floor tool to generate mass floor area faces can you apply real 
floor elements. Select Model by Face  Floor and start selecting the mass floor area faces to 
which you want to assign a floor. To create the floors, you will need to click the Create Floors 
button in the Ribbon or nothing will happen.

To accommodate floor creation in a tower with many floors, for example, you can check the 
Select Multiple option on the Options bar. You can then begin selecting all the floor area faces to 
which you wish to apply floors and finish with the Create Floors tool.

The Mass Floor tool slices the mass horizontally, creating horizontal floor plates by default. 
If you need floors to be sloped (such as ramps), you can always slope them later after applying 
Floors and the Shape Editing tools available when a floor is selected, or you can edit the sketch 
of the floor and add a slope arrow when in Sketch mode of the floor (Figure 9.15).

It’s worth mentioning that when you create a floor by face, the Options bar includes an Offset 
parameter.

Figure 9.15 
Click a grip  
control to change 
the floor slope.
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This isn’t the vertical offset of the floor from the level you can find in the Floor properties; it’s 
an offset of the floor sketch from the current floor area boundary. If you add a positive value to 
the offset, the floor plate becomes smaller than the actual floor area (Figure 9.16).

MODel by Face: rOOFS

You’ve learned how easy it is to apply walls and floors to massing faces. Roofs follow the same 
basic principles but are more flexible. You can create roofs by face on planar faces, arcs, or other 
shapes created by extrusions, revolves, sweeps, and blends.

Note these limitations:

You can’t select a vertical face to create a roof•u	

Once a roof is created using the Model by Face: Roofs method, you can’t edit its sketch to •u	

change its shape in plan. If you created a roof by face and need to change its sketch, you 
must change the shape of the underlying mass from which the roof has been derived; only 
in that way can you affect the shape of the created roof

MODel by Face: curtain SySteM 

Curtain systems are a handy tool for dividing a façade into regular intervals of panels and mul-
lions. With one click, you can convert the face of a mass into a curtain system with predefined 
parameters to match your needs. Curtain systems can be applied to any face and are composed 
of grids, panels, and mullions. Make sure the curtain system type you choose has a predefined 
Curtain Grid layout.

Figure 9.16 
Use Offset to make 
a slab smaller or 
larger than the 
floor area face.

Floor area face Floor by face without offset

Floor by face with 3˝ offset
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Keep these limitations in mind:

You can’t edit curtain system sketches. A curtain system made by face requires editing  •u	

the shape of the underlying mass

You can’t always predict the XY coordinate system applied to the face. You may have to •u	

make new types in order to meet your requirements

Only masses that are planar or curved in one direction can host custom curtain panels. •u	

Compound curved systems have to use the default system panel

Technical Details You Should Be Aware of When Scheduling Mass Elements
It’s important that your mass model be modeled properly from a geometrical point of view in 
order to support accurate area reporting and downstream applications of walls, floor, and roofs. 
Look at the towers shown in Figure 9.17. If you simply draw the two towers and schedule them, 
the schedule reports the values for the individual towers.

If you move the position of the towers so that they intersect, the schedule reports the same 
calculated values: Revit doesn’t join the geometries and eliminate the overlapping areas auto-
matically (Figure 9.18). If you place different masses that aren’t joined and overlap, when you 
use the Floor by Face tool the intersecting portions of floor slabs overlap and cause duplicate 
area calculations. To resolve this issue, you need to join geometry. 

Figure 9.17 
Unconnected mass 
forms and their 
schedule.
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To get the correct schedule that represents the actual volume, surface, and floor area values, 
use the Join Geometry tool on the Modify tab. Whichever mass you used first is the one that 
penetrates into the other mass. The schedule now reflects the values of the joined, merged geom-
etries (Figure 9.19).

Figure 9.18 
Mass forms inter-
sect but are still 
not joined; the 
schedule still 
reports the sum  
of the area and 
volume.

Figure 9.19 
Mass forms are 
joined. The sched-
ule reports the 
correct surface and 
volume.
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Joining the masses creates a relationship between the two masses. This means that if you 
move the location or edit the shape of one, the joined geometry (Boolean) automatically updates. 
Only in cases where you move one mass completely away from the other mass will you get an 
error message that the two masses don’t intersect anymore, and you will need to use the Unjoin 
Geometry option to fix the error.

Once the masses have been joined, you can begin to apply elements to the mass surfaces 
(Figure 9.20).

Applying 3D Components to a Divided Surface
The Curtain System by Face method is great if you only need to lay out equal-spaced lines in two 
directions, but what if you want to create more complex surface patterns and give 3D articulation  
to that pattern? This is where the new pattern-based curtain panel family comes into play. As 
we mentioned in the previous chapter, any surface in the conceptual design environment can be 
divided and patterned with any of the precooked patterns provided. These patterns are 2D by 
default, but they can be made 3D very easily. Once you have a 3D pattern family, you simply load 
it into the massing family, and it will be available in the type selector when any divided surface is 
selected. We’ll take you through an example.

Before jumping in, keep in mind that a surface has four levels of representation: the original 
surface, the UV division of the surface, a pattern that is “stitched” onto the UV division, and 
components that can fill in a pattern. Figure 9.21 shows the progression, from left to right. The 
most important thing to keep in mind is that a pattern is always made of straight segments that 
span from node to node along a surface—it is not made of segments that follow the curvature 
of a surface. This fact is important, as this is what truly makes a surface rational and eventually 
buildable.

Figure 9.20 
Mass with applied 
walls by face.
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To start, from the application menu, choose New  Family  Curtain Panel Pattern 
Based.rft. This will open the template for creating dynamically adjusting panels. The principle 
of these families is based on the idea that points can be used to register 3D coordinates—every 
point in the panel template will correspond to a node on a divided surface. As the surface 
changes shape, the panel will follow along.

Figure 9.22 shows an example of the default rectangular pattern family with the reference 
lines selected. The reference points can be clearly seen.

The grid represents an abstract version of a divided surface. If you select it and open the 
Instance properties, you can adjust the UV spacing. You can also swap the pattern type using 
the type selector. 

Figure 9.23 shows a hexagon pattern. The reference lines are important features of these 
families—these are the linear elements that span between points as the points adapt to surfaces. 
Using the reference lines to create form will cause the form to adapt to surfaces as well. Let’s try 
one out.

Figure 9.21 
From left to right: 
original surface, 
divided surface, 
patterned surface, 
component on pat-
terned surface.

Figure 9.22 
The default  
pattern-based  
curtain panel  
family template.
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 1. Open a new Curtain Panel Pattern Based.rft file.

 2. Select the grid and change the type to Triangle using the type selector.

 3. Place a reference point on one of the reference lines—this will be the host for a swept 
profile.

 4. Select the point to set it as the active work plane; then sketch a circle with a 3” radius 
around the middle of the reference line.

 5. Select the circle and the chain of reference lines that make up the triangle, and then click 
the Create Form button. You should end up with a sweep along the triangle.

Figure 9.23 
A hexagonal 
pattern—note how 
the pattern spans 
multiple tiles on 
the UV grid.
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 6. Create a new conceptual mass family and create a simple form. Divide a surface of the 
form, and then apply a triangle pattern to the form.

 7. Go back to the triangle family and load it into the mass family.

 8. Select the divided surface, and use the type selector to change the triangle pattern to use 
your custom panel—you should see the name of your family at the bottom of the list. 
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As you can see from Figure 9.24, this feature is very powerful way to propagate a family across 
a façade. The patterns available offer flexibility of formal expression, and you should feel inspired 
to give them a try. 

Using Imported Geometry from Other Applications 
for Massing
You can use various applications to create geometry to be imported into Revit for massing. 
This section looks at using SketchUp, Autodesk Maya, Rhinoceros, Autodesk 3ds Max, Autodesk 
Inventor, AutoCAD 2010, and many more.

SketchUp
SketchUp is a fantastic piece of software. It’s considered by many to be a great concept modeling 
and visualization tool that is easy to use, produces great results, and really feels architectural. Many 
architects adore SketchUp for conceptual studies or early images of design ideas. Revit users use 
SketchUp to make initial massing and conceptual studies to produce nice graphic outputs for 
their clients. They can then move the model into Revit for the documentation phase. 

SketchUp files can be imported in either of two file formats, which are tied to different work-
flows and expectations:

SKP    Use this format if you’ve created a complex geometric element in SketchUp that is pretty 
much final, and you just need to import it into Revit using the direct import of the SKP file. An 
example is a building with a complex shape or roof that you couldn’t easily do in Revit.

DWG    If you expect a dynamic workflow where the models need to move back and forth 
and maintain some intelligence, use file linking and link in the DWG files. This way, if the 
DWG changes, the model will update to show the latest version of the DWG.

Figure 9.24 
Triangle compo-
nent family applied 
to a surface.
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Import the SketchUp Model in a project environment to Leverage Linking

You can leverage the linking functionality only if you import the SketchUp model within the project 
environment. If you import it as a mass, the reload link functionality will not work.

Here is how we suggest working with a SketchUp file:

 1. In SketchUp, make a quick and easy initial concept design like the one shown in 
Figure 9.25, and save it.

 2. Start a new massing by using the In-Place Mass tool in the Massing & Site tab, and 
then import the file from the Insert tab, using the Import CAD button. This will open the 
Import CAD Formats dialog box (Figure 9.26).

Figure 9.25 
Massing created in 
SketchUp.

Figure 9.26 
The Import/Link 
CAD Formats  
dialog box.
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 3. Finish the family.

 4. Switch to 3D view, and switch the model graphics of the view to Shaded with Edges. The 
SketchUp model appears in Revit. You can also activate shadows to see the model better 
(Figure 9.27).

Often, when you finish the mass family after importing the SKP file, you’ll get a warning 
message. It’s important to read this message in order to understand the future expectations for 
the import. If a mass family imports only nonvolumetric geometry, you can’t create floor area 
faces in Revit. This is the case with any imports that come from surface or polymesh modeling 
applications. When imported into Revit, NURBS surfaces and solids can to be fully understood 
by Revit, and you can use them to generate the mass floor area faces and all future reporting 
needed for conceptual studies. Maya and Rhinoceros deliver good NURBS surfaces for this 
workflow.

Rhinoceros
Rhinoceros (known popularly as Rhino) is a neat application that many architects love for the 
powerful shapes it can create and its relative ease of use. Rhinoceros produces NURBS surfaces 
that can be easily imported and used as a reference to create a building out of the Rhino mass-
ing concept.

You can use Rhino to create concept studies or a complex-shaped building element. As an 
example, a draped form was created using Rhino and then imported into a Revit massing ele-
ment (see Figure 9.28), just as you’d do with a SketchUp import. The form was then used as a 
reference and a curtain system by face was applied to it to generate the roof in Revit.

Rhino models are imported in Revit as SAT files. To import a SAT file from Rhino into Revit, 
the best approach is to make a mass family in the project environment and import the SAT file 
while in mass editing mode. This allows Revit to use the imported geometry for mass floor area 
faces and to perform other calculations and cuts in section and plan. 

Figure 9.27 
Imported SketchUp 
file with shadows 
turned on.
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This warning can safely be ignored. Finish the family; then, from the Massing & Site tab, 
select the Model by Face  Curtain System tool. You can select a different type from the type 
selector. Click the imported file geometry, and click the Create Roof tool on the Options bar.

The new object—a curtain system—is generated from the underlying geometry (Figure 9.29). 
It’s important to understand that glass panels don’t conform to the surface—the panels remain 
planar and attempt to fit the surface as best they can. So, as the panel cell size gets smaller, devi-
ance decreases. You can always change the type later, just as you can for any element in Revit. 
Once you’re happy with the type and the size of the panels, you can apply mullions. Depending 
on the complexity of the imported file, this can take up to a few minutes—but don’t worry, it’s a 
one-time action! Note that tighter grids give better results but also increase the processing time.

Autodesk Maya
As technologies become more powerful, they have the ability to influence trends in many indus-
tries, including architecture. Organic, free-form, generative buildings are all over the architectural 
magazines: this in a way is provoked by the fact that building technologies have become more 
sophisticated but also because modeling tools to create such forms have become better and 
easier to use. And while no software can make something beautiful unless it is in the hands of a 
creative person, these inspiring tools certainly capture the creative mind of talented architects. 

In the myriad of available modeling tools today, the question is not only if you can make a 
shape or inspiring design but how. Maya is considered one of the best tools with a most artistic 
approach to form finding. No wonder that it started to capture the mindshare of many famous 
architects and is being implemented in the curricula of the most advanced architectural schools 
that teach generative techniques and methodologies of computational modeling. 

Maya not only helps artists explore forms that are approximations or alternatives to creative 
visions but in itself sparks ideas and forms not previously explored or considered in a creative 
process. 

Figure 9.28 
NURBS surfaces 
turned into curtain 
systems using the 
Curtain System by 
Face tool.

Figure 9.29 
You can apply a 
curtain system to 
a NURBS imported 
geometry.
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Maya can create the most amazing shapes (Figure 9.30) and supports three major types of 
geometry: polymeshes, NURBS surfaces, and subdivision surfaces. You can import any of those 
into Revit, but if you want to leverage the full power of Revit to get area, volume, and skin calcu-
lations from the Maya model, you’ll get best results by using NURBS in Maya.

The workflow from Maya to Revit is either via DWG directly to Revit or via AutoCAD where 
the DWG is converted into a SAT file and then imported into Revit. As a general rule, use the 
latter only in cases where you have trouble importing the DWG created with the plug-in.

The DWG export from Maya is not native in Maya but is a separate plug-in and can be found 
at the Autodesk Labs website: http://labs.autodesk.com/utilities/maya_export_dwg/.

Autodesk Inventor
Autodesk Inventor is a software solution for the manufacturing industry, but it starts to provoke 
a growing interest among architects for its parametric rules-based form generation as well as for 
its fabrication capabilities. Using rule-based techniques, you can create a complex conceptual mass 
in Inventor and then use them in Revit to make initial conceptual analysis, mass floor areas, 
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Figure 9.30 
There is no limit  
to your fantasy 
when modeling 
with Maya.
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volumes, and so on and then move the concept to a real building by creating elements by faces, 
just as you can from the other modelers (Figure 9.31). You should export the conceptual mass 
done in Inventor in SAT file format to be able to import it in Revit.

Inventor can serve later in the stage of creation of implementation documentation and fab-
rication details (Figure 9.32). You can design, for example, your curtain wall layout in Revit but 
can make fabrication exact drawings of each of the elements using Inventor.

Figure 9.31 
Conceptual mass 
created in Inven-
tor, imported as a 
Revit mass, turned 
into a building, 
and rendered.
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AutoCAD 2010
New to the 2010 release of AutoCAD are some new free-form modeling tools that allow you to 
rapidly convert boxy shapes into smooth subdivision surfaces. These forms can be imported into 
Revit and work well with the Model by Face tools. 

The new Mesh Modeler in AutoCAD is based on subdivision surfaces, and it allows you to 
make free-form shapes that would otherwise be difficult to model with NURBS, polygons, or 
solids. These tools provide a simple and intuitive set of modeling techniques, based on push-
ing and pulling vertices, edges, or faces of a mesh. This is done through direct manipulation of 
the mesh, which is quite nice. The modeler then has the ability to smooth the mesh, making an 
approximation of a curve with different levels of complexity. This can then be used in a Revit 
massing family (Figure 9.33).

When you import a mesh into Revit from Rhino, Max, Maya, SketchUp, or a similar appli-
cation, you can only use the surface of the imported object to apply faces, and you cannot get 
floor area calculations. With irregular or complex geometries, where walls may not be vertical, 
or where the concepts of wall, floor, and roof become blurry, generating a floor without a mass 
may become unfeasible. AutoCAD 2010 introduced a new topology that replaces the old mesh 
and can be directly manipulated and smoothened with a very simple set of commands. These 
meshes can be converted into solids or surfaces within AutoCAD and then imported into Revit 
as .dwg files and used to host walls, floors, and roofs using the Model by Face tools.

Figure 9.32 
Detailed design 
and fabrication 
documentation 
can be easily done 
with Autodesk 
Inventor.

Co
ur

te
sy

 o
f D

av
id

 L
ig

ht
, E

xc
ite

ch

Figure 9.33 
Creation of organic 
concept models 
using Mesh  
modeling in  
AutoCAD 2010.
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Using Smart Relationships between Building Mass and 
the Underlying Mass
The idea behind attaching building elements to massing surfaces is that you can come back to 
the massing and make large gestural edits to the underlying form and have the walls, floors, 
and roofs update to meet that design change. When you’re working in the conceptual design 
phase, you experiment a lot during the form-finding and creative-thinking stage. In Revit, the 
change of the underlying mass form will not automatically update Revit building elements related 
to mass surfaces, as this would present regeneration slowdowns and impede a fluid workflow. 
That said, it’s easy to keep your model in sync. You might first play with the shape, and then when 
you’re happy with it, choose to update Model by Face elements. To do so, select a mass, and then 
click the Show Related Hosts button in the Modify Mass tab. This will select all face-based ele-
ments related to the mass. Click the Update to Face button to bring the building elements into 
sync with the mass faces. So how does that work? When elements that are tied to a massing are 
selected, an Update to Face button appears in the contextual tab on the Ribbon. Clicking that 
button updates the element to match the newly edited shape of the underlying mass form, as 
shown in Figure 9.34.

Figure 9.34 
A: The starting 
form. B: The mass 
is made larger.  
C: The wall is 
remade to match 
the mass. D: The 
roof and other 
walls are remade 
to match the mass.

A B

C D

56491c09.indd   297 6/2/09   2:40:06 PM



298 | Chapter 9 From ConCeptual mass to a real Building

The Bottom Line

Make conceptual designs and early studies in Revit.    You can use massing studies to 
validate a design against the program requirements.

Master It    Conceptual modeling is used early in the design process to explore the build-
ing shape and building program. How do you approach schematic design using Revit 
and perform feasibility studies?

Build a real building out of a 3D concept mass.    Moving from massing to actual building 
components is easily done with Revit.

Master It    You have the basic massing nailed down, and now you need to study more 
details such as wall and window fenestrations. How do you approach this with Revit?

Use imported geometry from other applications for massing.    Make your own conceptual 
massing forms using the new Revit conceptual design tools. 

Master It    How can you reuse conceptual models created in other modeling applications 
and turn them into a measurable and documentable building in Revit?

Use smart relationships between the building mass and the underlying mass.    Use the 
update tools to re-sync building elements with changes to the underlying mass surfaces. 
With Revit, you can change the mass and know that most objects can be recomputed to 
match the form.

Master It    Change your massing model to explore design alternatives.
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Chapter 10

Working with Design Options

Revit supports workflows where multiple design options need to be explored, evaluated, and pre-
sented. This type of workflow is an integral part of developing and iterating a design solution. 
With Revit’s design options, you can use the same integrated building model to create a range of 
variations on a design at scales that range from entire façade studies down to kitchen layouts. 

In this chapter you’ll learn to:

Use Revit design options•u	

Decide on a design solution•u	

Use design options with parametric design•u	

Using Revit Design Options
Revit provides a set of tools for developing multiple design iterations in the context of one proj-
ect. You can use these tools to explore alternative designs without having to keep saving multi-
ple independent versions of your model as you move in different directions. With Revit’s design 
options, you create, evaluate, and mock up a wide range of options in the context of your project 
file. You’re free to investigate multiple roof configurations or different entry canopies, explore 
various furniture and office layouts and stairs—quite literally anything that can be modeled. 
Figure 10.1 shows an example of the same building model with two different entry canopies. 
Each canopy belongs to a separate design option that can be displayed or hidden in any view. 
This lets you create views that show each option so the two designs can be evaluated against 
each other.

Design options work in the following manner. First, you have a main model, which includes 
all the elements you’ve modeled that are fixed and not affected by the options you want to 
explore. The main model can be thought of as a backdrop or stage on which different options 
play. Elements in the main model are always visible by default whereas design options—such 

Figure 10.1 
Revit design 
options used  
to explore alter-
native design 
solutions for an 
entry canopy.
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as different furnishings for the interior or different canopies over an entrance—come and go, 
appearing and disappearing depending on what you’re editing. Put another way, the main 
model includes everything else that’s not in the options.

You can make as many options as you need—there is no limit. You can create views for each 
option that only show that option displayed against the main model, and thus be able to place 
these views on a sheet in order to compare and contrast your designs. You can then present 
them to a client, to the project architect, or to other stakeholders in the design process. Once a 
design option has been settled on, you accept it as the primary design solution going forward by 
adding it back to the main model. Doing so deletes all elements in the design option that you 
won’t use going forward. That is, some elements become embedded in the architecture, while 
others disappear forever.

Design Option Tools 
To access the design option toolset, switch to the Manage tab and select Design Options from 
the Design Options panel. 

In a new file that has no design options yet, by default only one button (Design Options) is 
enabled. That button launches the Design Options dialog box, where you create, manage, and 
edit all the design options in a project. We’ll cover the other buttons in the next few sections.

Creating a design option doesn’t create anything at first—it simply sets up the work environ-
ment so you can begin making various designs using the feature.

Design Option Sets
In Revit, every design option belongs to a design option set, which is a way of structuring the 
design options into clusters to aid your workflow. For example, a project may have three design 
options for an exterior façade, two options for a bathroom configuration, and three options for 
room and furniture layout. Revit allows you to have several sets—one for each major type of 
option you’re exploring. You may have a design option set called Exterior Façades, one called 
Bathrooms, and another called Room Layout. In each set, you can have as many options as you 
need for the design in question. This hierarchy is structured as a tree interface in the Design 
Options dialog box, as shown in Figure 10.2. Each option set is shown in a top-level node of the 
tree, and each design option is shown as a child of a set.

As you can see in Figure 10.2, there is always a primary option in each set. It is designated 
by the “(primary)” suffix. This makes that option always visible by default in any view unless 
overridden. You can change the default primary option by selecting any other option in that 
Design Set in the Design Options dialog box and clicking the Make Primary button. In the 
views, the new primary option will then be visible by default, hiding the previously defined 
primary option.

When you reach a point in your design where you’d like to explore multiple design solu-
tions, it’s time to start creating option sets. Think about how you’d describe the option—Façade 
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Studies, for example—and name your option set accordingly. Add at least two options to the 
set—more, if you think you’ll be exploring more than two options. You don’t have to define all 
the options in the beginning; you can always come back and add or remove options if needed.

Creating new design option sets is straightforward. Click the New button in the Option Set 
zone in the Design Options dialog box, and a new set is created. To give the set a unique name, 
select it in the tree and click the Rename button from the Option Set zone. Adding new options 
within the set follows the same pattern: use the New button in the Options zone, and then give 
the set a name.

You can delete design sets and options at any time. Deleting a design option effectively 
deletes any elements added to a design variation you’ve made using that design option. Deleting 
a design options set deletes all options in that set. These are drastic decisions, so be wary of 
deleting anything before you’re sure you are ready to do so. Deleting a design option will also 
delete any views that you have set up specific to those design options. In both cases, Revit will 
warn you before the views and option sets are removed. The same effect is achieved when you 
click the Accept Primary button—all other options in that set are deleted.

Adding Elements to a Design Option
Once you’ve formally established design option sets and design options, you can do a number of 
things depending on the scope of your options. You can add elements from the main model into 
each option if you want to experiment with variations of the element. This way, you can explore 
different expressions of the same object without adding new elements. For example, if you want 
to show two roofs with the same footprint but different slopes, this method of adding the roof 
into each design option will work nicely. Once the roof is added to each option, you edit the 
option first, then edit the roof slope. The roof is essentially a copy and can be edited indepen-
dently in each option (Figure 10.3).

Figure 10.2 
Design Options 
dialog box showing 
some option sets 
and options.
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Another way to work with options is to start editing the option directly, without first adding 
elements to the option. This approach works well if you have a design idea but don’t want to add 
it to the main model just yet. When you begin editing an option, the main model grays out, and 
any new element you add is added to the active design option. For example, let’s say you haven’t 
yet designed the entry canopy for your model, and you want to experiment with some different 
ideas. Start editing the option, and you can then model whatever you want. The main model is 
still visible for reference, but it won’t be editable.

You can use both methods in combination as well. For example, you might add a wall from 
the main model to two options and in each option add new, but different, window types to the 
wall. You’d use the Add to Set button to put the wall into both options, and then you’d edit each 
option to add the new windows.

To add elements to an option, first select them, and then add them to the appropriate design 
options by clicking the Add to Set button on the Design Options panel in the Manage Tab. Select 
only the elements you wish to make variations of—you don’t need to add elements that you won’t 
be editing. Once you click the Add to Set button, a dialog box appears that allows you to copy 
the elements into the desired design option or options. Again, this method is best if you know 
the elements will be essentially the same in each option and will vary only in type, material, or 
arrangement. Figure 10.4 shows the same walls in two options with different windows and wall 
material types.

Figure 10.3 
Two design options 
of a roof can be 
done within the 
same Revit model.

Figure 10.4 
Add walls to multi-
ple options in order 
to experiment with 
different window 
placements.
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To edit a design option, expand the list of available options from the Design Options panel and 
choose the option you want to edit. That option will become active and you will enter a special 
edit mode in which anything you create will be added to the active design option automatically. 
Use this method if you’re starting from a blank slate and laying out several options for furniture 
layout or exterior shading devices, like those shown in Figure 10.5.

When you’re adding elements to design options, keep the following basic rules in mind:

Host-based elements that cut the host (such as windows or doors) need to be included with the •u	

host when you make design options, meaning both the host and the insert have to be a part of 
the same option. You cannot have the host be a main model but make the inserts an option. 

Inserts are automatically copied with the host when you add hosts to design options. Using •u	

our example of a wall with a window in it, if you add the wall into a design option the win-
dow is automatically added as well.

By the same token, if you’re editing an option and try to place a window or door into a wall •u	

that’s not included in the option, you’ll get a warning:

You need to add that wall to your design option if you want to place inserts in the wall. 
Host-based elements that do not cut their hosts can reside in different design options without 
the host. For example, a wall-hosted sink can reside in a different design option than the 
wall on which it’s mounted (which resides in the main model), but a window that cuts a 
wall can’t.

When you’re adding curtain walls from the main model to a design option, the grids, mul-•u	

lions, and panels are automatically added for you.

Figure 10.5 
Use this dialog 
box to choose the 
design options into 
which you want to 
add elements.
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When you’re adding a roof to a design option, you should include all walls that attach to •u	

that roof. Otherwise, you won’t be able to attach walls to the roofs in your design options.

When you create groups or arrays within a design option, selected elements must be in the •u	

active option.

Once an element has been added to a design option, by default it will no longer be selectable 
when you work on the main model. You can override this behavior by deselecting the Active 
Only option check box located on the bottom of the application frame near the right corner.

Because the elements in a design option can’t be selected from the main model, you’ll need to 
use this feature to edit elements belonging to an option or activate a design option. For example, 
if you add all your exterior walls to design options in the Exterior Façades option set, the walls 
won’t highlight or be selectable unless you’re editing one of the design options. If you add ele-
ments to a secondary option, they won’t be visible by default in the main model.

Editing a Design Option
To start experimenting with design variations, after you create your design options you can edit 
them. To do so, use the drop-down menu in the Design Options panel and choose the option 
you want to edit (Figure 10.6). Alternatively, open the Design Option dialog box by clicking the 
Design Options button, select an option in the zone on the left, and click the Edit Selected but-
ton in the Edit zone on the right side of the dialog box.

The moment you select an option to edit, the main model grays out and becomes unselect-
able. This allows you to modify the elements in the design option without worrying that you’ll 
mess up other parts of the model. Any element created while in the design option’s Edit mode is 
automatically added to that option. For example, if you’re editing Option 2 of an Exterior Façade 
set and you insert new windows in a wall in that option, the windows are added to the design 
option—they aren’t added to the main model. 

Where’s the Wall?

Remember that the wall must be in the design option in order for you to place the window.

Figure 10.6 
List of available 
design options.
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Making Different exterior Skins

Using design options, we added the exterior skin of a building to two options in an option set. By 
creating a new wall type with different materials, we easily exchanged one wall type for another 
in each option. Once the wall types were swapped in each option, we duplicated the perspective 
view showing the exterior skin and changed it to show each of the options (spandrel glass in the 
one on the left, wood in the one on the right) using the Visibility/Graphic Overrides dialog box. To 
make the northeast perspectives easy to find in any list, we assigned the views meaningful names: 
Glass NE and Wood NE.
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Editing an OptiOn by SElEcting an ElEmEnt

If you want to start editing an element in a design option directly, click the Pick to Edit button. 
Hover the cursor over the model. Elements in design options will highlight. Now you can begin 
editing an element as soon as you select it. This shortcut lets you edit elements in a more direct 
manner. You can open the desired option automatically without having to know its name.

Take the example in Figure 10.4 of two views showing different roof options. In each view, to 
start editing the option choose Pick to Edit, select the roof, and start editing the roof. You don’t 
have to think about the name of the option.

Displaying Design Options
To visualize different design options and have them represented in separate views that you can 
drop on a sheet, you need to create a new view that displays the desired option. These usually 
are duplicated views of the same view for which you want to show different options. To do this, 
right-click any view in the Project Browser, choose Duplicate, and give the view a name that 
indicates which design option it represents. Then adjust the visibility/graphic overrides settings 
of that view to show the desired design option.

As you can see in Figure 10.7, once you’ve created option sets and design options, a new Design 
Option tab appears in the Visibility/Graphic Overrides dialog box of all views. The default visibility 
setting is Automatic, which means that the option displayed will be the primary option and the 
main model. However, using the drop-down menu under Design Option, you can override this 
setting and show any of your other options.

Figure 10.7 
By default, views 
are set to show the 
primary design 
options and the 
main model.
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In Figure 10.8, three options are shown for a building façade: Option 1 has no canopy over 
the third-floor deck, Option 2 has a solid canopy, and Option 3 has a louvered canopy. All three 
options exist in the same model and can be visualized next to one another by duplicating the 
view and changing the design option in the visibility/graphic overrides of the view. By dupli-
cating views and changing the default design option visibility, it’s easy to compare options and 
even place the views on sheets for printing.

Deciding on a Design Solution
After many meetings and discussions, there will be a moment when you will decide which option 
is the final one—the one to build. Keeping unused and out-of-date options in the project need-
lessly inflates the file size and adds unwanted complexity. Revit will let you, with one click, 
choose the option that will become a part of the main model and get rid of all other options and 
information and views related to them. 

 1. First, decide which option you intend to keep. Make sure you’re ready to implement your 
decision, because it will be irreversible after closing the project!

 2. Designate it as the primary option by clicking the Make Primary button in the Design 
Options dialog. 

 3. Select the option set, and click the Accept Primary button. Doing so brings up a warning 
dialog asking if you’re sure you want to do this.

As the message shown in Figure 10.9 suggests, if you proceed all secondary options will be 
deleted, and whatever is in the primary option will be pushed into the main model. The ele-
ments belonging to the chosen option will now become a part of the main model and thus you 
will be able to select them without having to edit a design option. 

Figure 10.8 
Visualizing three 
options within one 
model.

Figure 10.9 
Delete Option  
Set warning  
dialog box.

56491c10.indd   307 6/2/09   2:39:46 PM



308 | Chapter 10 Working With Design options

You cannot keep any views that were set to show secondary options that no longer exist. 
Therefore, Revit will display a dialog box asking you to delete any views that were set up to dis-
play options that you’re deleting (Figure 10.10). Click Delete to continue, and the views will be 
removed from your project. 

Putting Design Options into Practice
In the following exercise, you’ll make three different office layouts, shown in Figure 10.11, using 
design options. Option 1 is a hybrid design of open space and closed offices, Option 2 is an open 
office with cubicles, and Option 3 has only enclosed offices. 

Figure 10.10 
Delete Dedicated 
Option Views  
dialog box.

Figure 10.11 
The three office 
layouts you’ll 
create as design 
options.
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Once created, all the options will exist in one file and can be separately displayed in different 
views or dropped on one sheet for comparison. Follow these steps:

 1. Open the Foundation_chapter_10 model in the Chapter 10 folder of the book’s compan-
ion web page (www.sybex.com/go/masteringrevit2010). 

 2. Open the Level 1 Presentation plan view.

 3. From the Manage tab, select the Design Options button.

 4. Create a new Design option set called Interior Fitout.

 5. Create three options, and set Option 1 to be primary by clicking the Make Primary but-
ton, as shown in Figure 10.12 (this should be set by default).

 6. Close the dialog box.

 7. Choose to edit Option 1, using the drop-down list from the Design Options panel.

 8. While editing Option 1, place a series of workstation families (workstation.rfa) located 
in the Project Browser, under Families | Furniture Systems. Also add interior partitions 
and offices to create a layout similar to the one shown in Figure 10.13.

 9. Finish editing the options either by selecting the Design Options button and clicking the 
Finish Editing button or by simply switching to the Main model in the drop-down list of 
the available options in the Design panel.

 10. Choose Option 2 from the drop-down list to start editing that option.

Figure 10.12 
Create a design 
option set and 
three design 
options.
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 11. For Option 2, create an open floor plan layout similar to the one shown in Figure 10.14. 
You can simply draw this option layout. Alternatively, to speed up the process, you can 
choose to edit Option 1, copy the row of cubicle desks to the clipboard using Ctrl+C, 
choose to edit the Option 2 from the drop-down list, and paste the desks in using the 
Paste Aligned  Same Place option from the Clipboard panel of the Modify tab. Don’t be 
thrown off by Same Place; this pastes the workstations only into the active design option.

 12. When you’ve finished, select Main Model from the drop-down list in the Design Options 
panel to return to the main model. This finishes editing any particular option.

Figure 10.13 
Add workstations 
to Option 1.

Figure 10.14 
Add cubicles to 
Option 2.
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The elements in Option 2 will disappear from the view. The primary option (Option 1) is 
set to be visible by default, and as mentioned earlier, you can’t view more than one option 
per view.

 13. To make a third option that has enclosed offices and no cubicles, again you can either 
draw everything in that option from zero or you can choose to edit Option 1, select all 
the offices in the top half of the space, and copy them to the clipboard using Ctrl+C or the 
Copy command from the Clipboard panel.

 14. Choose Option 3 from the drop-down list of available options in the Design Options 
panel.

 15. From the Clipboard panel of the Modify tab, choose Paste Aligned  Same Place 
(Figure 10.15).

The workstations are copied into Option 3.

 16. Continue to fill the space with offices, drawing the partition walls as shown in 
Figure 10.16. You can use the Mirror command to speed up the process.

Figure 10.15 
Use the Paste 
Aligned feature 
to copy elements 
from one design 
option to another.

Figure 10.16 
Design Option 3 
contains offices.
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Next, you need to place each option on a sheet so you can show the options to your client and 
get feedback about the various layout options. To do that you will first need to create duplicated 
views, assign different design options to them, and finally place them on a sheet. Follow these 
steps:

 1. Duplicate the Level 1 plan view from the Project Browser and rename the copy  
Level 1 - Option 1.

 2. Duplicate the Level 1 plan view two more times, and give each view a unique name: 
Level 1 - Option 2 and Level 1 - Option 3.

 3. Open the Level 1 - Option 3 view, open the Visibility/Graphic Overrides dialog box, and 
select the Design Options tab. Change the Design Option value from Automatic to 
Option 3.

 4. Open Level 1 - Option 2, and repeat step 3, but make sure Design Option is set to Option 2. 
For Option 1 you can repeat the process, but you don’t need to do anything for the 
Level 1 - Option 1 view as it will be, as it’s a primary option automatically assigned to be 
visible with the Main model. You have thus created three views of the same floor plan, 
each showing a different design option.

 5. Create a new sheet view, and drag each of the plans onto the sheet, as shown in 
Figure 10.17.

 6. You’re now ready to present your alternatives. By associating schedules to design options, 
you can further illustrate the implications of various design decisions for your client.

Figure 10.17 
All three options 
can be placed on a 
sheet at the same 
time by duplicat-
ing the plan views 
and adjusting the 
settings in the 
Visibility/Graphic 
Overrides  
dialog box.
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Using Design Options with Parametric Design
Now that we have discussed the ability to have different design options within Revit and how 
to show these various solutions, let’s dig into a little more detail and talk about other ways to 
consider the various solutions. As any designer knows, multiple factors come into play with any 
design solution—beauty, functionality, cost, and sustainability, to name a few.

Showing Quantities and Cost Schedules for Multiple Options
When presenting design options to a client, schedules allow you to compare the cost of add-

ing particular features to different design options. A schedule, like any view, can be tailored to 
show specific design options. Here’s how to create a schedule of elements in a design option.

 1. Switch to the View tab.

 2. From the Create panel, click the Schedules button and select the Schedule/Quantities 
tool. Choose the category you’d like to schedule and the appropriate parameters. 

 3. Right click on the newly created schedule in the project browser and select Properties. 
From the Instance Properties dialog box (Figure 10.18), you can access the Visibility/Graphic 
Overrides dialog box and change the design option. The properties of the schedule 
include a parameter for Visibility/Graphics Overrides. 

Figure 10.18 
The Element  
Properties  
dialog box.

56491c10.indd   313 6/2/09   2:39:47 PM



314 | Chapter 10 Working With Design options

 4. Click the Edit button. This brings you to the Design Options tab (in this case, the only tab 
in the dialog box), where you can choose a design option to schedule. Here is this feature’s 
real power: only elements belonging to the selected category in the selected design option 
are included in the schedule.

Working with Rooms and Design Options
You can create rooms in design options to compare areas and create color schemes for various 
options. Revit allows you to create multiple independent room layouts in the same model. For 
example, you can create two office layouts with different sizes and number of offices in each 
option and then add rooms to the offices. You can then create views of each option that are 
color-coded to provide a nice visual comparison. To get a feel for how this works, consider this 
simple example.

Start with a corridor and rooms on either side. You need to create two design options that 
show different room configurations. Follow these steps: 

 1. Draw a simple layout of walls, as shown here in plan view.

 2. Open the Design Options dialog box from the the Design Options button on the Manage 
Tab, and create an option set named Office Configurations. Add two design options to 
the set, as shown in Figure 10.19.

Figure 10.19 
Adding the design 
options.
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 3. Back in the plan view, duplicate the view from the Project Browser. Name the view Level 
1 Plan View - Option 2. In the Visibility/Graphic Overrides dialog box for that new view, 
select the Options tab and set Option to Option 2.

 4. Go back to your original Level 1 view and change the Options Visibility/Graphic 
Overrides setting to Option 1.

 5. In the Option 1 plan view, choose to edit the option. Draw walls to create 12 offices, as 
shown here.

 6. Add rooms to each office using the Room tool from the Room and Area panel of the 
Home tab. Your design should resemble this graphic.

These rooms are added to the primary option.

 7. Open Plan View - Option 2, and click to edit Option 2 from the drop-down list of Design 
Options in the Design Options pane of the Manage tab. Place walls so that you make 10 
offices rather than 12, and place rooms in each office space, as shown here.
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 8. To create a schedule of the rooms in each option, select the Visibility/Graphics Overrides 
parameter in the Instance Properties of the room schedule, and set the design option to 
the desired option (Figure 10.20).

 9. Make a schedule for each design option showing rooms, areas, and count. Be sure to 
name each schedule so that it corresponds to your design options. You can then place 
each schedule and plan view on a sheet for comparison (Figure 10.21). Don’t be confused 
if the total areas of two options differ, even though the overall space is the same. This 
results from the spaces being measured to other than the center of each wall, such as the 
wall finish. More spaces require more partitions, resulting in different area totals. And 
with less usable space, you begin to understand why open-space offices are more com-
mon than partitioned offices. 

Figure 10.20 
A room schedule 
set to schedule the 
rooms of a chosen 
option.

Figure 10.21 
The design options 
in schedule form.
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The Bottom Line

Use Revit design options.    Design options provide a means to maintain two or more alter-
native designs for the same project or component.

Master It    What are design options in Revit?

Decide on a design solution.    The end result of exploring multiple options is to choose one 
alternative and implement that choice.

Master It    You’ve explored a number of design options for an entry scheme. Your client 
has selected one, and you need to incorporate it into the rest of the model and remove the 
unwanted alternates. 

Use design options with parametric design.    Making quantitative differences visible is an 
essential part of presenting multiple alternatives.

Master It    You need to look at some seating layout options for an auditorium space 
based on different-sized seating and show the seating counts.
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Chapter 11

Creating Custom 3D Content

In this chapter we explore how to build your own designed library elements (families) for use in a 
project. We’ll look at how parametric constraints and parameters can be used to build flexible, time-
saving, beautiful, and smart content. By learning a few simple rules in addition to the form-making 
principles that we covered in Chapters 6 (“Modeling Principles in Revit, Part 1”) and 7 (“Modeling 
Principles in Revit, Part 2”), you can build just about any element and assign it a behavior that you 
wish it to have—all without writing one line of code or knowing a programming language. 
Building intelligent content is a key feature of Revit and deserves an entire book in its own right, 
but we will introduce you to some useful concepts and get you going. This chapter will take you 
through fundamental principles and some compelling use cases using the Family Editor.

In this chapter, you’ll learn to:

Model parametric 3D families•u	

Nest one family into another•u	

Build relationships between parameters with formulas•u	

Modeling Parametric 3D Families
As a design progresses from generic to more refined, you’ll need to add more detail and real-
ism to your model. This process involves more faithfully representing what will be built and 
requires you to start building your own families. Although many types of families are provided 
out of the box, additional families can be downloaded from websites such as seek.autodesk.com 
www.revitcity.com, or www.arcat.com. You’ll inevitably reach a point where your design intent 
isn’t matched by any of those, and you’ll need to create new elements yourself. This is when 
you’ll need to dig into the Family Editor and create new building components (Figure 11.1).

Up to now we’ve covered many of the basic principles of families, including understanding 
the different family categories, the principles of modeling, form making, and constraints—but 
we haven’t put all this into practice beyond some simple shapes. In the following sections, we’ll 
look at more advanced techniques used to create parametric families with embedded intelligent 
behaviors.
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Choosing the Right Family Template
Every family belongs to a category, and it is essential to categorize new families correctly so 
they can be controlled and scheduled logically when you load them and use them in a project. 
Choosing the correct family template when making new families will set the appropriate cat-
egory. Revit provides templates (see Figure 11.2) for most families. These are hard-coded, and 
you cannot create a new template from scratch. Don’t regard this as a limitation, since there is a 
template for all major necessary architectural elements, and those few rare elements for which 
you might not find a corresponding template can be created using the generic template.

When you decide to create an element on your own, you need to select the correct template. 
These templates are time-savers, because they already have the right category assigned, provide 
the most important reference planes that drive the behavior and geometry, and in some cases 

Figure 11.1 
Custom design  
for a sunshading 
element.

Figure 11.2 
Family templates.
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include text notes to help explain how the family will work in the context of a project. Figure 11.3 
shows a window template file, which includes text indicating the exterior and interior of the wall; 
parametric dimensions for width, sill height, and opening height, and a sample host wall. This is 
the template to start with when you’ve designed a new custom-shaped window, for example.

The reference planes that appear in the family environment are the essential “bones” of any 
family. They establish the critical dimensional rules for the family, define the origin, and provide 
references that can be dimensioned to when loaded into a project. Without reference planes, you 
can’t make parametric content or dimension it in the project. Fortunately, all templates provide 
at least two reference planes to start with.

Figure 11.3 
Plan, elevation, 
and 3D views of a 
template for win-
dows. Text notes, 
reference planes, 
and dimensions 
have been preset.
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Types of Families
At the highest level, families occupy two categories: those that will appear in one view only 
(drafting, annotation, 2D families) and those that, when placed in a model, will appear in any 
view (model-based).

For model-based families, there are two high-level types: 2D families are used for making 2D 
details of the model, and 3D families are for making 3D geometric representations.

For 2D families, you can make standard detail components and line-based (2-pick) detail 
components. Three-dimensional family types include various host-based types (floor, wall, roof, 
and ceiling), profiles, line-based, work plane–based, and generic model. Note that 3D families 
can contain nested 2D elements as a way to embed more detailed information about that element 
directly into the families. Two new templates were added to 2010 that provide a custom set of tools 
for making conceptual masses. These are the Mass and Curtain Panel Pattern Based templates.

Choosing the correct template is essential to getting the desired family categorization and 
behavior of the element you are creating. To better understand what that means, let’s drill 
deeper into family types.

Host-Based Families

Windows, doors, skylights, and lighting fixtures are all discretely manufactured objects, but they 
have something in common: they’re installed into something else. Without the wall, ceiling, or any 
other mounting surface, the object has no place to ground itself in a typical building project. In 
other words, these types of elements require a host in which they can be placed or by which they 
can be supported. For these types of elements, Revit provides host-based families and templates.

When you need content to have an explicit relationship with a wall, floor, or roof, then a 
host-based family is absolutely the way to go. This is the most common type of family used in 
Revit. A host-based family includes components such as doors, windows, skylights, solar panels, 
light fixtures, and balusters. If you are reading this, you’ve probably placed some windows and 
doors in a Revit project, so we will not cover the benefits and behaviors of host-based families 
in detail here. If you are new to Revit, or need a refresher, don’t worry. The basic principles are 
quite simple: once a host-based element is placed in or on a host, a dependency arises between 
the element that requires a host and the host in which it is placed. In an example of a wall (host) 
and window (host-based family), if you move the host, the hosted element will move as well; if 
you delete the host, the hosted element, too, will be deleted. Bear this in mind going forward in 
developing your model. Figure 11.4 shows several examples of such host-based families. 

The golden rule when making a new family is to first consider it from a category point of 
view. What am I making? How does it need to behave (in a view or schedule, 2D or 3D, parametric, 
limited parameters, etc.)? Once it’s made, how might it need to change, if at all? Then you can 
use an appropriate template as a starting point. For example, if you need to make a new window, 
start with the Window.rft template. Similarly, if you are making a table, the Furniture.rft tem-
plate is the way to go.

Windows and doors don’t exist in the model in isolated, abstract form, but are always hosted 
by a wall. This is why when you start creating or editing a window family, you will see a sample 
host element (a small wall, roof, or floor). The sample host in the family is there just to help you 
construct the family so it behaves properly in the model. It gives you a context in order to build 
the family so it correctly relates to wall thickness.
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Where’s the host?

Note that the host that exists in the family template (such as the wall in the window template) 
isn’t loaded in the project when you load the window. It’s present in the Family Editor only as a 
reference to help you understand how the window will work when loaded into a project. Only the 
geometry, symbolic lines, and reference planes that you create will end up in your project. This is 
a very important concept to understand.

ProFile Families

Many architectural details have distinct cross sections that run in a closed, linear fashion. Revit 
constructs these details by extruding that profile along a path, a process that is similar to how 

Figure 11.4 
Examples of host-
based families.

Wall-based door Wall-based window

Roof-based skylight Ceiling-based lighting fixture
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many of these elements are physically manufactured. Baseboards, cornices, handrails, and mul-
lions are all good examples of profile-based elements:

Revit provides special templates designed for elements like these. To create one of these ele-
ments, you need to create a Profile family. You will notice that there are a few different profile 
family templates to choose among: Hosted, Mullion, Rail, Reveal, and Stair Nosing. Make sure 
you pick the correct one when creating a profile family. Once you select a template, you can start 
sketching with 2D lines, defining the shape of the profile cross section. Like many sketches in 
Revit, the profile must be made of a single closed loop of lines. Multiple loops will lead to errors 
downstream. For example, if you created a mullion profile like that shown in Figure 11.5 and 
then tried to load it and use it in a mullion family, you’d get a warning message. Delete the inner 
loop of lines to get the mullion to work properly.

If this is true, you must be asking yourself how you can make something like the shape 
shown in Figure 11.5. Although you can’t have multiple loops in the profile family, you can 
import a detail component into the profile family that will mimic the representation you need; 
this is possible because there is no penalty for having multiple loops of lines in the detail com-
ponent. The detail family showing the rest of the content within the outer profile adds much 
more detailed information about that element. It can be visible in a section of that element in 
the model (think plan and section views), and you can decide in which levels of detail you want 
that detail component to be visible.

To control when this level of detail will be visible in the model, set the visibility of the detail 
component so it appears only at fine levels of detail. Continuing with the mullion example, take 
these steps:

 1. Start a new family using the Profile Mullion.rft family template.

 2. Load a complex detail component done by a manufacturer into the mullion profile fam-
ily. You will find a myriad of them on the Web, usually offered in DWG format, although 
with every passing day more manufacturers offer their content in .rfa format as well.

Figure 11.5 
This profile is 
invalid because 
profiles with more 
than one loop 
won’t work in a 
project.
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 3. Trace the loaded component with a single loop of lines to get the outer shape of the profile 
(see Figure 11.6).

 4. As you probably don’t need to see such complexity at the coarse or medium level of detail 
(it will probably just print as black blobs in your drawings in small scales), set the options 
in the Visibility Settings dialog box to show the detail only in fine views.

 5. Load the Profile Mullion family into the project by using the Load into Project button.

 6. From the Project Browser, under the Curtain Wall Mullions node, locate the Rectangular 
Mullion family. Right-click to duplicate it and give it a specific name. Open the Type 
Properties dialog box of that new mullion, and under Construction on the Profile line, 
choose the ‘Curtain Wall Mullion-Rectangular-Center : 21⁄2” x 101⁄2”’ in the project to the 
mullion family (see Figure 11.7).

Figure 11.6 
On the left is the 
profile sketch, and 
on the right is a 
detail component.

Profile 
sketch lines

Detail 
component

Figure 11.7 
Choose the profile 
from the mullion’s 
type properties.
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Once a profile is loaded into Revit, it doesn’t take 3D form until it’s assigned to system fami-
lies such as mullions, rails, wall sweeps, and gutters. To do this, open the Type Properties dialog 
box of any of these families and assign the profile to the family. You can use a 2D profile in the 
definition of a wall as a precast parapet cap, as shown in Figure 11.8.

Many companies that sell finish molding provide 2D CAD drawings that you can import 
directly into a Revit profile family. This is a great time-saver and will keep you from having to 
draw complex profiles from scratch.

Profiles can be used for many different purposes. To accommodate more specific behavior as 
well as categorization, six profile family templates are available: Profile.rft, Profile-Hosted.rft, 
Profile-Mullion.rft, Profile-Rail.rft, Profile-Reveal.rft, and Profile-Stair Nosing. Be 
careful to select the correct one, because Revit looks only for specific profiles depending on what 
you’re making. For example, a mullion family won’t let you choose a wall-sweep profile; only 
mullion profiles will show up in the list. 

Notes on Using profiles

Keep in mind that simple-looking profiles can quickly weigh down a project if overused, and if you 
export for rendering purposes they can be more tessellated than necessary. When creating profiles, 
don’t use a spline when an arc (or series of tangent arcs) will suffice. And don’t use an arc when a 
line will suffice. 

2d line-Based Families

Working on a 3D model does not mean that all elements need to be modeled in 3D; some are 
represented using 2D detail drawings. Most details can be drawn using lines and filled regions, 

Figure 11.8 
Assigning a profile 
to a system family.
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but these are inherently difficult to maintain and reuse. For details that are likely to be used in 
other drawings or projects, you should create detail families. With Revit, you can make stand-
alone detail components or line-based families. The line-based family type is great for making 
elements where length is the primary variable and for making 2D repeating components.

The 2D line-based template (Detail Component line based.rft) allows you to draw a 
detail element as if you’re drawing lines with two picks, but the component can contain as many 
lines and filled regions as you want. For example, you can draw a detail component that repre-
sents plywood (lines plus wood hatch) with two clicks of the mouse.

Making a plywood Line-Based Family

When we had to make a plywood detail element, we went to the line-based detail family. With 
this detail template, we created a filled region between the left and right reference planes and 
assigned a plywood fill pattern to the region. As long as the left and right lines of the filled region 
are coincident with the reference planes, they will follow the planes when the family is placed in a 
project and drawn. The cross-sectional dimension of the filled region can be driven by a Thickness 
parameter, which is set to 3⁄4˝ and can later be modified if you need new types:

When the plywood family is loaded into the project, we were able to make a symbolic 2D plywood 
representation with two clicks that defines the length. Once the plywood was placed, we could 
reselect it and drag either end using the blue grips to stretch the detail. Compared to using a filled 
region in the project, this method provided parametric constraints, reusability, and incredible 
ease of use.

3d line-Based Families

Just like the 2D drafting line-based families, you can make 3D line-based families. For these 
families, use the template Generic Model line based.rft. Examples where you need such 3D 
line-based families are molding details, sunshades, grating, and any other elements that have 
length as their primary variable and repeating 3D components. Figure 11.9 shows a 3D chair 
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family that adds chairs as the family elongates. If you want to count the number of chairs, you’ll 
need to read about nested families and shared values, covered later in this book in Chapter 19.

With two clicks of the mouse, you can quickly add rich 3D content to your model. Figure 11.10 
shows a sunshade example. (Figure 11.1 showed this same sunshade in 3D.) The brackets at the 
left and right side were modeled in the family using solid extrusions and constrained to the 
left and right reference planes. The blades were modeled as sweeps between the two horizon-
tal reference planes, using a profile. When placed in the model, the sunshade can be stretched 
dynamically.

Face-Based and Work Plane–Based Families

For elements that need the flexibility to be placed on any model face, such as electrical outlets, 
signage, or coffee pots, there are work plane and face-based families. Not only do these families 
attach to any surface of the model during placement, but you can also re-host them at any point 
later to any other surface if need be. Any time you have a component that needs to be installed 
on multiple types of hosts, think of making the family face-based.

Face-Based Families

To create face-based families, use the template Generic Model face based.rft. When you open 
the template, you’ll see an abstract host surface on which you can model your family. When 
you load your family into your project, the host surface in the family maps to whatever face you 
choose in the project, and your family reorients to be placed on that face automatically. The face 
you choose can be anything from another family to geometry of a linked file. An example of a 
face-based family is an HVAC supply register, which you need to be able to place on walls, ceil-
ings, or even floors. Figure 11.11 shows another application of a face-based component, where 
the curved surface doesn’t have a work plane.

Figure 11.9 
3D line-based  
chair family.

Figure 11.10 
3D line-based Sun 
Shade family.
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Work Plane–Based Families

Work plane–based families are placed on the active work plane of the current view. Every view 
has an active work plane that you can manipulate using the Work Plane tool (see Chapter 6, 
“Modeling Principles in Revit, Part 1”).

Be sure to give the family an appropriate category before loading it so you can control its vis-
ibility and graphics.

ricH PHotorealistic content (rPc) Families

When you’re rendering a view, it’s possible to substitute real model geometry (the family) with 
highly photorealistic images (such as ArchVision content, available at http://www.archvision 
.com/). For example, a simplified stick figure can turn into a real-looking person when the view 
is rendered (see Figure 11.12).

Figure 11.11 
A sign created as a 
face-based family 
can be placed on a 
curved wall.

Figure 11.12 
Left: Entourage 
family, non-
rendered. Right:  
same family when 
rendered.
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This can be a cool feature when you’re rendering, and it makes rendering faster because there 
is no complex geometry to render. You can create plants, cars, and people using these families.

assigning a rendering aPPearance

RPC families are specialized and have specific behavior when rendered. In addition to the 3D 
and 2D representation that you normally add to a family, you can assign a rendering appearance 
to the family. This appearance shows up only when you render a 3D view.

You create RPC families using the template RPC Family.rft. RPC appearances can only be 
added to the Entourage and Planting families. When the family is set to either of these categories, 
a Rendering Type parameter is enabled in the dialog box that opens when you select Category 
and Parameters from the Create ribbon. RPC families in these categories have additional type 
parameters (located in the Family Types dialog box; see Figure 11.13) to control the associated 
RPC file used when the family is rendered in a project, along with specific properties. 

Figure 11.14 shows the Render Appearance library and some of the people/characters that 
come with Revit.

Once you’ve selected an RPC object, you can further refine the properties of the object by 
clicking on the first Render Appearance parameter. Figure 11.15 shows the properties of a 
Steelcase Think chair, with options to change the back and seat fabric. You’ll also notice that 
RPC content supplies you with 3D model geometry.

Figure 11.13 
RPC parameters in 
the Family Types 
dialog box.

Figure 11.14 
Render Appear-
ance library for 
RPC content.
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detail comPonent Families

As you’ll see in Chapters 20 and 21 (“Developing the Design with Smart Workflows” and 
“Moving from Design to Detailed Documentation”), a typical workflow to complete a construc-
tion document set involves enriching the model with 2D details in detail views. These detail 
elements typically depict cross sections or elevation views of elements that don’t need to be 
modeled in full 3D (to do so would only bog down the model and not add much value). For this 
use case, you can use detail component families to add detail to model or drafting views; these 
details are visible only in the view in which they’re placed. Examples include blocking, studs, 
steel sections, bolts, flashing, and so on:

Detail components can contain lines, filled regions, masking regions, symbols, and other 
detail components. Detail components are meant to represent real building components and 
assemblies, so they scale with the model when the view scale is changed. To create a new detail 
component family, use Detail Component line based.rft or Detail Component.rft. 

Figure 11.15 
Editing the render 
appearance prop-
erties for a chair.
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3d Families

To accommodate fast and easy creation of architectural content, many templates have been 
made for you with the appropriate category selected. Examples include Furniture.rft, 
Furniture Systems.rft, Mechanical Equipment.rft, and Plumbing fixture.rft, to name a 
few. Use these templates to make content when starting from scratch.

curtain Panel Families

Curtain walls and aluminum storefront systems are composed of mullions, panels, operable 
windows, and doorways. In Revit, the Curtain Wall tool organizes all these components into 
an integrated system of parts. For panels, the default solid and glazed options are usually suf-
ficient. Adding doors and windows to a curtain wall requires you to make custom windows and 
doors made with a special template in the Family Editor. Figure 11.16 shows a curtain wall door 
family in the Family Editor. (These templates don’t contain host walls as other door family tem-
plates do.)

Keep this in mind: to add doors to a curtain wall, you must use one of the special curtain 
wall doors; you can’t place a standard door into a curtain wall. Use the Door - Curtain Wall.
rft template to create these families. They resemble regular door families, but the width and 
height are dynamically tied to the size of the curtain wall cell in which the door is placed. As 
the curtain grid spacing changes, so does the size of doors placed in the wall. As you can see in 
Figure 11.17, the door family adapts to the size of the curtain grid spacing.

Figure 11.16 
Double-panel cur-
tain wall door.
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Family Categories and Parameters
In every Revit family, settings control specific behavior of the family and set the category. Depending 
on what category you assign the family, you can get a different set of type parameters and category-
based parameters. For example, in a window family template, preset parameters for sill height, 
width, and height are hard-coded into the family (see Figure 11.18). In a furniture family template, 
you don’t see these parameters.

Another set of parameters affects the entire family based on the category it belongs to. You 
can access these settings by choosing Category and Parameters on the Create tab. In the result-
ing dialog box (Figure 11.19), you can set or change the category and also adjust other param-
eters that affect how the family will behave when placed in a model.

Figure 11.17 
The curtain wall 
door adjusts its 
width and height 
to the size of the 
cell in which it  
is placed.

Figure 11.18 
Family parameters 
for windows.
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In the figure, the Entourage category has four family parameters listed: Work Plane–Based, 
Always Vertical, Rendering Appearance Source, and Shared. Remember that changing the active 
category at the top of the dialog box may enable or remove family parameters displayed in the 
bottom of this dialog box. Let’s briefly review what these parameters do.

Work Plane–Based    Enabling this option allows the family to be hosted by the active work 
plane when placed in the project or nested into another family. Any nonhosted family can be 
set to be work plane–based. Any family using the generic template (furniture, site, casework, 
and so on) can be set to work plane–based, as such families aren’t required to be hosted by 
another component (like doors or windows).

Always Vertical    This parameter keeps a family oriented in the positive Z direction when 
placed in a project. In most cases this is desired, because levels are always horizontal. But 
when you have sloped floors or sloped site conditions, you may want the component to be 
oriented perpendicular to the surface it’s placed upon. Parking stripes and cars placed on a 
sloped slab of a parking structure are examples where making the family not always vertical 
can make sense (see Figure 11.20).

As another example, the Always Vertical parameter comes into play with trees placed on a 
toposurface. As the site changes slope, you want to keep the trees vertical and not have them 
look like they’re falling over.

Rendering Appearance Source    This only applies to the categories Planting and Entourage. 
There are two options here: Third-Party or Family Geometry. Choosing Third-Party automat-
ically imports 3D geometry from RPC content. Choosing Family Geometry does not use RPC 
geometry but rather the geometry you construct yourself in the Family Editor.

Shared    This parameter controls whether or not a nested family will be scheduled in a proj-
ect of a family that is nested in another family component. You may choose to nest families 

Figure 11.19 
The Family  
Category and 
Parameters  
dialog box.
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to create assemblies or save time modeling components that repeat. Nesting has implications 
when you need to tag or schedule the family. For example, consider a window assembly with 
a main light and two side lights—one on each side. If the design intent is that the window 
is to be tagged and scheduled as a unit, then the families will be nested into a host family 
and the Shared parameter will remain unchecked. In this situation, only the host family (the 
family containing all nested windows) will schedule. If the intent is that the assembly be 
constructed from separately purchased units and assembled on site, then the nested families 
should have the Shared parameter checked. This allows each nested window to appear on 
the schedule as if placed separately.

additional Family Parameters For structural content

When you choose some structural categories, you’ll see additional options show up that are 
specific to structural framing, foundations, and columns. We will not go into detail here on each 
of these, but structural engineers should be aware that special functionality has been built into 
family templates depending on the type of family you are creating.

Nesting One Family into Another
When you open a family in the Family Editor, you can load another family and place instances 
of it into your host family much as you would in a project. This powerful feature allows you to 
manage your content and reuse existing work. For example, consider the workstation family 
illustrated in Figure 11.21.

This family is composed of loaded filing cabinets, a desktop, partitions, and a chair. This 
makes building the family much more manageable and also makes it much easier to place and 
manipulate the family as a unit when placed in a project. In this example, you’d want to make 
sure that the filing cabinets were set not to display in plan views, since they’re obscured by the 
working surface. 

One common example of family nesting is the combination window. Rather than model 
the entire unit from scratch, you can load and insert existing window components into a base 
window family. You place the windows just as you would in a project. For example, you can 
place a fixed-window family in the center and two double-hung windows on either side (see 
Figure 11.22). You can then save the family and load it into a project. The entire assembly acts  
as one element when placed in the model.

Figure 11.20 
Family set to not 
be always vertical.
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Figure 11.21 
Nested families 
used to create a 
workstation.

Figure 11.22 
Combination win-
dow: one family, 
created from two 
nested families.
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Choosing to use nested families not only saves modeling time but can also simplify your work 
in the Family Editor. It’s often easier to manipulate and constrain an assembly of extrusions as a 
nested family than to model the same geometry in the host family. In another example, a bracket 
for a sunshade is modeled separately and nested into the host sunshade family (Figure 11.23). 
Two instances of the bracket can now be placed and constrained in the family much more easily 
than modeling the same elements as separate extrusions. Later in the chapter, we review some 
powerful features that you can use via family nesting.

Finally, nesting of one family in others allows for centralized change management: if you 
create a handle, you can nest it in doors, windows, or curtain wall doors and windows. If any 
change is made to the handle, it will propagate to all other families where it has been nested.

Scheduling Nested Families
When a family is nested in another family, by default it doesn’t appear in project schedules and 
isn’t taggable. For the most part, this is the desired behavior because it avoids overburdening 
your schedules with unneeded subassembly elements. A nested family’s geometry displays, but 
is treated as part of the host family.

In some cases, you may want to schedule nested families—for example, if you’ve nested 
chairs within a table family. To expose nested families to tagging and scheduling, you need to 
enable a parameter called Shared, as we detailed earlier. To do so, follow these steps:

 1. Open the nested family.

 2. Choose Categories and Parameters.

 3. Select the Shared option in the Family Parameters group.

 4. Reload the family into all its host families, and then reload those host families into your 
project.

Once all your nested families have sharing enabled, they will be schedulable and can also be 
tagged in your project. Keep in mind that once a family is shared and placed in the project, it’s 
not possible to “unshare” the family and reload it into the model.

Linking Parameters
When families are nested, the parameters of the nested family aren’t visible in your project by default. 
Only the parameters of the host family are visible, and they can be modified in the project environ-
ment. If the element you’re nesting is unlikely to change parametrically, this may be desirable. 

Figure 11.23 
Nesting a bracket 
into a Sun Shade 
family (host).

Bracket.rfa

Sun Shade.rfa
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However, if you want to control the nested element’s parameters as well, you must explicitly link 
them to parameters in the host family.

In our example, the support bracket of the sunshade is a nested family, and you need to be able 
to drive its dimension from the context of the project. 

In Figure 11.24, the depth of the nested bracket family is associated with the depth of the host 
Sun Shade family. Changing the Depth parameter of the sunshade causes the depth of all support 
brackets to also change to the same value.

You can link any kind of parameter, from dimensions to materials to text. For example, the 
Sun Shade family has two material parameters: Material Supports and Material Blades. By 
selecting one of the nested brackets and opening its type properties, you can assign its Finish 
Material parameter to the sunshade (host) material parameter Material Supports. When this is 
done, you can control the bracket material from the project by assigning a material to the sun-
shade’s Material Supports property.

Parameters in many nested families can be linked to a single parameter in a host family to 
provide powerful control over size, quantity, and even display of family subassemblies from 
within a project. This is a great way to limit exposing a family’s internal complexity when the 
family is loaded into a project.

Linking Parameters (Conditional Visibility)
Every nested family or piece of solid geometry has a Visible parameter. This parameter allows 
you to control the visibility of nested families by creating a Yes/No parameter in the host fam-
ily and then linking the nested family to that parameter. Checking or clearing this check box 
controls the element’s visibility in the host family when viewed in a project. Keep in mind the 
Visibility option only controls visibility! If the nested element is shared, it will still schedule. 

For example, let’s look at a window family that has a shutter family nested in it and two 
instances placed on either side of the window. You can create a Yes/No parameter called 
DisplayShutters in the window family and link the Visible parameter of the shutter family  
to this parameter (Figure 11.25).

Figure 11.24 
Linking a param-
eter in a nested 
family to the host.
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Two types are then created: Window w Shutters and Window w/o Shutters. The former has 
DisplayShutters selected and the latter has it deselected. When they are loaded into the project, 
you can use the two types to control whether or not the shutters are visible (Figure 11.26).

Building Relationships between Parameters with Formulas 
There are many examples of building components that have repetitive subcomponents built 
into them: evenly spaced shelves, brackets, structural members, nested chairs, or other compo-
nents—the list goes on. Figure 11.27 shows a perfect example where using an array to place 
vertical and horizontal shelves makes sense.

Figure 11.25 
Linking a Yes/No 
parameter to the 
Visible parameter 
allows the same 
window to be 
shown with and 
without shutters.

Figure 11.26 
Two types of a 
single family—
conditional geom-
etry display.
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In the Family Editor, you can use arrays on any geometry you’ve created or on any nested 
families you’re using. The Array tool in the Family Editor works the same as it does in the proj-
ect, but in the Family Editor, it can also be driven parametrically.

Making a Parametric Array
To make a parametric array in the Family Editor, you need to use the Group and Associate 
option in the Options bar. This allows you to parameterize the number of instances of the ele-
ment in the array. When you select the array, a number appears that corresponds to the total 
number of groups in the array. If you change this number, the number of groups in the array 
updates. If the array was created with the option Move to: Last, elements are added or removed 
between the start and end of the array as defined when it was created. If the array was created 
with the option Move to: 2nd, elements are added or removed after the end of the array.

You can turn the array number into a parameter by selecting the array and labeling it as a 
parameter (see Figure 11.28). Once the number is selected, the Options bar displays a Label 
drop-down menu. Select <Add Parameter…> to create a new number parameter.

Figure 11.27 
Arrays can help 
maintain element 
spacing in a family 
and allow you to 
control the number 
of grouped element 
instances.

Figure 11.28 
Assigning an 
array number to a 
parameter.

56491c11.indd   340 6/5/09   1:01:49 AM



BuilDing relationshiPs Between Parameters with Formulas  | 341

Once you make the assignment of the array number to a type parameter, the number of ele-
ments in the array can be controlled from the Family Types dialog box. In Figure 11.29, the num-
ber parameter Chairs controls the number of chairs in the radial array. Changing the number 
automatically changes the number of elements in the array.

Encoding Design Rules
Proportion has been an important consideration in the design of objects for centuries. Relating 
width, height, and depth to a design rule informed the design of architecture dating back to 
early Greek and Egyptian times. The dimensional size of one element often drives the size of 
other related elements. Think, for example, of a window with muntins; the number of muntins 
often grows in proportion to the size of the window (see Figure 11.30). To this end, Revit pro-
vides ways to relate parameters to one another using formulas. By changing one dimension of 
a component, you can effectively change many other dimensions and thereby maintain design 
intent. Often, your family will have parameters that determine its dimensions, and it’s the rela-
tionship between these dimensions that you want to maintain.

Figure 11.29 
Array of  
chairs in  
Table-Dining 
Round w  
Chairs.rfa.

Chairs = 6

Chairs = 5

Figure 11.30 
Window with 
muntins added as 
function of height.
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examPle: using a Formula to control dimensions

In a simple case, you can imagine using a formula to set the width of a shutter in a window fam-
ily. The window family may already have types that control its width and height. Knowing that 
the shutters should always be equal to the window height and half the width, you can use a for-
mula and let Revit do the calculation for you. Follow these steps:

 1. Load the shutter family into your window family, and place an instance on either side of 
the window.

 2. In the window Family Types dialog box, create a new parameter by clicking the Add button:

 3. In the Parameter Properties dialog box (see Figure 11.31), give the parameter the name 
Half Width, and set Type of Parameter to Length. You can group the parameter under 
Dimensions to make it easier to find.

 4. Back in the Family Types dialog box, in the parameter’s formula field, enter =Width / 2 
(see Figure 11.32). This ensures that the parameter is always half the window’s width. The 
Value field displays the calculated value; when the family is loaded into your project, the 
parameter will display but won’t be editable.

 5. Select the nested shutter in your family, and link its dimensions to the window so they 
change together. To do so, in the Associate Parameter dialog box (accessed from the small 
button at the far right of the parameter row), click the button in the correct row of the 
Shutter element properties. Associating the shutter’s Width parameter with the window’s 
Half Width parameter and its Height to the window’s Height connects the two objects. 

The shutter will now adapt its dimensions to the window whenever its shape is adjusted.

Figure 11.31 
Use the Parameter 
Properties window 
to give the new 
parameter a name 
and type.
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using a Formula to control an array

In the next example, you’ll see how you can use a formula to control the number of elements in an 
array used to construct a sun-shading family (Figure 11.33). (You’ll find this file, Sunshade.rfa, on 
the book’s companion web page, www.sybex.com/go/masteringrevit2010.)

This family is constructed of a support bracket and blades that make up the shade. The 
design calls for supports to be added dynamically as a function of length. In this example, both 
the brackets and the shades are arrayed so that their quantity is determined by the size of the 
family when placed in the project. The number of brackets is controlled by the Support Quantity 
parameter, and the number of blades in the shade is controlled by Blade Quantity. Both of these 
can be driven by formulas. The calculated value of a formula is always displayed in the Value 
column. Let’s look deeper at this design problem and see how it can be solved.

Support Quantity uses a conditional statement to guarantee that there are always at least two 
support brackets in the family. A conditional statement takes this general form:

If (condition, do this, else do this)

In the support case, if Support Minimum is true, then the number of supports is set to 
Length / 60. If it’s false, then the value is 2.

Figure 11.32 
A simple formula 
for half width.

Figure 11.33 
A sunshade family 
can be parametri-
cally defined with 
a formula.
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Support Minimum is a Yes/No parameter that’s also set to a formula. In this case, if Length (the 
length of the family) is greater than 135 ,̋ Support Minimum is Yes (true); otherwise, it’s No (false).

In Figure 11.34, you see the default Length value is 110 .̋ So Support Minimum is false, and 
Support Quantity is set to 2. When the length exceeds 180 ,̋ Support Quantity equals 3, and an 
additional support bracket is introduced via the array.

Blade Quantity is simpler. The conditional statement determines whether the depth is greater 
than 15.75 .̋ When the depth is larger (shown as 37˝), the number of blades is one more than 
Depth – 10˝ / 6. When the depth is less than 15.75 ,̋ there are only two blades.

Figure 11.35 shows how changing the length to 180˝ causes a new bracket to be added based 
on the formula. 

Figure 11.34 
Formulas used to 
control arrays.

Figure 11.35 
Different shade 
sizes evaluated via 
the formula. On 
the left, two sup-
ports are added. 
On the right,  
three supports  
are added.
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Making a parametric Sunshade

We constructed an advanced line-based family to model an exterior shading element. The family 
uses arrays with a formula to capture the design intent regarding the number of blades, proper 
support spacing, and blade angle. The resulting family can be quickly placed with two clicks, and 
the correct number of supports are placed. Note that the way this family is constructed, it must be 
placed in a plan view of the model. Once you place the family, you can experiment with different 
blade angles and numbers of blades in the system by changing a few properties:

Building a Parametric 3D Family
In this exercise, you’ll assemble a furniture ensemble consisting of a round table surrounded by 
chairs (see Figure 11.36). To accomplish this, you’ll do the following:

Nest families•u	

Create an array•u	

Use a formula to lock in design intent•u	

Use parameter linking to control element visibility•u	

Figure 11.36 
Table family with 
nested chairs.
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nesting tHe cHair

To nest a chair into the table family so the whole family works as a unit, follow these steps:

 1. Open Table Round.rfa from the Chapter 11 folder of the book’s companion web page 
(www.sybex.com/go/masteringrevit2010).

 2. Open the Ref. Level plan view using the Project Browser, and fit the view to the screen.

 3. Choose Load Family from the Insert ribbon and load Chair-Breuer.rfa from the 
Chapter 11 folder.

 4. Activate the Component tool on the Create ribbon. The active component in the Type 
Selector should be Chair-Breuer.

 5. Place a single instance of the chair, as shown in Figure 11.37. Use the spacebar to rotate 
the chair to face the table, and type SI to use the intersection snap override to snap the 
chair origin to the reference-plane intersection.

creating a Parametric array

Next, you’ll make the chair array become parametrically driven. Follow these steps:

 1. Click the Types command on the Create ribbon to launch the Family Types dialog box.

 2. In the Parameters group, click Add.

Figure 11.37 
Place an instance 
of chair in the table 
family.
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 3. In the Parameter Properties dialog box, enter the information shown in Figure 11.38 for 
the parameter, and click OK.

 4. Add a Radius parameter (Figure 11.39), and click OK.

 5. For the Radius parameter, enter the following in the Formula column: Diameter / 2. This 
ensures that the radius is half the diameter.

 6. For the Chairs parameter, enter the following in the Formula column:

(Diameter *3.14)/2´6˝

This formula sets the desired number of chairs relative to the circumference of the table.

 7. Select the chair instance you placed earlier, and select the Array tool. Change the array 
type in the Options bar from linear to radial. A red box appears around the chair, with a 
blue rotate control in the center. Drag the blue control to the intersection of the two refer-
ence planes at the center of the table to set the center of the array.

Figure 11.38 
Adding a new 
Chairs parameter.

Figure 11.39 
New Radius 
parameter added.
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 8. Define the start of the array by clicking at the origin of the chair, and then move your 
mouse into the Options bar area. Set the Move To radio button to Last, and enter 360 in 
the Angle field.

 9. Press the Enter key twice. Revit creates three chairs.

 10. To constrain the array to the radius of the table, activate the Dimension tool, and choose 
the Radial placement method from the Options bar:

 11. Hold the tool over the table edge, and press Tab until the status bar reads Array : Array. 
Click in any whitespace to finish the dimension.

 12. Select the dimension. In the Options bar, set the Label drop-down menu to the Radius 
parameter. This sets the radius of the array to match the radius of the table.

 13. Select a chair group, and then the array reference (the line that connects the chair groups 
and displays the array number). You may need to press Tab until you see the status bar 
read Array: Array.

 14. Once you make this selection, the number of chairs should change to match the value of 
the formula-driven Chairs parameter (Figure 11.40).

Figure 11.40 
Assign the array 
reference to the 
Chairs parameter.
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controlling VisiBility

To modify the family so that chairs can be made visible (or not visible) as part of the family defi-
nition, follow these steps:

 1. Click Types on the Create tab to open the Family Types dialog box.

 2. In the Parameters group, click Add.

 3. In the Parameter Properties dialog box, enter the data shown in Figure 11.41.

 4. Click OK.

 5. Select one of the chair groups, and choose Edit Group from the Group panel.

 6. Select the chair, and edit its element properties, either by right-clicking and using the 
context menu or by clicking the Element Properties from the Element panel.

 7. Under the Graphics group, find the Visible parameter. At the far right end of the row, 
click the small button to launch the Associate Family Parameter dialog box.

 8. In the dialog box, choose the displaysChairs parameter you created earlier.

 9. Click OK twice to dismiss the Associate Family Parameter and Element Properties dialog 
boxes; then, click Finish Group.

 10. Click the Types command to launch the Family Types dialog box.

 11. Choose the type 36˝ Diameter in the Type drop-down list at the top of the dialog box.

 12. At the right, in the Family Types group, choose New.

 13. Type in the name 36˝ Diameter no Chairs, and then click OK.

 14. In the Graphics group, select the displaysChairs parameter, and then Click OK to close 
the Family Types dialog box.

Figure 11.41 
Fill out the Param-
eter Properties 
dialog box as 
shown here.
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 15. Save the family. Choose Load into Project from the Create ribbon to view the completed 
family.

 16. You should have four types of families available. Place an instance of each to see the 
results (see Figure 11.42).

The Bottom Line

Model parametric 3D families.    When you’re making a new family, consider how it will be 
used in the model, and choose an appropriate template.

Master It    You found a ceiling-mounted lighting fixture that you want to use in your 
existing project, but you can’t find a Revit family for it in any libraries or online commu-
nities. How would you start?

Nest one family into another.    The ability to nest families in other families lets you create 
content that’s easier to manage and improves your workflow.

Master It    Building components are often composed of a series of subcomponents that 
form an overall assembly. Think of some common examples and what strategies you 
could use to build such content in Revit.

Build relationships between parameters with formulas.    Create smart connections 
between geometry and dimensions to create efficient and parametric content.

Master It    You can use dimensional relationships to tie the size of one object to the size 
of another. How do you do this in the context of a family?

Figure 11.42 
Finished family 
types placed in a 
project. All four 
types are dis-
played, illustrating 
the use of the array 
with the formula 
and the condi-
tional display of 
the chairs.

36˝ diameter, no chairs

36˝ diameter

60˝ diameter

84˝ diameter
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Chapter 12

Extended Modeling Techniques—
Walls

In the previous chapters, we covered basic modeling techniques for constructing a simple building. 
We skipped over many additional features to give you a handle on essential workflow, the user inter-
face, and modifications to the model. In this and the following two chapters, we’ll cover advanced 
features that are available any time you’re modeling in Revit. As you’ll see, with a little refinement 
and creativity, you can create a wide range of building components with the standard tools.

In this chapter, you’ll learn to:

Use advanced modeling techniques for standard walls•u	

Use advanced modeling techniques to create stacked walls•u	

Use advanced modeling techniques for curtain walls•u	

Using Advanced Modeling Techniques for Standard Walls
Walls are made from layers of materials that represent the construction assemblies used to build 
real walls. In Revit, these layers can be assigned functions that allow them to join and react to 
other similar layers, so that when walls, floors, and roofs meet you get the expected representa-
tion. The wall core is one of these special layers, and understanding its behavior will help you 
when designing and editing your walls.

Wall Core
Revit has a unique ability to identify a wall core. As you will see, this core is much more than a 
layer of material. Every wall type in Revit has a core material with a boundary on either side of 
it. The core (the layers between the two boundary lines) defines the structural part of the wall 
and influences the behavior of the wall and how it interacts with other elements in the model. 
The core of a wall creates references to which you can dimension, designating the location of 
structural wall components as separate from the finish materials. The core boundary can also 
be used as the location definition when drawing host elements (walls, floors, ceilings, roofs). For 
example, you can constrain a floor sketch to the structural stud layer of walls by using the wall-
core boundary to create the sketch. If walls change size or types are swapped, the floor sketch 
maintains its relationship to the core boundary and will automatically adjust to the new wall.

To access and edit wall-core boundaries and material layers, select a wall and choose Element 
Properties  Edit Type. In the Type Properties dialog box, select Structure as the parameter to 
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edit. This will open a new Edit Assembly dialog box. From here you can add or delete wall lay-
ers, define their materials, move layers in and out of the core boundary, and assign functions to 
each layer (see Figure 12.1).

To get a feel for how core layers are used in relation to a floor, start a new session of Revit and 
follow these steps:

 1. Open a new project, select the Wall tool from the Basic tab in the Design bar, and draw 
a simple rectangular floor plan. Prior to drawing it, from the Type Selector select a mul-
tilayered wall type in order to understand the value of the exercise—the Brick on CMU 
wall type works well. Draw at least four connected walls that represent a simple floor 
plan.

 2. Use the View Control bar to switch to fine or medium detail view so you can see the wall 
layers. (In coarse views, wall layers are never displayed.)

 3. On the Home tab, select the Floor tool, and from the Draw panel keep the default Pick 
Walls option, and on the Options bar, check the Extend into Wall (to Core) option.

 4. Position your cursor over an edge of the wall (do not click yet), press Tab to highlight all 
connected walls, and then click to select, and then zoom in. A boundary line indicating 
the shape of the floor will be created. This line indicates the position of the floor bound-
ary relative to the wall—it’s drawn at the exterior edge of the wall core. Make sure you’ve 
selected all walls as a reference to create the floor and click Finish Floor.

Figure 12.1 
The Edit Assembly 
dialog box of a 
wall type lets you 
define the con-
struction layers  
of a wall.
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 5. Create a section through the wall and open the section view. Again, make sure your view 
level of detail is set to medium or fine. You’ll see the edge of the floor and how it aligns 
with the wall construction. Figure 12.2 shows the sketch in plan and how the floor looks 
when finished in section.

If you change the wall type later on or move its position, the floor will update to maintain its 
position relative to the wall’s new core position.

Layer Join Cleanup
Having clean and legible drawings is important when representing construction design intent. 
To this end, Revit provides a wall layer priority system that intelligently manages the cleanup of 
wall layers between touching and/or intersecting multilayered walls. Revit provides six func-
tions (levels of priority), with Structure having the highest priority (Figure 12.3).

When you create a new wall type and begin defining and adding layers to the wall, you need 
to assign a material, thickness, and priority to those layers. When you’re assigning a priority, 
think about the function of the layer in the wall—is it finish? Substrate? Structure? This decision 
will help Revit understand your intent and help clean up your wall joins down the road.

Figure 12.2 
Floor sketch  
indicated in plan 
view (left), and 
section through 
the floor and the 
wall (right).

Figure 12.3 
Each wall layer has 
a function.
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Editing Wall Joins
If you encounter situations in which the automated wall cleanup doesn’t correspond to your 
expectations, a tool is provided that allows you to cycle through a range of possible layer con-
figurations using the Wall Joins tool, located on the Modify tab.

With the Wall Joins tool, you can edit wall join configurations. The default wall join is set to 
butt join (see Figure 12.4). Activate the Wall Joins tool, and place your cursor over a wall join. 
(This can be a corner where two walls meet.) The Options bar shows some alternative configura-
tion options: Miter and Square. A miter join is also shown in Figure 12.4.

Disjoining Walls
In some cases, you will want to override the intelligent wall cleanup that Revit provides. For 
example, a nonrated partition should not interrupt the gypsum board in a fire-rated wall. The 
Disallow Join option lets you create this condition. To access this command, right-click the blue 
control dot at the end of any wall and select Disallow Join from the context menu. Doing so 
breaks the auto-join cleanup. Figure 12.5 shows the default cleanup (left) and the same join after 
disallowing the join and adjusting the wall end (right).

A wall on which Disallow Join has been applied displays an Allow Join symbol upon selec-
tion (Figure 12.6). This is to give you a visual aid so you know when a wall has been explicitly 
set to not join. Note that the symbol only appears when a single wall has been selected.

Figure 12.4 
A butt wall join 
(left) and a miter 
wall join (right).

Figure 12.5 
The Disallow Join 
option provides 
extra flexibility 
in controlling the 
wall joins.
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Stacked Walls
Walls in a building, especially exterior walls, are often composed of different wall types, made 
out of different material combinations and with different widths that stack one on top of another 
over the height of the façade. At the very least, most walls sit on top of a foundation wall. You 
can create such walls by creating individual walls of different types at different heights, but if 
you want an intelligent relationship among all different wall types that make up one wall and 
that act together as one wall (for example, the foundation wall moves and you expect walls on 
top of the foundation to also move), a stacked wall might be a good way to go.

Stacked walls allow you to create a single wall entity composed of different wall types 
stacked on top of each other. In order for you to construct stacked walls, some basic wall types 
need to already be defined in your project. To understand how stacked walls work and how to 
modify one, follow these steps:

 1. Open a new session of Revit, and make sure three levels are defined. (If you don’t have 
three levels defined, switch to an elevation view, add a few new levels, and then go back 
to your floor plan view.)

 2. Pick the Wall tool on the Home tab and select Stacked Wall: Exterior - Brick Over CMU w 
Metal Stud located at the bottom of the list in the Type Selector, as shown here:

Figure 12.6 
The Allow Join 
option indicates  
a wall that has  
Disallow Join 
applied to it.

The Allow 
Join Toggle
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 3. In the Element Properties dialog box, click the Edit Type button and then duplicate the 
wall type to create a new stacked wall.

 4. Edit the structure parameter and click the Preview button to see the wall in section 
(Figure 12.7). When you’re editing the Stacked wall type, you’ll notice that the user inter-
face is slightly different from when you’re working with a basic wall. Rather than editing 
individual wall layers, in this dialog box you are editing Stacked wall types.

 5. Click the Insert button to add a new wall. A new row appears in the list and allows you 
to define a new wall. Select the Generic wall type from the Name list, and set the Height 
value. With a new row selected, click the Variable button. This will allow the wall to vary 
in height to adjust with level heights. Click OK in each dialog box to return to drawing 
the wall.

 6. Go back to your level 1 plan view and draw the new wall, setting its top constraint to 
Level 3 using the Options bar.

 7. Cut a section through the model and change the heights of Level 1 and Level 3 to see 
the effect this has on the wall. (Make sure the level of detail is set to medium or fine so 
you can see the wall layers.) You’ll see that changing Level 2 does not change the bottom 
walls because they are fixed in height. However, changing the height of Level 3 changes 
the height of the variable wall (Figure 12.8).

Adding Wall Articulation
Walls are often complex and articulated in their composition. Cornices, reveals, corrugated 
metal finish, and other projections are used all the time. Some wall finishes have more than one 
material on them, and they can be flush or of different thickness. Revit can accommodate any of 
these types of design articulation in smart wall assemblies. Some examples of such walls, called 
“compound walls” by many Revit users, are shown in Figure 12.9.

Figure 12.7 
Section preview of 
stacked wall type.
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From the Edit Assembly dialog box of any basic wall type, you can enable a preview of the 
wall. This preview allows you to view the wall in either plan or section. When the section pre-
view is active, additional tools also become active and allow you to place geometric sweep and 
reveal components on the wall (Figure 12.10).

Figure 12.8 
The middle section 
of this stacked wall 
varies on a per-
instance basis.

Figure 12.9 
Compound verti-
cal walls: (A) brick 
wall with horizon-
tal sweeps, reveals, 
and a top finish; 
(B) compound wall 
with aluminum 
corrugated finish, 
trapeze-shaped; 
(C) compound wall 
with aluminum 
corrugated finish 
curved; (D) com-
pound wall with 
slanting wall finish.

A B

C D
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ExamplE: assigning Two DiffErEnT maTErials on ThE final finish of a wall

Now, imagine a case where you need to create a wall that has two different material finishes 
that are flush aligned, as seen in Figure 12.11.

 1. Select a multilayered wall as a base and duplicate it to create a new wall type.

 2. In the wall’s Edit Assembly dialog box, switch the view to show a section view of  
the wall.

Figure 12.10 
With section view 
active, tools for 
modifying the 
vertical structure 
become active.

Figure 12.11 
Exterior wall layer 
built of two different 
materials arranged 
vertically.
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In this exercise, the exterior wall layer is plaster, but what you need is the lower 4˝ (120cm) to 
be brick and to keep the walls flush with one another.

 3. Place your cursor at the beginning of the exterior finish layer. This highlights the wall 
component in the section preview. Select the Split Region tool and split the layer at the 4˝ 
(120cm) height (Figure 12.12).

 4. The moment you split the layer, you will notice that the Finish layer reports a thickness of 
0.00, meaning that it is variable.

 5. Add one more layer. Use the Insert button and add that layer right after the first exterior 
finish layer. Change its function to Finish 1, its material to Brick, and its thickness to 0.

Figure 12.12 
The Split Region 
tool applied to the 
exterior layer.
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 6. Place the cursor at the front of the row of the new material and select it. This highlights 
the material and shows a thin red line in the section view (Figure 12.13).

 7. After adding that layer, click the Assign Layer button and select the portion of the wall 
that you wish to assign the zero thickness layer to (in this example, the lower portion).

The result is that the selected portion of the wall has the new layer assigned and your wall 
exterior face shows two different materials.

While working on a complex compound wall, you might have a situation where you need to 
merge horizontal or vertical wall layers that already exist in the wall. For that, use the Merge 
button and select the line between two layers. Once the cursor is over a line between two lay-
ers, an arrow indicating which layer will override the other one during the merge shows up, as 
shown in Figure 12.14.

Figure 12.13 
Highlight the  
lower portion of 
the split wall layer 
to assign a new 
material to it.

Figure 12.14 
(A) Merge layers 
vertically;  
(B) merge layers 
horizontally.

A B
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Wall Wrapping
Materials are detailed at insert conditions (where doors, windows, and openings are placed in 
walls) depending on the construction type, building conventions, and aesthetics. For this pur-
pose, Revit provides Layer wrapping options in the wall Edit Assembly dialog box; however, 
they aren’t sufficient to accommodate a complex wrapping situation specific to a particular door 
or window. To achieve more control over these construction conditions, you need to set param-
eters in the window or door family itself.

In the Family Editor, you can assign a Wall Closure property to reference planes. This param-
eter defines a plane in the window family to which wall layers can wrap to.

In a door or window family, check the option Wall Closure in the Element Properties dialog 
box for the reference plane. This means that the exterior wall layers that have wraps assigned 
will terminate at this reference plane. The effect can be seen in Figure 12.15.

Sweeps and Reveals
Many walls have linear embellishments that are attached or embedded in the construction. 
Cornices, brick soldier courses, and reveals are all examples. Using basic walls, you can add 
these elements directly into wall types.

Clicking the Sweeps or Reveals button in the Edit Assembly dialog box opens a new dialog 
box where you can define profile families to use as sweeps or reveals.

These are 2D shapes made out of simple lines and then swept along the length of the wall 
at a specified height. Many profiles representing cornices, skirting, and chair rails ship with 
Revit, but if you need to create a custom profile, you can use the Profile Family template. Open 
the Application Menu and choose New  Family to access the Revit Family Editor templates. 
Choose a default Profile template. From here, you draw a single closed loop of lines at the desired 
real-world scale and load the profile back into your project. Be sure to use dimensions to verify the 
size of your profile. Follow these steps to get a feel for the workflow.

 1. Click the wall tool from the Home tab, then click the Type Properties button in the 
Element Types dropdown menu, and then duplicate the type.

 2. Open the Wall Assembly dialog box.

Figure 12.15 
(A) The reference 
plane in the Family 
Editor, and (B) its 
effect when set to 
Wall Closure.

A B
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 3. In the preview view, switch to section view. The six Modify Vertical Structure options 
become active at the bottom of the dialog box.

 4. Click the Sweeps button to bring up the Wall Sweeps dialog box, shown in Figure 12.16.

 5. Click the Load Profile button, browse to the Profiles folder, and load these two profiles:

Cornice profile: Traditional (1)•u	

Skirting profile: (Base 2, Ogee or similar)•u	

 6. Click the Add button. This adds a row in the dialog box that lets you select one of the 
loaded profiles and set its position relative to the wall geometry.

 7. Add both profiles. Set the Traditional profile’s From value to Top and the Ogee profile’s 
From value to Base. Doing so attaches the profiles to the top and bottom of your wall. 
Figure 12.17 shows the profiles attached to the top and bottom of the wall.

 8. Click OK. Draw a segment of this wall in the drawing area. Check out the wall in section 
and 3D views to see the result (see Figure 12.17).

Using the same principles outlined for adding traditional elements, you can get creative and 
add any type of profile you want. Figure 12.18 shows a wall with corrugated siding added as an 
integrated wall sweep.

Figure 12.16 
The Wall Sweeps 
dialog box before 
inserting any  
profiles.
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Figure 12.17 
Profiles attached to 
wall top and base.

Figure 12.18 
Wall with cor-
rugated siding 
created with inte-
grated wall sweep.
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rEvEals

Reveals can be added to a wall using the same workflow you use with sweeps; the only differ-
ence is that the profile is subtractive rather than additive.

wall swEEp rETurns

When you’re working on traditional architectural projects, the wall sweeps usually wrap around 
door openings in thick walls. Revit can accommodate that using the Change Sweep Return com-
mand. To understand this feature, follow this simple exercise:

 1. Open a new session of Revit and place a generic wall. Switch to the default 3D view.

 2. Rather than placing a sweep in the wall type (as we just did), you can use another 
method for placing sweeps: the Wall Sweep tool located in the Wall drop-down list. 

These sweeps can be placed either vertically or horizontally using the contextual ribbon.

 3. Add a horizontal sweep to the middle of the wall. Use the temporary dimensions to place 
the sweep at the desired height.

 4. Choose the Wall Opening tool, located on the Modify tab.
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Select Wall Opening, and using this tool, draw an opening that intersects the sweep 
(Figure 12.19).

 5. Select the sweep—it will display a blue grip at the end (the edge of the opening). Click 
the Modify Returns button in the Modify Sweeps contextual tab. Also take notice of the 
Options bar, where you can also set the angle of the return or decide to make a straight 
cut. The cursor turns into a knife symbol, and when you click somewhere on the profile it 
creates a new segment that can be wrapped around the edge of the opening. Press Esc or 
use the Modify tool to exit the command. You will need to zoom in close to the end of the 
sweep to really see the effect. (If you zoom very closely, the lines might become thick and 
ugly. In that case, click the Thin Lines Mode button on the View tab.)

 6. Select the sweep again, and drag the control to adjust the length of the sweep. 
Figure 12.20 shows how the return can be modified.

Figure 12.19 
A manually placed 
wall sweep inter-
sected by a wall 
opening shown in 
(A) perspective and 
(B) elevation.

A B

Figure 12.20 
Wall sweep 
returns.
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ExTEnDing wall layErs BEyonD ThEir BasE

In many construction scenarios, you need layers of materials to extend beyond the base 
of the wall. A typical example is the extension of sheathing and siding on an exterior wall 
(Figure 12.21). Letting layers extend requires you to unlock the bottom edges of the wall from 
the sectional preview in the Edit Assembly dialog box. Once the layers have been unlocked, 
an instance parameter of the wall becomes enabled, either Base Extension Distance or Top 
Extension Distance (depending on which edges you unlocked). This value can be entered 
directly in the Element Properties dialog box or adjusted graphically when you select the wall 
by dragging the small blue triangle control at the bottom of the unlocked layer.

Follow these steps to enable the Base Extension parameter of a wall:

 1. From the Home tab, create a new Wall. Select it and duplicate it by editing the type. Name 
it Exterior wood siding.

 2. Select the structure parameter to open the Edit Assembly dialog box.

 3. Add a new layer to the exterior of wall, set its function to Finish (4), use the material 
siding - clapboard, and give it 3⁄4² thickness.

 4. Open the preview and look at the section view. Zoom into the bottom of the wall.

 5. Select the Modify button located in the dialog box, and then click on the bottom edge of 
the exterior siding layer. Click the padlock icon to unlock the layer (Figure 12.22). Note 
that if you wanted to unlock additional layers, they all need to be adjacent—you cannot, 
for example, extend layers on either side of the core.

Figure 12.21 
Example of wall 
layers extending 
past the base of  
the wall.
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 6. The layer is now unlocked. Click OK twice to get back to the Instance Properties dialog 
box. You’ll see that the Base Extension Distance parameter is now enabled. Type in -10˝ 
for this parameter, and check the wall in 3D. You’ll see that the wood siding layer is now 
extending 10˝ below the level shown in Figure 12.23.

Figure 12.22 
Use the padlock 
icon to unlock  
layers.

Figure 12.23 
Modifying the wall 
layers to have a 
base extension.
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Creating Custom In-Place Walls
When you’re working on traditional architecture or restoration of historic buildings, you 
often need to create walls that are irregular in shape. The Model In-Place tool, found in the 
Component drop-down on the Home tab, lets you address such wall styles. Figure 12.24 shows 
an example. This tool allows you to draw solid geometry using one of four modeling meth-
ods. Each created form is assigned a specific category that is later used to control visibility and 
behavior in the model. For example, assigning a sweep to the category Wall allows the wall to 
host inserts such as windows and doors.

Using Blends to Make Nonstandard Wall Surfaces

The wall in Figure 12.24 was created using a series of blends assigned to the category Wall using 
the In-Place modeling method located in the Component tool on the Home tab. It still behaves like 
a wall: you can insert doors and windows into it; they will cut through the geometry and create 
openings. If you are making a wall schedule, you will also be able to schedule these walls and get 
correct documentation—very slick!

Various wall types can be created using this method. Consider the modeling tools we’ve covered 
previously and how you can use them to generate unique wall profiles. 

Figure 12.24 
Manually con-
structed wall used 
to create nonverti-
cal wall surfaces.

The finished wall The two wall blends combined 
to make the wall
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Using Advanced Modeling Design Techniques for Curtain 
Walls
Curtain walls in Revit are unique wall types that allow you to embed divisions, mullions, and 
panels directly into the wall. They have a distinct set of properties, but still share many charac-
teristics of basic walls. 

The curtain wall    A curtain wall is drawn like a basic wall and is available in the Type 
Selector when the Wall tool is active. It has top and bottom constraints, can be attached to 
roofs, can have its elevation profile sketch-edited, and is scheduled as a wall type.

Curtain grids    These are used to lay out a grid that defines the physical divisions of the cur-
tain wall. The layout grid can be designed freely as a combination of horizontal and vertical 
segments or can be a type with embedded rules that specify regular divisions. Figure 12.25 
shows a typical grid division and expressive curtain panels in between.

Mullions    These represent the metal profiles on a glass façade, and in Revit they follow 
the geometry of the grid. They can have any shape that is based on a mullion profile family. 
Mullions can be vertical or horizontal. If you have a playful spirit, however, you can make 
curved mullions as shown on Figure 12.26. 

Figure 12.25 
Curtain wall with 
regular orthogonal 
grids and expres-
sive curtain panels.

Curtain grids

Mullions

Curtain panels
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Curtain panels    These fill in the space between gridlines and are always one of the 
following:

Empty panels    No panel is placed between the grids.

Glazed panels    These can be made out of different types of glass that can have any color 
or transparency.

Solid panels and panels with wall types    These can take on any geometry you wish 
and thus create the most interesting structures, like the one shown in Figure 12.26.

Wall types as infill    You can also choose from the Type Selector a wall type to fill the 
space between the gridlines (mullions). All wall types in the project will be available for 
your selection. Adding a wall type is usually a typical case in office partitions where the 
lower portion is a parapet wall and glass fills the upper portion of the metal stud wall.

Designing a Curtain Wall
In this exercise, we’ll walk through the creation of a simple curtain wall. To draw a curtain wall, 
you can either draw a standard wall and then change its type to Curtain Wall or select a Curtain 
Wall type from the Wall Type Selector first. Follow these steps:

 1. From the Home tab, select the Wall tool.

 2. From the Type Selector, select Curtain Wall 1.

 3. In the Level 1 plan view, draw a simple curtain wall (Figure 12.27). Use the wall type 
Curtain Wall 1.

Figure 12.26 
With a little bit of 
inventive spirit, 
you can have 
curved mullions  
as well!
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 4. Toggle the view to see the result in 3D.

 5. Divide the wall into panels using the Curtain Grid tool on the Home tab. Position your 
cursor over the edges of the wall to get a preview of where the grid will be placed. 
(Selecting a vertical edge places a horizontal grid, and selecting a horizontal edge allows 
a vertical grid.) Revit has some intelligent snapping built into grid placement that looks 
for midpoints and points that will divide the panel into thirds. Place the grid so that you 
get something like Figure 12.28.

Figure 12.27 
A generic curtain 
wall before adding 
any grids or mul-
lions looks like a 
simple glass wall.

Figure 12.28 
Curtain wall with a 
few added grids.
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 6. Place mullions on the wall. You can place one mullion at a time by selecting separate grid 
segments. If you want to apply the same mullion on all segments, hold the Ctrl key and 
click a gridline to select all segments and apply the mullions. With mullions placed, your 
wall should look like Figure 12.29.

 7. Let’s say you want to add more mullions, but this time you don’t want them to extend the 
entire height of the curtain wall. Select the Curtain Grid Line tool on the Home tab, and 
place new grids (Figure 12.30).

Figure 12.29 
Mullions applied  
to the grids on a 
curtain wall.

Figure 12.30 
To add more mul-
lions, you will  
need to add 
another grid.
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 8. Before applying a mullion to the new gridline, delete the segments of the gridline where 
you don’t wish the mullion to occur. (You can also add grid segments that don’t span the 
entire panel. This may be faster than creating a long grid and then deleting the segments 
you don’t want.) Close the Curtain Grid tool, and select the newly created gridline. Click 
the Add or Remove Segments button in the contextual tab and click the segment you 
want removed. 

Remove the top and bottom segments, and then add mullions (Figure 12.31).

Curtain Panels
Curtain panels fill the space between the curtain grids and mullions. These elements are cre-
ated in the Family Editor using the Curtain Panels family template. Access them by choosing 
Application Menu  New  Family  Curtain Wall Panel.rft. The Revit default template has a 
couple of curtain panels preloaded: System Panel Glazed and System Panel Solid. You can dupli-
cate different types of these families and change the material, thickness, and offset to customize 
the appearance.

Figure 12.26, earlier in this chapter, shows some very creative curtain panels.

Figure 12.31 
Removing portions 
of the grid and 
applying a mullion 
on the remaining 
segment of the grid.
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sElEcTing ThE ElEmEnTs wiThin ThE curTain wall

Revit provides specially tailored selection options in the context menu to aid with workflow and 
interaction when you’re working with curtain walls.

When you hover the mouse over or select an element in a curtain wall, take note of the status 
bar in the lower-left corner of the screen: it tells you exactly the type of element you’re about to 
select or have already selected. Depending on what the mouse is hovering over, various selec-
tion options are available. The elements you can select include the following:

The entire curtain wall entity (indicated by a green dashed line surrounding the  •u	

curtain wall)

A gridline•u	

A mullion•u	

A curtain panel•u	

To select the element you want, use the Tab key until that element is highlighted.

Curtain Wall Doors and Windows
Curtain walls can host specially designed doors and windows. Keep in mind that standard 
doors and windows cannot be hosted by a curtain wall. These specially designed elements 
are recognizable in the library by a name that indicates they are curtain wall doors or win-
dows. Revit schedules them as doors and windows, but their behavior is dependent on the 
curtain wall. Curtain wall doors and windows adapt their width and height to fill in grid cells. 
Essentially, they behave exactly like panels—they’ve just been made to appear and schedule 
as doors or windows. To insert a door within a curtain wall, choose Component  Load from 
Library  Load Family. Navigate to the Doors folder, and select a curtain wall door (single or 
double). Figure 12.32 shows a curtain door panel that has been swapped with a glazing panel. To 
make your own doors, select the Application Menu  New  Family  Door - Curtain Wall.rft.

Figure 12.32 
A special curtain 
wall door family  
is used to represent 
a door within a 
curtain wall.
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Complex Curtain Wall Panels
Look at the complex-shaped curtain panels in Figure 12.33. You may think, “Oh, I can never do 
that!” Well, Revit can help you do it—and do it easily. The creation principle behind any of these 
types of curtain walls is the same as you learned in Chapter 10. By being smart about nesting 
and linking parameters, it is possible to build sophisticated curtain panel families.

Figure 12.33 
Complex curtain 
wall panel example 
using a series  
of nested  
components.
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The Bottom Line

Use advanced modeling techniques for standard walls.    Many design situations require 
more than just the basic wall features; learn to use the more advanced Revit tools.

Master It    A design calls for a horizontal soldier course in a brick wall every 12˝ on the 
façade. Using Revit, how would you build this into a wall element?

Use advanced modeling techniques to create stacked walls.    Walls along a building façade 
usually have different construction layers from foundations to the top of the building. Stacked 
walls allow for a single wall to be constructed with varying wall types along its height.

Master It    You have a building project where you are still experimenting with a number 
of floors but have already defined the wall types for the foundation, typical floor, and the 
attic and have combined them in a stacked wall type. How do you define the stacked wall 
so that it will accommodate middle floors with varying heights?

Use advanced modeling techniques for curtain walls.    Curtain walls find their way into 
many architectural projects and designs. Knowing how to manipulate curtain walls in Revit 
is a key piece of the software for many design solutions.

Master It    You’ve got to add a doorway to a storefront façade you’ve made. How would 
you go about doing this?
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Chapter 13

Extended Modeling Techniques—
Roofs and Floors

In the previous chapters we covered basic modeling techniques for constructing a simple build-
ing. We skipped over many additional features to give you a handle on essential workflow, the 
user interface, and making modifications to the model. In this chapter we cover more advanced 
features that are available any time you’re modeling in Revit. As you’ll see, with a little refinement 
and creativity, you can create a wide range of building components using the standard tools.

In this chapter, you’ll learn to:

Understand the various roof creation methods•u	

Create all kinds of roofs•u	

Work with advanced roof and floor shape editing•u	

Understanding the Various Roof Creation Methods
In real life, roofs can come in many shapes, sizes, and degrees of complexity. They can be as 
simple as a single-pitch shed roof, or they can involve complex sine curves or intersecting vaults. 
Once you understand Revit’s primary concepts, logic, and tools, you will be able to design just 
about any roof shape.

In general, roofs in Revit can be constructed in four different ways:

Roof by footprint    Use this method to create any standard roof that more or less follows the 
shape of the building footprint and is a simple combination of roof pitches.

Roof by extrusion    This method is best applied for roof shapes that are geometrically gener-
ated by extrusion of a profile, such as sawtooth roofs, barrel vaults, and waveform roofs.

In-place roof    This technique is used to accommodate roof shapes that cannot be achieved 
with either the footprint or extrusion methods. They are either done by using the general 
modeling techniques and applying a roof category to that geometry, or by using an under-
lying mass form.
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Roof by face     In this technique, you select faces of massing forms to create standard thick-
ness roofs. You can create those underlying massing forms within Revit, or import geometry 
created in other modeling applications into a mass family and use it as an underlay to create 
the roof by face. This technique is discussed in more detail in Chapter 8, “Concept Massing 
Study: Early Design Phase.”

The following sections provide a close look at these approaches and review their application 
to real-world scenarios.

Roof by Footprint
Use the roof by footprint method to create any standard roof that more or less follows the shape 
of the footprint of the building and is a simple combination of roof pitches (Figure 13.1).

These roofs are based on a sketched shape that you define in plan view at the soffit level and 
that can be edited at any time during the development of a project from plan and axonometric 
3D views. The shape can be drawn as a simple loop of lines using the Line tool, or can be created 
using the Pick Walls method, which also should result in a clean closed loop of lines. The latter 
means that the exterior walls are used to define the shape of the roof.

The best way to conceptualize the roof by footprint method is to understand that the sketched 
shape defining the main shape of the roof is just a simple, closed loop of lines—nothing more 
than that, regardless of whether it’s drawn or picked.

The Pick Walls method provides an intelligent selection method, so if you select walls as ref-
erences to generate the sketch lines, with or without an offset to the walls, the lines will maintain 
a smart relationship with the walls. The Pick Walls method is the suggested approach for creating 
roofs by footprint. By selecting the walls to generate the sketch for the roof, you are creating an 
exclusive relationship between the walls and the roof so that if the design of your building later 
changes (wall position, level height, wall height, etc.), the roof will follow that change and adjust 
to the new wall position without any intervention from you (Figure 13.2). Like any change in 
Revit, this happens everywhere in all views, and thus not only the model but also its entire 
documentation and related quantities will be updated. This will not automatically occur if you 
just drew the roof lines and did not explicitly create a relationship between them and the under-
lying walls.

Figure 13.1 
Simple roof  
created using the 
roof by footprint 
method.
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To guide you through the creation of roof by footprint and explain some of the main prin-
ciples and tools, here is a brief exercise demonstrating the steps:

 1. In a new project, open a Level 2 plan view and create a building footprint similar to 
Figure 13.3.

Figure 13.2 
Examples of using 
the Pick method: 
(A) original roof; 
(B) entrance 
wall position has 
changed and roof 
has been updated 
automatically; 
(C) angle of wall 
to right of the 
entrance has 
changed and roof 
has changed to a 
new shape.

A   

B   

C   

Figure 13.3 
Draw a simple set 
of walls.
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 2. From the Build panel in the Home tab, select the Roof tool. The default setting for the 
Roof tool when you click on the Roof button is Roof by Footprint. The other roof creation 
options as well some other roof-related tools are available when you expand the Roof 
button using the little arrow in the icon. 

 3. From the Draw panel in the Create Roof Footprint tab, select the Pick Walls tool (this 
should be the default).

 4. When you’ve chosen to create a roof by footprint, the Options bar makes the tools shown 
here available. 

To define whether you want a sloped or flat roof, use the Defines Slope check box in the 
Options bar. The Overhang parameter allows you to define the value of the roof overhang 
beyond the wall. When the Extend into Wall (to Core) option is checked, the overhang is 
measured from the wall core. If the option is deselected, the overhang is measured from the 
exterior face of the wall. 

 5. After defining these settings, place your cursor over one of the walls (don’t click). Press the 
Tab key. This will result in both automatic selection of all walls and automatic indication 
of the roof overhang around those walls. Once you see the entire roof overhang indicated 
around all walls, click with the mouse over the wall. The dashed lines indicating the over-
hang will turn into solid lines, confirming that the roof sketch is created. The lines will be 
offset from the walls by the value of the overhang that you defined in the Options bar. 
Your display should look like Figure 13.4.

 6. Click the Finish Roof button at the top right of the ribbon menu.

If at any time the shape of the roof doesn’t meet your expectations, you can select the roof 
and select Edit Footprint from the Edit panel in the Modify Roofs tab to return to sketch mode, 
where you can edit lines or sketch lines or the slope. 

Figure 13.4 
Roof sketch lines 
are automatically 
drawn offset from 
the walls by the 
value of the over-
hang as defined in 
the Options bar.
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To change the slope definition or angle of individual portions of the roof, select the roof, and 
then from the Edit panel, click Edit Footprint. This brings you back to Sketch mode; select the 
sketch line of the roof portion for which you wish to change the slope and either toggle (check) 
the Defines Slope button in the Options bar to remove or add a slope, or click the slope value 
that is displayed when you select the sketch line to change the slope angle. If you mistakenly 
made all roof sides with slope but wanted to make a flat roof, you can Tab-select all sketch lines 
that form the roof shape and clear the Defines Slope box in the Options bar.

Roof slope can be measured in different ways: it can be set as an angle or percentage rise. 
You can find all slope measuring options on the Manage tab by selecting the Project Units in 
the Project Settings panel and then selecting Slope (see Figure 13.5). If the current slope value is 
not expressed in the units you want to use (such as percentage when you want it to display an 
angle), you’ll need to change the slope units in the Format dialog box. (You will not be able to do 
this while editing the roof slope.) Setting it here means specifying the way you measure slopes 
for the entire project.

Here are some of the important instance properties you should be aware of and know how to 
set properly. All are found in the dialog box shown in Figure 13.6:

Base Level    As in other Revit elements, this is the level at which the roof is placed. The roof 
moves with this level if the level changes height.

Room Bounding    When this is checked, the roof geometry has an effect on calculating room 
area and volume.

Related to Mass    This property is active only if a roof has been created with the roof by face 
method (Conceptual Mass tools).

Base Offset from Level    This option lowers or elevates the base of the roof relative to the 
base level.

Cutoff Level    Many roof shapes require a combination of several roofs on top of each other. 
To do this, you need to cut off the top of a lower roof to accommodate the creation of the next 
roof in the sequence. Figure 13.7—in which the cutoff level is applied to the main roof and a 
secondary roof is built on top of the main roof using the cutoff level as a base—is an excellent 
example of this technique.

Figure 13.5 
Format dialog box 
for slopes.
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Cutoff Offset    When the Cutoff tool is applied, the Cutoff Offset value also becomes active 
and allows you to set the cutoff distance from the level indicated in the Cutoff Level parameter.

Rafter Cut    This defines the eave shape. You can select from Plumb Cut, Two Plumb Cut, 
or Two Plumb Square. When Two Plumb Square is selected, the Fascia Depth parameter is 
activated and you can set the value for the depth.

Rafter or Truss    With Rafter, the offset of the base is measured from the inside of the wall. 
If you choose Truss, the plate offset from the base is measured from the outside of the wall. 
Figure 13.8 is a typical example of a roof by rafter cut.

Figure 13.6 
Roof Properties 
dialog box.

Figure 13.7 
The cutoff level is 
applied to the main 
roof, and a second-
ary roof is built 
on top of the main 
roof using the cut-
off level as a base.
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Roof by Extrusion
The roof by extrusion method is best applied to roof shapes that are generated by extrusion of 
a profile, such as sawtooth roofs, barrel vaults, and waveform roofs. Like the roof by footprint 
method, it is based on a sketch; however, the sketch that defines the shape of the roof is drawn 
in elevation or section view (not in plan view) and is then extruded along the plan of the build-
ing (see Figure 13.9).

Figure 13.8 
Construction 
drawing of a  
rafter detail.

Figure 13.9 
A barrel-shaped 
roof extended 
with sunshades. 
The main roof is 
an extruded arch 
sketch.
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The Roof by Extrusion tool offers additional settings in the Options bar when selected.

Roofs by extrusion do not have an option to follow the building footprint, but that is often 
needed to complete the design. To accommodate this, a special tool called Vertical Opening is 
provided. This tool is available when you select Roof by Extrusion from the Modify Roof panel 
on the Modify tab.

Here’s a brief explanation of how the tool works. First you create your roof by extrusion by 
defining a profile in elevation that is then extruded above the building. The extrusion follows 
a straight path, which probably is not the same as the building footprint (unless your building 
footprint is also a straight rectangle in shape). If the shape of the building is nonrectangular in 
footprint or the shape of the roof you want to create is not to be rectangular, this tool will let you 
carve geometry from the roof to match the footprint of the building or get any plan shape you 
need using a plan sketch.

You will recall that with sketch-based design, any closed loop of lines creates a positive shape, 
every next loop inside it is negative, the next one inside that negative one is positive, and so on. In 
Figure 13.10, a roof by extrusion was drawn at an angle to the underlying walls, but the final state 
should not extend beyond those walls. To clip the roof to meet the walls, the Vertical Opening 
tool was used to draw, in plan view of the roof, a negative shape that will remove the portions of 
the roof that extend beyond the walls.

Figure 13.10 
The Vertical  
Opening tool 
applied in plan 
view to an 
extruded roof  
to follow the  
exterior shape of 
the building.

C. Resulting roof

A. Extrusion roof drawn at an angle
B. 2 Vertical Opening sketch lines drawn: rectangular 
   around the walls and a circular big one around it to cut 
   off the unneeded roof.
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Roof-in-Place
The roof-in-place technique accommodates roof shapes that cannot be achieved with either of the 
previously mentioned methods. It is the usual way to model historic roof shapes or challenging 
roof geometries such as domes and onion-domed roofs (see Figure 13.11).

Here’s the concept: you create a geometry using the Component tool found in the Home tab and 
select Model In-Place; then you can assign a roof category to it, and go wild with your creativity.

To start an in-place roof family, click the Component tool in Build panel of the Home tab. 
Select Roofs from the Family Category list (Figure 13.12), and click OK. This list allows Revit to 
assign a specific category (Roof in this case) to your in-place model and thus later schedule the 
new element as a roof.

You can create any roof shape using Solids and Voids and the modeling techniques of 
Extrusion, Blend, Revolve, Sweep, Swept Blend, or any combination of them (see Figure 13.13). 
There is a lot more information about some advanced shape-editing techniques later in this 
chapter, in the section “Working with Advanced Roofs and Floor Shape Editing.”

Figure 13.11 
Manually  
constructed  
in-place roofs.

C. Traditional Russian onion dome (Revolve)

A. Barrel roof finishing with half dome 
 (Extrusion + 1/2 Revolve)

B. Dome roof (Revolve only 
 or Revolve + Extrusion)
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Sloped GlazinG

You saw earlier that a curtain wall is just another wall type made out of panels and mullions 
organized in a grid system. Similarly, sloped glazing is just another type of roof that has glass 
as material and mullions for divisions. Using sloped glazing, you can make roof lights and shed 
lights, and use them to design simple framing structures.

To create sloped glazing, make a simple pitched roof, select it, and use the Type selector avail-
able upon selection of the Change Element Type tool to change the type to Sloped Glazing. Once 
you have done that, switch to a 3D view and use the Curtain Grid tool to start applying horizontal 
or vertical grids that define the panel sizes; then you can apply mullions. Figure 13.14 demon-
strates the process of converting a standard roof into sloped glazing.

Figure 13.12 
Set the category for 
an in-place roof.

Figure 13.13 
Organic-shaped 
roof created using 
the Swept Blend 
modeling  
technique.
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Figure 13.14 
(A) Standard roof. 
(B) Convert a 
standard roof into 
sloped glazing.  
(C) Divide with 
curtain grid. 
(D) Add mullions 
to the grid.  
(E) Finish applying 
all mullions to the 
grid. (F) Change 
curtain panel from 
glass to empty. 
(G)  Finished  
rafters.
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Creating a ridge Skylight roof

Suppose we are planning a factory whose roof needs to be a ridge skylight on a pitch.

Here’s how to make this roof:

 1. In Level 1, draw the floor plan of the building. For the sake of simplicity, we will assume that 
the floor plan is a rectangle.

 2. Switch to any elevation view and define two new levels in the drawing: Level 2 at 12́  (4m), and 
Level 3 at 18´ (6m).

 3. Switch to Level 2 and from the Home tab on the Build panel, expand the Roof tool. 

 4. Select Roof by Footprint.

 5. Click the Pick Walls tool from the Draw panel. 

 6. In the Options bar, define an Overhang setting of 1́ 6˝ (50cm), and check the Defines Slope 
option.

 7. Click Finish Roof (at the far right of the Create Roof Footprint tab).
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Once you complete these steps, this is how the resulting roof should look:

We now need to cut the top of this roof at Level 3.

 1. Select the roof and, in its instance properties, select Level 3 under Cutoff Level and –1́ 8˝ (–57cm) 
for Cutoff Offset (the roof thickness value); then click Finish Roof. The result looks like this:

Next, we’ll create the second roof and use the opening in the first roof as a reference for the sketch 
lines defining the new roof:

 1. Switch to Level 3 and select the Roof by Footprint tool. Instead of selecting the Pick Walls option 
from the Draw panel, select the Pick Lines tool, right next to it.
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 2. You will notice a Lock option in the Options bar. When checked, this option will lock the 
newly generated lines to the lines of the lower roof that you use as a reference. Check the Lock 
option. 

 3. Now select the four edges of the opening of the first roof: this results in the creation of four new 
rooflines for the upper roof that have a relationship with the lower roof sketch lines indicated 
by the four closed padlocks. 

 4. Click Finish Roof.

You just created the upper roof but also a relationship between the two roofs. That way, if you 
later change the cutoff level or the geometry, the second roof will change to match the new 
cutoff level.

 5. Select the newly created roof, and select the Change Element Type tool to open the Type Selector. 
From there, pick Sloped Glazing to get the following configuration:

If the slope of the upper roof isn’t what you desire, you can change it at any time. Select the 
roof, click Edit Footprint in the Edit panel of the Modify Roofs tab, click each of the sketch lines, 
and type in a new value over the slope value displayed. In this example, we have set 9˝ for the 
upper roof (the skylight).

 6. Divide the sloped glazing into segments and apply mullions. For that, use the Curtain Grid tool 
located in the Build panel of the Home tab and start dividing the glazing.
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 7. Add mullions by selecting the Mullion tool from the same Build panel and picking the gridlines 
on the glazing. The final outcome should be similar to this:

Sloped arrowS

Another way to slope a roof is by manually adding slope arrows to a sketch of flat roof slabs. 
This can be useful for unusual shapes, especially if the roof edges are not straight.

First create the sketch lines to define the shape of a roof, and do not check Defines Slope on 
the Options bar. Instead, choose the Slope Arrow tool from the Draw panel of the Modify tab. 
Draw the slope arrow in the direction you want your roof to pitch and at the intended height 
between the base of the roof and sloped end (see Figure 13.15).

Once you’ve drawn the slope arrow, you can select it, and click on the Properties button in 
the Draw panel to open the Instance properties dialog box and set any of the parameters shown 
in Figure 13.16. The most critical parameter to check is Height Offset at Head. This defines the 
height of the roof slab from the base to the top of its slope.

Figure 13.15 
A slope-defining 
arrow is added to 
the sketch in Roof 
by Footprint.
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To create a shed roof, you can draw a roof without any slope-defining sides and then apply a 
slope arrow that defines the exact sloping (see Figures 13.17 and 13.18).

Figure 13.16 
Slope arrow  
properties.

Figure 13.17 
A shed roof defined 
using the Slope 
Arrow tool.

Figure 13.18 
The same roof, 
with the slope 
arrow shortened. 
Note that the roof 
became much 
steeper.
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Creating All Kinds of Roofs
The following section demonstrates a series of typical roof conditions and the appropriate strat-
egy to use in Revit to create these roofs. For any roof, there can be many ways to solve it geo-
metrically. You can use this section as a guide and to shore up your skills with the roof tools and 
methods described previously in this chapter.

Each roof in the typology is represented with the roof plan view, sketch plan, and 3D view of 
the roof.

Flat Roof
We created this flat roof using Roof by Footprint and the Pick Walls tool; we also unchecked 
Defines Slope on the Options bar.
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Gable Roof with Asymmetric Slopes
We also created this roof using Roof by Footprint and the Pick Walls tool. But in this example 
we checked Defines Slope for the shorter sides of the roof, and the slope angles are not identical.
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Shed Roof
We created this Roof by Footprint by using the Pick Walls tool and checked Defines Slope for 
only one of the short sides of the roof.
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Note that you could also make this same roof by adding a Slope arrow to a flat roof:

Hipped Roof
We created this Roof by Footprint by using the Pick Walls tool, and Defines Slope was checked 
for all sides of the roof.
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Hip Roof Following Recessed Walls
We created this Roof by Footprint by using the Pick Walls tool. Defines Slope was checked for 
all sides of the roof except the three walls that recess toward the inside.
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Gable Roof
We created this Roof by Footprint by using the Pick Walls tool and checking Defines Slope for 
all sides of the roof but not for the one that recesses toward the interior of the building.
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Gable Roof with Extending Pergola
This Roof by Footprint was created over a rectangular floor plan using the Pick Walls tool. We 
then edited its sketch and included additional sketch lines to shape the extension. We checked 
Defines Slope only for the sides indicated in the sketch.
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Hip and Gable Hybrid Roof
We created this Roof by Footprint by using the Pick Walls tool with Defines Slope checked for 
all sides.

Notice that we split the sketch lines of the shorter sides in thirds and checked Defines Slope 
only for the middle portion of the line, as shown here
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Gambrel Roof
We created this Roof by Footprint by using the Pick Walls tool. We checked Defines Slope for the 
two long sides of the roof only. We cut the roof off at a certain height (cutoff level), and created 
a second roof using as a sketch the cutoff shape of the first roof. For the second roof, we checked 
the Defines Slope option for its two longer sides. 

56491c13.indd   401 6/2/09   2:38:59 PM



402 | Chapter 13 ExtEndEd ModEling tEchniquEs—Roofs and flooRs

Dutch Gable with Glazed Roof
We created this Roof by Footprint by using the Pick Walls tool and checking Defines Slope for 
all sides of the roof. We cut the roof off at a certain height (cutoff level), and created a second 
roof using as a sketch the cutoff shape of the first roof. We set the Type value of the second roof 
to Sloped Glazing. For the second roof we also checked Defines Slope for all sides of the roof, but 
the slope of the second roof is slightly steeper than that of the first roof. We applied curtain grid 
and mullions to the sloped glazing. (See “Real World Scenario: Creating a Ridge Skylight Roof” 
earlier in this chapter for a full step-by-step procedure for this example.)
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Dutch Gable
We created this Roof by Footprint by using the Pick Walls tool and checking Defines Slope for 
all sides of the roof. We cut the roof off at a certain height (cutoff level), and we created a second 
roof using as a sketch the cutoff shape of the first roof. We checked Defines Slope for all sides of 
the second roof; the slope of the second roof is slightly steeper than the slope of the first roof.
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Hipped Roof with Sloped Arrow Dormer
We created this Roof by Footprint by using the Pick Walls tool and checking Defines Slope for 
all sides of the roof. We split the sketch line on the south of the building into four segments to 
allow for the dormer creation. We added sloped arrows facing each other and meeting in one 
point to the middle two segments of the split sketch line.
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Hipped Roof with Two Dormers
We created this Roof by Footprint by using the Pick Walls tool and checking Defines Slope for 
all sides of the roof. The two dormers are also separate roofs created by the footprint of the walls 
defining the sides of the dormer. We then joined the roofs. The opening in the roof slab is made 
up of two simple closed loops of lines (this can be done directly in Sketch mode or later, using 
the Openings tool from the Modify tab).
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Four-Sided Gable
We created this Roof by Footprint by using the Line tool from the Draw panel in the shape indi-
cated in the sketch. Defines Slope is checked for all four corners (see the blowups of the corner 
and middle roof edge).
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Hipped Roof with Extruded Roof Dormer
We created this Roof by Footprint by using the Pick Walls tool with Defines Slope checked for 
all sides of the roof. We created the dormer roof as a roof by extrusion by using the wall face as a 
work plane, and then joined with the other roof in the sketch (you could also use the Openings 
tool later).
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Cone Roof
We created this in-place roof by using the Component tool and selecting Model In-Place from 
the Build panel of the Home tab, with Roof as the assigned category. A simple closed loop of 
sketched line is revolving around an axis. 

This roof can also be created as a footprint roof that is sketched as a circle while Revit is in 
sketch mode. Make sure that the number of full segments is set to 0. Adding three or more seg-
ments created even faceting.
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Dome
This dome was also created as an in-place roof using the Revolve modeling technique. To rep-
licate it, you will first need to draw a reference line in plan view that crosses the center of the 
circle describing the exterior walls, and then, in section view, draw the revolving shape as well 
as the axis of rotation.
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Barrel Roof
We created this example with the Roof by Extrusion method. A simple line in arc shape defines 
the main shape of the roof extruded over the building footprint. In this example we included 
an additional roof by extrusion and converted it into sloped glazing. The edges of the roof have 
been rounded using the Vertical Opening tool. The sloped glazing curtain panel type is set to 
Empty Glazing, which allows the mullion structure to create a sunshade. 

56491c13.indd   410 6/2/09   2:39:01 PM



cREating all Kinds of Roofs | 411

Multipitch Roof
We created this Roof by Footprint by using the Pick Walls tool with Defines Slope checked for 
all sides of the roof. Regardless of how complicated the underlying footprint, Revit correctly  
calculates the ridges as long as the eaves are aligned.
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Creating a Dormer

Roofs with dormers generally cause grief for architects, so we’ll guide you through the creation 
of one.

 1. Create the base of a building, set up three levels, and create a Roof by Footprint with Defines 
Slope checked for all sides.

 2. Approximately in the position indicated in the following graphic, on Level 2 create the four 
walls of a dormer using the Wall tool. Set their height to such a value that they extend above 
the roof. (For easier verification, create a cross section through the dormer to check the height 
of the dormer walls, and if necessary, modify their height in the element properties so that they 
extend above the roof.)

 

 3. Using the Roof by Footprint tool, create a pitched roof on top of the dormer walls.

 4. If you switch to a side elevation view, you will notice that the dormer roof probably does not 
extend to meet the main roof. Therefore, you will need to use the Join/Unjoin Roof tool, located 
on the Modify tab in the Edit Geometry panel, to join the main roof and the dormer. Select the 
Join/Unjoin Roof tool, select the main roof as the target, and then select the edge of the dormer 
roof to extend.

56491c13.indd   412 6/2/09   2:39:02 PM



cREating all Kinds of Roofs | 413

 5. From the Edit Geometry panel on the Modify tab, expand the Openings tools and select Dormer 
Opening. Now pick first the main roof, then the dormer roof, and then the sides of the walls that 
define the dormer. Select the inside faces of the walls. Unlike with most sketches, in this case 
you will not need to provide a closed loop of lines. Finish the dormer opening.

 6. Go back to the section view you previously created and edit the elevation profile of the walls 
to make sure they don’t extend below or above the roofs. Note that you should not use the Top/
Base Attach tool; instead use the Edit Profile tool available in the Edit panel on the Modify Walls 
tab to edit its elevation profile. Then manually change the base sketch line of the walls to get 
the triangular elevation profile as shown here:
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Your dormer opening is now correct and you will see that it has cut the roof in two directions, 
as a true dormer needs to.
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As a final touch, you can convert the front wall of the dormer to a storefront wall type or add a 
window.
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Working with Advanced Roof and Floor Shape Editing
No flat roof is ever really flat! And Revit is equipped with smart tools that allow for tapered 
insulation over a flat roof and similar conditions. A rich set of shape editing tools for roofs and 
floors help create and modify such conditions in no time. These powerful tools are modifiers 
that are applicable to roofs and floors and will allow you to model concrete slabs with multiple 
slopes, often referred to as warped slabs (see Figure 13.19).

The set of tools available for editing floor and roof shapes are called Modification tools and 
appear in the Shape Editing panel of the Modify tab when a roof is selected. Here is what each 
tool is meant to do (left to right):

Modify Sub Elements    This tool allows you to direct edit element geometry using selection 
and modification of points (vertices) and edges.

Add Point     This tool allows you to add points on the top face of a roof or floor. Points can be 
added on edges or surfaces. 

Add Split Line     This tool allows you to sketch directly on the top face of the element, which 
adds split lines to the floor and roof so that hips and valleys can be created.

Pick Supports     This tool allows you to pick linear beams and walls to create new split 
edges at the correct elevation automatically.

As you will see, once any of these modifiers are applied to a floor or roof, a new Reset Shape 
button appears on the tab when the roof is selected. Select this button to remove all modifiers 
applied to the floor or roof that you have selected.

Figure 13.19 
Sloped roof with 
drainage.
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Sloped Roofs
Let’s do a short exercise that shows how to make a sloped roof like the one in Figure 13.20 
(shown in plan view).

Follow these steps:

 1. Open Modifying Roof Shape start.rvt from the book’s companion web page (www.
sybex.com/go/masteringrevit2010). 

 2. Select the roof that has already been prepared for you.

 3. From the Shape Editing panel, activate the Add Split Line tool (note that the color of the 
rest of the model grays out while the roof lines are dashed green).

 4. Draw ridge lines to divide the roof into areas that will be independently drained. The 
ridge lines will be drawn in blue color.

 5. Using the same tool, draw diagonal lines within those areas to create the valleys. Make 
sure you zoom in closely when drawing the diagonal lines, so to be sure that you are 
snapping in the exact same diving points. (Should you notice that you have not snapped 
well, select the Modify Sub Elements tool, delete the incorrect segments, and try again.)

You have split the roof surfaces into many subfloors, but they are still all at the same height 
and inclination. You should have a roof that looks like Figure 13.21. Take care when sloping 
structures using this method; the structural thickness decreases with changes in slope. Press 
Esc to exit editing mode. 

Figure 13.20 
A roof plan show-
ing a roof divided 
into segments, 
with drainage 
points.

Figure 13.21 
Using the Add Split 
Line tool, you can 
create ridges and 
valleys.
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 6. Switch to a 3D view.

 7. To add a slope, you need to edit the height of the drainage points. Tab-select the crossing 
point of the diagonals. New controls that allow you to edit the text appear, and you can 
either move the arrows up and down or type a value for the point height. As shown in 
Figure 13.22, type -0´5˝ (-13cm).

 8. Repeat steps 1–7 for all three drainage points.

 9. If you need to move the point to another position (perhaps to accommodate what’s hap-
pening in the room below the roof), select the point and drag it.

 10. Make a section through the roof—if possible, somewhere through the drainage point. 
Open the section; change the detail level to Fine to see all layers. The entire roof structure 
is now sloped toward the drainage point.

What if you wanted the insulation to be tapered but not the structure? For that, the layers of 
the roofs can now have variable thickness. Let’s see how to apply a variable thickness to a layer.

 1. Select the roof, and navigate to its type properties to edit its structure.

 2. Activate the preview. You will notice that in the roof-structure preview, you do not see 
any slopes. That is correct and will not change. This preview is just a schematic preview 
of the structure and does not show the exact sloping. Look for the Variable column under 
Layers (see Figure 13.23). This allows layers of the roof to vary in thickness when slopes 
are present. Check Variable for the insulation material.

 3. Go back to the section view and take a look at the difference that this change provoked. 
As you can see, only the insulation is tapered now, while the structure remains flat.

Figure 13.22 
Drag the drainage 
points to change 
their height or type 
a new value in the 
numerical field.
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Warped Surfaces
Warped surfaces can also be created using this tool. Using the Roof by Footprint method, draw 
a flat roof, uncheck Defines Slopes, and then select the roof. Using the Modify Sub Elements tool, 
you can start moving edge points up and down (Figure 13.24).

Figure 13.23 
The Edit Roof 
Structure  
dialog box.

Figure 13.24 
Warped roof.
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The Bottom Line

Understand the various roof creation methods.    There are multiple methods for creating 
roof forms in Revit, and you should become familiar with each.

Master it    When would you use a Roof by Extrusion method?

Create all kinds of roofs.    Roofs are an integral part of any building. Knowing how to cre-
ate them in a variety of shapes and sizes is critical to the success of a project.

Master It    In the early design phases of a project, you are exploring a variety of roof 
forms for your building. Create the base building form and explore different roof options 
and shapes. How would you go about exploring a variety of roof shapes?

Work with advanced roof and floor shape editing.    Roofs are another seemingly simple 
element that presents architectural challenges, and Revit has tools for them.

Master It    You are working on a flat roof retail project, but the roof is not really flat and 
will need to drain. Using Revit roof tools, how would you go about modeling this?
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Chapter 14

Extended Modeling Techniques—
Railings and Fences

In the previous chapters, we covered some advanced modeling techniques for making complex 
walls and curtain walls and for accommodating various specific conditions with roofs and floors. 
In this chapter, we explore some advanced stair and railing features that enable you to make some 
quite creative and smart designs. As you’ll see, with a little refinement and creativity, you can cre-
ate a wide range of railings and fences with a simple set of standard tools.

In this chapter, you’ll learn to:

Work with railings and fences•u	

Use balusters and rails to construct railings•u	

Adjust additional settings•u	

Working with Railings and Fences
Railings and fences can range from very simple shapes to quite complex ones. A small selec-
tion of the possible variety of railings and fences can be found in the examples of the Revit help 
system (Figure 14.1). Railings and fences can be represented as simple walls that follow the sides 
of a stair or balcony, or the boundaries of your garden; you can also create glass frameless rail-
ings or complex combinations of balusters and posts in different materials (wood, metal, glass 
panels). Revit allows most combinations of railings to be built, but this does require a thorough 
understanding of the Railing tools, recognized as one of the more complicated tools in Revit.

Figure 14.1 
From the Revit 
help system, a 
variety of possible 
railings and fences 
that can be created 
with Revit.
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In the following sections, we will cover some of the main principles used to create different 
types of railings in Revit.

Railings
When you need to create a railing in your model, Revit provides a customized tool to accom-
plish this. From the Circulation panel of the Home tab, choose Railing. You’ll enter a Sketch 
mode where you have to first draw the path of your railing (Figure 14.2). You define the position 
and length of a railing by drawing a base line in Sketch mode. You can draw the base line of the 
railing wherever you please: in the center of the stair or on the side. The actual geometry of the 
railing is defined in the type properties, where you set up rail and baluster placement rules.

Like many elements in Revit, railings must be placed on a host object. A valid host for a rail-
ing can be a floor, a stair, a ramp, or a level. If you draw a railing sketch line without first defin-
ing a host, it is drawn on the active level of the view you are in and you will create a horizontal 
railing. If you want to add a railing to a stair, select the Railing tool and, before or after drawing 
the railing path but definitely before selecting Finish Railing, use the Set Railing Host button 

Figure 14.2 
Defining the posi-
tion and length of 
a railing by draw-
ing a base line in 
Sketch mode.
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available in the Tools panel of the Create Railing Path tab to select the stair as the host for the 
railing.

If you do not set a host prior to finishing drawing the railing, the railing will be placed below 
the stair, on the active floor or level. If you forget to do that and need to re-host the railing to a 
stair after sketching the railing, this is not a problem; you can re-host it later. To re-host, select 
the created railing, select the Edit Path tool available in the Edit panel of the Modify Railings 
tab, select Set Railing Host, and pick the stair as a host. Finish the sketch, and the railing will 
jump from the level to the stair.

Since a railing is based on a sketch line that defines its path, you can have your railing follow 
just about any path by drawing an appropriate line shape (Figure 14.3).

Subelements of the Railing Element and Principles of Railing Structure
A railing element consists of the subelements shown in Figure 14.4: posts, rails, and balusters.

Figure 14.3 
A freestanding 
railing and a rail-
ing hosted by a 
stair, both follow-
ing the sketch  
line shape.

Figure 14.4 
Railing components. Posts Rails

Balusters
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Balusters    These can be any shape or form. A baluster repeats itself in a railing based on 
spacing rules. To place balusters, you first need to load existing baluster families into your 
project. These could be baluster families provided by Revit or your own custom content. 
To create your own designed baluster families, use one of three available family templates: 
Baluster.rft, Baluster-Panel.rft, or Baluster Post.rft. Using the basic modeling tools 
explained in Chapter 6, “Modeling Principles in Revit I,” you can make balusters such as 
those shown in Figure 14.5.

Posts    Posts can also have any shape, as shown in Figure 14.6. They are created using the 
Baluster-Post.rft template in the Family Editor.

Rails    Rails are horizontal elements that can either connect posts (should there be any) or 
represent handrails attached to a wall. The geometry of the rails is defined by profile families 
that you create in the Family Editor using the Profile-Rail.rft family template. Figure 14.7 
shows some examples of typical rail profiles.

Figure 14.5 
Balusters can be 
any shape or size.

Figure 14.6 
Various post types 
created using  
Baluster-Post.rft.
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A rail can appear attached to a wall as a handrail, as shown in Figure 14.8. In this case, no posts 
are used and the wall-mount brackets are custom-designed balusters. The rail is following the 
stair and is given an appropriate offset from the wall.

Railing Construction
The order and combination of subelements of the railing element can create unlimited variations 
of railings. In the type properties dialog box of the railing, under the Rail Structure and Baluster 
Placement parameters (Figure 14.9), you can define any combination of rails and balusters.

Setting Up Rail Structure
From the type properties of a railing, selecting Rail Structure  Edit. That displays the Edit Rails 
dialog box shown in Figure 14.10, where you define the number, shape, and position of the rails in 
your railing.

Figure 14.7 
Typical rail profiles.

Figure 14.8 
Handrail attached 
to wall.

Figure 14.9 
Type properties of a 
railing element with 
embedded editors 
for rail and baluster 
placement.
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Figure 14.11 shows a railing with two rails: one set to 1́  (30cm) height and the upper one set 
at 3´-6˝ (1m). Both of them use the profile Rectangular Handrail. The rails are placed with an 
offset to the mid-axis of the rail sketch line. (The balusters have no offset.) The 1˝ (2.5cm) offset 
pushes the rail away from the sketch line, as you can see in the front elevation.

To define post and baluster patterns, click the Edit button for Baluster Placement in the type 
properties of the railing. You’ll see the dialog box shown in Figure 14.12.

OptiOns fOr pOsts

Depending on their position in the railing, posts can be placed at the Start, Corner, or End con-
dition of the railing. You can choose to have different families for the three positions and thus 
select a different baluster-post family for each, or you can keep it simple and use the same fam-
ily. You also don’t have to have them at all—you can set the post placement to None for any of 
them (for example, you can have start and end but no corner). Figure 14.13 shows various pos-
sibilities for the placement of posts. On the railing at left, the start, corner, and end posts use the 
same post family. The railing at right was created with the corner post set to None and uses dif-
ferent post families for start and end posts.

Figure 14.10 
The Edit Rails  
dialog box.

Figure 14.11 
Front and side ele-
vations of a railing 
with two rails.
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The Corner Posts At dialog box allows you to define corner posts to be dependent on the 
angle of the railing or to only appear under certain conditions, or choose to not place them at all.

The option Angles Greater Than allows for inclusion of the element dependent on the set 
angle. This means that if the individual segments of sketch lines of a railing turn into angles 
greater than the parameter you set, a corner post will be placed (Figure 14.14). If the angles are 
less than the parameter, none will be placed.

Figure 14.12 
The Edit Baluster 
Placement  
dialog box.

Figure 14.13 
Various possibili-
ties for the place-
ment of posts.

Figure 14.14 
When the sketch lines 
of a railing meet at 
an angle greater than 
the angle defined for 
corner posts, a corner 
post will be placed.
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As mentioned, railings can be hosted only on a slab, stair, ramp, or level. Thus, their place-
ment is usually defined as an offset from the host. In the Edit Baluster Placement dialog box, you 
will find that you can also define the position of a rail as an offset from another rail that exists in 
the structure (Figure 14.15).

The Top parameter is where you can either select the host of the entire railing or choose from a 
list of existing rails in the railing as a top reference. The top offset can be a positive or negative value.

The Space parameter defines the distance of the post centerline to the railing viewed in a lon-
gitudinal direction, as shown in Figure 14.16. This value can be positive or negative.

Defining the Main pattern

The Main Pattern section of the Edit Baluster Placement dialog is where you define the pattern 
of the railing between the posts to generate a complex railing, as in Figure 14.17. 

The options (Figure 14.18) are similar to those just discussed for the rails.

Figure 14.15 
Offset a rail from 
another rail.

Figure 14.16 
Space parameters 
define the longitu-
dinal position of 
the rail.

Figure 14.17 
Baluster main  
pattern.

Figure 14.18 
The Main Pattern 
options.
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Note that all parameters that define position (such as Dist. [distance] from Previous or Offset) 
are calculated from the center reference planes of the baluster families.

The Dist. from Previous setting allows placement of balusters at a specific set distance from 
one another. To keep balusters from running into one another, you should know the actual 
dimensions of your different balusters prior to defining this parameter (Figure 14.19).

As you can imagine, the railing length will not always fit an even number of panels or balus-
ters based on the pattern length. How do you deal with that?

Revit provides four different justifications for the pattern fit: Beginning, End, Center, and 
Spread Pattern to Fit. Their names explain the usage, but Figure 14.20 shows the different justifi-
cations and their implications for a design.

The justification you select obviously depends on your design, but you may also be using 
prefab standard railing patterns that come only in certain dimensions.

Balusters per treaD

Revit allows you to set a specific number of balusters per tread on stairs.

If you want to control the number of balusters per tread, check the first option: Use Baluster 
per Tread on Stairs. This makes the next option active and you can then type in the number 
of balusters you want to have per tread. You can also change the baluster family by clicking 
the Baluster Family option, which displays a list of all loaded baluster families available in the 
project.

Figure 14.19 
The baluster posi-
tion is always 
measured to the 
mid-axis for all 
positioning  
parameters.
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The top and middle images in Figure 14.21 show railings for spiral stairs created with two 
different settings: (A) two balusters per tread, and (B) one baluster per tread setting. When the 
bottom image (C) was created, the Use Baluster per Tread on Stairs option was not activated, so 
the railing follows the main pattern.

Figure 14.20 
Using different 
pattern options for 
seven defined pan-
els results in differ-
ent distribution of 
the panel along the 
railing length.

Center

Start

End

Spread To Fit

Figure 14.21 
Spiral stairs with 
different settings: 
(A) two balusters 
per tread; (B) one 
baluster per tread; 
(C) Use Baluster 
per Tread on  
Stairs option not 
activated. A B

C
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As you can see, the moment you use the Use Baluster per Tread on Stairs option, the Baluster 
Family selection overrides the one set in the Main Pattern section.

aDDitiOnal COntrOls

Landings can be difficult to work with when designing railings. Revit has a set of additional 
tools to control landings located in its Type parameters (Figure 14.22).

By default, each railing in Revit follows the stair flight and the landing and creates the most 
logical solution. Often, however, the height of the railing on a landing is not calculated accord-
ing to your design intent. With the Use Landing Height Adjustment parameter, you can change 
the railing at the landing to a specific height.

Landings can also generate unresolved situations where segments of the railing meet. By 
default, the joins at the angles are unresolved and the segments are not connected. You can fix 
that by adding vertical or horizontal segments and refine it further by setting the rail connec-
tions to Trim or Weld (see Figure 14.23). All these settings are also part of the type properties for 
the railing.

The Tangent Joins tool does a similar job but affects connections of different segments of the 
railing that are on a continuous tangent. The options are located in the type properties of a rail.

Figure 14.22 
Landing param-
eters: Use Landing 
Height Adjustment.

Figure 14.23 
Angled joins:  
(A) no connector; 
(B) add vertical 
or horizontal seg-
ments; (C) with rail 
parameter set to 
Trim/Weld.

AAA A B A C
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The effects can be seen in Figure 14.24.

Finally, there are a few more adjustment tools needed to refine the railing and bring it closer 
to your design goals. These last tools are available in Sketch mode of the Railing tool only.

Use the Edit Rail Joins tool to clean up segment joints while in the railing sketch. Once you’re 
in a Sketch mode, this option appears in the Tools panel of the Modify Railings tab.

After selecting the Railing tool, click the Edit Rail Joins button located in the Tools panel, 
hover the cursor over the sketch line joins, and then click the join (Figure 14.25) to activate 
options in the Options bar. These provide the same controls you saw in the previous example.

In Sketch mode, after you select one of the railing sketch lines, the Options bar tools shown 
in Figure 14.26 appear. These tools let you manipulate the sketch lines in order to adjust the 
slope of the railing or correct the height connection.

Figure 14.24 
Mid-landing rail-
ing segments 
cleanup: (A) No 
Connector; (B) Add 
Vertical Segments; 
(C) Extend Rails  
to Meet.

A B C

Figure 14.25 
Edit joins by click-
ing on the end join 
of sketch lines.
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The Slope tool offers you three possibilities: 

By Host    This option follows the slope of the host, which is what you would need in the 
majority of cases.

Flat    This option keeps the railing flat, regardless of the slope of the host.

Sloped    This option defines a custom slope for your railing that ensures uninterrupted con-
nection between adjacent segments.

Similar to what we have shown about the height adjustment on the landing, there is an addi-
tional adjustment of the height of a railing that is useful for controlling the extension of a railing 
(Figure 14.27). 

This is also available when in Sketch mode only and offers two options:

By Type    The railing height for the selected segment depends on the properties of the rail-
ing type.

Custom    The railing height for the selected segment can be forced to a different custom 
value. Figure 14.28 demonstrates both situations.

Figure 14.26 
The Slope tool.

Figure 14.27 
The Height Correc-
tion option.

Figure 14.28 
Railing height 
adjusted By Type 
or forced to a  
new height value 
(Custom).
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adding a rail onto a Wall

Adding a rail to stairs is easy, but adding a rail on top of a wall is more difficult the way Revit ele-
ments are set up today. Shown here is a railing design consisting of a base wall and a railing element 
on top of it. This is a common type of railing in institutional buildings or outdoor stairs, so let’s 
see how it is made.

The challenge we face is that a wall is not considered a host for a railing element in Revit, so we 
have to find a workaround for how to place a railing that will follow the stair angle and is based on 
the wall. 

Start by creating a stair without any railings (or if you already created a stair with default railings, 
delete the railings later) and create a wall next to the stair with an edited elevation profile, as shown 
in the previous graphic.
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Then create a very thin floor on top of the wall that will play the role of a host for the railing (a floor 
is a valid host for railings):

 1. Create a floor type that is very thin.

 2. Switch to elevation view. Using the Dimension tool, measure or dimension the height of the 
top of the wall at the beginning and end of the stair. You will need these values when you slope 
the floor to match the stair.

 3. Define the floor shape by switching to plan view and drawing a floor. Use the Pick method and 
select the four lines representing the top of the wall.

 4. While still in floor Sketch mode, click the Slope Arrow tool and set the properties as shown:

For Specify, choose Height at Tail•u	

For Height Offset at Tail, set the value of the lower height of the wall to 3́ -0˝ (97cm)•u	

For Height Offset at Head, set the higher value of 12́ -0˝ (405cm)•u	
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Draw the slope arrow in the middle of the floor starting at the beginning of the stair and finish-
ing toward the end of the stair. By doing this, you have added a slope to the floor that matches 
the slope of the wall.

 5. Select the Railing tool from the Circulation panel on the Home tab, then click on the Set Railing 
Host button on the Tools panel of the Create Railing Path tab, and select the floor, and draw the 
railing in the middle of the floor.

This workaround can be quite practical when dealing with railings in big auditoriums. Auditoriums 
are rarely done using huge stairs; rather, they tend to feature stairs divided into many floors. As a 
railing can only have one host, it isn’t possible to host the railing on many floors at the same time. 
Using this workaround, however, you will be able to create a railing that runs through many audi-
torium levels and is still hosted.
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The Bottom Line

Work with railings and fences.    Railings are a bread-and-butter architectural element 
whose design can be streamlined with Revit.

Master It    You’ve found some nice-looking railing panels and balusters while scouring 
the Web for interesting rail designs. How do you go about building the railing in Revit?

Use balusters and rails to construct railings.    A railing is a complex set of subelements that 
Revit lets you organize and control with rules and settings.

Master It    You want to make a railing where the balusters are glass panels with fixed 
width. You wish to add a railing that contains the maximum number of those panels and 
you wish them to be spread symmetrically. How do you do that?

Adjust additional settings.    Stair railing details are particularly difficult to design and plan 
at landings. Revit helps you fine-tune the details using additional settings.

Master It    After designing the stair railing, you notice that there is a gap between the 
rails following the stair flight and the horizontal rail on the landing. What options do you 
have to resolve this situation?
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Chapter 15

Presentation Techniques for Plans, 
Sections, and Elevations

As design professionals, we are deeply rooted in the art of representation and expression. Our 
drawings are powerful communication devices and tools for personal expression. We manipulate 
color, contrast, light, and shadow to give a drawing life and dramatic poise. From the loose napkin 
sketch to the photorealistic rendering, we imbue our designs with a sense of purpose and intent. 
This intent is a driving force in architecture and critical to its progression. Without models and 
drawings that challenge the senses, where would we be today? Consider the drawings of Piranesi, 
Boullée, Wright, Woods, and Hadid. Each is distinct, thoughtful, evocative—at times utopian. 

Consider your role in shaping the built environment. Think about how your drawings are 
interpreted, received, and understood. How do they shape the evolution of a design? How have 
digital tools changed the way you present and evaluate a design? Keep these questions in mind 
as we move through the next two chapters. Consider how the techniques can help you, and also 
think of how you might push some boundaries and extend your creativity using the tools in 
Revit 

You’ve seen with Revit that many traditional documentation drawing types are generated 
with little effort. With a few clicks of the mouse, you can generate entire building sections and 
elevations. Likewise, a perspective view now takes only a few seconds to generate. Revit does 
a fairly good job of producing these drawings, but it can’t fully replace the skill and decision-
making process of an artist. Design intent and message still need to be considered by the designer. 
Because of this, Revit provides some tools to help you make your drawings more legible and 
expressive. If need be, you can also export a drawing as vector lines or as pixels and further 
refine it to meet your design requirements.

In this chapter, you’ll learn to:

Use shadows for presentation purposes•u	

Create presentation-quality plans and sections•u	

Create elevation drawings that convey depth•u	

Using Shadows for Presentation Purposes
Shadows tend to be used for two purposes: analysis (Figure 15.1) and expression (Figure 15.2). 
For analysis, shadows are used to see how a building will be affected by its environment and 
real-world sun angles based on the location of the site. This analytic use is explored in depth in 
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Chapter 18, “Evaluating Your Preliminary Design: Sustainability,” and is covered here primarily 
to introduce the shadowing tools for presentation purposes. The expressive use of shadow, our 
focus in this discussion of presentation issues, conveys depth in drawings and gives them more 
character; it may or may not be tied to real-world sun positions. Revit provides a tool for each of 
these use cases, and this book will show you how to use both tools. The nice thing about shad-
ows in Revit is that it’s easy to enable them, and voilà!—shadows are there.

Figure 15.1 
Analytical use  
of shadows in a  
site plan shows  
the effect of  
buildings on their 
environment.

Figure 15.2 
A more expressive 
view using shad-
ows in a shaded 
view without 
edges.
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Analytical Drawings: Sun and Shadow Studies
Using shadows analytically allows you to see (and demonstrate) the effect of a building on its 
environment and, likewise, the effect of the environment on your building. Using real-world 
sun and building positions, you can evaluate the design impact on its surroundings. You need 
to know whether the building will have a negative impact and make sure building codes are 
satisfied. You’ll also want to see the effect of the sun on the building itself so you can study light 
penetration and how other buildings will affect light and shadow. Figure 15.1 shows a site plan 
view with shadows turned on. 

To get accurate sun shadows, you must establish where the building is on the planet, the build-
ing’s orientation relative to north, and the date and time that you wish to analyze. For example, it’s 
common practice all over the world to represent the extreme sun angles at both the summer and 
winter solstices. Both of these are provided in the default templates. These angles vary based on 
latitude and longitude. In Revit, every project has a location that is defined in the Manage Place 
and Locations dialog box that is accessible from the Manage tab, in the Project Location tab; this 
location has a direct influence on sun position. In the Place tab (shown in Figure 15.3), when you 
choose from a list of cities, the latitude and longitude are set for you automatically. If you don’t 
find your city in the list, choose a nearby city, and then edit the latitude and longitude to match 
your location. If you’re still not sure, you can use a tool like Google Earth to accurately locate your 
latitude and longitude.

You need to set your location only once per project; this will affect all sun angle calculations 
based on the selected location.

To turn on shadows and see the effect of date, time, and location, choose the Shadows On 
option from the view controls at the bottom of any view.

Figure 15.3 
Set your building 
location using  
the Manage Place 
and Locations  
dialog box.
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Enabling ShadowS

Shadows are enabled on a view-by-view basis. This means that for each view in which you wish 
to display the shadows, you need to activate them independently. The downside of this is that 
if you have activated the shadows in many views, there is no one global button to turn them all 
off; you might well have to do that throughout the course of the project, as shadows can slow 
down the performance of the project significantly. Alternatively, you can just close the views 
that have the shadows turned on.

To understand how shadows are being cast, click the Graphic Display Options button to open 
the dialog box shown in Figure 15.4, where all the shadow settings are defined. From this dialog 
box, you can access the Sun and Shadows Settings dialog box, play with the brightness and dark-
ness of the sun and shadows, override silhouette edges, and enable gradient backgrounds.

Sun and Shadow SEttingS

Clicking the ellipsis button next to the Sun Position field opens a dialog box where you set the 
angle of the sun. For analytical views, choose meaningful times and dates. Revit ships with the 
presets shown in Figure 15.5.

Figure 15.4 
Graphic Display 
Options dialog box.

Figure 15.5 
The Sun and  
Shadows Settings 
dialog box for  
still images.
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There are two methods for setting the sun angle: By Date, Time and Place; and Directly. 
Making any changes to them could cause serious problems later. For example, if you manually 
set Summer Solstice to an azimuth and altitude that aren’t accurate, you can create misleading 
settings. If you need to create a unique setting, the best practice is to duplicate an existing set-
ting and go from there, rather than editing the preset options. Or, if you really intend to change 
a preset setting permanently, go ahead and rename it with an appropriate and meaningful 
name.

intEnSity

To get different graphic results using the same geographical settings, try experimenting with 
the Sun and Shadows intensities in the Graphic Display Options dialog box by sliding the two 
sliders between the brightness and darkness extremes.

If you give the sun 100 percent intensity (Brighter), the model will appear brightly lit, and 
shadows appear more subdued. Figure 15.6 shows the different effects that can be achieved by 
adjusting the intensity values. Keep in mind that the sun and thus shadows affect only views set 
to Shading or Shading with Edges model graphic styles. In other words, for Hidden Line views, 
you can change only the darkness of the shadows but not the intensity of the sun.

To create several graphic versions of the same view, you must duplicate the view and apply 
different sun and shadow settings using the Advanced Model Graphics Settings dialog box.

Figure 15.6 
Adjust intensity 
to get different 
graphic results.

Sun = 20%
Shadow = 100%

Sun = 100%
Shadow = 20%
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Create Expressive Drawings with Shadows
When you use shadows expressively, the need for accurate lighting conditions is not as impor-
tant as the need to define consistent angles so that your drawings express depth. Without shad-
ows, a façade appears flat and difficult to interpret. By adding shadows and setting them to be 
Relative to View, you can create an image that discloses information about the depth in that 
flat image, allowing it to be much better understood. To do that, you establish a shadow angle 
that suits your needs and reuse the settings for multiple views. The default template includes 
two presets for this in the Sun and Shadows Settings dialog box: Sunlight from Top Right and 
Sunlight from Top Left (see Figure 15.7).

The combination of Azimuth and Altitude with these presets produces 45° shadows on an 
elevation.

high-ContraSt blaCk and whitE EffECtS

Using hidden line display and increasing the shadows to 80–90 percent produces nice, high-
contrast elevations. As you can see in Figure 15.8, this is a great way to create visuals that will 
read from far away.

Figure 15.7 
Sun locations 
 in the default  
template.

Figure 15.8 
High-contrast 
black and white 
elevation.

Shadows = 90%
Display mode = Hidden Line
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Soft ShadowS

If you prefer to give an image a softer appearance, try using a shading view (shading without 
edges) and setting shadows to 30 percent and sun to 70 percent. You’ll get a very even-colored, 
washed-out feel, as shown in Figure 15.9. Because the book is printed in black and white, you 
might not be able to appreciate the finesse in these, so make sure you try them out yourself!

Performance Considerations
As you’ll discover when working in views with shadows enabled, the speed of panning and 
zooming in the model degrades when shadows are on. So, as you start to use shadows, keep this 
in mind: turning off shadows is always two clicks away. If you want to start panning and zooming 
around the view, turn off the shadows for a while. When you’ve finished zooming about, turn 
them back on. Remember that the settings are persistent, and turning off shadows is just a sim-
ple way to improve performance while working with your model. But don’t worry—your work 
will be saved and you will not need to remake them again the next time you turn them on.

Color-Coded Plans and Sections
Colors, when associated with a legend, are an effective way to signify meaning. In the context of 
architectural drawing, the colors are often applied to convey how space is used or intended to be 
used. With Revit, you can use color to differentiate one room from another or to communicate 
ideas about usage, size, importance, and cost. By assigning parameter values to colors and pat-
terns, you can quickly make views that show how a building is spatially organized (Figure 15.10). 
For example, you can create a department floor plan by assigning department values (names) 
to all your rooms and then apply a color fill scheme to the view that changes the color of rooms 
based on what department they’re assigned to.

Figure 15.9 
Soft edges and low-
contrast shadows.

Sun = 70%
Shadow = 30%
Display mode = Shading
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To make a color-coded plan, first duplicate an existing plan view and give it a unique name. 
Then add rooms (if they have not been added already). The reason for adding rooms is that the 
color-coding is based on the properties of room elements and will have no effect unless room 
elements exist in the project. You can also create new area plans and use area separation lines 
to divide space at a more macro scale. You can then assign values to each area that can then be 
colored with a color fill scheme. Once rooms and areas have been placed, you can access their 
Element properties. 

All of the properties grouped under the Identity Data parameter group can be color-coded. 
Using project parameters, located in the Manage tab, you can also add custom parameters to the 
room and area categories.

From the View properties of a plan, area plan, or section view, you can assign a color fill 
scheme to the view. Clicking that parameter takes you to the Color Fill Schemes dialog box, 
where you set up and assign various schemes. Whatever is selected in that dialog box is applied 
to the view, and the rooms will become colored.

You can also create a color scheme using the Legend tool in the Home tab, in the Room & 
Area panel. The moment you place the legend, you will be prompted to select the space type 
(Rooms or Areas) and a color fill scheme.

Color fill SChEmES

Color fill schemes are applied to views on a per-view basis (in other words, they appear only in 
the view where you created them) and are exposed as an Instance property of floor plan, area 
plan, and section views. To access and create color fill schemes, click to expand the Room & Area 
panel on the Home tab, and click Color Fill Schemes to open the dialog box in Figure 15.11 (you 
can get to the same dialog box from the View Properties dialog box). In the Edit Color Scheme 
dialog box, you’ll see a list of schemes on the left and all the rules and colors for those schemes 

Figure 15.10 
Use color and 
parameters to 
generate color fill 
plans.

56491c15.indd   446 6/2/09   10:57:00 PM



using shadows for Presentation PurPoses | 447

on the right. Each scheme colors one parameter and all its values. For each unique value, a unique 
color or hatch pattern is assigned. For example, if you choose to color by name, the table fills 
with all the room names in the project and assigns a color to each unique name. Clicking the 
button in the Color column allows you to choose your own colors. While Revit will create new 
colors for you automatically with each new value, you are free to change those to your own col-
ors and can even save these into a template for use in other projects.

Information in this dialog box is also used to fill out color fill legends, which are essentially 
graphical tags of the color scheme and are placed next to the plans to explain the color-coding. 
The legend shows the title, values, and color swatches for the scheme applied to a view. To place 
a legend in a view, use the Color Scheme Legend tool in the Drafting tab of the Design bar.

The color-scheme legend allows you to edit its Type properties to control the visibility of the 
title, swatch size, fonts, and color (Figure 15.12).

Figure 15.11 
The Edit Color 
Scheme dialog box.

Figure 15.12 
Color Scheme  
Legend properties.
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Note that the order of the values in the legend coincides with the order set up in the Edit 
Color Scheme dialog box. The default behavior lists each entry alphabetically, but you’re free to 
change that by using the Move Up and Move Down buttons when a row is selected. Doing so 
simultaneously updates the color-scheme legend.

Another important graphical control of the legend is the Values Displayed parameter. This 
gives you the option to show only values in the legend that are also in the view (By View). In a 
project where the number of departments and room names can be large, and they aren’t used in 
all floor plans, this is a great way to focus the legend on what is important to that view instead 
of listing all possible colors that might not be applied in that view and are thus irrelevant. Many 
designers do not want to display all the color swatches, but this is ultimately up to your own 
personal taste and what the drawings are intended to convey. Revit allows you to do both, so it’s 
really up to you. Choosing the All option shows all values used in the project, whether used in 
the view or not.

CrEating PrEdEfinEd Color SChEmES

If you’ve created a list of room names, departments, and a carefully chosen palette of colors that 
are likely to be reused in future projects, you can transfer the color scheme from one project to 
another or reuse it in your office template. This transfers all the values and colors, even if the 
project you’re transferring to doesn’t contain that value.

transferring Color Fill Schemes between projects or templates

Imagine you have invested quite a bit of time setting up a color scheme in your current project, add-
ing room names and departments and assigning them colors in the Color Fill Scheme dialog box. If 
you want to reuse the same values and colors in other projects so that you maintain your graphical 
language, use the following strategy:

 1. Open the source project, and then open the project into which you want to transfer. You need to 
have two projects open to transfer from one to another. If you have only one project open, Revit 
will inform you that there are no open projects to transfer project standards from. Remember, 
the project in which you invoke the Transfer project standard is the one you wish to import the 
standards to.
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 2. Open the Manage tab, and then select Transfer Project Standards. Select Color Fill Schemes in 
the Select Items to Copy dialog box.

 3. Values are transferred into the project. You can then access the list of values from the room’s 
Element Properties dialog box.

This saves you from having to manually retype all these commonly used values, and the colors will 
be consistent from project to project. 

ColorEd SECtionS

In architectural practice, section views as well as floor plans are often color-coded, showing the 
stacking of various functional zones (Figure 15.13). You can get automated coloring of the rooms 
in section view just as you can in plan view:

 1. Open a section view.

 2. From the context menu, under View Properties, open the Visibility/Graphics Overrides 
dialog box (type VG) and make sure the Rooms category in the view is checked as visible.

 3. Open the View Properties dialog box and assign a Color Scheme setting to the view. Use 
Name as the parameter to color if you have not assigned any departments (departments 
are the default setting, which comes from the fact that the selection is alphabetical). 
You’re likely to get an image where the rooms do not fill the entire space being cut by the 
section, similar to Figure 15.13. (Since this book is printed in black and white, use your 
imagination: purple is used on the first two floors and gray on the third.)
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 4. You can see that the rooms are not extending up to the next floor and roof. To fix this, 
select a room and drag the blue arrow controls at the top, or change the Limit Offset 
parameter from the element properties of the room.

 5. To change how the color is drawn relative to the model geometry, you can set the color 
to be drawn in either the foreground or the background. This parameter is called Color 
Scheme Location and is a property of the view you are working in. Figure 15.14 shows the 
color in the background; the result is that you see walls and doors not colored by the color 
fill. Figure 15.15 shows the color in the foreground; now doors and walls appear filled in.

Figure 15.13 
Use the grip con-
trols when a room 
in section view 
is selected—or 
the Limit Offset 
parameter in the 
room properties—
to change the 
height of the room.

Figure 15.14 
Color fill drawn in 
the background.

Figure 15.15 
Color fill drawn in 
the foreground.
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Creating Presentation-Quality Plans and Sections
Not all plans and sections end up as drawings full of dimensions, tags, notes, and layers of 
construction information. Easy-to-read, graphically clean drawings are used all the time in 
marketing collateral, on project websites, in print magazines, for competition boards, and for 
client presentations. A great way to create presentation-quality plans and sections is to clear 
out most of the textual information and fill in walls, floor, and roofs with a solid fill when 
they’re cut. This creates views that are easier to read and that convey solid and void effectively 
(Figure 15.16). With Revit, this kind of representation is a few clicks away, and the fill hatch 
is tied directly to the element. You don’t need a paint-bucket tool or special hatch tool to get 
results.

There are two strategies for dealing with solid fill for elements that are cut: as a property 
of the element or as a property of the view. Each strategy has its own merits. Let’s review the 
options.

Coarse Scale Fill Patterns
Walls, floors, roofs, ceilings, and columns all have a Coarse Scale Fill type parameter. This 
allows you to define how the element will appear when cut in the view if the view detail level is 
set to Coarse.

Figure 15.16 
Plan view with 
walls and columns 
filled with solid 
black.
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The downside is that the property is stored with each type, so making all walls have the 
same hatch requires you to edit every wall type. The same goes for floors and roofs. And if you 
decide to change the color of the fill, you have to again edit every type.

Also, not all elements have this property. For example, in-place family walls, floors, and roofs 
don’t have this parameter, so you’d have to go a separate route to get correct graphics if you 
chose to use this type of element.

Graphic Overrides and View Templates
The other way to think of this problem isn’t as a property of the element but as a property of 
the view that can be reused in other views. Think of a view as a multidimensional lens through 
which you look at the model. Once you’ve set up the right lens, you can apply it to any num-
ber of views and get the right results using view templates. We recommend this direction for 
graphic overrides, as it makes for an easier way to deal with entire categories of elements. For 
example, most Revit categories can have their cut pattern overridden with a hatch or solid fill. 
If you go to the Visibility/Graphic Overrides dialog box and select the Walls, Floors, Roofs, 
and Columns categories (by holding Ctrl with each row selection), you can then click the Fill 
Override button and apply a solid fill hatch (Figure 15.17). This applies to elements in your 
active view but isn’t stored with the element. These overrides are stored on a per-view basis and 
are distinct from the project-wide object styles.

This view setting is great—but what if you want to apply the same graphics to other views? 
Follow these steps:

 1. Once you have the overrides set up, go to the Graphics panel on the View tab, and choose 
Create template from current view from the View Templates drop-down list.

 2. Name the view Cut Overrides.

Figure 15.17 
Use pattern  
overrides to apply 
a solid fill to  
categories.
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 3. If you only want to store the cut pattern values and not affect scale or any other graphic 
settings when applying this view template, clear all other view properties except for the 
properties under the V/G Overrides Model (Figure 15.18).

 4. Right-click the view name you want to apply the overrides to in the Project Browser, and 
choose Apply View Template. Choose the view template you just created.

Creating Elevations That Convey Depth
Revit applies the same line style to all edges based on the cut or projection settings in the Object 
Styles dialog box. This can lead to elevations that appear flat and lack depth. Strategies for deal-
ing with this issue range from using a highly parametric approach to using lines and drafting 
right on the view. In Figure 15.19, the Linework tool and some graphic overrides were used to 
punch out the building elements in the foreground and halftone elements in the background.

Figure 15.18 
You can selectively 
choose which view 
properties are 
stored in a view 
template.

Figure 15.19 
Edges can be made 
thicker with the 
Linework tool.
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Linework
The Linework tool, located in the Modify tab under the Edit... panel, is a parametric approach 
that allows you to select a line style and then apply it to edges of the model as an override. Any 
edge can be overridden by this tool in order to change the line’s graphic appearance. The over-
ride is applied to the element, so if the element moves, the line style override will move with it. 
When activated, the type selector displays a list of available line styles in your project. You can 
add additional Line Styles under the Object Properties dialog box.

The cursor changes to a pencil and highlights edges of the model as you move the mouse 
around the view. With each click, the override is applied to the edge. This override is associated 
with the element: if you move the element, the linework moves with it. The line style applies to 
the entire edge of an element by default, but this can be adjusted. For example, if you need to 
make the diagonal line of this wall with a thicker line style, you select the Linework tool, choose 
the Wide line style, and then select the edge of the wall. The line goes the entire length of the 
wall (Figure 15.20A). While still in the Linework command, click and drag the blue control dot 
to adjust the length of the linework override (Figures 15.20B–C). Note that if you have your view 
set to thin line display, you will not see the effects of using linework.

Figure 15.20 
(A) Initial condi-
tion; (B) linework 
applied; (C) clean-
ing up the line by 
dragging the con-
trol at the end of 
the line.

A B

C
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To reedit the length of linework, you need to activate the tool and then again select the edge 
you’re concerned with. The same blue controls appear, allowing you to adjust the length of the line.

If you need to remove a linework override, the same principle applies: activate the Linework 
tool, choose <By Category> in the type selector, and then select edges in the model that you 
don’t want overridden.

Drafting Lines
The other way to punch out the elevation is to use drafting lines and draw directly over the 
model in the view. This means you are not changing the appearance of a line in a view but 
instead are adding new lines on top of the model. With this method, you also choose a line style, 
and you can even use the Pick tool to get the same behavior you would with the Linework tool. 
The only difference is that the lines aren’t automatically associated with the element you draw 
on. Depending on your workflow and where you are in the process, this may be the best way 
to create a final elevation drawing. A nice benefit to this method is that you have access to all 
Revit’s familiar timesaving tools such as Trim, Align, and Multi-select.

True-Color Elevations
Every material in Revit has a shading color and transparency. This is the color you see when 
the display mode is set to Shading or Shading with Edges. Be aware that the transparency is 
graphically visible only in 3D view. In elevations, a glass window will not appear as transpar-
ent; this helps keep drawings clear of unwanted visual noise. After all, who wants to see interior 
furniture showing through the glass of a hotel façade in an elevation? The color you select in the 
Materials dialog box will be an RGB or Pantone color (see Figure 15.21), but it often won’t look 
like that color in shaded elevation views. That has confused many users, so here is the explana-
tion: shaded views use a hidden fixed light source to light the scene, which causes the color to 
appear washed out or brighter in different views.

Figure 15.21 
Every material has 
a shading color, 
transparency, and 
options for cut and 
surface patterns.
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To overcome this limitation, you can control where the light comes from by using the Sun 
and Shadows Settings dialog box. You can also force the light to come from directly above the 
model so it doesn’t affect any vertical surfaces. To do this, follow these steps:

 1. Open the Sun and Shadows Settings dialog box, and duplicate the Sun from Top Right 
setting—give it a name like True Color Shading.

 2. Change Azimuth to 0 and Altitude to 90 (see Figure 15.22).

 3. Open an elevation view, and go to the Graphic Display Options dialog box from the view 
frame. Set the Sun Position to True Color Shading. Set Shadow Intensity to 0. Set Sun 
Intensity to 80.

Be sure to enable shadows in the view. The effect should be immediately obvious.

Elevations with Transparent Materials
Using the standard Revit elevation views, transparent surfaces are always rendered as opaque 
surfaces. This generally produces the right quality and meets most expectations, but it can also 
seem limiting. Luckily, creating an elevation view with enabled transparency is easy using the 
3D views and orienting them to display an elevation view. Here is how you can do that.

 1. Open the default 3D view.

Figure 15.22 
Use these settings 
to get accurate RGB 
colors in elevation.
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 2. Right-click the View Cube and choose Orientate to View  Elevation  South.

 3. The camera swings around so it’s lined up with the elevation view, and transparent sur-
faces appear transparent.

Using Images in Elevation Views
You can import image files (click Image from the Import panel on the Insert tab) into a Revit view 
to create effects such as gradient fills, add a backdrop to the view, or add a photo-style entourage 
to a nonrendered view. By taking advantage of the draw-order options for images when placed in a 
view, you can position the image either in front of or behind the model. When you select an image, 
the Options bar gives you the ability to position the image in the foreground or background.

To add a gradient fill to the background of an elevation, follow these steps:

 1. Import a gradient image file into an elevation view.

 2. Select the image, and send it to the background using the Options bar.

 3. Stretch the image to fit using the grip controls. You can unlock the proportional scaling 
using the Options bar (see Figure 15.23). If you tend to use the same image or entourage 
from project to project, keep in mind that you can keep a “library” of image elements in a 
drafting view.
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Another great technique is to use the transparency channel available in PNG-formatted images. 
By making a color transparent and pushing images to the foreground and background, you can 
add trees, people, and cars, and the image won’t mask the model. In Figure 15.24, the tree image 
was imported into an elevation view and then copied and scaled. The copy on the right is set to 
Foreground, and the copy on the left is set to Background.

Figure 15.23 
Elevation with  
the gradient  
JPEG import set  
to Background.

Figure 15.24 
Imported PNG 
file of one tree set 
to Foreground 
and another to 
Background—note 
that the transpar-
ency channel is 
preserved.
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The Bottom Line

Use shadows for presentation purposes.    Presenting your design to stakeholders is a critical 
part of your workflow and allows you to sell your ideas. Having tools that make this process 
easier without compromising your creativity is essential to being successful.

Master It    You’ve been asked to show the effect of your building’s shadow on its sur-
rounding site during the winter solstice. How would you do this with Revit?

Create presentation-quality plans and sections.    Creating clean, easy-to-read plan and sec-
tion views using Revit is a huge timesaver.

Master It    Your latest design is all the rage, and you’ve been asked to publish the plans 
and sections in a magazine. How do you make these?

Create elevation drawings that convey depth.    Two-dimensional drawings can be hard 
for clients to read, which makes shadows a useful mechanism for illustrating recesses and 
projections.

Master It    You need to give your elevation view more variation in line weight to convey 
depth beyond the default line styles established in the Object Styles dialog box. How do 
you do this?
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Chapter 16

Presenting Perspective Views

One of the many advantages of working with BIM models is that you can produce perspective 
views of your model as often as you wish—and it takes only a few mouse clicks to do it. Think 
about how tedious the process of creating 3D axonometric or perspective drawings was, whether 
you did so manually or used CAD drafting tools. Perspective views are greatly appreciated by 
owners as they visually communicate the intent of the design better than any other 
representation.

If you open a Revit project that has been in development for a while, you’ll find dozens of 
perspective views. Although most of these views will never make it onto sheets, it’s becoming 
standard practice to include one or two exterior perspectives on the cover sheet. Sheets aside, 
these views are critical for understanding your design from a human point of view and are used 
consistently for client meetings and internally when fleshing out a design. In many cases, a hid-
den line perspective view with shadows turned on provides an excellent graphical representa-
tion of your model. You can also take the visualization up a notch and produce photorealistic 
renderings without having to be a rendering guru.

In this chapter, you’ll learn to:

Create perspective views•u	

Create photorealistic renderings•u	

Create animated walkthroughs•u	

Export the 3D model for use in other applications•u	

Creating Perspective Views
Use the Camera tool to create perspective views in Revit. This tool can be found in the Create 
panel of the View tab. For perspective views, a good exterior shot typically shows a corner of the 
building from a human vantage point (Figure 16.1).
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For exterior views, start by placing the camera approximately 100’ (30m) from where you 
intend to aim the camera. Placing the camera too close to the model will often put you right up 
against a wall, and you’ll have to readjust the camera to see more of the model.

When you activate the Camera tool, you first establish the eye position and then set the target. 
It’s a simple two-click operation, and the next thing you know, you’re taken directly to the camera 
view, looking at a perspective of your model. Revit puts the camera at eye level by default when 
you place a new camera in a plan view. This is usually fine, but you’re free to adjust the camera 
dynamically or by manipulating the elevation of the eye and target levels through the element 
properties of the camera.

To adjust your camera dynamically, enable the SteeringWheel from the Navigation bar located 
next to the ViewCube, and use the options to orbit, zoom, pan, and move through the view.

The walkthrough options allow you to walk, look, and move the camera up and down. To 
adjust the focal length of the camera (zoom the camera in or out without moving the camera), 
click the small arrow at the bottom right of the SteeringWheel, and choose Increase/Decrease 
Focal Length (Figure 16.2). It acts as if you’re zooming your lens in and out, while keeping the 
camera stationary. (Don’t confuse this with walking the camera closer to the building.)

Figure 16.1 
Street-level  
perspective view.
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Showing the Camera
To see a camera from the context of 2D or 3D axonometric views, right-click the 3D view name 
in the Project Browser and choose Show Camera. The camera appears in all views as a camera 
icon with the view extents shows as red lines (Figure 16.3), so you can visualize where the cam-
era is relative to your model. At this point, the camera is selected, so you can move it to a new 
location, and the view updates automatically to reflect the change. You can also adjust the target 
position in this mode. Just be careful where you click—clicking anything else (including nothing) 
deselects the camera, which causes it to disappear.

Figure 16.2 
Focal length  
controls are 
accessed from the 
SteeringWheel.

Figure 16.3 
When a camera is 
shown, the view 
extents appear in 
all views.
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perspective Views are for Visualization

Currently, perspective views are used only for visualization. You can select elements and change 
their properties (or delete them) from a perspective view, but you cannot edit any of the model 
using grips nor edit commands within these views.

Silhouetted Edge Display
As you saw when we discussed elevations, overriding the edges of elements can help make a 
drawing more legible and graphically clear. In addition to using the Linework tool, you can 
use a more dynamic feature built into Revit, which accounts for the fact that perspective views 
are likely to be spun around and reoriented. From the shadow icon in the view frame control 
tools you can access the Graphic Display Options dialog box. Toward the bottom is a control that 
lets you set a line style called Silhouette Style.

By choosing a line style with a thicker line weight, you’ll see the effect of this feature. 
The line style isn’t applied to specific edges of the model but instead is dynamically redrawn 
depending on the camera’s point of view. Revit applies the line style to the outer edges of ele-
ments visible in the view, giving the model a bold outline. The effect can be subtle but elegant, 
as shown in Figure 16.4. If the effect is too subtle, try making the view larger (the default is a 
6” × 4.5” view) and making a new line style with a heavier line weight. 
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Creating Photorealistic Renderings
Revit provides an integrated rendering workflow that delivers stunning photorealistic render-
ings. The rendering engine works hand in hand with a library of rendering materials custom-
designed for architectural visualizations. With Revit’s rendering features, you can assign 
some materials, set up a camera, click Render, and get some great results right out of the box 
(Figure 16.5).

Figure 16.4 
Top: No silhouette 
edges applied;  
bottom: silhouette 
edges applied with 
a line style using a 
line weight of 6.
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The Rendering Dialog Box
To render a perspective view, click the teapot icon in the view frame controls at bottom of the 
view. This launches the Rendering dialog box (Figure 16.6), where you set all the parameters for 
the rendering, such as quality, output, lighting, background, and exposure settings. 

Let’s look at this dialog box in more detail, as each setting will affect how the rendering 
looks.

Quality

The first set of rendering options is the Quality settings (Figure 16.7). These affect the overall qual-
ity and, perhaps more important, the time it takes to render the view. The higher you go in quality, 
the longer the rendering time will be. We recommend rendering at draft or low quality initially 

Figure 16.5 
Example of  
rendering.

Figure 16.6 
The Rendering 
dialog box.
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and going to higher quality only after you have validated the material and scene selection 
assigned to the model.

The settings have been tuned for optimal results, but if you want to tinker under the hood, 
so to speak, you can select the Edit… option located at the bottom of the dropdown list. This 
opens the Render Quality Settings dialog box (shown in Figure 16.8), where you can see all the 
variables that affect the rendering quality. Any change you make to these settings is stored in 
the file as a Custom (view specific) setting. This prevents your changing any of the factory 
presets but at the same time gives you total flexibility to go beyond what has been preset.

The images on the right and left sides of each setting are visual cues to help you understand 
the effect of the setting. To see what each factory preset does, use the Setting drop-down list at 
the top of the dialog box. To edit these settings, click the Copy to Custom button. This copies all 
the settings into the editable custom setting and allows you to refine the settings.

Output

The Output Settings area allows you to set the resolution of the image being rendered. The 
default is Screen; the size of the image (width and height) is measured in pixels, as shown in 
Figure 16.9A. Choosing Printer allows you to select from some standard DPI settings. The Width 
and Height values update automatically for you, giving you an idea of the final output size and 
the Uncompressed Image Size, which is the size of the file if saved as an uncompressed TIFF 
(see Figure 16.9B).

Figure 16.7 
Quality setting 
options range from 
Draft to Best.

Figure 16.8 
To see all the 
parameters that 
affect quality  
settings, open  
the Render  
Quality Settings 
dialog box.
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Unless you are ready to send the rendering off for printing (150 dpi draft or 300 dpi finished 
print quality is recommended), keep the resolution at Screen (72 dpi). This will improve the 
speed of the renderings without compromising overall quality.

lighting

The Lighting options (Figure 16.10) set exposure levels, let you select what kind of lighting to 
use, and establish the sun position. The options are self-explanatory: just match the setting with 
the kind of camera you’ve set up. Are you outside? Inside? Do you want to see the effect of sun, 
just artificial lights, or both?

Sunlight

The sun position is enabled for any scheme that includes the sun as a light source. The list includes 
sun settings. To access and edit these settings, click the Edit option at the bottom of the list. You 
can also access this same list by choosing Settings  Sun and Shadows Settings from the Manage 
tab. The resulting dialog box (Figure 16.11) lets you edit the sun position by adjusting time, date, 
and place. Be careful not to edit a setting without changing its name. You don’t want to change 
carefully prepared and geographically correct settings. Always duplicate an existing one, give it 
a new name, and only then set your desired values.

Figure 16.9 
Select Screen or 
Printer to set the 
output size for  
the rendering.

Figure 16.10 
Lighting options.

Figure 16.11 
Sun and Shadows 
Settings dialog box.
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Artificial Lights

When you choose a setting that includes artificial lights, Revit calculates and renders light 
that emits from lighting fixtures in the view. All the lighting fixtures that ship with Revit are 
designed to cast light when rendered. For lighting fixtures that were previously placed in earlier 
versions (pre 2009) of the software, you’ll need to manually upgrade the fixture. This is not as 
hard as it sounds; simply select the fixture, click the Edit Family button in the contextual tab, 
and then load it back into the project once it opens in the Family Editor.

By default, Revit calculates all the lighting fixtures in your model, which can lead to extra-long 
rendering times. To improve speed, click the Light Fixtures button in the Rendering dialog box. 
This opens the Artificial Light dialog box, where you can choose whether fixtures will cast light. 
You’ll see a list of all lights in the project in this dialog box, and you can turn them on or off.

What if you want to make an interior rendering in a real project? To improve performance, 
you want to render only lights that are visible in the view. In the Rendering dialog box, click the 
Artificial Lights button. Whenever you select lights in the resulting dialog box (Figure 16.12), they 
are selected in the model (turning red), which makes it easy to know which lights are on or off.

Turning Off Lights in a Rendering

In Figure 16.13, we created a new group by clicking the New button and naming the group First 
Floor Lights. We moved lights to the group by clicking on each light to see if it highlighted in 
the view. When the light did highlight, we clicked the Move to Group button to move the light 
into the First Floor Lights group. Then, to improve rendering performance, all we had to do was 
clear the Ungrouped Lights option to turn off all the lights not in our view.

You can group lights together from any view in Revit when a lighting fixture is selected. 
To do so, select a fixture and check the Options bar. You’ll have the option to assign the light 
to an existing group, ungroup it, or create a new group by choosing Edit/New, as shown in 
Figure 16.14.

Figure 16.12 
Using the Artificial 
Lights dialog box.
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You can also choose to edit the group (if the light is in a group) by clicking the Edit button. 
This changes the model to halftone and shows all lights in the group as green. A floating toolbar 
appears that allows you to select light fixtures and either add or remove them from the group 
(see Figure 16.15).

BackgrOund

The Background settings (Figure 16.16) help give your model some context by using a sky, a sky 
with cloud cover, or color. The sky in Revit is tied directly to the Sun and Shadows settings and 
will accurately color the sky based on time, date, and place. As you get toward dawn or dusk, 
the sky will change color to reflect this. You won’t need to manually specify any color gradi-
ents. If you intend to use images in your background with a tool like Photoshop, you’ll be glad 
to know that the background is saved as its own channel when images are exported as PNG 
files. This means you can use whatever background image you want and get a clean, perfectly 
blended look. This also allows you to position and edit your background graphics in Photoshop, 
where you have total control.

Figure 16.13 
Grouping lights 
that are visible in 
the view.

Figure 16.14 
When a fixture 
is selected, the 
option to add it to 
a group is available 
in the Options bar.

Figure 16.15 
When editing a 
light group, you 
can add or remove 
fixtures from the 
group using a float-
ing toolbar.
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To add some clouds to the background, choose from the options available in the Style drop-
down menu. Clouds will appear wispy and subtle when using these options. If you want strong, 
high-contrast clouds, add them in postprocessing by doctoring your images in an image-editing 
program—just be sure to export to PNG. You can also use a single color for a background.

rendering the View

Once you’ve chosen the quality, output, and lighting scheme, you’re ready to render the view. 
Click the Render button and Revit will start the rendering process. Actually, a new process starts 
that is independent of Revit, so if the rendering were to get stuck or crash, you could stop the 
rendering process without having to stop Revit. You can see this in Windows Task Manager as 
fbxooprender.exe (see Figure 16.17).

A progress dialog box will also appear.

Here you will see how long the rendering is taking, how many artificial lights and daylight 
portals are being calculated, and if any warnings are encountered during the rendering process. 
An example of a warning would be if the path to images used for rendering were no longer 
intact. To cancel the rendering at any time, just click the Cancel button, and confirm you want 
to stop.

You can also decide to render just a portion of a view. This will save time but still give you an 
idea of the results to be achieved. To render only a portion of the view, use the Region check box 
next to the Render button. This enables a box in the view that you can adjust by selecting it and 
then dragging the grips to resize it. Use this option if you want to render only portions of the 
model to check materials, rather than rendering the entire view.

Figure 16.16 
Background 
options.

Figure 16.17 
Rendering is  
managed as a  
separate process  
by the CPU.
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adjusting expOsure

When you choose a lighting scheme, Revit automatically determines some exposure settings for 
you. You can adjust these either before or after running a rendering. Click the Adjust Exposure 
button to open the Exposure Control dialog box, shown in Figure 16.18.

After the rendering is complete, you can change the values of these options. Click Apply to 
change the appearance of the image after the rendering is complete. For example, if the render-
ing seems too dark, try decreasing the Exposure Value setting. To return settings to factory 
defaults, click the Reset to Default button at top of the dialog box.

saVing renderings as images

Once you’ve produced a rendering that you’re happy with and want to keep, the Rendering dialog 
box gives you two options. You can either save the image in the project or export the image to 
disk. When saving to the project, the rendering is saved in the Rendering branch of the Project 
Browser and can be dragged onto sheets like any other view. When exporting, the image will be 
exported and not stored in the project environment. If you need to do some postprocessing with 
Photoshop, click the Export button. You can save the rendering in standard image formats (BMP, 
GIF, JPG, PNG, or TIF).

Materials
Revit’s rendering materials are designed to convey characteristics of texture, color, reflectivity, 
and transparency that you’d expect to see in reality. An entire library of materials (branded as 
ProMaterials) was designed specifically for architectural visualizations. In this section you will 
learn about how to use the material library and how to create custom render appearances. 

editing a rendering appearance

The Revit materials have an associated tab that contains information about how each material will 
look when rendered. This information is located in the Render Appearance tab in the Materials 
dialog box, shown in Figure 16.19.

Figure 16.18 
The Exposure 
Control dialog 
box gives you a 
series of settings 
for adjusting the 
exposure.
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replacing materials

If you’re not satisfied with the default render appearances and need to manually assign new 
materials, the Replace button should be your first stop. Click that button to bring up the Render 
Appearance Library (Figure 16.20), where you can search for and assign render appearances.

Figure 16.19 
The Render 
Appearance tab  
in the Materials 
dialog box.

Figure 16.20 
The Render 
Appearance 
Library.
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In this dialog box, you can search for materials by typing in the search field, or you can sort 
the materials using the Class drop-down list. Selecting a render appearance and clicking OK 
closes the dialog box and replaces your active material with a new render appearance. Consider 
using this library before making your own customized materials, as they have been carefully 
tuned to work well in Revit models.

custOm rendering images

Many good-looking materials use digital images that are scaled to match the building model. 
These images are often professionally produced and edited so as to not tile in an obvious man-
ner when repeated over a surface in the model. 

Sourcing texture Maps

A hallmark of a bad image map is that you can see where each image begins to repeat. We don’t 
recommend making your own texture maps, because the tiling effect is difficult to manipulate on 
your own. Go to a website such as www.turbosquid.com or do image searches for materials.

If you have your own high-quality images that you’d like to use when rendering, this is not 
a problem. Locate your material in the Materials list. To remap your image, choose the Color 
parameter and select Image File (Figure 16.21). This takes you to a dialog box where you can 
browse to your own image file.

Figure 16.21 
Assigning an 
image file to a 
generic render 
appearance.
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You’ll then need to set the scale and change the preview to something more appropriate. 
Change the scale by typing in a value next to the image preview. This value sets up the repeti-
tion module for the image—relating a pixel-dimensioned image to a real-world scale. You can 
play with other parameters available in the generic render appearance, but for the most part, 
getting scale correct will be the most important task.

To change the preview, use the drop-down menu next to the preview swatch scene at the top 
(Figure 16.22). In this example, we are using a custom brick image and changing the preview to 
use the Flat Surface setting.

adding entOurage fOr rendering

Adding people, cars, and trees to a rendering will give it a sense of scale and context. This tech-
nique is usually applied to give a rendered image a more realistic and human effect. This can be 
achieved by placing entourage and planting families into your model. When rendering a view, 
this content takes advantage of Rich Photorealistic Content (RPC) technology to show photo-
graphic images in the context of the rendering. 

Note that any trees created pre-2009 Revit will not render. You’ll need to load new trees and 
replace the old ones manually. To do so, load from the planting folder and select an RPC tree. 
Doing so will load many types, and you can choose from a list of RPC trees (Figure 16.23).

To replace trees quickly, use the Select All Instances option in the context menu when a tree 
is selected. This selects all instances of the tree and allows you to change the type to an RPC 
type. Be aware that the graphics will change, as the new RPC trees use a different mode of rep-
resentation than previous versions of Revit. To see what RPC file is associated with a type, select 
the tree, open Instance Properties, select Edit Type, and click the Render Appearance parameter 

Figure 16.22 
Changing the 
Scene preview.
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in the Type Properties dialog that opens. This opens a Render Appearance Library with all of 
the available RPC trees (Figure 16.24).

Once you have placed your trees, render the view, and you’ll see the results (Figure 16.25).

Rendering Tips
Here are some guidelines for rendering efficiently.

Don’t set the Quality settings to Best when iterating through material selections; doing so •u	

only slows down the time it takes to render. Keep Quality at Low or Medium until you’re 
ready for a final pass.

Use a low screen resolution until you’re ready to export a final image for printing.•u	

Figure 16.23 
Some RPC tree 
types provided 
in Revit planting 
content.

Figure 16.24 
Render appear-
ances for trees are 
accessed via the 
Type Properties 
dialog box.

56491c16.indd   476 6/2/09   11:00:50 PM



creating animated walkthroughs | 477

Turn off lights that aren’t visible in your view using the Artificial Lights dialog box. Group •u	

lights by floor if you are doing interior renderings of various floors in your model. This will 
speed up your renderings.

Adjust quality settings only if you absolutely have to. Changing one value could inadver-•u	

tently slow down your renderings and return unnoticeable effects. All of Revit’s presets 
were carefully calibrated and should do the trick.

Export rendered images to PNG in order to composite the image with background •u	

imagery.

Creating Animated Walkthroughs
Moving through a building in a virtual manner is a great way to experience a design before 
it gets built. Static images are nice, but it’s becoming a common method to create animation 
sequences that showcase key aspects of the design. Revit provides tools for creating walk-
through sequences for the model, which you can then export as an AVI file.

To make a walkthrough in Revit, the process is as follows:

 1. In a plan view, create a path through the model by starting the Walkthrough tool located 
in the Create panel of the View tab. The Walkthrough tool is located in the 3D View drop-
down list.

Once you’ve clicked the tool, you’re put into a Sketch mode where each click creates a key-
frame that lets you change the direction of the camera. Think about how a camera would 
move through or around a building. When you’ve finished sketching, click the Finish 
Walkthrough button on the Ribbon.

 2. Edit the keyframes along the path, so the camera looks in the proper direction, by click-
ing the Edit Walkthrough button on the Ribbon.

Figure 16.25 
Example of  
RPC trees  
rendered in a  
perspective view.
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In this mode, you can edit the camera and path. The default setting allows you to step through 
each keyframe using the VCR-style controls located in the Modify Cameras contextual tab and 
adjust the camera direction in the view. You can edit the camera direction only at keyframes. 
To see what the camera sees, click the Open Walkthrough button. Keep stepping through key-
frames and adjusting the camera. In the camera view, you can enable the SteeringWheel and 
change the direction the camera is looking just as you can in a 3D perspective view.

 3. With the walkthrough view open, export the walkthrough to .avi format by using the 
Application Menu and choosing Export  Images and Animations  Walkthrough. 
Figure 16.26 shows the resulting Length/Format dialog box.

Exporting the 3D Model for Use in Other Applications
If you have established ways of working with vector or pixel-based artwork, you can always 
export Revit views and use them as backdrops for your artistry. From the application menu, 
choose Export. You’ll find options to export CAD formats for DWG, DXF, DGN, and SAT. You 
can also export any view as an image file using the Export  Images and Animations option. 
Supported formats include BMP, JPEG, PNG, TARGA, and TIF.

Once you’ve made edits to the exports in applications such as Photoshop, Illustrator, or 
Piranesi, you can always re-import the artwork into Revit and place it on sheets with your other 
views.

For rendering purposes, you can export a Revit file to FBX format (Figure 16.27) and open 
it in 3ds Max (2009 or later). Even though Revit can create compelling renderings on its own, 
the ability to batch render as well as utilize render farms means that you’ll be able to create 

Figure 16.26 
The Length/ 
Format dialog box 
lets you set out-
put values for the 
length and size of 
the animation.
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renderings in minutes rather than hours when using 3ds Max. In addition to the geometry, the 
FBX file contains information about the materials in the model (Figure 16.28) and to which ele-
ments the materials are applied. This information is available only if you open the file with 3dS 
Max or 3dS Max Design 2009 or later.

The Bottom Line

Create perspective views.    Design visualization is a key benefit to using Revit as a documen-
tation solution. Being able to snap quick perspectives of your spaces and building forms can 
be critical to making good design decisions.

Master It    Create a new perspective view showcasing a critical design feature. Use the 
Rendering dialog, lighting, and the materials dialog to complete the rendering.

Figure 16.27 
On the Export 
menu you’ll find 
the option to 
export to FBX.

Figure 16.28 
Rendered model 
using 3ds Max.
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Create photorealistic renderings.    You know those signs that are put up at a site before and 
during construction—the ones with the nice rendering showing the final product? Well, you 
can generate those directly in Revit!

Master It    You’ve been asked to produce an exterior rendering of a building. Can you do 
this in Revit? Can you tweak the results in Photoshop?

Create animated walkthroughs.    Creating animated walkthroughs is an excellent way 
to visualize the spaces within the project, as walkthroughs are more dynamic than still 
renderings. 

Master It    You want to create a compelling animation showing an entry approach to the 
building. How would you do that with Revit?

Export the 3D model for use in other applications.    Revit is an excellent application, but 
a variety of other tools are available that you might want to use for rendering, modeling, or 
other BIM features such as 3D printing.

Master It    You’ve modeled your project in Revit and assigned materials, and now want 
to make an animation sequence with 3ds Max. What should you do?
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Fine-Tuning Your Preliminary Design

The next step we’ll explore is taking a preliminary building design and doing spatial analysis of 
the Revit model. You’ll see how creating simple schedules of building and room areas can verify 
program information and start to generate preliminary cost analysis. We’ll show you how to ver-
ify program data and evaluate a project’s initial feasibility. 

In this chapter, you’ll learn to:

Quantify your preliminary designs•u	

Create schedules•u	

Use schedules for preliminary cost estimates•u	

Quantifying Your Preliminary Designs
In this chapter we’re introducing a scenario that we’ll build on in the next several chapters. As 
this is a Mastering book, we won’t go into significant detail about how to perform some of the 
more basic techniques in Revit, such as how to make simple walls, floors, and roofs. Instead, 
you’ll work from an existing, more developed design and build skills by adding and extracting 
information to and from this base model. You will move the design from a preliminary level 
through a set of design documents based on common architectural requirements that occur in a 
typical project workflow. We will also explore some sustainable design strategies.

The Foundation Model
The model we’ll be using for the next several chapters can be downloaded from the book’s 
companion web page, www.sybex.com/go/masteringrevit2010. Called “The Foundation ch17,” 
it was part of a design competition for a university alumni facility and was created by BNIM 
Architects. The building is approximately 46,000 square feet and comprises office space, meet-
ing areas, and multipurpose space spread out over three floors. It is located at a major university 
in the Midwestern United States (see Figures 17.1 and 17.2). Under a leaseback agreement, the 
building will be owned by its builder rather than the university—hence you will need to calcu-
late rentable area.
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We recommend doing a few things to familiarize yourself with this model:

Open the project, and in the Project Browser, choose View •u	  All. This will give you a list of 
all the views in the model and provide you with an opportunity to browse through them 
and see what has been given focus and importance

Take a look at the generic 3D view. Using the ViewCube, spin it around a bit and kick the •u	

tires, so to speak. Take a look at the overall building form and geometry to help acclimate 
yourself to the overall design. That will give you a sense of direction within the building

Browse through any sheets that have been set up. Not only will this give you an idea of •u	

what the building looks like, but it will also tell you what stage the project is in and what 
the focus has been so far

In this Foundation model you will find many preestablished 3D views, as well as some sec-
tions and generic plan views. Sheets have been started and views placed on those sheets. A 
structural grid, elevations, and the primary building materials have all been defined. Based on 
the plans, you can get a clear idea of what the building program is and how the spaces are orga-
nized. At this stage in a project workflow, you’ll often need to take a short timeout from design 
work and do some program verification and evaluation, with the goal of creating an initial cost 
per square foot assessment. To do that, you will first create area plans for the Foundation’s total 
and rentable areas and then create schedules of materials so you can check costs against some 
square foot assumptions. This is where we’ll begin with this model.

Figure 17.1 
Perspective view 
of the Foundation 
model.

Figure 17.2 
Another view of 
the Foundation 
model.
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Calculating Area Plans
For the purpose of program verification, you need to establish how area values are calculated 
and represented. The simplest method is to use room tags, which can report room area, but 
you’ll quickly see the limitations of that approach. Room tags only report the carpet area of the 
room and the calculated room surface does not take into account walls. For the feasibility study 
in this chapter’s example, you’ll need to create area plans for both total area and rentable area. 
Then we’ll show you how to add areas and area tags manually.

Rooms and Room Tags
The room tag shown in Figure 17.3 has been placed in the model and is tagging a room. This is 
used to label the room and its surface. The surface value or the value expressed in square feet 
(SF) on the room tag is the usable area within the room, sometimes referred to as the carpet area.

Revit calculates this area by finding all of the entities that touch the floor bounding a space. 
As you can see from the thick outline of the room in Figure 17.3, it does not include things like 
the area below the column (at the upper left) or other objects that penetrate the space, giving you 
a truly usable floor area. Later in this chapter, we will discuss how to schedule those areas so 
you can report them in a way that they are all visible at the same time.

While this is certainly a useful feature, it does not accommodate calculation of the precise 
areas you will need to verify your program or perform any cost take-offs.

Area Plans
Area plans are views of the model used to calculate the areas of your model according to vari-
ous calculation standards. Some of the standards for area calculations are as follows:

Gross area    This is the overall area of a floor or footprint of the building.

Rentable area     Different developers and leasing companies have different standards for 
rentable area. For example, it may include all the spaces in a building except egress corridors, 
vertical transportation, and mechanical spaces. However, this includes the floor area taken 
up by columns and some walls.

Figure 17.3 
Room area as a 
property reported 
in the room tag.
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Usable area    This area defines only the usable space in a plan. It doesn’t count areas taken 
up by columns, walls, mechanical rooms, and shafts or other unusable space.

BOMA area    BOMA is the Building Owners and Managers Association. Widely used in the 
United States by architects, developers, and facilities managers alike, it was created to help 
standardize office building development. BOMA has its own set of standards for calculating 
areas. More information on BOMA standards can be found at www.boma.org.

Revit allows you to choose from two predefined area schemes, or it gives you the option to 
create your own scheme based on standard area calculation variables. 

All area- and room-related tools are available on the Home tab (Figure 17.4).

To add or modify the area settings, on the Home tab click the arrow in the Room and Area 
panel to expand it. From the expanded menu, select Area and Volume Computations. The Area 
and Volume Computations dialog box shown in Figure 17.5 will appear.

The Computations tab allows you to change how the areas and volumes are calculated in the 
model. Here you can set how areas are calculated relative to the wall geometry (wall finish ver-
sus wall core, for example).

The Area Schemes tab, shown in Figure 17.6, lets you add different schemes to calculate room 
areas, allowing you to calculate multiple area types.

In the sample Foundation model, you first need to establish the gross area per floor of the 
building. To do this, begin by adding an area plan to the model.

Figure 17.4 
Room and Area 
tools panel located 
on the Home tab.

Figure 17.5 
The Area and Vol-
ume Computations 
dialog box, with 
the Computations 
tab displayed.
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Creating a gross area Plan

Take the following steps to begin creating a gross area plan:

 1. Open the ‘Foundation ch17’ model.

 2. Select the Area button from the Room and Area panel on the Home tab and click Area 
Plan (see Figure 17.7). This opens the New Area Plan dialog box, where you will select 
the area scheme, levels, and scale. Select Gross Building from the drop-down menu at 
the top. Using Shift-click, select the floor plans for Level 1, Level 2, and Level 3. Leave the 
scale at the default setting, 1⁄8˝ = 1́ -0˝ (1:100), and click OK. You will then be presented 
with a dialog box asking you if you would like to ‘Automatically create boundary lines 
associated with external walls and gross building areas?’ Click Yes to continue. You’ll 
have to do this once for each floor plan selected.

Figure 17.6 
The Area Schemes 
tab of the Area and 
Volume Computa-
tions dialog box.

Figure 17.7 
Creating area  
plan views.
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 3. Revit automatically adds a new node called ‘Area Plans (Gross Building)’ to the Project 
Browser and adds plans for each level you selected. Open the Level 2 area plan.

 4. In the View window, you’ll see a duplicate of the Level 2 plan view you selected. The dif-
ference between the original Level 2 and this one is that it has purple lines defining the 
area boundaries (see Figure 17.8). This might be a challenge to notice in this black and 
white image, but you will get the idea if you open the project and follow the steps we 
indicated. These purple lines are placed on the walls according to the type of area plan 
computation you selected, which in this case was Gross Building Area. You can make 
manual adjustments to these lines, move them, or delete them if they don’t appear where 
you want them.  In our instance, you’ll note that Revit didn’t draw all of the lines around 
the building.  This is easy enough to remedy.  Using the Trim command from the Modify 
tab, simply trim the remaining lines to complete the area.

 5. Revit has generated Gross Building Area plans for each floor, and you can start adding area 
tags to get an idea of what your floor areas are for this project. From the Home tab, in the 
Room and Area panel, expand Tag Room and select Tag Area. You can do that by selecting 

Figure 17.8 
Area boundary 
lines for gross area 
are indicated by 
the gray color.
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the area tag is located As you can see, you have about 21,192 square feet (~ 7,000 m2) of area 
for the first floor. 

The area boundaries that Revit applies automatically are not set in stone. Should you need 
to manually change them and add new boundaries, you can do that using the Area Boundary 
tool, also available under the Area button. When adding new boundaries, note that they must 
form closed loops of lines in order for Revit to calculate areas. Any breaks or gaps between the 
area lines, or lines that don’t intersect, will result in Revit returning a “Not Enclosed” value for 
the area. If you get that message, inspect all your lines, and close gaps using the Trim tool or by 
extending the boundary lines. It is not possible to add Area Boundary lines to anything but an 
area plan. That option will be grayed out in all other views.

Creating a rentable area Plan

Now that you have defined the Gross Area and have a good idea of what the floor plate sizes 
are, you can move on to getting a better understanding of the building program. For the pro-
gram verification, you need to figure out the rentable area for each of the spaces so you can see 
how well you fared against the program supplied by the client for this project. Using the same 
process described earlier for the gross building areas, you can make rentable area plans for the 
building. Repeating the technique described earlier but selecting the Rentable option, you’ll cre-
ate a new view in the Project Browser: Area Plans (Rentable).

You’ll notice that in displaying rentable areas, Revit draws the area boundary on the inside 
of the exterior walls (unlike with the gross area, where the lines were drawn on the outside of 
the exterior walls), but it also draws boundaries down the centerline of the interior walls. All of 
this happens automatically—all that is left for you to do is to verify the lines and make sure you 
have them where you need them. 

For this exercise, you’ll want to modify the results slightly from what Revit provides by default. 
For the program and client on this project, you’re not going to calculate core areas (areas around 
the elevator and stair cores) as part of the rentable area, so you’ll need to adjust the area boundary 
lines around the core walls to reflect this and turn the many spaces into one area.
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automating area Calculations during Design

When Revit creates area boundary lines, those lines by default are locked to the walls on which they 
are created. This is a helpful feature: when your design changes and walls are relocated, the area 
boundaries automatically update as well, keeping your area plans always up to date.

In the case of the restroom core, start by deleting the lines that separate the restrooms from 
the janitorial closet (see Figure 17.9).

As you delete area lines, you’ll more than likely get the warning message shown in Figure 17.10. 
This message tells you that you have removed the boundary between two areas, and Revit is 
asking what to do with them. Before answering this question, let’s discuss what “areas” means 
in Revit. 

In the context of Revit, areas are elements, just like walls, doors, and furniture. They are 
selectable, have properties, and can be scheduled. When selected, they will highlight in yellow 
and appear within the space as a box with an X through it, as shown in Figure 17.11.

Because areas are elements, you can tag them. An area tag reflects the properties of the ele-
ment it is tagging. The tag itself is only an annotation.

Figure 17.9 
Modifying an  
area plan.

Figure 17.10 
Area warning  
message.
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At this point, you might be asking yourself, “Where did those areas come from? I didn’t 
insert them.” The answer is that Revit generated them automatically when you created the area 
plans. This is the essential difference between rooms and areas. By default, when you create a 
new area plan, it creates an area element within all of the closed area boundaries, so as long as 
there are no adjustments for you to make, it is only necessary for you to tag and label the areas.

In this case, you needed to make some changes to what Revit provided by default and now 
have more areas than you have spaces. So let’s jump back to the warning dialog box. You’ve been 
given two choices: delete all but one of the areas or click OK and accept having multiple areas in 
the space. Both of these options have viable workflows. If, as in our case, you do not plan to sub-
divide the room again, you can click Delete Area(s) to delete the extra areas and continue with your 
work. If you had deleted these lines with the intent of drawing new ones in a different location 
within this boundary, you could click OK, knowing you would have redundant areas for a short 
time until you finish this part of the model.

Clicking Delete Area(s) deletes the redundant areas and gives you a single core area for the 
restrooms shown in Figure 17.12.

Figure 17.11 
Areas are select-
able elements with 
properties.

Figure 17.12 
One area is used for 
the restroom core.

56491c17.indd   489 6/2/09   2:38:21 PM



490 | Chapter 17 Fine-Tuning Your PreliminarY Design

Since you don’t want to count any of the core areas, you’ll need to move the boundary lines 
from the centerlines of the walls to the inside face of those walls. Because the area boundaries 
surrounding the restrooms are locked to the walls themselves, you need to delete these lines 
and redraw them in desired locations. By now, you’ll be used to the warning message about 
redundant areas, and in this case you know that you want to keep the areas and click OK 
instead of the Delete Area(s) button.

To draw the new area boundary lines, use the Area Boundary Line tool described earlier to 
add the new area lines to surround the core. If you choose the default Pick option, Revit will 
automatically choose the line location based on the rules established for that area plan type. 
Since we specifically want the area lines on the outside of the core, it is best to draw them manu-
ally. So, instead of the Pick tool, select the Line tool from the Draw panel on the Place Area 
Boundary tab. Very quickly, our new core boundary will look like Figure 17.13. 

Creating Complex area plans

In some cases, such as General Services Administration (GSA) projects, there is a need to create and 
maintain a series of possible area plans. All these additional calculations can slow file performance, 
depending on the complexity of the building. One way around this is to make a separate project 
file for the area plans. By linking the building model to a separate file with area plans, you cannot 
improve model performance, but you can create the area plans quickly without interfering with 
other workflows. 

Figure 17.13 
Use the Area 
Boundary Line tool 
to revise the core 
boundary.
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Adding Areas and Tags
As we mentioned earlier, areas are actually elements within the model. When we made the area 
plans, Revit automatically populated the plan with area boundaries. However, you might want 
to create your own areas or area boundaries to provide for area types that Revit cannot auto-
matically generate. You might want to add units to a condominium building, for example. To 
add boundaries manually, click the Area button and use the Area Boundary Line tool. This adds 
an area and a tag (provided Tag on Placement is checked in the Options bar) at the same time to 
your area plan.

To tag an existing area element that was created without a tag, on the Area and Room panel, 
expand the Tag button and use the Tag Area button.

Don’t Draw More than Necessary

When designing office buildings, you will probably have your building cores as a repeating element 
on each floor of the building. In many cases, these cores will be identical. If that is the case, there is 
no need to redraw your area lines. You can simply group the area lines and then copy those elements 
between floors. This way, if you edit one group the change will be propagated to all other groups.

To copy area boundaries between floors, select them and copy them to the clipboard using 
the following steps.

 1. Select area boundaries using one of the following options:

Ctrl-click each line individually•u	

Highlight one line by mousing over it (don’t click) and press the Tab key. This will •u	

highlight the chain of all the connected lines, and you can then click to select them

Drag a selection window around all of the elements, and using the Filter tool in the •u	

Multi Select tab, filter out all but the <Area Boundary> lines, as shown in Figure 17.14. 
This is probably the best method

Figure 17.14 
Filtering your 
selection.
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 2. Once the Area Boundaries are selected, you can use Ctrl+C or the Copy command from 
the Clipboard panel to copy them to the clipboard. Now, choose Paste Aligned from the 
same panel and from the expanded menu, select the option Select Views (see Figure 17.15) 
to paste your copied area boundaries directly into the same location on other floors, 
ensuring consistency in your area calculations.

 3. Now that you have all the areas defined, you can present them by printing the individual 
views to see graphically how the spaces are assembled (see Figure 17.16).

But what happens if you want to show this information in a tabular, spreadsheet format? 
Often you’ll need to share information of this kind in a table format. Because Revit is based on 
a bidirectional information model, it can do all of these calculations and update tasks for you 
in real time. All you need to do is set up a view type in the model that allows you to look at the 
data in a list format instead of showing the information graphically. For this, use schedules.

Creating Schedules
Schedules are lists of elements within the model. They enumerate items, including building 
objects such as walls, doors, and windows; calculate material quantities or areas and volumes; 
and list the number of sheets, text notes, keynotes, and so on. The ability to dynamically create 
and update schedules is a core aspect of both BIM and Revit.

Creating schedules of objects, areas, or material quantities in a project is usually one of the 
most painful (if not boring) but necessary tasks for architects. Needless to say, performing a 

Figure 17.15 
Pasting the copied 
Area Boundaries 
into selected views.

Figure 17.16 
Area and tag 
graphics.
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manual calculation takes a long time and can result in errors. Using CAD tools can partly auto-
mate this process, but when it comes to calculating numbers of objects, the calculation can only 
count the number of blocks that are predefined in a file. In Revit, all elements have information 
about their physical properties, and you can add information to individual elements. For exam-
ple, doors can have properties such as size as well as material, color, fire rating, and whether 
they are exterior or interior.

Revit lets you schedule any element based on properties of the element. In effect, this means 
that almost anything placed in a Revit model can be scheduled and quantified. Additionally, 
because the schedule is linked to the objects in the model, you can use the schedule to locate 
objects within the model or to change their types and properties. This ensures that in any view, 
regardless of type, the count and properties of all elements are always synchronized. As we 
often state, the view in which you add or change something doesn’t matter; the changes will be 
reflected in all the views.

If you’re unfamiliar with database concepts, don’t worry; we’ll explain the options in the 
New Schedule dialog box. The following types of elements can be scheduled:

Areas
Casework
Ceilings
Curtain panels
Curtain systems
Curtain wall mullions
Doors
Electrical equipment
Electrical fixtures
Fascias
Floors
Furniture
Furniture systems

Gutters
Lighting fixtures
Mass
Mass floors
Mechanical equipment
Parking
Planting
Plumbing fixtures
Property line segment
Property lines
Railings
Ramps
Roofs

Rooms
Site
Slab edges
Specialty equipment
Stairs
Structural columns
Structural foundations
Structural framing
Structural trusses
Topography
Wall sweeps
Walls
Windows

There are also some other schedules you can create that are not limited to specific types of 
elements:

Multicategory    This type of schedule is for objects that span across Revit category organiza-
tion. For example, you may want to create a list of windows and doors in the same schedule. 
You may also want a schedule showing all the casework and furniture in a project. A multi-
category schedule allows you to combine a number of different categories into one schedule. 
It is also the only way to schedule generic model elements. The one limitation of a multicat-
egory schedule is that you can’t schedule host elements (walls, floors, roofs), only their mate-
rials and family components.

Area (gross building)    This schedule lists the gross building areas created with the area 
plans.

Areas (rentable)    This type can be created with a rentable plans schedule. Later in this 
chapter, we’ll walk through an exercise demonstrating how to create a simple schedule show-
ing the program areas we created in our area plans.
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Although we’ve listed quite a few, we haven’t included all the schedules available in Revit. 
There are still a few more worth mentioning. These schedules can be accessed only from the 
View tab. To see them, expand the Schedules button on the Create tab.

Material take-off    This type of schedule can list all the materials and subcomponents of any 
Revit family and allow an enhanced level of detail for each assembly. You can use a material 
take-off to schedule any material that is placed in a component. For example, you might want 
to know the cubic yardage of concrete within the model. Regardless of whether the concrete 
is in a wall or floor or column, you can tell the schedule to report the total amount of that 
material in the project. As we will show later, you can use this schedule type to make some 
preliminary calculations regarding the use of recycled materials in the project to support 
sustainable design goals.

Drawing list    This schedule shows a list of all the sheets in the project, sorted 
alphabetically.

Note block    This schedule lists the notes that are applied to elements and assemblies in 
your project. You can also use a note block to list the annotation symbols (centerlines, north 
arrows) used in a project.

View list    This schedule shows a list of all the views and their properties in the Project 
Browser.

These schedules are separated from the main list of schedules because they aren’t commonly 
used in building documentation. They are primarily for data coordination that happens outside 
the project documentation.

The Keynote Legend is located under the Legends button on the Create panel of the  
View menu.

The Revision Schedule is available in the Family Editor environment. You use this schedule 
when creating a Titleblock family.

Standardize Your Schedules

 You will find yourself making the same schedules for each and every project. Take the ones you 
find the most universal and make them a part of your default template. As you add content to the 
model, these will start to autopopulate.
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Making a Simple Schedule (Rentable Area)
You can begin making a new schedule by selecting the View tab, and in the Create panel, expand-
ing the Schedules button. There you select Schedule/Quantities. When you begin a new schedule, 
you will have a number of format and selection options. These will help you set the font style and 
text alignment as well as organize and filter the data shown in the schedule. Remember that Revit 
is a database at its core, so many of the same functionalities that are available in database queries 
are also available in Revit.

Sorting Your Drawing List

The drawing list can also be used as a sheet index to the documents. By default, Revit sorts sheets 
alphabetically. It is traditionally desirable to prepare the sheet index with civil sheets first, then 
architectural, structural, and so on. One way to customize sheet sorting is to add a Discipline field 
to the schedule and number the sheets so civil is 1, architectural 2, and so on. You can then sort by 
that numbered column.

The process of creating a new area schedule is best demonstrated with an example. Take the 
following steps to create a new rentable area schedule for the Foundation model:

 1. Open the Foundation.rvt file from the book’s companion web page (www.sybex.com/go/
masteringrevit2010).

 2. Navigate to the View tab, and click Schedules  Schedule/Quantities.

 3. Choose Areas (Rentable) from the Category area, name the schedule Rentable Area 
Schedule, and confirm by clicking OK.

You will see a series of tabs that allow you to specify the schedule’s graphic appearance and 
choose exactly what data you would like to show. Figure 17.17 shows the dialog box for the rent-
able area schedule. As each grouping of elements within Revit is unique, the list of possible 
schedule values changes accordingly.

Figure 17.17 
Rentable area 
scheduling options.
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Each tab controls different ways to sort and view the data within a schedule. Here is a basic 
explanation of their functions:

Fields    The Fields tab lets you select the data that will appear in your schedule. For the wall 
schedule, it shows all the properties available in the wall family.

Filter    On the Filter tab, you can filter out the data you don’t wish to show. You’ll use this 
tab, for example, to restrict displayed data so that only information about the concrete walls 
in the project appears in the schedule.

Sorting/Grouping    This tab lets you control the order in which information is displayed. 
You can also decide whether you want to show every instance of an item or only the totals for 
a given family.

Formatting    The Formatting tab controls the display heading for each field and whether the 
field is visible on the schedule. It’s possible to add fields that are necessary for calculations 
or sorting but don’t show on the printed copy of the schedule. Additionally, this tab can tell 
Revit to calculate the totals for certain fields.

Appearance    The Appearance tab controls the graphical aspects of the schedule, includ-
ing the font size and type of text for each of the columns and headers in the schedule. It also 
allows you to turn the grids on and off or modify the line thickness for the grid and bound-
ary lines. 

The following example walks through the different options in the New Schedule dialog box 
while you create a new wall schedule. 

In this example, you’ll create the schedule, filter out all but the concrete walls, and calculate 
the volume of recycled content in the walls based on the assumption that you’re using 15 percent 
recycled content in all the concrete you pour on this project.

 1. For your schedule, choose the following fields from the Fields tab and sort them in this 
order:

Level

Name

Area

 2. Select the Sorting/Grouping tab to give the schedule some parameters to sort by. First, 
sort by level, so you can see which floors you have the areas on, and then sort by area 
name. You will also want to see a total of the areas by floor, so include a footer showing 
totals only for the levels. Also check the Header check box so you can tell which floor 
you’re on in each grouping. Finally, you’ll want to see a grand total of all the areas in the 
building. Your dialog box should look like Figure 17.18.

 3. Select the Formatting tab, as you’ll also want to make a couple of changes here. Select 
the Level parameter and select the Hidden Field check box. You don’t need to see a level 
heading for each item in the list, especially since you have one established already as a 
header for each floor. You’ll also want to select the Area field and make two changes: first, 
right-justify the areas so they align properly, and then check the box to have the schedule 
calculate totals, as shown in Figure 17.19.

 4. Clicking OK at this point will give you a schedule broken out by level and totaling each 
floor’s areas. Your schedule should look something like Figure 17.20.
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 5. For areas, you are concerned only with the rentable spaces and don’t need to see how 
much area the cores take up in the building. By right-clicking on the schedule, you 
can view its properties and make some modifications. Choose the Filter tab this time, 
filter out any name that does not contain the word Core (with a capital C), as shown in 
Figure 17.21, and click OK.

Figure 17.18 
Set the Sorting/
Grouping tab to 
match this.

Figure 17.19 
Set up the Format-
ting tab to look  
like this.

Figure 17.20 
The area schedule.
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 6. Pan down to the bottom of the list and you will notice that you still have the name 
Restroom core in the list (see Figure 17.22).

 7. The name Restroom core is still in the list because the filter and fields in the schedules and 
families within Revit are case-sensitive. The fields need to match exactly. However, there 
is an easy fix. By clicking within the cell itself, as you would do in Excel, you can modify 
the word core so it has a capital C and the name will then be filtered from the list. The fin-
ished schedule should look like Figure 17.23.

Figure 17.21 
Filter out areas 
that do not include 
the word Core.

Figure 17.22 
Check the schedule 
to see the effect of 
the filter.

Figure 17.23 
The finished area 
schedule.
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Placing the Schedule on a Sheet
Now that you’ve created the schedule for the program, you need to put it on a sheet. As you’ve 
figured out by now, schedules work like any other view: to place the schedule on a sheet, drag 
and drop it from the Project Browser onto the sheet you wish to place it on. One of the nice 
things about schedules is that you can actually place them on multiple sheets and they will 
always provide the most current information.

We want to create a set of sheets you could provide to the client that demonstrates the pro-
gram for each floor in both graphic and list format. When finished, you should have an 11×17 
presentation sheet that looks like Figure 17.24, with a floor plan and schedule for each floor.

 1. Expand the sheets in the Project Browser and find the sheet 01 – First Floor Program.

 2. Expand the rentable area plans and drag and drop the Level 1 Rentable Plan onto the sheet.

 3. You will notice that the plan is much larger than the sheet, since we made the area plan 
at 1⁄8˝ scale originally. Right-click on the plan and choose Activate View from the context 
menu. In this view, you want to do two things: change the scale, and turn off some of the 
unnecessary annotations. So, first, adjust the scale of the drawing to be 1⁄16˝ = 1́ -0˝ (1:200). 
Second, open the Visibility Graphics dialog box (by typing VG or choosing the View tab 
and in the Graphics panel, clicking Visibility/Graphics). On the Annotations tab in the 
Visibility/Graphic Overrides dialog box, turn off visibility for the following categories:

Elevation tags•u	

Grids•u	

Reference planes•u	

Section tags•u	

Figure 17.24 
Finished presenta-
tion sheet with 
area plan and 
schedule.
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Once the view is resized and the display reconfigured, place the plan at the upper portion of 
the sheet.

 4. Drag and drop the rentable area schedule onto the same sheet. When it first appears, it 
will look something like Figure 17.25. You’ll need to do a bit of rearranging to get the 
schedule to fit the sheet properly.

Now, there are two different ways to modify the shape of the schedule directly from the 
sheet. The first one way is by dragging the triangles that appear on the upper portion of the 
schedule header. Note that there is one blue triangle for each column. By dragging the triangle 
left or right, you can resize the width of each column. You will notice some of our longer room 
names have wrapped to the next line. Grab the left triangle and drag it to the right to lengthen 
the Name field. Note that this also shortens the schedule by removing the wrapped lines.

The other way to modify how the schedule fits on the sheet is to use the squiggle, located 
in the center of the schedule. Clicking the squiggle splits the schedule into two columns. It is 
important to note that you cannot choose where this split occurs. However, you end up with two 
separate columns that you can now drag independently of each other. Now that the columns fit 
within the space you have remaining, you can relocate them on the right-hand portion of the 
sheet. The sections of the schedules can be subdivided as many times as you need, and each sec-
tion will subdivide independently of the others. Your final sheet will look like Figure 17.24.

Figure 17.25 
Unformatted 
schedule placed  
on sheet.
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Keeping Building area Schedules Updated

To most clients, building areas are a critical part of the development pro forma. (The pro forma is a 
document, typically a spreadsheet, that outlines the financial goals of the project or development.) 
In practice, you will create area plans that coincide with how the owner needs areas computed 
for its calculations. You keep these in a schedule, allowing owners to make regular updates to the 
building areas so they can compare them to the current pro forma. Since you can keep the schedules 
dynamically updated, you can set this up once and know that the areas will always be up to date. 

Additional Schedule Capabilities
Now that you’ve generated a schedule of spaces, let’s look at some of the other advantages of 
using schedules in the design process. Since Revit is a parametric modeler, all parameters are 
linked to elements within the model. You might notice that at the top of your schedule, the label 
is simply labeled Area. This is easy to change.

 

If we were not using BIM as a modeler, it would become tedious to locate these areas so they 
could be properly labeled. In Revit, there are two ways to rename these spaces. First, if you 
know what the areas are supposed to be, you can either type the name in or select it from the list 
of already used names. However, what happens when you need to locate the room on the plan 
before making changes to it? This is easy to do within Revit. By selecting the area name in the 
schedule, you’ll get useful tools in the Quantities tab of the Modify Schedule tab.

The Highlight in Model button repeatedly cycles through all of the existing views within 
Revit and zooms into the one that would best show the area in question. Clicking the button 
gives you a view similar to what you see in Figure 17.26. As you can see, the restroom does not 
have a descriptive name and is shown highlighted in the view. 

Figure 17.26 
Use the Highlight 
in Model option to 
point to the loca-
tion of elements 
highlighted in the 
schedule.
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This is a powerful tool because it can be used to locate any of the elements within the Revit 
model directly from any schedule. Not only do Revit schedules report information about ele-
ments in the project, but they can also be used to control elements. If you decide to exchange one 
wall type for another, you can do so by clicking in the schedule—under wall types, for example. 
A drop-down menu appears, listing all available types currently in the model, so you can 
choose the type you want. Again, this automatically changes the instance of the wall to another 
wall type in all views in which the wall is present.

Using Schedules for Preliminary Cost Estimates
At this stage, we’re still in preliminary design for this project, and have not gone through the 
rigor of cost estimating the project yet. Nonetheless, you can use some of the scheduling tools to 
help calculate a rough cost of the building based on a cost per square foot assessment. The dis-
claimer here is that Revit is not a cost-estimating package. It is a database that can count, total, 
and tally the number of items, areas, or other properties within the model. Cost estimating itself 
is part counting and part experience; we can work on the counting part with the BIM model.

Since you already created gross area plans earlier, go ahead and create a new schedule to 
analyze the area plans to create a rudimentary cost estimate based on the building square foot-
age. This time, only include the Level and Area fields in the Fields tab. Next, add a parameter for 
cost. That parameter is not a standard property of the areas, so you’ll need to add it to the list. 
Here’s how to do that.

 1. To add a custom parameter such as the Cost parameter, use the Add Parameter button on 
the Fields tab in the Schedule Properties dialog box. This allows you to add a new custom 
parameter to the Areas field. You need to add one for Cost and you need the parameter 
type to be a number so we can get a cost per square foot. See Figure 17.27 for the dialog 
box properties.

Figure 17.27 
Adding a new 
parameter.
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 2. Use the Calculated Value button to add a new field to the schedule. The button displays 
a new dialog box (Figure 17.28) where you can create new fields that are basically custom 
formulas defined by combining numerical values with other fields.

In our example, we want Revit to calculate a total cost for the project based on a cost per 
square foot we consider close to accurate based on previous experience.

 1. For our Type setting we made the type a Number. In Revit, you need to make sure the 
types of fields are compatible so you are not multiplying length times something like mate-
rial. Also, as we mentioned before, the fields are case-sensitive. In the formula line, you will 
need to type Area * Cost to get the total project cost. Click OK to exit the dialog box.

 2. Finally, on the Sorting tab, check the box for Grand Totals, and on the Formatting tab, 
highlight the Cost per Sq Ft field you just created and check the box to calculate totals. 
Once you enter an estimated cost of $169.00 for each floor, the final schedule will look like 
Figure 17.29. 

Now you have a constantly updated area of each floor of the building multiplied by our esti-
mated cost per square foot for a continuously accurate total, based on those metrics. However, 
the costs are being reported as SF values and not dollar amounts. You can fix that problem using 
the Schedule Properties dialog box.

Editing the Graphic Appearance of a Schedule
When you create a new schedule, you’re presented with a number of format and selection options 
on the Appearance tab of the Schedule Properties dialog box. These let you set the font style and 
text alignment and decide how to organize and filter the data for display in the schedule. Let’s 
explore the options in the Schedule Properties dialog box.

Figure 17.28 
Calculated Value 
dialog box.

Figure 17.29 
Building cost per 
square foot.
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On the Appearance tab (see Figure 17.30), you’ll see the options to change the font styles, 
gridline visibility, and other variables for header and body text of the schedule.

However, the change you need to make to the appearance of the data in the schedule is 
found on the Formatting tab of Schedule Properties dialog box. For our purposes in our cost per 
square foot schedule, select Cost per Sq Ft and make the following adjustments:

 1. Change the alignment to right justified, which is conventional for money totals.

 2. Select the Field Format button and uncheck the option Use Project Settings. Here is where 
you can choose to change the Unit suffix and remove SF from the cost per square foot val-
ues (see Figure 17.31). Click OK to close all the dialog boxes and return to our schedule.

You also have the ability to add headers to your schedule. By selecting the Headers check 
box, you can group them under another title.

 1. Select Level and Area by clicking in one of them and dragging the mouse to the other one 
(see Figure 17.32). They will show as highlighted. While Level does not look selected, it 
currently is.

Figure 17.30 
On the Appearance 
tab, you can con-
trol font, size, and 
header visibility.

Figure 17.31 
The Format  
dialog box.

Figure 17.32 
Selecting headers.
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 2. Doing this activates some of the different tools on the Schedule panel on the Modify 
Schedule/Quantities tab. You’ll now have the option to group (or ungroup) these headers. 
Choose the Group button.

 3. You now have a header that spans the two headers selected, and we can add some more 
descriptive information to help clarify the schedule. In this example, we have added the 
text “Preliminary Design Plan” to the header (see Figure 17.33).

Not all Schedules Need to appear on Sheets

You can use schedules to document objects used in your project (number of doors or windows, fur-
niture pieces, material quantity, areas of rooms, etc.), but you can also use them to locate elements 
in the model or look for inconsistencies. For instance, you can keep a schedule of text notes only 
within a model and not use them on sheets. This schedule can then be used to look for odd items 
inserted into the model. In essence, you can schedule the text note name and the number of times it 
appears in the model. Perhaps the schedule indicates that a particular note is used only one or two 
times in the model. You can then decide if the note was inserted incorrectly into the project and 
determine whether it’s inconsistent with the other notes in the model. The same thing can be done 
for wall types or anything else in the model.

new oPtions in revit 2010

When you are creating a schedule of elements that need naming and you click on any name 
in the schedule (as example open the Gross Area BOMA schedule) you will notice three new 
options on the Modify Schedule/Quantities tab.

Figure 17.33 
Grouped headers.
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The three options are as follows:

Show    In the room schedule, includes rooms that are not placed or enclosed in the building 
model. Those rooms will be marked as Not Placed in the schedule and the model.

Hide    Filters the schedule so that it only includes rooms that are placed or enclosed in the 
building model.

Isolate    Filters the schedule to list only rooms that are not placed or enclosed in the building 
model.

The Bottom Line

Quantify your preliminary designs.    Once your plans are established, create your own 
area plans to dynamically track changes in the project.

Master It    Establish your preliminary design, and then create area plans so you can keep 
up to date with space sizes, allocations, and your project program.

Create schedules.    One of the benefits of Revit is the ability to manage not only your draw-
ings, but also other information about the project. Create schedules for your project templates 
to manage the materials within the project.

Master It    Schedules have a multitude of uses and value at all levels of the project. 
Explore a variety of schedules to optimize your workflow and maximize what you can 
get from the model.

Use schedules for preliminary cost estimates.    Create a schedule that tracks project costs 
based on an estimated cost per square foot.

Master It    Many developers and facilities managers use BOMA calculations for figur-
ing rentable area, gross area, and R/U (rentable/usable) ratios. Establishing area plans 
and schedules can help you find these numbers much quicker than a legacy CAD system 
would have allowed.
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Chapter 18

Evaluating Your Preliminary Design: 
Sustainability

In this chapter, we will take our preliminary building model and investigate sustainable design 
strategies using the building information model geometry.

Revit does a number of things to support a sustainable design process and workflow, rang-
ing from accurate material take-offs to energy analysis with third-party software. As you move 
to Revit from a more traditional drafting approach, you will begin to see more opportunities to 
engage in model-based simulation. This represents a shift in office workflow and culture. Revit 
changes how teams communicate, since everyone works with one centralized model that can 
aggregate linked structural and MEP models. Such close integration allows team members to 
understand better the overall direction of the project from many vantage points. This ability to 
see the model from different points of view also makes a BIM project perfect for exploring sus-
tainable design strategies. We will explore how Revit can help support those strategies. 

In this chapter, you’ll learn to:

Incorporate a sustainable approach from the very beginning of project development•u	

Use Revit to create sun studies•u	

Track recycled materials and other sustainability strategies using schedules•u	

Analyze daylighting •u	

Incorporating a Sustainable Approach from the Beginning
Sustainable design has been a long-standing practice in the construction industry, but it has 
recently received mainstream recognition and grown in popularity. Sustainable design can 
address many issues, such as energy use, access to natural light, human health and productiv-
ity, water conservation, use of recycled materials—the list goes on. One of the primary goals of 
sustainable design is to reduce a building’s carbon footprint (the net amount of carbon dioxide 
emitted by a building through its energy use) to zero. This means the finished building uses no 
more energy than it can produce or offset. At the same time, sustainability means creating better 
conditions for the people who work, live, or play in the buildings.

An important factor in sustainable design is the huge effect that construction has on the 
environment. The United States, as an example, uses 25 percent of the world’s energy, and the 
U.S. building industry uses 40 percent of global energy. Buildings, taken together, are the larg-
est single resource consumer in the world. To solve the problem of global warming, we in the 
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architecture, engineering, and construction (AEC) industry must work toward a more efficient, 
more sustainable building practice. And even if this sounds like alarmist propaganda, we should 
embrace sustainability because it saves time, materials, labor, money… in other words, it leads to 
better buildings. 

Preliminary Design Tools
In the previous chapter, “Fine-Tuning Your Preliminary Design,” we introduced the Foundation 
model by working with the preliminary design, and we discussed verifying program and area 
information by creating area plans and schedules. We will be building on the same model in 
this chapter to investigate sustainable strategies.

Since we have a digital building model, we can also rapidly iterate different variations of the 
design using sustainable strategies. When designing for sustainability, the important thing is to 
understand which questions to ask—and to ask them early enough in the process that you can 
make appropriate changes. There are five simple things you can do to help make any project 
more sustainable:

Optimize the building mass•u	

Create good site orientation by maximizing north–south exposure and minimizing east–•u	

west exposure (in the northern hemisphere)

Optimize the use of daylight and sun shading•u	

Optimize the building envelope assembly•u	

Optimize the use of carbon-free resources such as sunlight, wind, and rain•u	

Although it was not created primarily as a sustainable design tool, Revit does provide an 
integrated 3D model that can be used as input by other applications for the purpose of running 
analyses. This saves you the time of having to remodel geometry in these applications and thus 
reduces the amount of time and money spent on analytical modeling. With Revit, you are build-
ing a 3D model by default, so testing a number of simple but effective sustainability strategies 
early on makes sense and does not require you to remodel anything.

The LEED Rating System
One widely used tool for measurement and rating of sustainability in the building industry 
in the United States is the LEED rating system. Created by the U.S. Green Building Council 
(USGBC), the Leadership in Energy and Environmental Design (LEED) system is a nationally 
recognized benchmark for high-efficiency design and construction. The LEED rating system 
consists of five key areas:

Sustainable site development•u	

Water savings•u	

Energy efficiency•u	

Material selection•u	

Indoor environmental quality•u	
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Each of these areas assigns point values to a variety of methods and processes of sustainable 
design. The goal of the ranking system is to determine and rank a building’s sustainability. For 
more information on the USGBC and LEED, visit www.usgbc.org/leed.

take advantage of the Design Cycle

As any designer can attest, design is an iterative process. The process of design—especially sus-
tainable design—can involve a series of intuitive and creative movements followed by periods of 
research, testing, and validating the design decisions. This is in turn followed by some manner of 
redesign to adapt to any changes that are needed due to the new information or direction.

Use the energy and sun tools in a similar fashion. If you wait until the end of the design process 
to begin using these tools, they will be of little value to mold and inform your process. Begin your 
investigations and testing right away to see how the energy and sun tools can shape the form and 
design of your project.

Using Revit to Create Sun Studies
Chapter 15, “Presentation Techniques for Plans, Sections, and Elevations,” introduced Revit’s 
tools for applying physically accurate shadows for presentation purposes and showed how to 
enable and control them. Here we take a closer look at using these features analytically.

Good sustainable design optimizes the use of natural daylight within a building and thereby 
minimizes the need for heavy use of electrical (artificial) lighting. The design should take into 
account the direction the daylight is coming from because this dictates the amount of solar gain 
the building takes in during the course of the day. East and west daylight are the hardest types 
to control. In the Northern Hemisphere, north elevations get a great amount of indirect lighting, 
while south elevations get a great deal of direct exposure. This can be mediated with the proper 
use of sun shading devices (see Figure 18.1).

Figure 18.1 
Sunshades and 
natural ventilation.
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Sunshading devices are specific to the local climatic conditions; however, there are some 
fairly typical rules of thumb. North and south sunlight are the easiest to control since the angles 
of exposure are not nearly as dramatic as the east and west façades. Because of this, sunshad-
ing on the south side is typically horizontal, to allow more sun exposure to the interiors during 
winter months when the sun is lower in the sky and less exposure in the summer months when 
the sun is higher. Sunlight affecting the east and west façades is more difficult to control, and 
sunshading is typically vertical.

Working directly and early on with a mechanical engineer who is knowledgeable about sus-
tainable principles and approaches can help direct and maximize the use of natural light and 
heat in your design. However, even without an expert, a simple daylighting view can help a 
design team make good decisions regarding daylighting.

Sun studies are views (they can be still or animated) that you can generate to reflect the solar 
conditions during specific times of the year to visually gauge light and shadow conditions. By 
creating camera views at key locations within the model, you can see the resulting shadows based 
on the location of the model on the planet and the date and time. In Figure 18.2, you can see the 
effect of sun on the Foundation model during four peak times of the year: the summer sol-
stice (June 21), the spring and fall equinoxes (March 21 and September 21), and the winter solstice 
(December 21). We will be using these same dates as we study the model from other angles. Note 
that because the spring and fall equinoxes replicate the same solar condition, only one image 
needs to be shown.

Remember, once we establish these views, they will be constantly updated as we make modi-
fications or design changes to the model.

Figure 18.2 
Sun studies at  
various times of 
the year.
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Making a Solar Study
Open the Foundation model in the Chapter 18 folder on the book’s companion web page (www 
.sybex.com/go/masteringrevit2010), and let’s establish a few views from different locations. 
We’d like a better understanding of the play of sun and shadow within the model from these 
locations. To do this, we are going to set up some sun studies in these spaces.

 1. Set up the following camera views:

 a. From the second floor, place a camera from the View tab looking at the southern eleva-
tion of the building, eastern half (because of the building’s length, we will not be able to 
see sufficient detail if we look at the entire façade at once). Name it Sun Study-South E 
Facade (Figure 18.3).

 b. From the second floor, place a camera looking at the western elevation of the building, 
east half. Name it Sun Study-West Facade (Figure 18.4).

Figure 18.3 
Exterior camera 
placement looking 
at south façade.

Figure 18.4 
Exterior camera 
placement looking 
at west façade.
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 c. From the interior third-floor office space, place a camera looking to the southwest. 
Name it Sun Study-3rd Floor Interior (Figure 18.5).

 2. Now if you go back to the first view, the Sun Study-South E Facade, the view by default 
will look like a colorless perspective of the south façade (see Figure 18.6). You can either 
choose to accept the way this view looks or choose Shading or Shading with Edges from 
the View Control bar at the bottom of the view window.

You need to turn on the sun and cast some shadows.

 3. In the View Control bar, the third button from the left is the Shadows button. Clicking 
this button toggles the shadows on and off. It also gives you the option to go to the 
Graphic Display Option dialog box, where you can then set the parameters for what time 
of day to show the shadows. Choose Graphic Display Option from the menu. Note that 
you can save these settings in a view template to quickly be applied to other views.

Figure 18.5 
Exterior camera 
placement looking 
at the third-floor 
interior.
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 4. In the Graphic Display Options dialog box, select the Cast Shadows check box 
(Figure 18.7).

This activates the browse button for the Sun and Shadows Settings dialog box. Click it to 
access that dialog box.

 5. In the Sun and Shadows Settings dialog box, you have three options:

Still casts the sun at a specific time of day based on the parameters you choose.

Single-Day allows you to animate the sun and export the animation to an AVI file to 
show it over the course of a single day.

Multi-Day casts the sun in the same position (same time of day) over the course of mul-
tiple days.

For this exercise, choose Still (see Figure 18.8).

Figure 18.6 
Default appear-
ance of a  
perspective view.

Figure 18.7 
The Graphic  
Display Options 
dialog box.
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 6. Here you need to start by setting the location of the building as well as the Date and 
Time of the year for which you wish to analyze the effect of the sun and thus shadows. 
Choosing the By Date, Time and Place option, we can give our building a geographical 
location.

 7. Click the browse button to open the Manage Place and Location dialog box. Here you’ll 
find a long list of choices available. Choose Kansas City, Missouri, and click OK. For the 
date, choose June 21, because we want to see the sun during the summer solstice. Set the 
time to 10:30 A.M. Finally, make sure Ground Plane at Level is selected and set to Level 1. 
This will allow Revit to cast shadows against the ground.

 8. Before you click OK and let Revit calculate the effect of the sun for the location you have 
selected, you need to name your settings. Choose Rename from the buttons on the left of 
this dialog box and rename Sun and Shadows Settings to 6/21, 10:30 am.

 9. Click OK twice to exit the dialog boxes. It will take a moment for Revit to calculate all 
the shadows. The finished view should look like Figure 18.9. It looks like the sun canopy 
extends far enough to reach all the floors at this time of day in the summer, and it will 
give us an interesting play of light on the façade.

Figure 18.8 
Sun and Shadows 
Settings dialog box.

Figure 18.9 
How the sun 
affects the  
south façade on a 
summer day.
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In Figure 18.9, you can see the results of the sunshades on the southern façade. Both solar 
studies were done at the same time of day, but there is an obvious impact of the shading devices 
on the second elevation over the first. Later in this chapter, we will discuss different energy 
modeling strategies that are designed to report the actual load differences the building will 
have with or without the shades.

Sun Studies throughout the Year

By going back to the Sun and Shadows Settings dialog box, you can duplicate the settings and modify 
only the date or time of day to include a sun study for the equinoxes and the winter solstice. You can 
then export each view using the Export Image option. From the Application Menu choose Export  
Images and Animations  Images and export each view to keep a record of the sun at different times 
of the year. Here are some examples of how shadows are cast on the building: the upper image reflects 
the sun on the building in the winter; the middle, spring and fall; and the bottom summer.

Animated Sun Studies
A great feature in Revit is the ability to create animated solar studies. You can see the effect of 
sun and shadow over time. For example, it is possible to animate the sun over the course of an 
entire year to see the extent of light penetration and shadow cast by your building and other 
buildings in its context. This is an excellent communication tool for explaining the impact of 
your building on the site and can be used very early on in massing studies to make adjustments 
to orientation, placement, and form.

Any view can be animated to show the effects of the sun. To access this feature, use the 
Graphic Display Options dialog box and navigate to the Sun and Shadows Settings dialog box. 
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There you will find three tabs: Still, Single-Day, and Multi-Day. The default tab is Still, and the 
settings on this tab affect static views. The other two tabs are specifically designed for creating 
multi-image representations of the model over time (Figure 18.10). 

Single-day studies    Create single-day studies with the settings on the Single-Day tab. These 
settings will show the effect of sun on a specific day at various intervals (15, 30, 45, or 60 min-
utes). By setting the date and checking the Sunrise to Sunset box, you’ll be able to animate 
the effect of sun on your model.

Multi-day studies    The settings on the Multi-Day tab (Figure 18.11) are just like the settings 
on the Single-Day tab, but the interval is days, weeks, or months, and you can see the effect of 
sun over the course of an entire year.

Once you select either a single-day or multi-day setting, a new control will become available 
in the View Shadow flyout menu to help facilitate visualizing and generating the animation.

Figure 18.10 
Use the Single-Day 
and Multi-Day tabs 
to define time and 
time intervals for 
the animation.

Figure 18.11 
Sun and shad-
ows settings for 
a multi-day sun 
study.
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Previewing a Solar Study

To preview the solar study, click the Animated Solar Study option; the following controls will 
appear on the Options bar:

You can use the controls to step through the frames of the animation and access the Sun and 
Shadows Settings dialog box. The animation will play slowly because the frames have to be 
redrawn one by one to recalculate the shadows. We do not recommend playing the animation using 
these controls, as it is very time consuming for Revit to redraw all these views. To get a feel for the 
final output, you need to export the view and see it play back at real-time speed in a video viewer.

exPorting the animation

Once you’ve set the correct values for the solar study, you can export it and play it in a media 
player. To do so, go to the Application Menu and choose Export  Images and Animations  
Solar Study. The Length/Format dialog box includes options to set file type, duration, size, and 
model graphics style (Figure 18.12). For better performance, drop the image size to something 
reasonable for a monitor (800´600, for example). As with the interactive preview, it will take 
Revit some time to process all the frames. The more frames, the longer the export will take, but 
the final result makes for compelling demonstration media. Revit also gives you the option to 
compress the video upon export.

animated Solar Studies

Animated solar studies can track the course of the sun over the period of a day or at one time of day 
over a period of many days or months in an animated video format. These studies help us to better 
understand the impact of the sun on a building and of the building on the surrounding context. To 
set up an animated solar study, follow these steps:

 1. Open the second perspective, Sun Study-West Facade.

 2. Using the View Control bar at the bottom of the screen, open the Sun and Shadows Settings 
dialog box. Alternatively, you can choose the View tab and click the Settings button to reach 
the same dialog box.

Figure 18.12 
Set the values for 
your animation.

56491c18.indd   517 6/2/09   11:13:14 PM



518 | Chapter 18 Evaluating Your PrEliminarY DEsign: sustainabilitY

 3. Choose the Multi-Day tab. You will notice that since you have set our location previously for the 
still study we did earlier, you don’t need to set a new location for the project. Set the start date 
to 1/2/2009, the end date to 12/28/2009, the time interval to one day, and the time of day to 
3:30 P.M. The dialog box should look like this:

 4. Clicking OK to exit the dialog box will give you a perspective with the sun located in a position 
to support the first date (1/2/2009) at the 3:30 time. If you go to the View Control bar and click 
the Shadow button again, you will notice a new option: Preview Solar Study.

 5. Choosing this tool highlights the view window and gives you a new set of tools in the Options 
bar, as shown here: 

 6. The controls work the same as they do on your DVD player. Clicking the time and date button 
will take you back to the Sun and Shadows Settings dialog box. The other controls are there 
to set the frame rate and initiate playback. Playback time will vary depending on the size and 
complexity of your model and your processor speed.

 7. You also have the ability to export this animation to an AVI file. Go to the Application Menu and 
choose Export  Images and Animations  Solar Study, and you can set the dimensions of the 
image, the model graphic style, and the frame rate for your AVI. You can play around with the 
settings until you get the right proportion of size and time for each slide.

 8. Once you have begun the export, you can view the progress of the AVI at the bottom of the view 
window.
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These types of sun and shadow studies are not designed to provide you with quantifiable 
metrics for the amount of daylight in a given space. However, they are a good, quick tool dur-
ing the earliest design decision phase to help check your design assumptions regarding where, 
when, and how the daylight enters the space.

Tracking Recycled Materials and Other Sustainability 
Strategies Using Schedules
In this section, we will be reviewing how to leverage schedules to track sustainable design 
strategies. Including recycled content in your building design is only part of the solution. To 
document credits for LEED points, it is important to know how much recycled content is in the 
building.

Recycled Materials
In Chapter 17, we discussed maximizing the power of schedules by adding custom variables to 
the calculations. We did this by doing a basic cost analysis on the Revit model and calculating a 
square foot cost against the gross square footage of the building. It is possible to use this same 
method to track the amount of recycled materials used in the project.

In our project, we have decided to substitute a percentage of Portland cement with fly ash in 
all of the cast-in-place concrete. As a by-product of burning coal, fly ash will help count toward 
the recycled materials points we need for LEED accreditation. Based on a number of concerns, 
we have chosen to use 21 percent fly ash in our concrete. We can calculate this very quickly 
using a simple schedule:

 1. Navigate to the View tab, click the Schedule button in the Create panel, and choose 
Material Takeoff from the flyout. Now, choose Multi-Category from the list of schedule 
types provided.

 2. In the next dialog box, you will be asked to choose fields for the schedule. Choose the fol-
lowing fields and place them in this order:

Material: Name

Material: Volume

 3. Clicking OK at this point would give you a list of all the materials in the project. Since 
we want only the concrete, select the Filter tab. Choose Material: Name and then 
Contains from the Filter By drop-down menu, and type Concrete in the Filter field (see 
Figure 18.13).

 4. Now, you’ll need to add another calculated value to tabulate the percentage of fly ash 
in the project. Click the Calculated Value button. Name the field Volume of Fly Ash. 
Change Type to Volume and enter the following formula: Material: Volume * 0.21. Another 
option is to create a separate parameter called Percent Recycled, and then multiply this 
value by Material Volume. This will allow the user to see the calculated value in the 
schedule, rather than hiding it inside the formula. 
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Remember, it is all case-sensitive, so make sure you type the formula properly. The finished 
dialog box should look like Figure 18.14. Click OK.

 5. On the Sorting/Grouping tab, check the Grand Totals check box.

 6. Finally, on the Formatting tab, select Volume and change the alignment to Right. Select 
Volume of Fly Ash and change the alignment to Right. Also, check the Calculate Totals 
box. Click OK.

When the schedule is complete, you will get an up-to-date list containing all the instances of 
concrete in the building and a calculation showing how many cubic feet of fly ash each contains. 
This will all be totaled at the bottom of the schedule. As you can see, there are 6,898 cubic feet 
(CF) of fly ash so far in the project if we are using 21 percent recycled content (Figure 18.15).

Each of these schedules can be added to a template. Even if the percent of fly ash varies from 
project to project, you will have the basis for the schedule already created.

Finding “Concrete” in the Model

Remember, by scheduling things within Revit, you can easily use the schedule to locate them. Simply 
select the element within the schedule view. In the Modify Schedules/Quantities tab, you’ll see a 
button to Highlight in Model; clicking this button will cycle you through all of the relevant views 
showing the element selected. This is true for any schedule.

Figure 18.13 
Filter the model 
materials for  
Fly Ash.

Figure 18.14 
Use a formula to 
calculate the  
volume of fly ash.

56491c18.indd   520 6/2/09   11:13:14 PM



traCking rECYClED matErials anD othEr sustainabilitY stratEgiEs using sChEDulEs | 521

Window Surface Percentage vs. Room Area
We discussed concepts of sustainability earlier in this chapter and specifically the use of sun-
shading devices to allow natural daylight into spaces but minimize the effects of solar gain at 
unwanted times of the day or year. Another way to keep out the sun is to simply minimize the 
amount of glazing on a given façade. There is a delicate balance between the amount of glazing 
on a façade and the amount of daylight that enters a space. In the ideal design, we want to maxi-
mize daylight but still be efficient with glazing. Again, north and south light is easier to control, 
the north particularly because it includes no direct sunlight. East and west light can be more 
challenging. One way to work toward the most efficient amount of glazing is to work directly 
with your mechanical engineer or energy modeler to calculate the ideal percentages of glazing 
for a given façade or cardinal direction. Once you have these goals, you will want to quickly cal-
culate the percent of glazing versus wall area or room area. Revit can help you do this with the 
Room/Area Report (Figure 18.16).

One of the export commands available within Revit is Room/Area Report (go to the Application 
Menu and choose Export  Reports  Room/Area Report). If all the room objects are placed in a 
given floor in the model, this report creates an HTML file detailing how the areas for the rooms 
were calculated. The report lists in graphic and table format each room, its perimeter, and the trian-
gulated areas within the room that generate the areas. If you choose the Settings option before you 
export the table, you can check a box to also report window area as a percentage of the room. This 
gives you the square footage of window area within the room as a percentage of the overall area 
of the room. This square footage percentage can also assist in the documentation you will need for 
LEED credit EQ 8.1 (for more information, see www.usgbc.org/leed).

Figure 18.15 
You can see the 
total amount of  
fly ash in the 
schedule.
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Energy Analysis
Energy analysis is a useful tool in estimating building life-cycle costs and is becoming more 
and more important to facility managers and owners early in the design process. The tool gives 
you the ability to predict building energy use. By making design changes to the model and run-
ning a series of energy analyses based on the various design iterations, you are able to estimate 
the building’s loads based on the design schemes, thereby helping to minimize energy use and 
overall life-cycle costs.

In its current incarnation, Revit does not provide energy analysis. The software is primarily 
created for architects to model and document their designs; you’ll need to use one of the third-
party applications discussed in the following pages. At the same time, the design of a building 
involves not only its function but also its aesthetic and social implications and its environmental 
impact. Today, the focus on energy efficiency is becoming increasingly important to stakehold-
ers involved with architecture. Owners and facilities managers alike are looking to get up-front 
data on predicted energy footprint and short-term and long-term costs and other information at 
the early stages of design.

Energy modeling can involve a complex set of analytical calculations, and entire careers are 
based on deriving accurate and predictable results. This type of analysis can encompass build-
ing energy use, daylighting, alternative power sources, computational fluid dynamics (CFDs), 
thermal gain, and carbon footprint, to name a few. Essentially, energy modeling allows you to 
understand the building from a more holistic, ecological point of view.

It is important to keep in mind that any value you get out of the Revit model with respect 
to energy analysis is only as useful as the information you put into the model. Good input will 
lead to good output.

There are a couple of applications that can be used in conjunction with the Revit architectural 
model for additional energy analysis data.

ieS <ve>

IES <Virtual Environment>, or IES <VE>, (www.iesve.com) is advanced simulation software that 
provides analytical tools for energy, daylighting, computational fluid dynamics (CFDs), and a 
variety of other analysis features. Opening a Revit Architecture model in Revit, in the Modify 
Schedules/Quantities tab you’ll see a button to Highlight in Model; you can link to Integrated 

Figure 18.16 
Analytical views 
of room area and 
window area.
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Environmental Solutions (IES) and get an estimation of the building’s energy consumption 
based on rooms, location, and construction type (Figure 18.17). Revit allows you to export the 
whole model to IES so that a full-blown analysis can be performed.

In Revit 2010, you can install an IES plug-in for Revit Architecture. This allows you to get 
peak energy loads in the form of reports.

gbxml

gbXML, or Green Building XML (www.gbxml.org), was designed as a neutral file format to trans-
fer the data required for an energy model into various analysis applications from a Revit model. 
This file format, while not quite an industry standard, has been quickly adopted by a number of 
leading CAD vendors and is one way to transfer design intent into an energy modeler without 
having to re-create the building form in another application. IES <VE>, for example, will import 
a gbXML file, but it will not have all the geometric and spatial data that you will have if you 
imported directly from Revit.

Exporting to gbXML

Exporting to gbXML is a simple, fluid process; one of the primary benefits of using this file for-
mat as a basis for your energy analysis is that it is easy to create. To begin, you need to set a few 
variables before you start the export.

 1. There is a location in the Revit file to set some energy data parameters of the project 
specifically for the energy analysis. Navigate to the Manage tab and click the Project 
Information button. Then click the Energy Data button. In this simple dialog box 
(Figure 18.18), define the following project variables:

Building Type    Such as office, residential, museum.

Postal Code    The five-digit postal code of the project. This variable defines the build-
ing’s global location for sunlight.

Figure 18.17 
A model as seen 
in the Revit MEP 
heating and cool-
ing interface.

56491c18.indd   523 6/2/09   11:13:15 PM



524 | Chapter 18 Evaluating Your PrEliminarY DEsign: sustainabilitY

Ground Plane    Where the ground level will be calculated.

Shading Surfaces    This is a simple check box. Shading allows you to take into account 
sunshades and other exterior features in the gbXML model.

Project Phase    Based on any phasing you have in your project.

Sliver Space Tolerance    By default, this value is set to 1́ -0 .̋ This specifies the tolerance 
for areas that Revit considers sliver spaces.

Export Complexity    By default, this value is set to ‘Simple with Shading Surfaces’ but 
can be expanded based on the complexity of your model’s geometry and inclusion (or 
not) of curtain wall and storefront wall types.

For our Foundation project, let’s declare it as an office building with a 64105 zip code 
(Kansas City). The ground plane is at Level 1, Shading Surfaces is turned on, and we can 
leave the other variables at their defaults.

 2. Next, we will need to turn on the volume calculations within the model. By default, these 
are left turned off; turning them on and leaving them on can lead to a lot of overhead 
within the model. We recommend turning them on for the gbXML export, then turning 
them back off after the export has completed successfully. To turn on the volumes, choose 
the flyout under the Room & Area panel on the Home tab and click Area and Volume 
Computations. Choose Areas and Volumes in the dialog box.

Figure 18.18 
Set basic variables 
to establish some 
assumptions about 
the energy require-
ments for your 
building.
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 3. Now that you have set those variables, exporting is a simple process. Go to the Application 
Menu and choose Export  gbXML. Revit will automatically begin calculating the export 
before you are given the option to save the file. The export will take a little time, depend-
ing on the speed of your computer. Once it’s created, you’ll have a small, compact file you 
can easily share with your mechanical consultant or upload directly into your energy 
analysis application.

Green Building Studio

The AutoDesk Green Building Studio (www.greenbuildingstudio.com) is an online service that 
provides a simple energy analysis based on your gbXML file and some basic energy demand 
assumptions you provide. The results are reported in an easy-to-interpret web format with a lot 
of visual cues and graphics. The report takes into account TMY2 (Typical Meteorological Year 2) 
data, which is historical data of sunny versus overcast days; regional utility demands and costs; 
and climatic data. It will return information such as the predicted annual utility costs, building 
life-cycle costs, and carbon footprint (see Figure 18.19).

This is a service for basic energy calculations, and there is a nominal charge for more devel-
oped results. You must download a small client application that will help coordinate the upload-
ing and calculations of the gbXML files. You can download it from http://usa.autodesk.com/
adsk/servlet/index?siteID=123112&id=11261770.

Even if you do not understand the results from an energy analysis application such as this, it 
can always be used as a comparative tool. Take, for example, the large sunshading device on this 
project. At some point during the design, we will undoubtedly find it necessary to discuss with 
our client how much energy something like this can save the project. Within Revit, this element 
can be set to a design option and we can run an energy simulation using Green Building Studio 
(GBS) with and without the sunshade. Figure 18.20 shows the building model with and without 
the shades.

By comparing the annual energy costs from the GBS analysis, we can quickly see a 68 percent 
increase in energy savings over the course of a single year (Figure 18.21). Over the lifetime of 
this building, that can lead to a substantial energy savings for the client and more than offset 
the initial costs of the shading device.

Figure 18.19 
Example from 
Green Building 
Studio showing the 
estimated energy 
cost of the building.
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Figure 18.20 
The Foundation 
model with  
and without  
the sunshades.

Figure 18.21 
The energy  
analysis for both 
designs shown in 
Figure 18.20.
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Daylighting
Daylighting is an important part of designing sustainably. Daylighting is the use of natural light 
for primary interior illumination. This reduces our need for artificial light within the space, thus 
reducing internal heat gain and energy use. Direct sunlight, once it enters the building, is not 
only light but heat, and that additional heat will need to be taken into account in your energy 
analysis. 

Natural light is the highest quality and most efficient light source available today, and the 
source is free.

 An effective daylighting design relies heavily on the proper building orientation, massing, 
and envelope design topics we have already discussed. The proper combination of these strate-
gies allows us to optimize our building’s use of natural resources and minimize our depen-
dency on artificial lighting. A fully integrated daylighting system can enhance the visual acuity, 
comfort, and beauty of a space while controlling external heat gain and glare. 

Not only does natural daylight help to light our workplaces and homes, but it also supplies us 
with a connection to the outdoors. Providing occupants with natural light and ties to the outside 
has been proven in a number of cases to have a positive effect on human health and productiv-
ity. Studies have shown that buildings with good daylighting design have positive effects on 
their occupants, such as increased productivity levels, low absentee rates, better grades, retail 
sale increases, improved dental records, and healthier occupants. 

Recent releases of Revit have incorporated some tools that can help us do daylighting analy-
sis. While Revit itself cannot perform the actual analysis, we can set up our Revit model to 
quickly and easily be imported into 3ds Max Design, which can perform the actual analysis. 
This export process will accurately take all of the Revit model geometry and materiality, if set 
up correctly. After that, the analysis is quick and easy with 3ds Max Design. 

Recently, 3ds Max Design has revised its analysis package (which uses the Radiance engine), 
making it acceptable for documentation for LEED point 8.1. Since this book is about Revit and 
not Max, we will cover only how to prepare your model for daylighting analysis. For more infor-
mation on how to perform the analysis in 3ds Max Design, visit: 

http://www.autodesk.com/3dsMaxDesign

Quality Control Measures
Before you can jump into daylighting, there are a few quality control measures that need to be 
taken within Revit. Unless you perform these checks, you can’t be sure that the lighting analysis 
you receive from 3ds Max is accurate. Although some of these things might seem simplistic and 
almost unnecessary to mention, it’s a good idea to double-check your model:

Remember: garbage in, garbage out    Make sure you have modeled the project properly and 
accurately. An improperly modeled building will lead to inaccurate results. 

Mind the gap    Make sure there are no “holes” in the project. Verify that all the walls meet, 
that the roof is connected to the top of the walls, and that there isn’t any place in the project 
where light can enter that is not intentionally left open. Unintentional openings can let in 
light that will taint your daylighting.

Live in a material world     Make sure that the elements within the Revit model have the 
proper materials applied to them. Assemblies and elements within the model that do not 
have a materiality will more than likely have improper light reflectance, which can change 
your lighting output. 
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If you have not decided on a material for a given surface, here are some guidelines for mate-
rial reflectance: 

Floors: 20 percent reflectance (0.20)•u	

Walls: 50 percent reflectance (0.50)•u	

Ceilings: 85 percent reflectance (0.85)•u	

You can access the dialog box shown here by opening the material’s properties window or by 
choosing the Manage tab and clicking Materials.

Achieve that glazed look.  Make sure the glazing material is set properly using Promaterial 
Glazing (do not use the material Glass). The glazing material has some specific presets in 
3ds Max that allow more accurate analysis. There are a number of different glass types in Revit 
and even more if you are downloading families from RevitCity.com or other sources. 

Make sure all your glazing is consistent and accurate.  If not, your results will not be valid. 
The following graphics show the glazing settings within the materials in Revit and demonstrate 
some of the inconsistencies in the glazing properties noted in the various colors of the glass.
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Finally, you will need to identify the number of planes your glazing has in Revit. While this 
can be done later in 3ds Max, it’s quicker to set it in Revit before the file is exported. Glazing 
modeled in Revit is typically represented by one plane. This can be beneficial for the model-
ing process as it will expedite the screen render time. However, when daylight enters a build-
ing, the materials and layers of the actual glazing can dramatically affect the light levels. The 
image that follows shows a typical glazing section in Revit. In reality, this would be shown 
with two or three panes of glass. To change this in Revit, simply change the material setting 
(on the Manage tab, click Materials) for the glazing. The example shown here also reveals the 
number of glazing layers. Choose one for each pane of glass. For example, if you are using a 
double-glazed unit, set the number to 2.

Once the materials are set within Revit, go to any 3D view. Make sure all the furniture is 
turned off (it will impact the lighting analysis and is not needed). Then go to the Application 
Menu and choose Export  FBX. This will put the Revit model geometry and its materiality into 
a file format readable by 3ds Max.

Now—at last—you are ready to import your model into 3ds Max Design for daylighting.
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The Bottom Line

Incorporate a sustainable approach from the very beginning of a project development.    
Sustainability is quickly becoming a core approach to any design. Learn to leverage the Revit 
model for a more holistic approach to sustainability.

Master It    BIM is also a computational database that can report information about the 
virtual building. The important thing about a sustainable approach is to know which 
questions to ask and to ask them at the right time. What is a strategy for doing this?

Use Revit to create sun studies.    Understanding the sun’s effect on a building is paramount 
to sustainable design.

Master It    How can you use the tools within Revit to produce still and animated solar 
studies from interior and exterior views in order to understand shading and the sun’s 
effect on the building and space?

Track recycled materials and other sustainability strategies using schedules.    Keeping 
track of project goals is an important part of any project process. By using the schedules and 
other tools in Revit, you can also track key sustainability goals.

Master It    Tracking recycled material usage is key to LEED credits and sustainability. 
Create a material schedule that tracks recycled content volume for concrete.

Analyze daylighting.    Understanding daylighting and its effects within the built environ-
ment is a critical part of design and helps with LEED credit 8.1.

Master It    Make your designs more sustainable by using the model geometry for day-
lighting analysis
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Annotating Your Model

No set of documents is complete without annotations to describe the drawings. Even when you 
are working in BIM and have a digital parametric model, you will need to provide annotated doc-
uments by adding dimensions, tags, text, and notes to the drawings, thus making communication 
of the design to the owner, contractor, and design team clearer and more informative.

In this chapter, you’ll learn to:

Annotate views•u	

Use schedule keys•u	

Leverage tags•u	

Understand shared parameters•u	

Add text and keynotes•u	

Annotating Views
In any set of documents, showing geometry alone isn’t sufficient to communicate all the infor-
mation a builder or fabricator needs in order to construct the building. Annotations assist in 
clearly describing your model for others to read and understand. Tags, dimensions, text, and 
keynotes all need to be added to the drawing to cleanly and concisely guide construction or 
fabrication. Revit provides a rich set of tools for accomplishing these tasks.

Text, dimensions, and tags are placed in the views, in relation to real elements, not on the 
sheet. This allows you to annotate a view at any point in the process, before or after the final 
(sheet) document has been created. Figure 19.1 shows a floor plan annotated in a drawing set.

Figure 19.1 
The annotated 
floor plan.
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Creating and Annotating Rooms
Rooms help define areas and spaces within the Revit model. Even if a room represents the 
empty space between boundaries of physical elements, it is still considered an element in Revit, 
similar to a door, window, or wall. Rooms have properties and can be created, moved, deleted, 
modified, queried, and scheduled like every other element in Revit. Rooms can also be used for 
energy calculations and are critical to gbXML export. For more information on this feature, see 
Chapter 18, “Evaluating Your Preliminary Design: Sustainability.”

You need bounding elements to define a space in which you can place the room element and 
thus generate a room that can calculate its area and volume. Bounding elements for rooms include 
roofs, walls, floors, columns, and room separation lines.

These elements all have an instance property called Room Bounding that determines 
whether that element participates in calculating room extents. By default, all these elements are 
set as room bounding. If you do not want an element to affect the calculation of room areas and 
volumes (for example, toilet partition walls are usually not deducted from the area and should 
be marked as non-room bounding), select it and clear the Room Bounding option in the Element 
Properties dialog box (shown checked in Figure 19.2).

Every model element in Revit can be tagged, including rooms. The room tags report informa-
tion stored in the room element properties. This means you can have the tags report anything 
about the room based on parameters of the room: name, number, area, finish, and so on. Rooms 
are separate elements from room tags, which, like all other tags used in Revit, are annotations 
that can report any information stored in the building elements they are associated with. Door 
and wall tags, for example, report values of the door or wall elements. Room tags do the same.

Even when rooms exist in a view, they are not visible in the view by default, but if they are 
tagged, the tag is visible, so it can be easy to confuse the tag with the element. As with other 
elements in Revit, the tag can be placed automatically when adding a room using the Tag on 
Placement button on the Options bar. Clearing this box means that when you create a room, no 
room tag will be added for that room.

In such cases, you can add room tags later in the project, individually for each room or for all 
rooms that are untagged at once. This means Revit can simultaneously tag any existing rooms in 
the active view and places the tags in the center of the X formed by the room element. You need 
to have created the room objects in the project first; then, wherever a room element is found, a 
room tag is placed in the room. This tool does not create rooms for you if they don’t exist.

It’s important to note that the tags only report the properties of the room. Deleting the tag 
does not delete the room element or the information shown in the tag.

You can insert rooms by clicking the Room button on the Home tab. To insert a room, you 
must be in a plan view of the model, so choose one of the plan views and select the Room tool 
from the Room & Area panel of the Home tab. When you select this tool, all of the rooms already 
placed within that view will highlight in transparent blue and an X will appear across the area 
that bounds that room (Figure 19.3).

Figure 19.2 
A checked Room 
Bounding param-
eter makes a wall 
room bounding.
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The X is a visual aid to show you where room elements already exist within the model. 
As you can see in Figure 19.3, we are missing a room element in Room 120. To place a room in 
that space, with the Room tool selected, click in the white area in the middle of the space to 
place a room element. A blue box appears and a room tag is automatically placed in the room. 
The Room tool remains active after the placement of each room and allows you to keep plac-
ing rooms in sequence. You’ll notice that Revit auto-increments each room tag as you place the 
rooms. If you change a room number, the number of the room you place next is based on the 
number of the last room you placed.

Once a room is placed, it extends itself to the boundaries of the space in which it is placed 
and becomes an object in the model. As we mentioned, the room tag is a separate element and 
can be removed without removing the room element itself or any of the information you might 
have added to the room element. In fact, deleting the tag from a room will prompt a warning 
message alerting you that the room element still exists (see Figure 19.4). In a schedule, all these 
rooms will continue to show up with their proper room names and any other information 
you’ve added, regardless of whether they have been tagged.

Once the tag has been removed, you can still select the room element. By default, the room 
element is not visible within Revit. This is intentionally done to avoid cluttering up precious 
space within a view. To select a room for further editing or to access its properties, drag the 
mouse over the space where the room is placed and click when the room element highlights. 
Click in an area close to one of the crossing diagonal lines to select the room.

Figure 19.3 
Placing a room.

Figure 19.4 
Deleting a  
room tag.
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Here are some other features critical to rooms that you will want to be aware of as you begin 
placing them in your model:

Room bounding elements need to create a closed loop.•u	  Placing a room in an unenclosed 
area generates an error message like the one shown in Figure 19.5.

If a room that reports that it is unbounded is not resolved and is left unbounded in the 
model, it will not properly report in the schedules. There are a few ways to resolve an 
unbounded room:

If you are still in the midst of design, simply finishing the design may give you the •u	

walls or other bounding elements you need to complete the enclosure. Once the room 
is properly enclosed, the room element will recognize this and dynamically stretch to 
fill the room

You can delete the room if it has been incorrectly placed. If you decide to remove a •u	

room, you must delete the room element itself, not just the room tag

You can use the Room Separation lines tool located in the Home tab, under the Room & •u	

Area panel, when expanding the Room tool, which lets you draw a boundary and create 
room boundaries to define the edges of the space and close the areas where the room leaks

Revit will tolerate a small gap in room boundaries such as walls that don’t quite meet or 
Room Boundary lines that are not quite drawn all the way across a room. In that case, the 
error message “Small gaps will be ignored by room boundary calculation” will not appear.

Room elements must not overlap. Revit does not accept overlapping rooms and will report •u	

an error if this occurs. You may come across this issue in any of three ways:

First, you might mistakenly attempt to place a room in a space that already has a room •u	

element. If this occurs, Revit will alert you to the issue by showing you both room ele-
ments in the space and an error message asking what you’d like to do (see Figure 19.6). 
Clicking OK in this dialog box will leave both rooms in place. Clicking the Delete 
Room(s) button will remove the most recently placed room element

The second way this can occur is if you remove a wall or other bounding element •u	

between two rooms. Revit will give you the same warning and ask how you would 
like to resolve the problem (see Figure 19.7)

A third way rooms can overlap is when the height of a room extends into the bounds •u	

of another. If a room extends vertically into a room on the next floor, a similar warn-
ing message will appear. To view the conflict, you will need to go to section view and 
check the room extents. It is important to understand that rooms can be volumes with 
3D dimensions. Room volumes are covered in more detail in the section “Area and 
Volume Computations” later in this chapter

Figure 19.5 
An unenclosed 
room error.
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Room Separation Lines
So, what happens when you need one room to end and another to begin and you don’t have a 
wall in between? For example, you might want a room to end at the end of a corridor that opens 
to an entry space, or you may have an open living room and dining room not separated by a 
wall.

For these conditions, use the Room Separation Line tool located when expanding the Room tool 
in the Room & Area panel of the Home tab. This tool allows you to draw lines in plan that will 
act as bounding elements.

Room separation lines show in plan views as distinctive green lines (see Figure 19.8). You can 
turn these lines on or off in the Visibility/Graphic Overrides dialog box, or by right-clicking and 
hiding the category using the context menu.

Figure 19.6 
Placing one room 
within another.

Figure 19.7 
Overlapping 
rooms.
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Room separation lines will print in the plans if you leave them visible. If they are turned off, 
they will still maintain their room boundaries—but just remember they are there! “Out of sight, 
out of mind” can cause problems later when you move walls and the rooms seem to react in 
strange ways; so if you do decide to turn off the visibility of room separation lines, make a note 
to yourself about it and turn them back on after printing.

adding a room Separation Line

In our Foundation project, there was a room named Corridor 127 that needed to be separated into 
a corridor and an entry area because they had slightly different finishes in the finish schedule. We 
used Room Separation lines to divide the spaces.

Drawing a room separation line from the stairwell across to the wall created a boundary, allowing 
a new room to be added named “Entry 139.” In the following view, you can see where the room 
element ends without requiring us to create a wall to divide the space:

Figure 19.8 
Room separation 
lines.
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Selecting Rooms
You can select rooms in one of two ways: graphically or from a schedule table.

Graphical Selection

When hovering your cursor over a room object, you will notice that the room object shows up 
and is represented with its boundary and two diagonal crossing lines, as shown in Figure 19.9.

The two diagonal lines might seem strange at first, but they are useful for selecting rooms. 
Without them, the room element could be selected only at its boundaries—but as those are 
coincident with many other elements (walls, floors, windows, etc.) the selection is quite tedious. 
The diagonal lines highlight when the cursor moves over them, so you can select the room (see 
Figure 19.10). These lines are a subcategory of the room element, and if you wish to see them all 
the time in the view and not just when hovering over them with the mouse or upon selection, 
you can turn on the Reference subcategory using the Visibility/Graphic Overrides dialog box. 
From that point on, all available room elements in your project will be graphically visible. When 
the Tag on Placement option is checked, your room tag is always placed at the intersection of 
these two diagonal lines.

Once you’ve selected a room element, your cursor turns into a move icon and lets you move 
the entire room somewhere else if needed. When a room is selected and you move it, it auto-
matically takes the extents of the new space. In principle, you are not moving the geometry of 
the room but you are displacing the room information and assigning it to another space. Moving 
a room allows you to take all of the data you’ve entered for the room (wall finishes, ceiling, floors, 
and so on) and relocate rather than retype it. The same is true for copying a room into a new 
space.

Figure 19.9 
Graphic represen-
tation of a room 
object.

Figure 19.10 
A selected room 
element.
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The graphical room selection can occur in both plan and section views. (Room selection in 
3D views is not possible.) You can see, select, change the properties of, and even manipulate the 
extents of rooms in section views now. When you select a room in section view, two sets of edit-
ing grips appear that allow you to manipulate the base and top extents of the room by dragging.

SelectinG a room from a Schedule table

To select rooms from a schedule table, highlight the room within the schedule while in the 
schedule view. Then click the Show button on the Modify Schedule/Quantities context menu.

Rooms and Room Tags
When you select one of the diagonal or boundary lines of a room, you are selecting the room 
element and can access its properties. When you select the room tag, you are selecting the tag of 
that room and can access or change the properties of the tag.

There is a difference between using the Move tool when a room is selected and using it when 
a room tag is selected. When you select a room tag, you are moving the tag around in the room 
or outside the room: with small spaces, a tag often needs to be taken out of the space the room 
tag describes because it doesn’t fit inside (remember to select the Leader option first). The most 
common example is a restroom. When you attempt to move the tag outside of the room it is 
associated with, the tag displays a question mark and you get this warning message:

If you select the tag that is outside the room, a button appears in the Modify Rooms contex-
tual tab called Show Related Warnings. It gives anyone who later joins the design team, and 
who isn’t aware of why the tag shows a question mark, the ability to understand the error.

To fix the error and clarify which room the tag is associated with, you can use the Leader 
option on the Options bar. This connects the room and the tag with a line, and it displays the 
correct room number and name, which will help you understand the relationship between 
the tag and the room in the model to which it belongs. Figure 19.11 shows the room tag with the 
leader line checked.

Rooms in Section Views
While you can also tag rooms in a section view, you will not be able to create new room ele-
ments in a section view. You can create rooms only in plan views. 

Volume Calculation Method Does Not affect how Volumes are Calculated

Volumes are always calculated up to the wall finish, regardless of the chosen calculation method.
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Room Properties
Like all other elements in Revit, rooms have properties. By selecting the room element and click-
ing the Properties button, you can see the room properties that are available. These properties 
can be scheduled, displayed in room tags, or used to color-code a floor plan or section with a 
color fill scheme. The parameters are divided into sections to help organize the information:

Level     Reports the level on which the room has been placed.

Upper Limit     Defines the top level of the room. For example, if you have a double-height space 
(like an open atrium), you might want the upper limit to be more than one floor high so the 
entire space is treated and scheduled as one element. By default, this is set to be the same as the 
level on which the room is placed so that you define the actual room height as an offset of Level.

Limit Offset    Defines the height of the upper limit of the room relative to the Upper Limit 
setting. This function is critical for volume calculations and gbXML exports. There are some 
settings that need to be addressed to get accurate results from gbXML exports:

Limit Offset needs to coincide with the bottom of the ceiling plane above for any •u	

given room on floors below the roof line

Limit Offset can exceed the top of the roof for rooms that are on the uppermost floor•u	

Rooms cannot overlap vertically for accurate gbXML exports. This means the upper •u	

limit of a room cannot encroach into the bottom of the room above it

Base Offset    Defines the distance at which the lower boundary of the room is calculated, 
measuring from the base level that itself is defined by the Level parameter. A positive value 
of the offset sets it above the base level, a negative below. Zero value is set by default and 
equals the base level.

Figure 19.11 
(A) A room tag 
doesn’t fit well 
in a small room. 
(B) Dragging the 
room tag outside 
the room it is 
associated with 
will turn the tag’s 
content into a 
question mark (?). 
(C) The tag leader 
is activated on the 
Options bar, so the 
room tag connects 
with the room it 
is associated with 
and displays its 
information.

A

C

B
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Area, Perimeter, Unbounded Height, and Volume    These are noneditable fields that report 
the metrics of the room element. We will review how these numbers are calculated in the 
next section.

Identity Data    This section includes identity information about the room. You can manu-
ally add data using these parameters and it will show up in tags. If you’re using a color fill 
scheme, it will also be used to color-code the plan.

Phase     This is a noneditable field that reports the phase in which the room was created. 
Remember that once you place a room you cannot change the room’s Phase property (unlike 
geometric elements). If you need to move the room to another phase, you’ll have to re-create 
it in that phase.

Area and Volume Computations
You can set different rules that dictate the automated calculations of area and volume for room 
elements. The selection of available rules can be found in the expanded panel of the Room & 
Area panel on the Home tab, by clicking on Area and Volume Computations. The resulting dia-
log box, shown in Figure 19.12, gives you the option to select from a number of area calculation 
schemes by relocating the boundary element of the rooms.

It is important to note the difference between room areas and area plans. Area plans follow 
different rules and treat exterior and interior walls differently. The Area Plans tool places areas 
automatically in the model, once the Area Plans function is initiated. Room elements have to 
be manually added in each space within the plan or design, and the rules that are set to define 
them apply to all the walls.

When calculating room area and volumes, you can choose among the following boundary 
locations, resulting in different calculations:

At wall finish•u	

At wall center•u	

Figure 19.12 
Area and Volume 
Computations 
dialog box.
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At wall core layer•u	

At wall core center•u	

In addition to calculating room areas, Revit can calculate room volumes. This feature is not 
enabled by default since volume computation can negatively affect the overall performance of 
Revit. You can decide at any time to activate the volume computation. This option is available 
in the Area and Volume Computations dialog box by checking the Areas and Volumes option 
in the Volume Computation group. We recommend enabling this option only when you need to 
create or print schedules or other views in which volume computation needs to be visible (such 
as gbXML exports). How much the volume computation affects the performance depends on the 
size and complexity of your model and your processor speed, but the general rule is to follow 
our earlier advice and activate it only when needed.

Here are some rules that you should be aware of when activating room calculations:

Every room can have an independent theoretical room height that you define using the •u	

Limit Offset room property. This is the height used for calculating room volume if the 
actual height of the ceiling, floor, or roof above it is higher than the applied height of the 
room (see Figure 19.13)

If the room height is greater than the height of the existing ceiling, floor, or roof, then the •u	

height to the first architectural element the room object hits is used to calculate the volume 
of the room (see Figure 19.14)

Figure 19.13 
The Room Offset 
(bounding box) is 
set to lower than 
the ceiling height, 
and the displayed 
room volume is 
214.72m3.
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Note that the room height can begin to cause other problems if it extends into the room on 
a floor above or below, even if the room element does intersect an architectural element, as 
noted previously (see Figure 19.15).

Usually a room height is set to 8´ (3m); so, depending on the default floor-to-ceiling height, it 
will often not be the real height of the room. You can verify that easily in section, when hovering 
over and selecting the room element. Adjusting the room height to the actual height of the space 
is easy in Revit 2010: you can graphically pick the room limits in section and adjust the height, 
as shown in Figure 19.16.

Figure 19.14 
The bounding box 
is set to 4100mm 
(above the ceiling). 
The tag displays 
279.14m3, which 
means that the 
volume was calcu-
lated taking a room 
height only up to 
the ceiling  
as a value.

Figure 19.15 
A change in the 
room height 
doesn’t have any 
effect on the room 
volume calcula-
tion unless it hits 
the floor or ceiling 
above or below. 
(A) Computational 
height is set to the 
standard 1200mm. 
Parts of the vol-
ume are missing 
in the calculation. 
(B) Change the 
computational 
height to floor level 
for the correct 
computation.
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calculatinG VolumeS of roomS with Variable widthS

Revit Architecture uses the perimeter of the room at the computation height when computing 
the room area and volume. The computation height is a type property of the Level family and 
can be changed any time. By default, it is set to 4´-0˝ (1200mm).

You can see the computation height graphically when you select a room element in section: it 
is represented with a dotted line across the lower part of the room (Figure 19.17).

To view or change the computation height, select a level line in section or elevation view and 
access its type properties, as shown in Figure 19.17.

For buildings with vertical walls, the room computation is straightforward, as explained 
earlier. However, if a building includes sloped walls, you may need to adjust the computation 
height to achieve more accurate room areas and volumes.

The typical case would be when working with rooms that are bound by nonvertical walls. 
Having the perimeter calculated at a height of 4´ (1.2m) would result in omitting portions of the 
floor area. To fix this, you have to adjust the computation height to be close to the floor plane.

Figure 19.16 
Arrow grips at the 
base and top limits 
of a room element 
allow you to graph-
ically manipulate 
the height of a 
room. (A) Default 
room height;  
(B) adjusted room 
height.

A B

Figure 19.17 
Computation 
Height is a type 
property of the 
Level family.
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Changing the computation height instantly affects the room perimeter and allows more accu-
rate computation of rooms with variable width. An example of the calculation of the room area 
and volume is shown in Figure 19.18.

In general, Revit 2010 has brought some improvements in the calculation of volumes: the 
computations are now more flexible in adjusting to nonorthogonal room sizes and volumes 
(Figure 19.19). Revit 2010 can correctly calculate rooms with nonhorizontal top limits. The room 
element adjusts its shape to the shape of the space it calculates.

Figure 19.18 
Changing the  
computation 
height allows for 
more accurate 
computation of 
rooms with vari-
able width.  
(A) Computational 
height is set to the 
standard 1200mm. 
Parts of the volume 
are missing in the 
calculation.  
(B) A change of the 
computational 
height to floor level 
allows for the cor-
rect computation.

A

B

Figure 19.19 
The room element 
adjusts its shape 
to the shape of the 
space it calculates.
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When the volume calculation is off, the room in section appears as if it doesn’t recognize the 
room boundaries (Figure 19.20A); when the room volumes are activated, the room shape adjusts 
to fit the shape of the space (Figure 19.20B).

If room bounding elements narrow as they rise, Revit calculates volume properly (Figure 19.21). 
If, however, bounding elements slope in a way that makes the room widen toward the upper 
limit, Revit ignores the side spaces when calculating the volume (Figure 19.22).

Figure 19.20 
Volume calculation 
(A) off; (B) on.

A

B

Figure 19.21 
Section view of 
a room: If room 
bounding ele-
ments narrow as 
they rise, Revit 
calculates volume 
properly.

56491c19.indd   545 6/2/09   11:26:40 PM



546 | Chapter 19 AnnotAting Your Model

Finally, if a room-bounding element does not reach the upper boundary of the room, the 
space above the element may not be included in the room volume (Figure 19.23).

Using Schedule Keys
Once you populate your model with rooms and begin adding information to each room about 
its department and finishes, you’ll most likely discover that information about rooms tends to 
repeat. Representing this information will be useful when you’re generating room and finish 
schedules. In previous chapters, we discussed ways to report the information in those elements 
using the schedule functionality. But what if you want to define a common set of parameter 
values that can be shared across many rooms? For instance, if you are working on a large office 
project, doing a room finish schedule that lists individual rooms might be unnecessary if many 
of the rooms share identical finishes. For these situations, a specialized schedule called a sched-
ule key can save time. Schedule keys can report any number of values that repeat across similar 
elements.

Creating a Schedule Key
Imagine the time it would take if you had to manually enter all your finishes in each schedule in 
each project! Schedule keys are a big time-saver and ensure consistency.

Since we have already added rooms to the Foundation model, let’s make a room finish sched-
ule using a schedule key for the project. To do this, we need to generate two schedules. The first 

Figure 19.22 
Section view of 
a room: If room 
bounding elements 
widen as they  
rise, Revit calcu-
lates volume  
incorrectly.

Figure 19.23 
Spaces above 
bounding elements 
that do not extend 
to the limits of 
the room will be 
ignored by the 
room calculation.
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one defines the room styles by using what is called a key name. The second schedule links our 
room styles to the rooms themselves.

Let’s begin with the room style schedule. On the View tab, choose Schedule  Schedule/
Quantities. The same dialog box you use when making any schedule appears. This time, how-
ever, you are going to choose some different values.

Choose Rooms from the list on the left, select the Schedule Keys radio button (see Figure 19.24), 
and click OK.

The next dialog box should look familiar (Figure 19.25). It is basically identical to the 
Schedule Properties dialog box (in fact, it has the same name), but one tab is not included in the 
dialog box: the Filter tab.

When you select the Fields tab, you will notice that one of the values is already on the right 
side to be included in our schedule: Key Name. Now you want to move the following values 
from the left to the right (they’ve already been moved in Figure 19.25):

Floor Finish•u	

Wall Finish•u	

Base Finish•u	

Figure 19.24 
Selecting a  
schedule key.

Figure 19.25 
Making a  
schedule key.
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The remaining tabs in this dialog box are identical to the dialog box for other schedule types. 
For more information on formatting or changing the appearance of a standard schedule, see 
Chapter 17, “Fine-Tuning Your Preliminary Design.” Once you have these values selected, click 
OK. A blank schedule like this one appears and is available for you to fill in with finish values:

Click the New button on the Modify Schedule/Quantities context menu to begin to add 
standard room finishes to the schedule. In this table, the key name is important because it will 
be the link between the two schedules. Using the New button, add the following room styles to 
your table: Key Name, Floor Finish, Wall Finish, and Base Finish.

Once the schedule is complete (you can always add to it or modify it later), you need to cre-
ate the finish schedule to be used in the construction document sheets. Again, select Schedule/
Quantities from the View tab and select Rooms from the list. This time, leave the default value 
Schedule Building Components selected (Figure 19.26) and click OK.

Again, you’ll see the standard Schedule Properties dialog box. Add the following fields to the 
Schedule fields list (the right side) in this order and click OK:

 1. Number

 2. Name

Figure 19.26 
Making the finish 
schedule.
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 3. Room Style

 4. Floor Finish

 5. Base Finish

 6. Wall Finish

 7. Area

The schedule that shows up will be a list of the rooms in the project, sorted by room number 
with (none) set as the value for Room Style. The Floor, Base, and Wall Finish columns will all be 
blank. Some sample lines are shown in Figure 19.27.

From here, adding values and finishes to the rooms by room style is fairly easy. Once you 
select the (none) value in the Room Style column, you will be given the option to select from the 
drop-down list of values we defined in the room style table (Figure 19.28).

Selecting a value from this list automatically fills in the values for the Floor Finish, Base 
Finish, and Wall Finish columns to match the values we defined in the previous schedule. As 
you modify values in the room style schedule, they are dynamically updated in this schedule, 
adding consistency and predictability to your workflow (Figure 19.29).

Figure 19.27 
The finish schedule.

Figure 19.28 
Selecting a room 
style.

Figure 19.29 
Adding values to 
the schedule.
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Leveraging Tags
Tags are text labels for elements such as doors, walls, windows, rooms, and a host of other 
objects that architects typically need to reference in a set of drawings. In Revit, tags are intel-
ligent, bidirectional symbols that report information stored in the properties of an element. A 
value can be directly edited from the tag; likewise, editing an element’s properties affects the tag.

A wall tag, for example (Figure 19.30), can display the wall type that is set in the properties of 
the wall itself, but it can show much more information, such as the wall’s fire rating or area.

Loading Tags
Revit comes with a variety of tags that can be customized to meet your office’s graphic stan-
dards or needs. The preloaded tags in the default templates cover many common requirements 
but are by no means exhaustive.

Every category of a family can be tagged, and you can load multiple types of tags for each 
category. Tags are loaded like any other family or component in Revit. From the Insert tab, select 
the Load Family button, Load Family, and browse to the tag you want to add to the project.

If you have designed some tags that you use frequently in your project, you should load them 
in your office template.

Placing Tags
Tags can be automatically placed during the creation of an element (using the Options bar set-
ting Tag on Placement) or can be placed later. You can insert tags by clicking the Tag button on 
the Annotate tab (see Figure 19.31).

During tag placement, the Options bar lets you position a tag in several ways. 

When tagging elements, if you don’t have the appropriate tag for the element you’re trying 
to tag, click the Tag button. In the resulting dialog box, you can load additional tags without 

Figure 19.30 
A wall tag.

Figure 19.31 
Tagging options  
by category,  
multi-category, or  
material.
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having to cancel the command and go back to the Load Families tool. If you click the Tag button 
but don’t have a tag of that category loaded for the element you want to tag, you’ll be prompted 
to load one.

Tags can have a horizontal or vertical orientation and can include or omit a leader line. In 
the case of a wall tag, you typically have a leader coming from the wall, whereas you probably 
would not use a leader with a door or window tag.

Clicking the Tag button offers three tagging options:

By Category    This option allows you to tag elements in the model by category or type. 
Examples are doors, walls, windows, and other commonly tagged elements. After you choose 
By Category, the elements you can tag highlight as you hover your mouse over them in your 
view. Revit also displays a ghost image of the tag you’re inserting and the value in that tag.

Multi-Category    Use the Multi-Category tag when you want to tag an element across dif-
ferent family types—for instance, when you’re using a similar glazing type in your windows 
and exterior doors and you want to be able to tag the glazing consistently. The Multi-
Category tag allows you to have the same tag and tag value for the glazing in both families. 
(Fire rating is another common application of this tag.)

Material    The Material tag lets you tag the materials in a given family. Tagging a wall by 
material exposes materials used in the wall assembly. This allows you, for example, to tag the 
gypsum board, sheathing, and studs separately.

Changing a Tag Value
There are two ways to modify text in a tag. Selecting the tag makes the text an active control and 
turns it blue; just click the blue text and start typing. This changes the value directly in the tag. 
The second option is to alter the properties of the element being tagged. Using a wall example 
again, if you select the wall, navigate to its properties, and change the Type Mark field, the wall 
tag updates to reflect this change. See Figure 19.32 for examples of each location.

Whichever way you choose, you change the symbol text for every instance of that tag type. 
Therefore, if you change a wall type from A1 to A2, you change every instance of that wall fam-
ily that was previously tagged A1.

Some tags only report instance values—values that are unique to the individual element. A 
room tag or door tag is a common example. The room tag graphics are consistent, but the room 
name varies from room to room. Doors are often tagged like this, with a unique value for each 

Figure 19.32 
Changing a tag 
value can happen 
by changing the 
value directly in 
the tag (A) or by 
changing the  
Type Mark field 
in the element’s 
properties (B).

A B
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door. With these types of tags, Revit detects if you enter duplicate values and warns you when 
that happens.

Tagging Untagged Elements
You can tag many elements at once using the Tag All tool in the Annotate tab. This time-saving 
feature lets you tag all the elements in a view simultaneously. When tagging elements, keep in 
mind that this feature only works with component families and not system families. For example, 
you cannot use Tag All Not Tagged for walls or floors.

During early phases of design, you often are not concerned with tags and annotations but are 
more focused on the model. Tags can become graphic clutter that obscure the design at times. 
Later in the process, when the design is more complete, you may want to annotate the drawing 
quickly. This is where the Tag All tool can be helpful. When you select this tool, the dialog box 
shown in Figure 19.33 appears. You can orient your tag or add a leader to it before tagging all the 
listed elements in your current view.

If you have elements selected, you can choose to tag only these elements. Note that this option 
is grayed out in the sample dialog box in Figure 19.33 because nothing in the model is selected.

taGGinG elementS in plan: doorS

Try the following exercise. 

 1. In the Foundation file we have been using, open the view called Level 1. You’ll notice in 
this file we’ve moved the documents forward a bit by defining the views we’ll be using 
in our callouts. In this view, using the tools mentioned, let’s add tags for the doors and 
walls. 

 2. On the Annotate tab, choose Tag By Category. Make sure your leaders are turned off in 
the Options bar before adding any tags to the plans.

Figure 19.33 
The Tag All Not 
Tagged dialog box.
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 3. Mouse over the door, and click when it highlights. This will insert a tag for the door cen-
tered on the door opening. By choosing Horizontal or Vertical for the tag orientation from 
the Options bar, you can quickly run through the plan placing door tags.

These tags might not be ideally located. As we’ve mentioned, the tag will come in centered 
on the door. However, it is a simple process to drag the tag to a more appropriate location if 
necessary.

Now that you have placed the door tags, you can see how each door is tagged and change 
the tags if appropriate. As we mentioned earlier, to change the value for any of the tags, sim-
ply select the tag, and then click on the blue text. This will allow you to enter a new value in 
that field. For our drawing set, you are going to number the doors with a door number/room 
number system, as shown in Figure 19.34. You can also change these values directly in the door 
schedule.

Another way to quickly tag the doors in this plan would be to use the Tag All function 
shown in Figure 19.33. This feature applies all the tags of a given family type at one time within 
the model. It’s a quick way to populate a view with tags.

Using the Tag By Category tool on the Annotate tab again, highlight and select the interior 
walls. For wall tags, be sure to turn on your leaders, but adjust the leader size in the Options bar 
to ¼˝ rather than ½ .̋ The finished floor plan should look like Figure 19.35.

Figure 19.34 
Numbering doors 
in plan.

Figure 19.35 
Adding wall tags.
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The number of annotations possible in any given view can be rather large, so it’s typically a 
good idea to conserve the available white space on the sheet by not duplicating notes and tags. 
As Revit is designed to annotate only single items, avoiding duplication in a given view can be a 
challenge using only the standard tools. In Figure 19.27, you’ll notice that in Room 121, the wall 
tag A3 has a leader going left and right to each wall. The leader on the left is a drafting line (see 
Figure 19.36). While this eliminates the parametric value for that single wall condition, in many 
cases adjacent interior walls have the same type. Before you adopt this approach in a project, 
you should weigh your need for accuracy against workflow considerations and how much space 
is available in your documents for this kind of approach.

Understanding Project and Shared Parameters
Each Revit element has a set of parameters defined by default, such as material, length, area, or 
other characteristics that describe the element. Often, however, you need additional parameters 
to describe an element that you don’t find in the standard parameter set. For such purposes, 
Revit lets you add your own parameters to elements and schedule or tag those parameters. 
There are a couple of ways to add these custom parameters that offer additional information 
about the element, depending on how you want to leverage them in the further development of 
the project and where you want them to be visible:

If all you intend to do with your custom parameter is to schedule it (for example, a parameter •u	

called Lockable that describes whether or not a door has a lock), you can take two approaches:

Add that parameter directly in a schedule using the Add Parameter function. This •u	

adds that new parameter only to the element that you create the schedule for, such as 
the door element

Create a new project parameter that you will be able to assign to one or •u	 more element 
categories—the difference is that this method allows you to assign the same custom 
parameter to more than one element (doors and windows, for example)

If you wish to be able to both schedule •u	 and tag your custom parameter, meaning that you 
wish to see the value of that parameter being called out by the element tag, you will need to 
use shared parameters. As the name indicates, shared parameters in Revit are parameters 
that can be shared between families and projects. This will allow you to add information to 
your elements that can be both scheduled and tagged in your project. An example of this 
might be a custom parameter for a room. It indicates whether the room is public or private, 
or heated or not heated. To see that information in the room tag, you would make this a 
shared parameter

Figure 19.36 
Adding leaders to a 
wall tag.
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Later in this chapter we will use a detailed example to present the whole process of creating 
and using a shared parameter. First, however, we present a basic procedure for creating a cus-
tom parameter that doesn’t need to be shared.

Creating a Custom Project Parameter
You can create a custom project parameter at any time in the project cycle. You can then assign it 
to any one or more element categories and generate schedules that will be able to call it out.

In the following example, we want to track whether or not the materials used in the project 
are recyclable, so we will create a new custom parameter recyclable, which doesn’t yet exist in 
Revit as a standard parameter. We will assign it to the Materials category.

 1. To add a new project parameter, select the Manage tab and from the Project Settings 
panel select Project Parameters. In the resulting dialog box, click the Add button (see 
Figure 19.37).

 2. In the next dialog box, give the new parameter a few definitions (see Figure 19.38):

Name, used for describing the parameter•u	

The group the parameter will belong to. This is specifically for sorting the parameter •u	

in the Element Properties dialog box

The discipline. This is also used as a method to help organize the parameters•u	

Whether it is an instance or a type parameter•u	

Instance parameters are specific to any instance or insertion. So if you insert three doors, 
they can each have different instance parameters. An example might be the door 
number.

Type parameters remain consistent for the family type. So, in the door example, this might 
be the door width, and you’d create a separate type for each door style (36˝, 34˝, 32˝, 
etc.) within the project.

What type it will be (text, integer, yes/no)•u	

Which Revit category the new parameter will be applied to•u	

Figure 19.37 
Adding a project 
parameter.
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 3. Following a scenario in which we are adding a recyclable parameter to the materials, name 
the parameter recyclable and assign it to the category Materials. Make it an instance 
parameter of the Yes/No type (see Figure 19.39).

 4. Navigate to the Materials dialog box (by clicking Materials on the Manage tab) and select 
the Identity tab. You will find the parameter you just created (see Figure 19.40).

With these steps, you have just assigned the new Recyclable parameter to all materials used 
in the project. What is left to do is to define their state for each material (Yes or No). To do this, 
you can choose Materials on the Manage tab and, for each used material, set the value of the 
recyclable parameter on the Identity tab.

Once you do, you can create a material takeoff schedule (on the View tab, select Schedule/
Quantities  Material Takeoff) and make a schedule that calls out the Recyclable parameter. You 
will then know how much and which of your materials used are indeed recyclable.

Note that you cannot tag the parameter you just created and will not be able to make it appear 
in the material tag. The reason for that is simple: the existing material tag will not recognize 
a custom parameter that you create on the fly in a project as it has no label that can call it out 
attached to it. Tagging a project parameter is only possible using shared parameters. They are 
used both on the elements and in the tags, and thus the tag understands them and can call 
them out.

Figure 19.38 
Parameter Proper-
ties dialog box.

Figure 19.39 
Creating a custom 
project parameter.
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Creating a Custom parameter While Scheduling

When scheduling, you can add a custom parameter to any schedule on the fly. This parameter is 
assigned only to the category of elements that you are scheduling. To create such a custom param-
eter, click Add Parameter in the Schedule Properties dialog box.

Figure 19.40 
Locating the new 
parameter.
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Creating Shared Parameters
When you want to schedule and tag a custom parameter you have created, use shared param-
eters. For example, you might wish the hardware set information of a door or window to appear 
in the door or window tag, or the level of radioactivity of medical equipment to appear in the 
equipment tag, or the door tag to display whether or not a door has a lock. None of these param-
eters exist by default in any of the families, so you will need to create them and add them to the 
families if you want to use them. They also don’t exist in any of the family tags, so to be able to 
call out the information of these customer parameters in the family tags, you will need to add 
the same parameters to the tag families as well. The concept seems complicated, but it’s actually 
straightforward. Imagine this: you have a set of chairs, some that are original Thonet chairs and 
some that are reproductions. You want to tag the originals with a special parameter called origi-
nal. To do this, you must add that parameter in the tag (by creating a label and calling it out), 
and you then have to add the parameter to the chairs that are the originals. Now, if you created 
the original parameter as a project parameter, that parameter would only exist in the project you 
created. Neither the chair family nor the tag family would be aware of it, as they were created 
prior to the creation of the parameter and didn’t have it among their parameters. That is where 
shared parameters come in handy—they allow you to reference the same parameter between 
project and family.

Let’s look at the workflow behind creating these, using the example of a hardware set for 
doors and windows. We will do an exercise in which you will create a door custom parameter 
called hardware that is schedulable and taggable.

 1. Create a new shared parameter file. At this stage, it doesn’t matter if you are in a Revit 
project or in the Family Editor. In both environments, you can choose the Manage tab and 
click Shared Parameters. This opens the Edit Shared Parameters dialog box.

 2. Select the Create option and enter a shared parameter file directory path and name. This 
is where you will store all your custom-created shared parameters. Make sure that the 
folder you store your shared parameters in is saved somewhere accessible to the rest of 
your team. 

 3. Next, create a group by clicking the New button in the Groups cluster of buttons that is 
now activated. This might be confusing, but in principle every shared parameter belongs 
to a group as a higher instance in a hierarchy, so you have to create at least one. If you use 
lot of shared parameters, the groups can come in handy for locating parameters. So, cre-
ate a group and name it Hardware. 

 4. Once you have created the group, you can create the shared parameter by clicking the 
New button. Name the new parameter Hardware Set. This is the shared parameter that 
we wish to have visible in our schedules—and more important, that we wish to tag.

The shared parameter you’ve just created is nothing more than a simple text (.txt) file that 
you will find in the directory you created at the beginning of the exercise. You can now assign 
this parameter to any one of the following:

The tag family•u	

The project (as a project parameter)•u	

The categories of elements you wish to have that parameter•u	

For this exercise, use the Foundation.rvt file located in the Chapter 19 folder on the book’s 
companion web page (www.sybex.com/go/masteringrevit2010) to create a shared parameter file.
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creatinG the Shared parameter file

In the following steps, we will first create the shared parameter file:

 1. Choose Shared Parameters on the Manage tab.

 2. In the Edit Shared Parameters dialog box, click Create (Figure 19.41).

 3. Specify the directory path and name of the new file; then click Save. The name of the new 
file that you assign here is not as important as the fact that this file needs to be accessible 
in Read mode for all team members. Do not give the filename an extension because the 
.txt extension will be appended automatically.

creatinG a Group of parameterS

Revit requires that you create a group before you can create a shared parameter.

 1. In the Edit Shared Parameters dialog box, under Groups, click New to create a new 
parameter group (Figure 19.42).

Figure 19.41 
The Edit Shared 
Parameters  
dialog box.

Figure 19.42 
Making a  
new group.
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 2. Give the new group the name Doors. To help you organize your shared parameters, you 
will want to name the group logically.

creatinG the Shared parameter

Now that you’ve created the backbone for the shared parameters, let’s create the parameters 
themselves.

 1. Still in the Edit Shared Parameters dialog box, click the New button in the Parameters 
section (Figure 19.43).

 2. In the Parameter Properties dialog box, do the following:

Enter a name for the new shared parameter. Call it •u	 Lockable Door

Under Discipline, keep the default, Common•u	

In the drop-down list under Type of Parameter, select Yes/No•u	

Confirm by clicking OK•u	

Figure 19.43 
Adding a new 
parameter.
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And that’s it! You’ve just created the shared parameter for door hardware and are ready for 
the next step: adding it to a door tag in the Family Editor, then moving into the project environ-
ment and assigning it to the Doors category. As explained earlier, you can only tag a custom 
property that you define if you share it across the families and the project.

creatinG a new project parameter uSinG the Shared parameter and aSSiGninG it to a 
cateGory

In the following steps, we’ll make our shared parameter a project parameter and assign it to the 
Door category.

 1. Open the file Foundation.rvt.

 2. Open the plan view Level 1.

 3. Choose the Manage tab and click Project Parameters. A list of parameters will appear. 
The Lockable Door shared parameter that you just created is not among them, so you will 
need to click the Add button (see Figure 19.44).

 4. In the Parameter Properties dialog box, in the Parameter Type group you will see a 
Shared Parameter option. Check it and click Select.

 5. The Edit Shared Parameters dialog box opens, and you will see the shared parameter you 
have just created, automatically selected. Click OK (see Figure 19.45).

Figure 19.44 
Adding the  
parameter.
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 6. In the Parameter Properties dialog box, set the Group parameter to Identity Data. Make 
sure you select the Instance radio button. This will make the parameter instance based 
since in the real world the same door type may or may not be lockable.

 7. All that is left to do now is select the category to which this shared parameter will apply. 
In the Categories list, select Doors (see Figure 19.46). Note that you can assign the param-
eter to as many categories as you wish.

 8. Confirm all that you have done by clicking OK.

Figure 19.45 
Linking the shared 
parameter.

Figure 19.46 
Assigning  
categories.
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SettinG the Shared parameter in the objectS that belonG to the Selected cateGory 
(doorS)

Now that you’ve created a shared parameter, you need to add the tags to show the lockable and 
nonlockable doors.

 1. In plan view, select a door (let’s say the door belonging to Room 131—Storage) and open 
its properties (see Figure 19.47).

 2. Notice that the newly created parameter appears in the group Identity Data, just as we set 
it to be. Note, however, that the value is gray, meaning that it has not been set.

 3. To set the parameter to one of the states, lockable or not, click the check box. Click again 
to clear the check box and void the selection.

You don’t have to set this parameter one door at a time. You can select multiple doors that 
will have a lock and check the box using the same method or set this value through the door 
schedule itself.

Figure 19.47 
Selecting a door  
in plan.
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addinG the Shared parameter to a door taG

If you only wanted to add a new parameter to the door category and schedule it, you could have 
done so by using a simple project parameter. The point of making a shared parameter is that 
you will be able to add it to the door tag family as well as tag the door and display the value of 
the shared parameter in that tag. You will now add this shared parameter to the door tag family 
so that the tag understands the shared parameter value and displays it. If you just added a new 
label for the shared parameter and the door is lockable, the door tag for a lockable door would 
simply display “Yes.” The parameter we made only reports Yes/No values, which is not very 
helpful. So you’ll need to add a static textnote next to the label: Lock (see Figure 19.48). 

There are two ways to create a tag that calls out a shared parameter: 

Take an existing door tag, duplicate it, and then add the shared parameter to the duplicate•u	

Make a tag from scratch•u	

In this exercise, we will make a new door tag from scratch.

 1. Go to the Application Menu,   New  Family. Select the Annotation folder.

 2. In the New dialog box, select the family template Door Tag.rft and click Open.

 3. The Family Editor opens in plan view, showing two crossing reference planes. The inter-
section of the two reference planes represents the insertion point (and center point) of the 
tag to be created. In the tag, you’d like the following information to be displayed: the door 
mark and whether it has a lock.

 4. Click the Label button on the Create tab. Click with the mouse somewhere close to the 
crossing point of the two references.

Figure 19.48 
The tag with  
fixed text.
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 5. In the Select Parameter dialog box, select Mark and click OK (see Figure 19.49).

 6. The Mark text is set to 1⁄8˝ (3mm) by default. This might be a bit big if we want to add a 
mark and a lockable parameter, so we need to make the font size smaller. In the Element 
Properties dialog box of the mark, click Edit/New. Click Rename in the Type Properties 
dialog box and enter a new name, indicating the size of the mark, 3/32˝ (1.5mm bold). 
Click OK. 

 7. In the Type Properties dialog box, set the properties of the mark as shown here:

 8. Confirm by clicking OK in the remaining dialog boxes when finished. What you see 
should be similar to what is shown here:

Figure 19.49 
Selecting the Mark 
parameter.
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Note that 1i is just a symbolic representation of the label. Once placed in the project environ-
ment, it will read and display the mark of the door.

 9. Remember, the goal was to display the hardware information about the door within the 
door tag. For that, we will now add the shared parameter Lockable Door to the door tag. 
Click again on Label on the Create tab and position this second label below the first, also 
centered in the tag.

 10. In the Edit Label dialog box, click the Add a Parameter button, and then in the Parameter 
Properties dialog box, click Select. The shared parameter list opens; here you will find the 
Lockable Door parameter. Select it and click OK in all remaining open dialog boxes.

 11. You can also select the Shared Parameter label in the Drawing area, click Modify to 
access its element properties, and set Sample Text to Yes.

 12. You will probably want to change the size of the text here as well to 3⁄32˝ (1.5mm), so navi-
gate to Edit/New and under Type Properties, select Duplicate. In the Name dialog box, 
enter 3/32˝ (1.5mm). Confirm by clicking OK.

 13. Clear the Bold parameter and click OK in all remaining dialog boxes.
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 14. Adjust the position or the size of the label if needed.

All that remains for you to do is to add the fixed text that will say “Lock:” and position it just 
in the front of the shared parameter label.

 15. Click Text in the property dialog box. In the drawing area, click somewhere in front of the 
label Yes.

 16. Enter the text Lock: and on the Options bar, select Properties. Repeat Steps 6 and 7 of this 
exercise to adjust the size and name of the new text type to match the label we added. 
Click OK in all remaining open dialog boxes.

The tag is ready. Save it and load it in the project Foundation.rvt. If you have already placed 
door tags, you can select them all and exchange them with the new tag that contains the shared 
parameter by simply selecting it in the Type Selector. You will notice that now all your door tags 
will display the mark on the top and the word Lock at the bottom. For doors that you previously 
defined as lockable, it will also show Yes. You will see that many doors have nothing shown in 
the tag after Lock:. Those are the doors that haven’t been marked Yes or No, such as the one in 
Figure 19.50.

Shared parameter Notes and Cautions

Keep the following point in mind when you create shared parameters: once you have added a shared 
parameter to your project, you will not be able to change any of the properties of the parameter itself. 
If you forgot to set the Yes/No parameter, or if you mistakenly selected Type instead of Instance, you 
will not be able to change this setting. To fix that, you will have to create a new project parameter 
using the same shared parameter—and be more careful the next time.
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Adding Text and Keynotes
Notes are a critical part of communicating design and construction intent to contractors, subs, 
and owners. No drawing set would be complete without written definitions and instructions 
on how to assemble the building. Revit has two primary ways of adding this information to the 
sheets. One way is through text. Text in Revit consists of words arranged in paragraphs with or 
without a leader. Text can be used for specialized annotations, sheet notes, legends, and similar 
applications. Keynotes—the other way of annotating a drawing—are element-specific and can 
be scheduled and standardized in the Revit project file. Chapter 4, “Setting Up Your Templates 
and Office Standards,” briefly introduced text and keynotes as elements you can include when 
customizing your template. In the following sections, we’ll explore the use and function of both 
tools in more detail.

Text
Text is easy to add to any view. However, it’s important to understand that text is nothing more 
than a view-specific annotation. Specific text families maintain a parametric relationship through-
out the project, and changing one text family type changes each instance of that type throughout 
the project. While text is a family within Revit, it is not directly tied to values of other families 
like keynotes or tags. Text is only text, and it will not dynamically report properties from elements 
it is pointing to.

You can access the Text tool from the Annotate tab. Text can be added to any view, including 
a 3D axonometric view (but not perspective views). To begin adding text, click the Text button 
after you’ve opened the view of your choice, select where in the view you wish to place text, and 
begin typing. To edit text you’ve already placed, click the text to highlight it, and then click it 
again to activate the text box. To move text once you’ve located it, select it and drag it, or use the 
Move command.

Figure 19.50 
A door without  
a Yes or No value 
for Lock.
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As with all the elements in Revit, there are ways to change the look and feel of the object 
being created. Once you’ve selected the Text tool, the Type Selector and Options bar provide 
some formatting options:

The Type Selector allows you to choose a style for the text you’re about to create. You can 
manage each text style using the Properties dialog box, which lets you modify parameters 
such as font, size, and color. To create a new text style from an existing one, click the Element 
Properties button and in the Instance Properties dialog box choose Edit Type and then choose 
Duplicate to duplicate the type and make adjustments to the properties (see Chapter 4). You can 
also choose to add a leader to the textnote before placing the note.

There are four options for leaders: 

No Leader•u	

One Segment •u	

Two Segments•u	

Curved•u	

Once you’ve placed the text, selecting the note itself provides additional options. You can add 
or remove additional leaders and rejustify the placed text. Note that when you are adding or 
removing leaders, the leaders will be removed in the order they were added to the text.

To edit the text, select the element. The letters will turn from black to blue. You can then click 
to place your cursor inside the text, and begin editing. When you’re editing the text, the Options 
bar will display formatting controls for bold, italic, and underline text styles. These apply to 
whatever text you’ve selected in the note.
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When you use the Move command, you move both the text and the leader. When you move 
text by dragging the arrow icon, you move only the text box, leaving the leader anchored in its 
original position. When moving text with the arrow icon, Revit will automatically align verti-
cal and horizontal text and leader nodes. This is designed to help you achieve a more consistent 
graphical appearance. One of the biggest limitations of Revit is that you cannot apply changes in 
text style to multiple elements (tags, schedules, title blocks, keynotes, or dimensions, for exam-
ple). So, if you want to make all text in Revit use a particular font, you will not be able to change 
a global project setting. Instead, you will need to edit each element’s type individually. A good 
way to avoid this type of change is to standardize the fonts in your project templates, as covered 
in Chapter 4.

Keynotes and Textnotes
Keynotes and textnotes are written annotations that use an external file to relate text to specific 
elements in the model. You can format font style, size, and justification in the same manner you 
can format standard text, but keynotes and textnotes behave similarly to a Revit family. This 
means you can insert different family types of text in Revit, just as you would door or window 
families. Changing one instance of the family type changes all the instances in the project. 
Because keynotes and textnotes act as families in Revit, they can also be scheduled. 

What’s the difference between a keynote and a textnote? A keynote is a short reference, typi-
cally a number followed by a couple of letters. An example would be 03300.AA, which points to 
a cast-in-place concrete wall. The 03300 portion of the note refers to the specification section the 
note is generated from, and the AA portion is a sorting mechanism used to differentiate cast-in-
place concrete from another note in Division 3 of the specifications.

All of the notes on a given sheet are keyed back to a legend, which is typically placed on the 
right side of a sheet. This reference helps you add more detail and understanding to the keynote 
without having to reference the specifications directly. (See Figure 19.55 later in this section for 
an example of a keynote and legend.)

Textnotes are very similar to keynotes, but they combine a short description of text and the 
key into one note. This saves you from having to coordinate the legend on the sheet and puts 
the note right next to the item you are pointing to. (See Figure 19.52, later in this section, for an 
example of textnotes.) No matter which style you prefer, you can create both the keynote and 
textnote with the same command in Revit. Since the command is called Keynote in Revit, we 
will refer to the process from here on out as keynoting regardless of the style of keynote (or text-
note) you choose to use. See Figure 19.51.

Figure 19.51 
Textnotes with 
keynotes.

56491c19.indd   570 6/2/09   11:26:43 PM



Adding text And KeYnotes | 571

The Keynote command is located on the Annotate tab. When you add keynotes in Revit, you 
have three options:

Element     This option allows you to note an element in the model, such as a wall or a floor. 
This type of note is typically used if you want to note an entire assembly, such as a wall 
assembly. You can find this value in the family properties of that element.

Material     This option allows you to note a specific material in Revit. You can add a note to 
concrete, gypsum board, or insulation, even if they are a part of an assembly.

User     This option allows you to select any model-based component in Revit and define a 
custom keynote for it. Notes defined this way differ from those defined as element or mate-
rial because they’re unique to the particular object selected. They can be used in conjunction 
with element and material notes.

All of these note types can be used in conjunction with one another. Using an element note to 
add a keynote to a wall doesn’t mean you can’t also use a material note to call out the individual 
materials in the wall assembly.

Keynote Behavior and Editing
A core concept in keynoting is how the notes react in the model. Keynotes are integrated into 
Revit just like any model element. Keynoting an object in Revit lets you associate a text value 
with that family’s keynote parameter. This value is consistent for every identical element in 
the model. For example, all doors have a type parameter that lets you set the keynote value. If 
you keynote a door—anywhere in the model—the keynote will show that value. Likewise, if 
you ever change the value of the keynote for the door type, all keynotes for that door type will 
update automatically.

Keynotes are special in that you cannot edit the text of a keynote directly in Revit. All the key-
notes in Revit are tied to an external text file, and can only be edited in this location. This file 
can be modified at any point to add or remove values and notes. A sample list looks like this:

03100 Concrete Forms and Accessories 03000 

03200 Concrete Reinforcement 03000 

03300 Cast-in-Place Concrete 03000 

03400 Precast Concrete 03000 

03500 Cementitious Decks and Underlayment 03000 
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This external text file is designed to keep annotations consistent by storing all of them in one 
repository. Every time you add or change the text of an annotation and reload the text file, it 
dynamically updates all the keynotes of that type used in the project.

You can edit a keynote text file (.txt) or add one to a project at any time. You can have mul-
tiple text files for various projects, but you can have only one text file per project at a time. The 
text file works just like any other Revit family. Since all the notes are parametric, changing a 
note in the text file will change all of the notes in the project when the text file is updated.

A powerful way to ensure consistent use of notes throughout your office is to create a mas-
ter text file for your various project types. These master note lists can be linked to materials or 
assemblies within your project template so that you can immediately begin inserting common 
notes into any project. To link keynotes to a material, click the Materials button on the Manage 
tab  and select the Identity tab. In the Keynote field, a predefined note can be selected from the 
master list and added to any material. The same is true for any assembly. Simply choose the 
assembly’s properties (such as a wall or floor) and select the keynote field to enter a note value.

Since the keynote text file is separate from the Revit file, if you send a project file to someone 
and don’t send keynote.txt, that person will be able to see all the keynotes you’ve added to the 
views but won’t be able to add or edit the notes without the text file.

Keynote Filenaming Conventions
The default Keynote text file in Revit is found in C:\Documents and Settings\All Users\
Application Data\Autodesk\RAC 2010\Imperial Library (or \Metric Library) and is called 
RevitKeynotesImperial.txt or RevitkeynotesMetric.txt.

To edit this file, open it in Notepad or Excel and follow the format already established in the 
file. Let’s look at that format to get a better understanding of how to customize keynotes.

The first few rows designate the groupings. They consist of a label (in this case, a number) 
followed by a tab and then a description. An example grouping looks like this:

03000 Division 03 - Concrete 

Below the groupings, with no empty lines in the file, are the contents of the groupings. These 
are shown with a minor heading, a tab, a description, a tab, and the original grouping header. 
Here’s an example:

03200 Concrete Reinforcement 03000 

Here, 03200 is the subheading, Concrete Reinforcement is the description, and it all falls 
under the 03000 grouping from the previous example.

Using this method, you can add or edit notes and groups of notes to the keynote file. It might 
seem horribly inefficient at the beginning of the process to have to constantly go to the keynote 
text file to edit or add notes. While this might seem like a burden, it can be a blessing as well. 
Accessing this file ensures a global consistency within the keynotes on a project that is unattain-
able in most drafting applications. If you are feeling frustrated with having to access this file to 
make changes, think about all of the time you are saving not having to check your set sheet by 
sheet to verify that all of the notes pointing to a material are the same.
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Keynote Settings
Once you change a keynote text file, you need to reload the file into Revit to update the key-
notes. You can open the dialog box to change or update the text file by choosing the Annotate 
tab, expand the Tag panel, and choosing Keynote Settings (Figure 19.52).

In the Keynote Table group, you define the path to the text file used for keynoting:

Path Type     Path Type defines how Revit looks for your text file using one of three methods:

Absolute    This option follows the UNC naming conventions and navigates across your 
network or workstation for a specified location.

Relative    This option locates the text file relative to the Revit project file. If you move the 
Revit file and the text file and maintain the same folder structure, Revit knows where to 
look for them.

At Library Locations    This option lets you put the text file in the default library location 
defined on the File Locations tab of the Options dialog box (click the Application button 
and choose Options).

Numbering Method     Numbering Method defines how the keynotes are numbered:

By Keynote    This option allows you to number keynotes as they come from the associ-
ated text file.

By Sheet    With this option enabled, Revit numbers the keynotes sequentially on a per-
sheet basis.

Adding Keynotes to a View
To add keynotes to a Revit model, choose one of the three keynote types from the Annotate tab. 
In your view, hover your mouse over the various model objects until you find the one you want 
to note, and click to add the keynote. You’ll then be prompted to add a two-joint leader, which 
will end at a box containing the text of the note you assigned to that material or assembly. Once 
you’ve placed the note on the sheet, you’ll see a dialog box (Figure 19.53) where you can identify 
the element you’re trying to note if it doesn’t already have a note associated with it.

Figure 19.52 
Keynoting Settings 
dialog box.
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Expand the plus signs until you find your desired keynote and double-click it. Doing so glob-
ally associates that particular note with the element or material in the model. As mentioned 
previously, you need to make this association only once. For example, if you keynote a material 
called Concrete, then every time you hover the mouse over that material anywhere else in the 
model with a keynote tag, you’ll see the preview graphic of the tag, which reads “Concrete.” 
This way, you can define the materials and assemblies in the model and begin your documenta-
tion process.

With the exception of detail components (covered later in this chapter), you can’t keynote 
lines or other 2D information.

Keynote Legends
Depending on your workflow and style of annotation, you may want to create a legend on each 
sheet for your keynotes. You might want only the keynotes that are on a given sheet to appear 
in the legend. Or you may wish to have one legend for the entire project that will show all key-
notes used in the project. The legends allow the builder to reference the note number with the 
text quickly and easily (see Figure 19.54). These lists usually reside on the side of the drawing 
near the title block information and can take either of two forms. The first type is all-inclusive 
and shows every note within the project. This style has the benefit of consistency between sheets 
in the set. The same note will always be in the same location in the list. The other type of key-
note list includes only the notes that are present on a particular sheet. This has the advantage of 
supplying a list of notes customized for each sheet without extraneous information. As you can 
imagine, this second list can be labor intensive and fraught with opportunities for human error. 
One of the beauties of Revit is its ability to accurately manage this kind of information for you. 
We will review how to create both types of lists.

Creating a keynote legend in Revit is simple. Choose the View tab, and in the Legend panel, 
select Keynote Legend. You’ll be prompted to name the legend; enter a name and click OK.

Figure 19.53 
Selecting a keynote.
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Only two fields are available in a keynote legend, and by default, they are both loaded into 
the Scheduled Fields pane of the Fields tab. Those fields are as follows:

Key Value    This field contains the numeric value of the keynote.

Keynote Text    This field contains the text value for the keynote.

A keynote legend works very much like any other schedule as far as formatting and appear-
ance. By default, the sorting and grouping are already established because the key value is used 
to sort. The one special item to note is located on the Filter tab. At the bottom of this tab is a fea-
ture unique to this type of schedule: a Filter by Sheet check box (shown in Figure 19.55) is avail-
able. Checking this box gives you the ability to filter the list specifically for each sheet set.

Either legend style you make can be placed again and again on every sheet in the project. The 
filtered legend style dynamically modifies the note list based on each sheet and the contents on 
each sheet. As views are added or removed from a sheet or notes are added to the project, the 
keynote legend updates accordingly. If the keynote is not used in the view placed on the sheet, it 
will not show up in the legend for that sheet.

Figure 19.54 
A keynote legend.

Figure 19.55 
The Filter by Sheet 
check box located 
at the bottom of 
the Filter tab in  
the Keynote  
Legend Properties 
dialog box.
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Keynote legends are considered another type of legend view: once created, they appear 
under the Legends branch of the Project Browser.

a Schedule for Keynotes

Creating a schedule for keynotes is a great way to find rogue notes and typos in a project. If you 
are working on a project team of any size, there’s always a chance that someone could be inserting 
an incorrect textnote into the project. Scheduling the notes is an efficient approach to managing 
this process and gives you the tools to verify consistency. Scheduling textnotes allows you to do 
two things: 

List all of the notes within a project and verify their spelling and accuracy•u	

Find the odd note. Sometimes a particular note only shows once or twice in a project. When •u	

this happens, it can mean the note was accidentally placed in lieu of another note

The Keynote Family
Revit comes with a keynote family that allows you to produce both keynotes and textnotes. If it 
is not loaded into your project, you can find it under the Annotations folder in the Imperial or 
Metric library. The family name is Keynote Tag.rfa. This family has three family types that let 
you change note styles within the project. You can see the three note styles in Figure 19.56.

The three default styles are Keynote Number, Keynote Number–Boxed, and Keynote Text. 
Each of these notes pulls information from the text file we discussed earlier in this chapter. We 
are simply using the flexibility of family types to report different values within the model from 
the same note. Like any other family, this family can be edited to change the note length, font 
style, or other attributes to match your office standards.

addinG noteS to a wall Section by material

As we discussed earlier in this chapter, there are three styles of keynotes: element, material, 
and user. With each of these styles, there are limits to what you can note within Revit—and 

Figure 19.56 
Note styles avail-
able in the default 
Revit keynote tag.
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these three note styles can annotate only objects within Revit. Understanding this is critical to 
successfully using the keynote system within Revit so you can optimize the value of your pre-
defined notes.

Here’s a summary of the most common tasks you can perform with keynotes:

Add notes to elements such as walls, roofs, floors, and families that are a combination of •u	

materials or elements

Add notes to the individual materials themselves or to any element that can be given a •u	

material

Add notes to detail groups and detail components. •u	

While this is an extensive list and covers most of what happens in Revit, there are a couple of 
things you cannot tag with the Keynote tool: detail lines; and groups (although you can tag ele-
ments within groups).

This becomes a critical issue when you begin embellishing details within a model. As a best 
practice, it is recommended that you optimize the use of detail components and embed them 
into the project families. Detail components are families created with 2D linework that can 
be dropped into any view to represent elements that are not directly modeled. For example, 
blocking that would appear over a window head is not something you would create as a model 
element, but it is still necessary to show in a section or detail (see Figure 19.57). We cover the 
technique of creating and noting detail components in Chapter 21, “Moving from Design to 
Detailed Documentation.”

Once you’ve established your keynote style and made your adjustments to font size and type 
and linked a keynote TXT file, you can add some notes to the drawing. Adding notes to a draw-
ing from this point is quite simple.

 1. On the Annotate tab, click the Keynote button.

 2. Select Element, Material, or User from the list. In our example, we’ve selected Material.

 3. When you hover your mouse over the material, Revit will try to identify it. If the material 
already has a note value defined, Revit will show you a floating note identifying the material.

Figure 19.57 
Detail components 
can be tagged with 
keynotes.
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 4. From here, click to place the arrowhead of the note, click again to locate the joint in the 
leader, and then click once more to locate the text. If the material is unknown, Revit 
shows a question mark to tell you this material has not yet been identified in the project.

 5. Locate the note using the same method for materials that are already defined (see 
Figure 19.58). After you set the text location, Revit will prompt you to select a value from 
the Keynotes table.

 6. Once you’ve selected the note for a material, that same note will be applied every time 
you select that material with a keynote in every other view in the project.

By default, Revit 2010 includes the Open 30 Deg arrow as a standard for your keynotes. 
However, this is new to the Revit 2010 default template and will not be the case if you are 
upgrading your template from a previous version. Revit doesn’t provide a way to preset arrow-
head styles for notes unless you preset them in the project template. After you first insert a note 
into Revit, select it to add an arrowhead. To do this, select the note and navigate to its properties, 
and then select Edit Type. Here you can globally set an arrowhead style for any of the keynote family 
types. Most of the common arrowhead styles can be found in this properties box. Selecting one 
from the list will change the arrowheads for all of the notes of that type in the project.

Figure 19.58 
Adding notes to a 
material.
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Once you’ve added a couple of notes, it’s an easy process to continue noting the remaining 
materials in the wall section. The completed section with keynotes looks like Figure 19.59.

addinG noteS to a wall Section by element

Another way to keynote a drawing is to note by assembly or, within Revit, by element. Keynoting 
by element means that you are not noting the individual materials as we did in the previous example 
but the entire assembly at once. So, in lieu of noting plywood and gypsum board, you are noting 
the entire wall assembly at once. The process to add the notes is very similar.

 1. On the Annotate tab, click the Keynote button.

 2. Select Element, Material, or User from the list. In our example, we’ve selected Element.

 3. When you hover your cursor over the element or assembly, Revit tries to identify it. If the 
element already has a note value defined, Revit shows you a floating note identifying the 
material. From here, click to place the arrowhead of the note, click again to locate the joint 
in the leader, and finally, click to locate the text. If the material is unknown, Revit shows 
a question mark to tell you this element has not yet been identified in the project. Locate 
the note using the same method you used for elements that are already defined, but after 
you set the text location, Revit prompts you to select a value from the keynotes table.

A wall section noted by element looks like Figure 19.60.

Figure 19.59 
A wall section 
annotated by 
material.

Figure 19.60 
A wall section 
noted by element.
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Remember that element, material, and user notes in Revit are different entities and are 
allowed their own, unique notes. You can note by material, by element, and by user within the 
same project.

Predefining Keynotes
There are a variety of other ways to add notes to a project without adding them directly in a view. 
Within the properties of elements and materials is a field to predefine a keynote. By putting a value 
in this field before noting the drawings, you can avoid selecting notes from the keynote list when 
you are actually annotating a view. All of the notes would be preselected. Depending on the note 
type, the location for these settings varies.

Element    This value can be set in the properties of the various families in a Revit project. 
By selecting a wall, for example, you can select this wall’s properties, and then click Edit/New 
to reach the wall type properties. Under Identity Data, you can then define a keynote (see 
Figure 19.61). Selecting this field, you will be presented with the same keynote table that 
you’d receive if you were noting this element in a view. If the note is incorrect for this project 
or element, you have the option to change the note here as well.

Material    This value can also be set by clicking the Materials button on the Manage tab. By 
selecting a material from this list, and then selecting the Identity tab, you can add keynote 
values directly to your materials (see Figure 19.62). You will again be presented with the 
familiar Keynote dialog box to select your materials.

Figure 19.61 
The type proper-
ties of the wall 
showing the  
predefined Key-
note field.
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User    User notes are view-specific and cannot be predefined. While it is still possible to 
annotate only model elements and detail components with user notes, this tool will allow 
you to note the same element with different notes in separate views. This can be dangerous 
to the consistency of your notes in your drawings if used inappropriately. The advantage of 
this note type, however, is if you need to note something differently in one view based on a 
unique condition. For example, you might need to note a material or color change in a special 
location or a special flashing or sealant issue around a unique window condition. This will 
spare you from having to create a new family type simply to add a different note.

Revit does not support more than one keynote.txt file per project, so if you wish to include 
keynotes from different standards, you can simply add more text entries to the text file that you 
have for the project and they will all be available immediately within Revit.

The Bottom Line

Annotate views.    Room elements are highly useful tools for a number of different applica-
tions in a set of documents. Learning how to use them and tag them will help you find areas, 
create finish schedules, and identify spaces.

Master It    Once the model has been largely built, you need to start adding information 
about rooms and finishes. What tools would you use?

Use schedule keys.    Adding information to the room element is only part of the documenta-
tion and design process. Knowing how to schedule that information allows you to communi-
cate effectively with owners and contractors.

Master It    Tags are used to report information about an element. How do tags work in 
Revit so that they always report accurate and consistent information about the elements 
they tag?

Leverage tags.    Revit supplies you with three ways to annotate your model and the project. 
Knowing when to use each and planning for them early in the documentation phase saves 
time and frustration.

Master It    It is important to understand the relationships between elements and materi-
als in Revit early. How does this help streamline the process of keynoting your project 
when you reach the documentation phase?

Figure 19.62 
Defining keynotes 
for materials.
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Understand shared parameters.    Revit lets its users add as many custom parameters to an 
element as are needed. When those added parameters need to be visible both in schedules as 
well as in the elements tags, they need to be created as Shared parameters.

Master It    You added a custom parameter to your door and window elements and wish 
to schedule and tag it such that each window or door tag displays the information about 
the hardware set. The schedule works well, but your tags seem to be unable to find the 
hardware set parameter. What is wrong?

Add text and keynotes.    No set of drawings is complete without keynotes or textnotes. 
Understand how to create and modify them for a complete set of documents.

Master It    You will need to add notes in every stage of design to communicate your 
design intent on a project. How do you create and modify the notes to ensure accuracy 
throughout all the sheets in the set?
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Chapter 20

Developing the Design with 
SmartWorkflows

In this chapter we’ll explore scenarios in which elements in a building repeat, and you’ll learn 
how to take advantage of some tools in Revit to help your workflow be more efficient and less 
prone to error. The tools we’ll explore are called groups and links—tools specifically designed to 
support design and propagation of repetitive entities, which can range from entire buildings to 
individual rooms to furniture arrangements.

Both of these tools require an understanding of some basic principles that will help you make 
decisions about when and where to engage these features in a design. We will introduce the con-
cept behind each tool and present a series of use cases in which groups or links provide a valuable 
solution to a design problem.

In this chapter, you’ll learn to:

Work with repetitive elements•u	

Understand the use of groups•u	

Understand the principles of links•u	

Decide whether to use groups, links, or both•u	

Working with Repetitive Elements
Many architectural projects deal with the design and organization of repetitive elements. The 
concept of a modular unit that is repeatable has been one of the more important principles of 
architecture and continues today in the form of housing, hospitals, schools, and office buildings. 
A repetitive element can be found at nearly every scale: from entire buildings to housing units; 
from hotel rooms, classrooms, and hospital rooms to bathrooms, closets, and furniture layout. 

In each case, the basic requirement is to group a collection of elements that is repeatable so 
that later in the design process any change to the module will be propagated to all the other 
instances (copies) of the module. This propagation results in huge time savings, as you don’t 
have to manually update the model, element by element. This also guarantees consistency and 
means there are fewer changes to correlate as documents are reviewed. 

At the same time, flexibility must be built into the tool to account for edge conditions where 
the repetitive unit needs to stray away from base without breaking its relationship to the essential 
nature of the module. Revit is remarkably well suited to meet both these needs and support a 
diverse set of design requirements.
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Understanding How to Use Groups
Groups significantly improve your workflow when you are working with collections of elements 
that need to be repeated throughout a project. 

When a collection of related elements is made into a group, it becomes possible to manage and 
change any single instance of the group and have the changes propagate throughout the entire 
model—all in one interaction. It is also possible to execute a change on one group instance only 
and not have that change propagate. As you will see, Revit was designed to be flexible. It lets you 
group elements in a project or even inside a family and use it to quickly lay out entire floor plans. 
You can also save groups and reuse them in other projects, making them quite versatile.

As we’ve discussed previously, the Revit categorization schema is intelligent: objects know 
what category they are and in what views they are visible. This directly impacts how groups are 
created and organized. For example, model elements (walls, floors, furniture, etc.) are grouped 
as model groups, and 2D, view-specific elements (dimensions, annotations, etc.) are grouped as 
detail groups. There is also a hybrid category called attached detail groups, which relates grouped 
details to a specific model group. If you create a group that contains both types of elements (model 
and annotations), Revit automatically stores this group as a model group with an attached detail 
group for the view-specific information. Keeping tags and keynotes associated with a model ele-
ment in a group is an example of this. That said, there are certain conditions where information 
cannot be attached within a group. For example, if a dimension between two walls is added to a 
group but only one of the walls is in the group, Revit cannot attach the dimension. The dilemma 
is obvious: when new instances of the group are placed, where should the dimension go in the 
absence of the original, ungrouped wall? Remember that dimensions, tags, and keynotes refer to 
real model elements and cannot exist without their references (hosts).

Using Groups for Repetitive Rooms
Most architectural firms have projects where repetitive units are used throughout the design. In 
our first example, we will work on a day-care center for children with cancer (Figure 20.1). The 
design calls for many typical bedrooms, most of which will be the same size and have the same 
accommodations (bed, bathroom, furniture). The ability to design, iterate on, and manage all 
these bedrooms will be a major part of the project, which also has to be easy to maintain, sched-
ule, and update.

We will first work with groups to solve this design challenge; later we will look at the same 
issue from the vantage point of using links and examine the differences between the two 
approaches. As you will see, each method leads to different results.

Figure 20.1 
Repetitive  
elements sample 
model.
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Creating and Managing Groups
As soon as the building design is roughly oriented on the site and you start laying out the 
modules inside the project, you can immediately take advantage of group functionality by 
defining the basic room unit that will repeat. Later, you can add more content in one instance of 
the group, which will then populate into other instances of the group that are placed through-
out the project.

Early on, you’ll work with walls and rooms to create reliable area schedules that will show 
you how the design is stacking up against the program requirements. You’ll also take full 
advantage of BIM by keeping all information centralized in one file. Using links (external file 
references) rather than groups, you would not get these benefits.

Creating and Placing Repetitive Units Using Groups
Let’s step through a workflow using groups to lay out bedroom units.

 1. Open the Chapter_20_Model_Groups_Start.rvt file from the book’s companion web 
page (www.sybex.com/go/masteringrevit2010). The project should open with the plan 
view (Level 3) shown in Figure 20.2.

 2. Create a room and add a door, as shown in Figure 20.3. Select the front wall with the door 
and one perpendicular wall and create a group by clicking the Create Group button in 
the active contextual tab.

Figure 20.2 
Floor plan showing 
just the exterior 
skin and core (the 
interior has not yet 
been designed).
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When creating the group, you only chose one of the perpendicular walls (the one on the right 
side) because you need to repeat the module along the length of the space. If you added both 
perpendicular walls to the group, you would end up with overlapping walls when the unit was 
copied along the length of the building. This would result in lots of warning messages to deal 
with. Not taking these warnings into account would later affect the scheduling of walls, so 
you need to be smart about how you make your groups.

 3. Once the Group tool is activated, you’ll be asked to name the group. As soon as this task 
is finished, the new group will appear in the Project Browser under Groups  Model 
Node. The group is listed as a model group because all elements we selected to become a 
part of the group were model elements.

 4. Before you make any changes to the group, take a look at a symbol showing the group 
origin (Figure 20.4).

The group origin symbol (insertion point) is placed at the middle of group geometry by 
default, but you can change it to what you feel will be the most appropriate and practical point 
of insertion when you pick the group to reuse and place again in the project. Move the group 
origin symbol to the intersection of two walls, which will help when placing new instances of 
the group. To do so, place the mouse over the intersection of the X and Y axes and drag it to a 
new position, or use the Move tool.

Figure 20.3 
Model group  
created out of the 
elements of the 
first room you  
created.
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There are many possible ways to proceed in the group placement process. You can insert 
more instances of this group along this wing of the building using the Copy Multiple Instances 
tool or the Array tool. An alternate approach is to use the Project Browser, and drag and drop 
the group instances into the view (Figure 20.5). Let’s see how this works.

 1. For this exercise, drag and drop from the Project Browser to place new instances of the 
group in the floor plan. (You can place groups in 3D views as well, but the common use 
case is in plan.) Once you drag the group from the Project Browser into the view, release 
the mouse button and take your time zooming in to the insertion point in order to get the 
correct snap without stressing your hand. 

After choosing the insertion point, you’ll see that the walls belonging to the group clean 
up with other walls that do not belong to the group. This is perhaps the most profound dif-
ference in behavior between groups and links (which we’ll get into a bit later): essentially, 
linked elements cannot interact with elements in the model they are linked to, while walls 
belonging to a group will clean up with walls from the main model.

 2. Continue to place groups until you arrive at a more developed floor plan. To speed up 
the process, try using the array command to array the group across the floor plan—just 
be sure to un-check the Group and Associate option in the Options bar, or you’ll end up 
with redundant groups. (Figure 20.6).

Figure 20.4 
(Left) Group origin 
default location. 
(Right) Origin 
moved to new  
location.

Figure 20.5 
The group can be 
placed from the 
Project Browser.
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 3. With the basic unit established, you can start adding more complexity and really see the 
power of groups. Because all the groups are instances of the original model group, any 
changes to this group will affect the others. Select any one of the groups in the floor plan, 
and take a look at the Group panel in the ribbon:

 4. To change a group during the process of design, select the Edit Group button. This takes 
you to the Group Edit mode, where a new Edit Group ribbon panel will appear.

The drawing area will turn a pale yellow, indicating that you are now in a special Group Edit 
mode (Figure 20.7). The group editing panel appears appended to the end of the ribbon.

Figure 20.6 
More groups  
are added to the 
floor plan.

Figure 20.7 
The Group Edit 
Mode is indicated 
with a pale yellow 
coloring of the 
drawing area, sig-
nifying the special 
mode. The floating 
group editing bar 
offers group- 
specific tools.

56491c20.indd   588 6/2/09   11:36:41 PM



UnDerstanDing how to Use groUps | 589

While in Group Edit mode, move the door to the other side of room. When you click Finish, 
all the other group instances will update with the new door location (Figure 20.8).

The need to change a design is quite common throughout the lifecycle of a project; projects 
evolve over time and are never complete with the first iteration. Groups are not fixed entities and 
are easily edited. You can make changes and add new elements to a group while in Group Edit 
mode seamlessly and at any point of your design process. You can access the modeling com-
mands while editing the group, in order to add these elements. If you need a new component 
added to the group, it’s just a matter of creating it while in Group Edit mode.

The Group Edit toolbar provides the following features:

Add     This allows you to add any element from the project as the current object in the group.

Remove     This allows you to remove elements from the group. 

Attach Detail    This allows you to add view-specific annotations, which will become 
attached details and will be displayed as a subcategory of the model group in the Project 
Browser.

Group Properties    This provides access to the Group Properties dialog box, where you can 
edit the group’s name. The level the group is attached to and its offset from that level are pre-
sented but not editable.

At this stage, you can generate an area report to check the requirements, and the design 
can continue to evolve. You will now add the bathroom and some furniture. Both of these will 
expand on the concept of groups by making new groups and nesting them inside of the unit 
group. You’ll also add some details (dimensioning) to create an attached detail group. To con-
clude, we are going to explore alternatives in the room’s layout.

Adding Rooms to a Group
The next step involves adding rooms so that you can schedule the room units by areas or by 
room type.

 1. Select the unit group, and then click Edit Group in the contextual tab. Once in Group Edit 
mode, use the Room tool (on the Home tab) to place the room. It will automatically be 
added to the group (see Figure 20.9).

Figure 20.8 
Editing one 
group propagates 
changes to all other 
instances of the 
group.
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 2. Click the Finish button on the Edit Group panel to finish the change to this group and 
populate the change into all other instances of this group.

 3. To verify that the rooms now exist, tag them using the Room tag command on the Room 
and Area panel on the Home tab, as shown in Figure 20.10.

Note that when you add a room tag to a grouped room, the room will get propagated but not 
the tag. You will still need to manually tag all the rooms in the copied groups.

 4. To see how many rooms you have and their areas, create a room schedule that includes 
name, number, and area (see Figure 20.11). This can be useful for making decisions about 
the composition of a floor plan and seeing if you are meeting program requirements as 
you make changes to the design.

Figure 20.9 
While in Group 
Edit mode, place  
a room.

Figure 20.10 
Tagging the rooms.
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Nesting a Group into Another Group
Often, repetitive units can be a part of other repetitive units. For example, a standardized bath-
room unit will repeat throughout many hotel rooms. To support this in an intelligent way, Revit 
offers a methodology of nesting a group into a group so that the integrity of the unit is main-
tained. The bedroom group we just created can be completed with the addition of a nested bath-
room group and furniture group. As shown here, a nested group appears in the Project Browser 
as a subnode of its host group.

Following a typical workflow, you can start designing the bathroom by adding walls and 
plumbing fixtures. Once you’ve added new walls and fixtures, select and group them, as you 
did the initial walls (see Figure 20.12). You’ll notice that walls in groups clean up with walls 
outside of the group, making the grouped wall interaction with walls outside of the group 
seamless.

Figure 20.11 
Room schedule 
showing areas.

Figure 20.12 
Build the bath-
room with walls 
and fixtures, and 
then group them  
as a new group.
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To add the bathroom group that you just created to the bedroom unit group, select the group, 
click Edit Group, and use the Add button in the Edit Group panel. By selecting the bathroom 
group, you add it as a nested group in the Bedroom unit group. You will notice that a new entry 
appears in the Project Browser under the Bedroom Unit node.

Finish the Group Edit mode by clicking the Finish button. The bathroom will be propagated 
to all other instances of the group (see Figure 20.13).

Adding Detail Elements to Groups
Now that the unit is more or less complete, you can start adding some annotations and dimen-
sions to the plan in order to better communicate the design. Begin by dimensioning and add-
ing text or tags in one of the units. To repeat the dimensions in other units, you can again take 
advantage of group functionality.

Select a dimension and group it to make a new detail group. You’ll be prompted to give the 
detail group a name. To then add the detail group to the model group, select the group and 
then click the Attached Detail Groups button in the Modify Model Groups tab. This opens the 
Attached Detail Group Placement dialog, where you can choose the detail group to attach.

Once you have a detail group, you can attach it to other instances of the group with relative 
ease. To do so, select a group and then use the Options bar button Place Detail to attach the 
detail group. The details will be added to the group (see Figure 20.14).

Figure 20.13 
All the instances 
of the group are 
updated.
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Nesting a Group from a Previous Project
To continue designing the unit, you can add furniture to one of the units. You can place the beds, 
dressers, and chairs and then group them and nest them just as you did with the bathroom. 

What if you already have a similar grouping of furniture from a previous project that you’d 
like to use in this project? To use a group from another project, open the other project, right-click 
on the group in the Project Browser, and choose the Save the Group to File option in the context 
menu. This creates an RVT file of that group that can be reused in other projects. You can also 
copy/paste a group from one project to another.

To reuse a saved RVT file as a group, select Load as Group from the Load from Library panel 
on the Insert tab, as shown in Figure 20.15. The dialog box that appears has some special options 
that let you choose whether to include attached details or levels and grids when loading. If the 
Attached Details option is checked, you will import any details attached to the file, such as 
dimensions and tags. Levels or grids can also be imported with the group, if necessary, but don’t 
bring in levels and grids if you don’t need them.

Load the file furniture.rvt to use it in this project.
The group will appear in the Project Browser and can be dragged into the view like any other 

group. Drag the group into the view and add it to the unit group. Once you do that, it will prop-
agate to all the other units, as shown in Figure 20.16.

Figure 20.14 
Details can be 
attached to group 
instances.

Figure 20.15 
The Load as Group 
option.
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Making Variations to a Group Instance
In just a few steps, you’ve developed quite a complex structure with extreme flexibility. Not only 
can Revit manage model and detail groups, but it can also work with different levels of nested 
groups within the main group. For example, if an alternative layout is needed, Revit provides 
tools that can facilitate a smart workflow. By right-clicking on the group’s name in the Project 
Browser, you’ll get a better picture of the possibilities (Figure 20.17).

The options displayed here provide the following functionalities:

Duplicate    This creates a copy of the group with a new name and allows you to edit a copy 
of the group without disturbing the original and affecting all other instances of the group. 
This is helpful when you need a significant geometric variation in design from the first 
group. You can then at any point swap groups using the Type Selector. Just keep in mind that 
groups swap out about their insertion point. So be sure that when you swap groups (using 
the type selector) they share an appropriate insertion point. 

Copy to Clipboard    This provides an easy way to choose a group and copy it to other levels.

Select All Instances    This selects all instances of the group in the entire model. Use this to 
quickly make selections for the purpose of deletion or swapping.

Create Instance    This provides an alternative means of placing a group. It’s as if you were 
dragging the group from the Project Browser into a view.

Match    This functions the same way as the Match Type tool. Enable the tool by selecting it. 
By first clicking Room Type A and then clicking a room of Type B, you can change Room B 
into a room of Type A. Another way of doing this would be to just select a group in the view 
and change the type directly using the Type Selector.

Figure 20.16 
Furniture group 
nested into the 
room group.

Figure 20.17 
The context menu 
for groups.
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Edit    This opens the group for editing in an independent session rather than in the active 
project. This allows you to see and edit the group in isolation without the clutter of the project.

Save Group    This allows you to save the group as an RVT file and reuse it later in other 
projects. This option leads to a dialog box where the new file’s name is by default the same as 
the group’s name, and you can decide whether or not to include the attached Detail Groups 
as views. 

Reload     This lets you reload a group. Use this if you edited the group as a separate file and 
saved the changes, and now need to reload it to get the most up-to-date version. Reload is not 
automatic; you’ll be prompted to locate the file on disk to do this.

In our example, you can duplicate the unit group, giving it a new name, and then make edits 
to the newly created group. You can then swap entire groups just as you would any other com-
ponent in Revit (Figures 20.18 and 20.19). Thus, with just a few clicks, you can explore design 
variations and propagate changes quickly and reliably.

Figure 20.18 
Groups before 
changing types.

Figure 20.19 
Groups after 
changing types.
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If you create a furniture schedule, you will be able to see easily how the changes to the 
design affect the quantities (Figure 20.20).

To understand the full potential of Revit groups, you should be aware of some other options. 
Let’s consider a practical example. What would you do if you need one of the Room A groups 
to have eight pieces of furniture instead of nine? The intuitive answer would be to duplicate the 
group and just take away the chair while in the Group Editor. Although this option would work, 
it means generating an additional new group and thus additional information for the project to 
handle, thereby adding more complexity, which always makes the project more prone to perfor-
mance issues.

Revit groups have a feature called Exclude, which basically takes away selected objects from 
selected instances of a group without altering the rest of the group’s instances. The object is not 
actually deleted (you have the option to restore excluded objects); it is just deactivated in that 
group and removed from any schedules. This option is more powerful than just overriding 
the view by hiding individual elements using the Hide Graphics in View by Element feature, 
because overriding the view would not update your schedules.

To access this option, press Tab to select an element within a group to see the Exclude icon 
(Figure 20.21).

Clicking the icon excludes the element, so it will no longer be counted in schedules 
(Figure 20.22). 

Figure 20.20 
Schedules update 
as groups are 
swapped in  
and out.

Figure 20.21 
The Exclude icon 
appears when you 
select an element 
inside a group.
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You can always add the element back to the group by right-clicking and choosing Restore All 
Excluded or by clicking the icon again. Note, however, that the icon will not show up if you are 
in Group Edit mode. 

Repeating Groups on Other Levels
If parts of the whole floor plan need to be repeated on other levels, you can make a group out of 
many groups, generating a new high-level group in the Project Browser. For example, you can 
select the six bedroom-unit groups (also containing nested groups and attached detail groups) 
and make a new master group, which we have called Complete Level (see Figure 20.23). 

The result of this action is represented in the Project Browser, shown in Figure 20.24.

With the entire collection of rooms on the floor now in one group, you can select that group 
and copy it to the clipboard. From the Clipboard panel, choose Paste Aligned  Select Levels by 

Figure 20.22 
The schedule 
updates to reflect 
that furniture was 
excluded.

Figure 20.23 
A master group 
for the entire floor 
layout.

Figure 20.24 
Complete level 
group.

56491c20.indd   597 6/2/09   11:36:42 PM



598 | Chapter 20 Developing the Design with smartworkflows

Name and choose which levels you want the bedrooms copied into. In a few clicks, you can have 
several floors filled with bedrooms, as shown in Figure 20.25.

To recap, we chose to leave the exterior wall outside of the group to treat it as a single element 
that spans many levels in the project. We proceeded to make a rough definition of the room unit, 
which was necessary to fill out the building’s wing. If we had instead added a portion of the 
exterior wall to the group, our exterior wall would have consisted of many separate walls, which 
would violate typical workflows and expectations. By placing just the initial module, we were 
able to quickly assess the needs for circulation and elevator locations, generate area calculations, 
and evaluate the design.

Then, by nesting groups, we solved the whole bathroom design and propagated it to the 
other rooms in one interaction, and likewise the furniture layout. If we had wanted alterna-
tives in the room’s layout, a new group made from the previous group could have been created, 
modified, and swapped out. For more granular changes, such as removing a seat from one 
single instance of a group, the Exclude option could be used to avoid making unnecessary 
new group types.

Making the Group a Part of the Project
The ability to make the group a part of the project is a key feature of groups. If there is a slight 
variation in an instance of a group that requires moving one or more objects, you can select the 
desired element by right-clicking on it and choosing Move to Project. This option excludes the 
object from that specific instance of the group and puts it into the model, where it can be freely 
edited without editing the group. For AutoCAD users, the closest analogy to this is exploding 
a block.

Figure 20.25 
The bedroom 
group can be cop-
ied and pasted into 
other levels with a 
few clicks.
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Moving an element in a Group to a New Location

In the bedroom design, the dresser needed to be repositioned in the last unit in the layout without 
making a brand-new group for such a slight variation. By tabbing into the dresser and selecting it, 
the designer was able to move it to the project using the context menu.

This action moved the element out of the group, allowing it to be relocated to a new position:

The left image shows the dresser before being moved to the project. The right shows the dresser 
moved to the project and then repositioned.

In terms of workflow, before deciding whether to move or exclude an element, the main question 
to ask is whether or not that change will be reused. Exclude and Move to Project are solutions for 
specific problems in an instance of the group, but that’s where their whole power resides. Always 
remember that when you exclude an object, it also disappears from the schedule, whereas Move to 
Project does not affect scheduling at all since the object is still around. 

Editing a Group in a Separate File
When you are working on a large file, it can be difficult to isolate a group for the sake of editing 
it. For example, when working in a complex building model where you don’t want to be bur-
dened with hiding unwanted elements to get a clear view of the group (Figure 20.26), you can 
use a feature that allows you to edit the group as a separate file. Since this option isolates the 
group in a single file, you can work from there and then save the file and use the Reload option 
explained previously. The Edit option that appears when right-clicking a group in the Project 
Browser opens the group as an independent file outside the project environment, similar to the 
way you can edit families independently of the project. You can have both the whole project and 
the single file open at the same time, working with changes that are reflected immediately after 
saving and reloading.
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After editing the group, save it and then go back to the project and reload it from the Project 
Browser using the right-click context menu. All groups of that type will then be updated.

Detail Groups
We have touched on detail groups, but let’s look at them a bit more closely. You can create anno-
tations to add textual descriptions, add dimensions to measure elements in a group, and then 
group them in what is called a detail group. The detail group can then be attached to instances of 
the model group. A detail group can be attached to a model group by using the contextual tab 
when a group is selected. This is a quick way to apply consistent annotations to many groups.

In Figure 20.27, a room is annotated, and then the annotations are grouped.

Figure 20.26 
Opening a group 
for editing in a 
separate RVT file.

Figure 20.27 
Annotations can be 
made into a group.

56491c20.indd   600 6/2/09   11:36:43 PM



UnDerstanDing how to Use groUps | 601

When you multiselect all the unit groups and click the Attached Detail Groups button, 
your recently created detail group will be applied to all your groups in one interaction (see 
Figure 20.28).

Best Practices for Grouping
Here are some aspects to consider when working with groups:

When using groups on multiple floors (levels), the levels have to have the same floor-to-•u	

floor height if the groups are to work effectively. Currently, there is no way to make walls in 
a group taller from one floor to the next, so just be aware of that. Always remember that 
although you are working in a seemingly 2D floor plan, everything is 3D. You’ll avoid 
propagation issues if the walls in groups have unconnected heights. 

Placing multiple instances of a group affects the file size. The group is not a link but rather •u	

is an element repeated inside the project (instantiated). Once you load a file as a group, it is 
part of the project and will add to the file size as often as it is used.

If you need to have reduced file sizes, using links instead of groups might be a solution, •u	

although it depends on the applicability of the scenario in which you wish to use them, and 
most important, you should be aware of the consequences of using links.

Try not to mirror groups—create left and right versions instead. While this is more time •u	

consuming, it avoids mirrored elements that should not be mirrored (such as plumbing 
fixtures, equipment, and specialty furniture). As an example, mirroring hospital rooms 
may easily create inadvertent errors from a utility connection standpoint.

Keep nested elements and their hosts grouped together.•u	

Groups are very processor intensive. You can quickly get to a point of diminishing returns •u	

(from a performance standpoint) when groups contain nested groups, or entire floors have 
been grouped. It works great when you need to disseminate large collections of elements. 
But editing groups and waiting for them to update can severely affect project workflow.

When you have worksharing enabled and you create a group, all the elements are assigned •u	

to the active workset. So although groups may contain elements on different worksets, the 
moment you ungroup and regroup that information is lost. So you might as well plan on 
assigning elements in groups to a single workset.

Figure 20.28 
The annotation 
group is then 
attached to a 
model group.
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Understanding the Principles of Links
You’ve seen that Revit groups can be a powerful tool for streamlining the design workflow, but 
the performance hit you take from increased file size can be significant. Revit provides another 
tool that allows you to work with repeating elements and avoid the file size problem: links. Be 
aware that links have limitations that you might not be comfortable with, so make sure you 
understand these limitations before deciding to go with the linking method.

To show how links work, we’ll continue with our example project. 
When you select a group, you will notice that the Link button appears in the Modify Model 

Group contextual tab. When you click the Link button, the dialog box shown in Figure 20.29 appears. 
It presents two options that you need to understand: Create New and Use Existing. In other words, 
is the information contained in the link going to a new file, or will it be added to an existing file? 

In this particular case, we are creating a new file, so Revit will automatically create a new file 
in the folder of the project (by default) and replace the group with a link in the exact same place 
(see Figure 20.30). The process does not involve any user action at all apart from clicking the 
Link button. This might look like the ultimate solution for managing file size. In certain cases 
this may be true, but let’s look more closely at the implications.

Walls in a linked file will not create clean wall join conditions with the host file, which can 
make scheduling of rooms particularly difficult. In fact, the first thing you will probably notice 
once you convert the group into a link is that the walls belonging to the link do not clean up 
with walls belonging to the active host model, because joining between elements in a link 
and those of the project isn’t possible. You can override this behavior by selecting the Room 
Bounding checkbox in the type properties of the link. This will allow the walls in the linked  
file to enclose space and let you place rooms.

Wall Cleanups in early Design

During the early stages of design, seeing wall joints clean up is necessary for graphical reasons, but 
it’s not needed at this stage for technical accuracy. In conceptual and schematic design, you typi-
cally don’t want to waste a lot of time dealing with wall join cleanups when you are trying to get 
the design down. To keep things simple, set the Coarse Fill setting of the wall properties to Solid 
Fill and set the Color to black. This will give you a great schematic level print of the walls and not 
show you any of the wall materials. Then, when you are ready to advance the design, change from 
Coarse to Medium or Fine in your View Level.

Figure 20.29 
Converting groups 
into links.
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If wall cleanups or definition of rooms are not a serious issue in your workflow (an example 
would be a renovation of an existing building), using links could be a good solution to help 
manage file size. Even so, it is nice to know that as soon as you bind the link (convert it back into 
a group), you’ll get wall cleanup and valid rooms again.

Note that binding links will work on any instance of a linked Revit file. This brings the link 
file completely into the project file and severs the link to the external file. For AutoCAD users, 
the closest analogy is binding of XREFs.

Common Link Use Cases
Links are well suited for workflows where you don’t need a tight connection between elements, 
such as linking entire buildings or site plans into your project file. Links are commonly used 
when working with the following kinds of projects:

Separate buildings on a shared site plan•u	

A site plan and contextual masses•u	

Large-scale divisions in building mass and program•u	

Other disciplines (Structure and MEP)•u	

In the following examples, you’ll see various situations when linking files can be useful.

Multiple buildings on a shared site plan    At Koolhaas’s station complex in Lille (see 
Figure 20.31), there are buildings designed by other architects directly over the station’s roof. 

Figure 20.30 
A group converted 
into a link on the 
fly. Note that  
the rooms no  
longer have  
boundaries  
defined by the 
walls.
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Interaction among the models is important in order to identify heights and possible restric-
tions between the buildings. This interaction could easily be created by linking the buildings 
for coordination, with each model residing in a separate file. What’s more, each building 
could also use nested links or groups. For example, when working on the building over the 
station, you could link the train station into your model. Within the train station could be 
links to mechanical system files. All of these elements would be visible in the main host file. 
This form of nesting keeps file size down and makes working manageable.

Identical buildings on a shared site    Another use would be a project where a housing unit 
is duplicated many times on a site. For example, if you have three identical buildings, you 
would model one building, link it into a site file, and then make two additional copies. If you 
then edit the original housing file and update the link, all three instances of the linked file 
will update in the site file.

Coordination with other disCiplines

The linking method is not only applicable to buildings with repeating units but can also be 
used as a methodology for working in a highly coordinated way with other engineers and con-
sultants using Revit Structure or Revit MEP. This workflow is designed as a fully collaborative 
use of BIM for all the disciplines. Using links, you can integrate structural framing, ductwork, 
and mechanical systems into your base architectural project for coordination. In a traditional 
process, this coordination was based on endless revisions, miscommunication, and colliding 
systems that ended up being resolved on-site during construction at tremendous cost. The Revit 
BIM platform provides transparent connections between Revit Architecture, Revit Structure, 
and Revit MEP. In fact, you can open a Revit MEP or Structure file in Revit Architecture because 
they are all based on the same technology. The only difference will be the available tools: with a 
Revit Structure or MEP file open, you’ll be able to select and modify ductwork, for example, but 
you won’t be able to make new ducts.

Linking different disciplines in Revit provides better coordination and even allows for colli-
sion detection. This toolset will not be covered now, but you should be aware that it is all possi-
ble in Revit using what are called Copy/Monitor and Interference Checking. For further reading 
on these subjects, consult the Revit help documentation.

Figure 20.31 
Rem Koolhaas’s 
train station would 
be a good project 
candidate for links.
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Linking Files
To link an RVT file, choose Link Revit from the Insert tab. The dialog box involves some deci-
sions in terms of how to position the linked model in a project and which worksets to open, as 
shown in Figure 20.32.

The positioning defines the location of the linked model inside the project and can be manu-
ally or automatically done. Automatic positioning of the link provides the following options:

AutoCenter to Center    This aligns the 3D center points of both models.

Auto–Origin to Origin    This places the world origin of the linked file at the model’s ori-
gin point. If the linked model was created far away from the origin point, linking with this 
option may put the linked file far away from the main model. (When this happens, Revit may 
warn you and automatically use the Center to Center option.)

Auto–By Shared Coordinates    This places the linked file geometry according to the shared 
coordinate system created between the two files. If no shared coordinate file has been cre-
ated, Revit will alert you. These Shared Coordinates settings can be found on the Manage 
tab; under the Project Location panel, click Coordinates:

Acquire Coordinates    This allows taking coordinates of the linked file into the host 
model. There is no change to the host model’s internal coordinates, but it acquires the 
true north of the linked model and its origin point.

Publish Coordinates    This allows publishing the origin and true north settings into the 
linked model. Revit understands that there may be other things in the linked file and that 
you may not want this to be a global change to the linked file. An additional dialog box 
appears, giving the option to name separate locations for each set of coordinates.

Specify Coordinates at a Point    This allows you to manually key in X, Y, and Z coordi-
nates relative to the origin or to define where the (0,0,0) will be.

Figure 20.32 
The Import/Link 
RVT dialog box.
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Report Shared Coordinates    This shows the E/W (East/West, X), N/S (North/South, Y), 
and Elevation (Z) coordinates of any point in the model.

Manual—Origin    The imported document’s origin is centered on the cursor.

Manual—Base Point    The imported document’s base point is centered on the cursor. Use 
this option only for AutoCAD 2009 files that have a defined base point.

Manual—Center    This sets the cursor at the center of the imported geometry. You can drag 
the imported geometry to its location.

Special Link Features
When you use links, keep these concepts in mind because they can aid in your workflow and 
help you set proper expectations:

Scheduling elements in links    You can schedule elements in link files without any trouble 
by choosing the option Include Elements in Linked Files, located in the Schedule dialog box.

Displaying nested links in the host file    This is another key feature because you can have 
two different states: Attach and Overlay. As with AutoCAD’s XREFs, if a file has a nested link 
set to Attachment, when you link it into another one, you will see both files. If the nested link 
is set to Overlay, it will not show up in other files. This setting is located in the dialog box 
accessed by choosing File  Manage Links.

Using nested links in the Project Browser    The Project Browser provides the same kind of 
interaction for links as it does for groups: dragging and dropping will place the link into the 
view. By right-clicking on the link, you’ll get nearly all the options available in the Manage 
Links dialog box (Reload, Unload, Open, and Reload From).

Making areas and area boundaries in linked files visible and schedulable    Since Revit 
Architecture 2009, you can now show areas from linked files, and this includes the ability to 
create color fill plans that color linked rooms or areas.

Dimensioning and establishing constraints    You can align and dimension to elements in 
linked files.

Copying and pasting elements     By Tab-selecting an element embedded in a link file, you 
can copy it to the clipboard and paste it into the host file.

Controlling and changing visibility properties     You can turn categories of linked files on 
and off, giving you total flexibility in controlling the display of information. 
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Binding a Revit link within the parent model    This option creates a group inside the par-
ent file, fully integrated to the project. You’ll learn more about binding later in the chapter.

Unloading and reloading Links

If you link a Revit file into the model, you cannot open the link without unloading it from the project. 
In that case, you need to unload the link, make the necessary changes, and then reload the link after 
saving what you’ve done, or open a second session of Revit (you can run multiple instances of the 
Revit application at the same time) and open the link there. This way, you can have direct feedback 
on any changes made in the link by reloading in the session with the parent file.

Controlling the Visibility of Links
The linked model will display levels, grids, and any annotations they have because the default 
visibility is defined by the model’s visibility. In an elevation, you will see not only the model’s 
levels, but also the linked levels, which may become a problem. To solve this, apply custom vis-
ibility settings that override the link in the view. In the Visibility/Graphic Overrides dialog box, 
choose the Revit Links tab, and override visibility by selecting the Custom radio button. You can 
control the visibility of all categories in a linked file by using this custom setting, giving you 
practically unlimited flexibility for what you can display.

This allows you to turn off visibility of categories in the link file. To hide levels, choose the 
Annotations tab and turn Levels off, as shown in Figure 20.33. 

Deciding Whether to Use Groups, Links, or Both
So, is it better to use links or groups to handle repetitive content? Or is there a way to capture 
the advantages of both groups and links without their disadvantages?

The answer depends on the project and definitely on the workflow. How much interactivity do 
you need between the elements in the link and the ones in the project? For smaller projects, where 
file size and performance are not an issue, groups should work fine. If you have a huge project with 
many instances of repeating elements, linking will reduce file size and make working on the model 
faster. But if you need control over rooms and cleanups, groups are a better solution.

Figure 20.33 
You can turn off 
visibility for cat-
egories in a linked 
file independently 
of the host file.
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Had we worked with links for the room units in the previous example, the rooms’ file size 
would not have been a major issue since we are working with instances of a link whose informa-
tion (and file size) resides outside the project file. If you have a massive repetition of something 
modular, you might want to consider using links over groups.

If you do go with links but later change your mind, no problem: it is possible to convert the 
link into a group by binding the link, which transforms it into a group and thus adds it to the 
project. An example would be linking an entire floor plate full of hundreds of rooms.

In our example, we could have linked the furniture since there is not much interaction with 
anything else in the project. Because models of furniture can increase the file size, this approach 
could be a smart way of managing size. We can start working with the furniture as simple com-
ponents in the floor plan and, as soon as we have something, group and afterward link them. 
As soon as we have the link, we can just copy it around the whole floor plan, resulting in a mar-
ginal file size (we don’t have 100 beds, but one bed repeated in 100 instances). Keep in mind that 
there is no way of excluding objects from the link without affecting the rest.

If you need to work with the group as a link to reduce file size during the project, you can 
link it (thus losing wall cleanups) and then later bind it back for final construction documenta-
tion. When you bind the link, a dialog box will open, as shown in Figure 20.34.

Be careful: as stated in the lower panel of the dialog box, if you bind levels and grids, Revit 
will create additional uniquely named levels and grids in the project, duplicating information 
and possibly causing problems.

All in all, binding links is a smart workflow that allows working with a sensible file size while 
restoring the lost relationships within the project as soon as you bind. Depending on the workflow 
and the size of the project, this seems to be the best of both worlds. Just remember that while the 
file is linked, you lose many key benefits of using a fully integrated building information model. 

Final Considerations
Now that you’ve gained an understanding of the basic differences between groups and links, 
there are still some important things to be aware of. We are not trying to sell you on using one 
or the other, but rather to help you take full advantage of both tools’ potential to solve specific 
problems. Ultimately, your project’s criteria should dictate your direction.

The relationship between groups and links is intended to improve workflows. Here are some 
examples:

When you’re looking for a tool that maintains consistency throughout the project and •u	

enables the management of repetitive content, when file size is not an issue and interactiv-
ity with the rest of the model is crucial, groups are the way to go. (Remember, you can at 
any point swap the group into a link and vice versa.)

Figure 20.34 
When binding 
links, you can 
choose to include 
details, levels, and 
grids.
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When you are looking for a tool that lets you work with a massive repetition of elements •u	

that have little or no interactivity within the project and you want to keep file size down 
and still be able to schedule the project’s contents, think about using links. From a project 
management standpoint, you could even have someone else on the team work on that 
information and eventually bind it all into the model, thereby taking advantage of how 
groups interact with the model.

If you want to keep elements as links but still need rooms, you could use room separator •u	

lines as a workaround so you will be able to define rooms without binding all the informa-
tion into the project. This requires some manual work, but it can be a practical solution if 
you give some intelligence to the separators. Using the Pick Lines tool when drawing room 
separation lines gives you a chance to lock the line to model elements and thus capture 
design intent and keep elements connected.

The Bottom Line

Work with repetitive elements.    Many projects have repetitive elements and can benefit by 
using groups and links efficiently.

Master It    Think of a scenario in your own practice where elements repeat and how you 
might use Revit groups to solve the problem.

Understand the use of groups.    Groups are a powerful design tool. Anyone working with 
repetitive elements needs to understand how they work.

Master It    Describe a fundamental benefit of using groups.

Understand the principles of links.    Links are Revit’s second major tool for repetitive ele-
ments, avoiding the file size and performance issues associated with groups.

Master It    Using a link paradigm means that the BIM model now depends on links to 
external files. Even so, the links can be scheduled, dimensioned to, and graphically al-
tered. Despite that, there are still some limitations. What are they?

Decide whether to use groups, links, or both.    Knowing when to link a file can improve file 
performance and provides an easy way to operate on large clusters of building data. You can 
hide links, remove them, and work on them independently. Knowing when to use groups 
can help replicate repeated elements quickly. Knowing how and when to use both groups 
and links helps speed the documentation process.

Master It    Know that links can reduce the overall file size and thus improve perfor-
mance when working in Revit; imagine a scenario in which you would most certainly 
want to employ links over groups.
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Chapter 21

Moving from Design to Detailed 
Documentation

In this chapter we discuss how to expand the model documentation to include construction details. 
Details are typically created by embellishing section or plan views of the model with additional 
2D elements. The use of 2D detail families in Revit allows you to complete a set of construction 
documents for a client or contractor quickly and easily without the burden of having to model 
every component and detail within the project in 3D.

In this chapter, you’ll learn to: 

Create drafting views•u	

Import and link CAD details•u	

Create 2D detail components•u	

Advancing the Design
In the lifecycle of a project, eventually it becomes necessary to add details to the model that are 
then used to build the building. Historically, the conceptual design, schematic design, and design 
development project phases progressed through a series of refinements to develop the final set of 
construction documents. With a BIM process, these discrete phases are redefined, but the work-
flow remains essentially the same. At the stage prior to adding details, the “big idea” is refined 
and most plans and building sections are in place. Materiality is added to the design, and the 
assemblies that make up walls, floors, and ceilings are added. Creating wall sections, schedules, 
and enlarged plans helps to describe the project further. Eventually, the systems solidify and 
details are created that truly begin to define how many of these elements are put together in the 
field. In this chapter, we will explore a few scenarios for detailing the model and creating some 
of the smaller-scale drawings that go into construction documents. We will look at some of the 
more common methods:

Creating details from scratch•u	

Importing details that have already been drawn•u	

Creating the detail from the model and embellishing it using 2D detailing tools•u	
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Creating Drafting Views
It isn’t feasible to model every single construction detail in 3D within Revit. A 2D detail often 
provides enough information for construction in the field. To this end, Revit provides a means 
of drafting in views strictly used for 2D information that can be placed on sheets like any other 
view. These views are called drafting views and document typical or special details of the project. 
They can be created by drawing the details directly within the view or by importing details. 
They can also have legends, maps, text, or any of a variety of graphics necessary for a construc-
tion document set. When placed on a sheet, drafting views have the same intelligent referencing 
as all the other views within Revit. Even though drafting views present only 2D information, 
they are still tied parametrically to sheets, so all the references are dynamic and coordinated.

To create a new drafting view, follow these steps:

 1. From the View tab, choose the Drafting View tool.

 2. In the dialog box that appears, enter a name in the Name field (Figure 21.1) to name the 
view. This is the default name that will appear when the drafting view is placed on a 
sheet in the drawing set.

 3. Using the Scale drop-down list, choose a scale.

 4. Click OK. A new node, Drafting Views, is added to the Project Browser. This new draft-
ing view is primed for either drafting a new detail or importing existing CAD details. 
This essentially creates a blank sheet within Revit for you to begin drafting (or import-
ing) 2D details.

Importing and Linking CAD Details
It is common to have details from manufacturers you’d like to include in your drawing set, or 
you may have standard details from an office detail library that need to be included in your 
documents. What if all these files were created in a 2D CAD application? As we discussed ear-
lier, you can easily import these 2D details into Revit to be used and reused across many BIM 
projects.

To see the types of CAD files you can import into Revit, open the Insert tab, and choose 
Import CAD to open the dialog box shown in Figure 21.2. The Files of Type pull-down menu 
contains all the file types you can import into Revit: .dwg, .dfx, .dgn, .sat, and .skp. You can 
also import images into Revit by using the Image command, located next to the Import CAD 
button on the same tab.

Figure 21.1 
Making a new 
drafting view.
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Later in this chapter, we’ll see how each of these file types is used, but first we want to make 
sure you understand the distinction between importing and linking.

Linking vs. Importing
Use linking when you have files that will update throughout the design process. Imagine a per-
son in your office who does nothing but develop 2D details and who works in parallel with you. 
With linking, the details will update constantly, as revisions are made, and you won’t need to 
manually re-import the work. By linking the file into Revit, you ensure that the information will 
update as the source file changes. Linking creates a live connection to a file. This allows you to 
work on the linked file and then have the Revit model update to reflect the changes in the link. 
This behavior is similar to an XREF in AutoCAD.

Use importing when you want to embed the CAD file within the project file itself. This might 
be of value if you need to modify imported details slightly, because unlike linked files, imported 
files can be exploded and thereby modified.

Linking CAD FormAts

The ability to link one file into another can be helpful in a collaborative environment. Perhaps 
someone on your team—a person working on details within your office or an external consul-
tant—is working in a CAD environment while you build the project in Revit. Linking lets you 
have their latest work updated in your Revit model. If you import without linking, you get a 
static file that will not update if changes are made to the original file. When you link, however, 
it’s possible to always get the latest state of the DWG by updating the link within Revit. 

Figure 21.2 
The Import CAD 
Formats dialog box.
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From the Insert tab, choose Manage Links to access the dialog box shown in Figure 21.3. 
Using this dialog box you can reload, unload, import, or remove a CAD link, or see what is 
already loaded.

importing or Linking CAD FormAts

Site plans, consultant files, and details or drawings done with CAD technologies on prior proj-
ects are all examples of information you may want to link or import into Revit. This isn’t lim-
ited to 2D data; you can link 3D files as well. The data you import or link into your model can 
be view specific, meaning that it is imported in one view only—using the Current View Only 
import option—as opposed to all views. Start by opening the view into which you want to bring 
data. Go to the Insert tab, and then choose either the Import CAD or the Link CAD button, 
depending on your workflow. As shown in Table 21.1, you can link/import five types of CAD 
files in 2D or 3D in Revit.

table 21.1 Importable/Linkable CAD File Types

extension types of Files

.dwg Files made from AutoCAD or other applications that can export to this industry standard 
format.

.dxf Drawing Exchange Format files. Most software packages can write to DXF in addition to 
their native format.

Figure 21.3 
The Manage Links 
dialog box.
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extension types of Files

.dgn MicroStation native files.

.sat Standard ACIS text files; many modeling and fabrication applications can write to this 
file type.

.skp SketchUp native files.

Linking    If you link a file, any changes made in that original file will be apparent in the 
Revit file in which it was linked. If your office or team workflow has personnel who are 
dedicated to working solely on details in a 2D environment, they can continue creating and 
changing the details in CAD and you can update the link to reflect the changes automati-
cally. You can also manipulate the linked file through the Manage Links dialog box (Insert  
Manage Links). 

Note that you cannot modify a linked import, because modifying any information requires 
explosion of the import, which the linking method does not allow. However, you do have the 
ability to manage the layers in the linked file and turn them on or off as needed, without the 
ability to explode the file. This can all be done through the Visibility/Graphic Overrides dia-
log box.

Importing    An import is not tied to an external file, which means you can modify the CAD 
drawing directly in Revit by first exploding it. Once an import has been exploded, the import 
ceases to exist and everything becomes part of the Revit file. The import is translated into a 
bunch of lines and they are just that: lines, with no inherent intelligence. In addition, any line 
names or styles from the CAD layers that have been imported will become Revit line styles.

options During import/Link

There are a series of options that you will need to understand and set during the Import/Link 
function, depending on the result you would like to achieve with the file that will be imported 
or linked:

Current View Only    Selecting the Current View Only check box (located at the far left of 
the dialog box) brings the linked or imported file into only the view that is currently active. 
It’s not always desirable to see your CAD files in all the views in your model. A site plan, as 
an example, doesn’t have to be seen in all floors of a building—just the site view and maybe 
the Level 1 (ground floor) view. More often than not, you’ll want to select this check box, 
because you will likely want to limit the number of views in which your linked files appear. 
If you import with this option unchecked, the file will be visible in all of your views (and any 
new views you create), plus you’ll need to manage the visibility via the Visibility/Graphic 
Overrides dialog box or view templates. If you import your CAD file into one view and 
would like to have it in others, you can easily copy and paste it from one view to the next. 

table 21.1 Importable/Linkable CAD File Types (continued)
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Limiting Visibility of CaD Files

If you don’t want the CAD file to be “Current View Only” so that it can display in more than one 
view, it’s likely that you don’t want it to show up in every 3D view in the project (which it will). To 
avoid this, create a workset for CAD files that are not Current View Only and uncheck the Visible 
by Default option. Make this the active workset when you link the CAD file (and make sure that 
this workset is visible in the current view). The CAD file will not show up in every view but will be 
available when you need to see it in other views.

Layers    The Layers drop-down menu gives you the option to import or link in all the layers, 
only the layers that were visible at the time the CAD file was last saved, or a selected group 
of layers from a secondary dialog box. (Layers are a DWG-based naming convention. Revit 
allows the same functionality with levels from DGN drawings.) 

Layer/Level Colors    The default view background in AutoCAD is usually black, so the col-
ors used in AutoCAD are easily visible on a black background. When you import a DWG file 
into Revit, which has a white background, many of the colors usually used in AutoCAD (yel-
low, light green, magenta, cyan) are often difficult to read. Revit recognizes this issue, and in 
the Layer/Level Colors section of the Import/Link dialog box you have the option to invert 
these colors. You also have the option to not change the colors or to convert them to black.

Import Units    The Import Units section of the Import/Link dialog box allows you to let 
Revit autodetect the scale at which the imported or linked drawing was created and convert 
accordingly. Or you can do the detection manually and apply a scale factor using the Custom 
Factor option.

tips on Importing CaD Details

It is not possible, or always desirable, to communicate the entire project in 3D. At times your work-
flow will demand using 2D graphics from a past project, manufacturer’s library, or other resource. 
To optimize the performance of imported CAD files in your model, we strongly recommend that 
you delete all the superfluous data in the CAD file before importing it into Revit. Here are some 
general tips to help your workflow:

If your import contains hatches or annotations that you don’t intend to use in Revit, delete •u	

them before importing. 

Import only one detail at a time so you can take better advantage of Revit’s ability to manage •u	

sheet referencing. If you have a series of details organized in a single CAD file that you’d like to 
import into Revit, isolate each detail, save it as a separate file, and then import.

Consider annotating in Revit and removing the annotations from CAD. This can help keep con-•u	

sistency in your documents. If you use arrowheads or leaders in your CAD file, they will import 
into Revit (when exploded) as polylines. Consider drawing the arrows within Revit.
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Make sure you import the CAD details using the proper line weights, colors, and styles. Check •u	

your CAD file before importing into Revit to make sure it is consistent with your office’s 
standards.

Every time you explode a CAD file in Revit, you add objects to the database. An inserted CAD •u	

file is one object. An exploded CAD file in Revit consists of many objects—maybe thousands 
of objects. For best performance, we recommend you explode CAD files as seldom as possible. 
If you must explode the CAD file, be sure to remove any unwanted or unneeded linework from 
the file in CAD before inserting it and exploding it in Revit. 

Revit doesn’t allow line segments shorter than 1/32”. Take care when exploding CAD details •u	

with very small line segments. Revit will remove them upon exploding. 

importing CAD DetAiLs

The ability to communicate and share design intent with others is critical to any design and doc-
umentation process. With that inevitably comes the need to translate or transfer ideas, drawings, 
and information from one format to another to create a versatile workflow. Revit recognizes this 
need to share information and allows you to import and export CAD-based drawings to aid in 
communication. 

If you’re working with someone who produces details using only CAD, you can incorporate 
their work into your Revit model without disrupting the workflow.

It is common to have a library of existing details that can be used for many projects. This example 
demonstrates the process of getting these details into a Revit project using a DWG file you can 
download from the book’s companion web page (www.sybex.com/go/masteringrevit2010):

 1. Create a new drafting view. Under the View tab, choose Drafting View and give it a cus-
tom scale of 1:1.

 2. Link your CAD detail. In this example, we have a typical doorjamb detail that is already 
noted and dimensioned. Choose Link CAD from the Insert tab, and set these options:

Colors: Black and White•u	

Positioning: Auto Center to Center (the default)•u	

 3. Choose detail B2020A-01.dwg (located on this book’s companion web page), and click OK. 
This will import your CAD file into a new drafting view. 
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 4. Now you can change your view scale to match the scale in which you’d like your detail to 
be displayed. For your detail, change the scale to read 1½˝ = 1́ -0 .̋

In this detail, note that the wall tags are unnecessary. Unfortunately, they were not deleted in 
the original CAD file (the recommended practice) before we linked the file. 

So, you have two options. One is to address the issue in CAD—delete the tags there and 
relink the file. For this exercise we’ll assume that’s not feasible. Your second option is to man-
age the layers of the link within Revit and simply turn off the layer on which the tag has been 
placed. As mentioned earlier, you can do this using the Visibility/Graphic Overrides dialog box. 
You can also do it through Revit’s graphical interface. Selecting the detail will expose useful 
tools in the Ribbon, such as the Query tool:

Clicking the Query button allows you to select elements in an imported or linked CAD file 
and discover what layer they belong to. With Query enabled, you can select any of the lines or 
hatches of the CAD file. Choose the border of the wall tag. This gives you the dialog box shown 
here, which tells you the Entity, its Layer, Block Name, and Style:

The Import Instance Query dialog box also allows you to delete the entity (which we do not 
want to do here) or hide the layer. Choosing Hide in View turns that layer off in this view. It can 
be turned on again with the Visibility/Graphic Overrides dialog box.

Now the detail is complete, you can drag and drop the drafting view from the Project 
Browser onto the sheetA350 Details. If you need more details from CAD files for our project, 
simply create more drafting views.

The finished detail is shown here. The imported detail on the printed sheet should be indis-
tinguishable from the details created in Revit.
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Creating 2D Detail Components
Creating two-dimensional detail components is a powerful way to utilize parametric capabili-
ties built into Revit to produce the necessary details that will help tell the contractor how to 
create the building. Learning how to leverage these detail types can make the detailing process 
much more efficient.

Detail Groups
Detail groups are similar to blocks in AutoCAD. They’re collections of 2D graphics (drafting 
lines, other detail groups, 2D content) and represent details that you’ll probably want to use 
again and again in the same or different views. A classic example is wood studs or blocking. 
You can easily set up a Revit group and use that group over and over in the model. Doing so 
helps control consistency throughout the drawing.

To make a detail group, create the detail elements you’d like to group and then select them. 
In the contextual tab that shows up, select the Create Group button. When you’re prompted for 
a group name, name the group something clear rather than accepting the default name Revit 
wants to give it (Group 1, Group 2, and so on).

To place a detail group, use the Detail Group button in the Detail panel on the Annotate tab. 
Then use the Type Selector to choose which group you want to place.

Detail Components
Detail components are 2D families that can be made parametric. They’re similar to detail 
groups, but are created in the Family Editor and can thus be designed with dimensional varia-
tion built into the family. In other words, a full range of shapes can be available in a single detail 
component. Because they are families, they can also be stored in your office library and shared 
across projects easily. 

To add a detail component to your drawing, select Detail Component from the Component 
drop-down list located on the Annotate tab. Use the Type Selector to choose which detail to 
place. If you already have preloaded detail components in your project, you can search in your 
Project Browser, under Families  Detail Items.

If you need to load a new component, click the Load Family button that shows up in the 
Ribbon when placing a component. Browse to the Detail Components folder. Revit has a wide 
range of common detail components in the default library. 

To make a new detail component, use the Family Editor and Detail Component.rft tem-
plate, accessed from the Application menu, under New Family. Once in the Family Editor, you 
can begin drawing lines, adding parametric values, and then save the file as an independent 
family that can be loaded into any project.
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Masking Regions
A masking region is designed to hide portions of the model that you don’t want to see in a cer-
tain view. This tool is known to many users of AutoCAD as the “wipeout” tool and serves to 
make white masks over graphics or text. The masking region places a 2D shape on top of the 
model that masks elements behind it.

To add a masking region to your view, click the Masking Region button in the Region drop-
down on the Annotate tab.

This takes you to a mode where you draw a closed loop of boundary lines over the area you 
wish to mask. When you draw a masking region, you can assign the boundary lines different 
line styles—check the Type Selector to make sure you’re using the line style you want. One of 
the line styles that is particularly useful for the Masking Region tool is the Invisible Line style. 
It allows you to create a borderless region, which is ideal if you want to mask an element in the 
model. A masking region is shown in Figure 21.4. Note that masking regions do not mask text, 
annotations, or leaders.

Figure 21.4 
(A) The detail 
without a masking 
region; (B) portion 
of the detail cov-
ered with masking 
region; (C) mask-
ing region with 
invisible line style 
outline.

A B

C
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Creating a Repeating Detail Element
Repeating details are a common occurrence in architectural projects. Masonry walls, metal 
decking, and roof tiles all are potentially repeating shapes that can create a repeating detail. 
Most of these elements aren’t modeled as 3D components in Revit but are repetitions of symbolic 
detail components.

You create repeating details in Revit by clicking Annotate  Component  Repeating Detail. 
This tool takes a single detail component and arrays it along a straight line at regular intervals. 
Open the Element Properties dialog box of any available repeating detail (click the Repeating 
Detail command and look in the Type Selector) to get a feel for how it’s laid out. 

Figure 21.5 shows the Type Properties dialog box for a repeating brick detail. When you 
select a repeating detail, the Type Selector is activated so that you can select any repeating detail 
you’ve already loaded in the project. Repeating details are similar to families: they have types 
and properties. If you don’t have the repeating detail that you want loaded, it’s easy enough to 
create one on the fly. All you need is a detail component that you wish to repeat.

Placing a repeating detail is similar to drawing a line: it requires just one click to indicate a 
start point and a second click to indicate an end point. After you do this, repeating 2D geometry 
will fill in between the clicks. Take these steps to create a repeating detail:

 1. Select Annotate  Component  Repeating Detail.

 2. Click the Element Properties button.

 3. Click Edit Type.

 4. Click Duplicate.

 5. Give your new repeating detail a name.

 6. Select a detail component to repeat.

Figure 21.5 
Repeating detail 
type properties.
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The default repeating detail in Revit is a running brick pattern. If you look at it in detail, it 
consists of a brick detail component and a mortar joint (Figure 21.6).

When you create a repeating detail layout, measure the distance between the beginning of 
the brick and the end of the mortar joint to understand the module on which the detail will 
repeat. When the detail component is inserted, it acts like a Line tool and allows you to pull a 
line of brick, as shown in Figure 21.7. This line can be lengthened, shortened, or rotated like any 
other line. The line will automatically expand in length based on the module of the repeating 
detail.

Figure 21.6 
Single brick detail 
component.

Figure 21.7 
A repeating brick 
detail.
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Detail Component Properties
If you’re making a repeating detail from a component that isn’t loaded in your project, you won’t 
find it listed next to the Detail parameter in the Type Properties dialog box. This is because you 
first need to load that detail component in your project and then make a repeating detail compo-
nent with it. The Properties window will then look like Figure 21.8. Let’s take a look at the dif-
ferent parameters that you can set using this dialog box.

Detail    This setting allows you to select the detail component to be repeated.

Layout    This option offers four different modes:

Fixed Distance    This represents the path drawn between the start and end point when 
the repeating detail is the length at which your component repeats at a distance of the 
value set for spacing.

Fixed Number    This mode sets the number of times a component repeats itself in the 
space between the start and end point (the length of the path).

Fill Available Space    Regardless of the value you choose for Spacing, the detail compo-
nent is repeated on the path using its actual width as the Spacing value.

Maximum Spacing    The detail component is repeated using the set spacing, and the 
number of repeated components is set so that only complete components are drawn. 
Revit creates as many copies of the component as will fit on the path.

Inside    This option adjusts the start point and end point of the detail components that make 
up the repeating detail.

Spacing    This option is active only when Fixed Distance or Maximum Spacing is selected 
as the method of repetition. It represents the distance at which you want the repeating detail 
component to repeat. It doesn’t have to be the actual width of the detail component.

Detail Rotation    This option allows you to rotate the detail component in the repeating detail.

Creating Custom Line Types Using Repeating Details
You can use the Detail Component tool to create custom line types (lines with letters or num-
bers for various services such as fireproofing, rated walls, and fencing). Note that when you 
create a detail component, you can’t use text for the letters; you need to draw the letters or text 

Figure 21.8 
Repeating detail 
type properties.
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using lines. Figure 21.9 shows the creation of a detail component in the Family Editor and the 
final result used as a repeating detail in the project environment.

Miscellaneous Line Tools
Other tools located on the Annotate tab worth understanding are the Insulation tool, Filled 
Region tool, and Show/Remove Hidden Lines tool. Each serves important purposes in your 
drawings.

insuLAtion

Designed as a symbolic representation for batt insulation, the Insulation tool works just like 
any other line type. Insulation can be created simply in Revit in two clicks defining the length. 
When you select the Insulation tool, two blue grips appear at the ends and let you change the 
length. The element properties of the insulation include two editable parameters:

Width    This parameter is used to control the thickness (referred to as Width in Revit) of 
the insulation that is used. The Width parameter is also available in the Options bar when 
Insulation is selected (see Figure 21.10).

Insulation Bulge to Width Ratio    This parameter is used to control the density of the 
circles used in the insulation line and can be set in the Options bar when the Insulation tool 
is selected. In most cases, you’ll have two lines representing the space in the wall where the 
insulation needs to fit. Revit allows you to place the insulation using the centerline of the 
insulation as a location line.

Figure 21.9 
Repeating detail: 
(A) in Family  
Editor; (B) used  
in project.

A

B

Figure 21.10 
The width can  
be set in the 
Options bar.
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region

The Region tool is a drafting tool for making 2D hatch shapes and solid fill shapes. It can help you 
color surfaces or areas for graphic representations during the conceptual or design-development 
phase. It is also a useful tool for showing materials at finer levels of detail.

A region consists of a boundary—which can be created using any line style—and a fill pat-
tern, which fills the area defined in the boundary. Figure 21.11 shows a region with a tile hatch 
pattern used to show tile in an interior elevation. In lieu of a complex stacked wall condition for 
bathroom walls, a region with a 4˝-square model pattern is used to represent tile on the rest-
room wall. While this will not be reflected in any material take-offs, it is a quick way to create 
interior elevations.

Regions can be either transparent or opaque to show or hide what is behind them. 
Figure 21.12 shows two regions—the left one is opaque and the right one is transparent—and 
how they interact differently with a model component.

Figure 21.11 
Regions used for 
quick graphic rep-
resentation of tile 
wall finish.

Figure 21.12 
Opaque and trans-
parent regions.
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Region Type Properties

Region type properties define how a fill appears, including pattern, pattern color, and transpar-
ency (Figure 21.13). Notice that the boundary lines of the region are not part of the type proper-
ties and are defined independently when the sketch is edited. To change the line thickness of 
the boundary, select the pattern, click Edit Boundary in the contextual tab, and change the line 
pattern in the Element Properties dialog box or from the Type Selector.

For each filled region that has a different pattern, transparency, or other variation in appear-
ance, you need to make a new type. Remember that type properties propagate to all instances 
of the type, so making a change to one type may affect many instances in many different views. 
If you want to make a filled region that uses a new pattern, be sure to duplicate an existing type 
before you start changing type parameters.

Regions can use both drafting and model patterns, making them a flexible and handy tool for 
2D workflows. As previously noted, drafting patterns are patterns that will maintain their sepa-
ration distance relative to the printed sheet. Model patterns will maintain their separation dis-
tance relative to the model element. To describe this further, let’s use two examples. If you were 
looking to use a cross-hatched pattern of lines, as in the example earlier for 4˝ restroom wall tile, 
you would want to use a model pattern. The pattern would be set to 4˝ and it would maintain 
a 4˝ pattern regardless of what scale the drawing was set to. So, the pattern in a 1⁄8˝ scale draw-
ing will appear twice as tight as in a ¼˝ scale drawing. In the example of a drafting pattern, you 
would want to use this in places where graphical consistency is more important than actual 
dimension. So, when creating a filled region that represents rigid insulation, the pattern might 
be set to a 1⁄8˝ grid. It will always print as a 1⁄8˝ grid regardless of what scale the view is set to. 
Just keep in mind that all of these are truly just 2D shapes with no 3D BIM characteristics.

showing hiDDen eLements with DAsheD Lines

In visual communications between architects and engineers, when one element obscures 
another, the hidden element is usually graphically represented with dashed lines. Often, just a 
portion of an element is hidden. In the 2D CAD application, it can take a lot of manual work to 

Figure 21.13 
Region type  
properties.
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make this possible: you will need to explode the block representing the element that has to be 
half-hidden, and split lines so that one portion remains solid and another converts to dashed.

Revit has a special tool, Show Hidden Lines, for recognizing obscured elements and repre-
senting the portion that is hidden with dashed lines while still maintaining the complete object.

 1. Select the Show Hidden Lines tool located on the Modify tab.

 2. Click the element that obscures the object.

 3. Click the element that is obscured. The hidden portion of the element becomes dashed. If 
an element is obscured with more than one element, keep repeating this operation until 
you get the desired look.

When you relocate or delete the obscuring element, the hidden element responds intelligently 
to those changes. Figure 21.14 shows an I-beam hidden by another beam. Figure 21.15 shows the 
results after using the Show Hidden Lines tool when the second beam is selected as an obscur-
ing element and the I-beam is selected as an obscured element.

The Show Hidden Lines tool applies to 2D and 3D elements in all possible combinations: 
detail over detail, detail over model, model over detail, model over model. Right below the Show 
Hidden Lines tool is the Remove Hidden Lines tool, which resets the graphical display of the 
elements so they look as they did before you applied the hidden line behavior.

Figure 21.14 
An I-beam  
hidden by another 
element.
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Linework
While Revit does a lot to help you manage your views and line weights automatically, it does not 
cover all requirements all the time. Sometimes you wish some lines to punch out and be stronger 
while others stay thinner. This is where the Linework tool comes into play; it allows you to 
choose any existing line style and apply it to individual edges of elements with a few clicks of 
the mouse.

To use this tool, click the Linework button located on the Modify tab, choose a line style from 
the Type Selector, and begin picking lines in any view. Once a line style is selected, you can con-
tinue selecting lines to override. To change the length of the new linework that has been applied 
over the existing model element, use the blue grip controls. Figure 21.16 shows an unaltered 
elevation of a window and the finished view.

Using Callouts
Callouts are another view type in Revit. They are used extensively in plans and sections to indi-
cate a more detailed view of various conditions in any type of construction document package. 
Figure 21.17 shows two callouts in a wall section.

Figure 21.15 
The I-beam after 
using the Show 
Hidden Lines tool.

Figure 21.16 
The outer bound-
ary of the window 
with linework 
applied.

Before… After…
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In Revit, there are two types of callouts you can choose when creating new details: one for 
floor plans and one for details.

Depending on the type of callout you select, it will appear under different folders in the 
Project Browser. Choosing a floor plan callout will add a new view under Floor Plans in the Project 
Browser called Callout of <view name>.

Choosing Detail Callout will add a new view under the Detail Views (Detail) heading. The 
subsequent view will be by default named Detail 0, Detail 1, Detail 2, and so on (Figure 21.18). 
For the ease of finding and organizing your views, be sure to choose the correct view type when 
creating a new view.

Figure 21.17 
Wall section with 
callouts.

Figure 21.18 
The new detail 
views in the  
Project Browser.
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Adding Information to Your Details
Now that we have discussed many of the tools used for detailing in Revit, let’s step through a 
detail and see how these tools can be put to practical use. For this exercise, a detailed wall sec-
tion will be used to illustrate a workflow. In the Foundation_Start.rvt.ext file found in the 
Chapter 21 section of this book’s companion web page, Detail A14 on Sheet A301 (Figure 21.19) 
is a wall section at the east entry. Since we already discussed dimensioning and keynoting in 
Chapter 19, “Annotating Your Model,” those items have already been added to the view.

In this view, the only things that have been added are text notes and dimensions. The rest 
of the model graphics were automatically generated the moment the section was placed in plan 
view. To add more detail, start by adding callout detail bubbles at each major construction join. 
Use the Callout tool on the View tab (Figure 21.20). 

In this wall section, we need four 1˝ = 1́ -0˝ callouts:

The roof/wall condition (•u	 Roof Detl, Typ)

The wall/floor condition capturing window heads and sills (•u	 Floor Detl, Typ)

The exterior storefront (•u	 Head @ Storefront, typ)

The interior storefront (•u	 Storefront Head Detl)

Figure 21.19 
A typical wall sec-
tion before callouts 
are added.

Figure 21.20 
The Callout tool.
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Using the Callout tool, create callouts in those locations. You can make the first three callouts 
by choosing the Callout tool and drawing a rectangle around the detail condition. For the inte-
rior storefront, a different method will be used that takes advantage of an existing CAD draw-
ing by referencing it rather than making a new view of the model.

To do this, follow these steps:

 1. Create a new drafting view. Under the View tab, choose Drafting View and give it a cus-
tom scale of 1:1.

 2. Import your CAD detail in the drafting view. In this example, a typical doorjamb detail is 
already noted and dimensioned. On the Insert tab, choose Import CAD. Choose the detail 
B2020A-02.dwg found in the project directory on the companion website and select the 
following options in the dialog box:

Colors: Black and White•u	

Positioning: Auto Place Center to Center (the default)•u	

Click OK to link the file into the view.

 3. Change the view scale to match the scale in which you’d like your detail to be displayed. 
For this detail, set the scale to 1˝ = 1́ -0 .̋

 4. Right-click the view in the Project Browser (in the Drafting Views node) and rename it 
Storefront Head Detl.

 5. With the drafting view for our detail created, you can now reference that detail when 
making new callouts. Choose the Callout tool from the View tab, but do not draw a rect-
angle in the view yet. First go to the Options bar and check the Reference Other View 
box. This activates a drop-down menu from which you can choose the detail named 
Storefront Head Detl (Figure 21.21).

 6. Once the reference view is selected, draw the callout at the interior storefront head 
condition.

 7. Keep the views related by dropping them onto sheet A350.

Figure 21.21 
Choosing the 
Storefront Head 
Detl detail. 
from the drop-
down menu.
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Embellishing the Wall Section: The SIM (Similar) Condition
With the four details identified, you can start to add embellishment to the wall section. Beginning 
with the most recent detail you cut—the Storefront Head Detail condition—you need to do a 
little work in the section to match the CAD detail you’ll use for this condition. Because this is a 
unique condition you will see in only this one detail, you’ll not need to model the assembly but 
rather create it using the annotation tools. In Figure 21.22, you can see the current condition of 
the modeled wall section (A) and what we have imported as a similar condition (B) for our CAD 
detail.

You need to show the soffit and head condition at a lower level of detail within the wall 
section to make the detail work. As you can see in the detail and wall section shown in 
Figure 21.22, the ceiling’s condition above the window head does not coincide. The wall section 
needs to be edited to match the detail by extending the ceiling so that it overhangs 5˝ (13cm).

 1. In the section view, select the ceiling and choose Edit Boundary from the contextual rib-
bon. Revit will alert you to the fact that the ceiling cannot be edited in the section view 
and will let you switch views (Figure 21.23). Choose Reflected Ceiling Plan: Level 1.

Figure 21.22 
The callout (A) and 
its reference 2D 
detail (B).

A

B
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 2. The Reflected Ceiling Plan (RCP) view will open, and you’ll be placed in boundary edit 
mode to modify the ceiling over the entry. According to the detail, we need a 5˝ (13cm) 
projection past the head of the door for the design (Figure 21.24).

 3. Finish the ceiling and return to the section view to see the effect (Figure 21.25).

Figure 21.23 
Choosing a new 
view to edit the 
ceiling.

Figure 21.24 
Editing the ceiling 
in plan view.
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Adding Detail Components
Looking at the detail, we see the need to add some blocking and 3½˝ (8cm) studs. This type of 
element is likely to be used throughout the model, so it makes sense to use a detail component 
rather than draw them as individual 2D lines. There will be some strictly 2D drafting lines to 
add later to this wall section for sealant and flashing, but first you’ll need to add architectural 
elements like blocking.

To represent the blocking you need above the window head, you’ll use a premade detail com-
ponent from the Revit library and load it in the project.

 1. On the Annotate tab, open the Component drop-down list; choose Detail Component and 
then Load Family. Browse to Detail Components  Div 06-Wood and Plastic  061100-
Wood Framing, and choose Nominal Cut Lumber-Section.rfa. 

 2. A list of predefined types will show up at the bottom of the dialog box. Since you are not 
sure which type you want right now, select a few of them by holding down the Ctrl key 
and selecting 2 × 4, 2 × 6, and 2 × 8 from the menu (Figure 21.26).

Figure 21.25 
The edited ceiling 
in section.

Figure 21.26 
Choosing detail 
components.
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 3. This loads the family and the types into the project. Click the Detail Component but-
ton and choose 2 × 4 from the Type Selector. Insert it in the general location shown in 
Figure 21.27. We can then rotate it and move it into place.

Detail Components and project templates

If you find you are inserting the same detail components over and over again, load them into your 
project templates and make them readily available when you begin any new project.

eDiting A DetAiL Component

For printing purposes, the line weight for the default 2 × 4 detail component is too thick and 
needs to be adjusted. Because elements are so simple to modify, you will find yourself changing 
stock components to better meet the needs of your office.

 1. For the 2 × 4 you just inserted, the line weight of the border can be changed by selecting 
the component and clicking the Edit Family button in the contextual tab. You’ll get a con-
firmation dialog box before going directly to the Family Editor to change the component. 
Click Yes.

 2. To change the thickness of the border, first hover the cursor over the element to see what 
it is. You’ll see that this component is made of a masking region and some detail lines. 
Select the masking region (Figure 21.28) and click Edit Boundary in the contextual tab.

Figure 21.27 
The finished detail 
component.
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 3. This opens the boundary edit mode of the masking region. Select the boundary lines and 
use the Type Selector to change them from heavy lines to medium lines. These line styles 
are actually subcategories of the Detail Items category, which you can access from the Object 
Styles dialog box shown in Figure 21.29 (select the Manage tab and choose Settings  Object 
Styles). That is where you can change the line color, thickness, or pattern of the object style.

 4. Clicking Finish Region completes the masking region. Clicking the Load into Project but-
ton loads the changes back into the model. You will be prompted to override parameter 
values of existing types. Click Overwrite the Existing Version. 

Figure 21.28 
The masking 
region.

Figure 21.29 
Viewing the line 
object styles.
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The blocking displays much better, as you can see in Figure 21.30.

 5. Moving the component into place, use the fact that it was created as a masking region to 
cover some unwanted gypsum board above the door head.

Don’t forget that you have the ability to see multiple views at once. By closing all views but 
this detail and the wall section, you can choose Tile on the View tab’s Windows panel and see 
both views side by side (Figure 21.31).

 6. The same procedure can be followed to place metal studs in this detail by loading 
them from Detail Components  Div 09-Finishes  09100-Metal Support Assemblies  
09110-Non-Load Bearing Wall Framing  Interior Metal Studs-Section.rfa. Place them in 
a similar location to what is shown in the drafting detail view.

There is one more element to add before we begin drafting lines to finish the detail. There is 
a ¾˝ piece of plywood backing over the entryway in our detail that does not appear in our wall 
section. You can represent that with a filled region.

 1. Select the Region tool from the Annotate tab.

 2. Set the boundary lines to thin lines using the Type Selector and draw a box ¾˝ tall on top 
of the gypsum board that will represent the plywood.

Figure 21.30 
(A) Before chang-
ing the detail com-
ponent line weight. 
(B) After changing 
the detail compo-
nent line weight.

Figure 21.31 
Callout view (left); 
Drafting view 
(right).
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 3. Choose Region Properties in the contextual tab; select Edit Type and then Duplicate. 
Name it Plywood.

 4. Change the Background parameter to Opaque.

 5. Set the Fill Pattern to the Wood_Glu-LamBeam pattern (Figure 21.32).

 6. Click OK to complete the new type; then click the Finish Boundary to complete the filled 
region.

Finishing the DetAiL

To complete the detail, use detail lines on the Annotate tab. These lines are similar in nature to 
most drafting applications. Choose the Detail Lines tool, select the desired line type from the 
Type Selector, and start drafting. By using some thin, medium, and hidden lines, you’ll be able 
to quickly complete this detail (Figure 21.33).

Figure 21.32 
Select a plywood-
style fill pattern.

Figure 21.33 
The finished ceil-
ing detail.
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Embellishing the Wall Section: The Model Details
Now that you have explored the use of some of the drafting tools for a typical detail, let’s look 
at some of the more common detail types when there is no SIM (Similar) condition and only the 
model data. You will begin this exercise by working on the detail in the same wall section at the 
floor of Level 3. This will allow you to work on the head and sill conditions of the windows at 
the same time. The detail right out of the model looks like Figure 21.34 (again, using the tiled 
views to see both conditions at same time). 

Since Revit is parametric, you can actually work in either the detail or wall section as changes 
to the model changes will propagate everywhere. For this exercise, you will be working directly 
in the detail with the understanding that the wall section will also be updated. The finished 
detail you are going to create is shown on Figure 21.35.

Figure 21.34 
The detail and  
the related wall 
section.

Figure 21.35 
The finished detail.
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reusing DrAFting Lines

Design is cyclical in nature. Just because you think that in one phase you won’t need more than 
one detail of a condition doesn’t mean it will remain like that throughout the rest of the project. 
We have found it useful to use Copy and Paste and filtered selections together.

For instance, if you needed to make another detail similar to the drafting lines you drew in 
the prior exercise, you can make a selection box over a large portion of the detail and then use 
the Filter button in the Multi-Select tab to open a dialog box where you can choose to filter out 
all but the drafting lines and detail components. This lets us take the detail with us when we 
click OK and add a simple Ctrl+C to copy.

moDiFying the FLoor ConDition

The first thing you need to modify for this detail is the floor condition. Since the project is using 
a structurally insulated panel (SIP) for the skin, we cannot have the floor slab bearing on the 
insulation inside the panel. In reality, the panel will be clipped and hung from the side of the 
floor system. You’ll need to pull the edge of the floor back to 1 ½˝ from the inside face of the 
wall. You can do this the same way you fixed the ceiling in the detail earlier.

 1. Select the floor and choose Edit Floor from the contextual ribbon.

 2. When prompted for a view to edit the floor in, choose Floor Plan: Level 3.

 3. Move the slab edge on that wall 1 ½˝ from the inside face of the wall and click Finish 
Sketch.

The revised detail should look like Figure 21.36.

Figure 21.36 
The modified floor.
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CreAting A mAsking region

Obviously, you can’t run gypsum board back behind the slab and we still don’t have a clip to 
hold up our structurally insulated panel (SIP) panel. However, based on all the wall sections 
and details we have, it doesn’t make sense to create this out of detail lines, and there is no 
default Revit detail component for this condition. Instead, you will make your own detail com-
ponent to reuse for this condition. Detail components are like any other family in Revit. Once 
added to the drawing, you can always reedit and update them with new information. In the next 
exercise, you will make a quick and simple detail component—a masking region to hide the 
gypsum board on the SIP wall system.

 1. From the Application menu, choose New  Family  Detail Component.rfa.

 2. In the Family Editor, select the Masking Region tool from the Family tab in the  
Design bar.

You need to create a masking region 7⁄8˝ wide × 1́ -8˝ long to hide that run of gypsum board. 
You also want to make three sides (top, bottom, and right) medium lines because they will rep-
resent cut material and the left line an <Invisible Lines> type to keep it hidden. Invisible lines 
will show as gray when drawn in Sketch mode but will not appear at all and hide other lines (if 
on top) in model views. Since the masking region is overextended, you need to cut the top and 
bottom lines. Notice in Figure 21.37 that the left line of the rectangle appears as gray because it 
is an invisible line.

Masking regions are very precisely shaped elements. The reason this masking region is 7⁄8˝ 
wide is to cover the 5⁄8˝ gypsum board, taking into account that the line weight of the gypsum 
adds thickness to the line; this needs to be covered by the masking region.

Figure 21.37 
Creating the  
masking region.
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Now you need to draw the clip. For the moment, the clip can be represented by a simple filled 
region box 2˝ high and 1˝ wide, located 1 ½˝ down from the top of the finished floor on the right 
side of the masking region. 

 1. Using medium lines, create the box as shown in Figure 21.38.

 2. Before finishing the boundary, choose Region Properties and select the Aluminum pat-
tern. Click OK and then choose Finish Sketch. The finished component should look like 
Figure 21.39.

 3. If you choose Load into Project right now, it will load with a default name of Family1, 
which is not highly descriptive and not easy to relocate when you want to use it again. 
Take a moment and save the detail component to your project directory or library as SIP 
Clip.rfa. Now load it into your project, as shown in Figure 21.40.

Figure 21.38 
Creating the  
filled region.

Figure 21.39 
The finished  
component.
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 4. Because you have chosen a detail component, you have the added benefit of being able to 
keynote it, which you will need for the detail. Because this is a 2D, view-specific element, 
use the User keynote.

To finish cleaning up this floor condition, a few more items can be added by placing base 
molding around the floor/wall condition and then bringing the ceiling finish of the second floor 
to meet the wall and the floor finish to meet the wall.

a Note on annotation Crop regions

The annotation crop region is designed to allow you to crop annotations separately from model ele-
ments. Be aware that if your annotations extend past the annotation crop region in any way, they 
will not appear in the view. The annotation crop region needs to be outside the entire keynote or 
other annotation for it to appear in the view.

ADDing the BAse moLDing

For this detail, it is easiest to make a simple detail component. This will make it reusable and 
taggable—something you wouldn’t get with mere lines.

 1. Choose Application  New  Family  Detail Component.rft.

 2. Draw a simple 6˝ × ½˝ rectangle using a masking region and thin lines.

 3. This time, add a parameter to the base in case you want to change the height later in 
the design. Add a dimension to the base from top to bottom (Figure 21.41). Selecting 
the dimension, choose the Label drop-down from the Options bar and choose <Add 
Parameter…>.

Figure 21.40 
The component 
placed in the view.

56491c21.indd   643 6/3/09   10:37:48 AM



644 | Chapter 21 Moving froM Design to DetaileD DocuMentation

 4. In the Parameter Properties dialog box, name it Height and choose Dimensions from the 
categories (Figure 21.42).

If you choose to change the height of the base later in the project, you don’t have to reedit the 
family. It is simply a matter of changing the parameter using the following steps:

 1. Save the file to your project director or library as 6in base.rfa and load it into the 
project.

 2. Place it in the model (Figure 21.43).

Figure 21.41 
Adding a  
dimension to the 
baseboard.

Figure 21.42 
Setting the height 
as a parameter.

Figure 21.43 
Creating a param-
eter to control the 
baseboard height.
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moDiFying the FLoor AnD CeiLing ConneCtions AnD DetAiLs

In Revit there are a number of ways to create a detail. There is no single best solution, just as 
there is not one way to build something on site. We chose to cut the floor back from the wall and 
use filled regions to re-extend the floor to meet the wall condition. We could have left the floor 
connected to the wall and simply used masking regions and filled regions to give the appear-
ance of the floor structure being pushed back instead of the floor finish being pulled forward. 
We chose our particular method because our contractor had requested the use of the Revit 
model to do some concrete take-offs, so we needed to make sure the volume of concrete was as 
accurate as possible. Overextending or underextending that condition, even by a few inches, 
would have changed the volume of concrete reported in the schedule. Before choosing a direc-
tion for a workflow, it’s a good idea to understand all the uses for your model (beyond documen-
tation) and keep those in mind when making these kinds of decisions. In the following steps, 
these techniques will be demonstrated.

The floor line has been cut back to make room for the clips; you still need to finish detail-
ing the subfloor and finish floor to meet the wall. To do this, you’re going to create some simple 
filled regions.

 1. Using the Region tool on the Annotate tab, draw a rectangle boundary at the ceiling of 
the second floor to close the gap for the gypsum board under our blocking (Figure 21.44).

 2. When drawing the region rectangle, be sure to define the left line as invisible using the 
Type Selector so it appears continuous with the gypsum ceiling. Make the top a thin line, 
the right medium, and the bottom wide. Be sure to overextend the invisible line a bit to 
compensate for the line thicknesses. 

 3. Open the Region Properties dialog box, set Type to Gyp, and click OK. Verify that the 
region is opaque so you don’t see the model geometry through the region.

Once you click OK, the region should look like Figure 21.45. Somehow, it is not quite right. 
This is because the filled region and the detail components layer can rest on top of the others. 
You need to resolve their order by pushing the gyp-filled region to the top.

Figure 21.44 
Using a region to 
clean up a detail 
graphically.
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By selecting the filled region, you will be given some layering options in the contextual tab. 
In order from left to right, these are Bring to Front, Send to Back, Bring Forward, and Send 
Backward. Select the first button, Bring to Front, and the gyp hatch will appear correctly on top 
of the detail component (Figure 21.46).

Using this same example, you can build simple regions for the floor extension under our 
base. The floor condition looks like Figure 21.47.

ADDing repeAting DetAiLs

To finish this portion of the detail, you need to add material definition to the floor. The concrete 
has been poured on top of a corrugated metal deck, but it is not possible to add a corrugated 
metal material pattern as part of our floor materials, so we want to make a repeating detail in 
the form of our 3¾˝ corrugated deck. While the structural engineer will show this in detail, you 
still want to show the material architecturally in our sections and details. First, you’ll need to 
make the profile of the deck.

 1. Create a new detail component using the steps described earlier. You need to make a 
corrugated metal deck 3¾˝ tall to mimic the height in the model (Figure 21.48). There are 

Figure 21.45 
The region  
does not look  
correct yet.

Figure 21.46 
The graphically 
modified condition.
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a couple of ways to make the decking in the Family Editor. One option is to simply use 
lines. Another option is to create it as a masking region or region. It’s a matter of personal 
preference, and one might be better for your project workflow than the other. We only 
need to draw a section that can be repeated. When you’re finished, save the detail compo-
nent as Mtl Deck.rfa to the project folder or library.

 2. Once the detail component is loaded into the project, click the Repeating Detail button on 
the Annotate tab. You will need to make a new type, so click the Properties button next to 
the Type Selector, choose Edit Type, and choose Duplicate. Name the new type Metal Deck.

 3. In the Detail field, choose Mtl Deck from the drop-down menu. 

 4. Change the Detail Rotation field to 90 Degrees Clockwise. 

 5. Start drawing the element as you would a line.

Since this is a 2D element, you will also want to go back to the wall section and add the cor-
rugated deck to all of the appropriate locations. The finished deck in detail and section looks 
like Figure 21.49.

Figure 21.47 
Floor detail  
condition.

Figure 21.48 
Metal deck detail 
component family.
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nesting DetAiL Components

There are a couple more conditions to address to finish this detail. The head and sill conditions 
for the storefront system will probably not be affixed directly to the rigid insulation as the detail 
currently shows. You’ll need to add some blocking and flashing to those locations. Again, since 
you will want to reuse this condition in other views, you can make it with a detail component. 
This time, however, you are going to add a more significant level of detail to the detail compo-
nent before inserting it into the model. You’ll do this by nesting detail components within each 
other. Let’s start with the storefront head condition.

 1. Start a new detail component family using the process described earlier.

 2. Notice that in the Family Editor, there is a Detail Component button, similar to the one 
in the project environment. Click it and load a 2 × 6 from the same path we used earlier 
(Detail Components  Div 06-Wood and Plastic  06100-Rough Carpentry  06110-Wood 
Framing  Nominal Cut Lumber-Section.rft).

 3. Use the horizontal reference plane to simulate the top of the storefront. We want to place 
our blocking ¼˝ back from this line, centered on the vertical reference plane.

 4. Using a masking region, draw a shim under the 2 × 6.

Figure 21.49 
The metal deck in 
section and detail.
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 5. Once you click Finish Sketch, because this is a shim, you’ll want to show it with a single 
diagonal line through it. Using the Detail Line button, you can add a detail line to make 
this condition.

To help finish the window on the exterior, place a stone header over the window opening. 
This can be created with a region and a new region type for stone. The stone head is 6˝ high 
by 2¼˝ wide and placed 13⁄8˝ from the edge of our 2 × 6. (This measurement isn’t arbitrary: it is 
taken directly from the wall condition in the model.) Figure 21.50 shows your current progress.

 1. You need to add a steel lintel for the stone header. Revit does not provide these as default 
detail components, so you can create one with a filled region.

 2. Save this condition as SIP Storefront Head.rfa and load it into the project.

Once the detail component is inserted into the model, you should see something that looks 
like Figure 21.51.

Figure 21.50 
Nested detail  
component.

Figure 21.51 
Inserting the 
nested detail  
component.
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Using simple detail lines and filled regions, you can add any necessary flashing and gypsum 
returns to the window. The completed head condition should look like Figure 21.52.

Finishing the DetAiL

By combining the simple tools used in the previous sections, you can easily complete this detail. 
As we have mentioned throughout this chapter, many of the elements that were imported or 
created need to be made only once. All of the families and detail components you built in the 
course of this detail are now available in the project for use in other views. The finished detail 
looks like Figure 21.53. 

You can easily adapt this process to complete details for the other conditions.

Figure 21.52 
Final detail at head 
condition.

Figure 21.53 
The completed 
detail with the 
nested component.
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General tips for Detailing

When detailing, keep these ideas in mind:

If your model is detailed to begin with, the detailing will go much faster because you will need •u	

to add fewer components. However, you must strike a balance and not make an overly detailed 
model, because that will negatively impact performance. When wondering what to model or 
what to make into a detail component, ask yourself the following questions:

Will I see or use this in other views in the project? •u	

Will it affect other aspects of the project (like material take-offs)?•u	

How large is it? (Our office tends to use 2D detailing for details 1 ½˝ and smaller.)•u	

If you insert User keynotes and in the Options bar choose the option Free End for the Leader, you •u	

can drag the notes around anywhere on the view and add as many as you’d like. The benefit of 
this method is that it allows you the consistency of always pulling your notes from the keynote 
text file. And if the note is updated in the text file, it will be updated in the project.

Remember to import only CAD files that you have already cleaned up. Only bring in what you •u	

need to reduce your overhead and keep file performance optimal.

There is no limit to how much information you can place in a detail component. If you will be •u	

seeing similar conditions throughout the model, put in as much as you can.

You can use detail components at every scale within the model, so it is a great way to draw the •u	

information only once.

If the lines describing geometry merge when printed into a single graphic element, there’s little •u	

point in showing that geometry at that scale. You might consider making the model simpler.

The Bottom Line

Create drafting views.    Not every drawing or view in Revit is created with model elements. 
Some of the views on sheets will be made solely with 2D drafting views. Knowing how to 
create and use these views is critical to any documentation package.

Master It    Keeping views hyperlinked together is a key benefit to using Revit. How do 
you draw simple, 2D details in Revit but still keep them parametrically linked to sheets?

Import and link CAD details.    Even if you’ve been using Revit for years, you will need 
to import 2D geometry from an old library of standards or manufacturer drawings. 
Understanding how to do this effectively will keep you from having performance issues with 
your model.

Master It    Your office has a huge repository of standard details. How do you reuse de-
tails drawn in CAD in a Revit project?
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Create 2D detail components.    Detail components can be used again and again within a 
model to graphically show in 2D different typical building components. Mastering these will 
result in enhanced productivity when you work on a project.

Master It    Detailing is a process of adding more granular layers of information and 
graphics to the model and view. What tools would you use to add 2D detail?
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Advanced Detailing Techniques

Chapter 21, “Moving from Design to Detailed Documentation,” covered the transition from design 
to construction documentation. Now you will continue building your skills and learn some addi-
tional techniques for more detailed construction documentation. As your project experience grows, 
your library and detailing capacity within Revit will grow with it. This chapter is dedicated to tools 
and functionality that you can employ after you become comfortable with creating details in Revit. 
By building your library and knowledge of detailing workflows, you can cut down the time you 
spend detailing, leaving more time for design.

In this chapter, you’ll learn to:

Create 3D details•u	

Add detail components to 3D families •u	

Reuse details from other Revit projects•u	

Creating 3D Details
As building designs become increasingly complex and the construction industry continues to 
specialize its assembly methods, it has become imperative that information be communicated 
effectively between designer and contractor. A technique for showing construction assemblies 
that has an established place in the history of architectural representation is the use of 3D detail 
drawings (Figure 22.1) that show a sectional cut through the building in a 3D format (axonomet-
ric or perspective). This type of drawing is used to convey pragmatic detail and constructability 
information rather than having to create a multitude of 2D sections and elevations to demon-
strate complex building details. In recent years, this documentation technique has fallen into 
disuse because it is difficult and time consuming to re-create axonometric details in a 2D CAD-
based environment.

With Revit’s 3D modeling capabilities, it is easy to create such 3D details. By using 3D views 
and the Orient to Other Views command, you can quickly generate 3D views that focus on a con-
struction condition. These views can be used for constructability or to demonstrate critical building 
concepts. Figure 22.2 shows a detail of a sustainable solution employed on the Foundation project. In 
this sectional axonometric, we are able to demonstrate many of the green building concepts simulta-
neously while also showing dimensional depths of the sunshading and daylighting systems.
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Figure 22.1 
Hand-drawn  
perspective detail.

Figure 22.2 
Sectional axono-
metric showing 
details of sunshad-
ing solution.
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Creating these kinds of 3D details in Revit is quick and easy to do. There are two ways to do this:

Turn on the Section Box tool, and then adjust the section box to focus on your detail•u	

Orient a 3D view to an existing view. This method adjusts a 3D view to resemble a chosen •u	

2D view. You can then rotate the cropped 3D view to any new orientation. This method is 
much more practical than cropping the view manually because it is much faster to generate 
details and because the size of the detail condition is focused on an existing, pre-established 
scope

3D Details: Enabling a Section Box in 3D View
Take the following steps to enable the Section Box tool in a 3D view:

 1. Start by creating or opening a 3D axonometric of the building. To create one, click the 
Default 3D View button in the Quick Access toolbar. Be sure to rename your view some-
thing unique.

 2. Open View Properties and enable the Section Box parameter. A large section box that sur-
rounds the entire model will appear in the view. This is a 3D clipping box that allows you 
to cut the model from six directions.

 3. By clicking and dragging the blue arrows, you reduce the size of the box to a clip that rep-
resents the detail area you wish to indicate (Figure 22.3). Manipulating a section box can 
take a bit of trial and error, regardless of your experience with Revit. Later in this chapter, 
we’ll discuss some ways to make this quicker and more accurate.

3D Details: Orienting to View
An alternative for creating a 3D detail is to orient the 3D view to an existing view. Do this by 
first creating a detail callout where needed, let’s say in a wall section, as shown in Figure 22.4. 
Then, give the callout detail view a recognizable name by selecting the callout and editing its 
element properties. Call it Sunshade Detail. Having a recognizable name will make the detail 
easier to find later, as the number of details in a project can become quite large.

Figure 22.3 
Drag the blue 
arrows to resize 
the section box.
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Now that we have established which detail we’d like to be able to rotate in 3D, let’s create the 
new, 3D view:

 1. After creating the callout, open the default (3D) view by selecting the 3D view icon from 
the toolbar. Right-click the ViewCube and choose View  Orient  To Other View, and 
select our Sunshade Detail from the list (Figure 22.5).

 2. Once you click OK, the 3D view reorients and appears in the form of a section—just 
like the detail callout. However, this is a 3D view. By orbiting this view (using either the 
ViewCube or combining Shift and the middle mouse button), you’ll be able to visualize 
the sectional detail in 3D (Figure 22.6).

The crop boundaries of the 3D detail correlate to the boundaries of the callout, so there is no 
need to alter the section box as was the case with the first method of creating 3D details. The 
depth of the section box in this view is defined by the depth of the view you have used for orien-
tation. You can edit the section box using the grip controls as you would any other section box. 
To hide the section box lines but keep it cutting the model, select it, right-click it, and choose 
Hide in View  Elements from the context menu.

Figure 22.4 
Creating a callout 
detail in section.

Figure 22.5 
Selecting a view 
by right-clicking 
the ViewCube and 
choosing View  
Orient to View 
from the context 
menu.
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Create a 3D View of One Single Floor

Reorienting to view is also practical when you want to isolate an entire floor and show a 3D view 
on one floor only.

Figure 22.6 
Top: Oriented to 
other view, detail 
looks like a flat  
section. Bottom:  
The rotated 
(orbited) view 
reveals a 3D detail.
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Adding Annotations to the 3D Detail
Even if 3D details are much richer and clearer in information than 2D details, they still need 
annotations (dimensions, text notes) that add to the graphical explanation. To add dimensions 
to a 3D view, you first need to define a work plane where the dimensions will appear, as they 
cannot float free in the 3D space; they need a surface (work plane) to be drawn against. (See 
Chapter 6, “Modeling Principles in Revit I,” for more on work planes.) We are showing our 
dimensions at Level 3 in the view. From the Workplane panel on the Home tab, select Level 3 
from the drop-down menu. Using the Work Plane Visibility toggle, you’ll be able to see what 
plane the dimensions will be created on, as shown in Figure 22.7. Dimensioning along this plane 
is similar to dimensioning in any plan view. By selecting parallel elements, you can apply the 
necessary dimensions.

You can then begin to add text notes to this view. Note that in a 3D view, you can add text 
and dimensions but not keynotes or tags. Also, be careful not to rotate the 3D view after you 
apply your notes. Text is placed perpendicular to the view you have created and will maintain 
that relationship. Rotation of the 3D detail after you’ve added text will result in leaders or text 
not pointing to the desired building elements.

By turning on the shadows in the view, you’ll be able to give the view a better sense of depth, 
as shown earlier in Figure 22.2.

Be sure the ground plane is enabled in the Sun and Shadows Settings dialog box for the view. 
A good choice is either Sun from Top Right or Sun from Top Left. See Chapter 15, “Presentation 
Techniques for Plans, Sections, and Elevations,” for more detail on presentation techniques.

Adding Detail Components to Families
In the previous chapter, we investigated how to add levels of detail to a detail component by 
creating one detail out of a number of separate components, thus making it easier to replicate a 
detail condition across various project views. Again, this idea of drawing it once and repeating 
that detail easily is a core theory in Revit. Combining these principles, we can extend this theory 
to family creation, where you can turn details on or off within a family depending on the Level 
of Detail view setting. 

Figure 22.7 
Setting and visu-
alizing the work 
plane in a 3D view.
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When we explored the notion of the view detail earlier, we mentioned the ability to show 
different levels of detail at coarse, medium, and fine settings. Combining this with detail com-
ponents, you can embed details for typical conditions directly within the families themselves, so 
that you do not need to add more drafting elements to your views. 

Figure 22.8 shows the same window family in coarse, medium, and fine views. All of the 
detail has been added to the family itself, and the detail is activated by switching between the 
levels of detail. Note that the fine detail level in this series shows the actual CAD detail from the 
manufacturer’s website and is not modeled in detail in 3D. Modeling this level of detail within 
the Revit model would be a huge performance killer. Because the detail was created as part of 
the window family, this highly detailed information will be displayed each time any section or 
plan view is made that cuts through the window. This method enables you to have the level of 
detail always present in the drawings without having to give up performance or over-model the 
building.

Building this type of window family is not complicated, but it does require a bit of knowl-
edge about how a family is created and assembled. For our purposes, we are going to assume 
that the window family has been created correctly and we are simply trying to apply more 
detail to the window itself so that it displays much more detailed information in fine view. 

Adding Details to a Window Family
Since we have already created the sill condition, let’s now focus on creating the head detail. Start 
by locating the family within the project using the Project Browser. Select it, right-click, and 
choose Edit Family from the context menu. The interface changes to the Family Editor environ-
ment. Open a section view (or if there is no section view, create a new one using the Section 
tool). The section view of the window family head will look like Figure 22.9.

Figure 22.8 
The same awning 
window shown  
in (A) coarse,  
(B) medium, and 
(C) fine view.

A B C

Figure 22.9 
Section view  
of the window 
family head.
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In Chapter 21 we discussed how to insert default Revit detail components. For the blocking 
above the window head, we can load a detail component from the Revit default library. Here are 
the steps:

 1. On the Home tab, click the Component button (or choose Place Component from the pull-
down list). Next, click Load Family from the Place Component contextual ribbon. Then, 
once the browsing window opens, you will need to follow the path Detail Components 
| Div 06-Wood and Plastic | 06100-Rough Carpentry | 06110-Wood Framing and choose 
Nominal Cut Lumber-Section.rfa.

 2. Insert this component 1¼˝ (3cm) from the exterior face of the wall. This ensures that it 
ends up in the right location relative to the wall it will be inserted into. If this window 
was going to be inserted into a variety of wall types, you could make the 1¼˝ (3cm) 
dimension a parametric family parameter.

 3. Once the component is inserted, lock it to the reference plane that is at the window head. 
This ensures that as window sizes are changed, the blocking moves as well.

 4. Based on the window type, the blocking needs to always be set 1¼˝ (3cm) from the front 
face of the wall, so you can add a constraint there as well. Add a dimension to the left 
edge of the blocking and the left edge of the wall, and lock it into place (Figure 22.10).

 5. We want to create a new detail for the window head showing an added level of detail at 
the head condition. For this, we’ve downloaded the manufacturer’s standard CAD detail 
and we want to incorporate it into our window. To begin, you need to create a new detail 
component using this CAD detail. From the Application Menu select New  Family. 
Choose Detail Component to open the Family Editor. 

Figure 22.10 
Adding a dimen-
sion and locking it 
into place.
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 6. To import our CAD detail, follow the steps we discussed in the previous chapter. 
Choosing Import CAD from the Insert tab will bring up the dialog box where you can 
insert the CAD detail. This time, you’ll want to choose slightly different options. Accept 
the defaults for all but the following: 

Select the Black and White option in the Layer/Level Colors area•u	

In the Import or Link area, change the Layers setting to Select (we want to pick the •u	

layers to import)

The dialog box will look like Figure 22.11. Click Open.

 7. A dialog box similar to Figure 22.12 opens, asking you to choose the correct layers to import. 
Hatch is something we do not need, and typically, manufacturers are fairly good about 
keeping their layer management for CAD details consistent and easy to understand. We 
want to deselect any layers that reference hatch or any layers we know we will not need as 
part of our detail. Deselect the box and click OK.

Figure 22.11 
Importing CAD 
detail into a detail 
component.

Figure 22.12 
Selecting layers  
to import.
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 8. With the detail inserted, position it using the reference planes in the detail component. 
While you can reposition things within the Revit families fairly easily, these reference 
planes provide invisible snap references when loaded into a project—making place-
ment and dimensioning easier and more specific. Because the top of the head and the 
face of the glass are key to this detail, use those to place the imported file, as shown in 
Figure 22.13.

 9. You are nearly done with this family. Because this detail has such a simple construction 
(very few lines) and we have removed the hatch, we are going to explode the detail. Select 
the detail and from the Modify Imports in Families context menu, choose the Explode 
flyout and click the Full Explode button. This converts the detail into Revit detail lines 
and allows you to modify some of the line weights and the detail geometry to better fit 
the family. A detail with too many lines or lines that are very, very small (< 0.3mm) will 
be deleted when the detail is exploded.

 10. With the detail exploded, you can now remove the glazing, which is only partially drawn. 
We have modeled glazing in the family itself, so including it in the detail as well is a bit 
redundant. Select the lines shown in Figure 22.14 and delete them. Instead of exploding the 
detail, another way to do these same steps is to go into the original CAD file and remove the 
lines and layers you don’t need before inserting the detail into a Revit detail component.

 11. The last thing you need to do before saving the model is change the line weights. Select 
all of the lines in the detail by creating a selection box around them, and while they are 
selected, choose Detail Items from the Type Selector. You could keep all of the lines the 
way they had been imported from CAD and change them to the appropriate line weight 
using Settings  Object Styles from the Manage tab. However, this is a little cleaner for 
future tweaks and does not add unnecessary line types to your project.

Figure 22.13 
Aligning the refer-
ence planes.
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 12. Save the detail as Head.rfa in your project folder or library and import it into the window 
family using the Load into Project button on the Create tab.

 13. Back in the window family, place the detail component over the existing extruded win-
dow frame and lock it to the reference plane that defines the head opening (Figure 22.15).

Visibility Settings
With the detail components in place, you can now establish rules for when each of them will be 
visible when loaded into the model. You might not want to have your details shown in coarse 
or medium scales of 1:200 or 1:100, but you might wish to show them in 1:50 or 1:20 scale. In 
the next steps, visibility settings will be applied to some of the model elements and detail com-
ponents that will link these items to the detail level setting. For this family, we need the detail 
component to be visible only in fine levels of detail and the 3D solid form window frame sweep 
to be hidden in fine levels of detail.

Figure 22.14 
Select the lines for 
the glazing and 
delete them.

Figure 22.15 
Detail component 
in window  
head detail.
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 1. Still in the Family Editor environment, select the detail component. On the Modify 
Imports in Families tab, click the Visibility Settings button. Clicking this button opens 
the Family element visibility settings dialog box shown in Figure 22.16.

 2. This dialog box is as simple as it looks, but it’s quite powerful at the same time. By dese-
lecting any of the options here, you limit the visibility of components to specific detail 
levels. For this example, clear the Coarse and Medium check boxes and click OK.

Now you will notice that a funny thing happens—or actually, doesn’t happen. If you change 
the visibility of detail levels, the detail component still appears, although now it is drawn in a 
gray tone, as if it ignores the visibility settings you just made. You can quickly confirm that you 
deselected those view levels by checking the visibility settings again. Don’t worry. You have 
done nothing wrong. In the Family Editor, for editing purposes, you will always see everything 
in each view detail level regardless of its setting. Only when you load the family in the project 
environment will you really understand if you have modified the visibility correctly.

The goal was to see the highly detailed representation of the window when switching to fine 
detail view. At the same time, you don’t need to see the original 3D window frame because the 
linework of the frame will overlap with the linework of the newly inserted 2D detailing compo-
nents. You need to turn off the visibility of the window frame from within the family when in 
fine detail view:

 1. Select the 3D sweep created to represent the window frame and click the Visibility 
Settings button on the Modify Imports in Families tab. The dialog box that appears is the 
same as you saw previously when you selected the 2D detail component, but since this 
3D element appears in more views, you now have more visibility options (Figure 22.17).

 2. You still want to see the window frame in plan, reflected ceiling plan, and elevation, so 
leave those boxes checked for now and just uncheck the When Cut in Plan/RCP and Fine 
boxes, mirroring the settings for the detail component.

Figure 22.16 
The Family  
element visibility 
settings dialog box.

Figure 22.17 
Visibility settings 
for a 3D element.
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Controlling Visibility in plan Views

The same rules can be applied to plan views using this technique, so that the sweep does not show 
up in fine levels of detail. By clearing the Plan/RCP check box, you turn off the visibility of the 
window frame in plan view as well.

We will now add a trim. Use a masking region to cover the trim piece above the window 
frame on the exterior side of the glass. Use the boundary lines of the masking region to define 
the shape; it’s not necessary to draw separate lines. Create it on the fly (Figure 22.18). While 
visually scanning through the manufacturer’s product information, we selected a trim piece, but 
we don’t have any Revit or CAD details for it. So, you have two options: make a new detail fam-
ily and import it or build it on the spot.

Adding More Information Using Symbolic Lines
At this stage of the detailing process, you need to add sealant, flashing, and trim at the window 
head. For that you can use symbolic lines. Symbolic lines are 2D lines that are visible only in the 
view in which they were added. An example of the use of symbolic lines would be a representa-
tion of a door swing in elevation. The dashed lines that represent the hinge points are symbolic 
lines. 

 1. Using symbolic lines, add sealant to the detail, as shown in Figure 22.19.

Figure 22.18 
Draw a masking 
region for trim.

Figure 22.19 
Adding symbolic 
lines for the  
sealant.
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 2. Before loading the detail into the project, you need to make sure the visibility of the sym-
bolic lines and the masking region are correct. You cannot change the visibility of those 
elements simultaneously, so you’ll need to select each one independently (choosing the 
masking region, then the symbolic lines) and set the visibility to show them only in fine 
detail views. 

Doors and Symbolic Lines

Doors are typically modeled in a closed position but shown as open and with a door swing direction 
in plan view. To get this dual representation, in the Family Editor turn off the visibility of the door 
panel (extruded solid form) in the plan view and draw the 90-degree open door panel and its swing 
using symbolic lines. Symbolic lines can be controlled using the same visibility settings available 
for detail components and the solid model elements in the family. You can use the same logic and 
draw the dashed lines that represent the door opening direction in elevations.
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Save the family with a unique name before loading it. Once it is loaded, you can quickly cycle 
through the various view detail options and see the power of using visibility settings in the 
family, as shown in Figure 22.20.

Imagine that the door has already been modeled and you are adding the lines representing 
the swing. For that you add the symbolic lines in both plan and elevation to complete the element. 
When drawing new symbolic lines, use the Type Selector to define the subcategory of the lines.

Reusing Details from Other Revit Projects
There are many times in a project workflow when you want to leverage details already created 
in other projects and reuse them. So far we have covered how to do this using CAD files from 
other projects or from manufacturers’ websites. This workflow is also possible using details cre-
ated from other Revit projects. We will explain how to take an active project file and export key 
details to the library. We’ll also discuss how to pull single details out of a Revit file and put them 
into your active project.

Exporting Details from Revit Projects
As you create more and more details in Revit, you will inevitably want to save some of them to 
your office’s standard library so you can reuse them in other projects and save the work you’ve 
invested. Saving a view out of a project creates a separate RVT file that contains only that view. 
There are a couple of ways to do this, either of which will result in the same outcome. First, if 
you have a 3D model detail that you’ve embellished with 2D components and would like to save 
it for future projects, you can save it as a Revit file.

Right-click any view (or schedule) in the Project Browser and choose Save to New File. It might 
take Revit a minute to compile the view content, but you will be presented with a dialog box ask-
ing you for a file location to save the view (Figure 22.21). The default filename will be the same as 
the view name in the project.

Once the view is exported, it functions like any other RVT file. Opening the view directly 
will allow you to edit and manipulate any of the elements you exported in the view. You will 
also see a streamlined version of the Project Browser (Figure 22.22) with only the related views 
present. These Revit files can be kept in a project library for later use.

Figure 22.20 
Cycling through  
to different levels 
of detail of the 
window.

Coarse Medium Fine
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The second way to export a view from Revit is from the Application Menu, using Save As  
Library  View. This opens a dialog box of all the exportable views from the project file. Here, 
you can select any number of views to be simultaneously exported into separate library files 
(Figure 22.23). This is a great way at the end of a project to export all of the detail views you 
would like to keep in a project library. Select the desired views by checking the appropriate 
boxes and click OK.

Figure 22.21 
Exporting a  
drafting view  
from Revit.

Figure 22.22 
Project Browser 
only has views 
appropriate to 
the ones for the 
exported view.

Figure 22.23 
Multiple views can 
be saved as sepa-
rate Revit files.
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Importing Views into Revit Projects
To import any of these files into a new project, switch to the Insert tab and from the Import 
Panel and choose Insert from File  Insert Views from File with the project open. This lets you 
navigate to your library containing your exported details. When you choose the exported detail 
file, a dialog box opens allowing you to select the view (Figure 22.24).

Notice that the view is described by both its location within the Project Browser (Drafting 
View) and its view name (Storefront Head Detail). Selecting this view and clicking OK merges 
the view into your current project. The view will appear in the location called out by the view 
name. In this case, you can find this view in the Project Browser under Drafting Views. 

Another way to insert content into Revit is to use the 2D views from exported files. For 
example, elements of a detail you have in your library may need to be inserted into a view you 
are working on to augment that view. An excellent use case for this would be if you are creating 
a new detail and want to reference or use parts of one from another project that is similar but 
not exactly the same. An example of this might be a new detail of a window head in a concrete 
opening and you are reusing parts of a detail from a masonry opening. You may only want to 
use a selected portion of the new view in the current detail you are working on. To import the 
2D content into your view, follow these steps:

 1. Open the view you want to import into, click the Insert tab and from the Import panel 
choose Insert 2D Elements from File. The resulting dialog box looks similar to the one for 
importing the full view but with some slight differences (Figure 22.25).

Figure 22.24 
Selecting a file to 
import into the 
current project.
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Unlike Insert Views, the Insert 2D Elements from File command allows you to choose only one 
view at a time to insert. There is also an option to transfer the view scale with the view elements. 
Checking this box reconfigures the receiving view to match the view that you have inserted.

 2. Select the drafting view and click OK. This brings all of the 2D elements in the selected 
view into your active view. You can repeat this command multiple times in the same 
view window if you need to repeat the content.

Using Detailing to Create a Shaft Opening

Revit offers a couple of ways to create an elevator shaft. One commonly used approach that we’ve 
seen discussed on the community forums is to create a door family that also contains all the eleva-
tor information (essentially, a combined door and elevator family in 3D). As a door family, it cuts 
a hole into a wall and gives proper representation of both the door and the elevator. This will give 
you your elevator, but then you need to perform a secondary task of editing the floor slab profiles 
to accommodate the shafts. Although this method will work, it can cause a problem with making 
sure the floor openings stay aligned between the floors. In our practice, we use a different method, 
which was used in creating the Foundation model. By using the Opening tool on the Modify tab, 
we can create a shaft opening.

Figure 22.25 
Importing  
2D content.
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This tool allows you to create one vertical shaft through multiple floors. This has a few benefits 
over the other method:

The openings in the floors will always be aligned•u	

We can extend this shaft through as many or as few floors as desired•u	

The constraints of the shaft can be locked to reflect the manufacturer’s required size•u	

Symbolic lines can be embedded in the opening to represent the elevator cab and can be drawn •u	

(or imported) to reflect the manufacturer’s cab sizes and proportions

This last point is very valuable within our office. After creating the shaft, we can add the elevator 
cab plan directly from the manufacturer’s CAD detail as symbolic lines. 

Now, any time we cut the shaft in plan, it will display the elevator cab using these symbolic lines. 
If our building is complex in form and we need to move our view range up or down, we will always 
maintain the elevator cab in the plans.

The Bottom Line

Create 3D details.    3D axonometric details are a great way to demonstrate more complex 
assemblies and conditions in any document set. Knowing how to create them in Revit will 
expand the ways in which you can detail.

Master It    Use a 3D axonometric detail to demonstrate constructability in a unique as-
sembly condition.

Add detail components to 3D families.    Adding detail components to 3D families can save 
time by embedding the linework of a detail within the family itself and making it instantly 
available throughout all the locations that family is placed.

Master It    Create a detail by embedding it into a family so it can be expressed by simply 
modifying the detail level of a view.

Reuse details from other Revit projects.    There are times when details are common 
between projects. Knowing how to use details from other Revit projects will cut down on 
your documentation time.

Master It    Use details you created in your other Revit projects.
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Chapter 23

Tracking Changes in Your Model

Once a project is under way in the construction document phase, changes to the design need to be 
tracked. This is typically done on a per-sheet basis by adding revision clouds around elements 
that are changing in the drawings and documenting those changes in the title block of the sheet. 
The revision history of each sheet is then tracked in the title block with a number, description, and 
issue date. In this chapter we will look at adding new revisions, adding revision clouds to sheets, 
and assigning a cloud to a revision. We will also explore some best practice tips and tricks for per-
forming revisions in Revit. Lastly, we will investigate using Autodesk Design Review to pass 
comments and markups back and forth between team members.

In this chapter, you’ll learn to:

Add revisions to your project•u	

Understand BIM and supplemental drawings•u	

Use Autodesk Design Review•u	

Adding Revisions to Your Project
Revisions allow designers and builders to track changes made to a set of construction docu-
ments. Typically, these changes are recorded after a set of documents has been issued and per-
mitted. Since the construction documents usually consist of numerous sheets, this methodology 
allows everyone on the team to track and identify which changes were made by whom and 
when during the construction process those changes were made. The purpose is not only to 
ensure correct construction but also to create as-built documentation at the end of the construc-
tion process that can be delivered to owners for their continued use of the building. 

In a typical workflow, the revisions will look something like Figure 23.1 when they are cre-
ated in Revit and issued as part of the drawing set.

To create a revision, open the Annotate tab and choose Revision Cloud from the Detail panel. 
This will put you in Sketch mode. Once you draw your revision cloud, open the Revisions dialog 
box found on the Manage tab in the Settings drop-down list. Here, you will see the default revi-
sion, Sequence1, which is where your revision cloud has been placed.  Here, you can also add, 
delete, merge, issue, and define the behavior of revisions. Let’s go through the major elements  
of this important dialog box.
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The numbering method    You can choose to number revisions by Sheet or by Project. (By 
Project is a global project setting.) Which method you should choose mainly will depend on 
how your firm tracks revisions. By Sheet allows you to have as many revisions as you want 
within the drawing set, but on each sheet, the revision numbers always start with 1. In the 
example shown in Figure 23.2, the tags and revision schedule are unique for each sheet, depend-
ing on what revisions are on each sheet. The revisions on each sheet are presented sequentially 
by sheet. This means you are chronologically numbering and tracking the changes that happened 
on one particular sheet, not all the changes that happened in the entire project.

Using By Project will tag your revision clouds based on the global sequence established 
within the project as a whole. In this example, all revisions with the same issue date within 
the model would have the same revision number. So you might skip a revision number on 
any given sheet. You can also set up this numbering method in your default office templates.

Figure 23.1 
A typical-looking 
revision cloud and 
triangle-shaped 
revision tag.

Figure 23.2 
The Sheet  
Issues/Revisions 
dialog box.
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The revision table    The Sheet Issues/Revisions dialog box starts with one default revision 
already in place, even though you may have not made a revision yourself. This is only so that 
you have a place to start. No revision will appear in your title blocks until you add revision 
clouds to your sheet. Each revision has a fixed number of parameters that you can fill out. As 
you can see in the dialog box, they are fairly self-explanatory and include numbering, date, 
description, and an Issued check box, in addition to Issued To and Issued By columns and 
options for showing clouds and tags.

The Add button    To create a new revision, click the Add button. The new revision will 
automatically be placed in sequential order. Only the sequence number will be automatically 
updated. You’ll need to add your own description and date.

Revision numbering    The Numbering option allows you to number each revision numeri-
cally, alphabetically, or not at all. If you choose alphabetic sequence, the sequence is defined 
in the Alphabetic Sequence Options, in the lower right of the dialog box. Click the Options 
button to set your sequence and remove letters you don’t want (Figure 23.3). By default, an 
entire alphabet will appear here. The None option will allow you to add project milestones—
non-numbered entries that appear in revision tables—to sheets without having to add revi-
sion clouds.

Revisions    To issue a revision, click the check box in the Issued column. This will lock the 
revision clouds placed on sheets or in views associated with that revision, preventing them 
from being moved, deleted, or otherwise edited. The parameter values in the dialog box will 
gray out and become noneditable. This is to guarantee that the clouds and data do not change 
downstream once you issue a set of drawings.

revisions in a Live Model

Keep this in mind: while the clouds can become fixed in the project, the model will not be. So, if you 
need to maintain an archive of all project phases and of each revision, be sure to export the sheets 
either as DWF or PDF files to preserve a snapshot of the sheets at time of issuance.

Revision clouds and tags    The visibility of revision clouds and tags related to revisions that 
have been issued is controlled from this dialog box. As issues occur, you may want to hide 
clouds or tags from previous revisions. This is where the Show parameter comes in handy. 
For example, if you’ve issued a revision and then add revisions later and want to clean up 
your drawing, you can choose to show the issued revision as the tag only (typically a small 

Figure 23.3 
Sequence options 
allow you to use 
any order of letters 
you want.
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triangle with the revision number inside it, as in Figure 23.4) or not show anything at all, by 
using the None option (Figure 23.5).

Merge Up or Merge Down    If you need to combine two revisions into one, use the Merge Up 
or Merge Down button. All associated revisions on sheets and tags will update automatically.

tracking revisions in the title Block

The revision is typically a part of the architectural sheet and is located in a prominent position in 
the title block to alert readers to changes made in the documents. These revisions can be incorpo-
rated into your title block design so Revit will parametrically read them from the sheet into a revi-
sion table. To add a revision schedule to a title block, you will need to open the Family Editor and 
make changes in the title block. Please refer to Chapter 4, “Setting Up Your Templates and Office 
Standards,” to understand how that can be done.

Placing Revision Clouds
To place a revision, open a view in which changes to the model have occurred and use the 
Revision Cloud tool found in the Detail panel on the Annotate tab. Once you activate the tool, 
you will be dropped directly into Modify Revision Cloud Sketch mode. Start drawing lines 
around the area you are calling out as a revision in a clockwise direction. Revit automatically 

Figure 23.4 
A revision tag.

Figure 23.5 
Use the Show 
parameter to hide 
clouds and tags of 
issued revisions  
on your sheets.
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creates a line that makes a cloud (or series of arcs), as shown in Figure 23.6. When you’re finished 
creating the cloud, click Finish Sketch Cloud button at the top-right side of the Ribbon.

Like every other object in Revit, the graphics for revision clouds are controlled from the 
Annotation Objects tab of the Object Styles dialog box, shown in Figure 23.7.

Figure 23.6 
Clouds are drawn 
for you as you 
sketch.

Figure 23.7 
You can change the 
graphic appear-
ance of revision 
clouds globally 
using the Object 
Styles dialog box.
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Use this dialog box to make revision clouds have thicker line weights or to change patterns 
or colors. As we mentioned in Chapter 4, the graphical appearances of your elements should be 
set up in your office templates in advance to guarantee consistency between projects. 

Changing the color of the revision cloud to red in the Object Styles helps them stand out as 
you work. By default, each new revision cloud will be assigned to the last revision in the Sheet 
Issues/Revisions dialog box (which you access from the Settings menu on the Manage tab). If 
you need to change the revision that a cloud belongs to, select the cloud and use the drop-down 
list in the Options bar to change it. This information is also stored in the Instance Properties 
dialog box of the cloud, as shown in Figure 23.8.

As soon as you have placed a revision cloud onto a sheet, any revision schedules in your title 
block will update to include the revision number, description, and the date you assigned in the 
Sheet Issues/Revisions dialog box earlier.

Updates in Custom title Blocks

If you are using the default Revit title blocks, updates will happen automatically. If you are using 
custom title blocks, be sure you’ve added a revision schedule to them in the appropriate location so 
you can take full advantage of using a parametric model. (See Chapter 4 to learn how to add revision 
schedules to your title block families.) 

Figure 23.8 
The revision 
cloud’s Instance 
Properties  
dialog box.
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Tagging a Revision Cloud
Revision clouds can be tagged like many other elements in Revit. The tags are intelligent and 
designed to report the revision number or letter that has been assigned to the cloud. To place a 
revision tag, use the Tag by Category tool in the Tag panel on the Annotate tab. 

If a tag for revisions is not in your template, you will be warned that no such tag exists in 
your project. To continue, simply load a revision tag. The default Revit tag loaded by default in 
Revit is named Revision Tag.rfa and is located in the default Annotations folder created with a 
standard installation (see Figure 23.9).

Once you have a tag loaded, you are ready to go. Hover the cursor over a revision cloud and 
click to place the tag. You will see a preview of the tag prior to placing. Once the tag is placed, you 
can drag it around the cloud to reposition it, and it will stay associated with the revision cloud.

Customizing the tag

Just as with the majority of annotations in Revit, you can design your custom revision tag as you 
see fit. You can follow the steps presented in Chapter 4 to make a custom annotation tag from 
scratch, or you can customize the default revision tag provided with the software. To customize 
the appearance of the default revision tag, select a tag already placed in the project and click the 
Edit Family button on the Modify Revision Clouds tab. Editing the tag within the project will 
take you to the Family Editor, where you can tweak its size, font, and appearance. Once you’ve 
made your customizations, save the tag to your local library, and then load it into your project 
and swap it with the default tag using the Type Selector.

Figure 23.9 
Load a revision tag 
if it’s not already 
part of your  
template.
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Disabling the leaDer

You can choose to use a leader line between the tag and the cloud depending on your prefer-
ence or your office standards. In many cases, the tag just needs to be near the cloud and a leader 
is not necessary. Disable the leader by selecting the tag and clearing the Leader option in the 
Options bar (shown in Figure 23.10).

BIM and Supplemental Drawings
The process of making supplemental drawings (SDs) entails making a change to an existing 
drawing and then issuing that change as a separate package. Sometimes this can be a single 
8.5˝×11˝ sheet where the new detail is then pasted over the old one in the construction set in the 
job trailer. From a workflow perspective, this can be a little disruptive in Revit for a couple of 
reasons:

Placing the new detail into an 8.5˝•u	 ×11˝ or smaller sheet to issue the individual drawing can 
lead to other problems. You will need to either remove the view from the sheet it was 
issued on temporarily (and remember to put it back) or duplicate the view and hope that 
you do not need to make last-minute additional changes

An SD, once issued, is like a snapshot in time. It becomes a numbered change made to the •u	

drawing set at a given date. Since the model and all the views in the model always reflect 
the most current state of the project, making separate SD sheets and views within Revit 
will show any additional changes made to that view

As a best practice, some architects leave all of the revisions directly on the sheets where they 
were originally issued. The sheets are printed to PDFs and the PDFs (with the revision clouds) 
are imported into Adobe Illustrator or a similar application where they can be properly scaled 
and cropped to the view or detail in question and then placed on an 8.5˝×11˝ template to be 
issued for the revision. This process not only creates a historic record of the revision, but also 
allows you to avoid issuing the full sheet. You can also export a portion of a view to DWG and 
then import it into a drafting view for annotation of supplemental drawings. This keeps every-
thing in Revit. 

Figure 23.10 
The revision tag 
leader is set using 
the Options bar.
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tracking Changes in the Foundation project

To see the change-tracking process in practice, you can try an example using the Foundation project. 
Assume that you have already submitted a construction documentation set, and after some review 
with the client have decided to make some additional changes. Imagine that you need to change 
some windows from sliders to casements.

Another team member implements this change, and now you need it to be tracked on your sheet as 
a revision to the original document set.

When you open the sample file, Foundation.rvt, from the Chapter 23 folder on the companion 
web page (www.sybex.com/go/masteringrevit2010), you’ll see some markup notes on the sheet 
indicating the desired changes, along with the revised window design itself.

You first open the Sheet Issues/Revisions dialog box, click Add to add a new revision, and give the 
revision a description: Window Modifications. Click OK and move to the Annotate tab, and select 
the Revision Cloud tool. Draw a cloud around the windows, and click the Finish Cloud button in 
the Ribbon. Then, to place a tag, click the Tag By Category button, clear the Leader check box in the 
Options bar, and tag the revision cloud. Your revision cloud should look like this:

Notice the Revit revision cloud and tag. In the title block, note that a new entry appears in the revision 
schedule. Your revision tag, the cloud, and the revision number are parametrically associated.
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Using Autodesk Design Review
Autodesk Design Review offers a fast, efficient way to view and mark up 2D and 3D designs for 
review. This workflow is different from what we just covered and is geared more toward infor-
mal design review rather than management of sheet issues. For example, if your drawings must 
be reviewed for quality and overall design comments by a senior designer who neither owns 
Revit nor knows how to use it, this tool can streamline the process and offer a way to achieve 
that need. The senior designer, consultant, or any other third party can make comments and 
review changes and send it back to the Revit user who needs to follow up on those reviews.

This is the next generation of the DWF format—one that is more closely aligned with emerg-
ing technology standards supported by Microsoft. Once a DWFx is exported from Revit, it can 
be opened in Design Review, marked up, and then linked back into the Revit file, where changes 
can be picked up and tracked. If you export the drawing sheets from Revit to DWFx, when the 
DWFx is linked back into Revit, Revit will automatically place the DWFx with the corresponding 
sheet so there is no need on your part for any sort of alignment or placement of the revisions.

The DWFx format allows you to share drawings and models with stakeholders with a light-
weight and easy-to-use application. The navigation and ability to hyperlink between views 
works well with Revit and is easy to learn.

Design Review is a free tool that you can download from the Autodesk website: www.autodesk 
.com/designreview.

Once it’s installed, you can open any DWFx or DWF file produced by any Autodesk or non-
Autodesk software packages.

The Design Review User Interface
The interface for Design Review is straightforward, as shown in Figure 23.11. It contains a main 
view window, toolbar, and navigation pane.

Figure 23.11 
The Autodesk 
Design Review 
interface.
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The view window    The main window shows the active view. Using the middle mouse but-
ton, you can zoom and pan. If you are looking at a 3D DWF, you’ll also see the ViewCube in 
the upper-right corner of the view. Use this cube to rotate the model by clicking it, or you can 
hold the mouse down and rotate the cube. Before you start rotating the model, make sure the 
orbit method is set to Turntable in the toolbar.

This will keep your model rotating with the Z axis always pointing up. If you use the Orbit 
option, your model will tumble around freely in space on all axes.

seleCting elements in Design review

For certain types of elements, selection is very much the same in Design Review as in Revit. 
For example, when you select a wall, level, grid, or section marker, that element will highlight 
in other views as well—not just where your cursor is. It behaves this way because the DWFx 
originated from Revit, where every element is a unique, model-based element and not just a 
set of abstract lines. When an element is selected, check out the context menu; it contains many 
options that allow you to zoom, hide elements, make them transparent, and even move them 
(Figure 23.12).

Exporting to Design Review
The DWFx format allows others to examine your design without needing to own or know how 
to use Revit. The files are also small, which makes them easy to email, something you cannot 
do with a large Revit file. There are two ways to share your model using Design Review: as 2D 
information or as 3D information. If you export to 3D, you create a single 3D representation of 
your model. Exporting to 2D can create either a view or a whole collection of interconnected 
views and sheets all packaged as one file.

Figure 23.12 
The Autodesk 
Design Review 
context menu.
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archiving with DWFs

A 2D DWF of all the sheets of the drawing set is a great way to keep an archive of your project. This 
allows you to take a snapshot in time of the state of your drawings in a single, small file that is easy 
to print and easy to reference back into the model should you ever need to return to a previous state 
in the design. Again, make sure you export sheets, not views.

DwF exports

You can export to DWF from any view in Revit. To export your active view, click the Application 
Menu and choose Export  DWF. The resulting Export to DWF dialog box lets you choose which 
views/sheets to export. The default is your current view. Give your file a unique name and save. 
Then open the file with Design Review to see the result. When in Design Review, experiment with 
some of the viewing options in the View panel on the Home tab (Figure 23.13). The Perspective 
toggle is a nice feature that lets you toggle the 3D view between isometric and perspective with a 
single click.

Click the Export drop-down list to choose what you want to export. You can choose to 
include or exclude any sheets or views using the Include column. When you’ve made your 
selection of sheets and views to export, click the Export button. By default, all your views and 
sheets will be combined into a single DWF file. If you want a separate file for each view and 
sheet, uncheck the option Combine Selected Views and Sheets into Single DWF File. Let’s walk 
through this:

 1. Open the Foundation.rvt model in the Chapter 23 folder on the companion web page.

 2. Go to the Application Menu and choose Export  DWF to open the dialog box shown in 
Figure 23.14.

 3. Select Sheets in the Set and then chooseExport <In session view/sheet set> from the 
Show in list drop-down list.

Figure 23.13 
Options for 
viewing the 
model—note the 
Perspective toggle.
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 4. To check the export size, open the DWF Properties tab and click the Print Setup button. 
In the resulting dialog box, you can set explicit sizes for your export. Click the option Use 
Sheet Size to let Revit autodetect sheet sizes based on the title blocks you are using in the 
project (Figure 23.15).

Figure 23.14 
The DWF Export 
Settings dialog box.

Figure 23.15 
Set the Use Sheet 
Size option and 
Revit will auto-
detect the size of 
your sheets when 
exporting to DWF.
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 5. Click the Export button to specify the filename and the location to save it. Make sure you 
specify to combine all sheets into a single DWF file, as shown in Figure 23.16.

 6. Save the file as foundation_all_sheets.dwfx to a location on your hard drive.

 7. This process will take some time because it is exporting all the views on all these sheets. 
When the process completes, open the file with Design Review. You’ll see all the sheets 
displayed with previews in the navigation pane in the Contents tab (Figure 23.17).

Marking Up the Model Using Design Review
Once you have exported a DWF, you can open it in Design Review and add textual markups that 
can then be shared with your team, or even linked back into Revit. To mark up a view in Design 
Review, use the callout tools in the Markup & Measure tab (Figure 23.18).

Draw the shape using the tool, and then add your text. Figure 23.19 shows a clouded area and 
associated text note.

Figure 23.16 
You can combine 
sheets into a single 
DWF file.

Figure 23.17 
Sheets are  
displayed in 
Design Review as 
previews in the 
navigation pane.

Figure 23.18 
Design Review  
has a variety  
of markup  
graphic styles.
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Importing a Design Review Markup
Once you’ve added markups in Design Review, save the file. You can then link these back into 
the Revit project. Go the Link panel on the Insert tab, and then choose DWF Markup:

When a DWF file is selected, Revit will link and show only the markups, not the entire DWF 
file. So if there are no markups in the DWF file, nothing will come into Revit. Markups are any 
text note, markup, or stamp added in Design Review. Figure 23.20 indicates that three sheets 
have markups.

Figure 23.19 
Type in comments 
and use the grips 
to position your 
markups.

Figure 23.20 
For each markup, 
there is an associ-
ated Revit view.
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Note that markups can only be linked to sheets. If you export a view and mark it up, it will 
not show up in Revit. Always work from sheets when using Design Review for markup transfer.

You cannot move or delete linked DWF markups—they appear with a pin when selected. You 
can do a number of things to graphically indicate that you’ve dealt with a markup:

Change its graphic appearance    Let’s say you have 20 redline markups on your sheet. You 
need to keep track of which ones you’ve dealt with. One way to do this is to graphically over-
ride each one as you finish. Select the markup, then use the context menu option Override 
Graphics in View  By Element. Choose a color to indicate “done.” Yellow works well because 
it suggests a highlight marker.

Hide it    This approach is similar to the graphic override, but you hide the markup alto-
gether. Select the markup, and use the context menu option Hide in View  Element.

Remove it    You can remove markups by choosing Manage Links from the Manage tab. In 
the Manage Links dialog box, select the DWF Markups tab, select the markup, and click the 
Remove button. This removes all markups associated with the link.

The Bottom Line

Add revisions to your project.    You need the ability to track changes in your design 
after sheets have been issued. Adding revisions to a drawing is an inevitable part of your 
workflow.

Master It    Add revisions to your project that automatically get tracked on your sheet.

Understand BIM and supplemental drawings.    Making an actual revision to a construction 
document involves adding graphics and coordinating the clouds with revisions.

Master It    You need to cloud a design change. How would you do this using Revit?

Use Autodesk Design Review.    You’ll often need to share your design with people who do 
not have Revit, so that your design can be examined and marked up.

Master It    How can you export your designs in a lightweight file format?
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Worksharing

Most projects involve more than one person working on a project at any given time. It’s common 
in design for many people to work together to meet deadlines and crank out a set of construction 
documents. Keeping with the theme of an integrated single-file building model, Revit allows for 
this workflow without breaking apart the model. A complex model can be edited by many people 
at once using a feature called worksharing. In this chapter, we’ll focus on enabling the worksharing 
feature of Revit.

In this chapter, you’ll learn to:

Set up a project with worksets•u	

Understand worksharing basics•u	

Manage workflow with worksets•u	

Understand element ownership in worksets •u	

Setting Up a Project with Worksets
Worksharing in Revit refers to the use of worksets to divide up the model for the purpose of shar-
ing data between multiple people. A workset is a collection of building elements and compo-
nents (floors, roofs, walls, windows, and so on) that can be used to manage project workflow 
and responsibilities by separating these various building components into subsets that allow 
control over visibility and element ownership. By default, worksharing is not enabled when you 
start a project in Revit, because the software assumes you are working in a single-user environ-
ment until you tell it otherwise.

Worksharing Warning

Once you enable worksharing in a model, you cannot undo it. We suggest that you make a copy of 
your project file before you enable worksharing so you have an unshared version as a backup.

You share your work by saving a central file to a shared network location. This central file 
becomes the repository where all the individual work on the project is collected and permis-
sions are managed.

56491c24.indd   689 6/3/09   12:23:05 AM



690 | Chapter 24 Worksharing

Once the central file has been established, each team member then makes a local copy of it 
and works solely in that local copy. All work is done directly in these copied—but still associ-
ated—local files. This enables all users to open their local files simultaneously and work in them 
(see Figure 24.1).

The elements in each separate file are tied to an ownership rule linked to the central file, 
making it impossible to edit an element in your local file if that same element is owned by 
someone else in another local file. Remember, Revit is a database. In effect, you’re obtaining 
permission to edit one or more elements from the central database. Once you have permission to 
modify an element, no one else can make changes to that element until it is reconciled with the 
central file—in other words, “checked back in.” This occurs when you use the Synchronize with 
Central command (hereafter referred to as STC) to copy your work back to the network. If one 
user has ownership of an element, no other user can edit that element until its permissions, and 
any changes to it, are reconciled with the central file.

Worksets allow you to group many elements into virtual collections of objects for the pur-
pose of managing visibility and file performance. To that end, there are a number of benefits to 
enabling worksets beyond allowing multiple team members to work within the same file:

Using worksets, you can turn visibility off and on for elements that aren’t being worked on •u	

or that are not needed for the current tasks.

Revit allows you to close a particular workset globally across all views and also remove it •u	

from active memory, thus improving performance. Therefore, closing worksets is different 
than turning them on or off in only one view,

You can quickly request and obtain permission to work on groups of elements belonging to •u	

someone else.

When you enable worksharing, a new tab appears in the Visibility/Graphic Overrides dialog 
box for the worksets (see Figure 24.2). You can turn any workset on or off in any view using this 
tab. Additionally, you can make those settings part of any of your view templates. 

Figure 24.1 
The worksharing 
concept. Each team member works in the local file.

The local file sends requests for
permission to the central file.

Local files can get the latest
information from the central file
at any time.

As each local file is Saved to
Central, it is also updated
with new work saved in the
central file.

Central File
on the server

Local File Local File

Local File Local File
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Understanding Worksharing Basics
Revit’s worksharing features are designed to accommodate any division of labor you see fit. There 
are no inherent restrictions on how you use worksharing to divide up a model. For example, you 
can break up a model and have one group work on the shell and another work on the interior 
core of a building. You can turn worksharing on at any stage of the project, and you can create 
or remove individual worksets during the project cycle.

Worksharing is found on the Collaborate tab of the Revit UI.

Start worksharing by clicking the Worksets button on the Collaborate panel. It will then be 
the only active button on the panel.

This action opens a dialog box telling you that you’re about to enable worksharing for your 
project and that once it’s enabled it can’t be undone (Figure 24.3). After confirming that you do 
want to proceed, Revit will automatically create two worksets: Shared Levels and Grids, which 
contains all the levels and gridlines from the project, and Workset1, which contains everything 
else in the model.

Figure 24.2 
Workset visibility.

Figure 24.3 
Activating work-
sets within a  
project.
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In addition to the two worksets created automatically when you initialize worksharing, Revit 
maintains three other types of worksets in a project:

View worksets    Each view in a project has a dedicated view workset. It contains the view 
properties and any view-specific elements (text, dimensions, tags, and so on). View-specific 
elements cannot be moved to another workset. You can take ownership of any view in Revit 
by simply right-clicking it in the Project Browser and choosing Make Workset Editable (see 
Figure 24.4). This will give you ownership of the view workset and all of the view-specific 
annotations, allowing you to easily and quickly make modifications to any of the 2D con-
tent within the view. This is a handy feature during the construction document phase when 
much of the work is segregated, as it allows users to view worksets for dimensioning and 
annotations.

Family worksets    For each family loaded in the project, a workset is automatically created. 
When editing properties of a family, you will take ownership of that family unless someone 
else already owns it. You can add families to each of the views without having ownership 
over view worksets, but you cannot make changes to the families or their properties without 
having permission over the families themselves.

Project standards worksets    This workset is dedicated to all the project settings, such as 
materials, line styles, tags, and dimensions. Any time you edit a project-wide setting, you 
must take ownership of a workset for that setting. However, you can always add new infor-
mation, materials, or line styles to a project without having to own a workset. You only need 
to take ownership of a workset to edit existing settings or elements.

Once you’ve activated the worksets, you’ll see the dialog box shown in Figure 24.5. The 
Worksets dialog box lets you add and remove worksets from the project. When a new workset is 
created, it does not contain any model elements or components; it is a blank container that you 
can then begin to fill.

Also note that at the bottom of this dialog box you have the option to turn on visibility for the 
automatically created worksets we discussed earlier. By default, they are not activated. To acti-
vate them, simply check the box for the workset desired. You can see in Figure 24.6 that enabling 
any of these check boxes adds a considerable number of elements to the view window.

Figure 24.4 
Making a view 
workset editable  
is a property of  
any view in a  
workset file.
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When you activate a workset, you become the owner of that workset and all the elements in 
it. This ownership is what the Yes value in the Editable column refers to; if you are the owner of 
a workset, the value in the Editable column will be Yes, but if you are not the owner, the value 
will be No.

Who Controls Worksets?

Worksets are usually activated by the team’s project manager, who initially enables worksharing, 
creates user-defined worksets, and assigns people and tasks for the project. However, worksets 
are managed by the team itself. It is up to the team members to make sure they are working on the 
correct workset. It is also not currently possible to lock a workset from use or editing by any team 
members beyond simply taking permission of the workset.

Figure 24.5 
Worksets  
dialog box.

Figure 24.6 
Worksets dialog 
box with Project 
Standards enabled.
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Workset Organization
It’s important that you think of your project holistically when dividing it into worksets. 
Technically speaking, you don’t need any more than the initial default worksets because Revit 
manages ownership of elements on a per-element basis and relinquishes elements automatically 
when you save your changes to the central file. However, you might want to divide up the model 
into worksets for some of the reasons we described earlier. Some good examples of typical work-
sets are Shell, Core, Exterior Skin, First Floor Interior Partitions, Second Floor Interior Partitions, 
Roof, and so on. You may also want to create another workset named Entourage for rendered-
only elements (not for documentation).

thinking in Worksets

One of the biggest challenges facing teams new to Revit is losing the legacy of layers. Many teams 
that have been drafting in 2D CAD immediately want to begin managing worksets as they would 
manage a CAD drawing. They make a workset for doors, one for walls, and one for windows. 
Remember that all of your objects are in one file and you can control visibility of those objects 
through the Visibility/Graphic Overrides dialog box. Not only is there no need to put your doors 
into a separate workset, but doing so will actually make your model more difficult to manage. 
What happens when you have ownership of the doors, your teammate has ownership of the walls, 
and you want to move or add a door? You can’t do so because you don’t own the entire assembly. 
You have to own the door and the wall you want to place it in to make those changes. Overall, it is 
preferable to think about each workset as a collection of ideas that you want to be able to isolate 
and visualize separately from the rest of the model, such as core, exterior, exterior, and roof, plus 
entourage (for rendered elements only). 

Divide your project into worksets that relate to the roles and responsibilities of people work-
ing on the project. By default, you don’t need more than two to three worksets per person on a 
project. When making new worksets, remember the Ludwig Mies van der Rohe dictum, “Less  
is more.”

For our Foundations project, we have divided the model into four worksets, shown in 
Figure 24.7: Interiors, Shared Levels and Grids, Shell and Core, and Site.

Interiors    All of the interior walls, furniture, and other items are managed with this 
workset.

Shared Levels and Grids    This workset contains the level and grid information from the 
model, as was originally established when worksharing was enabled. 

Shell and Core    All the exterior skin elements of the building as well as the elevator, stair, 
and toilet cores that are grouped in any typical office building are in this workset.

Site    The topography (toposurface) and any site-specific elements in the project go into this 
workset.
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Keeping It Simple

For our project, creating the Site workset meant renaming Workset1. Because the Shell and Core 
workset will have the most elements in it, renaming allowed us to forgo the additional work of 
moving all those objects into a blank workset.

Notice that Workset1 has been renamed. That title is not descriptive enough to be of ongoing 
use, so it can be modified once all the model elements have been moved to relevant worksets. 
The worksets we’ve set up demonstrate how a typical breakdown might occur in a project of 
this size, but it’s by no means limited to this scheme. Depending on how you structure work in 
your office, the worksets might be quite different. 

Once you are in a workset environment, you can see or change an object’s workset by access-
ing its element properties. At the bottom of the Element Properties dialog box, you can see 
which workset an object or group of objects belongs to, and you can change what workset the 
element belongs to (see Figure 24.8). Note that you can move elements to other worksets only if 
you own the elements. You do not need to own the entire workset to do this—just the individual 
elements.

Additionally, you can tell what workset an object belongs to by hovering your cursor over 
the object and waiting for the tooltip to appear. This tooltip will give you a host of information 
about the object in question. In our example, the workset is Shell and Core, the element is also 
part of the Walls category, the name of the family is Basic Wall, and the family type is A3 - 4¾ :̋

Figure 24.7 
Workset  
organization.
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practice Good Workflow

As a best practice, do not work directly in the central file once the worksets have been established. 
Every user should be working in their user (local) file. Working directly in the central file will change 
the file attributes and nullify anyone’s ability to successfully use the STC command. Once someone 
has worked directly in the central file, any work by anyone else will be lost and everyone will be required 
to make new local copies. Working in the central file should only occur if there is a file upgrade or 
some other historically significant event, and even then should only be done with full knowledge 
of all the team members.

Moving Elements Between Worksets
Once the worksets are created, there are some simple steps for moving elements quickly to other 
worksets. As mentioned, the easiest way to move the bulk of the objects is to not move them 
at all but simply rename Workset1. After that, it is easiest to move elements in a subtractive 
method from a 3D view. The following exercise will walk you through moving elements to their 
new worksets using a subtractive method to locate model geometry. Note that this should be 
done while one person is still the solitary owner of all the worksets.

 1. Open the default 3D view ({3D}) so that you can see all of your model elements within the 
project.

 2. Open the Visibility/Graphic Overrides dialog box, turn off the Site workset, and click OK. 
Since nothing is in the Site workset, the view should still look the same after you do this.

Figure 24.8 
Change the  
workset an  
element belongs 
to by selecting a 
different workset 
using element 
properties.
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 3. Now, in the 3D view select a comfortable number of site elements and click the Properties 
button. (Comfortable means you don’t have to try to select them all at once.) In the 
first image in Figure 24.9, the toposurface and some trees have been selected and are 
highlighted.

 4. In the Element Properties dialog box, select Site for the Workset value and click OK. All 
of the elements you selected will disappear. Not to worry: remember, you turned the Site 
workset off using the Visibility/Graphic Overrides.

 5. Using the same technique, you can move the remainder of the site elements to the Site 
workset. The same procedure is repeated in order to move the interior walls to the 
Interior workset.

At any point in this process, you can check your work by opening the Workset tab in the 
Visibility/Graphic Overrides dialog box and clearing all of the boxes but one to see what is in 
each workset. Figure 24.10 shows the Interiors workset with all of the interior elements. As you 
can see, this is a great way to manage visibility without using the object categories.

Figure 24.9 
Moving objects 
between worksets.

Figure 24.10 
The Interior  
workset.
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Moving every Instance of an element

A quick way to move every instance of a single element to a new workset is to use the Select All 
Instances option from the context menu. For example, select a tree in the model, right-click on the 
tree, choose the Select All Instances command from the context menu, and open Element Properties. 
You can then change the workset for all those elements in one action. This also ensures that you 
actually selected all of the elements, whereas in a window selection it can sometimes be suspect.

Managing Workflow with Worksets
With worksharing there is always one central file that spawns local files and manages element 
ownerships. This is the file that collects all the work being done by your team members and 
allows the team to get regular updates of new work saved to the central file. Once the work-
sets are initialized and the model is divided into various worksets, you will need to complete 
a few more steps before the team can jump into the model and begin working in a multiuser 
environment.

To use Revit in a workset environment, start by doing something any IT manager would 
yell at you for doing: make a local copy of the central file and work directly off your C: drive. 
Although this approach is a bad idea for most work in an office environment, for the Revit data-
base there are several good things about it:

It allows more than one user to make changes to the central file by editing local files and •u	

synchronizing those changes with the central file.

Your local copy will be more responsive than a networked local file because your access •u	

speed to your hard drive is much faster than it is across most networks.

Should anything bad happen to your network or your central file, you will have an up-to-date •u	

backup to which you can easily apply the Save As command and make a new central file.

Creating a Central File
Now that you’ve turned on worksharing, you need to set up the central file to be used by more 
than one person. To do this, first you create a central file located on your network; then you cre-
ate the local files. To create the central file, choose the Application Menu  Save As and give the 
model a new name. Before you save, click the Options button at the bottom of the dialog box and 
verify that Make This a Central File After Save is checked (see Figure 24.11).

Figure 24.11 
Creating a  
central file.
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The reason for the new name is twofold. First, it gives you a backup of your original, pre-
workset file. Backups never hurt. Second, Revit sometimes does not like to have a new file saved 
over an active file or a file of the same name. It can cause file corruption.

Creating the Local File
Now that the central file has been created, you need to create the local files that you will work 
from.

 1. Make a new, local copy of the central file by dragging the file you just created to your 
desktop or another location on your hard drive. Be careful not to move the file; you just 
want to make a copy of it. 

 2. Now, open this new, local file. The first time any local file is initialized, you will receive 
the warning message shown in Figure 24.12. All this means is that you’ve made a local 
file and you will be the owner of the local copy. If you don’t see this message, check to 
make sure you’re opening the correct file.

Once you click OK, you are set and ready to begin working in a worksharing environment.
Now that you’re in a worksharing environment, every element added to the file belongs to a 

workset. Try to keep model elements in a workset other than Shared Levels and Grids because 
these worksets may be locked down at some point to avoid accidental movement of key datums. 
To make sure you’re placing elements in the proper workset, check the Collaborate tab to see 
what the active workset is. All newly created elements will be assigned to the workset shown in 
this box. Remember, you don’t have to be the owner of this workset in order for to be able to add 
new elements to it, nor does the workset need to be editable.

A helpful toggle on the Collaborate tab is the Gray Inactive Workset button. It grays out all 
elements that aren’t in the active workset, helping you identify which elements in the workset 
are active. This is a temporary view state and will not affect any print output.

Figure 24.12 
Opening the  
local file for the 
first time.
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Saving Shared Work
Once you begin working in a worksharing environment, you need to know how to save your 
work and be able to share it with others. There are three ways to save your work when you’re 
using a workshared file:

Save    The Save tool saves the work you’ve done to your local copy only; the work isn’t 
shared or saved back to the central file. This is useful when you’re in the design phase and 
trying out different designs, or if you’re not ready to share your work with others but you 
definitely want to save the work you’ve done.

Synchronize with Central    If you want faster access to synchronizing, a Synchronize with 
Central button is available on the Quick Access toolbar.

Save to Central    The Save to Central button is on the Collaborate tab. Use this to publish 
your work into the central file. When you do so, your work appears in the central file and 
becomes available to the entire team. Using Save to Central also acquires the changes that 
others have made (and likewise saved to the central file) and loads them into your local 
model. Using the menu option for STC is a good way to save yet maintain permission over 
the elements you are creating. Choosing this option will open the dialog box shown in 
Figure 24.13, which allows you to customize how you save to the central file. You can choose 
to relinquish some permissions or none of them, and you can choose to save a local copy at 
this time (or not). You can also add comments about this particular version you are saving. 
The comments are available in the History dialog box (covered later in this book).

Synchronize with Central  Synchronize Now    This option, found under the Synchronize 
with Central button, will synchronize your changes and download other people’s changes 
without your needing to interact with the dialog box. 

Revit will remind you regularly to save your work. In a worksharing environment, you will 
see a dialog box reminding you to save locally, and another one reminding you to synchronize 

Figure 24.13 
Save to Central 
dialog.
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the central file. You can dismiss these reminders from time to time, but remember that it’s 
always a good time to save (and not lose) your work. It’s also important to remember that 
although Revit provides automatic reminders to save your work, it will not autosave.

Each of the dialog boxes comes with three options: you can save/synchronize the proj-
ect; save/synchronize the project and set reminder intervals (choosing this will bring up the 
Options dialog box); or you specify that you do not want to save/synchronize or set reminder 
intervals (this last option dismisses the reminders). However, if you want this dialog box to go 
away and be reminded again at the interval you’ve requested, just hit the cancel button.

 

The reminder time shown in the dialog box can be modified across the application using 
General  Application  Options.

Loading Work from Other Team Members
It’s possible to update your model from the central file without committing your changes to the cen-
tral file. Think of this process as getting an update of the model. To do so, choose the Collaborate 
ribbon and click Reload Latest. Revit finds the latest changes saved to the central file and brings 
them into your local file without publishing any of the changes you’ve made.

Optimizing reload Latest

Mapping Reload Latest to a keyboard shortcut can help you see others’ edits quickly. Also, much of the 
time in a Synchronize with Central process is consumed by reloading the latest changes. More frequent 
use of Reload Latest will shorten the time it takes to save when you use Synchronize with Central.

Understanding Element Ownership in Worksets
While you are working in a worksharing environment, it might become necessary to see if you 
have ownership of an element. To do so, select the element. If you own it, it will be highlighted 
in purple and can be readily moved or modified. If you do not own it, it will still be highlighted 
purple, but you will also see an icon resembling three stacked blocks in blue. This indicates that 
you do not currently have ownership of that element.
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recovering from Mistakes

Inevitably, with any team of people, someone is bound to make a mistake somewhere in the process. 
It happens; it’s just human nature. The important thing is knowing how to recover when those acci-
dents happen. On one project, someone new to our team kept accidentally deleting the west wall of 
the project while deep into construction documentation. Since Revit is a database and everything 
is linked to everything else, every time this happened, not only were the plans affected, but we lost 
the west elevation, wall sections, the door and window details in those sections, and so on. You get 
the idea. Once the west wall was deleted, the user issued the Synchronize with Central command, 
thereby changing the central file. Fortunately, we caught the mistake in time and thus did not have 
to resort to a backup from the previous night and lose a day’s worth of work. Because each local 
copy was a fully functional copy of the model, all we needed to do was find the latest local version 
with the wall in it, click the Application button, and choose Save As  Project. We then clicked the 
Options button and selected Make This a Central File after Save. Once everyone on the team made 
a new local copy, we were back in business.

You can obtain ownership of the element in a few ways:

If you edit or move an element, Revit will automatically grant you permission to own it •u	

provided no one else currently owns it or the workset it resides within.

If you can click the stacked block icon, and if the element is available, Revit will grant you •u	

permission to edit or change it. 

You can right-click the element and choose Make Elements Editable from the context menu •u	

(see Figure 24.14).

Figure 24.14 
Making an element 
editable.
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Note that in this context menu, you also have the option to make worksets editable and take 
permission of the entire workset the object is assigned to. 

Borrowing Elements
Borrowing is a critical technological concept in Revit. It allows users to fluidly transfer permis-
sion of objects without having to constantly save all their work to the central file and relinquish 
all worksets. By borrowing elements, team members can take ownership of some of the elements 
within a particular workset that belongs to someone else. This is typically used to modify only 
one or a few elements in a given workset without taking ownership of the entire workset. This is 
also valuable if you need to edit elements in a workset and someone else already owns it.

The key idea here is that you can borrow elements individually rather than by workset. If you 
need to work on an element that belongs to someone else, you’ll be informed of that and given 
the option to send a notification asking to borrow it. The owner of the element can then grant 
permission for you to take ownership. This is referred to as relinquishing permission.

Let’s look at this workflow in more detail.

Requesting Permission
Say you are happily working away on your model and realize that someone else is the owner 
of an element you need to modify. Should that occur, you will be presented with the dialog box 
shown in Figure 24.15. This will occur every time you are working in a model in which work-
sharing is enabled and you are attempting to edit an element that is already owned by someone 
else on the project.

You can click Cancel, which will undo any edits you have made to that element, or you can 
click Place Request to ask the other user to relinquish permission over the element in question. 
If you opt to place a request, you will see this dialog box:

Figure 24.15 
Placing a request 
for permission.
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It is important to note that the other user does not receive an explicit notification that you 
have placed the request. To make sure your colleague knows of your request, you’ll need to call 
or instant message (IM) that person, and get them to grant the permissions. (You’ll learn how to 
do this in just a bit.) If owning this element is critical to the task at hand, keep in mind that you 
will not be able to perform any more work in relation to that element until that other user grants 
you permission to borrow it. Once the other user has agreed to relinquish ownership, click the 
Check Now button to see if you do in fact own the element. Or, if you want to just keep work-
ing, click the Continue button. This will undo your last command and return you to the view to 
continue your work.

Get their attention!

Asking another user to grant permission to an element is a great reason to use an intra-office IM or 
chat service. It is invasive enough to alert another user to the fact you are requesting permission 
for an element. However, the phone works well, too. Formatting a Revit username as Your Name + 
Phone Extension is another good trick.

Once you’ve received notice from the other user that your request has been granted, click 
Check Now and you will receive the message shown here:

Clicking OK will apply your edits and you will then be the borrower of that element.
You can view the Worksets dialog box to see who owns which worksets and who is borrowing 

from a workset at any time, as shown in Figure 24.16. 

Granting Permission
Suppose that you have been happily modeling along and you receive a phone call, IM, or tap on 
the shoulder from someone who wants permission for an element you own in the model. How do 

Figure 24.16 
Owning and bor-
rowing worksets.
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you grant it? On the Worksharing toolbar is a button called Editing Requests, which allows you 
to see outstanding requests that have been sent your way. 

Clicking this button gives you the dialog box shown in Figure 24.17.

From here, you have a few options:

Grant    This gives your teammate permission for the requested element. 

Deny/Retract    This denies permission to your teammate (or takes it away).

Show    This shows you exactly which element or elements have been requested, which help 
you make an informed decision. 

Once you are ready to grant permission, one of two things will happen. If you haven’t made 
any changes that need to be saved, you can simply grant the permission and notify your team-
mate that you have done so, and then both of you can continue to work. If you have been edit-
ing the requested element, you’ll need to save your changes to the central file before anything 
else can happen. Changes of this nature are specially flagged in the Editing Requests dialog 
box with an asterisk before the request. This indicates that the element has been modified and 
a Synchronize with Central command must be issued before permission can be granted (see 
Figure 24.18).

Figure 24.17 
Editing Requests 
dialog box.

Figure 24.18 
Editing requests 
for changed  
elements.
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Trying to grant permission at this point will give you the dialog shown here:

To remedy this issue, close the dialog and perform a Synchronize with Central using one of 
the methods we discussed earlier. Keep in mind that if you choose Synchronize with Central 
from the Collaboration tab and uncheck the boxes for relinquishing permission, you will need 
to come back to the Editing Requests dialog box to grant permission for this element. Once you 
have saved to the central file and notified the other user, he or she can then click the Check Now 
button to continue to work.

The user who is requesting permission of the element will see this dialog box after clicking 
Check Now:

This means that the object the other user was trying to use has been edited. He or she has to 
choose Reload Latest or Synchronize with Central from the Collaborate tab and reload the most 
current copy of that object before it can be edited. Unfortunately, any modifications to this ele-
ment will be lost because the element will be changed in the central file.

Closing Revit 
Depending on your role on a project, your schedule, or those annoying urges to eat and sleep, 
from time to time you might leave your desk and want to close Revit. Revit helps you do this by 
providing some directions for saving your work. It offers two options:

Relinquish Elements and Worksets     This is the default option. It will do exactly what it 
says: synchronize your work with the central file and relinquish all of your permissions.

Keep Ownership of Elements and Worksets    This button gives you the option to save only 
locally and keep ownership of the elements you’ve checked out. Be careful when using this 
option, because no one on your project team will be able to gain permission for or edit those 
elements while you are away.

Getting permission when Someone Is away

Inevitably it happens. Someone leaves their desk for a meeting or goes home early (or just closes 
Revit) without relinquishing permission to their elements or worksets. Now you’re stuck, unable to 
make the changes you need to make. There is a workaround for this dilemma. However, be warned 
that using it will cause the other person to lose any and all work since their most recent synchroniza-
tion. If they did a Synchronize with Central and simply chose to keep ownership of their elements, 
no work will be lost. If they did not, the remaining work will need to be redone.
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Should your needs outweigh the risk of data loss, follow these steps:

 1. Open a new session of Revit. (You can keep your current session open if you prefer.)

 2. Select Application  Options  General.

 3. Change the name listed in the Username field from your username to that of the person whose 
work you are trying to save.

 4. Either open the central file where the elements are locked or create a local copy while the tem-
porary username is active.

 5. Now you can open and Save to Central, and all the other person’s elements will be available 
to you. 

 6. When you’ve finished, remember to change the temporary user name back to the appropri-
ate name.

As a side note, doing this with a username that is not in use by any team members (for example, 
“Project Admin”) is a good way to lock down gridlines or other elements you don’t want anyone to 
accidentally edit by making the Levels and Grids workset editable and then closing the file without 
relinquishing the workset.

The Bottom Line

Set up a project with worksets.    Knowing how to activate worksharing and set up the proj-
ect file for more than one person at a time is critical in any office environment.

Master It    How do you work in a single Revit file on a project team with more than one 
member in the file at a time?

Understand worksharing basics.    Once you’ve enabled worksharing, you’ll need to under-
stand the dynamics of central and local files to fully leverage working in a worksharing 
environment.

Master It    Once you have enabled worksets to allow for multiple users, what’s the best 
way to implement and use the file?

Manage workflow with worksets.    Saving to and loading from the central file allow you to 
view other team members’ work and allows them to see what changes to the project you have 
added.

Master It    How can you translate the changes you’ve made in your local file to the cen-
tral file on the network? How do you download changes from other team members to 
your local file?

Understand element ownership in worksets.    Editing elements in a central file means you 
have sole ownership over further changes to those elements. Understanding the permissions 
will be critical to working in a team.

Master It    How do you edit an element in the model if someone has already taken per-
mission of it in a worksharing environment?
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Appendix A

The Bottom Line

Chapter 1: Understanding Basic BIM: From the Basics to 
Advanced Realities

Identify the advantages of building information modeling.    The traditional architectural 
design tools you’ve mastered are probably serving you well. New software and a new con-
ceptual model of the building process will inevitably involve some adjustments, so they need 
to provide significant benefits.

Master It    What are some of the advantages of using BIM over traditional CAD tools?

Solution    BIM is a model-based tool that keeps your documents coordinated in a single 
file. As a modeling tool, representational drawings such as plan and section are by-products 
of modeling, not separately managed drawing files. BIM is also well suited for making 
early design decisions and iterating in the design, because you can run analysis early and 
frequently.

Know what to expect from BIM.    A BIM project is based on a single, centralized database 
of information. You need to anticipate how that change can affect workflows based on more 
independent functions.

Master It    How can your work process be affected by the adoption of BIM?

Solution    BIM changes the way projects are managed and worked on. You’ll find that 
teams must communicate on a regular basis when working on a shared BIM model. 
This encourages members of the team to take active responsibility for their parts of the 
model and understand the impact that design changes have on other parts of the model. 
Using BIM also means you have to shed some old habits and expectations and be willing 
to change the way you think about producing construction documents. Moving from a 
drafting-centric workflow to a model-based workflow can be jolting at first, but once you 
take the plunge, you’re unlikely to look back.
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Chapter 2: Revit Fundamentals 

Understand Revit parametric elements.    Although you can find references to objects, fami-
lies, instances, and components, in the end everything is an element.

Master It    What are Revit elements, and how are they managed graphically?

Solution    Anything you can select in the view is a Revit element. By using a fixed cate-
gory structure, Revit lets you quickly identify elements, control their visibility and graph-
ics, and generate reports based on this information. The data is highly structured, but 
you have tremendous liberty when it comes to the representation of that data. 

Work with the Revit user interface.    As in any software application, you need to know 
where all the major components are and what tasks they support.

Master It    How do you change the graphics of a category for all views? What if you need 
to change the graphics for only one view?

Solution    Use the Object Styles dialog box to set up and edit the graphics for all elements 
in the model. This establishes a default behavior for all views. To change the graphics on 
a per-view basis, use the Visibility/Graphic Overrides dialog box, which you can access 
from the context menu when elements are selected or by pressing the VG keyboard short-
cut. The sooner you embrace this concept and start exploring the opportunities it presents, 
the better. If you can’t get your drawing to look just right, chances are you haven’t dug 
deep enough. 

Use the Project Browser.    This UI component provides access to all elements in your model. 
Become accustomed to using it to locate views, families, groups, and links.

Master It    Knowing how to navigate views in Revit is essential to completing work. 
What are some of the ways to open views in Revit?

Solution    You can open views from the Project Browser by double-clicking any view. In 
addition, you can double-click view tag symbols directly (level heads, section heads, el-
evation tags, and callout bubbles) to open the view.

Navigate views and view properties.    Views are also elements. Just like the walls, floors, 
and roofs you add to the model, you’ll also add views. They have properties you should 
become familiar with.

Master It    You need to change the scale of a plan view from 1⁄8” to 1⁄4”. How do you do 
this with Revit?

Solution    Using either the View Properties option on the view’s context menu or the 
view controls at bottom of the view, change the scale. The annotations and hatch patterns 
will update automatically. You can change the scale of any view at any time.

Chapter 3: Know Your Editing Tools

Select, change, and replace elements.    Learning the basic mechanics of the interface is cru-
cial to just about everything you’ll do in Revit.
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Master It    Selecting elements in the model happens all the time. What are some of the 
capabilities that the Revit user interface provides when you select elements?

Solution    Any time an element is selected, you’ll notice that a few things change in the user 
interface. First, the element changes color, indicating that it’s selected. Second, if you select a 
model element, you get temporary dimensions to help you position the element. Third, icons 
appear for graphic controls such as drag grips, check boxes, and flip arrows. And finally, the 
contextual ribbon tabs and sometimes the Options bar updates with element-specific tools. 
All these features help keep the user interface out of your way until you need it.

Edit elements interactively.    The architectural process inevitably involves revision, so be 
sure you know how to make changes on the fly.

Master It    You need to make some major changes to a floor plan, moving the bathroom 
20´ down a corridor. How might you do this with Revit?

Solution    Box-select all the walls, fixtures, and doors that are part of the bathroom. Use 
the Filter tool to make sure you have the right categories selected. Then, select the Move 
tool in the toolbar. Click anywhere in the model, and move the mouse in the direction 
you need to move the bathroom. Type 20 .́ The whole set of elements then moves 20 .́

Use other handy editing tools.    Revit provides a wide range of tools for making changes in 
a project.

Master It    In a section view, you notice that the walls and floors aren’t cleaning up neat-
ly—you’re seeing lines overlap. What tool could you use to try to clean that up?

Solution    For quick join cleanups, use the Join Geometry tool. Activate the tool from 
the Modify tab, and then select the elements you want to join. With each click of the 
mouse, you see the overlapping lines disappear, and your drawings start to clean up 
immediately.

Chapter 4: Setting Up Your Templates and Office Standards

Start a project with a custom template.    Creating a template that incorporates your firm’s 
styles and preferences is an essential first step in putting Revit to work.

Master It    Your firm has some deeply established graphic conventions that were defined 
in AutoCAD. How would you go about matching these graphics and setting up a Revit 
template?

Solution    Using object styles to customize how elements appear in both projection and 
cut, you can get model and annotation categories to match the line weight, color, and pat-
tern of those used in AutoCAD.

Create custom annotation tags.    Styles for annotations, dimensions, and text are all governed 
by office standards, and the Family Editor is your tool for setting up those standards in Revit.

Master It    You need to create dimensions, text, and annotations that match your office 
standards. How do you do this with Revit? 

Solution    Make new types of system families for text and dimensions. With these fami-
lies, you can control font, color, and size. For tags, open an existing tag and customize its 
graphics to suit your needs. Be sure to add parametric labels to make your tags smart and 
associative. This will save you huge amounts of time later.
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Create custom title blocks.    Title blocks are another important element of office standards 
that you can configure in the Family Editor.

Master It    Most offices have several title blocks with lots of information embedded in 
them. How would you add multiple title blocks to your project template file?

Solution    Make your own title blocks as parametric families, and then load them into 
the template using the Load family button on the Insert tab. With smart labels, you need 
to define these only once in the Family Editor; they will adapt to whatever project you 
load the title block into.

Chapter 5: Customizing System Families and Project 
Settings in Your Template

Create new types of system families.    Incorporating common building components in your 
project template is fundamental to using Revit effectively.

Master It    How do you add/remove wall, floor, and roof types to your template?

Solution    Start with an existing template, and draw at least once all the walls, floors, and 
roofs you’re likely to need in your own projects. Then, purge unused wall, floor, and roof 
types from the file using the Purge Unused tool available in the Project Settings panel 
of the Manage tab. That way, all unused types will be removed from the template. If you 
need to add types, duplicate a type, name it, and make changes to properties as needed. 
When you’re done, save your file as a new Revit template (RTE file).

Use type catalogs.    Revit’s type catalogs are an important tool for keeping the types you 
create accessible in a project.

Master It    What are type catalogs used for?

Solution    A type catalog is a tool that lets you easily and quickly create many types 
of a family that have different dimensions and sizes. The type catalog is a text file con-
nected with a Revit family. This text file can store many definitions of family types. It is 
imperative that the type catalog have the same name and be located in the same folder 
as the family for which it defines additional types; otherwise there will be no association 
between them and the type catalog will fail. When you load a family with an associated 
type catalog, you can selectively load types from the catalog.

Customize project settings in your template.    View templates allow you to tailor views 
according to the requirements of a project.

Master It    How would you set up a new view template for plan views where the surface 
pattern of floors is turned off?

Solution    You can turn off categories and patterns and override the graphics for any 
view, and store these settings in a view template so they can be applied to many views. 
First, open the View Templates dialog box by clicking the View Templates button on the 
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View tab and then clicking on the View Template Settings option. Duplicate an existing 
plan-view template type, and give it unique name. Next, click the V/G Overrides Model, 
which takes you to the Visibility/Graphic Overrides dialog box for that view. Scroll down 
to the Floors category, and click the Surface Pattern Override button. Deselect the Visible 
option, and click OK twice to get back to the View Templates dialog box. You can now 
apply this view template to your plan views by right-clicking the view name in the Project 
Browser and using the Apply View Template feature.

Chapter 6: Modeling Principles in Revit I

Understand the basics of modeling with Revit.    Modeling with software is an extension of 
the traditional art of modeling with the hands. Free-form 3D modeling tools are not designed 
with BIM workflows in mind, but it is still possible to import shapes into Revit for down-
stream use. At the same time, Revit provides some basic tools for 3D design, and you should 
familiarize yourself with these.

Master It    Tools such as Alias Design Studio, Rhinoceros, 3ds Max, Maya, SketchUp, and 
AutoCAD 2010 allow you to create free-form shapes with relative ease. How does Revit 
let you take advantage of such shapes?

Solution    In Revit you can import shapes into the project and family environments and 
reuse them intelligently in a parametric setting. You can also create shapes from scratch 
in Revit.

Understand sketch-based design.    Sketch-based design allows you to define some basic 
parameters and shapes in Sketch mode within Revit.

Master it    Revit uses a 2D sketch-based approach to modeling. What modeling elements 
in Revit use this 2D sketch principle to generate their form?

Solution    Every model element in Revit has at least one 2D sketch in it. Even walls, while 
not made initially using a Sketch mode, have a sketch that can be edited. All 3D content is 
composed of combinations of forms that all derive from 2D sketches.

Understand work planes, levels, grids, reference planes, and reference lines.    Using these 
tools gives you the ability to better control your model and your design by applying and con-
trolling parameters.

Master It    In order to sketch a form, the form must reside on a work plane. How do you 
define and visualize the work plane in Revit?

Solution    To see the active work plane in a view, click the Show (work plane) button in 
the Work Plane panel of the Home tab. Right above it is the Set (work plane) tool, which 
allows you to change the work plane by choosing an existing level, or by clicking on an 
existing model face.
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Chapter 7: Modeling Principles in Revit II

Understand the principles of modeling in Revit.    Understanding how to use Revit’s mod-
eling tools is an important part of project documentation. Knowing which modeling tools to 
use when will aid not only in project visualization but also in documentation, scheduling, 
and rendering.

Master It    There are many unique design elements in any project. Know when to use the 
appropriate modeling tools at the right times. What tool in Revit might you use to model 
the following elements?

Reception counter•u	

Entry canopy•u	

A lampshade•u	

Custom furnishings•u	

Solution    While there is no right tool in Revit for a given task, some tend to work better 
than others:

Reception counter: Use the Create tool on the Modeling tab.

Entry canopy: If there is only one, you might use the Create tool or the Family Editor.

Massing study: Use the Massing tab and the mass and void tools there.

Custom furnishings: Use the Family Editor.

Model with five basic forms.    These tools are at the root of practically all form modeling.

Master It    Having learned the basics of Revit’s form-making tools, how would you build 
this faucet designed by Philippe Starck?

Solution    Start a new generic model family. In the family, use revolves, sweeps, and 
blends to create the faucet. In this example you would model the base as a revolve, the 
spout a sweep, and the toggle switch as a blend.

Master It    In some cases, a form uses multiple sketch lines to generate its form. What 
form-making tools in Revit use more than one set of 2D sketches to generate the form?

Solution    Sweeps have a profile sketch and a path sketch. Revolves have a profile sketch 
and an axis line. Blends have two sketches: one for the base and one for the top.
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Combine solids and voids to create complex and intriguing forms.    Revit’s five basic forms 
can be expressed as either positive space (solids) or negative space (voids).

Master It    To make more complex forms, both solids and voids can be used. Think of a 
case where using voids as a subtractive element makes sense.

Solution    If you create an extrusion in plan form, and then need to edit it in elevation, a 
void is a perfect match. With the void, you can carve the top of the extrusion to give it a 
unique shape.

Chapter 8: Concept Massing Studies

Understand massing workflows.    Using generic forms, you can create early conceptual 
models and then use the mass to create the walls, floors, and roofs.

Master It    You need to explore a design idea early on, in 3D, using abstract forms. How 
would you do this with Revit?

Solution    Revit lets you import a site DWG file and begin building a 3D massing study 
of the surroundings using the lines from the CAD import. Then, using the massing tools, 
you can model your conceptual composition. Using design options, you can make a few 
different proposals. With mass and floor schedules, you can measure what you’ve done 
and test against the local regulations as well as program requirements. 

Start a conceptual massing study.    In the project environment, you can make massing 
forms at any time. For generic forms that might appear in multiple projects, consider using 
the Family Editor and creating mass families.

Master It    You’ve imported a 2D site plan, and now you need to start building a massing 
study model in the project. How would you approach this with Revit?

Solution    Once a final design is selected, you can use the Building Maker concept to 
quickly turn the mass model into a BIM model that contains walls, floors, roofs, and other 
architectural elements. In the early stage of this conversion, you can keep the dependency 
with the mass model so that if you decide to make changes you can use the Remake func-
tionality to update the converted building accordingly. The idea is simple—you move 
from mass to a final building seamlessly, without data loss.

Understand form making and rationalization.    You can make many types of form using 
Revit’s form-making tools. You can then rationalize your form using the Divide Surface 
tool. Get familiar with how to go about creating forms, as it’s different from in the standard 
Family Editor.

Master It    You have made a form and want to edit it further. What tools can you use to 
make changes to the form?

Solution    When a form is selected, check the Modify Form panel on the Ribbon. From 
here you can use the X-Ray tool to see into your form and make edits. Also experiment 
with using the Add Edge and Add Profile tools.
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Chapter 9: From Conceptual Mass to a Real Building

Make conceptual designs and early studies in Revit.    You can use massing studies to vali-
date a design against the program requirements.

Master It    Conceptual modeling is used early in the design process to explore the build-
ing shape and building program. How do you approach schematic design using Revit 
and perform feasibility studies?

Solution    Revit lets you import a site DWG file and begin building a 3D massing study 
of the surroundings using the lines from the CAD import. Then, using the in-place mass-
ing tools, you can model your conceptual composition. Using design options, you can 
make a few different proposals. With mass and floor schedules, you can measure what 
you’ve done and test the fit to the local regulations as well as the program. 

Build a real building out of a 3D concept mass.    Moving from massing to actual building 
components is easily done with Revit.

Master It    You have the basic massing nailed down, and now you need to study more 
details such as wall and window fenestrations. How do you approach this with Revit?

Solution    Load your mass into a project and use the Model by Face tools to start apply-
ing standard components to your model, such as walls, floors, and roofs.

Use imported geometry from other applications for massing.    Make your own conceptual 
massing forms using the new Revit conceptual design tools. 

Master It    How can you reuse conceptual models created in other modeling applications 
and turn them into a measurable and documentable building in Revit?

Solution    Revit allows you to import models from AutoCAD, SketchUp, Rhino, Maya, 
3ds Max, and Inventor. You import early concept studies into a mass element and then 
apply real components (walls, roofs, floors, and so on) to its faces.

Use smart relationships between the building mass and the underlying mass.    Use the 
update tools to re-sync building elements with changes to the underlying mass surfaces. 
With Revit, you can change the mass and know that most objects can be recomputed to 
match the form.

Master It    Change your massing model to explore design alternatives.

Solution    Edit your mass in place or as loadable family and then update your model 
with new shape. Update the Model by Face objects to match the new design. Look to the 
contextual tab for tools specific to this workflow.

Chapter 10: Working with Design Options

Use Revit design options.    Design options provide a means to maintain two or more alter-
native designs for the same project or component.

Master It    What are design options in Revit?

Solution    Design options allow you to explore alternatives to your current design di-
rection. By creating option sets from the Design Options dialog box, you can make an 
unlimited number of variations to your design theme. These can be controlled with the 
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Visibility/Graphic Overrides dialog box, which lets you see the options in any number of 
view types: plans, elevations, sections, perspectives, schedules, and so on.

Decide on a design solution.    The end result of exploring multiple options is to choose one 
alternative and implement that choice.

Master It    You’ve explored a number of design options for an entry scheme. Your client 
has selected one, and you need to incorporate it into the rest of the model and remove the 
unwanted alternates. 

Solution    In the Design Options dialog box, select the desired option and click the 
Make Primary button. Doing so pushes that option into all your views in the project as 
the default option. Now, select the option set and click the Accept Primary button. Each 
of your other unwanted options is eliminated, and your primary option is incorporated 
into the design.

Use design options with parametric design.    Making quantitative differences visible is an 
essential part of presenting multiple alternatives.

Master It    You need to look at some seating layout options for an auditorium space 
based on different-sized seating and show the seating counts.

Solution    Using design options and a Revit auditorium seat family, you can create two 
design options for the layout: one for seating 20˝ wide and one for seating 24˝ wide. Once 
these are laid out in their respective design options, you can create a schedule to count 
the seating based on size. By creating a seating schedule and then duplicating it, you can 
change the Visibility/Graphics Overrides options of the second schedule to count the 
second design option. In the following views, the two schemes have 276 and 234 seats, 
respectively.
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Chapter 11: Creating Custom 3D Content

Model parametric 3D families.    When you’re making a new family, consider how it will be 
used in the model, and choose an appropriate template.

Master It    You found a ceiling-mounted lighting fixture that you want to use in your 
existing project, but you can’t find a Revit family for it in any libraries or online commu-
nities. How would you start?

Solution    Knowing that you need to build a lighting fixture from scratch, begin by 
opening the Lighting Fixture ceiling based.rft template file. This will ensure that 
the family is hosted by ceilings and will thus move and stay connected with the ceiling in 
which the light is placed. 

Look carefully at how the fixture is built, and consider what Revit form-making tools 
are best suited for building it. Proceed to build the family, and assign it materials and 
any dimensional parameters using reference planes and labeled dimensions. When you 
think you’re done, save the file with a unique name, load it into your project, and place 
it. Remember, if you need to make edits, the process is simple: select the family, and then 
click the Edit Family button in the Family panel of the contextual Modify tab. You’ll be 
taken directly into the Family Editor, where you can tweak the design. Clicking the Load 
into Project button reloads the family into your project and updates all instances of the 
type with your changes. 

Nest one family into another.    The ability to nest families in other families lets you create 
content that’s easier to manage and improves your workflow.

Master It    Building components are often composed of a series of subcomponents that 
form an overall assembly. Think of some common examples and what strategies you 
could use to build such content in Revit.

Solution    Consider an office workstation. Typically, a workstation is made of modular 
components: the desk surface, vertical partitions, file cabinets, bookshelves, and a chair. 
You could load these elements into a project and manually manage all the parts, maybe 
even using groups to do so. A more efficient and easier-to-manage method is to nest 
various parts into one family. Starting with a blank Furniture Systems family template, 
you could load the desk, partitions, cabinets, and chair into one family. By making each 
nested family a shared family, you can tag and schedule all the elements.

Build relationships between parameters with formulas.    Create smart connections 
between geometry and dimensions to create efficient and parametric content.

Master It    You can use dimensional relationships to tie the size of one object to the size 
of another. How do you do this in the context of a family?

Solution    Using the Family Types dialog box, you can add new parameters and then cre-
ate formulas that tie the value of one or more parameters to any other parameter. Using 
a conventional mathematical formula, you can create families that are extremely flexible 
and dynamic.
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Chapter 12: Extended Modeling Techniques—Walls

Use advanced modeling techniques for standard walls.    Many design situations require 
more than just the basic wall features; learn to use the more advanced Revit tools.

Master It    A design calls for a horizontal soldier course in a brick wall every 12˝ on the 
façade. Using Revit, how would you build this into a wall element?

Solution    Create a new wall type and add integrated wall sweeps into the wall defini-
tion. Each wall sweep can have a material assigned to it, so you just need to define the 
correct size and materials to the sweep to get it to look correct. Place several instances  
at 12˝ intervals. You can change the preview sample size of the wall to be any height in 
order to add additional sweeps above the default 20 .̋

Use advanced modeling techniques to create stacked walls.    Walls along a building 
façade usually have different construction layers from foundations to the top of the build-
ing. Stacked walls allow for a single wall to be constructed with varying wall types along its 
height.

Master It    You have a building project where you are still experimenting with a number 
of floors but have already defined the wall types for the foundation, typical floor, and the 
attic and have combined them in a stacked wall type. How do you define the stacked wall 
so that it will accommodate middle floors with varying heights?

Solution    Stacked wall types allow for one of the walls in the stacked wall to have a 
variable height. In this case, set the middle wall type as a variable height layer. Thus you 
will assure that the stacked wall updates correctly when floor to floor heights change.

Use advanced modeling techniques for curtain walls.    Curtain walls find their way into 
many architectural projects and designs. Knowing how to manipulate curtain walls in Revit 
is a key piece of the software for many design solutions.

Master It    You’ve got to add a doorway to a storefront façade you’ve made. How would 
you go about doing this?

Solution    Load a curtain wall door panel and then swap out a glazed panel with the 
door. Remember—you cannot use standard door families with curtain walls.

Chapter 13: Extended Modeling Techniques—Roofs and 
Floors

Understand the various roof creation methods.    There are multiple methods for creating 
roof forms in Revit, and you should become familiar with each.

Master it    When would you use a Roof by Extrusion method?

Solution    The Roof by Extrusion method for creating roofs is great for barrel vaults, 
sawtooths, or any roof with an arc profile.
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Create all kinds of roofs.    Roofs are an integral part of any building. Knowing how to cre-
ate them in a variety of shapes and sizes is critical to the success of a project.

Master It    In the early design phases of a project, you are exploring a variety of roof 
forms for your building. Create the base building form and explore different roof options 
and shapes. How would you go about exploring a variety of roof shapes?

Solution    Create a roof using the Roof by Footprint tool. Then by editing the roof, modi-
fy the slope on the various roof edges (at times setting some of the options to 0) to explore 
different roof shapes.

Work with advanced roof and floor shape editing.    Roofs are another seemingly simple 
element that presents architectural challenges, and Revit has tools for them.

Master It    You are working on a flat roof retail project, but the roof is not really flat and 
will need to drain. Using Revit roof tools, how would you go about modeling this?

Solution    Start by creating a flat roof, and then select it. Use the shape modification 
tools to add ridges and low points to the roof. By selecting points, you will get temporary 
dimension controls to accurately set the height and get correct slopes for drainage.

Chapter 14: Extended Modeling Techniques—
Railing and Fences

Work with railings and fences.    Railings are a bread-and-butter architectural element 
whose design can be streamlined with Revit.

Master It    You’ve found some nice-looking railing panels and balusters while scouring 
the Web for interesting rail designs. How do you go about building the railing in Revit?

Solution    Start by figuring out what is baluster and what is rail. For the rails, you’ll need 
to make custom profile families and use those when you define the rails in the system. 
For the balusters, use the baluster family templates as a starting point and break the sys-
tem down into Revit-centric constructs: extrusions, blends, revolves, and sweeps. Once 
you have the baluster made, load it into your project, create a new railing type, set up the 
baluster spacing, and establish the rail pattern.

Use balusters and rails to construct railings.    A railing is a complex set of subelements that 
Revit lets you organize and control with rules and settings.

Master It    You want to make a railing where the balusters are glass panels with fixed 
width. You wish to make a railing that contains the maximum number of those panels 
and you wish them to be spread symmetrically. How do you do that?

Solution    In the Edit Baluster placement dialog box, under Main Pattern, set Justify to 
Center and Excess Length Fill to None. Justify Center will assure spreading a full number 
of patterns from the center toward the two ends of the railing, and the Excess Length set 
to None will assure that no pattern is truncated and only a full number of patterns find 
their place in the length of the railing.

56491bapp01.indd   720 6/2/09   2:44:01 PM



ChapTer 15: preSenTaTion TeChniqUeS for pLanS, SeCTionS, and eLevaTionS | 721

Adjust additional settings.    Stair railing details are particularly difficult to design and plan 
at landings. Revit helps you fine-tune the details using additional settings.

Master It    After designing the stair railing, you notice that there is a gap between the 
rails following the stair flight and the horizontal rail on the landing. What options do you 
have to resolve this situation?

Solution    Using the options under the Angled joints in the Type Properties dialog box of 
the railing, you can choose to add horizontal/vertical connectors that fill the gap or leave 
the gap as is by choosing No connector.

Chapter 15: Presentation Techniques for Plans, Sections, 
and Elevations

Use shadows for presentation purposes.    Presenting your design to stakeholders is a criti-
cal part of your workflow and allows you to sell your ideas. Having tools that make this pro-
cess easier without compromising your creativity is essential to being successful.

Master It    You’ve been asked to show the effect of your building’s shadow on its sur-
rounding site during the winter solstice. How would you do this with Revit?

Solution    Use a site-plan view, and enable shadows from the View Control bar. Set the 
Sun and Shadows Settings to the correct date, time, and place. Remember to set the cor-
rect place, because this affects how shadows are calculated.

Create presentation-quality plans and sections.    Creating clean, easy-to-read plan and sec-
tion views using Revit is a huge timesaver.

Master It    Your latest design is all the rage, and you’ve been asked to publish the plans 
and sections in a magazine. How do you make these?

Solution    Turn off all the clutter in the view by selecting unwanted categories and ele-
ments and hiding them in the view. Then, give the walls, columns, roof, and floors a bold 
solid fill hatch override when cut. This will make the drawings jump off the printed page.

Create elevation drawings that convey depth.    Two-dimensional drawings can be hard 
for clients to read, which makes shadows a useful mechanism for illustrating recesses and 
projections.

Master It    You need to give your elevation view more variation in line weight to convey 
depth beyond the default line styles established in the Object Styles dialog box. How do 
you do this?

Solution    Use the Linework tool to apply heavier lines to element edges in the fore-
ground. Use element overrides to apply halftone or thin line weights to elements in the 
background.

56491bapp01.indd   721 6/2/09   2:44:01 PM



722 | Appendix A The BoTTom Line

Chapter 16: Presenting Perspective Views

Create perspective views.    Design visualization is a key benefit to using Revit as a docu-
mentation solution. Being able to snap quick perspectives of your spaces and building forms 
can be critical to making good design decisions.

Master It    Create a new perspective view showcasing a critical design feature. Use the 
Rendering dialog, lighting, and the materials dialog to complete the rendering.

Solution    Using the Camera tool on the View tab, you can quickly create a perspective 
from a view to describe the design intent of the project. Using the tools described in this 
chapter, create a quick rendering to analyze the design further.

Create photorealistic renderings.    You know those signs that are put up at a site before and 
during construction—the ones with the nice rendering showing the final product? Well, you 
can generate those directly in Revit!

Master It    You’ve been asked to produce an exterior rendering of a building. Can you do 
this in Revit? Can you tweak the results in Photoshop?

Solution    Set up some dramatic exterior camera shots, and assign photorealistic materi-
als supplied in the new Render Appearance Library. Add RPC entourage such as trees, 
cars, and people. Render the view, and then export the image so it can be touched up in 
Photoshop. Send the image to the print shop, and get the rendering up on the billboard!

Create animated walkthroughs.    Creating animated walkthroughs is an excellent way 
to visualize the spaces within the project, as walkthroughs are more dynamic than still 
renderings. 

Master It    You want to create a compelling animation showing an entry approach to the 
building. How would you do that with Revit?

Solution    Start with a plan view and choose the Walkthrough tool from the View tab. Draw 
your path, and then adjust the camera at each keyframe to get the desired look and feel.

Export the 3D model for use in other applications.    Revit is an excellent application, but 
a variety of other tools are available that you might want to use for rendering, modeling, or 
other BIM features such as 3D printing.

Master It    You’ve modeled your project in Revit and assigned materials, and now want 
to make an animation sequence with 3ds Max. What should you do?

Solution    Use the new option to export the model to FBX. This will create a file that can 
be opened directly with 3ds Max 2009 or later, where you can take advantage of anima-
tion tools. To do so, go to the Application Menu, and choose Export  FBX.

Chapter 17: Fine-Tuning Your Preliminary Design

Quantify your preliminary designs.    Once your plans are established, create your own 
area plans to dynamically track changes in the project.

Master It    Establish your preliminary design, and then create area plans so you can keep 
up to date with space sizes, allocations, and your project program.

Solution    Use the tools for figuring gross area and rentable area to establish these base-
line plans.
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Create schedules.    One of the benefits of Revit is the ability to manage not only your draw-
ings, but also other information about the project. Create schedules for your project templates 
to manage the materials within the project.

Master It    Schedules have a multitude of uses and value at all levels of the project. 
Explore a variety of schedules to optimize your workflow and maximize what you can 
get from the model.

Solution    Here is a list of schedules you might try:

Wall schedules showing length and area by wall type•u	

Multicategory schedules showing a full list of all the families in a project•u	

Material schedules—for example, a schedule for reporting the cubic volume of con-•u	

crete in the project

Auditorium seating schedules•u	

Door schedules•u	

Parking stall schedules for parking counts by type (stalls, accessible stalls, and so on)•u	

Use schedules for preliminary cost estimates.    Create a schedule that tracks project costs 
based on an estimated cost per square foot.

Master It    Many developers and facilities managers use BOMA calculations for figur-
ing rentable area, gross area, and R/U (rentable/usable) ratios. Establishing area plans 
and schedules can help you find these numbers much quicker than a legacy CAD system 
would have allowed.

Solution    Establish the schedules as part of your default templates, and as you create 
your area plans, the schedules will dynamically fill. Also, become familiar with the typi-
cal methods of calculating space. These are some of the formulas you can also incorporate 
in your default templates:

building rentable area + pro rata building common area = rentable area

gross rentable area / usable area = R/U ratio (load factor)

usable area  (1 + load) = rentable area

Chapter 18: Evaluating Your Preliminary Design: 
Sustainability

Incorporate a sustainable approach from the very beginning of project development.    
Sustainability is quickly becoming a core approach to any design. Learn to leverage the Revit 
model for a more holistic approach to sustainability.

Master It    BIM is also a computational database that can report information about the 
virtual building. The important thing about a sustainable approach is to know which 
questions to ask and to ask them at the right time. What is a strategy for doing this?
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Solution    Come up with your sustainable goals early on in the project process and re-
visit them regularly to make sure you stay on track.

Use Revit to create sun studies.    Understanding the sun’s effect on a building is paramount 
to sustainable design.

Master It    How can you use the tools within Revit to produce still and animated solar 
studies from interior and exterior views in order to understand shading and the sun’s 
effect on the building and space?

Solution    Use the Graphic Display Options dialog box to set the global location of the 
project. Next, establish a time of day to view the effects of the sun. Create key interior and 
exterior views of the project and apply these sun settings to the new views. To see the 
effects of the sun at that time throughout the year, animate the solar study for each week 
throughout the year.

Track recycled materials and other sustainability strategies using schedules.    Keeping 
track of project goals is an important part of any project process. By using the schedules and 
other tools in Revit, you can also track key sustainability goals.

Master It    Tracking recycled material usage is key to LEED credits and sustainability. 
Create a material schedule that tracks recycled content volume for concrete.

Solution    Create a schedule for the concrete in the building. Using a custom calculated 
field, apply your percentage of recycled content by building a formula to multiply the 
percentage of recycled content by the volume of concrete in the model. As you build and 
refine the design and the model, this value will dynamically update.

Analyze daylighting.    Understanding daylighting and its effects within the built environ-
ment is a critical part of design and helps with LEED credit 8.1.

Master It    Make your designs more sustainable by using the model geometry for day-
lighting analysis

Solution    Set the model up from the beginning of the design process to have the proper 
reflectivity for your surfaces. Adding these values to your materials helps ensure more 
accurate daylighting results.

Chapter 19: Annotating Your Model

Annotate views.    Room elements are highly useful tools for a number of different applica-
tions in a set of documents. Learning how to use them and tag them will help you find areas, 
create finish schedules, and identify spaces.

Master It    Once the model has been largely built, you need to start adding information 
about rooms and finishes. What tools would you use?

Solution    Once the rooms in the project are roughly defined by walls, you can use the 
Room tool to add room elements to your project. After these are defined, use the schedule 
key in combination with a room finish schedule to quickly create finish values for each 
room that are easy to control and define.
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Use schedule keys.    Adding information to the room element is only part of the documenta-
tion and design process. Knowing how to schedule that information allows you to communi-
cate effectively with owners and contractors.

Master It    Tags are used to report information about an element. How do tags work in 
Revit so that they always report accurate and consistent information about the elements 
they tag?

Solution    Elements defined in Revit such as walls, doors, and rooms all have param-
eters. These parameters can be used to drive information into tags by adding labels to 
the tag families. If you change the parameter value, the tag will update automatically. 
Likewise, by editing the value in the tag, you are affecting the element.

Leverage tags.    Revit supplies you with three ways to annotate your model and the project. 
Knowing when to use each and planning for them early in the documentation phase saves 
time and frustration.

Master It    It is important to understand the relationships between elements and materi-
als in Revit early. How does this help streamline the process of keynoting your project 
when you reach the documentation phase?

Solution    If this is your first project in Revit, discuss the keynoting strategy used within 
your office and see how easily that transitions into Revit. Set up your keynotes and 
schedules for those notes long before you need to document the project. This will ensure 
that when the time comes to begin laying out your sheets, you can do it with a minimum 
amount of disruption to your workflow.

If this is not your first project in Revit, begin embedding notes into your project template, 
building from the experiences of past projects.

Understand shared parameters.    Revit lets its users add as many custom parameters to an 
element as are needed. When those added parameters need to be visible both in schedules as 
well as in the elements tags, they need to be created as Shared parameters.

Master It    You added a custom parameter to your door and window elements and wish 
to schedule and tag it such that each window or door tag displays the information about 
the hardware set. The schedule works well, but your tags seem to be unable to find the 
hardware set parameter. What is wrong?

Solution    To be able to display a custom parameter in a tag, that parameter needs to be 
created as a shared parameter. Create a shared parameter as a .txt file, and assign it to 
the tag family as well as in the project environment (to the Door and Window category) 
to achieve the desired result.

Add text and keynotes.    No set of drawings is complete without keynotes or text notes. 
Understand how to create and modify them for a complete set of documents.

Master It    You will need to add notes in every stage of design to communicate your 
design intent on a project. How do you create and modify the notes to ensure accuracy 
throughout all the sheets in the set?

Solution    Use the Keynote tool on the Annotate tab to insert element, material, and user 
notes. As these notes are all tied to a single file and are not modifiable within the project, 
they will always be identical. To modify the notes, simply use the linked text file found 
under the Tag flyout and choose Keynote Settings.
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Chapter 20: Developing the Design with Smart Workflows

Work with repetitive elements.    Many projects have repetitive elements and can benefit by 
using groups and links efficiently.

Master It    Think of a scenario in your own practice where elements repeat and how you 
might use Revit groups to solve the problem.

Solution    A hotel room in a multistory tower is a good example of where groups could 
come in handy. You can draw the walls, add the bathroom and all the fixtures for one 
unit, and then group them in what will be a typical hotel room. Once they’re grouped, 
you can place instances of the group throughout the model to fill out the design. From 
there on out, any change to any group will propagate to the other group instances.

Understand the use of groups.    Groups are a powerful design tool. Anyone working with 
repetitive elements needs to understand how they work.

Master It    Describe a fundamental benefit of using groups.

Solution    When you make a group of elements and then duplicate it many times, it is 
important to maintain consistent and predictable results. Using groups, you are guaran-
teed that a change to one instance will propagate to all other instances in the model. At 
the same time, Revit recognizes that some group instances might have to be slightly dif-
ferent from the rest and that it must be flexible enough to support slight differences with-
out the necessity of creating a separate new group.

Understand the principles of links.    Links are Revit’s second major tool for repetitive ele-
ments, avoiding the file size and performance issues associated with groups.

Master It    Using a link paradigm means that the BIM model now depends on links to 
external files. Even so, the links can be scheduled, dimensioned to, and graphically al-
tered. Despite that, there are still some limitations. What are they?

Solution    One of the major limitations is how walls in a linked file interact with walls 
in the host file. For example, when a Revit link is used, none of the walls in the link will 
clean up with the host walls and rooms will not be calculated. Note that you can make 
the walls of a linked file room bounding using its type properties.

Decide whether to use groups, links, or both.    Knowing when to link a file can improve 
file performance and provides an easy way to operate on large clusters of building data. You 
can hide links, remove them, and work on them independently. Knowing when to use groups 
can help replicate repeated elements quickly. Knowing how and when to use both groups 
and links helps speed the documentation process.

Master It    Know that links can reduce the overall file size and thus improve perfor-
mance when working in Revit; imagine a scenario in which you would most certainly 
want to employ links over groups.

Solution    A campus layout master plan would be a great candidate for using links. By 
building a master site file and building each campus building as a separate file, you could 
then link them all together in the master file and have good performance in each of the 
separate files. This also keeps levels and grids from neighboring buildings from interfer-
ing with your workflow.
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Chapter 21: Moving from Design to Detailed Documentation

Create drafting views.    Not every drawing or view in Revit is created with model elements. 
Some of the views on sheets will be made solely with 2D drafting views. Knowing how to 
create and use these views is critical to any documentation package.

Master It    Keeping views hyperlinked together is a key benefit to using Revit. How do 
you draw simple, 2D details in Revit but still keep them parametrically linked to sheets?

Solution    By creating drafting views, you can use detail lines (found on the Drafting 
tab) to draft 2D details in from within Revit. These drafting views can then be placed on 
sheets, keeping all the same parametric values maintained by any other view created in 
Revit. You can also reference these drafting views with the Callout tool.

Import and link CAD details.    Even if you’ve been using Revit for years, you will need 
to import 2D geometry from an old library of standards or manufacturer drawings. 
Understanding how to do this effectively will keep you from having performance issues with 
your model.

Master It    Your office has a huge repository of standard details. How do you reuse de-
tails drawn in CAD in a Revit project?

Solution    Make sure the CAD detail is free of extraneous information and then import it 
into a drafting view at a 1:1 scale. Reset the scale to the proper scale of the view and place 
the new drafting view in the appropriate sheet. When forming a new detail callout from 
a plan or section, check the box Reference Other View on the Options bar and select the 
CAD detail from the list. This will give the new detail a SIM (similar) annotation.

Create 2D detail components.    Detail components can be used again and again within a 
model to graphically show in 2D different typical building components. Mastering these will 
result in enhanced productivity when you work on a project.

Master It    Detailing is a process of adding more granular layers of information and 
graphics to the model and view. What tools would you use to add 2D detail?

Solution    Create detail components for content that can be reused in other views. Add 
as much detail to the component as is applicable, including nesting components within 
one another. Use masking regions (also referred to as whiteout) to cover unneeded model 
geometry, taking care to balance proper modeling techniques with efficiency and produc-
tivity. Use filled regions to add additional levels of detail and materiality to the view. Use 
repeating details in lieu of copying or arraying simple 2D elements. Finish the detail by 
drafting necessary areas with detail lines.

Chapter 22: Advanced Detailing Techniques

Create 3D details.    3D axonometric details are a great way to demonstrate more complex 
assemblies and conditions in any document set. Knowing how to create them in Revit will 
expand the ways in which you can detail.

Master It    Use a 3D axonometric detail to demonstrate constructability in a unique as-
sembly condition.
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Solution    Locate the new detail in a wall section or enlarged plan. Navigate to the de-
fault 3D view, and using the Orient to View option in the view cube right-click menu, 
orient the 3D view to match the desired detail. By orbiting the orientated view, you can 
begin adding annotations and dimensions to describe the construction of the assembly.

Add detail components to 3D families.    Adding detail components to 3D families can save 
time by embedding the linework of a detail within the family itself and making it instantly 
available throughout all the locations that family is placed.

Master It    Create a detail by embedding it into a family so it can be expressed by simply 
modifying the detail level of a view.

Solution    Open the family in the Family Editor. By adding detail components to the 
family, you can begin building the corresponding detail (flashing, blocking, sealant, trim, 
etc.). Next, select these elements and modify their visibility to make them viewable only 
in specific conditions (in this case, the fine level of detail). Reinserting the family into the 
project allows you to control what is displayed in any view by modifying the view detail 
in each view.

Reuse details from other Revit projects.    There are times when details are common 
between projects. Knowing how to use details from other Revit projects will cut down on 
your documentation time.

Master It    Use details you created in your other Revit projects.

Solution    After finishing the detail or project, from the Application Menu choose  
Save As  Library  Views to select a variety of views and export them to your project  
or office standards library.

Chapter 23: Tracking Changes in Your Model

Add revisions to your project.    You need the ability to track changes in your design 
after sheets have been issued. Adding revisions to a drawing is an inevitable part of your 
workflow.

Master It    Add revisions to your project that automatically get tracked on your sheet.

Solution    Use the Sheet Issues/Revisions dialog box (choose  the Manage tab, then use 
Settings  Revisions) to add, edit, and manage revisions. Be sure to set the numbering 
scheme to By Sheet.

Understand BIM and supplemental drawings.    Making an actual revision to a construction 
document involves adding graphics and coordinating the clouds with revisions.

Master It    You need to cloud a design change. How would you do this using Revit?

Solution    Draw clouds with the Revision Cloud tool. Next, tag your revision clouds with 
parametric tags. In turn, your title block will also be parametrically tied to each revision 
placed on the sheet.

Use Autodesk Design Review.    You’ll often need to share your design with people who do 
not have Revit, so that your design can be examined and marked up.
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Master It    How can you export your designs in a lightweight file format?

Solution    Export your sheets to Autodesk Design Review by opening the Application 
Menu, and choosing Export  DWF. 

Chapter 24: Worksharing

Set up a project with worksets.    Knowing how to activate worksharing and set up the proj-
ect file for more than one person at a time is critical in any office environment.

Master It    How do you work in a single Revit file on a project team with more than one 
member in the file at a time?

Solution    Worksharing allows for multiple users in a Revit environment. Understanding 
and using worksharing is a vital part of any large-scale project where you will have 
more than one person doing the drawing. Worksharing will be the most successful when 
implemented in an organized, well-thought-out division of model assemblies. To set up 
worksets, first enable worksharing (Collaborate tab  Worksets). Then save the file as a 
central file and inform team members to make their own local files.

Understand worksharing basics.    Once you’ve enabled worksharing, you’ll need to under-
stand the dynamics of central and local files to fully leverage working in a worksharing 
environment.

Master It    Once you have enabled worksets to allow for multiple users, what’s the best 
way to implement and use the file?

Solution    Set up a central file on your network. Each of your users makes new, local files 
from the central file on their local drives and works directly in these copies. These files 
are smart enough to be able to manage changes between all the members of the project 
team while updating the central file.

Manage workflow with worksets.    Saving to and loading from the central file allow you to 
view other team members’ work and allows them to see what changes to the project you have 
added.

Master It    How can you translate the changes you’ve made in your local file to the cen-
tral file on the network? How do you download changes from other team members to 
your local file?

Solution    Use the Save to Central command from the Application Menu. This will copy 
all of your changes up to the networked central file and download their changes to your 
local file. If you are simply looking for changes others have made to update your local copy 
(without posting your own changes), you can use the Reload Latest command located in 
the Synchronize panel of the Collaborate tab.

Understand element ownership in worksets.    Editing elements in a central file means you 
have sole ownership over further changes to those elements. Understanding the permissions 
will be critical to working in a team.
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Master It    How do you edit an element in the model if someone has already taken per-
mission of it in a worksharing environment?

Solution    By simply trying to edit the element, you can request permission for the object 
from another user on the team if permission is not readily available. They can similarly 
grant or deny you permission for any element they own by using the Editing Requests 
button on the Collaborate tab.
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Tips and Troubleshooting

This appendix provides tips and tricks about how to keep your project file running smoothly. 
Listed here are some pointers to keep you from getting into trouble, along with some solutions in 
case you do.

Optimizing Performance
It should make sense that a small file on a good network runs the quickest. “Typical” file sizes 
can vary widely. We’ve seen file sizes range from 30MB to 200MB. Much of that variation depends 
on the level of detail you’ve put into your model, the presence of imported files (like other 3D files 
or CAD files), and the overall complexity of your model. Your hardware configuration is also a 
factor. There are a number of things you can do to be proactive about keeping your model per-
formance optimized. Here are a few we recommend:

Use the 3GB switch.    Revit now supports Microsoft XP’s 3GB switch. Use of this setting will 
give your machine more RAM to draw from before it goes to virtual memory. Windows XP 
allows any given application access to only 2GB of RAM at a given time; if the application 
needs more, it gets the rest from virtual memory. Microsoft’s switch (which is available in XP 
Service Pack 2) allows you to change that 2GB limit to 3GB. To find out how to do this, visit 
www.autodesk.com/support, choose Revit Building from the menu, and read the support  article 
on enabling the 3GB switch. Of course, you need more than 2GB of RAM in your workstation 
for this switch to do you any good.

More information on RAM and virtual memory can be found at the Autodesk knowledge 
website. Visit this site for details:

http://usa.autodesk.com/adsk/servlet/ps/ 
item?siteID=123112&id=8018971&linkID=9243099

As another option, Revit supports 64-bit operating systems like Windows XP 64-bit and 
Windows Vista. This allows you to tap into even more RAM and go well beyond 3GB. Keep 
in mind, on a 64 bit OS, two gigs are used by the OS itself (rather than one gig in a 32 bit 
OS), so you will need more than 4 GB of RAM before you will see any difference in RAM 
allocation.
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Don’t explode imported CAD files.    A CAD file imported into Revit is a collection of 
objects that is managed as a single entity. If you explode a CAD file, the single object immedi-
ately becomes many—and becomes that much more data that Revit needs to track and coor-
dinate. If you’re unfortunate enough to explode a hatch pattern, one object becomes many 
thousands. If you’re importing DWG files, leave them unexploded as much as possible. If 
you need to hide lines, use the Visibility/Graphic Overrides dialog box to turn layers on and 
off. Explode only when you need to change the imported geometry, and start with a partial 
explode. Figure B.1 shows the tools available in the Import Instance panel of the contextual 
Modify tab when you select an imported or linked DWG file. Also note that lines smaller 
than 1⁄32˝ are not retained with CAD files are exploded. This can result in unusable imports.

Another option is to change the DWG file directly in CAD by deleting lines and layers you 
don’t need, then reimporting the file into Revit.

As a final option, if you really feel like you need to edit the linework in Revit directly, import 
your CAD file into a 2D Detail Component family, edit the linework there, and import that 
Detail Component into your project file. This is a great way to keep the CAD file editable but 
also keep the number of objects in your project file minimized.

Delete or unload unused DWGs.    Often, you import a DWG as a reference, but then you 
don’t need it later in the project lifecycle. It’s easy to forget, but if you no longer need an 
import, go ahead and delete it by selecting it in the view, right-clicking it, and choosing Select 
All Instances from the context menu, and then delete it. This will delete the import in all 
views.

Close unused views.    Keeping the number of open views to a minimum helps the model’s 
performance. Choose the View tab  Close Hidden Windows often (Figure B.2), because 
it’s easy to have many views open at once, even if you’re concentrating on only a few views. 
Once you reduce your open views to just two or three, you can take advantage of the view 
switch toggle: press Ctrl+Tab, and you’ll cycle through your open views. Press Ctrl+Shift+Tab 
to reverse the view cycle.

Turn on volume computation only when necessary.    You can turn on room volume cal-
culation by choosing the Manage tab  Area and Volume Computations. Check Areas and 

Figure B.1 
Explode options 
for an imported 
CAD file.

Figure B.2 
Close hidden win-
dows that you’re 
not using.

56491bapp02.indd   732 6/2/09   2:43:56 PM



using besT pracTices | 733

Volumes under Volume Computations (shown in Figure B.3) only if you need room tags or 
a schedule to display volumetric information. Don’t forget to switch off this option after you 
print or view the information. Otherwise, the volumes will recalculate each time you edit 
something in the model, and this can affect the overall performance of your file dramatically.

Using Best Practices
The following best practices will not only help you keep your project files running smoothly but 
will also keep frustration levels with poorly performing files low.

Workshared files: Make a new local copy once a week.    Sometimes in a workshared envi-
ronment, your local copy can begin to perform poorly but others on your team don’t share 
the same problems. If this is the case, we recommend that you make a new local file. Local 
files can become problematic because of any of the things that commonly cause issues with 
large files in a networked environment. As a general practice, it’s a good idea to make a new 
local copy once a week.

Use graphics card options to improve drawing performance.    In the Application Options  
Graphics tab, make sure you have both Use OpenGL Hardware Acceleration and Use Overlay 
Planes to Improve Display Performance checked (Figure B.4). Deselecting the Use Overlay Planes 
check box can cause significant degradation in performance—we recommended you never 
deselect this option.

Import or link DWGs in one view only.    Importing in all views can seriously affect perfor-
mance. Figure B.5 shows the Link (Instead of Import) check box in the Import or Link dialog 
box. Linking is better than importing if you don’t need to edit the geometry. 

Watch out for imported geometry.    Although Revit has the ability to import files from a 
number of other sources, you should exercise caution when doing so. If you’re importing a 
60MB NURBS-based Rhino file into your model, expect your Revit model to grow in size and 

Figure B.3 
Do not compute 
room volumes 
unless necessary.
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react a bit slower than it did before the import. Delete unneeded imports or convert them to 
Revit content to reduce file size and improve overall performance.

Purge unused elements.    Revit has a built-in tool that allows you to purge unused families 
and content. This is a good way to reduce file size, improve performance, and minimize the 
list of things you need to search through when adding content in the project. Loaded but 
unused families can make your file grow quickly. To purge, choose the Manage tab  Purge 
Unused. If your file is very large, it may take a few minutes to run this command before 
you see the dialog box shown in Figure B.6. Here, you can opt to keep or purge families 
individually.

This is typically not a good idea at the beginning of a project, because your template may 
contain families that you intend to use but haven’t yet inserted (such as wall types).

Use purge to Reduce File Size

Some Revit families can only be removed from the project with the Purge command. You will notice 
with elements such as dimensions and text notes, there is no way to delete a family type from the 
Properties dialog box. To get rid of unused elements of these types, use Purge Unused. Everything 
included in the Other Styles group falls into this category.

Figure B.4 
Enable graphics 
card options  
for better  
performance.

Figure B.5 
Import into  
one view.
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Manage the amount of information shown in views.    Learn to manage the amount of 
information needed in your views. Don’t show more than you need to show in a view either 
in depth or in your level of detail. Here are a few easy ways to keep your views opening and 
printing smoothly:

Minimize the level of detail.    Set your detail level (in the View Control bar) relative to 
the scale you’re viewing. For example, if you’re working on a 1⁄32˝ (1:50) plan, you prob-
ably don’t need Detail Level set to Fine—it will cause your view performance to suffer 
needlessly.

Use Level of detail to Speed Up View performance

One project was taking upward of 20 minutes to open plan views. As you can imagine, this was very 
frustrating for the users, especially when you opened those views accidentally. As it turned out, the 
views were set to a 1⁄16˝ scale and a fine level of detail. For many of the elements in the plan, none of 
them showed any significant information at this level of detail. By setting the View Detail to Coarse, 
users were able to reduce the time to open those views to under two minutes. We further optimized 
view performance by modifying complex families in the view to show less detail at a coarse level.

Minimize view detail.    This goes along with the level of detail, but this tip is more user 
based than tool based. If you’re printing a 1⁄32˝ (1:50) drawing, make sure you’re showing 
the proper level of detail in the view. Even if Detail Level is set to Coarse, do you really 
need to show balusters in an elevation on your railing at that scale? They will print as a 

Figure B.6 
Use the Purge 
Unused dialog box 
to reduce file size.
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thick, black line. Turning them off in this view will help improve not only your printing 
speed but also the quality of the resulting printed sheet.

Minimize view detail in Components/Families.    Along these lines, make sure that 
component families only display what needs to be shown with regard to orientation 
Minimizing detail is a practice that will result in good performance through many as-
pects of Revit. When creating families, make sure to use the View Levels to control the 
amount of detail you can see in a family.

Minimize view depth.    View depth is a great tool to enhance performance. It’s espe-
cially valuable in section views. A typical building section is shown in Figure B.7. The 
default behavior causes Revit to regenerate all of the model geometry the full depth of 
that view every time you open the view. To reduce the amount of geometry that needs to 
be redrawn, drag the section’s far clip plane (the green dashed line when you highlight 
the section) in close to the cutting plane.

Figure B.7 
Minimize the 
section’s Far Clip 
Offset (the Depth 
of the section).
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Turn off shadows.     Shadows can help you make beautiful presentations, give a sense of 
depth in façades, and show the effect of the sun in a site-plan view; however, shadows are per-
formance intensive and can significantly slow a view’s time to open, print, or regenerate as you 
pan and move around in it. Make sure you turn shadows off whenever you don’t need them.

Open only what you need.    One of the benefits of having worksets is that you don’t have 
to turn them all on at once. When you open the project, go to the Workset dialog box. There, 
you can highlight a workset and click the Close button (see Figure B.8). Doing so drops that 
workset from active memory and gives you better performance. Remember, if worksets are 
closed, you can’t do anything with them. If a workset isn’t visible, it won’t print. To print a 
current copy of the whole model, you’ll need to turn the worksets back on.

Break up your model.    For larger projects, or campus-style projects, you can break up 
your model into smaller submodels that are referenced together. You can also do this on a 
single building. If you decide to divide your project, make your cuts along lines that make 
sense from a holistic-building standpoint. Don’t think of the cuts as you would in CAD, but 
think about how the actual assemblies will interact in the building. As an example, don’t 
cut between floors 2 and 3 on a multistory building unless you have a significant change in 
building form or program. Here’s a list of some good places to split a model. See Figure B.9 
for an example:

At a significant change in building form or massing•u	

At a significant change in building program•u	

Between separate buildings on the site•u	

At the building site•u	

Figure B.8 
Worksets can be 
closed to reduce 
the amount of 
memory used to 
open a file.

56491bapp02.indd   737 6/2/09   2:43:56 PM



738 | Appendix B Tips and TroubleshooTing

Consider printing paper sheets from DWFs or PDFs.    Printing big Revit files can some-
times take a long time. Enabling raster printing speeds up printing, although there is a trade-
off compared to the quality that vector printing offers. Depending on the printer, you may 
get better line quality by going to a DWF or PDF first, then printing your physical sheets. 
Experiment on a few sheets to see what your printer responds to best before sending your 
entire set. Printing a digital set first will also give you a record of what you have just printed 
as well as a quick way to make additional copies later if needed.

Model just what you need.    Don’t fall into the trap of overmodeling. Just because you can 
doesn’t mean you should. Be smart about the level of detail you choose to model based on the 
complexity and size of your project. Some data is just easier and better to show in a 2D detail 
rather than as 3D model data. The amount of information you model or do not model should 
be based on your project size and complexity, your timeframe, and your comfort level with 
the software.

Ask yourself three simple questions when detailing.    Many people who understand the 
principles of modeling in Revit struggle with the changes in methodology when actually 
creating a set of construction documents. When moving from modeling to detailing, you will 
find that you are creating and modifying families to add details specific to the current state 
of the design. When doing this, it always begs the question “How much do I model?” As a 
rule of thumb, here are three simple questions to help you make the right decision:

Scale    What scale will this detail be seen in? If it’s a very small-scale detail, it might be sim-
pler to just draft it in a drafting view.

Repetition    How many times will this detail appear in the drawing set? If it will appear only 
in one location, it might be easier again to just draft it in 2D rather than try to model the 
element. If it will appear in several locations, modeling is probably the better solution.

Quality    How good at modeling families in Revit are you? Don’t bite off more than 
you can chew. If you’re new to Revit, keep it simple and use 2D components. The more 
projects you complete in Revit, the better you’ll begin to understand the change to a BIM 
workflow.

Figure B.9 
Splitting up a 
model can improve 
performance.
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Don’t overconstrain.    You must embed user-defined relationships and constraints in the 
design to help keep important dimensions constant. However, if you don’t need to lock a 
relationship, don’t. Even though the option to lock all alignments is available, it’s often not 
necessary to do so. Overconstraining the model can cause problems later in the project pro-
cess when you want to move or modify an element and you need to figure out (or remember) 
what you locked and where to allow the particular element to be moved or modified.

Assign proper view detail.    It is possible to create families in Revit with a seemingly infi-
nite amount of detail. Use the Visibility tool found in the Family Editor to set the appropriate 
level of detail for when the element is viewed in plan, elevation, or section. Setting elements 
to Coarse, Medium, or Fine can also keep your families from looking like blobs in Coarse view 
and small scales as well as quicken your screen-refresh times.

Fix an overconstrained object.    If you keep encountering a dialog box telling you the model 
is overconstrained and this is impeding your workflow, you can delete the constraint. If it is 
a simple element (such as a wall with no openings or sections), it might be easier to simply 
delete and redo the troubled object.

Close Revit with an empty view.    To avoid long opening times for really large files, estab-
lish an office standard that you always close your last view as a drafting view or legend that 
is empty, or maybe contains only some text with the project name. This way, when Revit first 
opens the project it will need much less processing time. By default, Revit always opens with 
the view from when the project was last saved. We’ve seen some nice-looking “project pages” 
made with a drafting view using text and some simple instructions.

Upgrade to new versions.    Many CAD workflows required you to use the same version of 
CAD over the lifecycle of the project. With each new release of Revit, many changes have been 
put in place to make large files easier to manage and saving faster, as well as improve overall 
performance. 

Dealing with File Corruption
If your file becomes corrupted and begins to crash frequently, there are a few things you can do 
to help fix the problem before you call Revit Support in a panic. To proactively avoid this issue, 
focus on the previous tips before you begin having problems. Otherwise, here are some sugges-
tions on what to do when you get into trouble:

Audit the file.    Auditing the file will review the data structures and correct problems that 
are found within the model. An audited file won’t look any different when the audit is com-
pleted; however, it should (ideally) not crash. This is not a cure-all, by any means, but it can 
help you get out of a tight spot when necessary.

Get everyone out of any worksets and local files, and have them relinquish their permissions. 
Open the file using the Application Menu  Open  Project. The resulting Open dialog box 
lets you browse to a project location. Select your project and before clicking the Open button 
to open the file, select the Audit check box in the lower-right corner (shown in Figure B.10). 
Revit gives you a warning before performing an audit on your file. The audit itself can take 
several minutes to complete. When this process is finished, save the project with a new name 
or in a new file location; don’t save this file over the old Revit file. Saving over an existing 
Revit file can sometimes lead to instability. When you’re finished, have everyone make a new 
local file, and you can get back to work.
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Review warnings.    Each time you create something that Revit considers a problem, a 
warning is issued. Warnings will accumulate if left unresolved. Think of all these errors as 
unresolved calculations. The more there are, the more your computer will have to struggle to 
resolve them, and eventually you will have performance issues or file instability. Revit pro-
vides an interface where you can review all the warnings in the project and fix problems.

Try to read and react to all warnings that Revit sends. You don’t have to do it when you’re 
under a tight deadline or when doing so will interrupt your work. But once a week, you 
should spend 30 minutes reviewing the warnings, as this can improve your model’s overall 
performance. You can find the list of warnings in your file on the Modify tab on the Inquiry 
panel. Choose the Warnings button (Figure B.11). 

Purge unused elements.    We referred to this earlier in the “Best Practices” section. Purge 
can also be used to get rid of poorly built families that might be wreaking havoc in your file.

Figure B.10 
The Audit option is 
located in the Open 
dialog box.

Figure B.11 
Review the  
warnings in this 
dialog box.
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Getting Started in Revit
Knowing how and where to begin your journey can be a challenge, and we want to give you a 
few pointers to help you get started. Although this list isn’t complete by any means, it should 
help steer you in the right direction:

Begin with the end in mind.     Planning is always a good way to start a project. Regardless 
of your project, when working with Revit it’s always harder to go back and modify the model 
to fit a new goal than to build to suit the goal along the way. You can set yourself up for a suc-
cessful implementation from the beginning by using a bit of forethought about your process, 
workflow, and desired outcome. If you are using Revit for the first time, set some reasonable 
limits for how far you plan to take the modeling and detail process. This will help guide the 
development of families along the way. If you are trying to push into some higher-level BIM 
challenges like 4D, costing, or energy modeling using Revit model geometry, set those goals 
at the beginning of the project process as each will require you to focus on aspects of the BIM 
model you might not have typically considered. 

Get your project and office standards in place early.     As design professionals, we have a 
tendency to develop unique graphic conventions and styles for our documents. This is a specific 
area where good planning leads to a good project. If possible, get your standards in place before 
you begin a project. Revit does an excellent job of getting you started with a good template of 
graphic standards to work with. However, if you’re like most architects, an application right 
out of the box is never quite nice enough. Revit provides a good starting point for customiza-
tion, and with some up-front time, you soon can have your project and office standards up and 
running. Once you nail down your standards, they can be easily applied to your project using 
the Transfer Project Standards command on the Manage tab.

Remember that the first project you do in Revit will require a change in methodology.     
You’re leveraging technology to help you change the way you approach design and documen-
tation. Don’t expect the process to have the same workflow as it did in a CAD-based system. 
Try to stay flexible in your expectations and schedule and allow yourself time to adapt to the 
change.

Don’t try to conquer the world on the first project.     There are many advantages to using 
BIM as a design and documentation methodology. As this process becomes more mainstream 
within the industry, those benefits will only increase. All of these things and more are possible 
with the use of Revit, but it will take a couple of projects to get there. Tailor the use of BIM to 
the project, and use the features that will maximize the benefits of using BIM. Choose your 
goals realistically based on the expertise of your project team, and plan ahead so those goals 
can be met successfully. Consider a project that is less complex for your initial pilot. 

Learning a Modeling Workflow

One of the most important rules to follow as you begin your project is to model the building as it will 
be built. That said, keep in mind that you do not need to model every condition three-dimensionally. 
Use Revit to get the essential dimensions and building form coordinated. You can then embellish 
the model with 2D details to convey the fine grain.
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Model correctly from the beginning.     We can’t stress this enough. As you refine your 
design, it’s critical to model correctly right from the beginning so you don’t have to fix things 
later. What does this mean? As an example, think of a wall. Does it sit on the floor, or does 
the floor attach to the wall? If you can begin to think about how your project will be assem-
bled, it will save you a lot of time at the end. It’s good practice to plan ahead, but remember 
that Revit will allow you to make major changes at any stage in the process and still maintain 
coordination. If you are still in an early phase of design and do not know the exact wall type, 
use generic walls to capture your design intent; changing these later will be simple.

Get information into the project as soon as it is known.     A key advantage of using Revit is 
the ability to change your project schedule. In a traditional design process, most of the effort 
on a project is realized during the construction-document phase. At that time, a typical proj-
ect has the most staff working on the project, and it can be fairly difficult to implement major 
changes to the project design. This is due to the complexity of the documents by this time 
and the amount of effort for the team to redraw all the changed information. You’ll find that 
with Revit, design change is largely managed by the software itself. This gives you a great 
deal of flexibility in both your design and documentation. Take advantage of this shift in 
the process, and add information to your model early. It can be in the form of more detailed 
content or showing the material construction of your wall system. Remember that you can 
change all this information much more quickly and easily than you ever could in CAD, so 
don’t assume you’re locked into the information you displayed early in the design process.

Plan for good communication among team members early in the process.     Communication 
within a team is critical for understanding a project and documenting it successfully. One of 
the downfalls inherent in a CAD-based system is that there is no connection among the differ-
ent files that make up the drawing set. This phenomenon carries through to the project team 
and is a function of project workflow and project management. In CAD, it’s possible for team 
members to work in some degree of isolation. They aren’t forced to immediately reconcile 
their changes with changes made by their teammates. Revit’s single-file environment forces 
a much higher degree of team communication between not only the architects but also your 
structural and mechanical engineers.

Don’t try to model everything.     Most of us have drafted in a 2D environment until now. 
Moving to a 3D world is a significant change. Do you have to model every single screw? 
Every mullion? Every stud? That’s a good question. The simple answer is no, you don’t have 
to, and in fact you should not attempt to do so. Like any BIM system, Revit isn’t 100 percent 
3D information. Standard computer workstations aren’t capable of handling all the data of a 
building in model form. Additionally, few projects have the time in their schedule to model 
the screws in a sheet of gypsum board or the sealant around all the windows; some of that 
information is best presented in 2D or in the specifications. This still leaves you with a wide 
range of options for modeling. In the beginning, err on the side of simplicity. It’s far easier 
to add complexity to your model later on as you gain experience and confidence than it is to 
troubleshoot overconstrained parameters early in the process. Start with the big ideas: walls, 
openings, roofs, and so forth. Work your way down to a comfortable level of detail for both 
you and your computer.

Organize your team.     A BIM project team includes three basic technical roles. These roles 
are interchangeable, especially on smaller projects with fewer team members. However small 
the team, it’s useful to make sure all these roles are filled:
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Building designer    This is the person or team whose primary responsibility is to figure 
out what the project will look like and how it will be made. They create walls, floors, and 
roofs and locate windows, doors, and other building elements.

Content/family creator    The family creator’s primary role is to create the parametric 
content in the Revit model. This is typically someone with 3D experience who also has a 
firm understanding of Revit and Revit families. The families, as you’ll see later, have pa-
rameters that can control visibility, size, color, proportion, and a number of other things.

Documenter    This role supplies the bulk of the documentation. It consists of drafting 
some of the 2D line work over portions of the 3D model to show detail, adding annota-
tions and keynotes, and creating details.

Finding Additional Resources
If you get stuck along the way, don’t assume you’re alone. There are myriad resources in the help 
file, in books, or on the Web to help you find a specific solution to your problem. Chances are, 
someone has tried the same thing before. In our digital age, a wealth of information is available 
online; powerful communities of passionate users are out there willing to help. So before you 
spend hours trying to work through a particular problem on your own, try tapping some of the 
existing resources:

Revit Help menu    Your first stop, if or when you get stuck, should be the Revit Help menu. 
It’s one of the easier and more robust help menus out there, and it can give you a lot of useful 
information very quickly. It’s also the most accessible help source. As with most applications, 
it’s at the far right of the menu bar.

Subscription Support    If you have bought Revit on subscription, Revit Subscription Support 
offers an exemplary web-based support system. Their responses are speedy, and their advice 
is top-notch. If you need information more quickly, Revit also has an online knowledge base 
of FAQs that is available without a subscription. Both of these resources can be accessed at 
www.autodesk.com/revit.

AUGI    Autodesk User Group International (AUGI) is also an excellent source for tips and 
tricks. It’s an online user community free to participate in, ask questions, get answers, and 
share families and examples. To get the benefit of this fantastic online resource, go to www.
augi.com and look for Revit Architecture as a product. If you never logged in, you will have 
to register once; from then on it’s easy! 

Revit City    Looking for content and families? Revit City, another free online service, has a 
growing database of free families posted by other users. Its address is www.revitcity.com.

Autodesk Discussion Groups    These pages offer insightful discussions and some great 
Q&A threads: http://discussion.autodesk.com/.

AECbytes    A website dedicated to following and reporting on the trends in the AEC indus-
try, with a strong focus on BIM, technology, and the direction of the industry—put together 
by Lachmi Khemlani: www.aecbytes.com.
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Blogs    There are numerous blogs from passionate, experienced Revit aficionados. Here are 
some of them in no particular order:

http://revit4you.blogspot.com (Philippe Drouant [French])

http://insidethefactory.typepad.com (Tom Vollaro, Revit Product Designers)

http://revitoped.blogspot.com (Steve Stafford)

http://revitnorge.blogspot.com (Håvard Vasshaug [English and Norwegian])

http://designreform.net (Dave Fano)

http://www.allthingsbim.blogspot.com (James Vandezande)

http://architechure.blogspot.com (Phil Read)

http://irevit.blogspot.com (Craig Barbieri)

http://dorevit.blogspot.com (Robert Manna)

http://do-u-revit.blogspot.com (David Baldacchino)

http://malleristicrevitation.blogspot.com (Aaron Maller)

http://www.bimx.blogspot.com (Laura Handler)

http://www.revitbeginners.blogspot.com (Bradley Hartnagle)

http://revitbeginners.blogspot.com (David Duarte)

http://www.revitcoaster.blogspot.com (Troy Gates)

http://revitit.blogspot.com (Daniel Hurtubise)

http://revitrocks.blogspot.com (Daryl Gregoire)

http://www.revitfamilies.blogspot.com (Shaun Van Rooyen)

http://www.revit-alize.blogspot.com (Bruce Gow)

http://www.revitrants.blogspot.com (Chris Price)

http://blog.reviteer.com (Tom Dorner)

http://www.revitlution.blogspot.com (Christopher Zoog)

http://www.revit-up.blogspot.com (The PPI Group’s Revit evangelist)

http://www.greenrevit.blogspot.com (Beau Turner and Bradley Hartnagle)

http://www.revitup.co.za (Justin Taylor)

http://gmcdowelljr.wordpress.com (Greg McDowell, Jr.)

http://www.autodesk-revit.blogspot.com (David Light)

http://www.auservice-bim.blogspot.com (Simone Cappochin [Italian])

http://www.cmotion.net/products/revit-tools.html (Siggi Pfundt and Gotthard Lanz 
[German and Italian])
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Note to the Reader: Throughout this index boldfaced page numbers indicate primary discussions of a topic. 
Italicized page numbers indicate illustrations.

Numbers
2D elements, importing, 

669 – 670
2D line-based families, 

325 – 326
3D components on divided 

surfaces, 286 – 290, 287 – 290
3D line-based families,  

327 – 328, 328 
3D models, 3 – 4, 6, 6

conceptual, importing,  
262, 262

context, 269 – 270, 270 – 271
Building Maker tools. 

See Building Maker 
tools

design options, 273, 
273 – 274

program check and 
feasibility,  
271 – 272, 272

custom content. See custom 
3D content

details
annotations, 658, 658
creating, 653 – 658, 

654 – 658
physical, 228 – 229, 228

3D views
axonometric, 71
orienting, 71 – 72, 71, 

655 – 656, 656 – 657
perspective. See perspective 

views
section boxes in, 655, 655

3GB switch, 731

A
Absolute keynote paths, 573
accelerators, 95 – 96, 95

Acquire Coordinates option, 
269, 605

Activate View option, 53
activating

Project Browser views,  
53, 53

worksets, 691, 691
Add Current Folder to Places 

option, 29
Add Point tool, 416
Add Split Line tool,  

416 – 417, 417
Add to Design Option Set 

dialog box, 303, 303
Add tool

groups, 589
parameters, 555, 555

additive selections, 76
AEC (Architecture, 

Engineering, Construction) 
world, 3, 12

AECbytes site, 743
Align tool, 173, 173
aligned dimensions, 113
aligning

elements, 87 – 88, 88, 173, 173
fill patterns, 109, 110

Always Vertical parameter, 
334, 335

analytical drawings, 439 – 443, 
440 – 443

angles
elevation tags, 132
extrusions, 384, 384
fill patterns, 110
joins, 431, 431
railings, 427, 427
reference lines, 187, 187
revolves, 206 – 207, 206 – 207
roof slope, 394
rotation, 83, 85
segments, 214, 214

shadows, 443
sun, 441, 443, 514 – 515
sweeps, 211, 211
units, 165, 169

Angles Greater Than setting, 
427, 427

angular dimensions, 113
animation

sun studies, 515 – 519, 
516 – 518

walkthroughs, 477 – 478, 478
Annotate tab, 40, 40

tags, 550 – 551, 550
text, 568, 571, 573

Annotation Objects tab,  
119, 119

annotations, 531
3D detail, 658, 658
callouts, 127 – 128, 127
crop regions, 643
keynotes. See keynotes
material definitions, 101
object categories, 19
revision clouds, 677, 677
rooms. See rooms
schedule keys, 546 – 549, 

547 – 549
separation lines,  

535 – 536, 536
shared parameters. See 

shared parameters
tags. See tags
text, 568 – 570
views, 531, 531
visibility, 499

appearance
materials, 108
schedules, 143, 496, 

503 – 506, 504 – 505
application button, 36
application frame, 36 – 44, 

36 – 44
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application menu, 36 – 37, 36
Apply Nosing Profile  

option, 159
Apply View Template  

option, 175
Architecture, Engineering, 

Construction (AEC) world, 
3, 12

architecture history, 1 – 2
Area and Volume 

Computations dialog box
area plans, 484, 484 – 485
automated calculations, 

541, 541
settings, 168 – 169, 169

Area Boundary tool, 487
Area Boundary Line tool, 490
area plans

calculations, 483 – 484, 
483 – 485

complex, 490
gross, 485 – 487, 485 – 487
rentable, 487 – 490, 487 – 490
vs. room areas, 540

area schedules, 493
Area Schemes tab, 484, 485
areas

adding, 491 – 492, 491 – 492
computation settings, 

168 – 169, 169
rooms, 540 – 542, 540 – 543
units, 165

arrays
creating, 346 – 348, 347 – 348
elements, 85 – 87, 86
formulas for, 343 – 344, 

343 – 344
parametric, 340 – 341, 

340 – 341
Arrow Angle setting, 132
arrowheads

keynotes, 578
leaders, 118

articulation, wall, 356 – 360, 
357 – 360

Artificial Light dialog box,  
469, 469

artificial lighting, 469, 469, 509
Associate Family Parameter 

dialog box, 247, 348 – 349
Associate Parameter dialog 

box, 342
associations

arrays, 87
bidirectional, 23
shutter width, 342

asymmetric slopes on gable 
roofs, 394, 394

At Library Locations  
method, 573

Attach Detail tool, 589
Attached Detail Group 

Placement dialog box, 592
attached detail groups, 584, 

592, 593
auditing files, 739, 740
auditorium railings, 436
Auto - By shared coordinates 

option, 268, 605
Auto - Center-to-center  

option, 268
Auto - Origin-to-origin option, 

268, 605
auto-hiding sections, 68
AutoCenter to Center option, 

605
Autodesk Design Review. See 

Design Review
AutoDesk Inventor software, 

294 – 295, 295 – 296
AutoDesk Maya, 293 – 294, 294
Autodesk Online services, 38
Autodesk User Group 

International (AUGI), 743
automated dimensioning,  

173, 173
automating area calculations, 

488, 541, 541
axes for revolves, 206, 206,  

208, 209
axonometric 3D views, 71

B
background

photorealistic renderings, 
470 – 471, 471

text, 118, 118
balusters

main patterns, 428 – 429, 
428 – 429

placement, 426, 427
railings, 424, 424
per tread on stairs, 

429 – 431, 430
barrel roofs, 383, 383, 385,  

410, 410
Base blend setting, 216
Base Extension parameter, 

366 – 367
Base Level property, 381
base molding, 643 – 644, 644
Base Offset property, 539
Base Offset from Level 

property, 381
Baseline dimension style, 114
Basics Design bar, 66
Begin with a Riser setting, 159
Beginning setting for baluster 

patterns, 429, 430
behavior of keynotes, 571 – 572
Bernini, Giovanni, 2
bidirectional associations, 23
bidirectional relationships, 

22 – 23, 22 – 23
BIM. See Building Information 

Modeling (BIM)
Binding a Revit link within the 

parent model option, 607
binding links, 603, 607 – 608, 

608
black and white high-contrast 

effects, 444, 444
blends, 215 – 216, 215 – 216

examples, 221, 221
for lamp, 219 – 221, 219 – 220
troubleshooting, 217, 

218 – 219
vertices, 216, 217 – 218
walls, 368

56491bindex.indd   746 6/3/09   10:41:47 AM



blocks • closed loops | 747

blocks, 21
blogs, 744
Bold setting, 118
BOMA (Building Owners and 

Managers Association) area 
calculations, 484

Boolean joins, 286
boolean operations, 240 – 242, 

240 – 242
Borromini, Francesco, 2
borrowing elements, 703
Bottom view range for floor 

plans, 57, 58
boundary lines, 485 – 486, 486
bounding boxes, 541, 541
Break Symbol in Plan setting, 

158, 159
Broken Section Display Style 

setting, 121, 121
broken section lines, 67, 67
Browser Organization 

Properties dialog box, 52, 52
Brunelleschi, Filippo, 2
Build panel, 47, 47
building area schedule 

updates, 501
Building Information 

Modeling (BIM), 1
advantages, 1 – 4
for creativity, 6, 6
drafting, 9, 9
Family Editor, 9, 10
interaction, 7
layers and X-References, 10
as new technology, 12
problem-solving, 8, 8
process change, 4 – 5, 5, 

10 – 11
properties, 6, 7
tool support, 8 – 9
working with, 12 – 13, 13

Building Maker tools
advantages, 274 – 275
design verification, 

278 – 281, 279 – 281
Mass Floors, 275 – 278, 

276 – 278

Model by Face tool, 
281 – 284, 282 – 283

Building Owners and Managers 
Association (BOMA) area 
calculations, 484

By Category tag option, 
551 – 552

By Date, Time, and Place sun 
angle setting, 443, 514

By Host railings option, 433
By Keynote numbering  

option, 573
By Project revision numbering 

option, 674
By Sheet option

keynote numbering, 573
revision numbering, 674

By Type railings option,  
433, 433

C
CAD files and formats

details, 617 – 618, 617 – 618
exploding, 732
linking, 614 – 615, 614

calculated fields, 503, 503
Calculated Value dialog box, 

503, 503
calculations

area plans, 483 – 484, 
483 – 485, 488, 541, 541

room volume, 732 – 733, 733
stairs, 158, 158

Callout tool, 630 – 631
callouts and callout tags

custom, 127 – 130, 127 – 130
elevation, 133
working with, 628 – 629, 629

Camera tool, 461
cameras

3D views, 72 – 73, 72
perspective views, 461 – 462
showing, 463, 463
sun studies, 511 – 512, 

511 – 512
carbon footprints, 507
cars, 475 – 476

Cascade option, 45
Cast Shadows option, 513
categories, 15 – 17, 16 – 17

annotation, 19
imported, 20, 21
Model Object, 17 – 18, 18 – 19
for shared parameters, 

561 – 562, 561 – 562
CDs (Construction Documents), 7
ceilings

floor connections and 
details, 645 – 646, 645 – 646

types, 156, 156
Center setting, 429, 430
Centerline Pattern option, 116
Centerline Symbol option, 116
Centerline Tick Mark option, 116
central files

saving, 694
workflows, 698 – 699, 698
working on, 696
in worksharing, 690, 690

CFDs (computational fluid 
dynamics), 522

chain selections, 76
chairs

arrays, 346 – 348, 347 – 348
nesting, 346, 346
visibility, 348 – 349, 348 – 349

Change Sweep Return  
option, 364

change tracking, 673
BIM and supplemental 

drawings, 680
Design Review. See Design 

Review
revisions, 673 – 680, 674 – 680

classification system, 16
Close Hidden Windows option, 

45, 733
closed loops

blends, 221, 221
lofts, 252
profiles, 324, 324
revolves, 207 – 208, 207 – 208
sketches, 182, 182
sweeps, 210
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closing
Revit, 706
unused DWGs, 733

clouds, 470 – 471
coarse settings

Scale Fill parameter, 
451 – 452

wall detail, 153
Collaborate tab, 41, 41
color

dimensions, 116
elevation tags, 132
elevations, 455 – 456, 

455 – 456
fill schemes, 176, 446 – 448, 

447 – 448
in importing and  

linking, 616
legends, 446 – 447, 447
level tags, 134
lines, 102
text, 118

color-coded plans and sections, 
445 – 446, 446

fill schemes, 446 – 448, 
447 – 448

sections, 449 – 450, 450
Color Fill Schemes dialog box, 

446, 448
commas (,) in type-catalog 

syntax, 164
common edges, 168, 168
communication with teams, 742
Communications Center, 38
complex area plans, 490
complex roofs, 224, 224
component families, 27 – 28, 28, 

30, 31
compound walls, 356, 357
Computation Height property, 

543, 543 – 544
computational fluid dynamics 

(CFDs), 522
Computations tab, 484, 484
conceptual design and early 

studies, 265, 266

positioning imported files, 
268 – 269

site data and context, 
266 – 268, 267 – 268

conditional visibility,  
338 – 339, 339

cone roofs, 408, 408
constraints

design stage, 25, 25
move, 82, 92, 92
in performance, 739

construction document  
sets, 331

Construction Documents 
(CDs), 7

context, building, 266 – 268, 
267 – 268

contextual tabs, 39, 39
Continuous dimension  

style, 114
converting groups into links, 

602 – 603, 603 – 604
coordinates for UV surface 

divisions, 260, 260 – 261
copies in performance, 733
Copy tool, 83
copying

area boundaries,  
491 – 492, 491

color, 448 – 449, 449
with Copy, 83
groups, 594
with Move, 82
options, 78 – 79, 78
sweeps, 212
system families, 27, 27

cores, walls, 351 – 353, 352 – 353
Corner Posts At dialog box, 427
Corner Radius option, 127
corruption, file, 739 – 740, 740
cost estimates, 502 – 506, 

502 – 505
cost schedules, 313 – 314, 313
Count Selection tool, 38 – 39, 38
Create Floors tool, 282

Create Form tool, 238 – 239, 238
parametric extrusions, 244
revolves, 250 – 251
void and solid forms,  

240, 240
Create In-Place Mass tool, 270
Create Instance group  

option, 594
Create Mass tool, 236
Create Roof tool, 293
Create Similar tool, 79
Create tab, 40, 40
Create View Template From 

View option, 50, 50
creativity, 6, 6
Crop Region Size dialog box, 73
crop regions

annotations, 643
perspective views, 73, 73

cupolas, 208, 208
Current View copying  

option, 79
Current View Only option,  

269, 615
Curtain Grid tool, 371
Curtain Grid Line tool, 373
curtain panel families, 332, 

332 – 333
Curtain System tool, 282
curtain systems

3D components on divided 
surfaces, 286 – 290, 
287 – 290

Model by Face tool, 
283 – 284

with Rhino, 292 – 293
Curtain Wall Panel.rtf 

template, 373
curtain walls, 369 – 370, 369 – 370

designing, 370 – 373, 
371 – 373

doors and windows, 374, 374
panels, 373 – 375, 374 – 375

custom 3D content, 319
encoding design rules, 

341 – 344, 341 – 344
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families
building, 345 – 349, 

345 – 349
categories and 

parameters, 333 – 335, 
333 – 335

curtain panel, 332, 
332 – 333

detail component,  
331, 331

face-based, 328, 329
host-based, 322 – 323, 323
line-based, 326 – 328, 

327 – 328
linking parameters, 

337 – 339, 338 – 339
modeling, 319, 320
nesting, 335 – 339, 

336 – 340
profile, 323 – 326, 

324 – 326
RPC, 329 – 330,  

330 – 331, 334
template selection, 

320 – 321, 320 – 321
types, 322
work plane-based, 329

parametric arrays, 340 – 341, 
340 – 341

custom images for materials, 
474 – 475, 474 – 475

custom keynotes, 139 – 140, 
139 – 140

custom line types, 623 – 624, 624
custom patterns, 108 – 112, 

108 – 110, 433
custom tags, 119, 119,  

135 – 136, 135
doors, 136 – 138, 136 – 138
revision clouds, 679
view. See view tags

custom templates, 97 – 100, 
98 – 99

custom title blocks, 140 – 145, 
141 – 145

custom walls, 148, 148 – 150
default wrapping, 153, 153
layers, 150 – 154, 151 – 152
preview window, 150

cut graphics, 18, 19
Cut Line Styles, 166
Cut Pattern option, 107
Cut Plan Profile tool, 384
Cut planes, 57 – 60, 59 – 60
Cutoff Level property, 381
Cutoff Offset property, 382

D
daylighting, 527 – 530, 528 – 529
Deactivate View option, 53
defaults

graphics settings, 168
keynote text files, 572
project settings, 172 – 176, 

173 – 176
view templates, 175
wall wrapping, 153, 153
work planes, 193 – 197, 

193 – 197
Defines Slope option, 380 – 381
Delete Dedicated Options 

Views dialog box, 308, 308
Delete Inner Segment option, 90
deleting

dimension types, 117
line styles, 103
markups, 688
materials, 106
tags, 532, 533
text type, 119
unused DWGs and  

views, 733
Deny/Retract option, 705
dependencies

views, 19
work planes, 184

depth
blends, 215
elevations for, 453 – 455, 

453 – 456
extrusions, 204
view, 60 – 62, 60 – 61

design cycle, 509
Design Option Set dialog box, 

307, 307
design options, 299 – 300, 299

accessing, 300, 300
design-option sets, 

300 – 301, 301
displaying, 306 – 307, 

306 – 307
editing, 304 – 306, 304
elements for, 301 – 304, 

302 – 303
with parametric design, 

313 – 316, 314 – 316
in practice, 308 – 312, 

308 – 312
quantities and cost 

schedules, 313 – 314, 313
rooms, 314 – 316, 314 – 316
selecting, 307 – 308, 308

Design Options dialog box, 
301 – 302, 302, 309, 309

Design Review, 682
exporting to, 684 – 686, 

684 – 686
importing markups, 

687 – 688, 687
interface, 682 – 683, 682 – 683
model markup in, 686, 

686 – 687
design rules, encoding, 

341 – 344, 341 – 344
designer role, 743
designing curtain walls, 

370 – 373, 371 – 373
Detail Component.rtf file, 331
Detail Component Line based.

rft file, 331
detail groups, 584, 600 – 601, 

600 – 601, 619
Detail Level setting, 735
details and detail components, 

17 – 18, 18 – 19, 611
3D

annotations, 658, 658
creating, 653 – 658, 

654 – 658
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callouts, 628 – 631, 629
creating, 619 – 620
drafting views, 612, 612
exporting, 667 – 670, 668
families, 331, 331, 659 – 663, 

659 – 663
groups, 592, 593
importing and linking, 

612 – 618, 613 – 614, 
617 – 618

importing views, 669 – 670, 
669 – 670

information for, 630 – 631, 
630 – 631

keynotes, 577, 577
line tools. See line tools
for line types, 623 – 624, 624
nesting, 648 – 650, 649 – 650
properties, 623, 623
repeating, 621 – 622, 

621 – 622, 646 – 647, 647
rotating, 623
shaft opening, 670 – 671, 

670 – 671
symbolic lines for, 665 – 667, 

665 – 667
tips, 651
visibility settings, 663 – 665, 

664 – 665
wall sections

components, 634 – 638, 
634 – 638

model details, 639 – 650, 
639 – 650

SIM condition, 632 – 633, 
632 – 634

.dgn files, 615
dialog launchers, 42 – 44, 42 – 44
Dimension Line Extension 

setting, 115
Dimension Line Snap Distance 

setting, 117
Dimension String Type 

parameter, 114
Dimension tool, 435
dimensions

defaults, 173, 173
in family details, 660, 660

formulas for, 342, 342 – 343
in moving elements, 80 – 81, 

80 – 81
styles, 113 – 117, 114 – 115
in views, 531

Direct Editing tool, 416
directions in reference planes, 

205, 205
Directly sun angle setting, 443
Disallow Join option, 354, 354
Disassociate option, 192
discussion groups, 743
disjoining

hosted elements, 82
walls, 354, 354

displaying design options, 
306 – 307, 306 – 307

Dist. from Previous setting, 429
Divide Surface tool, 260 – 261, 

260
divided surfaces, 3D 

components on, 286 – 290, 
287 – 290

documentation. See 
annotations

documenter role, 743
documents, 8 – 9
dome roofs, 208, 208, 385, 385, 

409, 409
Don’t Cut tool, 241
Door category, 62
Door-Curtain Wall.rtf 

template, 374
door knobs, 209, 209
doors

curtain wall, 374, 374
defaults, 172
host-based families, 322, 323
in modeling principles,  

200, 200
rotating, 83, 83
symbolic lines for, 666, 666
tags, 532, 552 – 554

custom, 136 – 138, 
136 – 138

shared parameters for, 
564 – 567, 564 – 568

types, 161 – 162

dormers
creating, 412 – 415, 412 – 415
hipped roofs with, 404 – 405, 

404 – 405, 407, 407
drafting, 9, 9
drafting lines

for elevations, 455
reusing, 640, 640

drafting patterns, 108 – 109
drafting views, 612, 612
drainage points, 418
Draw panel, 238, 238
drawing list schedules, 494
Duplicate option

groups, 594
materials, 106

Dutch gables, 402 – 403, 403 – 404
DWF Export Settings dialog 

box, 683 – 684, 684
DWF files

exporting, 684 – 686, 
684 – 686

in performance, 738
sharing, 682

DWG files
importing and linking, 

266, 614
in performance, 733
with SketchUp, 290

.dxf files, 614

E
edges

common, 168, 168
silhouetted, 464, 464 – 465

Edit Assembly dialog box
floors and roofs, 155, 155
split sections, 358 – 360, 360
sweeps and reveals, 361
wall cores, 352, 352
wall extensions, 366
wall tools, 356, 357 – 358
walls, 148, 149 – 150, 153

Edit Baluster Placement dialog 
box, 426 – 428, 427

Edit Blend Base setting, 216
Edit Blend Top setting, 216
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Edit Color Scheme dialog box, 
446 – 447, 447

Edit Extrusion option, 203
Edit In-Place button, 239
Edit Joins tool, 432
Edit Label dialog box

callouts, 128
custom title blocks, 142, 142
door tags, 136, 136
parameters, 124, 124, 566

Edit option for groups, 595
Edit Rail Joins tool, 432
Edit Rails dialog box,  

425 – 426, 426
Edit Roof Structure dialog box, 

418, 419
Edit Shared Parameters dialog 

box, 559 – 562, 559 – 560
Edit Vertices tool, 216
Edit Work Plane option, 192, 

204 – 205, 204
editable worksets, 692, 692
editing

actions for, 75
aligning, 87 – 88, 88
arraying, 85 – 87, 86
constraints, 92, 92
copying and pasting, 

78 – 79, 78
Create Similar, 79
extending lines and 

walls, 90, 90
joins, 93 – 94, 93
keyboard shortcuts, 

95 – 96, 95
moving, 79 – 82, 80 – 82
offsetting, 91, 91
painting, 94 – 95, 95
pinning, 91 – 92
rotating and mirroring, 

83 – 85, 84 – 85
scaling, 87, 87
selecting, 75, 76 – 78, 77
splitting, 90, 90, 94 – 95, 94
trimming lines and 

walls, 89, 89
blend vertices, 216, 217 – 218

design options, 304 – 306, 304
detail components, 

635 – 638, 635 – 638
groups, 599 – 600, 600
keynotes, 571 – 572
materials, 105 – 108, 105 – 107, 

472, 472
schedules, 503 – 506, 

504 – 505
sketches, 183
wall joins, 354, 354
work planes, 192

Editing Requests dialog box, 
705 – 706, 705

electrical lighting, 509
Element Assembly dialog  

box, 361
Element Properties button,  

43, 43
Element Properties dialog box, 

6, 7
color fill, 449
parameters, 555, 565
parametric forms, 242
regions, 626
repeating elements, 621
roofs, 391, 392
rooms, 532
stacked walls, 356
sweeps, 211
visibility, 348 – 349
wall extensions, 366
wall wrapping, 361
walls, 172
worksets, 695, 697

elements
aligning, 87 – 88, 88
arraying, 85 – 87, 86
borrowing, 703
default settings, 172 – 176, 

173 – 176
for design options, 

301 – 304, 302 – 303
for keynotes, 139, 571, 

579 – 580, 579
moving, 80 – 82, 80 – 82

ownership, 701 – 706, 
702 – 706

pinning, 91 – 92
rotating and mirroring, 

83 – 85, 84 – 85
scaling, 87, 87
tagging, 532

Elevation Base setting, 134
elevations, 453, 453

default settings, 174, 174
images in, 457 – 458, 458
Linework tool, 454 – 455, 454
Project Browser views, 

68 – 71, 70
tags for, 130 – 134, 131 – 133
transparent materials, 

456 – 457, 457
true-color, 455 – 456, 

455 – 456
Empty glazing setting, 410
enabling

design rules, 341 – 344, 
341 – 344

shadows, 442, 442
End setting for baluster 

patterns, 429, 430
End angle resolve setting,  

204, 207
End with a Riser setting, 159
energy analysis, 522 – 525, 

523 – 526
Entire Walls option, 173
entourage, 475 – 476, 476
Exclude feature, 596, 596
expanded panels, 41, 41
exploding imported CAD  

files, 732
Export to DWF dialog box, 684
exporting, 478 – 479, 479

to Design Review, 684 – 686, 
684 – 686

details, 667 – 668, 668
to gbXML, 523 – 525, 524
sun studies, 517, 517
sun views, 515

Exposure Control dialog box, 
472, 472
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exposure settings, 472, 472
expressive drawings, shadows 

for, 439 – 440, 440, 444 – 445, 
444 – 445

Extend Below Base setting, 158
extending

lines and walls, 90, 90
walls, 366 – 367, 366 – 367

extending pergola, gable roofs 
with, 399, 399

exterior skins, 305, 305
external text files, 572
extruded roof dormers, hipped 

roofs with, 407, 407
Extrusion end setting, 203, 203
Extrusion start setting, 203, 203
extrusions

parametric, 244 – 247, 
244 – 247

roofs by, 193 – 197, 193 – 197, 
383 – 384, 383 – 384

working with, 202 – 205, 
203 – 205

F
face-based families, 328, 329
faces with extrusions, 205
families and Family Editor, 9, 

10, 15 – 16, 16, 26
3D. See custom 3D content
vs. blocks, 21
callout tags, 127 – 129, 

127 – 129
ceilings, 156, 156
component, 27 – 28, 28, 30, 31
custom title blocks, 

141 – 145, 141 – 145
details, 659 – 663, 659 – 663
door tags, 564
doors and windows, 

161 – 162
elevation tags, 134
floors and roofs, 155 – 156, 155
in-place, 31 – 32, 32
keynotes, 576 – 580, 576 – 579
loadable, 200, 200
managing, 120

mass placement, 242 – 243
organizing, 29 – 30, 29 – 30
parametric extrusions, 

244 – 245, 245
parametric material, 

247 – 249, 249
for primary forms, 202, 202
profiles, 361 – 362
Project Browser views,  

54, 54
section view tags, 122 – 125, 

123 – 125
stairs, 157 – 161, 157 – 161
system, 26 – 27, 26 – 27
templates, 320 – 321, 

320 – 321
type creation in, 162 – 163
types. See types and type 

catalogs
visibility settings, 325, 325, 

663 – 665, 664 – 665
wall wrapping, 361, 361
walls. See walls
worksets, 692

Family Category and 
Parameters dialog box, 
333 – 334, 334

family creator role, 743
Family Element Visibility 

Settings dialog box, 325, 325
Family Types dialog box,  

333, 333
arrays, 344, 344, 346
dimensions, 342, 343
parametric extrusions,  

245, 245
RPC, 330, 330
visibility, 349

FAR (Floor Area Ratio), 271
feasibility, program, 231 – 233, 

231 – 233, 271 – 272, 272
feet units, 170
fences. See railings
Fields tab, 495 – 496, 495, 502, 547
File Locations tab, 29, 29, 98, 99
File Save Options dialog box, 

698, 698

filenaming conventions, 
keynotes, 572

files
corruption, 739 – 740, 740
linking, 605 – 606, 605
workflow, 698 – 699, 698 – 699

Fill Available Space modes, 623
Fill Patterns dialog box, 108, 

108, 111
fills and fill patterns

color, 446 – 448, 447 – 448
custom title blocks, 142
for details, 645 – 646, 

645 – 646
elevation tags, 132
graphics, 451 – 452, 452
materials, 108 – 113, 

108 – 110, 112 – 113
Filter dialog box, 76, 77
Filter tool, 491, 491
filtering

area boundaries, 491, 491
keynotes, 575, 575
schedules, 495 – 496, 498, 506
selections, 38, 38, 76, 77

Fine level of detail, 153
Finish Mass button, 239
Finish option for wall layers, 151
First end blend setting, 215
Fixed Distance modes, 623
Fixed Number modes, 623
Flat railing option, 433
flat roofs, 393, 393
flip controls, 83, 83 – 84
Flipped Dimension Line 

Extension option, 115
Floor Area Ratio (FAR), 271
floor plans, 55 – 56, 55

Cut planes, 57 – 60, 59 – 60
primary range, 59 – 60, 

59 – 60
View Depth, 60 – 62, 60 – 61
View Range, 56 – 58

floors
bidirectional relationships, 

22 – 23
ceiling connections and 

details, 645 – 646, 645 – 646
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Mass Floors tool, 275 – 278, 
276 – 278

Model by Face tool, 
282 – 283, 282 – 283

in modeling principles, 
199 – 200

sketch-based design, 
181 – 183, 181 – 183

types, 155 – 156, 155
focal length in perspective 

views, 461 – 462, 463
Font setting, 159
fonts for elevation tags, 132
footprint roofs, 378 – 382, 

378 – 383
force units, 165
form making and 

rationalization, 243, 243
importing models, 262, 262
lofts, 252 – 256, 252 – 256
parametric extrusions, 

244 – 247, 244 – 247
parametric material, 

247 – 249, 248 – 249
revolves, 249 – 252, 250 – 252
surfaces, 259 – 261, 259 – 261
sweeps, 256 – 259, 256 – 259

Format dialog box, 381, 381
formats

CAD, 614 – 615, 614, 617 – 618
exporting to, 478 – 479, 479
roofs, 381, 381

formatting schedules, 496, 497, 
503, 504

formulas
arrays, 343 – 344, 343 – 344
dimensions, 342, 342 – 343

Foundation model, 481 – 482
area plan calculations, 

483 – 484, 483 – 485
areas and tags, 491 – 492, 

491 – 492
change tracking, 681, 681
rentable area plans, 

487 – 490, 487 – 490
schedules. See schedules
worksets, 694 – 695, 695

four-sided gable roofs, 406, 406
freestanding elements

railings, 423, 423
rotating, 84

Full Navigation Wheel, 46, 46
Full Ribbon display, 39, 39
Function column for wall 

layers, 150 – 151
Furniture category, 62
Furniture System category, 62

G
gable roofs, 398, 398

with asymmetric slopes, 
394, 394

Dutch gable with glazed 
roofs, 402, 402

Dutch gables, 403, 403
with extending pergola, 

399, 399
four-sided, 406, 406
hip and gable, 400, 400

gambrel roofs, 401, 401
gbXML, 523 – 525, 524
Generic Model face based.rft 

template, 328
Generic Models category, 17
Generic Tag.rft template, 138
glazed panels, 370
glazing, 528 – 529, 528
global settings, 168, 169

area and volume 
computation, 168 – 169, 169

defaults, 172 – 176, 173 – 176
keynotes, 170, 171
materials, 171 – 172, 171
units, 169 – 170, 170

Go to View dialog box, 190, 
190, 632, 633

granting permissions, 704 – 706, 
705 – 706

graphic appearance
consistency settings

dimension styles, 
113 – 117, 114 – 115

Fill Patterns, 108 – 113, 
108 – 110, 112 – 113

Line Patterns, 103 – 104, 
104 – 105

Line Styles, 102 – 103, 
102 – 103

Materials Editor, 
106 – 107, 106

Object Styles,  
100 – 102, 101

text, 117 – 119, 118
markups, 686, 686, 688
schedules, 503 – 506, 

504 – 505
Graphic Display Options 

dialog box
elevations, 456, 456
silhouetted edge displays, 

464, 464
sun and shadows,  

442 – 443, 442
sun studies, 512 – 513, 513, 

515 – 516
true-color shading, 456

graphic overrides, 166 – 168, 
167 – 168, 452 – 453, 452

graphical selection, 537 – 538, 537
graphics cards, 733, 734
Graphics tab, 106 – 107
Green Building Studio service, 

525, 525 – 526
Green Building xml,  

523 – 525, 524
grids, 185 – 186, 185

curtain walls, 369 – 370, 
369 – 370, 372, 372

tags, 135
work planes, 190, 191

Grids worksets, 691
grips

markup, 686, 687
mass manipulation, 239, 239

gross area
calculations, 483
floors, 279, 279
plans, 485 – 487, 485 – 487

gross building schedules, 493
Group Edit mode, 588 – 589, 

588 – 589
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Group Edit toolbar, 589
Group Properties dialog  

box, 589
groups, 584

adding rooms to, 589 – 590, 
590 – 591

arrays, 85 – 87, 86
best practices for, 601
creating and managing, 585
detail, 600 – 601, 600 – 601, 619
detail elements for, 592, 593
editing, 599 – 600, 600
lights, 469 – 470, 470
vs. links, 607 – 609, 608
moving elements in, 599, 599
nesting, 591 – 593,  

591 – 593, 598
parameters, 559 – 560, 

559 – 560
as parts of projects, 598
Project Browser views, 55
repeating, 584 – 589, 

584 – 589, 597 – 598, 
597 – 598

variations, 594 – 597, 
594 – 597

H
hatch patterns, 108 – 113, 

108 – 110, 112 – 113
head graphics in section tags, 

125 – 126, 125 – 126
heads, callout, 127 – 130, 

127 – 130
height

railings, 433, 433
text, 118

Height Offset At Head  
setting, 391

Help menu, 743
Hide option, 506
hiding

markups, 688
schedule elements, 506
sections, 68 – 69, 69

high-contrast black and white 
effects, 444, 444

hip and gable hybrid roofs, 
400, 400

hipped roofs, 397 – 398, 397 – 398
with extruded roof 

dormers, 407, 407
with sloped arrow 

dormers, 404 – 405, 
404 – 405

historical data, 525
History dialog box, 700
history of design and 

documentation, 1 – 2
Home tab

design bar, 315
Ribbon, 39 – 40, 39 – 40

Horizontal tag orientation, 553
host-based elements, 303
host-based families, 322 – 323, 323
Host Layer Line Styles dialog 

box, 167 – 168, 168
host objects in graphic 

overrides, 166 – 168, 167 – 168

I
identical buildings on shared 

sites, 604
Identity Data property, 540
Identity tab, 107, 556, 557
IES <Virtual Environment> 

application, 522 – 523, 523
images

in elevation views, 
457 – 458, 458

for materials, 474 – 475, 
474 – 475

Imperial library, 576
imperial units, 170
Import CAD Formats dialog 

box, 291, 291
Import/Link dialog box, 616, 

661, 661
Import/Link RVT dialog box, 

605 – 606, 605
Import Unit section, 616

imported files and geometry
AutoDesk Maya for, 

293 – 294, 294
categories and 

subcategories, 20, 21
exploding, 732
Inventor for, 294 – 295, 

295 – 296
limitations, 20
in performance, 733 – 734
positioning, 268 – 269
Rhino for, 292 – 293, 

292 – 293
SketchUp for, 290 – 292, 

291 – 292
importing

3D conceptual models,  
262, 262

Design Review markups, 
687 – 688, 687

details, 612 – 618, 613 – 614, 
617 – 618, 661, 661

DWG/DGN site 
information, 266

patterns, 111 – 113, 112 – 113
with SketchUp, 291 – 292, 291
views, 669 – 670, 669 – 670

in-place families, 31 – 32, 32, 
200, 201, 368

In-Place Mass tool, 236 – 237, 
237, 291

in-place roofs, 385, 385
in-place walls, 368, 368
inches units, 170
Increase/Decrease Focal 

Length option, 461 – 462, 463
infill wall types, 370
InfoCenter, 37 – 38, 37
information for details, 

630 – 631, 630 – 631
Insert 2D Elements dialog box, 

669 – 670, 670
Insert tab, 40, 40
Inside detail option, 623
instance parameters, 21 – 22, 

555 – 556
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Instance Properties dialog box, 
52, 53

callout tags, 130
cost schedules, 313, 313
door tags, 137
elevation tags, 133
parametric extrusions,  

246, 246
parametric material, 

247 – 249, 249
revision clouds, 678, 678
revolves, 251, 251
scope boxes, 188, 188
section tags, 126
templates, 175, 175
UV surface divisions, 260
wall extensions, 367, 367
walls, 148
worksets, 695, 696

instances, selecting, 76 – 77, 77
Insulation Bulge to Width 

Ratio setting, 624
Insulation tool, 624, 624
intensities, sun, 443, 443
interaction, 7
interface. See user interface
Interior Tick Mark option, 116
Interiors workset, 694
Inventor software, 294 – 295, 

295 – 296
invisible lines, 138
Isolate option, schedules, 506
Italic setting, 118

J
jogged sections, 67, 67
Join Geometry tool, 93 – 94, 93, 

241, 285
joins, 93 – 94, 93

masses, 284 – 286, 284 – 286
solids, 241 – 242, 241 – 242
walls, 354, 354

K
Keep Readable option, 109,  

110, 118
keyboard shortcuts, 48, 48, 

95 – 96, 95
Keyboard.txt file, 96
KeyboardShortcuts.txt file, 48
Keynote command, 571
keynote legend schedules, 494
keynotes, 138 – 140, 139 – 140, 

570 – 571, 570 – 571
behavior and editing, 

571 – 572
elements for, 579 – 580, 579
family, 576 – 580, 576 – 579
filenaming conventions, 572
legends, 494, 574 – 576, 575
predefining, 580 – 581, 

580 – 581
schedules, 576
settings, 170, 171, 573
in views, 531, 573 – 574, 574
wall sections, 576 – 580, 

577 – 579
keys, schedule, 546 – 549, 

547 – 549
keytips, 48, 48
Koolhaas, Rem, 603 – 604, 604

L
labels

custom title blocks, 142, 143
keynotes, 139
section view tags, 122
shared parameters, 566 – 567

lamp, 219 – 221, 219 – 220
lampshade, 221, 221
Landing Carriage Height 

setting, 161
Landing Overlap setting, 158
landings, 431, 431
layer joins cleanup, 353 – 354, 353
layers, 10

custom walls, 150 – 154, 
151 – 152

extending, 366 – 367, 
366 – 367

importing and linking, 616
merging, 360, 361
overrides, 166 – 168, 168
position, 154, 154
splitting, 358 – 359, 359 – 360

Layout modes, 623
LCR (Lot Coverage Ratio), 271
Le Corbusier, 2
Leader Arrowhead setting, 118
leader lines, 680, 680
Leader option, 538
Leadership in Environmental 

and Energy Design (LEED) 
system, 508 – 509, 521

Legend tool, 446
legends, keynotes, 494,  

574 – 576, 575
length

keynotes, 139
lines, 116
nosing, 159
units, 165, 169

Length/Format dialog box, 
478, 478, 517, 517

Level tool, 275 – 277
levels, 185 – 186

bidirectional relationships, 
22 – 23

default settings, 173
floor plans, 55 – 56, 55
roof slopes, 23 – 24, 24
rooms, 539
selection by, 79
tags, 134, 134

levels of detail
families, 658 – 659
in performance, 735
walls, 153, 154

Libeskind, Daniel, 4, 4
libraries

keynotes, 576
materials, 473, 473, 476
organizing, 29 – 30, 29 – 30

lifecycle costs, 229
Light Fixtures option, 469
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lighting
daylighting, 527 – 529, 

528 – 529
settings, 468 – 470, 468 – 470

lighting fixtures, 322, 323
Limit Offset property, 450, 450, 

539 – 540
line-based families, 326 – 328, 

327 – 328
Line Pattern Properties dialog 

box, 103 – 104, 104
line patterns

creating, 103 – 104, 104 – 105
elevation tags, 132
level tags, 134

Line Patterns dialog box, 
103 – 104, 104

Line Styles dialog box,  
102 – 103, 102

line tools
custom title blocks, 141
Insulation, 624, 624
Linework, 454 – 455, 454, 

628, 628
regions, 625 – 626, 625 – 626
Show Hidden Lines, 

626 – 627, 627 – 628
Line Weights dialog box, 

102 – 103, 103
linear arrays, 86
linear force units, 165
lines

boundary, 485 – 486, 486
extending, 90
invisible, 138
offsetting, 91, 91
repeating details for, 

623 – 624, 624
separation, 535 – 536, 536
silhouetted edge displays, 

464, 465
splitting, 90, 90
styles, 102 – 103, 102 – 103, 

166 – 168, 167 – 168
symbolic, 665 – 667, 665 – 667
trimming, 89

lineweights, 102 – 103, 102
dimensions, 115
elevation tags, 132
level tags, 134
text, 118

links and linking, 602 – 603, 
602 – 603

common uses, 603 – 604, 604
details, 612 – 613, 614

CAD details, 617 – 618, 
617 – 618

CAD formats,  
614 – 615, 614

files, 605 – 606, 605
vs. groups, 607 – 609, 608
markups, 687
parameters, 337 – 339, 

338 – 339
Project Browser views, 54, 54
special features, 606 – 607
unloading and  

reloading, 607
visibility, 606 – 607, 607

live connections, links for, 613
Load Family dialog box, 28 – 30, 

28 – 30
loadable family types, 200, 200
loaded profiles for sweeps, 211
loading

group files, 593, 593
shared work, 701
tags, 550
from type catalogs, 166, 166

local files
in performance, 733
in workflows, 698 – 699, 699

Lockable Door parameter, 566
lofts, 252 – 256, 252 – 256
loops

blends, 221, 221
lofts, 252
profiles, 324, 324
revolves, 207 – 208, 207 – 208
sketches, 182, 182
sweeps, 210

Lot Coverage Ratio (LCR), 271

M
M_Generic Tag.rtf template, 138
main model, 299 – 303, 306
Make Elements Editable 

option, 702, 702
Make Workset Editable  

option, 692
Manage Links dialog box,  

614, 615
Manage Place and Locations 

dialog box, 441, 441, 514
Manage tab, 41, 41
Manual - Base Point option, 

269, 606
Manual - Center option,  

269, 606
Manual - Origin option,  

269, 606
manual dimensioning, 173
markups

Design Review for, 686, 
686 – 687

importing, 687 – 688, 687
masking regions, 620, 620, 

641 – 643, 641 – 643
Mass Floors tool, 275 – 278, 

276 – 278, 282
Mass.rft file, 242, 244
Massing & Site tab, 41, 41, 237
massing and massing studies, 

227 – 229, 227 – 229
3D components on divided 

surfaces, 286 – 290, 
287 – 290

3D contexts. See 3D models
best practices, 273, 273 – 274
boolean operations, 

240 – 242, 240 – 242
direct manipulation, 

239 – 240, 239
Floor Area tool, 275 – 278, 

276 – 278
form making. See 

form making and 
rationalization
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imported files and 
geometry, 290 – 296, 
291 – 296

importing 3D conceptual 
models, 262, 262

join geometry, 241 – 242, 
241 – 242

mass creation, 237 – 239, 
237 – 238

mass element creation, 236
mass element visibility, 

236 – 237, 236 – 237
mass family creation, 

242 – 243, 243
mass joining, 284 – 286, 

284 – 286
massing forms,  

238 – 239, 238
Model by Face tool, 

281 – 284, 282 – 283
scheduling, 284 – 286, 

284 – 286
tools, 234, 234 – 235
uses, 230 – 233, 230 – 233
workflows, 201, 201, 

229 – 230
master builders, 2
Match option for groups, 594
Match Type option, 77 – 78
Material column for wall 

layers, 151 – 152, 152
materials, 472

custom images, 474 – 475, 
474 – 475

editing, 105 – 108, 105 – 107, 
472, 472

entourage, 475 – 476, 476
fills, 108 – 113, 108 – 110, 

112 – 113
keynotes, 139, 571, 576 – 580, 

577 – 579
parameters, 556, 557
parametric, 247 – 249, 

248 – 249
replacing, 473 – 474, 473
settings, 171 – 172, 171
stairs, 159

tags, 551
takeoff schedules, 494
tracking, 519 – 520, 520 – 521
true-elevation color, 455, 455
for types, 162
wall finish, 358 – 360, 

358 – 360
Maximum Riser Height 

setting, 159
Maximum Segment Angle 

setting, 214, 214
Maximum Spacing modes, 623
Maya, 293 – 294, 294
Medium level of detail, 153
Membrane Layer option, 151
MEP models, 507
merging layers, 360, 361
Mesh Modeler, 296, 296
metal decks, 647 – 648, 647 – 648
Metric library, 576
Metric Mass.rft file, 244
metric units, 170
Middle Stringers setting, 161
Minimum Tread Depth  

setting, 159
Mirror tool, 85, 85
mirroring elements, 83 – 85, 

84 – 85
mistakes in worksharing, 702
miter joins, 354, 354
MMiscellaneous Wide Flange-

Column.rfa family, 164
Model by Face tool, 281 – 284, 

282 – 283
model groups, 584
Model Object categories, 17 – 18, 

18 – 19
model patterns, 108 – 109
Modeling In-Place tool, 200, 200
modeling principles, 179, 

180 – 181
blends, 215 – 223, 215 – 222
extrusions, 202 – 205, 

203 – 205
overview, 199 – 201, 200 – 201
revolves, 206 – 209, 206 – 209

sketch-based design, 179 – 180
floors and roofs, 

181 – 183, 181 – 183
work planes. See work 

planes
solids and voids, 222 – 224, 

223 – 224
sweeps, 209 – 214, 209 – 214

Modeling tab, 20
models

3D physical, 228 – 229, 228
details, 639 – 650, 639 – 650
importing, 262, 262
objects, 100 – 102, 101

Modify Roof panel, 384
Modify Schedule/Quantities 

tab, 505, 505
Modify Sub Elements tool, 416
Modify tab, 40, 40
Modify Vertical Structure 

options, 362
Modify Walls tab, 42, 42
Monolithic Stair setting, 158
Move To 2nd option, 85, 86
Move tool, 81 – 82, 81
moving elements, 79 – 80

in groups, 599, 599
with nearby elements, 82, 82
nudging, 82
with temporary 

dimensions, 80 – 81, 80 – 81
between worksets, 

696 – 698, 697
mullions, 369, 369, 372, 372 – 373
Multi-Category tags, 551
Multi-Day sun settings, 513, 

515 – 516, 516, 518, 518
multicategory schedules, 493
multipitch roofs, 411, 411
Multiple Alignment option, 88
multiple buildings on shared 

site plans, 603 – 604, 604
Multiple Copy or Array 

command, 275
multiple massing design 

options, 273, 273 – 274
muntins, 341, 341
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N
Name dialog box

callout tags, 129, 129
elevation tags, 133, 133
section tags, 125 – 126, 

125 – 126
names

callout tags, 129, 129
dimension types, 117
door tags, 565, 565
elevation tags, 132 – 133, 133
line patterns, 104
materials, 106
section tags, 125 – 126, 

125 – 126
text type, 119
work planes, 189

natural lighting, 509, 527 – 530, 
528 – 529

Navigation bar, 45 – 46, 46
navigator pane, 686
Nearby Elements feature, 82, 82
nesting

chairs, 346, 346
detail components, 

648 – 650, 649 – 650
families, 335 – 339, 336 – 340
groups, 591 – 593,  

591 – 593, 598
links, 606

New Area Plan dialog box,  
485, 485

New dialog box for door  
tags, 564

New Drafting View dialog box, 
612, 612, 617, 617

New Pattern dialog box, 109, 
112 – 113, 112 – 113

New Schedule dialog box, 
277, 277, 493, 496, 547 – 548, 
547 – 548

No Edge option, 168
Noguchi, Isamu, 221
nonlinear sections, 121
Nosing Length setting, 159
Nosing Profile setting, 159
note block schedules, 494

notes
keynotes. See keynotes
text, 138 – 140, 139 – 140

nudging elements, 82
numbering

keynotes, 573
revisions, 674

NURBS shape, 262, 262
NURBS surfaces, 292 – 293, 

292 – 293

O
Object Styles dialog box, 16, 16, 

636, 636
Annotation Objects tab, 19, 

119, 119
component families, 27
cutting, 58
floor plans, 56
for graphic consistency, 

100 – 102, 101
Imported Objects tab, 20, 21
Model Object tab, 17 – 18
Modeling tab, 20
revision clouds, 677, 677

offsets
Floor by Face tool, 283, 283
lines and walls, 91, 91

opaque filled regions, 625, 625
Open dialog box

auditing files, 739
libraries, 30

Open Stringer Offset  
setting, 161

optimizing. See 
troubleshooting and 
optimizing tips

Options bar, 44, 44, 432
Options dialog box

application frame, 37, 37
File Locations tab, 98, 99
folders, 29

order of panels, 47, 47
Ordinate dimension style, 114
Orient to Other View dialog 

box, 656, 656

orientation
3D views, 71 – 72, 71, 

655 – 656, 656 – 657
fill patterns, 109, 109
imported site data, 

266 – 268, 267 – 268
tags, 553

origins
groups, 586, 587
linked files, 268, 605 – 606
orienting, 109
rotation, 83 – 85, 84

output settings, 467 – 468, 468
overconstrained objects, 739
Overhang parameter, 380, 380
overlapping items

rooms, 534, 535
walls, 586

overrides. See Visibility/
Graphic Overrides dialog box

ownership of elements, 
701 – 706, 702 – 706

P
Paint tool, 94 – 95, 95
Palladio, Andrea, 1 – 2
Panel Tiles display, 39, 39
panels

curtain, 332, 332 – 333, 
369 – 370, 370, 373 – 375, 
374 – 375

SIPs, 640 – 641
Parameter Properties dialog box

arrays, 346 – 347, 347
base modeling, 644, 644
custom parameters, 

555 – 556, 555 – 556, 560, 560
extrusions, 245, 245
visibility, 348, 349

parameters and parametric 
elements, 15 – 16, 16 – 17

3D models and families, 3
building, 345 – 349, 

345 – 349
modeling, 319, 320

Annotation object 
categories, 19
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arrays, 340 – 341, 340 – 341, 
346 – 348, 347 – 348

base molding, 644, 644
bidirectional relationships, 

22 – 23, 22 – 23
constraints, 25, 25
design options with, 

313 – 316, 314 – 316
dimensions, 342, 342 – 343
door tags, 566
extrusions, 244 – 247, 

244 – 247
families, 26 – 31, 26 – 32
forms, 242
imported categories/

subcategories, 20, 21
linking, 337 – 339, 338 – 339
material, 247 – 249, 248 – 249
Model Object categories, 

17 – 18, 18 – 19
overriding, 32 – 34, 33
shared. See shared 

parameters
subcategories, 20, 20
sun shades, 345, 345
type and instance 

parameters, 21 – 22
views, 20
visibility, 348, 349

pasting, 78 – 79, 78
.pat files, 110 – 111, 113
paths

keynotes, 573
sweeps, 209 – 210, 209 – 210

patterns
balusters, 428 – 429, 428 – 429
custom, 108 – 112, 108 – 110
fill, 108 – 113, 108 – 110, 

112 – 113
importing, 111 – 113, 

112 – 113
line, 103 – 104, 104 – 105
surfaces, 261, 261

PDFs in performance, 738
people, 475 – 476

performance
best practices, 733 – 739, 

734 – 738
recommendations, 731 – 733, 

732 – 733
shadows, 445

Perimeter property, 540
perimeters in volume 

calculations, 543 – 544, 
543 – 544

periods (.) in type-catalog 
syntax, 164

permissions
granting, 704 – 706, 705 – 706
requesting, 703 – 704, 

703 – 704
taking, 706 – 707

perspective views, 461
3D, 71 – 72, 72 – 73
animated walkthroughs, 

477 – 478, 478
cameras, 463, 463
creating, 461 – 462, 462 – 463
exporting, 478 – 479, 479
photorealistic renderings. 

See photorealistic 
renderings

silhouetted edge displays, 
464, 464 – 465

Phase property, 540
photorealistic renderings,  

465, 466
background settings, 

470 – 471, 471
exposure settings, 472, 472
families, 329 – 330, 330 – 331
guidelines, 476 – 477
lighting settings, 468 – 470, 

468 – 470
materials, 472 – 476, 473 – 476
output settings,  

467 – 468, 468
quality settings,  

466 – 467, 467
rendering process, 471, 471
saving as images, 472

Physical tab, 107
Pick 3D Edges option, 210
Pick a Line and Use the Work 

Plane It Was Sketched In 
option, 190, 190

Pick a Plane option, 189, 190
Pick Level Graphics option, 79
Pick New Host tool, 192
Pick Path option, 210
Pick Plane option, 190
Pick Supports tool, 416
Pick Walls method, 378, 379
pinning elements, 91 – 92
Place Mass tool, 236
Place Request option, 703
Place tab, 441, 441
Place Wall tab, 42, 42
placing

balusters, 426, 427
repetitive units, 585 – 589, 

586 – 589
revision clouds, 676 – 678, 

677 – 678
tags, 550 – 551, 550 – 551

Plan/RCP option, 665
plan regions, 66
plan views

default settings, 173
Project Browser views, 

62 – 66, 63 – 66
visibility in, 665

planes. See work planes
planning projects, 742
plans, presentation-quality, 

451 – 453, 451 – 453
plywood, 327, 327
positioning imported files, 

268 – 269
posts, railings, 424, 424, 

426 – 428, 427
predefined color schemes, 448
predefined profiles, 210
predefining keynotes, 580 – 581, 

580 – 581
preliminary cost estimate 

schedules, 502 – 506, 502 – 505
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preliminary designs, 481
Foundation model. See 

Foundation model
sustainability. See 

sustainability
presentation techniques, 439

color-coded plans and 
sections, 445 – 450, 
446 – 450

elevations, 453 – 455, 
453 – 456

plans and sections, 
451 – 453, 451 – 453

shadows, 439 – 445, 440 – 445
previewing

custom walls, 150
material images, 475, 475
sun studies, 517

primary design set options, 300
primary range for floor plans, 

59 – 60, 59 – 60
principles of modeling. See 

modeling principles
Print Setup dialog box, 684, 684
printing

Design Review, 684, 684
in performance, 738

problem-solving, 8, 8
process change, 4 – 5, 5, 10 – 11
Profile Family template, 361
profiles

3D content, 323 – 326, 
324 – 326

reveals, 361 – 362, 362 – 363
revolves, 206, 208, 208
subtractive, 364
sweeps, 210 – 212, 210 – 211, 

361 – 362
programs

feasibility, 271 – 272, 272
verification, 231 – 233, 

231 – 233
Project Browser, 46, 46

for callouts, 629, 629
details, 667 – 669, 668 – 669
family details, 659
groups, 586 – 587, 587

nesting links in, 606
undocking, 48, 48
views, 49 – 51, 49 – 51

3D, 71 – 73, 71 – 73
activating, 53, 53
custom organization, 

51 – 52, 51 – 52
elevations, 68 – 71, 70
families, 54, 54
floor plans, 55 – 62, 55 – 62
groups, 55
links, 54, 54
plan views, 62 – 66, 

63 – 66
section views, 66 – 68, 

67 – 68
sheets, 52 – 53, 53

project environment types, 
162 – 163

project parameters, 555 – 556, 
555 – 557, 561 – 562, 561 – 562

Project Settings menu, 168, 169
project standards worksets, 692
Project Units dialog box, 

169 – 170, 170
projection graphics, 18, 19
projects on Start screen, 34, 34
Promotional Glazing  

material, 528
properties

elements, 6, 7
rooms, 539 – 540

prototyping, 232
Publish Coordinates option, 

269, 605
Purge Unused dialog box, 734, 

735, 740
Purge Unused Elements dialog 

box, 119

Q
quality

daylighting, 527 – 530, 
528 – 529

rendering settings, 
466 – 467, 467

quantities for design options, 
313 – 314, 313

Quick Access toolbar, 37, 37

R
radial arrays, 86, 86
radial dimensions, 113
Radius setting for arrays,  

346, 347
Rafter property, 382
Rafter Cut property, 382
railings, 421 – 423, 421 – 423

in auditoriums, 436
balusters per tread on 

stairs, 429 – 431, 430
construction, 425, 425
main pattern, 428 – 429, 

428 – 429
miscellaneous controls, 

431 – 433, 431 – 434
post settings, 426 – 428, 427
rails, 424 – 425, 425
subelements and 

principles, 423 – 425, 
423 – 425

on walls, 434 – 436, 434 – 436
rapid prototyping, 232
RCP (Reflected Ceiling Plan) 

view, 633
recessed walls, hip roofs 

following, 397, 397
Rectangle tool, 244
Rectangular Handrail  

profile, 426
recyclable parameters, 555 – 556
recycled materials, 519 – 520, 

520 – 521
Reference Label settings, 132
reference lines, 187, 187
reference planes, 186, 186, 205, 

205
Reflected Ceiling Plan (RCP) 

view, 633
Region Properties dialog box, 

645
Region tool, 625 – 626, 625 – 626
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regions
filled, 645 – 646
masking, 620, 620, 641 – 643, 

641 – 643
rehost elements, 192
Related to Mass property, 381
relationships

bidirectional, 22 – 23, 22 – 23
building mass and 

underlying mass, 297, 297
Relative keynote path  

method, 573
relinquishing permissions, 703
reloading

groups, 595
links, 607

Remove tool for groups, 589
renaming

dimension types, 117
door tags, 565, 565
line patterns, 104
materials, 106
text type, 119

Render Appearance Library, 
171, 171, 473, 473, 476

Render Appearance tab, 108, 
472, 473, 528, 528

Render Quality Settings dialog 
box, 467, 467

rendering. See photorealistic 
renderings

Rendering Appearance Source 
parameter, 334

Rendering dialog box, 466, 466
background settings, 

470 – 471, 471
exposure settings, 472, 472
lighting settings, 468 – 470, 

468 – 470
output settings,  

467 – 468, 468
quality settings,  

466 – 467, 467
rendering process, 471, 471

Rendering Progress dialog box, 
471, 471

rentable area
calculations, 483
plans, 487 – 490, 487 – 490
schedules

making, 495 – 499, 495, 
497 – 499

on sheets, 499 – 500, 
499 – 500

repetitive details and  
elements, 583

creating and placing, 
585 – 589, 586 – 589, 
621 – 622, 621 – 622

floors, 646 – 647, 647
groups, 584, 584, 597 – 598, 

597 – 598
for line types, 623 – 624, 624

replacing materials, 473 – 474, 473
Report Shared Coordinates 

option, 269, 606
requesting permissions, 

703 – 704, 703 – 704
resizing elements, 87, 87
Restore All Excluded option, 597
Return Panels to Ribbon 

command, 47, 47
reusing details, 667 – 670, 

668 – 670
Reveal Hidden Elements  

mode, 68
reveals, 361 – 365, 361 – 365
Review Warnings option,  

740, 740
revision clouds

placement, 676 – 678, 
677 – 678

tagging, 679 – 680, 679 – 680
visibility, 675 – 676, 676

Revision Properties dialog box, 
143, 144

revision schedules, 143 – 145, 
144 – 145

Revit City service, 743
Revit OpEd blog, 744
revolve forms, 249 – 252, 

250 – 252
revolves, 206 – 209, 206 – 209

.rfa files, 28
Rhino software, 292 – 293, 

292 – 293
ribbons, 35, 35, 39, 39
Rich Photorealistic Content 

(RPC) families, 329 – 330, 
330 – 331, 334, 475, 476

ridge skylight roofs, 388 – 391, 
388 – 391

Riser Thickness setting, 160
Riser to Tread Connection 

setting, 160
Riser Type setting, 160, 160
Roof by Extrusion tool, 384, 384
roofs, 377

barrel, 383, 383, 385, 410, 410
bidirectional relationships, 

22, 22
complex, 224, 224
cone, 408, 408
creation methods, 377 – 378
dome, 208, 208, 385, 385, 

409, 409
dormers, 412 – 415, 412 – 415
by extrusion, 193 – 197, 

193 – 197, 383 – 384, 
383 – 384

flat, 393, 393
footprint, 378 – 382, 378 – 383
gable, 398, 398

with asymmetric slopes, 
394, 394

Dutch gable with glazed 
roofs, 402, 402

Dutch gables, 403, 403
with extending pergola, 

399, 399
four-sided, 406, 406
hip and gable, 400, 400

gambrel, 401, 401
hipped, 397 – 398, 397 – 398

with extruded roof 
dormers, 407, 407

with sloped arrow 
dormers, 404 – 405, 
404 – 405

in-place, 385, 385
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Model by Face tool, 283
in modeling principles, 

199 – 200
multipitch, 411, 411
ridge skylight, 388 – 391, 

388 – 391
shapes, 416 – 417, 416 – 417
shed, 392, 392, 395 – 396, 395
sketch-based design, 

181 – 183, 181 – 183
sloped, 23 – 24, 24, 416 – 419, 

416 – 419
sloped arrows, 391 – 392, 

391 – 392
sloped glazing, 386, 387
types, 155 – 156, 155
with warped surfaces,  

419, 419
Room/Area Reports, 521, 522
Room Bounding property, 381, 

532, 532
rooms

annotating, 532 – 534, 
532 – 535

area calculations, 540 – 542, 
540 – 543

area plans, 483 – 484, 
483 – 485

creating and placing, 
585 – 589, 586 – 589

design options for, 314 – 316, 
314 – 316

groups for, 584, 584, 
589 – 590, 590 – 591

overlapping, 534, 535
properties, 539 – 540
in section views, 538
selecting, 537 – 538, 537
separation lines, 535 – 536, 536
styles, 549, 549
tags, 483, 483, 538, 538 – 539
volume calculations, 

541 – 546, 541 – 546, 
732 – 733, 733

window surface 
percentage, 521, 522

Rotate True North option, 268

rotating
detail components, 623
elements, 83 – 85, 84 – 85
orientation, 268
sweeps, 211, 211

RPC (Rich Photorealistic 
Content) families, 329 – 330, 
330 – 331, 334, 475, 476

RPC Family.rft template, 330

S
Same Place option, 79
SAT files

importing and linking, 616
with Inventor, 295
with Rhino, 292

Save Group option, 595
Save to Central dialog box,  

700, 700
saving

photorealistic renderings 
as images, 472

shared work, 700 – 701, 
700 – 701

sun studies, 517
scale

coarse scale fill patterns, 
451 – 452

elements, 87, 87
imported site data, 266
material images, 475

Schedule Properties dialog 
box, 495 – 496, 495, 497 – 498, 
502 – 504, 504

schedules
capabilities, 501 – 502, 

501 – 502
cost, 313 – 314, 313
creating, 492 – 494
custom parameters, 557, 557
floors, 277 – 278, 277
graphic appearance of, 

503 – 506, 504 – 505
keynotes, 576
keys, 546 – 549, 547 – 549
link elements, 606

mass elements, 284 – 286, 
284 – 286

nested families, 337
preliminary cost estimates, 

502 – 506, 502 – 505
rentable area, 495 – 499, 495, 

497 – 499
revision, 143 – 145, 144 – 145
on sheets, 499 – 500, 

499 – 500, 505
schemes

color fill, 446 – 448, 447 – 448
settings, 176

scope boxes, 188 – 189, 188
search function in InfoCenter, 38
Second end blend setting, 215
section boxes, 655, 655
Section Head setting, 121
Section Tail setting, 121
sections and section views

colored, 449 – 450, 450
presentation-quality, 

451 – 453, 451 – 453
Project Browser views, 

66 – 68, 67 – 68
rooms in, 538
split, 358 – 359, 359 – 360
tags, 121 – 126, 121 – 126
walls

details, 632 – 650, 
632 – 650

keynotes for, 576 – 580, 
577 – 579

segmented sweeps, 213 – 214, 
213 – 214

Select Items to Copy dialog 
box, 27, 27

Select Layers/Levels to 
Import/Link dialog box,  
661, 661

Select Levels option, 78
Select Parameter dialog box, 

565, 565
Select Views option, 79
Selection Count tool, 76
Selection Filter dialog box, 38
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selections, 75, 76 – 78, 77
for copying, 27, 27, 78 – 79, 

449, 449
Design Review, 683, 683
element editing by, 306
filtering, 76, 77
floor areas, 282
instances, 76 – 77, 77,  

594, 698
layers, 661, 661
levels, 597 – 598
parameters, 565
rooms, 537 – 538, 537

semicolons (;) in type-catalog 
syntax, 164

separation lines, 535 – 536, 536
Set Host option, 436
sets, design-option, 300 – 301, 301
shades

parametric, 345, 345
from sweeps, 211 – 212, 211

shadows and shading, 439 – 440
for analytical purposes, 

441 – 443, 441 – 443
enabling, 442, 442
for expressive drawings, 

440, 440, 444 – 445, 
444 – 445

high-contrast black and 
white effects, 444, 444

materials, 107
performance, 445, 737
with SketchUp, 292, 292
soft, 445, 445
sun, 509 – 510, 509 – 510
sun and shadow studies, 

441 – 443, 441 – 443
shaft opening, 670 – 671, 670 – 671
Shape Editing tools, 282
shapes

elevation tags, 131
floors, 155
roofs, 155, 416 – 417, 416 – 417

Shared Coordinates settings, 269
Shared Levels and Grids 

workset, 691, 694
shared parameters, 334 – 335, 554

creating, 558 – 562, 559 – 562
door tags, 564 – 567, 564 – 568

groups, 559 – 560, 559 – 560
notes and cautions, 567
project, 555 – 556, 555 – 557, 

561 – 562, 561 – 562
shared site plans, buildings on, 

603 – 604
shared work, saving, 700 – 701, 

700 – 701
shed roofs, 392, 392, 395 – 396, 

395
Sheet Issues/Revisions dialog 

box, 674 – 676, 674, 676
sheets

exporting, 684 – 686, 
684 – 686

Project Browser views, 
52 – 53, 53

schedules on, 499 – 500, 
499 – 500, 505

views on, 145
Shell and Core workset, 694
shortcuts, keyboard, 48, 48, 

95 – 96, 95
Show Hidden Lines tool, 

626 – 627, 627 – 628
Show Mass tool, 236
Show Opening Height  

option, 117
Show option

schedules, 506
shared elements, 705

Show Related Warnings 
option, 538

Show View Name setting, 132
shower fixture, 212, 212
shutters, 342
silhouetted edge displays, 464, 

464 – 465
SIM (Similar) condition, 

632 – 633, 632 – 634
Simple fill pattern option, 110, 

112 – 113, 112
Single-Day sun settings, 513, 

515 – 516, 516
SIPs (structurally insulated 

panels), 640 – 641
site data, 266 – 268, 267 – 268
site studies, 230, 230
Site workset, 694

size
elements, 87, 87
text, 118, 132, 159
type catalogs for, 162

sketch-based design, 179 – 180
floors and roofs, 181 – 183, 

181 – 183
modeling principles, 

180 – 181, 180 – 181
rules of thumb, 183

Sketch mode, 26
for elements, 43
railings, 432

SketchUp software, 290 – 292, 
291 – 292

skins, exterior, 305, 305
SKP format

importing and linking, 616
with SketchUp, 290 – 292

sky background, 470 – 471
skylight roofs, 388 – 391, 

388 – 391
skylights, 322, 323
slicing masses, 277
Slope tool, 433, 433
Slope Arrow tool, 435
sloped glazing curtain panel 

type, 410
slopes

floors, 155
railings, 433, 435 – 436
sloped roofs, 23 – 24, 24, 155, 

416 – 419, 416 – 419
barrel, 410, 410
ridge skylight roofs, 

388 – 391, 388 – 391
slope arrows for, 

391 – 392, 391 – 392
sloped arrow dormers, 

hipped roofs with, 
404 – 405, 404 – 405

sloped glazing roofs, 
386, 387

smart workflows
groups. See groups
links. See links and linking
repetitive elements, 583

snap distance for dimension 
lines, 117
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soft shadows, 445, 445
Solid Form options, 202, 202
solid panels, 370
solids and solid shapes

characteristics, 222 – 224, 
223 – 224

with extrusions, 205, 205
massing forms, 240 – 241, 

240 – 241
Sorting tab, 503
Sorting/Grouping tab, 496, 497
Space parameter for railings, 428
Spacebar for rotation, 83, 83
Spacing detail option, 623
Specify Coordinates at a Point 

option, 269, 605
Specify Types dialog box,  

634, 634
Split Face tool, 94, 94
Split Region tool, 359, 359
Split Segment tool, 121
splitting

layers, 358 – 359, 359 – 360
lines and walls, 90, 90

Spread Pattern To Fit setting, 
429, 430

stacked walls, 355 – 356, 
355 – 356

Stafford, Steve, 744
Stair Calculator dialog box, 

158, 158
stairs, 157, 157

balusters per tread, 
429 – 431, 430

properties, 158 – 161, 
159 – 161

standard families, 27 – 28, 28, 
30, 31

Start angle revolve setting,  
207, 207

Start screen, 34 – 35, 34
starting Revit, 34
startup tips, 741 – 743
static text, 122
status bar, 38, 38

SteeringWheel
cameras, 72, 72
perspective views, 461 – 462, 

462 – 463
working with, 45 – 46, 46

Still settings for sun studies, 
513, 516

Stringer Carriage Height 
setting, 161

Stringer Left/Right setting, 161
strong reference planes, 186, 186
structurally insulated panels 

(SIPs), 640 – 641
Structure option for wall 

layers, 150
Structure panel, 42
Structure Settings dialog  

box, 42
styles

dimensions, 113 – 117, 
114 – 115

lines, 102 – 103, 102 – 103, 
166 – 168, 167 – 168

objects. See Object Styles 
dialog box

rooms, 549, 549
subcategories, 20, 20
subdivision surfaces, 296
submodels, 737, 738
Subscription Center, 38
Subscription Support, 743
Substrate option for wall 

layers, 151
subtractive profiles, 364
sun and shadow studies, 

441 – 443, 441 – 443, 509 – 510, 
509 – 510

animated, 515 – 519, 516 – 518
daylighting, 527 – 529, 

528 – 529
exporting, 517, 517
making, 511 – 515, 511 – 515
multi-day, 515 – 516, 515
photorealistic renderings, 

468, 468
previewing, 517
time of day, 513

time of year, 515
true-color shading, 456, 456

Sun Shade family, 338
sun shades

parametric, 345, 345
from sweeps, 211 – 212, 211

sunlight renderings, 468, 468
sunny vs. overcast days, 525
supplemental drawings, 680
surfaces

lofts, 252 – 256, 252 – 256
massing forms, 240, 240
materials, 107, 107
NURBS, 292 – 293, 292 – 293
patterns, 261, 261
rationalization, 259 – 261, 

259 – 261
subdivision, 296
units, 165
warped, 419, 419

sustainability, 507
daylighting, 527 – 529, 

528 – 529
energy analysis, 522 – 525, 

523 – 526
incorporating, 507 – 508
LEED rating system, 508
recycled materials, 

519 – 520, 520 – 521
sun studies. See sun and 

shadow studies
window surface percentage 

vs. room area, 521, 522
sweeps, 209, 209, 256 – 259, 

256 – 259
examples, 212 – 213, 212 – 213
lamp from, 219 – 220, 

219 – 220
paths, 209 – 210, 209 – 210
profiles, 210 – 212, 210 – 211
trajectory segmentation, 

213 – 214, 213 – 214
walls, 361 – 365, 361 – 365

Symbol setting, 134
Symbol at End 1/2 Default 

settings, 134 – 135
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symbolic lines, 665 – 667, 
665 – 667

system families, 26 – 27, 26 – 27, 147
ceilings, 156, 156
creating, 147
doors and windows, 

161 – 162
floors and roofs, 155 – 156, 155
stairs, 157 – 161, 157 – 161
walls. See walls

System Panel Glazed panel, 373
System Panel Solid panel, 373

T
Tab Size setting, 118
tables, revision, 675
Tabs display on Ribbon, 39, 39
Tag on Placement option, 537
tags, 550, 550

adding, 491 – 492, 491 – 492
changing values,  

551 – 552, 551
custom, 119, 119,  

135 – 136, 135
doors, 136 – 138, 136 – 138, 

552 – 554, 553
loading, 550
placing, 550 – 551, 550 – 551
revision clouds, 679 – 680, 

679 – 680
rooms, 483, 483, 538, 

538 – 539
untagged elements, 

552 – 554, 552 – 554
view. See view tags
visibility, 675 – 676, 676
walls, 553 – 554, 554

tail graphics in section tags, 
125 – 126, 125 – 126

Tangent Joins tool, 431
teams

communication with, 742
organizing, 742 – 743

templates
creating, 97 – 100, 98 – 99
custom 3D content, 

320 – 321, 320 – 321

custom title blocks, 141
family, 30, 31
fill patterns, 452 – 453
graphic overrides of host 

objects, 166 – 168, 167 – 168
in performance, 741
strategies, 100
views, 170, 175 – 176, 175, 

452 – 453, 452 – 453
Temporary Dimension 

Properties dialog box, 81, 81
temporary dimensions, 80 – 81, 

80 – 81
testing design options, 231, 231
text

annotating, 568 – 570
dimensions, 117 – 118
elevation tags, 131 – 132, 131
for graphic consistency, 

117 – 119, 118
section view tags, 122, 122
stairs, 159
in views, 531

textnotes, 138 – 140, 139 – 140, 
570 – 571, 570 – 571. See also 
keynotes

Thermal/Air option, 151
Thickness column for wall 

layers, 152
Thickness/Height of Stringers 

setting, 161
Tick Mark Line Weight  

setting, 115
tick marks, 114 – 116, 114 – 116
Tile option, 45
title blocks

custom, 140 – 145, 141 – 145
revision tracking in, 676
updates in, 678

TMY2 (Typical Meteorological 
Year 2) data, 525

tool support, 8 – 9
toolbars, 589
tooltips, 17
Top Extension Distance 

parameter, 366

Top setting
blends, 216
railings, 428

Top view range for floor plans, 
57, 58

tracking changes, 673
BIM and supplemental 

drawings, 680
Design Review. See Design 

Review
revisions, 673 – 680, 674 – 680

tracking recycled materials, 
519 – 520, 520 – 521

Trajectory Segmentation 
option, 213 – 214, 213 – 214

transferring color-fill schemes, 
448 – 449, 449

transparency
elevation views, 457 – 458, 

457 – 458
filled regions, 625, 625

Tread Thickness setting, 159
trees, 475 – 476, 476
Trim Stringers at Top  

setting, 160
trimming

lines and walls, 89, 89
railings, 431

troubleshooting and 
optimizing tips, 731

best practices, 733 – 739, 
734 – 738

blends, 217, 218 – 219
file corruption, 739 – 740, 740
performance, 731 – 733, 

732 – 733
resources for, 743 – 744
startup tips, 741 – 743

true-color elevations, 455 – 456, 
455 – 456

Truss property, 382
turning off lights, 469 – 470, 470
Twisting blend setting, 216
Type Mark field, 551
type parameters, 555
Type properties, 43, 43
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Type Properties dialog box, 
70, 70

callouts, 129 – 130, 130
color fill schemes,  

447 – 448, 447
detail elements, 621 – 622, 623
dimensions, 114 – 115, 114, 117
door tags, 137, 565
elevation tags, 131 – 134, 131
filled regions, 626, 626
keynotes, 580, 580 – 581
linking parameters, 338, 338
profile families, 324 – 326, 325
railing construction, 425, 425
room volumes, 543, 543
stairs, 158, 158
text, 118 – 119
tick marks, 115, 115
view tags, 120, 125 – 126, 126
walls, 148, 153, 153

Type Selector
family types, 42 – 43, 43
materials, 93 – 94, 95
selection by, 77
text, 569

types and type catalogs, 162, 162
3D content. See custom 3D 

content
creating, 162 – 163, 164
loadable, 200, 200
loading from, 166, 166
parameters, 20
in project environment, 

162 – 163
syntax, 164 – 165
units, 165

Types dialog box for  
revolves, 252

Typical Meteorological Year 2 
(TMY2) data, 525

U
UIState.dat file, 47
Unbounded Height  

property, 540
Underline setting, 119

Underside of Winder setting, 
158, 159

undocking Project Browser, 
48, 48

unenclosed room errors,  
534, 534

units
settings, 169 – 170, 170
type catalogs, 165

Unjoin Geometry option, 
241 – 242, 286

unloading
links, 607
unused DWGs and  

views, 733
unused elements

in performance, 734,  
735, 740

unloading, 733
updates

building area schedules, 
501

in title blocks, 678
Upper Limit property, 539
usable area calculations, 484
Use Baluster Per Tread On 

Stairs option, 429 – 431, 430
Use Common Edge Style 

option, 168
Use Function option, 168
Use OpenGL Hardware 

Acceleration option, 733
Use Overlay Planes to Improve 

Display Performance  
option, 733

Use Project Settings option, 504
Use Render Appearance for 

Shading option, 107
Use Sheet Size option, 684, 684
user interface, 34

application frame, 36 – 44, 
36 – 44

Design Review, 682 – 683, 
682 – 683

modifying and 
personalizing, 47 – 48, 
47 – 48

Project Browser. See Project 
Browser

ribbons, 35, 35
Start screen, 34 – 35, 34
starting Revit, 34
SteeringWheel and 

ViewCube, 45 – 46, 46
View window, 45

user keynotes, 139, 571, 581
UV surface divisions, 260, 

260 – 261, 286 – 287, 288

V
Variable property, 155, 155
variable widths, rooms 

calculations for, 543 – 546, 
543 – 546

variations to group instances, 
594 – 597, 594 – 597

vaults, 223, 223
verifying

designs, 278 – 281, 279 – 281
programs, 231 – 233, 

231 – 233
Vertical Opening tool, 384
vertical shapes, 223, 224
Vertical tag orientation, 553
vertices, blend, 216, 217 – 218
video card options, 733, 734
View Control bar, 45, 45
view depth

floor plans, 60 – 62, 60 – 61
in performance, 736, 736
plan views, 62 – 66, 63 – 66
section views, 68, 68

View Detail setting, 735
View/Floor Plan tool, 275
View Range dialog box, 56 – 58, 

57, 62 – 66, 63 – 66
View tab, 41, 41
view tags, 120, 120, 531

callouts, 127 – 130, 127 – 130
elevation, 130 – 134, 131 – 133
grid, 135
levels, 134, 134
section, 121 – 126, 121 – 126
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View Templates dialog box, 
175, 176, 453, 453

View window, 45, 683
ViewCube, 45 – 46, 46
views, 20

annotating, 531, 531
default settings, 175, 175
dependent, 19
drafting, 612, 612, 631
elevation tags, 132
importing, 669 – 670, 

669 – 670
keynotes in, 573 – 574, 574
lists of, 494
in performance, 735, 739
perspective. See perspective 

views
plan

default settings, 175
Project Browser views, 

62 – 66, 63 – 66
visibility in, 665

Project Browser. See Project 
Browser

selection by, 79
on sheets, 145
for sketches, 183
templates, 170, 175 – 176, 

175, 452 – 453, 452 – 453
worksets, 692

visibility
chairs, 348 – 349, 348 – 349
conditional, 338 – 339, 339
details, 663 – 665, 664 – 665
extrusions, 204, 204
link, 606 – 607, 607
mass elements, 236 – 237, 

236 – 237
revision clouds and tags, 

675 – 676, 676
work planes, 190, 191
worksharing files, 690

Visibility/Graphic Overrides 
dialog box, 10, 11, 32, 33

colored sections, 449
cost schedules, 313
cutting, 58

design options, 306, 306
exterior skins, 305
fill patterns, 452 – 453, 452
graphics, 166 – 168, 167 – 168
imported CAD files, 732
line patterns, 104
links, 615
mass elements, 236 – 237
Project Browser views, 50
room elements, 315
room separation lines,  

535, 537
schedules, 499
site data, 266
worksets, 694, 696
worksharing files, 690, 691

Void Form options, 202, 202
void shapes, 205, 205, 222 – 224, 

223 – 224
volume

computation settings, 
168 – 169, 169

rooms, 541 – 546, 541 – 546, 
732 – 733, 733

units, 169
Volume property, 540

W
walkthroughs, 462, 477 – 478, 478
Wall tool, 42
Wall by Face tool, 282
Wall Editor, 152
Wall Joins tool, 354, 354
Wall Sweep tool, 364
Wall Sweeps dialog box, 362, 362
walls, 147 – 148, 149

articulation, 356 – 360, 
357 – 360

bidirectional relationships, 
22 – 23, 23

blends, 368
compound, 356, 357
cores, 351 – 353, 352 – 353
curtain, 369 – 370, 369 – 370

designing, 370 – 373, 
371 – 373

doors and windows, 
374, 374

panels, 373 – 375, 
374 – 375

custom, 148, 148 – 150
default wrapping,  

153, 153
layers, 150 – 154, 151 – 152
preview window, 150

defaults, 172
disjoining, 354, 354
extending, 90, 90, 366 – 367, 

366 – 367
finish materials, 358 – 360, 

358 – 360
functions, 154 – 155
host-based families, 322, 

323
in-place, 368, 368
join editing, 354, 354
layer join cleanup, 353 – 354, 

353
levels of detail, 153, 154
Model by Face tool, 

281 – 282
in modeling principles, 

199 – 200
offsetting, 91, 91
overlapping, 586
railings on, 434 – 436, 

434 – 436
rotating, 84, 84
sections

details, 632 – 650, 
632 – 650

keynotes for, 576 – 580, 
577 – 579

splitting, 90, 90
stacked, 355 – 356, 355 – 356
sweeps and reveals, 

361 – 365, 361 – 365
tags, 532, 550, 550,  

553 – 554, 554
trimming, 89, 89
wrapping, 361, 361

56491bindex.indd   767 6/3/09   10:41:51 AM



768 | warnings • Zoom tool

warnings
overlapping items, 586
reviewing, 740, 740
tags, 533, 533, 538

warped surfaces, 419, 419
weak reference planes, 186, 186
Weld setting, 431
Where Is My Command? tool, 

44, 44
width

elevation tags, 132
Insulation tool, 624
shutter, 342
text, 119

Window category, 62
Window.rft template, 322
window surface percentage, 

521, 522
windows

curtain wall, 374, 374
defaults, 172
host-based families, 322, 323
in modeling principles,  

200, 200
with muntins, 341, 341
rotating, 83
selection, 76
types, 162

witness lines, 115 – 116

work plane-based families, 329, 
334 – 335

Work Plane-based option, 
334 – 335

work planes, 183 – 184, 184
grids, 190, 191
levels, 185 – 186
operations, 190 – 192, 

191 – 192
roofs by extrusion, 193 – 197, 

193 – 197
visibility, 190, 191
working with, 189 – 190, 

189 – 190
workflows, 698

central files, 698 – 699, 698
local files, 699, 699
massing studies, 229 – 230
smart

groups. See groups
links. See links and 

linking
repetitive elements, 583

worksets, 696
worksets, 689 – 690, 690, 

692 – 693, 692 – 693
moving elements between, 

696 – 698, 697

organization, 694 – 695, 
695 – 696

in performance, 735
permissions, 704 – 705, 

704 – 705
worksharing, 689

basics, 691 – 693, 692
element ownership, 

701 – 706, 702 – 706
mistakes in, 702
in performance, 733
saving shared work, 

700 – 701, 700 – 701
workflows, 698 – 701, 

698 – 699
workset methods. See 

worksets
wrapping walls, 361, 361
Wraps column for wall layers, 

152, 152

X
X-Ray mode, 256
X-References, 10

Z
Zoom tool, 46
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Project Gallery
This gallery comes from architects from all around the globe who have embraced 

the move to a smarter way of working on projects. They all have different skill 

levels with Revit, but what ties them together is that they have produced beautiful 

architectural examples using BIM.

BIM is not a myth. These are real architects, real projects, and real sources of 

inspiration. And don’t forget, it’s technology, it’s digital—but still, what really 

matters is that it’s good architecture.

Courtesy of DARK Arkitekter AS, Norway



Burt, Hill
USA

Various Projects: Student Centre; Hamilton Plaza



Nemeth, Polakova, Senteska
Slovakia



Hviezdoslav Apartments



Tower Study

Case Design
USA



Gensler
USA



American University of Beirut, School of Engineering



To Pluss To
Norway

Commercial Rehabilitation project, Norway



HOK
Worldwide

Residencias Garza Sada, Monterrey
Architect—HOK, Mexico

DC Consolidated  
Forensic Laboratory
Owner: Government of  
the District of Columbia,  
Architect—HOK; Washington, DC



Internacional de 
Inversiones 
Conjunto Torre 40  
Monterrey, N.L.
Architect— 
HOK, Mexico

Reston Heights, Reston VA
Owner: The JBG Companies,
Architect— 
HOK; Washington, DC
MEP Engineers— 
R.G. Vanderweil; Boston, MA

DC Consolidated  
Forensic Laboratory
Owner: Government of  
the District of Columbia,
Architect—HOK; 
Washington, DC



Residencias Garza Sada, Monterrey
Architect—HOK, Mexico

Estadio de Futbol Rayados
Design Architect—Populous  
Prime Architect—HOK, Mexico



WATG
USA

Four Seasons Cove 4 Restaurant and Sofitel Qiandaohu Lakeside Resort



Ellerbe Becket
USA

Medical and Research Center



Montealegre Beach  
Arquitectos Ltda
Chile

Stadium



Link Landskap
Norway

Nedre Jarlsberg Brygge, Residential Harbor Development, Midtbygda Skole, Norway



E. N. Raycroft; T. Castro;  
A. Blood; D. Belcher
USA

99K, AMD
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